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Chapter 1 

Introduction 

Welcome to the Hydrologic Engineering Center’s Reservoir Simulation (HEC-ResSim) 
computer program.  HEC-ResSim is the successor to HEC-5, Simulation of Flood Control 
and Conservation Systems” (HEC, 1998).  HEC-ResSim is comprised of a graphical user 
interface (GUI), a computation engine (to simulate reservoir operations), data storage 
and management capabilities, and plotting and reporting facilities.  HEC-DSS, the 
Hydrologic Engineering Center’s Data Storage System,  (HEC, 1995 and HEC, 2009) is used 
for storage and retrieval of input and output time-series data. 

1.1 Starting ResSim 

To begin modeling reservoirs, you must first start ResSim.  Like 
most other Windows applications, you can launch ResSim by: 

• Double-clicking the HEC-ResSim icon on your Windows 
desktop (Figure 1.1), or  

• Selecting HEC-ResSim from the HEC menu in the Windows 
Start menu (Figure 1.2).  

 

Figure 1.1 
ResSim Desktop Icon 

    

Figure 1.2 ResSim Main Window 
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After a moment or two, ResSim’s main window will open (Figure 1.2). The short delay 
before ResSim displays its main window is because ResSim is a Java application and, as 
such, the Java Runtime Environment must be launched before ResSim can be loaded. 

1.2 A ResSim Watershed 

In the physical world, a watershed is a region of land that drains into a stream, river 
system, or other body of water.  In the hydrologic modeling world, a watershed is a 
dataset associated with a geographic region that drains into a system of rivers and 
reservoirs for which you may develop one or more models in one or more modeling 
applications (e.g., HEC-HMS, HEC-ResSim, HEC-RAS, etc.).  A watershed may include some 
or all of the streams, projects (reservoir, levees, etc.), gage locations, impact areas, time-
series locations, and hydrologic and hydraulic data for the associated geographic area.  
All of these details together, once configured, form a watershed data set. 

Since ResSim is used to model the system of rivers and 
reservoirs of a watershed, the term watershed is used 
to label the set of files and folder that represent a 
ResSim model. Thus, a ResSim project (dataset) is called 
a watershed.  

When you create a new watershed, ResSim generates a 
folder structure named for the watershed in which it 
will store all files associated with the watershed. The 
watershed folder structure is illustrated in Figure 1.3.  

Two files are stored in the root folder of the watershed: 

● watershed.wksp - where watershed is the name you gave to the watershed when 
you created it and .wksp is appended to the watershed name 
to identify the file type.  The .wksp file is your “project” file.  

● stream.align - the file containing the stream alignment for your watershed.   

Four subfolders are created in the watershed folder:  

● maps - the maps folder is where you should put a copy of the 
background maps you will display with your watershed 
schematic 

● rss - the rss folder is where ResSim will store the networks and 
alternatives that are created in the Reservoir Network module 
as well as the simulation folders that represent the simulations 
created in the Simulation module 

● shared - the shared folder is where you should store the HEC-DSS files 
from which that your alternatives get their time series data   

 

Figure 1.3 Watershed 
Folder Structure 
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● study - the study folder is where ResSim stores most of the watershed 
configuration and its associated schematic elements defined in 
the Watershed Setup module 

The modules mentioned above are introduced in the next section of this chapter and 
described in detail in subsequent chapters. 

1.2.1 Understanding Watershed Directories  

When you create a new watershed, ResSim creates a watershed tree in the directory 
you indicated.  The watershed folder (the root of the watershed tree) is assigned the 
same name you gave to the watershed.  

For example, in Figure 1.4 the watershed folder is Hayes_Basin.  The full path to 
the folder (or directory) where the watershed Hayes Basin is stored is 
D:\CurrentProjects\Example Watershed; this is the path you would specify if you 
created a shortcut to your watersheds. 

The watershed tree stores all of the data for 
the watershed, including maps, schematic 
elements, model configurations, simulation 
data, and results. The watershed tree is 
highlighted in yellow in Figure 1.4. 

When you create a new simulation, ResSim 
generates a simulation directory named (by 
default) according to the date and time of 
the simulation.  In Figure 1.4, the simulation 
directory name 1999.10.18-2400 
corresponds to a simulation for October 18, 
1999 at midnight.  ResSim also copies all of 
the model data that define your selected 
alternatives into the simulation tree.  This 
facilitates archiving of simulation information 
and ensures consistency in your model 
results. 

If you Save to Base Directory in the Simulation Module, ResSim copies your model 
alternative data from the simulation directory back to the base directory.  If you 
Replace From Base Directory in the Simulation Module, ResSim copies the original 
model alternative data from your base directory into your simulation directory.  See 
Section 15.8 for more information about these commands. 

1.3 Opening an Existing Watershed 

Once you have launched ResSim, you will need to open a watershed.  Here’s how:  

• Select Open Watershed from the File menu (of any module). The Open Watershed 
browser will appear (Figure 1.5). 

 

Figure 1.4 Example Watershed Tree 
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Figure 1.5 Open Watershed Browser 

• Navigate (browse) to and select your watershed’s .wksp file. The .wksp file is the 
ResSim “project” file.  This file is located in your watershed’s root or main folder and 
its filename is the name of your watershed with an extension of .wksp. The .wksp file 
identifies the watershed to ResSim.  

• Click the Open button.  The Open Watershed browser will close and the watershed 
you selected will load and appear in ResSim’s main window with the watershed name 
shown in the Title Bar. 

The options for opening a watershed are described in more detail in section 2.4 

1.4 About this Manual 

This User’s Manual and its companion, the HEC-ResSim Quick Start Guide, are the primary 
references for providing ResSim users with instructions for creating ResSim models and 
analyzing simulation results.  With the exception of Chapters 1 and 2 (which deal with 
introductory and core concepts), the chapters of this manual group tasks according to 
module.  Each chapter provides an overview of key concepts and a detailed description of 
the user interface components and tools available in the module. Appendices cover 
topics and tasks that require levels of detail beyond the scope of an individual chapter. 
The organization of this manual is summarized in Table 1.1. 

The HEC-ResSim Quick Start Guide provides a brief introduction and overview of the HEC-
ResSim capabilities while describing the process for developing a reservoir model with 
ResSim.  Throughout the Guide are references to this User’s Manual for more detailed 
information on topics and features that are only briefly described in the Quick Start 
Guide. 

 

 

New 
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Table 1.1 Contents Summary of the HEC-ResSim User's Manual 

If you want to learn about… Refer to… 

HEC-ResSim concepts Chapter 2 

How to create and manage watersheds Chapter 2 

How to work with map layers  Chapter 3, 
Appendix B 

How to create watershed configurations Chapter 3 

How to establish a stream alignment Chapter 4 

How to create and define watershed elements and projects (e.g., 
reservoirs, levees, etc.) 

Chapter 5 

How to create computation points (hydrograph locations) Chapter 5 

How to develop reservoir networks Chapter 6 

How to edit element data (junctions, routing reaches and diversions) Chapter 7 

How to define and edit physical reservoir data Chapter 9 

How to develop reservoir operations…  

…operation sets Chapter 10 

…operational rules (downstream control, induced surcharge, 
hydropower, pumps, tandem) 

Chapter 11 

…Boolean statements for operations Chapter 12 

...scripted operations — state variables and scripted rules Chapter 12 

…special operations — outage schedules, storage credit, decision 
schedules, projected elevation 

Chapter 12 

How to import network properties from another watershed Chapter 12 

How to define reservoir systems Chapter 13 

How to define alternatives Chapter 14 

How to develop and execute simulations Chapter 15 

How to calibrate model Chapter 15 

How to manage simulations Chapter 15 

How to plot results Chapter 16 

How to develop reports Chapter 17 
  

Detailed application settings Appendix A 

How to define the coordinate system Appendix B 

How to edit maps Appendix B 

How to change colors of messages Appendix A 

How to use HEC-DSSVue Appendix D 

How to copy, export, and print tables Appendix E 

Yield Analysis Appendix F 

Ensemble computing Appendix G 

Monte Carlo computing Appendix H 

Operation Support Interface Appendix I 

References Appendix J 
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1.4.1 Document Conventions 

A variety of text formatting is used throughout this manual to emphasize the 
significance of a word or phrase.  The text formatting follows these conventions: 

“ResSim” HEC-ResSim is the software’s full name but it is easier to say and 
type just ResSim, so we do. 

Bold Text Words or phrases shown in Bold Text in Title Case indicate that the 
word or phrase refers to something you will see somewhere in the 
ResSim user interface.  It may be the name of a menu, an option in 
a menu, the name of a dialog or editor, or the name of a data entry 
field or region. 

Italic Text  Italic text is used to emphasize a word or phrase in a sentence.  

Italic text is also used identify the name of a document or file. 

A word or phrase shown in ItalicText in camelCase is a placeholder 
for something you should enter in its place.  For example: 

WatershedName.wksp   

is a reference to a file that has the name of your watershed and the 
extension .wksp.   

Underlined Text Words or phrases that have been underlined represent the 
definition for a word or phrase in ResSim’s terminology. 

Menu → Menu 
Item 

The → (arrow symbol) is used between menu selections in a 
sequence of selections or steps in sequence of steps.  For example: 
Edit→Reservoir can be read as “from the Edit menu, select 
Reservoirs”. 

“…left mouse 
button…” 

By default, in Windows (and most other windowed operating 
systems), the left button is the primary button on a standard 
mouse.  We recognize that not everyone uses a standard mouse or 
uses their mouse with the default settings.  However, for efficiency, 
we have written most instructions with the assumption that you, 
the user, are using default settings. If you are using a non-standard 
mouse or are not using default settings for your mouse, we leave it 
up to you to translate “left mouse button” to “primary mouse 
button” and act accordingly. 

 New Features or program enhancements are marked with this 
image.  These features were added to ResSim with the version 
number identified on the cover of this manual. 

 

This storm cloud icon is used to mark a disabled or malfunctioning 
feature.  Like rain in California, this is an unusual occurrence so you 
won’t see a lot of these in this manual. 

New 
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Tips are added where we wanted to make an instruction or description 

standout.  Sometimes, a Tip will provide a “how-to” for a “hidden feature” that 

we wanted to share where it seemed most logical.  For example, see the Tip in 

the section on creating a New Simulation. 
 

 

Warnings are used to tell you to be careful, or to watch out for something, or to 

just not do something. 

 

 

Notes are used to share information that you should take special note of. 

They are intended to emphasize a point or to tell you something beyond the 

how-tos of the ResSim user interface. 
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Chapter 2 

The ResSim User Interface  

Before you begin working with ResSim, you should understand some ResSim concepts 
and user interface fundamentals to enable you to develop, access, and interact with 
watersheds in ResSim.  Specifically, this chapter covers: 

• The Widgets that make up the User Interface 

• The Common ResSim Interface Components 

• Layers and the Map Display Area 

2.1 User Interface Components 

By now, most computer users recognize the various components or widgets that make 
up a graphical user interface and how to interact with them. For those who are uncertain 
of the terminology or what to expect when using a graphical user interface, Table 2.1 lists 
the various widgets that are used in the ResSim user interface and describes how to 
interact with them. 

Table 2.1 User Interface Widgets 

Name Description 

Pointer 

 

The object that moves around on your 
monitor when you move your mouse. 

Button 

 

By positioning your pointer on a button and 
pressing then releasing (a.k.a.  “clicking”) 
your left mouse button, the function 
indicated by the label or image on the 
button is executed. 

Text Box 

 

Usually, a data entry field.  Position your 
pointer in the box and click.  A blinking 
vertical bar (cursor) will appear.  Type in an 
appropriate value.  Some text boxes are used 
to display information and are not editable. 
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Selection (or Drop-down) List  

 

A selection list looks like a text box with a 
down-pointing triangle or “V” in it. When 
you click in the text box, a list of options will 
appear below it. If the list of possible options 
is long, a scrollbar may appear to the right of 
the list.  You can select one of the options by 
clicking on it in the list with your pointer.  
The list will disappear, and your selection will 
be displayed in the text box. 

Radio Buttons 

 

A set of options that are mutually exclusive 
— pick one and only one.  The buttons are 
open circles.  The selected option appears 
with a black circle inside. 

Check boxes 

 

A check box is used to identify an option that 
is or isn’t activated, on, or selected. A check 
box is an open square.  An “activated” 
checkbox has a checkmark inside the box. 
The checkmark is added or removed by 
simply positioning your pointer in the box 
and clicking. 

Table, Function, Relationship 

 

A table is a set of columns and rows that 
allow input and/or output of related data.  
For data entry, almost all data entry tables 
must be entered in monotonically increasing 
order, especially for the independent 
variable — the first column. 

Trees 

 

Trees are used to reflect a hierarchy or 
order of data objects or elements.  The tree 
structure should be familiar to a Windows 
user since the same basic structure is used 
in the standard file explorer. 

Tabs 

 

Tabs are used to organize editors/windows 
so that they can be less “busy” — to collect 
similar data into subpanels of the editor.  
Click on the tab to make that tab “current” 
or bring it “forward”; to view it. 
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Slider Bar 

 

Slider bars are used to allow quick selection 
of a value from an allowable range.  The bar 
usually appears as a horizontal bar 
representing the range with a small vertical 
bar as the marker on the range.  The 
selected value appears in a textbox to the 
side of the slider. 

VCR Buttons 

 

These buttons are a set that look like the 
buttons on your VCR/DVR remote.  They are 
typically used in the ResSim editors to move 
quickly through the various elements that 
can be edited by the editor. The four buttons 
shown from left to right are go to the first 
element, go to the previous element, go to 
the next element, and go to the last 
element.  The box in the middle indicates 
which element of the full set is the current 
element shown in the editor. 

2.2 ResSim’s Modules 

The design of the ResSim user interface separates the model development process into 
three major stages and provides the functionality and activities associated with each 
stage as Modules.  These modules are Watershed Setup, Reservoir Network, and 
Simulation.  Each module has a unique purpose, one or more unique datasets, and a set 
of functions accessible through menus, toolbars, and schematic elements for creating 
and editing that module’s dataset(s).  Figure 2.1 illustrates the basic modeling features 
and data available in each module. 

  

Figure 2.1 ResSim Module Concepts 
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2.2.1 The Watershed Setup Module  

The purpose of the Watershed Setup module is to provide a common framework for 
defining the features of a watershed for modeling with one or more HEC modeling 
applications.  Aspects of this module can be found in HEC-ResSim, HEC-FIA, HEC-
WAT, and the CWMS CAVI. 

Activities associated exclusively with the Watershed Setup module include creating 
new watersheds, adding background maps, establishing and editing a stream 
alignment, defining watershed configurations, assembling configuration elements to 
describe a watershed’s physical features, and viewing lists of schematic elements 
that you have created. 

Chapters 3 through 7 describe the Watershed Setup module and its activities in 
detail. 

2.2.2 The Reservoir Network Module 

The purpose of the Reservoir Network module is to isolate the development of the 
reservoir model and alternatives from the analysis of results.  The activities 
associated with the Reservoir Network module include creating a reservoir network 
and schematic, describe the physical and operational features of your network, 
assembling the alternatives that you want to analyze, and viewing reports that list 
your network elements by type.   

Chapters 8 through 13 describe the Reservoir Network module and its activities in 
detail. 

2.2.3 The Simulation Module 

The purpose of the Simulation module is to isolate the analysis of results from the 
model development process.  Once you have created your reservoir model (network) 
and defined at least one alternative, you can use the Simulation module to create 
simulations, compute your alternatives, view output, and make changes to your 
model as appropriate to achieve your desired operations.   

Chapter 15 describes the Simulation module and its activities in detail. 

2.3 Recognizing Common Screen Components 

Although the main ResSim interface has three faces or modules—each with its own 
functions and module-specific tools, menus, and output—the modules share common 
screen components, as illustrated in Figure 2.2. These common components include: 
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Figure 2.2 ResSim Main Window and its Common Components  

The Title Bar displays the software name and version.  After a watershed is opened, the 
name of the current watershed will also be displayed. 

The Menu Bar contains menus for access to ResSim features and options. As you switch 
between modules, module-specific menus as well as the list of items in the 
common menus may change, offering module-specific commands.  You can 
select a menu item by clicking on the name of the menu (such as File), then 
pointing to and clicking on the menu item you wish to select.   

The Module Toolbar is the row of user interface objects (a.k.a. widgets) directly below 
the Menu Bar.  It contains module management tools including: 

The Module Selector—this widget gives you access to the three available 
modules of ResSim.  Use this drop-down list to move between the 
Watershed Setup module, the Reservoir Network module, and the 
Simulation module.  

The Active Configuration or Network—this widget displays the name of the 
currently open or “active” configuration or network. The active 
configuration or network is available for editing from the various 
editors in the module and its schematic is displayed in the Map 
Display area. 

The Edit Lock—this button toggles the edit feature of the module on and off. 
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The Map/Schematic Display Area (a.k.a. map region) is the (geo-referenced) map space 
where all model schematic elements (stream alignment, computation points, 
reservoirs, etc.) and map layers are shown.   

The Map Toolbar contains tools for interacting with the map display, manipulating 
schematic elements, editing element properties, and viewing results.  The first 
three tools in the Map Toolbar and their functionality are common to all three 
modules. The other tools that appear in the Map Toolbar have module-specific 
functions and may appear in only one module.   

The Status Bar, located at the below the Map Display displays “Ready” unless your cursor 
is somewhere in the Map Display area, then it shows the coordinates of the 
cursor as it relates to the current view in the Map Display area in the watershed’s 
coordinate system.   

The Message Bar, located to the right of the Status Bar, displays a scrolling list of 
messages from ResSim.  These messages are usually produced by processes that 
may take a few moments (or more) to complete. The scroll arrows and the … 
button to the right of the Message Bar control the display and allow you to 
review all messages received during your ResSim session. Program diagnostic 
messages from ResSim are directed to the console log (not the message bar), 
which can be accessed from the Tools menu. 

2.3.1 The Menu Bar 

Figure 2.3 ResSim Menu Bar 

The Menu Bar of the ResSim Main Window (Figure 2.3) contains several menus, most 
of which are common to all three ResSim modules.  Although the menus are 
common, the options available in some of the menus may vary from one module to 
another.  In addition, one or more menu options may be “greyed out” or disabled 
when they are not applicable for the current state of ResSim.  For example, Save 
Watershed (a File menu option) will be disabled if there is no currently open 
watershed.   

The most common and consistent menus in the Menu Bar are the File, View, Tools, 
and Help menus.  These menus provide the same options or commands in all three 
ResSim modules. These menus may also contain module-specific options that appear 
only within individual modules.  These menus and their options are described in 
detail below. 

Two other menus, Edit and Reports, are also included in the Menu Bar of all three 
modules.  These menus contain only module-specific options and are described in 
detail in later chapters of this manual. 
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2.3.1.1 The File Menu 

The File menu (Figure 2.4) contains options specific 
to the ResSim watershed (project or model) that 
you want to work with.  These options include: 

New Watershed—creates a new ResSim watershed. 
This option is only available in the 
Watershed Setup module. 

Open Watershed—opens an existing Watershed. 
See Section 2.4 for details on opening a 
watershed. 

Save Watershed—saves the currently open 
watershed to disk including any changes you have made since opening it. 

Save Map As—saves the current view of the Map Display Area to a file.  You will 
be required to give the file a name and select a graphical file format (e.g., 
jpg, png, etc.). 

Exit—prompts you to save any unsaved files and shuts down ResSim. 

Last Five Watersheds—at the bottom of the File menu, your five most-recently—
opened watersheds are listed.  These entries are shortcuts for opening 
the identified watershed. 

2.3.1.2 The Edit Menu 

The Edit menu is different in each module of ResSim.  It contains options for 
editing the components of the primary dataset that is the focus of the current 
module.  For example, the Reservoir Network module’s primary focus is the 
reservoir network, so the Edit menu provides access to the editors for the various 
components of a network. 

2.3.1.3 The View Menu 

The View menu (Figure 2.5) contains options 
related to the Map Display Area as well as to the 
entire ResSim user interface. The View options 
include: 

Zoom to All—restores your map display to the full 
watershed extents, 

Layers…—opens the Layer Selector dialog  

Unit System—sets the data units (English or SI) you 
want displayed in the ResSim GUI. 

Restore Windows—brings to the foreground any windows or dialogs that have 
become hidden or inactive. 

Grid Lines—toggles on/off display of a grid in the map region. 

 

Figure 2.4 File Menu 

 
Figure 2.5 View Menu 
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Computation Point Layer—toggles on/off the available computation point layers.  
This option is only available in the watershed setup module. 

2.3.1.4  The Tools Menu 

The Tools menu (Figure 2.6) provides access to features 
that can be considered tools for assisting with model 
development.  This menu also provides access to the 
program Options editor and the watershed Information 
viewer.  The features accessible from this menu include: 

HEC-DSSVue—is the primary software utility program of 
viewing and editing HEC-DSS data—e.g., time 
series data, rating curves, etc.   

Scripts...—provides access to the list of utility scripts you 
have added to the watershed.  You can launch 
them from here. 

Scripts Editor…—opens the Scripts Editor which allows you to create, edit, 
import, delete, and run utility scripts. 

Console Log…—displays the contents of the “HEC-ResSim.log” file which is stored 
by default in your AppData folder for ResSim.  The path to this folder 
should look like: “C:\Users\yourUserName\AppData\Roaming\HEC\HEC-
ResSim\3.3\logs”. The console log contains messages produced by 
ResSim during its current or most recent execution.   

HEC-DSS Output…—displays the HEC-DSS log file, HEC-ResSim_DSS.log, which is 
also located in your AppData folder, The HEC-DSS log contains messages 
produced when DSS files are accessed by ResSim. 

Options…—opens the ResSim Program Options Editor (Figure 2.7). The Options 
editor gives you access to a variety of program settings that affect how 
ResSim behaves.  This editor is organized into tabs: 

 

Figure 2.7 ResSim Options Editor 

 

Figure 2.6 Tools Menu 
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 Shortcuts—lets you associate a name with a directory path where you 
will be storing your watersheds. Shortcuts were formerly called 
Watershed Locations. 

Compute Display—contains settings that control the appearance of the 
Compute Window and the format of the compute, console, and 
DSS logs. 

Debug Levels—allows you to control the quantity of various categories of 
debug message that are written to the logs.  

General—provides options for a confirmation message to appear when 
you exit ResSim and to automatically open the watershed you 
were working on the last time you ran ResSim. 

Fonts—lets you change the font used throughout the ResSim GUI. 

Additional tabs and their associated program options may appear in the 
Options editor depending on the current module.  The Options editor 
shown in Figure 2.7 is from the Simulation module and includes the 
Simulation, Advanced, and ResSim Compute tabs.  The Options Editor is 
described in detail in Appendix A. 

Information…—opens the Application Properties viewer (Figure 2.8) which 
displays the properties of various aspects of the current instance of 
ResSim. Like the Options editor, this viewer is also organized with tabs: 

 

Figure 2.8 Application Properties Viewer 

Watershed—displays details about your watershed 

User—displays information about you (the ResSim user) 

Client—displays information about ResSim itself (the Client) 

Server—if ResSim is were launched in Client-Server mode, this tab 
displays information about the server application that ResSim is 
connected to.  However, the Client-Server feature is disabled in 
the public release version of ResSim. 
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System Properties—displays the list of environment variables defined for 
the currently running instance of ResSim.  This list includes 
variables defined for both the operating system and the Java 
Runtime Environment. 

2.3.1.5  The Help Menu 

The Help menu (Figure 2.9) provides a few 
options to assist you in using ResSim.  These 
options include: 

Quick Start Guide—displays the ResSim Quick 
Start Guide. 

User’s Manual—displays the ResSim User’s 
Manual (this document).   

Install Example Watersheds—allows you to install a couple of watersheds that 
were used to create many of the screen shots in the Quick Start Guide 
and the User’s Manual.   

About HEC-ResSim—displays information about option the version of ResSim you 
are using. 

2.3.2 The Module Toolbar 

The Module Toolbar is located between the Menu Bar and the Map Display area of 
the main ResSim user interface (Figure 2.10).  The content of the Module Toolbar 
varies depending on the current module, but for all modules, the common object in 
the tool bar is the Module Selector.  Other objects on the toolbar that appear in 
more than one module include the current Configuration and/or Network name field 
and the Edit Lock button.   

2.3.2.1 The Module Selector 

The Module Selector is a selection list of the available ResSim modules.  Use this 
drop-down list to move between the Watershed Setup module, the Reservoir 
Network module, and the Simulation module.   

2.3.2.2 The Active Configuration or Network  

The Module Toolbar in each module contains widget that shows the name of the 
currently open or “active” Watershed Configuration or Reservoir Network.  The 
active configuration or network schematic is displayed in the Map Display area.  

  

Figure 2.9 Help Menu 

 

Figure 2.10 Module Toolbar 
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In the Watershed Setup module, the widget is a selection list from which you can 
select and/or change the active configuration. In the Reservoir Network and 
Simulation modules, the widget is a textbox that shows the name of the currently 
open (or active) network whose schematic is being displayed in the Map Display 
area. 

2.3.2.3 The Edit Lock 

The Edit Lock button is another somewhat common object on the Module 
Toolbar.  The Edit Lock button appears in the Watershed Setup and Reservoir 
Network modules, just to the right of the current Configuration or Network 
name.  This button toggles the edit feature of the module on and off. 

If the lock button appears unlocked , the editing features of the module will 
be in “view only” mode.  “View Only” mode means that some options in the main 
and context menus will be unavailable (greyed out) and the available editors will 
open in “view only” mode with most of their editable fields “greyed out” (non-
editable).  

If the Lock button appears locked , all relevant editing features will be 
enabled.  

 

The concept of locking the module to allow editing is counter-intuitive to 

many users.  However, if you understand where the lock originated, it 

may make more sense.  You see, when ResSim was first designed and 

built, it was part of a multi-user, client/server system.  In order to function 

properly in that multi-user environment, the ability to lock out other users 

so that only you could edit the watershed was an important feature.  

Unfortunately, now that the multi-user framework is no longer being 

actively used, the locks have become redundant.  They will be removed in 

a future version of ResSim. 
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2.3.3 The Map Toolbar 

The Map Toolbar (Figure 2.11) is located to the left of the Map Display 
area and contains a column of buttons.  Each of these buttons changes 
the functionality (behavior) of your mouse cursor (tool) in the map 
display area, effectively changing your mouse into different map tools.  
Each tool button (a.k.a, tool) displays an icon to illustrate its purpose.  
The set of tools available in the Map Toolbar changes depending of the 
current module; however, the first three tools on the Map Toolbar and 
their functionality are common to all three modules.  These tools are: 

  Pointer/Selector Tool—use this tool to select schematic elements in 
the map display and to edit, rename, and delete them.  To access 
the context (pop-up) menu of any schematic element, select the 
Pointer/Selector Tool, click the right mouse button (right-click) 
on an element, and a (module and element appropriate) list of 
functions will appear beside the element in the map space. 

  Zoom Tool—use this tool to 
zoom your view of the map 
space in and out.  To zoom in, 
hold the left mouse button 
down and drag a “box” to 
outline the area you want to 
zoom in on.  To zoom out, 
right-click in the display area; 
the view will zoom out in 
intervals. 

 Pan Tool—this tool can be used to move (pan) the display area when 
zoomed in.  To pan, with the cursor in the map display area, hold 
down the left mouse button and drag the mouse in the direction 
you would like to pull the display area.  Note: when zoomed in, 
scroll bars appear at the bottom and right edges of the map 
display. These scroll bars can also be used to pan the display 
without switching to the Pan tool. 

2.4 Opening an Existing Watershed 

Once you have launched ResSim, you will need to open a watershed.  You can open an 
existing watershed from any module in ResSim, but if you need to create a new 
watershed you must be in the Watershed Setup module. See Chapter 3 for details on 
creating a new watershed.  Three methods of opening an existing watershed are 
available:  

• Use the Open Watershed browser  

• Select one of the five most recently used watersheds from the File menu 

 

Figure 2.11 
Map Toolbar 

 

If your mouse has a 

wheel, the zoom tool is 

not required for 

zooming—just click in 

the Map Display area and 

roll the wheel up to 

zoom out and down to 

zoom in. 
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• Reload the Last Watershed at startup. 

2.4.1 The Open Watershed Browser 

To access the Open Watershed browser: 

• Select Open Watershed from the File menu (of any module). The Open 
Watershed browser will appear (Figure 2.12). 

Figure 2.12 Open Watershed Browser 

• Navigate (browse) to and select your watershed’s .wksp file. The .wksp file is the 
ResSim “project” file.  This file is located in your watershed’s root or main folder 
and its filename is the name of your watershed with an extension of .wksp. The 
.wksp file identifies the watershed to ResSim.  

• Click the Open button.  The Open Watershed browser will close and the 
watershed you selected will load and appear in ResSim’s main window with the 
watershed’s name shown in the Title Bar. 

If you intend to store several watersheds in the same folder, you can create a 
Shortcut to that folder so that you can navigate to it quickly in the Open Watershed 
browser.  To create a shortcut: 

• From the Open Watershed browser, navigate to the folder containing your 
watershed(s), then press the Add button.  A dialog will appear asking you to 
“enter an alias” for the current folder.  After 
you give the shortcut (or watershed location) 
a name and press OK, your shortcut will 
appear in the Shortcuts panel at the right of 
the Open Watershed browser.   

2.4.2 Opening a Recent Watershed 

ResSim keeps track of the last five watersheds you have opened and lists them at the 
bottom of the File Menu.  If the watershed you want to open is one of those five, you 
do not need to access the Open Watershed browser to open the file, you can simply 
select the watershed directly from the File Menu (Figure 2.13).  If you are unsure if 

 

 

Note: You can also create 

and edit Shortcuts in the 

Options editor’s Shortcuts 

tab—see Appendix A for 

details. 

New 
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the watershed you want is one of the five, hover 
on its name in the File Menu—the folder location 
of the watershed will appear in a tooltip box. 

2.4.3 Reload Last Watershed at 

Startup 

If you are going to be working on the same 
watershed for a while, you might like the option 
to Reload the last watershed you had open each 
time you startup ResSim.  To enable this option: 

• Select Options from the Tools menu. The 
Options Editor will open (Figure 2.14). 

• Select the General tab 

• Click in the checkbox next to Reload last Watershed at Startup. 

• After the checkmark appears in the checkbox, click OK to save your setting and 
close the Options editor. 

 

2.5 Understanding the Two Schematic Types 

The Map/Schematic Display Area of ResSim was designed to enable you to visualize river 
and reservoir systems (watersheds) in a map-based, geo-referenced context through a 
series of map layers. Some map layers are created outside of ResSim and can be 
imported and used as 
background maps. Other layers 
are created inside ResSim and 
represent different portions of 
your river and reservoir (model) 
schematic.  

Each ResSim module displays a 
somewhat different schematic 
in the Map/Schematic Display 
Area: 

In the Watershed Setup module (Chapters 3 through 7) you will create watershed 
schematics that can be shared across models that support the watershed 
schematic elements and features.   

Figure 2.13 File Menu—Last Five 
Watersheds 

Figure 2.14 Options Editor—Reload Last Watershed 

 

Since ResSim can open only one watershed at a time, to work on two 

watersheds at the same time, launch a second instance of ResSim. 

Note: It is NOT recommended that you open the same watershed in both 

instances of ResSim. Be aware that both instances of ResSim will write to the same 

console and DSS log files. As a result, the content of these logs may become quite 

unintelligible.   
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In the Reservoir Network module (Chapters 8 through 13) you will create one or more 
model schematics (networks) that symbolize the river and reservoir system(s) 
you are modeling.   

In the Simulation module (Chapter 14), the model schematic for the network of your 
active alternative will be displayed. And, by right-clicking on a schematic element 
in the Map Display, a context menu will appear giving you options to quickly plot 
and tabulate results. 

2.5.1 The Shared Watershed Schematic 

The watershed schematic and its components were designed to be shared 
(implemented) across the various HEC models and the model integrating software 
packages HEC-WAT and CWMS.  In ResSim, as well as HEC-WAT and CWMS, the 
shared watershed schematic embodies a set of schematic components that a 
sequence of models are intended to represent.   

The components that make up a watershed schematic include the stream alignment, 
computation points, projects, and impact areas.  These components are created in 
the Watershed Setup module of ResSim and combined represent the watershed 
schematic.   

Projects are collected into sets called configurations.  Configurations are unique sets 
of projects that when combined with the common stream alignment, computation 
points, and impact areas defining unique watershed schematics; thus configuration is 
often used as a synonym for watershed schematic since the configuration is what 
makes each schematic unique. 

For example, a watershed modeling team may create two watershed schematics 
(configurations): an “existing conditions” configuration that includes all the 
reservoirs, diversions, gages, levees, and other points that currently exist in the 
watershed and a companion “without levees” configuration that includes all the 
same schematic elements except for the levees.  The expectation of the modeling 
team that developed the two configurations is that a different set of individual 
models will be needed to reflect each configuration. In reality, some of the models 
may be appropriate to both configurations while other models may only be 
appropriate to one configuration or the other.  

ResSim, HEC-WAT, and CWMS have all adopted the shared schematic concepts and 
implemented the associated Watershed Setup module. Other HEC models have not 
included the Watershed Setup module in their design but have reflected selected 
shared watershed schematic components in their native model schematics. The 
stream alignment and the computation points are the most widely represented 
shared watershed schematic components. 
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2.5.1.1 The Stream Alignment 

The Stream Alignment represents the 
river and stream network of a 
watershed (Figure 2.15). It appears in 
every ResSim module, but can only be 
created and edited in the Watershed 
Setup module.  Streams, Stream 
Nodes, and Stream Junctions are the 
elements of a Stream Alignment.  See 
Chapter 4 for detailed information on 
creating and editing the Stream 
Alignment. 

The Stream Alignment is the 
foundational element of the 
watershed schematic; all other 
schematic elements have some 
relationship to the stream alignment; 
either they are positioned at a specific station along a stream or they are located 
relative to a stream.  

2.5.1.2 Computation Points 

Computation Points (Figure 2.16) are point 
features within the shared schematic where 
data is exchanged between models (e.g., 
between ResSim and HEC-HMS).  These 
points are placed on the Stream Alignment 
and usually represent gages, confluences, or 
model element boundaries (e.g., the inflow 
and outflow points of a reservoir). ResSim 
represents Computation Points with Junction 
elements in the model schematic of a 
Reservoir Network.  

 

Figure 2.15 Stream Alignment 

Figure 2.16 Computation Points 
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2.5.1.1  Project Elements 

Projects are man-made features in the watershed that affect flow in the river 
system.  Project elements that can be placed in the watershed schematic include 
Reservoirs, Levees, Diversions, Channel Modifications, Off-Channel Storage, and 
Other Projects like pump stations and in-line spillways (Figure 2.17).   

ResSim can directly represent reservoirs and diversions in its model schematic 
with reservoir and diversion model elements, but there is no direct parallel for 
any other project element as a ResSim model schematic element. However, with 
some creativity, you may be able to represent the other project elements using 
one or more of the available model elements.  For example, a channel 
modification could be represented with a routing reach with specific routing 
parameters that reflect the smoother, faster reach. 

2.5.1.2 Impact Areas 

Impact Areas ( Figure 2.18) are watershed schematic elements that represent 
distinct portions of a watershed affected by rising water where flood damages 
may be evaluated.  Impact areas can be included in your ResSim watershed for 
consistency with your HEC-FIA model; however, since ResSim cannot directly 
represent impact areas as model elements, only the computation points 
corresponding to the index locations for the impact areas can be represented in 
your ResSim model. 

For more information about Impact Areas, refer to the HEC-FIA User’s Manual 
(HEC, 2003). 

 

Figure 2.17 Project Elements 
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 Figure 2.18 Impact Areas 

2.5.1.3 Time Series Icons 

Time Series Icons  may be placed in the map region to provide access to time 
series data.  You can use Time-Series Icons to identify and visualize any external 
data that you associate with the icon (e.g., HEC-DSS data).  Time Series Icons are 
included in the Watershed Setup module to facilitate their use in CWMS and RTS.   

Note: Although Time Series Icons can be created in the Watershed Setup module 
of ResSim, they are not accessible from the other ResSim modules so are rarely, 
if ever, used in ResSim. For more information about Time-Series Icons, refer to 
the CWMS User’s Manual (HEC, 2010). 

2.5.2 The Model Schematic 

The ResSim Model Schematic (Figure 2.19), which you will create in the Reservoir 
Network module (based on a shared watershed schematic (configuration) created in 
the Watershed Setup module), is the visual representation of your reservoir network. 

The ResSim model schematic elements include reservoirs, reaches, diversions, 

 

  Figure 2.19 Model Schematic 
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diverted outlets, and junctions.  When you create a network, reservoirs, diversion, 
and junctions are automatically added to your network for each reservoir, diversion, 
and junction element in the selected watershed configuration (schematic).  You will 
complete the model schematic by adding routing reaches, diverted outlets, and 
diversions to connect the model elements.  Each element of the model schematic is 
located on the stream alignment. 

Through context menus, the individual elements of the model schematic allow you to 
access data editors to specify properties of your reservoir network elements and, 
from the Simulation module, to plot element-specific results.  The ability to select 
schematic elements and access element-specific context menus is why we call the 
representation of your model in the map display area an “active schematic”. 

Although the stream alignment is visible in all modules, the model schematic is visible 
in the Reservoir Network module only when a Network has been opened and in the 
Simulation module only when an Alternative is Set as Active.  See Chapters 7-14 for 
more details of reservoir networks, alternatives, and simulations. 

2.6 Context Menus 

A context menu, also commonly called a pop-up or shortcut menu, is a menu that 
appears when you right-click on a schematic element in the map display or on many 
other ResSim GUI components such as plots, tables, and tree nodes.  Context menus 
offer a variety of context-specific commands and 
options that allow you to access data editors, plot 
and tabulate data, view reports, compute 
simulations, and more.  Specific context menus and 
their options are described throughout this manual. 

2.7 Tooltips 

Tooltips are small text boxes that appear when you position (and hover) your cursor over 
an icon, label, button, map element, tree node, or other widget for which a tooltip has 
been defined.  The text that is displayed will relate to the object you hovered over.  
Although it is usually informative, the text may be instructional.  But, read quickly, most 
tooltips don’t hang around long. 

 

 

Lots of good stuff may 

be hiding in a context 

menu.  

So, when in doubt… 

right-click! 
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Chapter 3 

Watershed Setup and Configurations 

The purpose of the Watershed Setup Module is to provide a common framework for 
defining the features of a watershed for modeling with one or more HEC modeling 
applications, i.e., to setup a shared schematic.  Aspects of this module can be found in 
HEC-ResSim, HEC-FIA, HEC-WAT, and the CWMS CAVI. 

In the Watershed Setup Module, you will create new watersheds, set up your 
watershed’s map display, and specify the physical arrangement of schematic elements 
that make up your basin. The set of schematic elements includes:  

• The Stream Alignment is a representation of the stream centerlines of the river 
network in your watershed and is the backbone or framework for your schematics.  

• Computation Points are locations where time-series information is exchanged 
between models in an integrated framework. Most Computation Points are placed 
on the stream alignment and represent gage locations, control points, or other key 
physically or operationally important locations.   

• Projects are, typically man-made, structures that impact the flow of water in a river 
system. The types of projects that can be included in your schematics include 
Reservoirs, Levees, Diversions, Channel Modifications, Off-Channel Storage Areas, 
and Other Projects.  

• Impact Areas are geographic regions that may experience economic damages due to 
high water levels (flooding). 

You will also group the projects in your watershed into one or more Configurations.  
Configurations represent a current or potential arrangement of the watershed schematic 
elements (e.g., Existing Condition or Without Project). 

This chapter will cover the Watershed Setup Module itself and the user interface features 
that are unique to this module.  It will also cover how to create a watershed, add maps to 
the watershed, and define watershed configurations.  Chapters 4 and 5 will cover 
creating and editing the stream alignment and drawing schematic elements. 

3.1 The Watershed Setup Module  

The Watershed Setup Module provides tools for setting up your watershed’s physical 
arrangement, including maps, coordinate system, stream alignment, schematic elements, 
geo-extents, and other geo-referenced data.  Figure 3.1 shows the components of the 
Watershed Setup Module’s main window.  User interface components and options that 
are unique to this module are described in this section. 
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Figure 3.1 Watershed Setup Module—Main Window 

3.1.1 The Menu Bar 

The following is an overview of the menus unique to the Watershed Setup Module.  
The options in these menus will be described in more detail in the context of specific 
tasks later in this and later chapters. Refer to Chapter 2 for information about the 
File, View, Tools, and Help menus, which are common to all three modules. 

3.1.1.1 The Edit Menu 

Use the Edit menu (Figure 3.2) to access the following editors:  

• Watershed Properties Editor,  

• Impact Areas Editor,  

• Projects Editor, and  

• Drawing Properties Editor.   

You must select Allow Editing if you wish to make 
changes to your watershed (or toggle the Lock above 
the Map Display area).  

Figure 3.2 Edit Menu 
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3.1.1.2 The Watershed Menu 

Using the Watershed menu (Figure 3.3), you can:  

• Create and edit Configurations 

• Update Computation Points 

• Import and Export Stream Alignments 

• Save Configurations.  

3.1.1.3 The Reports Menu 

The Reports menu (Figure 3.4) gives you access to 
reports for your watershed.  Reports include the List 
of Streams, List of Impact Areas, List of All 
Configurations, List of Computation Points, and 
Projects listings by project type. 

 

3.1.2 The Configuration Selector  

The map display can only display one watershed schematic at a time. That schematic 
is contained in a watershed configuration. You can use the Configuration Selector 
(drop-down box) to select the configuration you want displayed in the Map Display 
area. Once you select a Configuration, all project elements you add to the schematic 
will be included in that Configuration.  The default configuration, Study, contains the 
entire set of all projects defined in the watershed, whether or not it is the active 
configuration.   

3.1.3 The Edit Lock 

Before you can add, remove, or edit schematic elements in 
your watershed, you must lock the configuration for editing.  
The easiest way to lock the configuration is by using the Edit 
Lock button, located to the right of the Configuration 
Selector. A less obvious way is by selecting Allow Editing from 
the Edit menu. Figure 3.5 illustrates the states of the Edit Lock. Remember, the Lock 
button must appear Locked in order for you to edit your configuration. 

Figure 3.3 Watershed Menu 

Figure 3.4 Reports Menu 

Unlocked Locked 

Figure 3.5 Edit Lock 

 

The concept of locking the configuration to allow editing is counter-

intuitive to most users.  However, if you understand where the lock 

originated, it may make more sense.  You see, when ResSim was first 

designed and built, it was part of a multi-user, client/server system.  In 

order to function properly in that multi-user environment, the ability to 

lock out other users so that only you could edit the watershed was an 

important feature. Now that the multi-user framework is no longer being 

actively used, the lock has become redundant.  It will be removed in a 

future version of ResSim. 
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3.1.4 Map Tools 

The Tool Bar is located to the left of the map display area and contains a column of 
buttons.  Each of these buttons changes the functionality (behavior) of your mouse 
cursor in the map display area, effectively changing your mouse into different map 
tools.  Each tool button (a.k.a, tool) displays an icon to illustrate its purpose.   

The first three tools on the Tool Bar and their functionality are common to all three 
modules.  These Common tools are: 

 Pointer/Selector Tool—use the pointer tool to select any schematic element in 
the map display. Left click will select the element your cursor is “pointing at”.  
Right-click will open a context menu for the element you are pointing at. 

 Zoom Tool—use the Zoom Tool to zoom the map display area in and out.  To 
zoom in, hold the left mouse button down to draw a box around the area 
you want to zoom in on.  To zoom out, right-click in the display area; the 
display will zoom out in program-defined increments. 

 Pan Tool—use the Pan Tool to move or scroll the display area while you are 
zoomed in. 

In the Watershed Setup Module, the map tools that appear below the three 
Common tools are the Schematic Element tools.  These tools allow you to create, 
edit, and manage the schematic objects in your watershed configuration(s).  These 
tools also act as Pointer/Selector tools, but they will only interact with objects of 
their specific type.  The schematic element tools are separated into five groups: the 
Time-Series Icon tool, the Stream Alignment tools, the Project tools, the Impact Area 
tool, and the Computation Point tool. 

The Time-Series Icon Tool 

Time-series Icons are used for plotting and tabulating time-series data. This tool is 
provided for compatibility with CWMS; however time-series icons have very little use 
in ResSim itself.  Creating and editing time-series icons is described in Chapter 6. 

 Time-Series Icon Tool—use the Time-Series Icon tool to create and edit time-
series icons.   

The Stream Alignment Tools 

The stream alignment represents the river system of your watershed.  The tools for 
creating and managing the stream alignment include the Stream Alignment tool and 
the Stream Node tool.  Working with the stream alignment is described in detail in 
Chapter 5. 

 Stream Alignment Tool—use the Stream Alignment Tool to draw and edit the 
multi-segmented lines that define a stream in the Stream Alignment.   
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 Stream Node Tool—the Stream Node Tool allows you to create and edit stream 
nodes and stream junctions (confluences), two of the primary components of 
a Stream Alignment.  

The Project Tools 

The project tools include the Reservoir Tool, Levee Tool, Diversion Tool, Channel 
Modification Tool, Off Channel Storage Tool, and the Other Project Tool.  Creating 
and editing the project elements is described in detail in Chapter 6. 

 Reservoir Tool—use the Reservoir Tool to create and edit reservoir projects in 
the map display.  The Reservoir Tool is the first of the Project tools in the 
toolbar.  Creating and editing project schematic elements are described in 
detail in Chapter 6. 

 Levee Tool—use the Levee Tool to create and edit levee projects in the map 
display.  

 Diversion Tool—use the Diversion Tool to create and edit diversions in the map 
display.  

 Channel Modification Tool—use the Channel Modification Tool to select and 
add channel modifications (such as channel straightening, concrete walls, 
dredging, and widening) to the map display and access editors for Diversions. 

 Off Channel Storage Tool—use the Off-Channel Storage Areas Tool to select and 
create Off-Channel Storage Area polygons in the map display and edit their 
properties. 

 Other Project Tool—use the Other Projects Tool to place an icon that represents 
a project that cannot be classified as one of the defined project types, such as pump 
stations and gages, etc. 

The Impact Area and Computation Point Tools 

Creating and editing impact areas and computation points are described in detail in 
Chapter 6. 

 Impact Area Tool—use the Impact Area Tool to create and edit impact areas 
representing regions in the watershed where flood damages will be 
evaluated. 

 Computation Point Tool—use the Computation Point Tool to create and edit 
Computation Points.  Computation Points are locations in the watershed 
where individual models will share information.  Typically, one model will 
produce results at a Computation Point that another model will use as input. 
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3.1.5 Using Context Menus 

Context menus are accessed by right-clicking 
on a schematic element in the map area.  
The options in a context menu vary 
according to the schematic elements with 
which they are associated.  Figure 3.6 shows 
the context menu that appears if you right-
click on a reservoir element in the Map 
Display area in the Watershed Setup Module. 

If your watershed is locked , the context 
menu will provide options to Edit, Rename, 
or Delete the current element, Remove the 
current element from the current 
Configuration, and edit the Configuration Notes about the current element.   

If your watershed is unlocked , the configuration is in “view only” mode so some of 
the context menu options will be unavailable (greyed out) and the available editors 
will open in “view only” mode. 

3.2 Creating a Watershed 

When you create a new watershed, you will need to provide a few details about it 
including:  

• a name and description 

• its directory location (on disk) 

• the units of measure of the data and computations  

• the Time Zone in which it is located 

Once you have created your new watershed, ResSim will generate a new folder in the 
directory you specified; the folder name will be the name you gave your watershed.  Your 
new watershed will then become the open watershed in ResSim, and the tools needed to 
create watershed data will become available in the ResSim user interface.  After creating 
the watershed, you will proceed with other watershed setup tasks such as adding 
background maps, setting preferences for the map display, etc., as described later in this 
chapter. 

3.2.1 Defining a Watershed Location 

A Watershed Location is the place on disk where you store your watersheds.  You can 
have multiple watershed locations, although an individual watershed cannot span 
multiple locations.  Each watershed location is given an alias (or logical name) such as 
My Watersheds or Current Projects. 

In prior versions of ResSim, you were required to create at least one watershed 
location (shortcut) before you could create a watershed.  In this version, that 

Figure 3.6 Reservoir Context Menu 
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requirement has been removed; however there are still features in ResSim that 
expect your watershed to reside in a known watershed location so we recommend 
that you continue to create and use specified watershed locations for storing your 
watersheds.   

So, before you create or open a watershed, you should define at least one watershed 
location.  To define a watershed location, a.k.a., a Shortcut: 

• From the Tools menu, select Options….  The ResSim Options editor (Figure 3.7) 
will open. 

Figure 3.7 ResSim Options Dialog—Shortcuts 

• Select the Shortcuts tab.  The Name and Location of any watershed locations you 
have previously defined will display in the Shortcuts list. 

• To add a new location 
to the list, click the 
Add Shortcut button.  
The Add Shortcut 
dialog will open 
(Figure 3.8). 

• Enter a Name (or 
Alias) for the new location/shortcut, then click Browse….  A file browser dialog 
will open (Figure 3.9).  Use it to select the folder on disk where you want to store 
your watershed(s).  Click OK to close the file browser and accept the selected 
folder as your shortcut’s location. 

• Click OK to finish creating your shortcut and close the Add Shortcut dialog. The 
new location/shortcut will now appear in the list of Shortcuts on the Shortcuts 
tab.  Refer to Appendix A for information about other options available in the 
Options dialog. 

 

Figure 3.8 Add Shortcut Dialog 
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 Figure 3.9 ResSim File Browser 

3.2.2 Creating a New Watershed 

Once you have established a watershed location, you can create a new watershed. 

To create a new watershed: 

• Select New Watershed from the 
File menu.  The Create New 
Watershed dialog (Figure 3.10) 
will open. 

• Enter a Name for the new 
watershed.  The watershed name 
must be less than 32 characters.  
Because the Name will be used 
for both a directory and a 
filename in your file system, the 
watershed name cannot contain any of the following characters:   

| / : * ? ” < > - \ .  

• Enter a Description for the new watershed. 

• Select a Location (a working directory) for the new watershed’s directory from 
the file browser. A new folder representing your watershed will be created in the 
Location you select.  The new folder will be given the Name of your watershed.   

• Select the watershed’s Units—your options are English (U.S. customary units) or 
SI (System International). See Section 3.2.2.1 Units of Measure below, for more 
information. 

• Set the watershed’s Time Zone by selecting from the list of standard time zones.  
See Section 3.2.2.2 Time Zone below, for more information. 

• Click OK to create the watershed and close the Create New Watershed dialog.   

Figure 3.10 Create New Watershed Dialog 
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• A Watershed Summary confirmation dialog (Figure 3.11) will open showing your 
selections.  Review the settings carefully, then select: 

Figure 3.11 Watershed Summary Dialog 

OK—if the settings are all correct 
and you want to proceed 
with creating the watershed. 

< Back—If you want to change any of 
the settings. 

Cancel—if you do not want to create the new watershed.  

3.2.2.1 Units of Measure 

The watershed’s Units is the unit system in which the watershed will perform its 
calculations and store its data and results. The options are English and SI.  English 
(or U.S. Customary) units include feet, acres, cfs, Fahrenheit, etc.  SI (or Metric) 
units include meters, hectares, cms, Celsius, etc.    

Be aware that you cannot change the watershed units once you have created the 
watershed.  However, you can (at any time) change the display units using the 
View menu; so even if you select SI as the watershed units, you can set the 
display units to English which will allow you to enter data and view results in 
English units. 

ResSim will check the units of all input time-series data and will convert the data, 
if necessary, to watershed units before beginning the computations. This means 
that input time-series data can be provided in English or SI units, or both. 

3.2.2.2 Time Zone 

When you create a new watershed, you must select a time zone for the 
watershed.  This typically would be the time zone for the dam or for most of the 
watershed, although you may have reasons for selecting a different time zone.   

 

Be Careful…  

You cannot change the watershed’s 

Name, Units, or Time Zone after 

the watershed has been created. 
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All time zones in the list provided when you create the watershed are considered 
“standard” time zones. They each utilize a fixed time offset from GMT and do not 
adjust for Daylight Savings Time.  

ResSim will use the watershed time zone to store all time-series data that it 
generates.  It will also adjust any input time-series data with a specified time 
zone that is different from that of the watershed into “watershed time” before 
beginning the computations.  If any input time-series data does not have a 
specified time zone, ResSim will assume that the data is in watershed time. 

3.3 Adding Background Maps  

Layers in ResSim are like transparencies laid one on top of the other.  Static images of 
physical, political, or logic features of the watershed, such as rivers, subbasins, roads, 
state boundaries, etc., can be layered in the display as color pictures.  Each of these 
images, along with its associated data, is called a map layer and is added to the 
watershed and managed by the Layer Selector.  Access to the Layer Selector is available 
from the View menu.  In addition to the sections below, you can refer to Appendix B for 
more information on managing Map Layers. 

Several map file formats are supported in ResSim including: 

• ArcView® Shapefiles 

• AutoCAD® DXF files 

• ArcInfo® DEM files  

• USGS Digital Line Graphs (DLG) files 

• USGS Digital Elevation Model (DEM) files 

• ASCII NET TIN files 

• Raster images 

3.3.1 Adding a Map Layer 

Before adding a map layer to your watershed, we recommend that you copy the map 
files into the maps folder of the watershed.  Also, you should verify that all maps you 
plan to add to your watershed share the same coordinate system. 

To add a map layer to your watershed: 

• Select Layers from the View menu.  The 
Layer Selector dialog will appear (Figure 
3.12). 

• From the Edit menu, select Allow Layer 
Editing.  This option is a toggle switch that, 
when set, will allow you to add and 
remove map layers, rearrange their 
drawing order, and modify the map 
display properties. 

 

Figure 3.12 Layer Selector Dialog   
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• From the Maps menu, select Add Map Layer.  The Open File dialog (Figure 3.13) 
will open.  

• Locate the map file you wish to use on your local computer (for example, 
“np_shed.shp”). 

• After you have selected the map you wish to use, click OK.  The new map will 
now appear in the Layer Selector dialog. 

 

Figure 3.13 Open File Dialog to Add Map Layer 

3.3.2 Setting the Geographic Coordinate System 

To maintain a geographic reference, you must specify a coordinate system for each 
watershed.  To establish the grid size and coordinate system: 

• Select Layers from the View menu to open the Layer Selector dialog. 

• From the Maps menu, select Map Display Coordinates to open the Display 
Coordinates dialog (Figure 
3.14). 

The Display Coordinate 
Information dialog includes the 
following data:  

Coordinate System 
This box identifies the 
coordinate system 
established for the 
watershed.  The coordinate 
system can be edited, but 
remember that all maps and data must exist in one unified coordinate system.  

 

 Figure 3.14 Display Coordinates Dialog 
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Therefore, some layers or data might require the use of a GIS program to 
transform coordinate system information.  For additional information about 
editing the Coordinate System, see “Editing the Coordinate System” paragraph 
below. 

Extents 
The Easting Minimum & Maximum and the Northing Minimum & Maximum 
values indicate the location of the left, right, top and bottom borders of the grid 
in the display area.  ResSim displays coordinates in the Status Bar as you move 
the cursor within the map display panel. 

Grow to Map Extents 
When you check this box, ResSim automatically sets the geographic region to 
define the smallest rectangle that encompasses all the objects (maps, icons, 
alignments, etc.) in the display area.  If you add any objects to the watershed that 
lie outside the geographic region, ResSim automatically updates the extents to 
include the new objects. 

3.3.3 Setting Map Coordinates to Display 

If the extent of your model schematic covers only a small portion of the extent of 
your map layers, you can automatically set the geographic extents of the Map Display 
area to the coordinates in your current view.  Here’s how: 

• First, zoom in or out in the display area until the Map Display shows only your 
model schematic (with a little bit of margin),  

• Next, open the Display Coordinate Information dialog from the Layer Selector 
and click Set Map Coordinates to Display.  ResSim will set the maximum view 
extents of the Map Display area to the current view extents.   

• Click OK to save your selection and close the dialog. 

To return the view to the extents covered your map layers: 

• Check the box labeled Grow to Map Extents then click the OK button. 

3.3.4 Editing the Coordinate System 

You can edit the Coordinate System of the Watershed by selecting Edit in the 
Geographic Region dialog.  This opens the Map Coordinate Information dialog, where 
you can configure the System, Units, Spheroid, and other system-specific data.  See 
Appendix B for more information on configuring map coordinate information.  

 

You must specify the geographic extents of your watershed carefully to 

ensure that all map layers in your watershed setup are included.  The 

extents you specify and the coordinate system you use must be consistent 

for all layers in the watershed.  You should use GIS tools to transform map 

layers from one coordinate system to another before you use them in 

ResSim. 
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3.4 Watershed Configurations 

Before you begin to create the watershed schematic for your model (by establishing the 
stream alignment and adding projects and computation points), you should create a 
Watershed Configuration. As you learn more about configurations in this section, it may 
seem as though creating a configuration at this point is too early but doing so facilitates 
the ease of later steps.  In addition, learning about configurations early will help make 
other concepts regarding reservoir networks and configurations clearer. 

A Watershed Configuration is a specific physical arrangement of projects that will later be 
used as a template to create a reservoir network model.  Configurations should be 
created to reflect particular watershed conditions (physical arrangement of projects) 
needed for your study.  For example, you might create a configuration named Existing 
Conditions and another named With Project Conditions in which one or more projects 
have been added or removed with respect to the Existing Conditions configuration.  

Configurations can be used in both real-time and planning contexts, although fewer 
configurations are usually needed to identify the set of projects to be modeled by real-
time alternatives.   

To create or edit watershed configurations, you must be in the Watershed Setup module 
and you must lock the configuration for editing: 

• If necessary, select Watershed Setup from the Module selector on the Module Bar 

• Click the Lock  button on the Module Toolbar (so that it appears locked) OR select 
Allow Editing from the Edit menu. 

3.4.1 The Configuration Editor 

The Configuration Editor (Figure 
3.15) is used to create, edit, and 
delete configurations.  To open 
the Configuration Editor: 

• Select Configuration Editor… 
from the Watershed menu. 

  

 

Figure 3.15 Configuration Editor 
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3.4.2 Creating Configurations 

To create a new configuration: 

• In the Configuration Editor, select New from the Configuration menu.  The Create 
a New Configuration dialog (Figure 3.16) will open. 

• Enter a Name and an optional Description for your configuration. 

• Select a configuration Time 
Step.  This timestep is not 
used by ResSim but it may 
be used by another program 
that shares the watershed 
such as CWMS or HEC-WAT.  
Select a timestep that you 
believe will be the typical 
timestep used by the 
alternatives you plan to 
develop in this watershed. 

• Click OK to close the Create a New Configuration dialog and complete the 
configuration creation process.  The Configuration Editor, Figure 3.17, will open. 

• The name of the new configuration will appear in the Name field of the 
Configuration Editor, as will its Description and Time Step in their associated 
fields. 

Figure 3.17 Configuration Editor 

• Any project configuration element added to the watershed and flagged as an 
Existing Project (Section 5.2.4) before you created the new configuration, will 
automatically be included in the Projects table.  To add projects to the 
configuration (that are not flagged as Existing) see Section 3.4.3 below. 

Figure 3.16 Create a New Configuration 
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3.4.3 Adding and Removing Projects from a 

Configuration 

As you set up your watershed and manage it over time, you may need to add or 
remove projects from the configurations you have created.  To do this: 

• In the Configuration Editor, select the configuration you want to edit from the 
Name dropdown list (selector). 

• From the Projects menu, select Edit Project List (Figure 3.18). 

Figure 3.18 Configuration Editor—Projects Menu 

• The Project Selector (Figure 3.19) will open.   

• The Project Selector displays the active configuration’s Name and Description for 
reference.  Below the Description are two list panes with some buttons in 
between. The left pane lists the Available Projects that are not already associated 
with the active configuration.  The Projects in Configuration pane on the right 
lists the projects that are currently associated with the active configuration.  Use 
the buttons in the middle to add or remove projects from the active 
configuration by moving them from one pane to the other.  

• Click OK to save your changes and close the Project Selector dialog. 

Figure 3.19 Configuration Editor—Project Selector 
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3.4.4 Setting the Configuration’s Base Date 

Once you have created a configuration, you can optionally associate a Date with it.  
The Base Date field is used by some HEC applications (e.g., HEC-FIA) that may share 
the watershed, particularly in a planning context.  You can either type the date into 
the field in the appropriate format (e.g., 01Feb2002) or use the Calendar Tool (Figure 
3.20). 

To use the Calendar Tool to specify a Base Date: 

• In the Configuration Editor, click the  button to the 
right of the Base Date field.  The Calendar Tool will 
appear. 

• Select the month and year by clicking the left and right 
arrows to navigate backwards and forwards.  Select the 
day by clicking on the appropriate day in the month 
panel. 

• Click OK to accept the date you have selected and 
close the Calendar tool.  The date you selected will 
appear in the Base Date field of the Configuration 
Editor. 

3.4.5 Adding Project Notes to a Configuration 

Project notes within a Configuration are comments that pertain specifically to a 
project in a particular Configuration.  Although ResSim does not use these project 
notes, they may be useful to one of the models that share the watershed.  

To Add or Edit project notes within a Configuration: 

• In the Configuration Editor, select the configuration of interest from the Name 
selector.   

• Select a project from the list on the Projects tab.  

• Select Project Notes from the Edit menu.  The Project Notes Editor will open 
(Figure 3.21). 

Figure 3.21 Project Notes Editor 

• In the Configuration Notes textbox, enter configuration-specific notes as needed. 

• Click OK to apply your changes and close the Project Notes Editor. 

Figure 3.20 Calendar Tool 
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3.4.6 Copying a Configuration 

Sometimes you might want to make an exact copy of an existing configuration and 
then make some changes to it so you have a different configuration.  To make a copy 
of a configuration: 

• In the Configuration Editor, select the configuration you want to copy from the 
Name selector.   

• Select Save As… from the Configuration menu. The Save As… dialog (Figure 3.22) 
will open.  

Figure 3.22 Configuration Menu—Save As... 

• The Name field contains the name of the selected configuration.  Replace this 
name with a new one and enter/edit the description. 

• Click OK to complete the creation of the new configuration and close the Save 
As… dialog.  The name of your new configuration will be displayed in the Name 
field/selector of the Configuration Editor. 

3.4.7 Deleting a Configuration 

To delete a configuration: 

• In the Configuration Editor, select the configuration you want to delete from the 
Name selector.   

• Select Delete from the Configuration menu. 

• A confirmation dialog will open asking you if it’s ok to delete the configuration. 
Click Yes to complete the deletion and close the confirmation dialog.  No will 
cancel the delete.  

3.4.8 Saving Configuration Data 

To save the data you have defined for your configuration(s): 

• Close the Configuration Editor and choose Yes when prompted to “Save/Apply 
Changes?”  This saves you change in memory.  Then, 

• Select Save Configuration from the Watershed menu of the Watershed Setup 
module. This will cause the ResSim to save all configuration specific data to disk. 
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3.4.9 The List of Configurations Report 

Once you have all your configurations defined, you might like to review the basic 
data for the configurations in your watershed.  In the Reports menu of the 
Watershed Setup Module is a report, called List of Configurations, which contains this 
information. 

To view the List of Configurations report (Figure 3.23): 

• Select List of All Configurations from the Reports menu of the Watershed Setup 
module. 

Figure 3.23 List of Configurations Report 

• This report provides a list of the configurations that have been defined for the 
watershed.  Data included in the list are the Name, Description, Time Step, and 
Base Date specified for each configuration. 

• From the File menu of the report, you can send the report to a printer or export 
it to a text file.  See Appendix E for details about printing and exporting tabulated 
data. 

• Click Close to close the List of Configurations report.
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Chapter 4 

Defining the Stream Alignment 

The Stream Alignment represents the river system of the watershed.  It indicates where 
confluences and bifurcations occur and provides a sense of distance and scale.  It also 
imposes a flow direction for reaches and reservoirs that are created with respect to it.   
Figure 4.1 shows the stream alignment created for one of the example watersheds that 
are provided with ResSim. 

 

  Figure 4.1 Stream Alignment 

The Stream Alignment is made up of streams, stream nodes, and stream junctions. Figure 
4.2 illustrates these components of the Stream Alignment.  Although you can change the 
drawing properties of the elements of the stream alignment, by default, streams are 
drawn in orange, stream nodes in dark green, and stream junctions are symbolized by a 
bright green halo around a stream node. 

  

Figure 4.2 Stream Alignment Conponents 

A stream in the stream alignment is defined by an ordered set of points or vertices that 
ResSim connects with straight line segments to form a “polyline”. The Stream Alignment 
Tool is used to draw and edit streams in the Stream Alignment.  When you create a 
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stream, you will draw it, from upstream to downstream, as a series of points. Figure 4.3 
illustrates the points and line segments that define a stream in the stream alignment. 
NOTE: Each stream should be a continuous element that represents a named 
watercourse in the river network; a river should not be broken up into discrete streams 
(reaches) at each confluence. 

For each stream you create, ResSim will create 
two stream nodes and place them on the stream, 
one at the upstream-most end of the stream and 
one at the downstream-most end. When you 
connect one stream to the middle of another 
stream, ResSim will add an additional stream 
node to the existing stream at the point of 
connection. That connection, usually representing 
a confluence of two streams, is referred to as a 
stream junction and is denoted by the bright 
green halo around the stream node(s). Each 
stream junction contains a stack of at least two 
stream nodes, one for each stream entering 
and/or leaving the junction. Stream nodes and 
stream junctions are managed using the Stream 
Node Tool in the Watershed Setup module. 

ResSim applies stream stationing to each stream 
in the stream alignment. By default, the stationing 
of a stream starts at zero at the downstream end 
and increases upstream along the stream as an 
accumulation of the lengths (in the watershed 
coordinate system and units) of the line segments 
that describe the stream. The stream stationing is 
reflected in the drawing of the stream alignment with tic marks and tick mark labels.  You 
can override the default stationing by editing the station values of the stream nodes at 
the upstream and downstream ends of the stream element.  You can also add additional 
stream nodes along the stream and override their default station values, thereby 
imposing a “piece-wise” stationing between each pair of stream nodes. 

To work with the stream alignment in any way, you must be in the Watershed Setup 
module and you must lock the configuration for editing: 

• Select Watershed Setup from the Module selector on the Module Bar 

• Click the Lock  button on the Module Toolbar (so that it appears locked) OR select 
Allow Editing from the Edit menu. 

  

Figure 4.3 Visualization of a Stream 
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4.1 Defining the Stream Alignment 

You have two options for defining the stream alignment.  You can: 

1. Digitize (draw) each stream by hand  

2. Import your stream alignment from an ArcView® shapefile. 

Although it is not necessary, you may find it useful to display a background map of the 
river system as a guideline for drawing the streams for your stream alignment.  If your 
stream alignment is going to be imported from a shapefile, that shapefile should already 
have been included as a map layer in the watershed.  See Section 3.3 or Appendix B to 
learn how to add map layers to your watershed.   

To be useful as a guide for drawing the stream alignment, the map layer should contain 
water features, such as stream channels and reservoirs or lakes.  Also, by adding at least 
one background map layer to the watershed, you have implicitly established the 
coordinate system and units of the watershed;   the stream stationing of your stream 
alignment will be determined using in the watershed coordinate system and units. See 
Chapter 3 for more information about specifying the watershed coordinate system and 
units. 

4.1.1 Drawing the Stream Alignment 

The following are the steps for digitizing a stream alignment. (See Section 4.1.2 for 
details on importing the stream alignment.) 

To create a stream in the stream alignment: 

• Select the Stream Alignment Tool  from the Toolbar. 

• Determine an upstream location where you want to start a stream element.   

• Hold down the Ctrl key.  Starting at the upstream end, draw the first vertex of the 
stream element by clicking the left mouse button.  

• While continuing to hold down the Ctrl key continue moving the cursor 
downstream and clicking the mouse button to place more vertices and thus draw 
more of the stream element (Figure 4.4) 

Figure 4.4 Drawing a Stream Element 
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• To place the last point of the stream, release the Ctrl key, then click at the last 
downstream location.  An ending stream node will be created at the last point of 
the stream element. 

• The Create New Stream 
dialog (Figure 4.5) will open 
after you place the last 
point of your stream.  Enter 
a name (and an optional 
description) for the stream 
element, then click OK to 
close the Create New 
Stream dialog. 

• Repeat these steps to add more stream elements to your stream alignment. 

To create a Stream Junction at a confluence (or bifurcation):  

• Place the last (or first) point of the stream you are drawing directly on an existing 
stream.   

• After naming the new stream, the Connect Stream Reaches dialog (Figure 4.6) 
will appear.  You must determine whether you want to connect the new stream 
to the existing 
stream.  Click Yes if 
you want the two 
stream elements 
connected. If you 
selected No, and if 
there are other 
existing streams that 
are possible candidates for connecting your new stream element to, then a 
subsequent Connect Stream Reaches dialog will appear to give you the 
opportunity to connect to the next existing 
stream. 

• When multiple stream elements are connected 
(e.g., at a confluence), a stream junction is 
automatically created.  A stream junction looks 
like a stream node highlighted with a bright 
green circle (a “bright green halo”) as shown in 
Figure 4.7. 

• Once you have completed the creation of your 
stream alignment, save your work.  From the 

Figure 4.5 Create New Stream 

 

When drawing the stream of your stream alignment… 

▪ Draw the mainstem (primary river) of your watershed) first. 

▪ Draw the major tributaries (of the mainstem) next. 

▪ Then draw the minor tributaries (of the major tributaries), etc. 

Figure 4.6 Connect Stream Reaches 

Figure 4.7 Stream Junction 
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File menu, select Save Watershed and the stream alignment for your watershed 
will be saved. 

4.1.2 Importing a Stream Alignment 

Since creating and editing the stream alignment is a Watershed Setup activity, the 
stream alignment Import feature is only available in the Watershed Setup Module. It 
can be found in the Watershed menu in a submenu under the Import option. 

The Importer can only import streams from an ArcView® shapefile containing 
polylines that represent the stream system of your watershed.  The polylines in the 
shapefile must have an attribute that is the name of each stream, and each stream 
must form a single contiguous line. In addition, the Importer has been designed to 
look for appropriate shapefiles from the active map layers of your watershed.  
Although not required, before importing, you should first add the shapefiles that 
represent the centerlines of the rivers and creeks of your watershed as map layers 
and make them active.  Refer to Chapter 3, Section 3.3.1 for instructions on “Adding 
a New Map Layer” to your 
watershed.   

To import a stream 
alignment: 

• You must be in the 
Watershed Setup 
module.   

• If you haven’t already, 
use the Layer Selector 
(View menu) to add the 
relevant shapefile as a 
map layer and make it 
active (check it on). 

• From the Watershed 
menu, select Import, 
and then select Stream 
Alignment from the 
Import submenu. 

• The Import Stream 
Alignment dialog 
(Figure 4.8) will open. 

• The Shapefile Name 
selector (drop-down list) should show the name of one of the active line 
shapefile map layers that have been added to your watershed. If the first entry is 
not the desired shapefile, select the correct one from the drop-down list.   

Note: if the desired shapefile is not in the Shapefile Name selection list, then it is 
not an active map layer in the watershed.  However, you can still import from a 
shapefile that is not a map layer in the watershed: 

Figure 4.8 Stream Alignment Importer 
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o From the File 
menu of the 
Importer, select 
Choose Shapefile. 
The Choose 
Shapefile dialog 
(Figure 4.9) will 
open.  Browse to 
the folder 
containing the 
shapefile you want 
to add, select it, 
and click OK. 

• Once the correct shapefile has been chosen, select the appropriate attribute that 
identifies the individual streams from the Database Field Name selector. This is 
typically a “name” attribute or field. 

• The Importer automatically searches for an attribute of Stream_ID; if it doesn’t 
find one, it will select the first attribute in the selection list by default.  You 
should review the available attributes in the selection list to find the one that 
contains the names of each stream. 

• The table below the Database Field Name selector will fill with the values of the 
selected Database Field Name (attribute).  Hopefully, these values will reflect the 
names of the streams in your watershed.  

• If the polyline(s) identified by each displayed attribute value forms a single 
contiguous line, then the checkbox in the Import column of the table will be set 
(checked).  If there is something wrong with the line that represents a stream, 
the checkbox will not be set, and ResSim will not import that stream element.  

• The Gap Tolerance (Figure 4.8) value is used to enable the Importer to create 
stream junctions (connections) between connect stream elements that have a 
gap between the end point of one stream and the nearest line segment or 
endpoint of another stream. By default, the Gap Tolerance is set to zero (0.0), so 
ResSim can only connect streams where the endpoint of one stream is exactly 
coincident with a stream segment or vertex of another stream.  If you click Gap 

Figure 4.9 Choose Shapefile for Importing Stream Alignment  

 

You can view the streams before Importing!!! 

▪ Move the Import Stream Alignment dialog (the Importer) so that it 

doesn’t overlap the main ResSim window. You need to be able to 

see the Map Display Area.   

▪ Click (select) a row in the table of attribute values.   

▪ The polyline(s) identified by the attribute value in the selected row 

will highlight in red in the Map Display.  Even polylines that the 

Importer has identified as “non-contiguous” and won’t import can 

be highlighted in this manner—making them easy to identify and 

review. 

Note: Only active map layers are visible in the Map Display so you 

cannot view streams from a shapefile you have selected with the 

Choose Shapefile browser opened from the Importer’s File menu. 
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Tolerance, then you need to enter a value larger than zero in the Gap Tolerance 
box, which will allow ResSim to connect streams that might have a larger gap 
between them. 

• The Replace Existing Stream Alignment box, allows you to replace the existing 
stream alignment with the one being imported from the selected ArcView® 
shapefile. 

• Once everything is set, click Import.  The stream alignment will be automatically 
drawn in the display area.  From the File menu, choose Close and the Import 
Stream Alignment dialog (Figure 4.8) will close. 

4.2 Editing the Stream Alignment 

After drawing a stream alignment in the display area, there are many options available 
for revising your stream alignment.  To edit your stream alignment, you must be in the 
Watershed Setup Module.  The Zoom Tool can be used to help magnify the stream 
network, thus providing more detail to make editing the stream alignment easier. 

This section describes the following capabilities for editing your Stream Alignment: 

• how to refine and re-shape your stream alignment (by moving/adding/deleting 
vertex points of the stream elements) 

• how to review stream stationing and provide a stream element description (by using 
the stream element editor) 

• how to rename and delete stream elements 

• how to add and edit stream nodes (for defining stream stationing) 

• how to move and edit stream junctions 

• how to reverse the flow direction of a stream element 

• how to disconnect a stream element 

 

Since the Stream Alignment may be referenced by other models, care should be 

used when making any changes to it. 
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4.2.1 Reshaping a Stream 

Reshaping a stream means that you must reposition 
(move) the vertices that form the stream element. 

To move a vertex of an existing Stream Element: 

• Using the Stream Alignment Tool , double-
click on the stream you want to reshape.  The 
stream you selected will turn red and all the 
vertices of that stream element will turn blue. 

• Click on the vertex you want to move, and drag it 
to a new location, as illustrated in Figure 4.10. 

4.2.2 Adding Vertices to a Stream  

To add a vertex to an existing stream element: 

• With the Stream Alignment Tool  selected, double-click on the stream so that 
the vertices are visible—they should appear as blue dots. 

• Place the pointer on the selected stream where you want to add a vertex.  Hold 
down the Ctrl key and click.  A new blue dot will appear on the selected stream 
where you have added a new vertex. 

4.2.3 Deleting Vertices from a Stream  

To delete a vertex from an existing stream element: 

• With the Stream Alignment Tool  selected, double-click on the stream so that 
the vertices are visible—they should appear as blue dots. 

• Hold down the Shift+Ctrl keys and click on the vertex point to be deleted.  The 
blue vertex point will disappear from the stream element, and the stream will 
straighten between the two adjacent vertices. 

Figure 4.10 Reshaping a Stream 
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4.2.4 The Stream Editor 

A Stream Editor (Figure 4.11) is not really an editor but rather a report that shows the 
list of nodes that belong to the stream and their positions. The nodes and their 
positions are not editable from 
the table. The only editable 
field on this editor is the 
Description.  

To open the Stream Editor: 

• Using the Stream 

Alignment Tool , right-
click on the stream you 
want to edit. 

• Select Edit Stream Element 
from the context menu (Figure 4.12) to open the Stream Editor. 

The Stream Editor fields include: 

Name: This is the name of the stream element you selected.  However, you can 
view information for any stream in the Stream Alignment by either 
selecting it from the Name selector or by using the left and right arrows 
(navigator buttons) to click through the 
available streams. 

 

Description: To edit the Description of the stream, 
you can type directly into the textbox or 

click the  button at the end of the 
Description textbox to access the larger 
Enter Description dialog (Figure 4.13).  

Node List:  the table below the Description is the 

Node list.  It lists the nodes from upstream to downstream and shows 
the Station, Easting, and Northing of each node. Since the position of the 
nodes cannot be edited from the Stream Editor, use the Stream Node 
Editor (described in Section 4.2.8) to edit the stream stationing of the 
nodes. 

 

Figure 4.11 Stream Editor 

 

Figure 4.12 Stream Alignment 
Context Menu 

 

Figure 4.13 Enter Description Dialog 



Chapter 4 - Defining the Stream Alignment HEC-ResSim User’s Manual 

4-10  

4.2.5 Renaming a Stream Element 

To rename a stream element: 

• Using the Stream Alignment Tool , right-click on the stream element. 

• Select Rename Stream Element 
from the context menu. 

Enter a new Name (and optional 
Description) for the stream element 
in the Rename Stream dialog (Figure 
4.14). 

4.2.6 Deleting a Stream Element 

To delete a stream element: 

• Using the Stream Alignment Tool , right-click on the stream element. 

• Select Delete Stream Element from the context menu. 

• When the confirmation message appears (Figure 4.15), select Yes to delete the 
stream or No to cancel the delete. 

4.2.7 Inserting a Stream Node 

By default, ResSim generates beginning and ending stream nodes for each stream 
element.  Also, stream nodes are automatically created where stream elements 
connect (stream junctions).  Since stream nodes are used for establishing the stream 
stationing, you may want to include additional stream nodes along your stream 
element for locations where you want to define specific stream stationing. 

To insert a stream node on an existing Stream Alignment: 

• Using the Stream Node Tool , hold down the Ctrl 
key and right-click on the Stream Alignment in the 
place where the stream node is to be inserted. 

• When you right-click on the stream station node, a 
context menu appears (Figure 4.16). 

• From the context menu on the stream node, you can 
choose Edit Node, which will bring up the Stream Node Editor illustrated in 
Figure 4.17. 

 

Figure 4.14 Rename Stream 

 

Figure 4.15 Confirmation Message when Deleting a Stream Element 

Figure 4.16 Stream Node 
Context Menu 
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4.2.8 Editing a Stream Node 

The Stream Node Editor (Figure 4.17) displays the location information for the node.  
The Easting and Northing are for your information only and should not be edited.  
The Station is the distance in map units of the stream node from the downstream-
most end of the stream element. 

Use Default Stationing—this check box is checked by default.  When checked, the 
station of the node is not editable.   

If you want to specify the station (distance) for the node on the stream 
element, then uncheck the Use Default Stationing checkbox.  This will make 
the Station field editable. Enter the relative distance (from the downstream 
end of the stream element) of the node directly into the Station field, then 
click OK.  

NOTE—changing the station of a stream node does not change the node’s 
position along the stream element.  Instead, it changes the relative 
(piecewise) stationing of the stream element. 

4.2.9 Deleting a Stream Node 

Since stream nodes define the stream stationing that may be referenced by other 
models, care should be used when deleting stream nodes. 

To delete a stream node from an existing Stream 
Alignment: 

• Find the stream node you wish to delete. 

• Using the Stream Node Tool , right-click on the 
stream node. 

•  Select 
Delete Node 
from the 
context 
menu. 

• A Confirm 
Delete 
message will 
display (Figure 4.18) asking you whether you really 
want to delete the selected stream node. 

• Click Yes and the message will close, and the stream node will be deleted from 
the stream element. 

 

Remember: other models that share the watershed (e.g., HEC-FIA) may use the 

same stream alignment, so be sure to confirm with other modelers before 

making any changes to the stream alignment including deleting and re-

stationing streams. 

Figure 4.17 Stream Node Editor 

 

Figure 4.18 Confirm Delete Dialog 
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4.2.10 Moving a Stream Junction 

When two stream elements intersect (e.g., at a 
confluence), a Stream Junction is automatically created.  
A stream junction represents multiple stream nodes at 
one location and is drawn in the Map Display with a dark 
green dot surrounded by a bright green halo (Figure 
4.19).  Although ResSim generates default stream 
junctions when you connect one stream to another in 
the Stream Alignment, you can move them as needed. 

To move a Stream Junction along an existing Stream 
Alignment: 

•  Using the Stream Node Tool , double-click on the 
stream junction.  The stream junction will turn dark 
green and will have small squares called move handles 
at each corner (Figure 4.20). 

• Drag the stream junction along the (downstream) 
stream element to its new position. 

4.2.11 Editing a Stream Junction 

 To specify the stream stationing of the stream nodes at a Stream Junction: 

•  Using the Stream Node Tool , right-click on 
the Stream Junction to access its context menu 
(Figure 4.21). 

• Select Edit Node to open the Stream Junction 
Editor (Figure 4.22). 

The Stream Junction Editor displays the list of 
Stream Nodes associated with a stream junction 
and allows you to edit the stationing of each of 
the nodes by deselecting the “Use Default 
Stationing” box and entering the desired station.  Did you notice that the Stream 
Junction Editor is a just a special form of the Stream Node Editor? 

 

Figure 4.22 Stream Junction Editor 

Figure 4.19 Stream Junction 

Figure 4.20 Stream Junction 
with Move Handles 

 

Figure 4.21 Stream Node 
Context Menu 
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4.2.12 Deleting a Stream Junction 

Occasionally, due to user or software error, a stream junction is created connecting a 
stream to the wrong stream at the confluence.  To delete the stream junction, you 
simply need to disconnect the stream that ends (or begins) at the junction.  See 
Section 4.2.14 for details. 

4.2.13 Reversing the Direction of a Stream 

If you find that you have inadvertently drawn your stream element in the wrong 
direction (i.e., downstream to upstream when it should be upstream to 
downstream), don’t and redraw it; reverse it.  To reverse the direction of a stream 
element: 

• Using the Stream Alignment Tool , right-click on the stream element and 
select Reverse Direction from the context menu. 

• A warning message (Figure 4.23) will open asking you whether you really want to 
reverse the direction of the stream element. 

 

Figure 4.23 Confirm Reverse Direction of Stream Element 

• Click Yes. The warning message will close, and the stream element’s direction will 
be reversed. 

4.2.14 Disconnecting a Stream Element 

One stream element can may connect to another stream element at a Stream 
Junction (the confluence of two streams).  If, for some reason, you need to 
disconnect one stream element from another, you can do so. 

To disconnect a stream element from another stream element: 

• Using the Stream Alignment Tool , right-click on the stream element you want 
to disconnect and select either Disconnect Upstream or Disconnect Downstream, 
as appropriate, from the context menu (Figure 4.23). 

• The stream element will now be disconnected from the other stream element 
(Figure 4.24).  In the display area, the end of the disconnected stream will be 
drawn a short distance away from the stream node where the stream junction 
had been and the stream junction (bright green halo) will disappear, leaving 
behind a stream  
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node where the stream junction had been.  The 
stream node that was left behind is innocuous, 
but if you wish to remove it, see Section 4.2.9 
above. 

4.3 The Stream Alignment 

Properties Editor 

You can change the drawing properties of the Stream 
Alignment using the Stream Alignment Properties 
editor.  Refer to Appendix B, Section B.7 for a detailed 
description of the Stream Alignment Properties editor. 

To open the Stream Alignment Properties editor: 

• From the View menu, select Layers. The Layer 
Selector will open. 

• Right-click on the Stream Alignment layer in the 
Layers tree.   

• From the context 
menu, select 
Properties. 

• The Stream Alignment 
Properties editor 
(Figure 4.26) will 
open.  

4.4 Saving the 

Stream 

Alignment 

Since creating a stream 
alignment can be a very 
detailed activity, you 
should save it frequently 
during its creation.  From 
the File menu, click Save 
Watershed.  This 
command will save all the stream alignment properties and the appropriate files created 
and used by ResSim for the stream alignment. 

 

Figure 4.24 Stream Alignment—
Context Menu 

 

Figure 4.25 Disconnected Streams 

Figure 4.26 Stream Alignment Properties  
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4.5 Exporting the Stream Alignment 

If you have digitized a stream alignment by hand, you might want to save that stream 
alignment as an ArcView® shapefile.  To export a stream alignment, you must have a 
stream alignment in the display area. 

To export a stream alignment: 

• From the Watershed menu, select Export, and then select Stream Alignment from 
the Export submenu. 

• A Save File browser (Figure 4.27) will open.   

• Enter a name in the File Name box.  Click OK, the Save File browser will close, and 
you will have an ArcView® shapefile of the displayed stream alignment. 

4.6 The List of Streams Report 

Once you have your stream alignment completed, it’s a good idea to review the streams 
in your stream alignment.  The List of Streams report, accessible from the Watershed 
Setup Module, contains this information. 

• From the Reports menu, select List of Streams.  A report similar to the one shown in 
Figure 4.28 will appear. 

Figure 4.27 Save File Browser 
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Figure 4.28 List of Streams in Stream Alignment 

• This report provides a list of streams and their descriptions that have been defined in 
the Stream Alignment. 

• Select Print from the File menu to print the report 

• Select Export from the File menu to save the report as a tab-delimited text file. 

• Select Close from the File menu or the X in the Title Bar to close the List of Streams 
report. 
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Chapter 5 

Watershed Schematic Elements 
In the Watershed Setup Module you can define the Watershed Schematic Elements 
(Projects, Computation Points, and Impact Areas) used by ResSim and by other models 
that may share the watershed. 

The ResSim Map Toolbar provides the tools for drawing and editing the geographically-
referenced schematic elements in the Map Display area. The drawing tools also provide 
access to context menus for managing the schematic elements directly from the map 
display.   

When you add a Project (reservoir, diversion, etc.) to the Map Display, it becomes part of 
the active configuration (the one displayed in the Configuration selector on the Module 
bar). A “superset” of all configurations is named Study and includes all of the Projects for 
the watershed; although not technically a configuration, if you have not created a 
configuration, Study will be selected as the active configuration by default.  For more 
information on associating projects with Configurations, refer to Section 5.2.4. 

Of the array of available watershed schematic elements, ResSim models only use 
computation points, reservoirs, and diversions so these configuration elements will be 
covered first.  Creating the other schematic elements will be described later in this 
chapter. 

To create or edit the watershed schematic elements you must be in the Watershed Setup 
module and you must lock the configuration for editing: 

• Select Watershed Setup from the Module selector on the Module Bar 

• Click the Lock  button on the Module Toolbar (so that it appears locked) OR select 
Allow Editing from the Edit menu. 

5.1 Computation Points 

Computation Points are locations where time-series information will be computed for 
possible exchange between models (e.g., ResSim and FIA).  ResSim automatically 
generates computation points when projects are placed on the Stream Alignment so you 
should create computation points at locations that are not project related such as inflow 
and gage locations, control points, and confluences. 

5.1.1 Drawing Computation Points 

To draw a Computation Point: 

• Using the Computation Point Tool , hold down the Ctrl key and click at the 
desired location on the Stream Alignment where you want a computation point.  

• A Name… dialog will appear (Figure 5.1).  Enter a Name for the computation 
point and an optional Description.  When you are finished, click OK.  
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Figure 5.1 Name New Computation Point Dialog 

The new computation point will appear in the Map Display.  By default, computation 
points snap to the Stream Alignment.  If you prefer that the computation point not 
exist on the Stream Alignment, de-select the Snap to Stream Alignment check box in 
the Computation Point Properties Editor. 

5.1.2 Importing Computation Points 

Another way to create computation points is to import them from a point shapefile.  
The shapefile must be an active map layer in the watershed.  To import computation 
points: 

• From the Watershed menu, select Import, then select Computation Points … 
from the Import submenu.  The Import Computation Points importer will open 
(Figure 5.2). 

• Select the attribute in the Database Field Name selector that identifies the 
individual computation points.  The table will fill with information about the 
points in the shapefile including the value of the selected attribute in the 
Name column, the stream in the Stream Alignment that it will import to, 
whether the point is at a stream junction in the Stream Alignment, and its 
stream station.   

• The Import column in the table is for you to edit—use it to select or de-select 
the point you want imported.  If you want them all, click Import All. 

• Like the Stream Alignment Importer, you can locate the individual 
computation points on the map by selecting them in the list.  The selected 
point will highlight in Red on the Map Display. 

New 
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• Once you have identified which points to import, click Import. The Importer 
will close, and you will get a message box telling you how many computation 
points imported (Figure 5.3). 

Figure 5.3 Successful Import Message 

5.1.3 Editing Computation Point Data 

Use the Computation Point Editor to edit a Computation Point: 

• Using the Computation Point Tool , right-click on the computation point.  

• Select Edit Computation Point from the context menu.  The Computation Point 
Properties Editor (Figure 5.4) will appear.  

The Computation Point Properties Editor displays information associated with a 
Computation Point and allows you to edit its location information. 

Figure 5.2 Computation Point Importer 
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Figure 5.4 Computation Point Editor 

Computation Point Name—The Computation Point Editor displays the name of the 
Computation Point you have selected (in the list along with all available 
Computation Points in the watershed).  Also, left and right arrows allow you 
to click through the Computation Points in the watershed.  

Description—To edit the Description of the computation point, click in the text box 

and start typing or click the  button to access the larger Enter Description 
dialog.  

Stream Name—The stream name automatically appears in the Stream Name box.  In 
the case of a computation point situated at a confluence of two streams, you 
need to verify that the computation point resides on the appropriate stream. 

Label Position—ResSim automatically positions the text label for a computation point 
where it is least likely to overlap other labels.  However, you can move the 
position of the layer by selecting a position from the Label Position list.  

Location Information—The following allow you to provide location information. 

Stream Station—The Stream Station field displays the location of the 
computation point along the stream element. 

Easting / Northing—ResSim automatically fills in the coordinate information.  
You may type in new coordinates to relocate the computation point 
on the map display. 

Location ID—Optionally, you can enter a Location ID to reference the 
computation point to a ResSim ID. 

Snap to Stream Alignment—By default, each time you can draw a 
computation point, it will snap to the nearest stream in the Stream 
Alignment.  If a computation point is snapped to the stream 
alignment, only the Stream Station of its location information can be 
edited. If you want the point located off-stream, uncheck this 
checkbox.  An off-stream computation point does not have a valid 
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Stream Station, but its Northing and Easting values can be edited to 
move the point to the exact position you desire. 

System Generated—ResSim automatically generates computation points for 
the watershed when you create certain project elements.  The 
System Generated checkbox will be checked if the computation point 
has been generated with a project element.  This checkbox is not 
editable.  If checked, the relevant project should be listed in the 
Associated Project field. 

5.1.4 Renaming a Computation Point 

To rename a Computation Point or edit its description: 

• Select the Computation Point Tool  and right-click on the Computation Point. 

• Select Rename Computation Point… 

• Use the Rename dialog (Figure 5.5) to edit the Name and Description.  Click the 
 button to access the Enter Description dialog for longer descriptions. 

Figure 5.5 Rename Computation Point 

5.1.5 Deleting a Computation Point 

To delete a Computation Point: 

• Select the Computation Point Tool  and right-click on the Computation Point. 

• Select Delete Computation Point from the context menu.  The Confirm Deletion 
dialog will appear. 

• Click Yes to confirm the deletion. 
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5.2 Reservoirs 

5.2.1 Drawing a Reservoir Element 

A reservoir is created by using the Reservoir Tool  to draw it from upstream to 
downstream on the stream alignment. As soon as a reservoir has been drawn, 
several visual elements will appear that represent the reservoir (Figure 5.6).  These 
elements include:  

• a storage reach (cyan),  

• a pool (cyan triangle),  

• a dam (small gray rectangle),  

• and 2 or more computation 
points (black dots) at the 
upstream and downstream end 
of the reservoir on the stream 
alignment. 

To add a reservoir to the watershed: 

• Select the Reservoir Tool  

• Press the Ctrl key and click on the stream alignment at the upstream extent of 
the reservoir pool.  If more than one stream flows into the reservoir pool, 
continue pressing the Ctrl key and click at each location of inflow into the 
reservoir on each inflowing stream. 

• Release the Ctrl key and click on the stream alignment where the dam is located.  
This is the downstream extent of the reservoir.  Note: When drawing a reservoir, 
do not overlap or encompass existing computation points. 

• The Name New Reservoir dialog will appear (Figure 5.7). 

• Name the Reservoir by entering a name in the Name field.  Optionally, you can 
also enter a Description for the Reservoir. Click OK when you are done.  The new 
Reservoir will appear in the Map Display as illustrated in Figure 5.6. 

Figure 5.7 Name New Reservoir 

 

Figure 5.6 Basic Reservoir Element 
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5.2.2 Reshaping a Reservoir’s Pool 

The pool of a reservoir is represented by the storage reach as well as the triangle that 
is drawn near the dam.  The storage reach follows the stream alignment so it cannot 
be reshaped without reshaping the stream alignment.  However, the triangle is 
simply a polygon attached to the downstream end of the storage reach.  The triangle 
can be reshaped to reflect the shape of the reservoir pool if you desire or it can be 
stretched to encompass a larger area so that it can be easily seen and selected when 
the Map Display is zoomed-out.   

To enlarge the reservoir triangle: 

• Using the Reservoir Tool , double-
click on the reservoir’s storage reach 
or triangle. The storage reach and 
triangle will highlight (turn yellow) and 
the vertices that define the triangle 
will display as blue dots as show in 
Figure 5.8.  

• The yellow dot at the apex of the triangle is the label handle for the Reservoir. 
Move the label handle away from the triangle. 

• Drag one of the blue dots that define the triangle away from its current position.  
Repeat this for each corner dot of the triangle in order to enlarge the triangle.  

If you would like to reshape the triangle so that it follows the outline of the reservoir, 
you will need to add additional points or vertices to the triangle polygon.  To add 
points to the pool (triangle) polygon: 

• Hold down the Ctrl key while clicking along one of the sides of the triangle.  A 
new blue dot (point) will appear where you clicked.   

• Add several new points to the polygon then drag the points around on the Map 
Display to form an outline of the lake. 

You may end up adding more points to the polygon that you need.  To delete points 
from the pool polygon: 

• Hold down both the Ctrl and Shift keys while clicking on a point you want to 
delete from the polygon.  The point will disappear. 

5.2.3 Drawing a Reservoir with two or more dams 

In Section 5.2.1, you saw how to create a reservoir with one dam and one or more 
inflow points.  Those are the typical reservoirs you are likely to need, but every once 
in a while, you may encounter a situation in which the reservoir has multiple rivers it 
can release water into. By drawing the reservoir across two or more streams that 
flow away from the inflow(s), a dam will be created at each outflow junction of the 
reservoir.   Figure 5.9 illustrates how to create a reservoir with two dams.  In this 
example, an L-shaped dam was constructed upstream of the confluence of two 
streams, but outlets were included that could release water into both streams.  This 

Figure 5.8 Reservoir Ready for Reshaping 



Chapter 5 - Watershed Schematic Elements ResSim User’s Manual 

5-8  

dam is treated as two dams in ResSim due to the need to produces releases to the 
two separate streams. 

5.2.4 Editing Reservoir Data (Watershed Setup) 

Physical and operational data of a reservoir belong to the reservoir model element 
and is entered in the Reservoir Network module.  However, to edit configuration data 
related to the reservoir:  

• Using the Reservoir Tool  or the Pointer Tool , right-click on the reservoir.   

• From the context menu, select Edit Reservoir to open the Reservoir Properties 
Editor. 

The fields of the Reservoir Properties Editor (Figure 5.10) include: 

Figure 5.10 Reservoir Properties Editor 

 

 

Figure 5.9 Creating a Reservoir with Two Dams 
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Name—For a reservoir schematic element, the only data that you need to specify is 
its Name which you took care of when you created it. The name field in the 
Reservoir Properties Editor is really a selector so that you can switch from 
one reservoir to another to review its configuration element properties. 

Label Position—Select where to draw the reservoir name label relative to the 
reservoir’s label handle.  The label handle can be found by double-clicking on 

the reservoir using the Reservoir Tool ; it will appear as a yellow dot (on 
the top of the reservoir triangle, if you haven’t already moved it). 

Existing Project—If the reservoir currently exists, this box should be checked so that 
the reservoir will be added automatically to any new configurations.  This is a 
useful option if you are creating multiple configurations that use the same 
set of reservoirs. See Section 5.2.6 for removing a reservoir from a 
configuration. 

Corp Project—Certain modeling software needs to know if the project is owned or 
operated by the Corps. For example, FIA needs to know in order to compute 
project benefits, therefore, use the Corps Project checkbox to indicate if the 
reservoir is a Corps Project. (This field is not used by ResSim.) 

Year in Service—This field is optional and is used by some modeling software in 
planning studies.  You do not need to specify a year in service when defining 
projects for real-time studies. (This field is not used by ResSim.) 

5.2.5 Renaming a Reservoir 

To rename a Reservoir: 

• Using the Reservoir Tool  or 

the Pointer Tool , right-click 
on the reservoir.   

• From the context menu, select 
Rename Reservoir.  This opens 
the Rename Reservoir dialog 
(Figure 5.11).   

• Enter a Name and an optional Description, then click OK. 

 

• An “are you sure…?” message (Figure 
5.12) will appear asking you to confirm 
that you really want to rename the 
reservoir. Choose: 

o Yes to complete the rename process. 

o No to abort the rename process. 

o Cancel to return to the Rename 
Reservoir dialog. 

Figure 5.11 Rename Reservoir Dialog 

Figure 5.12 Rename Reservoir Query 
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5.2.6 Removing a Reservoir from a Configuration 

To remove a Reservoir from the current Configuration,  

• Using the Reservoir Tool  or the Pointer Tool , right-click on the reservoir.  

• From the context menu, select Remove from Configuration.  This removes the 
reservoir from the current or active Configuration (the configuration that is 
currently displayed in the Configuration box on the Module bar).   

• A Confirm Removal dialog will appear (Figure 5.13).  Click Yes to confirm. 

Figure 5.13 Confirm Removal of Reservoir 

You can also remove a Reservoir from a Configuration by opening the Configuration 
Editor, then selecting Edit Project List… from the Project menu. 

5.2.7 Deleting a Reservoir 

To delete a reservoir configuration element and all data associated with it from the 
watershed: 

• Using the Reservoir  or Pointer  Tool, right-click on the reservoir.   

• From the context menu, select Delete Reservoir.   

• A Confirm Deletion dialog will appear (Figure 5.14). Click Yes to confirm.  

Figure 5.14 Confirm Deletion of Reservoir 

• A Confirm Removal dialog (Figure 5.15) will appear next, asking if you also want 
to remove (delete) the computation points that were created when the reservoir 
was created.  Click Yes to confirm deletion of the computation points. Click No to 
keep the computation points; the reservoir will still be deleted. 

 

Figure 5.15 Confirm Removal of the 
Deleted Reservoir’s Computation Points 
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5.2.8 Adding Configuration Notes for a Reservoir 

Although ResSim does not use Configuration Notes, other models that share the 
watershed may.  To open the Configuration Notes editor for a reservoir: 

• Using the Reservoir  or Pointer  Tool, right-click on the reservoir. 

• From the context menu, select Configuration Notes.   

• In the Configuration Notes textbox of the Notes editor (Figure 5.16), enter 
information about the selected reservoir relevant to the current configuration.  

Figure 5.16 Configuration Notes for Reservoir 

You can also access the configuration Notes editor by selecting Notes… from Edit 
menu of the Reservoir Properties Editor. 

5.3 Diversions 

5.3.1 Drawing a Diversion Element 

To draw a diversion from a stream:  

• Using the Diversion Tool , position your pointer at the location on the stream 
alignment where the diversion will occur (the “from” or inflow location) then 
press the Ctrl key and click.   

o If a computation point exists at (within the “snap” range of) that location, a 
Computation Point Found query dialog will ask if you want to connect the 
diversion to the Existing Computation Point or to a New Computation Point 
(Figure 5.17). 

Figure 5.17 Connect to Existing Computation Point Query 
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o If you select New Computation Point, ResSim will create a new computation 
point on the stream alignment as near as possible to the location of your 
pointer when you “clicked” and will connect the diversion to it.  The new 
computation point will be given a default name and will be located very near 
the existing computation point that was identified in the query.  Don’t forget 
to rename the new computation point(s). 

• You can give shape to the diversion reach by continuing to hold down the Ctrl key 
and clicking as you move the pointer across the map display.  With each 
Ctrl+click, a point will be added to the polyline that represents the diversion. 

• To place the last point of the diversion, move the pointer to the location where 
the diverted water will go (the “to” or outflow location) then release the Ctrl key 
and click.  Note: the outflow of the diversion can be placed at a location… 

on the stream alignment. This will make the diversion connected and 
indicates that the diverted water will remain within the river system.  
Like the inflow location, if a computation point exists at this location, 
you will be queried to be sure you want to connect the diversion to 
that computation point. 

not on the stream alignment. This will make the diversion unconnected and 
indicates that the diverted water will be lost from the river system. 

A Name New Diversion dialog 
(Figure 5.18) will appear. Enter 
a Name and Description for 
your diversion and click OK to 
complete the creation of the 
diversion. 

If the outflow of your diversion is 
connected to a computation point, 
the diversion will be drawn in the Map Display with a blue arrowhead.  If the 
diversion is unconnected, the diversion will be drawn with a black arrowhead.  Figure 
5.19 illustrates two diversions—Irrigation Diversion is a connected diversion and WS 
Diversion is unconnected.  If you cannot see a difference between the arrowheads of 
a connected and an unconnected diversion, you can change the draw properties of 
the diversions in the Drawing Properties Editor.  Select Drawing Properties… from the 
Edit menu to open the editor. For more details, refer to Appendix B. 

Figure 5.18 Name New Diversion 
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Figure 5.19 Connected and Unconnected Diversions 

To draw a diversion from a reservoir: 

• Using the Diversion Tool , position your pointer along the storage reach of a 
reservoir—away from the dam or inflow junctions, then press the Ctrl key and 
click.  This will connect the diversion’s inflow to the reservoir.   

• Finish drawing the diversion as described above. 

ResSim will not generate a computation point at the inflow of a diversion from a 
reservoir. The Irrigation Withdrawal diversion illustrated in Figure 5.19 is a diversion 
from a reservoir. Note that ResSim did not generate a computation point at the 
inflow of a diversion from a reservoir. 

5.3.2 Disconnecting a Diversion 

Connected diversions are diversions whose outflow point is connected to a 
computation point in the watershed schematic.  To disconnect the outflow point of 
the diversion: 

• Using the Diversion Tool  or the Pointer Tool 

, right-click on the diversion. 

• Select Disconnect Outflow from the bottom of the 
diversion’s context menu (Figure 5.20) 

(NOTE: the inflow point of a diversion cannot be 
disconnected.  If you connected the upstream end of a 
diversion to the wrong computation point, you must 
delete the diversion and re-create it. Figure 5.20 Diversion 

Context Menu 
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5.3.3 Reshaping a Diversion 

A diversion is represented by a polyline that ends with an arrowhead.  To reshape the 
diversion polyline: 

• Using the Diversion Tool ,  double-click on the 
diversion. The polyline will highlight (turn yellow) 
and the vertices (points) that describe the 
polyline will display as tiny black dots as 
illustrated in Figure 5.21.  

• Drag each of the black dots to a new position in 
the Map Display until the diversion polyline is 
shaped as you desire.  If the diversion is 
unconnected, the only point that cannot be 
moved is the first one at the diversion inflow.  If the diversion is connected, 
neither the first (inflow) point nor the last (outflow) point can be moved. 

o To add points to the polyline, hold down the Ctrl key and click anywhere 
along the diversion’s polyline.  A new black dot will appear where you 
clicked.   

o To delete points from the pool polygon, hold down both the Ctrl and Shift 
keys while clicking on a point you want to delete from the polygon.  The 
point will disappear. 

5.3.4 Editing Diversion Data 

Use the Diversion Properties Editor to edit configuration data for the diversion 
elements.  To open the Diversion Properties Editor (Figure 5.22): 

• Using the Diversion  or Pointer  Tool, right-click on the diversion. 

• Select Edit Diversion from the diversion’s context menu. 

Figure 5.22 Diversion Editor 

Use the Diversion Properties Editor to edit the description of the diversion, specify 
whether the diversion is an Existing Project and/or a Corps Project, and enter the 
Year in Service (when the diversion first began operating).  You can also verify which 

Figure 5.21 Highlighted Diversion   
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schematic elements the diversion is connected to by reviewing the content of the 
Diversion Information table.  

5.3.5 Renaming a Diversion 

To rename a diversion: 

• Using the Diversion  or Pointer  Tool, right-click on the diversion. 

• Select Rename Diversion… from the diversion’s context menu.   

• Enter a new Name (and Description) for the diversion in the Rename Diversion 
dialog then click OK.  (Cancel will abort the rename process.) 

• An “are you sure” warning message will appear asking you to confirm that you 
really want to rename the diversion.  

o Select Yes to complete the rename process 

o Select No to abort the rename process 

o Select Cancel to return to the Rename Diversion dialog so that you can revise 
the new name for the diversion. 

5.3.6 Removing a Diversion from a Configuration 

To remove a diversion from the current configuration: 

• Using the Diversion  or Pointer  Tool, right-click on the diversion. 

• Select Remove from Configuration from the context menu 

• The Confirm Removal dialog will appear (Figure 5.23). Click Yes to remove the 
diversion from the active configuration. 

Figure 5.23 Confirm Removal of Diversion 

You can also remove a diversion from a configuration by opening the Configuration 
Editor and using the Project Selector to remove the diversion.  To open the Project 
Selector, select Edit Project List… from the Project menu of the Configuration Editor.  

5.3.7 Deleting a Diversion 

To delete a Diversion from the watershed: 

• Using the Diversion  or Pointer  Tool, right-click on the diversion. 

• From the context menu, select Delete Diversion.   A Confirm Deletion dialog will 
open asking “Are you sure…?” 
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• Click Yes to delete the diversion and all data associated with the diversion from 
the watershed. Click No to cancel the delete. 

Figure 5.24 Confirm Deletion Dialog 

5.3.8 Adding Configuration Notes for a Diversion 

Although ResSim does not use Configuration Notes, other models that share the 
watershed may.  To open the Configuration Notes editor for a diversion: 

• Using the Diversion  or Pointer  Tool, right-click on the diversion.  

• From the diversion’s context menu, select Configuration Notes.  

•  In the Configuration Notes textbox of the Notes editor (Figure 5.25), enter 
information about the selected diversion relevant to the current configuration.  

Figure 5.25 Configuration Notes for Diversion 

You can also access the diversion’s configuration Notes editor by selecting Notes… 
from Edit menu of the Diversion Properties Editor. 
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5.4 Drawing a Levee 

A levee is (typically) an earthen barrier built along a stream to provide protection from 
flooding.  A levee can reduce flood damage by preventing flood stages from reaching a 
potential damage area.  Although levees are not used by 
ResSim, it may be useful information for the modeler 
when developing routing information. 

To add a levee to the watershed: 

• Using elect the Levee Tool , move your cursor to 
the location of the upstream end of the levee along 
the Stream Alignment. 

• While holding down the Ctrl key, click on the stream 
alignment to select the upstream end of the levee. 

• Release the Ctrl key, move the cursor to the location 
of the downstream end of the levee and click again.  A 
Name dialog will appear. 

• Enter a Name and option Description for your levee, 
then click OK to complete the levee creation process.  
The levee will be drawn in the Map Display as a thick 
black polyline along one side of the stream alignment 
from the upstream to downstream points that you 
identified (Figure 5.26).   

• You can use the Levee Editor to reposition the levee 
(Figure 5.27). 

Figure 5.27 Levee Properties Editor 

 

 

Figure 5.26 Levee 
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5.5 Drawing a Channel Modification 

A channel modification is typically an attempt to improve conveyance in the natural river 
channel.  The modification can be implemented in a number of ways, including debris 
and vegetation removal, armoring or lining of the channel, and even straightening of the 
channel.  Although channel modifications are not used by ResSim, the presence of one 
may offer useful information to the modeler when developing routing information. 

To add a Channel Modification to the watershed: 

• Using the Channel Modification Tool , move 
your cursor to the location of the upstream end of 
the channel modification along the Stream 
Alignment. 

• While holding down the Ctrl key, click on the 
stream alignment to select the upstream end of 
the channel modification. 

• Release the Ctrl key, move the cursor to the 
location of the downstream end of the channel 
modification, and click again.  A Name dialog will 
appear. 

• Enter a Name and option Description for your 
channel modification, then click OK to complete 
the channel modification creation process.  The 
channel modification will be drawn in the Map 
Display as a thick black polyline atop the Stream 
Alignment from the upstream to downstream 
points that you identified (Figure 5.28). 

• You can access the Channel Modification Properties Editor (Figure 5.29) by right-
clicking on the channel modification in the Map Display and selecting Edit from the 
context menu. Useful options for editing the channel modification include revising 
the stationing of 
the upstream 
and downstream 
ends of the 
project and the 
position of the 
label relative to 
the midpoint of 
the project. 

Figure 5.28 Channel Modification 

Figure 5.29 Channel Modification Properties Editor 
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5.6 Drawing an Off-Channel Storage Area 

An off-channel storage area is a pond or ineffective flow area where water may collect.  
These project elements are not used by ResSim but that may be used by another model 
that shares the watershed (such as RAS).  To model a constructed off-channel reservoir 
that ResSim can use, use a reservoir element, even if you have to create an off-channel 
stream in the Stream Alignment to place it on. 

To add an Off-Channel Storage Area to the watershed: 

• Using the Off-Channel Storage Tool , hold down the Ctrl key and click the location 
in the map where you want to start drawing the off-channel storage area.   

• Continue to hold the Ctrl key while you click to add additional vertex points of the 
polygon that represents the off-channel storage area. 

• Before placing the last vertex of the polygon, release the Ctrl key, then click to place 
the last point.  A Name … dialog will appear. 

• Enter a Name and optional Description for 
your off-channel storage area, then click OK to 
complete the off-channel storage area 
creation process.  The off-channel storage 
area will be drawn in the Map Display as a 
closed polygon connecting the vertex points 
you placed (Figure 5.30).  

5.7 Drawing an “Other” Project 

Other project is a catch-all name for a man-make features in the watershed related to the 
movement of water.  Possible other projects might include pump stations, in-line 
spillways, or even an ecosystem restoration project.  ResSim does not use other projects 
but you should consider carefully whether the other project you are considering adding 
to the watershed could be modeled with a reservoir or a diversion—such as a pump 
station. 

To add an “Other” Project to the watershed: 

• Using the Other Project Tool , Ctrl-click at the location in 
the Map Display where you want the other project to appear.  
A Name… dialog will appear.  

• Enter a Name and optional Description for your other 
project, then click OK to complete the other project creation 
process.   

• The other project will be drawn in the Map Display as a 

computation point with an Other Project icon  attached 
(Figure 5.31).  

Figure 5.30 Channel Modification 

Figure 5.31 Other Project 
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• Use the Computation Point or Pointer tool to rename the computation point 
associated with the other project. 

• You can use the Other Project Properties Editor to reposition the Other Project icon 
and its associated computation point (Figure 5.32). 

Figure 5.32 Other Project Properties Editor 

5.8 Configuring Project Display Properties 

You can configure the appearance of Reservoirs, Levees, Diversions, and Computation 
Points in the Study Layer of your watershed using the Drawing Properties Editor (Figure 
5.33).   

To access the Drawing Properties Editor: 

• Select Drawing Properties… from the Edit menu of the Watershed Setup 
module, or 

Figure 5.33 Drawing Properties Editor 



ResSim User’s Manual Chapter 5 - Watershed Schematic Elements 

  5-21 

• Select Properties from the context menu of the Study layer in the Layer 
Selector. 

See Appendix B for details on how to change the drawing properties for your 
configuration elements. 
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Chapter 6 

Developing a Reservoir Network 

A reservoir network is the principal component of your ResSim model.  It contains the 
model schematic, its elements, and all their physical and operational data. The model 
schematic elements include reservoirs, routing reaches, junctions, diversions, and diverted 
outlets. 

Each model schematic element has its purpose in the reservoir network.  

Reservoirs and Diversions are the operational elements—they make decisions about 
the movement of water through the network.   

Junctions are connectors—they connect all other schematic elements to one 
another.  Junctions also provide connection to inflow data.  

Reaches route flow through the network, from one junction to another. 

Diverted Outlets are a hybrid of a diversion and a reservoir outlet group.  As an outlet 
group, they are effectively a sub-element of a reservoir. As a diversion, they 
take the water allocated to them and deliver it to wherever the diversion is 
connected.  

This chapter provides an overview of the Reservoir Network module’s user interface and 
describes the processes for creating a new reservoir network and completing its 
connectivity by adding reaches and other model schematic elements as needed. 

Once you have established your reservoir network and its schematic, you will need to 
complete its definition by specifying the Junction, Reach, and Diversion data (Chapter 7).  
You will then use the Reservoir Editor (Chapter 8) to defining the physical (Chapter 9) and 
operational (Chapters 10, 11, and 12) components of the Reservoirs.  You may also wish 
to develop Reservoir Systems (Chapter 13) in your network. 

After completing the definition of your reservoir network, you can start creating 
alternatives (Chapter 14).  And, with your network(s) and alternative(s) defined, you will 
be ready to create and run Simulations (Chapter 15). 

After running a simulation, you can review results using default or custom Plots, Tables 
(Chapter 16), and Reports (Chapter 17).  You can also develop scripts to post-process 
results or automate the building of plots, tables, and reports (Chapter 18). 

6.1 The Reservoir Network Module 

The Reservoir Network module of ResSim is effectively the editor of a reservoir network.  
Almost every feature and tool in this module is involved in creating, editing, or managing 
some aspect or component of a reservoir network. This Section describes the various 
user interface components and tools (Figure 6.1) provided in the Reservoir Network 
module. 
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6.1.1 Menu Bar 

The following is an overview of the menus unique to the Reservoir Network module 
which provide features for creating and editing reservoir networks and their 
elements. Detailed descriptions of the options in these menus will be provided in the 
context of specific network development tasks later in this and subsequent chapters. 
Refer to Chapter 2 for information about the File, View, Tools, and Help menus, 
which are common to all three modules. 

Edit—The Edit menu (Figure 6.2) provides access to 
the ResSim editors for Reservoirs, Reaches, 
Junctions, Diversions, Reservoir Systems, State 
Variables, and Water Account Sets, as well as 
the Wizard to Import Element Properties… 
Also in the menu is the Allow Network Editing 
option to lock the module for editing. Since 
the Reservoir Network module is now used 
only by ResSim, the multi-user locking 
requirement is no longer necessary; so, the 
lock is now set by default whenever there is a 
network open in the module.  All edit locks will 
be removed in the next version of ResSim. 

 

Figure 6.1 Reservoir Network Module 

 

Figure 6.2 Edit Menu 
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Network—The Network menu (Figure 6.3) is 
unique to the Reservoir Network Module. 
You can think of it as a secondary File 
menu since it provides most of the same 
functions but applied specifically to 
reservoir networks.  The Network menu 
options allows you to create a New 
network, Open an existing network, Edit 
the description of the current network, 
Save, copy (Save As), and Rename the 
current network, and Delete Networks. 
Rename a network.  You can also Update 
Network from Configuration and Import 
Networks. 

 Alternative—The only option, Edit, in the Alternative 
menu (Figure 6.4) opens to the Alternative Editor.  
This menu is also available in the Simulation 
module. 

 Reports—The Reports menu (Figure 6.5) provides access to 
a variety of reports that highlight different aspects of 
reservoir networks; these include the Reservoir List, 
Reach List, Junction List, and Diversion List as well as 
two Advanced reports—the Network Connectivity 
report (for All Elements or for Selected Elements) and 
the Node List. The last option, Alternative Input, lets 
you select an alternative and generate a structured 
listing of the features that make up the selected 
alternative and its associated network. 

 

6.1.2 The Module Toolbar 

In the Reservoir Network module, the Module Toolbar (Figure 6.6) contains the 
Module selection as well as two fields that identify the currently open Network and 
the Configuration the open network is based upon.   

 

Figure 6.6 Network Module—Module Toolbar 

Between the Network and Configuration fields is an Edit Lock  button. Since the 
multi-user locking requirement is no longer necessary, the lock is now set by default 
whenever there is a network open in the Reservoir Network module.  All edit locks 
will be removed in a future version of ResSim. 

 

Figure 6.3 Network Menu 

 

Figure 6.4 Alternative Menu 

 

Figure 6.5 Reports Menu 
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6.1.3 Map Display Area 

In the Reservoir Network module, the Map Display area shows the model schematic 
of the open reservoir network, along with the background maps and the stream 
alignment you established in the Watershed Setup Module.   

By using the Map Tools to access context menus directly from the schematic in the 
Map Display, you can open data editors as well as Rename, Delete, and Import 
Properties for the elements in your reservoir network. 

6.1.4 Map Tools 

The Map Tools allow you to create and edit the model schematic elements from in 
the Map Display area.  The Reservoir Network module has three standard Map Tools 
(Pointer, Zoom, and Pan), five network (model schematic) element tools (Reservoir, 
Diverted Outlet, Reach, Junction, and Diversion), and a tool for visualizing the 
connectivity of your reservoir network. 

 Pointer Tool—right-click with the Pointer Tool to select and access a context 
menu for any schematic element within your map display.  The Pointer Tool 
is available in all ResSim modules. 

 Zoom Tool—the Zoom Tool allows you to zoom in and out of the display area in 
all modules.  To zoom in, hold the left mouse button down and outline the 
area you want to enlarge.  To zoom out, click the right mouse button.  
Zooming out using the right click button zooms out by a factor of two, 
positioning the clicked location at the center of the screen.  The Zoom Tool is 
available in all ResSim modules. 

 Pan Tool—after you have zoomed in with the Zoom Tool, you can use the Pan 
Tool to drag the content of the Map Display, effectively scrolling the viewable 
portion of the watershed.  The Pan Tool is available in all ResSim modules. 

 Reservoir Tool—with the Reservoir Tool, you can add reservoirs to your reservoir 
network.  You can also edit reservoir properties, rename, and delete 
reservoirs using commands in the context menu. 

 Diverted Outlet Tool—the Diverted Outlet Tool allows you to create a diverted 
outlet from a reservoir in your network.  The context menu for this tool 
provides access to the Reservoir Editor and allows you to rename and delete 
a diverted outlet. 

 Reach Tool—use the Reach Tool to draw routing reaches (from upstream to 
downstream) to connect the junctions on the stream alignment.  You can 
also edit reach properties, rename, break, and delete reaches using 
commands in the context menu. 

 Junction Tool—the Junction Tool allows you to manually insert junctions in your 
reservoir network.  The context menu for this tool allows you to edit junction 
properties, rename and delete junctions. 
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 Diversion Tool—with the Diversion Tool you can add diversions to your reservoir 
network.  You can also edit diversion properties, rename, delete, and 
disconnect outflow of diversion reaches using commands in the context 
menu. 

 Network Connectivity Tool—using the Network Connectivity Tool you can click on 
any element in the map display area to see which elements are connected 
(connected elements will be highlighted).  If you right-click on an element, 
you can choose to show the upstream or downstream connectivity. 

6.2 Creating and Managing Reservoir Networks 

ResSim provides three ways to create a reservoir network:  

1. create a new network,  

2. make a copy of an existing network, and  

3. import a network from another watershed. 

But, before you start creating reservoir networks, it is important to understand how they 
relate to watershed configurations and the watershed schematic(s) you created in the 
Watershed Setup module. 

ResSim was designed to fully implement the shared schematic concepts that are the basis 
of the Watershed Setup module and watershed configurations.  To that end, ResSim’s 
reservoir networks were designed to be created using a watershed configuration as a 
template.  Using a configuration as a template means that ResSim will create model 
elements in the reservoir network for each watershed schematic element it recognizes in 
the selected configuration.  Thus… 

For each reservoir in the configuration, ResSim will create a reservoir with the same 
name and position on the stream alignment in the new network.   

For each diversion from a stream in the configuration, ResSim will create a diversion 
with the same name, shape, location, and connectivity in the new network.  

For each diversion from a reservoir in the configuration, ResSim will create a diverted 
outlet the associated reservoir in the new network.  The diverted outlet will 
have the same name, shape, location, and connectivity as the diversion in 
the selected configuration. 

In addition, for each computation point defined in the watershed schematic, ResSim 
will create junctions in the reservoir network when a reservoir network is 
created based on a configuration.   

Each of the network elements that were created based on a watershed schematic or 
configuration element stores a reference or link to the element it was based on.  By 
maintaining this information, a network can be updated to reflect any changes that have 
been made to the watershed schematic or configuration since the network was first 
created. 
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Once the preliminary model schematic for a new network appears in the Map Display, 
you will need to add routing reaches (and possibly other network elements) to complete 
the connectivity of your reservoir network schematic.   

6.2.1 Creating a New Network 

When you create a new reservoir network, you can (and should) identify which 
projects will be included in your network by selecting an appropriate watershed 
configuration.  After creating the network (based on a configuration), you will need 
to add additional elements to complete the connectivity and to represent any 
additional features that were not identified by the configuration.   

To create a new reservoir network: 

• From the Network menu, select New.   

The Create New Reservoir Network dialog will appear (Figure 6.7). 

• Enter a Name and a Description for the 
network.   

• From the Configuration list, select the 
configuration on which this network will 
be based.   

• Click New.  

If no configuration was selected, a 
warning dialog will ask you to confirm 
that the network will not be based on a 
configuration (Figure 6.8).  

o Click Yes to proceed without a 
configuration.  If you do not use a 
configuration when creating your network, you will have to create all the 
model schematic elements for your network. 

o Click No to return to the Create New Reservoir Network dialog so that you 
can select a configuration. 

Figure 6.8 Creating a New Network with no Configuration Selected 

After you (and ResSim) complete the process of creating a new network, you will 
see the name of your new network and the configuration it was based on 
displayed below the Module Toolbar.  Also, the reservoirs, junctions, and 
diversions that ResSim created in your network based on the configuration will 
appear in the Map Display area.   

 

Figure 6.7 Create New Reservoir Network 
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6.2.2 Importing a Reservoir Network 

The Import Network Wizard guides you through the process of importing a reservoir 
network from another watershed.  For each step of the process, the Import Network 
Wizard displays a different dialog panel.  Each panel identifies the current Step in the 
title bar and tells you what the objective of the step is with a label in the upper left 
corner of the panel (below the title bar).  The process involves six steps: 

1. Select the Watershed—select the source watershed that contains the network 
you want to import into your current watershed. 

2. Select the Network to Import Elements from—select the source network. 

3. Set New Network Name—the process of importing a network creates a new 
network in your current watershed, so you are given the option to give the 
new network a new name and description. 

4. Assign Stream Names—associate streams in your current watershed’s stream 
alignment to the schematic elements in the network you are importing. 

5. Resolve Network Computation Points—associate computation points in your 
current watershed schematic to the junctions in the source network. 

6. Review the Import Summary and Finish—this step shows you a listing of the 
current stream or computation point associations you made for the various 
elements of the network you are importing.  It also shows what elements, if 
any, have not been associated to elements in your current watershed.  Be sure 
to review the summary carefully.   

To import a network: 

• Select Import Network… from the Network menu. 

• The Import Network Wizard will open and display the Step 1 of 6 panel (Figure 
6.9).  This panel shows two tables. 

 

Note: A reservoir network can be created without specifying or selecting 

a configuration.  If you do so, you will have to add each model 

schematic element into your network by drawing them, one by one, in 

the Map Display area.  And, networks created without a configuration 

cannot be updated based on changes in made to a configuration nor 

can a configuration be applied to or imposed on them. 
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Figure 6.9 Import Network Wizard—Step 1—Select the Watershed 

• The first table lists the Watershed Locations (shortcuts) you currently have 
defined in ResSim. Select the appropriate watershed location.   

• The second table lists the Watersheds that ResSim found at the selected 
watershed location.  Select the watershed that contains the network you want to 
import. 

 

Note: The Import Network Wizard is only capable of identifying 

watersheds in known watershed locations.  If you do not have a 

watershed location (or shortcut) already defined in ResSim for the 

location where your source watershed resides, you must create one 

before you can proceed with the network import process.  Instructions 

for creating a shortcut/watershed location are provided in Chapter 3, 

Section 3.2.1 Defining a Watershed Location and in Appendix A. 

• Click Next> to proceed to the next step (or Cancel to abort the import process 
and exit the Import Wizard). 

• The Import Network Wizard will display the Step 2 of 6 panel (Figure 6.10).  The 
Select the Network to Import Elements from panel shows the name of the source 
Watershed you selected and a list of the Available Networks it contains.   

Figure 6.10 Import Network Wizard—Step 2—Select the Network to Import 
Elements from 

• Select the source network (from which you would like to import all its elements).  

• Click Next> to proceed to the next step or <Back to return to the previous step.   
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• The Import Network Wizard will display the Step 3 of 6 panel (Figure 6.11).  The 
top half of the Set New Network Name and Description panel shows the name of 
the current watershed and a list of the networks that exist in it.  The bottom half 
has two textboxes which contain the name and description of the source 
network. 

Figure 6.11 Import Network Wizard—Step 3—Set New Network Name and 
Description 

• You can let the New (imported) Reservoir Network have the same name and 
description as its source or you can enter a new Name and Description. 

• Click Next> to proceed to the next step (or <Back to return to the previous step.) 

• The Import Network Wizard will display the Step 4 of 6 panel (Figure 6.12).  The 
Assign Stream Name panel shows the name of the current Watershed as well as 
the name you specified for the New Network and the name of the Import From 
(source) Network.  This panel also contains a table showing a list of the network 
Elements to be Imported, their Element Type, and the (From) Stream they are 
associated with in the source watershed.  
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Figure 6.12 Import Network Wizard—Step 4—Assign Stream Names 

• In the last column of the table, you will associate a stream in the current 
watershed to each element in the list.  If any of the streams in the current 
watershed have the same name as a stream in the source watershed, ResSim will 
assume they are the same stream and will fill in those cells of the table for you. 
You have two options for assigning streams to each element: 

1. Assign the streams, one at a time, to each element in the list by selecting 
an appropriate steam from the drop-down list in each cell. Or… 

2. Assign the streams all at once by clicking the Assign Stream Names button, 
then, for each stream listed in the From Stream column in the Select 
Stream Name dialog, select a stream from your current watershed from 
the selection list in each cell in the To Stream column.  When done, click 
OK.  The importer will use the associations you made to complete the To 
Stream column of the Assign Stream Names table.  

• Click Next> to proceed to the next step (or <Back to return to the previous step). 

• The Import Network Wizard will display the Step 5 of 6 panel (Figure 6.13). The 
Resolve Network Computation Points panel starts by identifying the current 
watershed which is followed by a selection list of the available configurations. 
Select the configuration that you want the new (imported) network to be 
associated with. 
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Figure 6.13 Import Network Wizard—Step 5—Resolve Network Computation Points 

• The Resolve Network Computation Points panel also includes a table containing a 
list of the model schematic elements to be imported from the source network.  
Your objective is to associate each element with a watershed schematic element 
from the selected configuration in the current watershed.  Use the drop-down 
list in each cell to make your selections.  This can be a tedious process so take 
your time.  

• Click Next> to proceed to the next step (or <Back to return to the previous step). 

• The Import Network Wizard will display the Step 6 of 6 panel (Figure 6.14).  This 
Import Summary panel  

• Review the Import Summary carefully.  This is your last chance to double-check 
all the work you put in mapping (associating) the imported elements to streams 
and configurations.   
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Figure 6.14 Import Network Wizard—Step 6—Import Summary 

• Select Finish to carry out the Network import, or select Back to make changes in 
previous steps. A confirmation dialog will open…   

o Select Yes in the Continue with Import dialog (Figure 6.15) to perform the 
import.  Or… 

o Select No to return to Step 6 of 6 of the Import Network Wizard.  From there, 
you can go <Back to a previous step to revise one or more entries or Cancel 
the process and exit the Wizard. 

Figure 6.15 Continue with Import 

• Review the imported network carefully.  The Importer is good but not perfect.  
Areas for careful review include: 

o Any rule, constraint, or condition that is a function of a time series (model, 
state, or external variable)—the links may look okay, but it wouldn’t hurt to 
reset them. 
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o Downstream connectivity—any rule or feature that identifies another 
element in its setup should be reviewed.  These features include 
downstream control rules, tandem rules, pump rules, and tailwater 
definitions. 

o Any state variable or scripted rule—scripts often reference other model 
elements, but the importer does not have the ability to revise the names of 
those elements in the scripts during the import process. 

6.3 Completing the Network Connectivity 

Routing reaches are elements that establish the connectivity of the reservoir network 
schematic.  By adding a routing reach between two junctions, you can connect the 
reservoir network so that water will transverse through the routing reach from upstream 
to downstream. 

6.3.1 Drawing Routing Reaches 

Routing Reaches are drawn from upstream to downstream.  You connect two 
adjacent junctions (typically, computation points added to the network’s 
Configuration in the Watershed Setup Module) by drawing a routing reach. 

To draw routing reaches: 

• Select the Reach Tool . 

• Point to the upstream junction at the upstream end of the reach. 

• Hold down the Ctrl key and click on the junction to start the upstream end of 
the reach. 

• Release the Ctrl key and move the mouse pointer along the stream 
alignment, then click on the downstream junction. 

Routing reaches automatically conform to the stream alignment.  You can connect 
routing reaches to existing junctions; otherwise, if you begin and/or end a reach 
elsewhere on the stream alignment, ResSim will create new junctions at both/either 
end of the reach. 

ResSim will automatically constrain a new reach between existing junctions (e.g., will 
not allow a reach to be drawn past an existing junction).  If the reach appears to draw 
past a junction, then the junction is not on the stream you think it’s on.  This can 
occur if the computation point (that the junction is based on) is not initially placed on 
the appropriate stream.  To solve this situation, go back to the Watershed Setup 
Module and revise the location of the computation point (you may need to delete 
and recreate the computation point to be on the appropriate stream).  After saving 
your watershed configuration, change to the Reservoir Network Module and select 
Update Network from Configuration from the Network menu.  See Section 6.4.6, 
“Updating a Reservoir Network” for additional information for updating networks. 

Additionally, you may not connect tributaries to the middle of a reach; tributaries 
must connect to a junction. 
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6.3.2 Renaming Routing Reaches 

ResSim automatically names routing reaches according to the names of the upstream 
and downstream junctions.  To rename a reach component: 

• Using the Reach Tool , right-click on the routing reach to be renamed.  

• Select Rename from the context menu.  The Rename Reach dialog will 
appear (Figure 6.16), allowing you to type in a new name. 

Figure 6.16 Rename Reach 

The new name will now appear as a label in the map display. 

6.3.3 Deleting Routing Reaches 

To delete routing reaches: 

• Using the Reach Tool , right-click on the routing reach to be deleted. 

• Select Delete from the context menu.  A Confirm Delete dialog will appear. 

• Click Yes if you are sure about the deletion. 

The deleted routing reach will no longer appear in the map display. 

6.4 Managing Reservoir Networks  

The tools for managing your reservoir networks are 
provided through the Network menu of the module 
(Figure 6.17).  

Although you will rarely, if ever, need to work directly 
with the files that make up a ResSim watershed, it may 
be useful to know how the reservoir network data is 
stored. 

Reservoir networks are not stored to a single file in the 
watershed; they are, in fact, stored to 8 separate files.  
The primary network file network.rsys file—where network is the name you gave the 
reservoir network.  The .rsys file contains the definition of all the network objects that 

Figure 6.17 Network Menu 
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make up the reservoir, their connectivity, and most of the data that describes them. The 
second file is the network.dss file which stores all of the tabular data that describes the 
physical data of the reservoirs and any rating curves for the junctions. 

6.4.1 Opening an Existing Reservoir Network 

To open an existing Reservoir Network for 
editing: 

• Select Open from the Network menu.  
The Open Reservoir Network dialog will 
appear (Figure 6.18). 

• Select the Existing Reservoir Network 
you want to open and click Open. 

The Open Reservoir Network dialog will 
close, and you will see the name of your 
network and its configuration displayed 
in the Module Toolbar. 

6.4.2 Editing a Network 

Since the whole Reservoir Network module is effectively the editor for reservoir 
networks, the Edit option in the Network menu does not open an editor with a wide 
variety of parameters for you to define 
or change.  Instead, it opens a small 
dialog (Figure 6.19) whose sole purpose 
is to allow you to edit the Description of 
the network.  This may seem trivial, but 
experienced modelers, as well as the 
developers of ResSim, consider the 
descriptions for most elements of a 
model to be important and significant.  Descriptions allow you to internally document 
each aspect of the model as it is created and as it evolves.  These descriptions will be 
invaluable to you and to anyone else who wants to use or review your model. 

6.4.3 Saving a Network 

ResSim maintains a lot of information about your network in memory. And each time 
you make any changes to the components of your 
network and click OK or Apply in an editor, those 
changes are stored in memory. And, ResSim will give 
you a visual clue when the network in memory is 
different from what is stored in files in the 
watershed.  That visual clue is an asterisk * at the 
end of the Network name in the Module Toolbar 
(Figure 6.20). 

Figure 6.18 Open Reservoir Network  

Figure 6.19 Edit Network Dialog 

 

Figure 6.20 Network has changes 
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To save the open network to disk: 

• Select Save from the Network menu. 

Since ResSim knows when changes have been made to the open network, if you try 
to close ResSim or change modules, ResSim 
will ask you to save with the query dialog 
shown in Figure 6.21. 

Click Yes to save the network and 
proceed with activity that you 
initiated. 

Click No to discard your changes and proceed with the activity. 

Click Cancel to abort the activity and return to the Reservoir Network module.  
Your changes will not be saved to disk nor will they be discarded. 

6.4.4 Renaming Networks 

Renaming a network seems like a simple thing to do.  And it is.  All you have to do to 
rename a network is: 

• Select Rename… from the Network 
menu to open the Rename 
Network dialog (Figure 6.22).   

• Select the network you want to 
rename from the list of Existing 
Reservoir Networks. 

• Enter a new Name (and 
Description) for the network. 

o Click Rename to rename the 
selected network. 

o Click Cancel to abort the 
rename process. 

Renaming a network may have unintended consequences:  

o A reservoir network may be referenced by one or more alternatives.  Since the 
alternatives are tied to the network by its ID number, not its name, the 
connection between the alternatives and the network are not broken when you 
rename a network.  However, things can get a bit more complicated in your 
simulations. If you have a simulation that was created before you renamed the 
network that one or more of the simulation’s alternatives are based on, the 
alternatives will continue to compute and function as they did before, but the 
new name of the network will not migrate into the simulation, not even with the 
Replace From Base feature.   

o And, when you rename a network, the eight files that contain your network’s 
data on disk do not actually get renamed.  Instead, a new set of files are created 
with the new network name and the primary network file of the old network is 

Figure 6.21 Save Network Query 

Figure 6.22 Rename Network As Dialog 
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deleted, leaving behind seven files that still have the original name of the 
network cluttering-up your watershed. 

6.4.5 Deleting Networks 

You will occasionally find it necessary to delete unnecessary networks from your 
watershed. To delete one or more networks: 

• Select Delete Networks… from the 
Network menu. The Delete Networks 
dialog will open (Figure 6.23). 

• Select the network that you want to 
delete from the list of Existing 
Reservoir Networks.  You can select 
more than one.  The names of the 
selected networks will appear in the 
Name field below. 

• Click OK to proceed (or Cancel to 
abort the delete process). 

• An “are you sure…?” dialog listing the 
networks you selected to delete will 
appear (Figure 6.24).  

o Click Yes to delete the selected 
network(s).  

o Click No to abort the delete 
process.  

o Click Cancel to return to the Delete 
Networks dialog. 

Although deleting reservoir networks is simple, there may be unintended 
consequences if you are not careful:  

o  Alternatives reference networks. If you delete a network that is referenced by an 
existing alternative, that gets broken.  When you select a select a network that 
has been broken in this manner, an Error Message dialog will appear (Figure 
6.25) and the alternative will not display 
any of its settings in the editor.  Since there 
is no way to attach another network to 
your alternative, your only option with a 
broken alternative is to delete it. 

o Simulations contain copies of alternatives.  
If you have a simulation that contains a 
copy of one or more alternatives that have been broken by the delete of their 
network, the alternatives in the simulation become orphans.  They will continue 
to function correctly in the simulation but their connection to the original 
alternative is broken so Save to Base and Replace from Base will no longer work 
for those alternatives. 

Figure 6.23 Delete Networks Dialog 

Figure 6.24 Delete Networks Query 

Figure 6.25 Broken Alternative Message 
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6.4.6 Updating a Network from its Configuration 

In the Watershed Setup Module, if you make changes (e.g., add, delete, move or 
rename elements) to the watershed configuration that your network is based on, you 
may need to update your Reservoir Network to include those changes.   

To update the active network from its configuration: 

• Select Update Network from Configuration from the Network menu. 

• A confirmation dialog will appear (Figure 6.26). 

After the network has been updated from the revised configuration, you should see 
the revisions reflected model schematic in the Map Display area. 

6.5 The Reservoir Network Reports 

In the Reservoir Network module, the Reports menu provides access to summary reports 
pertinent to the elements in your active network.  Each report includes a table containing 
the list of information pertinent to that report.  In addition, Advanced reports describing 
your network connectivity are also available.   

For information about printing and exporting options available from each report’s Report 
menu, see Appendix E. 

 

Sorting a Report Table:  

In most reports, if you click on a column header of the table, the contents of the 

table will resort alpha-numerically based on the content of that column.   

6.5.1 The Reservoir List 

The Reservoir List (Figure 6.27) displays the names, descriptions, and operations of all 
reservoirs in your network.  Additionally, the number of reservoirs is listed in the 
bottom right corner.  For information about printing and exporting options available 
from the report’s Report menu, see Appendix F.  The Edit menu provides access to 
the Reservoir Editor (after selecting a reservoir in the list and then selecting Edit from 
the Edit menu). 

Figure 6.26 Confirm Network Update from Configuration 
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Figure 6.27 Reservoir Network Reports—Reservoir List 

6.5.2 The Reach List 

The Reach List (Figure 6.28) displays the names, descriptions, routing method, and 
losses of all reaches in your network.  For information about printing and exporting 
options available from the report’s Report menu, see Appendix F.  The Edit menu 
provides access to the Reach Editor (after selecting a reach in the list and selecting 
Edit from the Edit menu). 

 

Finding Schematic Elements: 

In large or unfamiliar models, it can be difficult to locate a specific model 

element.  The network summary reports are a great tool for this. Find the 

element you are looking for in the report list and click on it to select it. When 

an element is selected in the report listing, that element is highlighted in the 

Map Display area. 

6.5.3 The Junction List 

The Junction List (Figure 6.29) displays the names and descriptions of all junctions in 
your network.  For information about printing and exporting options available from 
the report’s Report menu, see Appendix F.  The Edit menu provides access to the 

 

Figure 6.28 Reservoir Network Reports—Reach List 
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Junction Editor (after selecting a junction in the list and selecting Edit from the Edit 
menu). 

 

Deleting Schematic Elements: 

If you encounter a circumstance in which you want to delete an element that 

you either cannot find or select in the Map Display area or you want to delete 

several element at once, the network summary reports can come in hand for 

this too.  Select the element(s) you want delete in the table, then select Delete 

from the report’s Edit menu. 

6.5.4 The Diversion List 

The Diversion List (Figure 6.30) displays the names, descriptions, and method of all 
diversions in your network.  For information about printing and exporting options 
available from the report’s Report menu, see Appendix F.  The Edit menu provides 
access to the Diversion Editor (after selecting a diversion in the list and selecting Edit 
from the Edit menu).  

6.5.5 The Advanced Reports 

Two Advanced Reports are available from the Reports menu—Network Connectivity 
and Node List.  These reports each describe how the model schematic is connected. 

 

Figure 6.29 Reservoir Network Reports—Junction List 

 

Figure 6.30 Reservoir Network Reports—Diversion List 
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6.5.6 The Network Connectivity Report 

The Network Connectivity report provides a detailed list of the elements (and sub-
elements) that make up the model schematic of the active reservoir network.  This 
report is complicated and requires that you understand 1) the concepts of elements, 
sub-elements, and the nodes that connect them and 2) how the report is arranged to 
identify the elements, their sub-elements, the connecting, and the connections.   

This report uses row shading to indicate grouping of sub-elements within other 
elements.  The rows identifying parent or primary schematic elements have a grey 
background.  If a primary element contains sub-elements, those sub-elements will 
have a light grey background.  The connection nodes of an element or sub-element 
have a white background and immediately follow the element or sub-element they 
pertain to. 

The headers for each column identify their contents, however, some of the headers 
include two labels separated by a slash (/).  The first label applies to the data in the 
grey or light grey rows (the elements and sub-elements).  The second label applies to 
the data in the white rows (the nodes).  The column headers include: 

Element/Node—the element or node type. These include: 

JunctionElement—a Junction element; a primary schematic element. As 
far as the network connectivity is concerned, junctions do not 
have physical sub-elements.  However, they do have virtual sub-
elements—local inflows—which show up in the network 
connectivity report as inflow nodes at the junction. 

ReachElement—a Reach element; a primary schematic element. As far as 
the network connectivity is concerned, reaches do not have sub-
elements and, when connected properly, they have only one 
inflow and one outflow node. 

DiversionElement—a diversion; a primary schematic element.  Diversions 
are a bit more complex than junctions or reaches; they do 
contain sub-elements.  Every diversion has one sub-element 
named Cntrl which identifies flow entering the diversion.  If the 
diversion is routed or returned to the system, there will also be a 
sub-element named Rch, which represents the flow leaving the 
diversion. 

ReservoirElement—a reservoir; a complex element in the network that 
contains other sub-elements.   

If a sub-element of the reservoir is a complex element with sub-
elements of its own, it may be one of the following: 

ReservoirDamElement—the dam.  The dam contains at least two 
sub-elements by default—Tailwater and L&O. 

DivertedOutletElement—a diverted outlet that was added to the 
reservoir.  Like the dam, it will have a “tailwater” sub-
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element and, if connected back into the network at its 
downstream end, it will also have a “reach” element. 

OutletGroupElement—an outlet group added to the dam, 
diverted outlet, or another outlet group. 

If a sub-element of the reservoir or of one of its complex sub-
elements is a simple element with no sub-elements of its own, it 
will be labeled Element and may represent one of the following: 

The Pool—the storage element of the reservoir. 

The Tailwater junction—the collector of the various release 
elements of the dam or diverted outlet. 

The L&O—the default release element of the dam that 
represents Leakage (if specified) and Overflow. 

An Outlet—a release element added to the dam or to an outlet 
group. 

ID—the number of the element or node. 

Name—the name of the element or node.  Elements will show either the name you 
gave the element or the name ResSim assigned to it—like Pool for the 
reservoir pool element.  Nodes that represent a local inflow at a junction will 
show the name you gave to the local inflow. All other nodes are assigned a 
name in the form ~Enn where nn usually relates to the element number of 
the parent element of the node. 

Function/Upstrm Elem—Elements will indicate the purpose of the element, e.g., the 
function of a controlled outlet is AdjustableFlow.   

Nodes will identify the ID number of the element upstream of the node. 

Parent/Dnstrm Elem —Sub-elements will indicate the name of the parent element to 
which the sub-element belongs.  If blank, the element is a primary element. 

Nodes will identify the ID number of the element that is downstream of the 
node. 

Note: the purpose of the Network Connectivity Report is to show how all the network 
elements are connected through the inflow and outflow nodes listed with each 
element.  But to fully understand the report you need to know a few things: 

1) Every element has an outflow node that “belongs” to that element; that 
node will always show the ID number of the element it belongs to (or one of 
that element’s sub-elements) as the upstream element. 

2) Local inflows appear as inflow nodes at junctions; these nodes display blank 
for the upstream element. 

3) Inflow nodes almost always “belong” to an element other than the element 
in which they are listed as an inflow node.  The exceptions to this are: 

a. Diversions are treated as negative inflows at junctions.  Thus, 
Diversion elements place an inflow node at the junction from which 
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they remove water and that node appears as an outflow node in the 
diversion element.  That’s bad enough but this oddity also shows up 
in the upstream and downstream element ids.  The inflow node that 
represents the flow going to the diversion has the diversion element 
id as the upstream element; and that same node, listed as an 
outflow node at the diversion, has the ID number of the junction 
element it is taking water from as the downstream element.   

b. Reservoir sub-elements that represent a group of outlets (dam, 
outlet group, or diverted outlets) act like a passthrough element for 
the elements they contain; thus, the inflow nodes listed in the dam 
are also inflow nodes to the outlets they contain, even if those 
outlets are contained in an outlet group.  In addition, each group-
type element contains a junction sub-element that collects the 
outflow nodes of the outlets into a single outflow that then appears 
as the outflow node of the (internal) junction and of the group. 

To generate a Network Connectivity report for all elements in the active network: 

• from the Reports menu, select Advanced → Network Connectivity → All 
Elements (Figure 6.31) 

Figure 6.31 Reservoir Network Reports—Advanced—Network 
Connectivity—“All Elements” 

 

To generate a Network Connectivity report for a set of selected elements: 
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• First, select elements you want in the report by holding down the Shift key 
and clicking on the desired elements in the Map Display area (holding the 
Shift key allows you to select multiple schematic elements as indicated in the 
map shown in Figure 6.32). 

 

Figure 6.32 Selection of Multiple Schematic Elements 

• Then, from the Reports menu, select:  Advanced → Network Connectivity → 
Selected Elements.  The report will look just like the one shown in Figure 6.31 
but will only contain information for those elements you selected in the Map 
Display area. 

The Find menu of the Network Connectivity report allows you to search for text 
strings within the report.  

6.5.7 The Node List 

The second advanced report is the Node List (Figure 6.33).  This report provides a 
summary of all nodes in your reservoir network.  Details include the Node ID, Name, 
Key String, Upstream Element, Downstream Element, Stream, Stream Station, and 
Stream Coordinate (i.e., a normalized position on the stream). 

To generate a Node List report: 

• from the Reports menu, select Advanced → Node List 
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Figure 6.33 Reservoir Network Reports—Advanced—Node List 

The Edit menu provides two options:  Clean Network and Delete Node.  These 
options can potentially damage a working network and should only be used when 
recommended by a ResSim technical expert. 
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Chapter 7 

Junctions, Reaches, & Diversions 

Once you have created a reservoir network and established its connectivity (as described 
in Chapter 6), you will need to specify the properties of the elements in the network.  To 
do so, you will use ResSim’s specialized network element editors. This chapter explains 
the Junction, Reach, and Diversions Editors and how to enter and edit data for these 
network elements. Chapters 8-12 describe the Reservoir Editor and how to edit the 
physical and operational data for your reservoirs.  

As explained in Chapter 6, the Reservoir Network module of ResSim is effectively the 
editor of a reservoir network.  As such, the Reservoir Network module is where you will 
create your reservoir network and definite the data for its elements.  However, when you 
begin to compute your alternatives in the Simulation module, you will learn that the 
same editors you used to define the elements of you network are accessible there as 
well. 

There are two methods for accessing the element editors 
from the ResSim interface:  

From the Edit menu—select the element type you 
want to edit.  Figure 7.1 shows the Edit menu 
and its list of Editors that you can use to edit 
the elements of your network. 

From the Map Display—Using either the Pointer Tool  

 or the specific element’s Tool  , right-
click on the element in the Map Display area 
and select Edit … Properties from the 
schematic element’s context menu  

All the reservoir network element editors (e.g., the 
Junction Editor, shown in Figure 7.2) share some common characteristics.  These include:  

Name Field—The Name field at the top of the editor displays the name of the 
element that you are currently editing.  However, in addition to identifying 
the current element, the Name field has a second function—it is an element 
selector; it contains a list of all the elements (of this editor’s type) in your 
network, allowing you to select any element in the list to edit without leaving 
the editor. 

Navigation Buttons—To the right of the Name field are a set of Navigation Buttons 
 that allow you to move forward and backward through the list 

of elements for editing.  

The leftmost button  will take you to the first element in the list. 
The rightmost button  will take you to the last element in the list.   
The middle two buttons,  and , will select the previous or next element, 
respectively, in the list.  

 

Figure 7.1 Reservoir Network 
Module—Edit Menu 



Chapter 7 - Junctions, Reaches, & Diversions HEC-ResSim User’s Manual 

7-2  

The box in the middle of the navigation buttons  displays the index of 
the current element and the total number of elements of that type in the 
currently open dataset (in this case, the network). 

 

Figure 7.2 Element Editor—Common Features 

Description Field—Below the Name field is the Description.  If you provided a 
description when you named the network element (or its associated 
configuration element), that description will appear in this field.  Almost all 
description fields throughout ResSim are editable, allowing you to change 
and add to them as you work on your model. 

Thumbnail Plot—Wherever a table of data appears in a ResSim editor, a small plot 
called a thumbnail plot will accompany it, as illustrated in Figure 7.2. These 
plots are included to help you quickly notice bad data in the table.  To get a 
full-size plot of the data, double-click on the thumbnail plot. 

 

Description Fields accompany almost every namable object you will 

create in ResSim.  They are included in the Name dialog when you 

first create an object and they are also included in all the editors 

where you define the data for the object.    USE THEM!   

You’ll find there’s nothing more helpful to you, other modelers, and 

reviewers than a well internally-documented model. 

So, when you enter your descriptions, try to answer as many of the 

Who, What, Where, When, Why, and How questions as you can; 

describe what the object represents, the sources of the data or 

parameters, why you chose to represent the physical or operational 

element the way you did, and what result or behavior you were 

expecting. 
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Tab Panels—The Tabs provide access to various parameters for defining the current 
element.  

Observed Data tab—The Observed Data tab (Figure 7.3) contains a table 
listing the computed parameters for the element.  If you may want 
to associate an observed time series with one or more of the listed 
variables, place a checkmark in the checkbox to the right of the 
Variable(s) of interest by clicking anywhere in the checkbox’s cell. For 
each Location and Variable that has a checkmark in the Observed 
box in the table, a corresponding entry will appear in the table on 
Observed Data tab of the Alternative Editor.  See Chapter 14 for 
details on associating observed time series data in the Alternative 
Editor with the selected locations and variables from the element 
editors. 

Figure 7.3 Element Editor—Observed Data Tab 

 

 

OK, Cancel, and Apply Buttons—Use these buttons to save or discard your changes 
and close the Editor: 

OK—will save your changes and close the Editor.   
Cancel—will discard your changes and close the Editor. 
Apply—will save your changes without closing the Editor.  You should use the 

Apply button before changing tabs or navigating to another element 
in the Editor.  Even if you Cancel after an Apply, your changes up to 
the last Apply action are saved. 

  

 

Providing observed data is optional.  ResSim uses observed 

data for comparison purposes only — and then, only in its 

standard element plots accessible from the active schematic 

in the Simulation module. ResSim does not use observed 

data in its computations. 
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7.1 The Junction Editor 

Use the Junction Editor (Figure 7.4) specify the properties of the junctions in your 
network.   

The Junction Editor has four tabs on which you will define your junction data:  

• Info 

• Local Flow 

• Rating Curve, and  

• Observed Data. 

These tabs are described in the following sections. 

7.1.1 Junction Editor—Info Tab 

The Info tab of the Junction Editor 
(Figure 7.4) displays the Stream 
Station, Stream, and Tributaries 
associated with your junction. These 
properties describe the junction’s 
relationship to the stream 
alignment.  

Stream Station—the position of the 
junction is described as its 
distance (in map units) from 
the downstream end of the 
stream it’s on in the stream 
alignment. 

If the junction is not associated with a computation point in a watershed 
configuration, the Stream Station can be edited. However, by changing the 
stream station of a junction, you are changing the position of the junction 
along the stream alignment, so be careful with this option, you can get 
unintended consequences and there are restrictions — for example, you 
should not attempt to move a junction above or below another junction on 
the current stream by changing its stationing.   

Stream and Tributaries—These fields are provided so that you can verify that the 
junction is located where you intended when you placed it in your schematic 
from the Reservoir Network or Watershed Setup module.   

Label Position—Near the bottom of the Info tab is a Label Position field.  This field is a 
dropdown list that contains the 8 points on the compass (North, South, East, 
West, Northeast, Northwest, Southeast, and Southwest). Use this field to 
control where the label for the current junction will display in the Map 
Display area.  The junction’s Name will be drawn horizontally in the position 
you selected with respect to the center of the junction (plus a small offset). 

 

Figure 7.4 Junction Editor—Info Tab 
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7.1.2 Junction Editor—Local Flow Tab 

The Local Flow tab (Figure 7.5) of the 
Junction Editor contains a table 
where you can identify one or more 
inflows entering the river system at 
this junction.  

You must identify at least one inflow 
at each headwater junction in your 
watershed; inflows at all other 
junctions are optional. Each inflow is 
identified by a unique Name and 
Factor. 

Name—The name of each Local Flow 
should identify the source of 
the inflow or contain some 
other uniquely identifying information so that it will be clear what is required 
when it comes time to associate a time series of flow data with this inflow in 
the Time-Series tab of the Alternative Editor. (See Chapter 13 for more on 
creating Alternatives.)   

There is limit on length of the local flow name, 
but it should be unique within the first 24-32 
characters.  And, since this name will be used in 
the B Part of a DSS pathname, do not use the 
following characters: \ ‘ / ` “ and |. 

Factor—The factor value is provided to enable you to provide a weighting of the 
values in the associated inflow hydrograph.  Use this Factor for “basin 
weighting” of a single inflow hydrograph across multiple junctions. The 
default value for the Factor is 1.0.  

When you identify one or more local inflows on the Local Flow 
tab of a junction, then a visual clue will appear in your model 
schematic in the map display.  This visual clue appears as a 
white circle or halo around the junction, as illustrated in 
Figure 7.6. The white halo makes it easy to tell at a glance 
where inflows are coming into your reservoir network. 

 

  

Figure 7.5 Junction Editor—Local Flow Tab 

 

NOTE: Local flows 

cannot have the same 

name as a junction (or 

any other network 

element). 

Figure 7.6 Junction 
with Local Inflow 
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7.1.3 Junction Editor—Rating Curve Tab 

Most junctions do not require a rating 
curve, but for those that do or for any 
junction where you would like ResSim 
to output stage associated with is 
computed junction flow, you can use 
the Rating Curve tab (Figure 7.7) to 
enter a rating curve for that junction.  
Two options are available for entry of a 
rating curve — Simple Rating and Rating 
Function. 

Simple Rating—A Simple Rating can be 
used where you have a 
relationship between Flow and 
Stage at the junction. ResSim 
considers Flow to be the 
independent variable and Stage 
to be the dependent variable of a rating curve so be sure to enter Flow in the 
first column of the table and Stage in the second column. Figure 7.7 shows 
an example of a Simple Rating. 

Rating Function—A Rating Function can be used when Stage is a function of a 
variable other than Flow at the junction or when Stage is influenced by backwater 
effects. If you select the Rating Function option, you will be able to specify a 
stage lookup table as a function of: 

• Model Variable, 

• External Variable, 

• State Variable, or 

• Two Variables 
(such as flow and 
downstream pool 
elevation).  Figure 
7.8 illustrates an 
example of a family 
of rating curves 
(stage as a function 
of two 
independent 
variables). For 
more information 
on setting the 
independent 
variable(s) of a 
function (lookup 
table), refer to Appendix C.   

 

Figure 7.7 Junction Editor—Rating Curve Tab 

 

Figure 7.8 Junction Editor—Rating Curve—Function 
of Two Variables 

New 
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7.2 The Reach Editor 

Reaches route water through your reservoir network by employing a hydrologic routing 
method.  Use the Reach Editor (Figure 7.9) to specify routing method, the routing 
parameters, and the loss rates for each of your reaches.   

 

Figure 7.9 Reach Editor 

The Reach Editor has three tabs with which to define your reach data:  

• Routing, 

• Losses, and  

• Observed Data.  

These tabs and their options are described in the following sections. 

7.2.1 Reach Editor—Routing Tab 

The Reach Editor’s Routing tab (Figure 7.10) is where you will select the reach’s 
hydrologic routing method and enter the parameters for the selected method. There 
are nine routing methods to choose from:  

• Null Routing 

• Coefficient 

• Muskingum 

• Muskingum-Cunge 8-pt Channel 

• Muskingum-Cunge Prismatic Channel 

• Modified Puls, SSARR, Working R&D Routing 

• Variable Lag & K.  

Each method requires a different set of parameters.   

Select the routing method for the reach from the dropdown list of the Method 
selector.  The panel below the Method selector will fill with the appropriate fields for 
defining the parameters for the routing method you selected.  
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NOTE: If the flow entering a reach is negative, only the Null and Coefficient 

Routing methods will “route” that negative flow to the outflow of the reach.  All 

other routing methods will not route negative flow and will instead produce a 

zero outflow.  This “zero-ing out” of the negative inflow has the net effect of 

“creating water” and could be considered a violation of the conservation of 

mass of the system. 

 

7.2.1.1 Null Routing 

The Null Routing method 
produces an instantaneous 
translation of the inflow to the 
outflow of the reach.  Since this 
method applies no lag or 
attenuation to the inflow, it 
requires no parameters as you 
can see in Figure 7.11. If you 
have a very short reach or a 
reach that exhibits no lag or attenuation of the hydrograph, you can use Null 
Routing. 

7.2.1.2 Coefficient Routing 

The Coefficient Routing method is a linear hydrologic routing method that 
describes the routing with a series of timesteps and coefficients (or factors). The 
coefficient method uses the following equation to compute outflow from the 
reach: 

𝑂𝑡 = ∑ 𝐶𝑖 ∗  𝐼𝑡−(𝑖−1)

𝑛

𝑖=1

 

 

Figure 7.10 Reach Editor—Routing Tab    

Figure 7.11 Null Routing Edit Panel 
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Where: 

O = Outflow 
I = Inflow 
C = Coefficient 
t = the current timestep 
n = the number of rows in the table. 

Each coefficient equates to the fraction of the flow entering the reach that will 
reach the downstream end at the end of each timestep in the table.  The values 
in the table must sum up to 1.  The coefficients represent the fraction of the flow 
entering the reach in the current timestep that will exit the reach in the current 
and subsequent timesteps. 

Figure 7.12 shows the edit panel 
for the Coefficient Routing 
method.  In the example, 75% of 
the flow entering the reach in the 
current timestep plus 25% of the 
previous timestep’s inflow will exit 
the reach in the current timestep.  
The other 25% of the current 
timestep’s inflow to the reach will 
exit the reach in the next timestep, 
along with 75% of the next 
timestep’s flow into the reach.   

 

If you enter a coefficient of 1.0 in the first row of the Coefficient Routing 

table and leave the rest of the table blank, you have defined a Null or 

instantaneous routing reach — all the flow entering the reach will exit 

the reach in the same timestep. 

7.2.1.3 Muskingum Routing 

The Muskingum routing method 
(Figure 7.13) is a linear routing 
method that describes the 
routing with three parameters: 
Muskingum K, Muskingum X, 
and Number of Subreaches.   

The Muskingum method 
computes outflow from the reach using the following equation: 

𝑂𝑡 = (𝐴 − 𝐵) ∗ 𝐼𝑡−1 + (1 − 𝐴) ∗ 𝑂𝑡−1 + 𝐵 ∗ 𝐼𝑡 

Where: 

𝐴 =
2 ∗ ∆𝑡

2 ∗ 𝐾 ∗ (1 − 𝑋) + ∆𝑡
 

𝐵 =  
∆𝑡 − 2 ∗ 𝐾 ∗ 𝑋

2 ∗ 𝐾 ∗ (1 − 𝑋) + ∆𝑡
 

Figure 7.12 Coefficient Routing Edit Panel 

Figure 7.13 Muskingum Routing Edit Panel 
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and: 

O = Outflow 
I = Inflow 
t = the current timestep 
∆t = the length of the timestep 
K = Muskingum K 
X = Muskingum X 

Muskingum K—The travel time for the reach, in hours; i.e., how long it takes for a 
drop of water that enters the reach to exit the reach.  

Muskingum X—The Muskingum weighting factor or attenuation coefficient, a 
value from 0.0 to 0.5.  X= 0.0 indicates maximum attenuation of the 
hydrograph through the routing reach.  X=0.5 indicates no attenuation; a 
“direct translation” of the hydrograph through the reach. 

Number of Subreaches—The travel time through any reach should be at least as 
long as the timestep.  If the travel time is greater than the timestep, the 
number of subreaches should approximately equal K/∆t.  If the travel 
time of a reach is less than half the length of the timestep, consider using 
Null routing. 

 

A Rule of Thumb… 

The Number of Subreaches should equal K/∆t (rounded to a 

whole number), where: 

K is the travel time and  

∆t is the length of the timestep (in hours). 

7.2.1.4 Muskingum-Cunge 8-pt Channel Routing  

The Muskingum-Cunge 8-pt Channel routing method is a non-linear hydrologic 
routing method that uses a representative cross section to apply a physical or 
hydraulic influence to the method.    

The edit panel for the Muskingum-Cunge 8-pt Channel Routing method is shown 
in Figure 7.14. This panel includes a generalized illustration of an 8 point cross 
section to provide a guide for defining the cross section.  Below the illustration is 
a thumbnail plot to show your cross section as defined in the Cross Section Table. 
Use the thumbnail plot to verify that your cross section points were entered 
correctly and adequately reflects the cross section template shown in the 
illustration.  
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Figure 7.14 Muskingum-Cunge 8-pt Channel Routing Edit Panel 

The parameters for defining the Muskingum-Cunge 8-pt Channel routing method 
include: 

Channel Length—The length of the routing reach, measured along the channel 
centerline.  This value is not computed by ResSim based on the stream 
alignment. 

Channel Slope—The average bed slope of the routing reach, y/x. 

Eight Station and Elevation pairs—The horizontal and vertical position 
(respectively) of each point used to describe the representative cross 
section for the reach.   

Manning’s n Values—The roughness coefficients for the Left Overbank, Main 
Channel, and Right Overbank are used in the normal depth calculations 
of the cross section.   

 

The cross section illustration in the edit panel for the Muskingum-Cunge 

8pt Channel routing method shows the numbering of the eight cross 

section points and how they relate to the partitioning of the cross section 

into a Left Overbank, Channel, and Right Overbank. This illustration 

indicates that points 3 and 6 are the bank stations of the cross section, 

these points the mark the boundary between the channel and the 

overbanks.  

Be sure that when you enter your cross section into the Cross Section 

Table that its bank stations are at points 3 and 6. 
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Default Reference Flow—The reference flow is used to compute the celerity of a 
flood wave through the reach which is then used to compute the travel 
time for the reach. If the travel time is greater than the size of the 
computation interval (timestep), the reach is divided into subreaches for 
the computations.  Travel time is usually greater for low flow; therefore, 
start with a default reference flow value that approximates the base flow 
for the reach. 

Routing Timestep Subintervals—As its name suggests, this parameter is the 
number of increments to break the timestep into for purposes of 
numerical stability of the Muskingum-Cunge solution.  Although some 
implementations of the Muskingum-Cunge method include a strategy for 
determination of the subintervals based on a review of the inflow 
hydrograph, this option is not feasible for ResSim because the flow 
hydrographs into the reaches downstream of the reservoirs are not 
“known” at the start of a ResSim simulation. As a result, ResSim requires 
you to select the number of subintervals as a whole number value 
between 1 and 12.   

 

A Rule of Thumb… 

Use fewer subintervals for constant or gradually varying flow. 

Use more subintervals for rapidly varying flow. 

7.2.1.5 Muskingum-Cunge Prismatic Channel Routing 

The Muskingum-Cunge Prismatic Channel method (Figure 7.15) is the same basic 
method as the Muskingum-Cunge 8-pt Channel method but it uses one of two 
shapes to describe the representative cross section—a trapezoid or a circle. Use 
this method for reaches that have no overbanks and whose channel cross section 
can be approximated by a trapezoidal shape or for routing through pipes or 
culverts.  

The parameters for defining the 
Muskingum-Cunge Prismatic 
Channel method include: 

Channel Length—The length of the 
routing reach, measured 
along the channel 
centerline. 

Channel Slope—The average bed 
slope of the routing reach, 

y/x (“rise over run”). 

Manning’s n—The roughness 
coefficient to be used in 
the normal depth 
calculations of the cross 
section. 

Figure 7.15 Muskingum-Cunge Prismatic 
Channel Routing 
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Channel Shape—Select from the following channel cross section shapes: 

Prismatic—the representative cross section is shaped like a trapezoid (whose 
bottom width is less than or equal to its top width — see Figure 
7.16).  The trapezoidal 
shape is defined by two 
parameters: a bottom 
width and a side slope; 
depth of the trapezoid is 
not required, ResSim will 
assume the channel is 
infinitely deep.  

Bottom Width—b, the width of the bottom of the trapezoidal 
section. 

Side Slope—z, the slope of the sides of the trapezoid entered as 

x/y. (“run over rise”. Yes, this is the inverse of the bed 
slope.)  If the sides of your trapezoid are vertical, the slope is 
0.0. 

Circular—This cross section shape is a simple circle.  Use this shape to 
represent a free-flowing pipe or culvert. This method and shape is 
valid for flow depths up to 0.77*diameter.  For depths greater than 
this, the depth used by the method is held to 0.77*diameter and a 
warning message is generated.  If you choose Circular as the Channel 
Shape, you also need to specify the Channel Diameter. 

Channel Diameter—Define the size of the circle. 

Muskingum-Cunge Stability Control—Enter the default reference flow and the 
routing timestep subintervals. 

Default Reference Flow—The flow value is used to compute the celerity (and 
thus the travel time) for the reach.  If the travel time is greater than 
the timestep size, the reach is divided into subreaches for the 
computation.  Travel time (and thus the number of subreaches) is 
greater for low flow; therefore, the reference flow value should 
approximate the base flow for the reach. 

Routing Timestep Subintervals—As its name suggest, this parameter is the 
number of increments to break the timestep into for purposes of 
numerical stability of the Muskingum-Cunge solution.  Select the 
number of subintervals as a whole number value between 1 and 12.   
 

  

Figure 7.16 Prismatic Channel 
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7.2.1.6 Modified Puls Routing 

The Modified Puls routing method (Figure 7.17) describes the reach as a series of 
cascading reservoirs, the number of which is specified by the Number of 
Subreaches.  The outflow from the reach is defined as a function of storage in the 
reach.  The parameters for defining the Modified Puls routing method are 
described below: 

 

Figure 7.17 Reach Editor—Modified Puls Routing Method 

Storage and Outflow—Enter a monotonically increasing set storage and outflow 
values to describe the storage-outflow relationship needed for this 
routing method.  HINT: An HEC-RAS steady-flow model can be used to 
develop a Storage-Outflow relationship for use in this method. 

Number of Subreaches—This parameter is similar to that used in the Muskingum 
routing method.  Enter the reach travel time divided by the computation 
interval. 

Channel Losses—An option to compute Channel Losses due to seepage within 
the routing computation is included in the edit panel for the Modified 
Puls routing method. The data required to use this option includes 
Elevation data associated with the Storage values in the Storage-Outflow 
table, an average Invert Elevation for the reach, and a Percolation (or 
Seepage) Rate.  However, the Channel Losses option and all the 
associated data entry fields have been disabled in this version.  See the 
Losses tab of the Reach Editor to learn how to define channel losses that 
are computed independently of the routing method. 

 

7.2.1.7 SSARR Routing Method 

The SSARR routing method (Figure 7.18) is an implementation of the channel 
routing method used in the computer program Streamflow Synthesis & Reservoir 
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Regulation (SSARR) developed the Corps’ Northwestern Division (USACE, 1991) 
and NOOA’s North West River Forecast Center. 

Figure 7.18 Reach Editor—SSARR Routing Method 

SSARR is conceptually similar to Modified Puls in that it represents the reach as a 
“chain of lakes” and the Number of Subreaches defines the number of “lakes in 
the chain.  The routing of each lake in the chain is described by the equation:  

𝑂𝑡 =  𝑂𝑡−1 +  ∆𝑡 ∗
𝐼𝑚 − 𝑂𝑡−1

𝑇𝑠 + 
∆𝑡
2

 

Where: 

Ot  = Outflow for this timestep 
Ot-1 = Outflow for the previous timestep 
∆t  = length of the timestep 
Ts = time of storage 
Im = the mean inflow 

Two options are available for defining the parameters for this routing method: 

Outflow vs Time of Storage (Interpolation table)—In this form of the SSARR 
method, the outflow vs. reach storage is defined by Time of Storage 
values, Ts in units of hours.   

Time of Storage equation—this equation defines Ts as a power function of 

outflow: 

𝑇𝑠 =
𝐾𝑇𝑆

𝑄𝑛
 

Where: 

Ts = Time of Storage (per increment, in hours) 
Q  = Outflow 
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KTS  = Coefficient, determined empirically  
n       = The power coefficient on outflow; usually between -1.0 

and 1.0. 

As evident from the above equation, Ts is a nonlinear function of 

discharge except when n = 1.  A negative value of n is used when 
time of storage increases as discharge increases.  According to the 
SSARR User’s Manual, a value of n = 0.2 is reasonable for most 
streams in the Columbia River Basin. 

7.2.1.8 Working R&D Routing 

The Working R&D routing method (Figure 7.19) uses a nonlinear storage-outflow 
relation, like the Modified Puls method, but it adds the concept of wedge 
storage, like the Muskingum method.  For a linear storage-outflow relation, the 
Working R&D method produces results identical to the Muskingum method.  For 
routing with no wedge storage (Muskingum X = 0), the Working R&D method 
produces results identical to the Modified Puls method (USACE, 1994). 

This method is not widely used.  In fact, it has been so long since anyone 
attempted to apply it in ResSim that no one noticed that the Storage-Outflow 
table is nonfunctional.  This will be corrected in or removed from future versions 
of the software. 

 

Figure 7.19 Reach Editor—Working R&D Routing Method  

Storage and Outflow—Use a monotonically increasing set of storage and outflow 
values to describe the storage-outflow relationship needed for this 
routing method. 

Muskingum X—The attenuation coefficient used in the wedge storage 
computations (from 0.0 to 0.5).  A value of 0.0 indicates maximum 
attenuation of the hydrograph through the routing reach.  A value of 0.5 
indicates a “direct translation” of the hydrograph through the reach. 

Number of Subreaches—The number of steps (subreaches) applicable for the 
routing reach.  This parameter should be approximately equal to travel 
time divided by the computation interval. 
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7.2.1.9 Variable Lag & K 

The Variable Lag & K method (Figure 7.20) is a hydrologic routing method for use 
between flow points that is based on a graphical routing technique.  This method 
was added to ResSim at the request of the National Weather Service.  Lag & K is a 
flexible method of storage routing, where both Lag and K values can be either 
constant or variable.  Lag & K works by delaying the inflow hydrograph in time 
causing a Lag in the graph.  The K value is used to attenuate the newly shifted 
curve.  

Figure 7.20 Reach Editor—Variable Lag & K Method 

Constant Lag (hrs)—The travel time of the reach in hours. 

Lag vs. Inflow—The Lag vs Inflow table is why the method is called “Variable”.  
Use the Lag vs Inflow table to describe the relationship between Inflow 
and travel time. 

Constant K (hrs)—the attenuation factor, in hours. The derivation of K is often 
given as a ratio of channel storage to discharge. It is related to the K 
value used in the Muskingum method. 

K vs. Outflow—K can vary as a function of Outflow.  Use the K vs Outflow table to 
enter the function; the Outflow values must be monotonically increasing. 
The thumbnail plot to the right of this table displays the data you 
entered in the table. 
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7.2.2 Reach Editor—Losses Tab 

The Losses tab of the Reach Editor (Figure 7.21) provides two options for computing 
losses in the routing reach:   

Constant Seepage—The flow (in cms or cfs) lost to the reach through the soil. This 
value will be constant throughout the simulation. 

Seepage as a function of Flow—This option lets you define the loss as a function of 
the routed flow of the reach; flow values should be monotonically increasing. 
The thumbnail plot will reflect the values you enter in the table and can be 
viewed in full size when you double-click on it. 

 

Figure 7.21 Reach Editor—Losses Tab 

Reach losses are computed after the flow is routed through the reach; therefore, the 
final outflow from the reach is the routed flow minus the losses.  
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7.3 The Diversion Editor 

Diversions remove water from your river system at junctions in your reservoir network.   

If a diversion is connected at its downstream end to another junction in the network, that 
diversion is said to be “connected” and the downstream junction will receive the routed 
diversion flow as inflow.  Connected diversions have a reach component to allow you to 
specify the routing and channel losses through the diversion reach. If a diversion is not 
connected at its downstream end, it is said to be “unconnected”, and it removes the 
diversion quantity of flow from the network completely.  

Diversions take priority over a reach or reservoir that may be connected to the outflow of 
the junction, so if there is not enough flow entering the diversion’s source junction to 
meet the specified diversion quantity, the diversion will get all there is, and the 
downstream element will receive zero inflow. Although unusual, a diversion is allowed to 
have a negative diversion quantity; a negative diversion will be seen as inflow to the 
junction. 

Use the Diversion Editor (Figure 
7.22) to specify the diversion flow 
(or demand) for each diversion in 
your network.   

The Diversion Editor has four tabs 
for defining the data related to your 
diversion: 

• Diversion 

• Losses 

• Routing 

• Observed Data 

These tabs are described in the 
following sections. 

NOTE: the Losses and Routing tabs 
are available only for connected 
diversions (diversions that connect 
to another junction at their outflow). 

 

7.3.1 Diversion Editor—Diversion Tab 

The Diversion Editor’s Diversion tab (Figure 7.23) is where you will specify the 
diversion demand—the quantity of flow that the diversion will try to withdraw from 
its source (upstream) junction.  This tab has two data entry fields: Method and 
Computed during UnReg, and an edit panel in between them. 

Method—The Method selector offers seven options for specifying the diversion 
quantity:  

 

Figure 7.22 Diversion Editor   
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• Constant  

• Monthly Varying 

• Seasonal  

• Function of Flow 

• Function of Pool 
Elevation 

• Time Series 

• Flexible Diversion 
Rule   

Select the diversion 
method from the 
Method list.  The edit 
panel below the Method 
selector will fill with the 
appropriate fields to 
enable you to specify the parameters for the diversion method you have 
selected.  The default method is Constant. The diversion methods are 
described in the following sections. 

Computed during UnReg—Activate the Computed during UnReg checkbox if you 
want the diversion to be reflected in the unregulated flow computations.  If 
checked, the diversion will operate during the unregulated flow calculations; 
if unchecked, the unregulated flow will reflect flow conditions without the 
diversion. 

7.3.1.1 Diversion Method—Constant 

Use the Constant diversion method 
(Figure 7.24) when the desired 
withdrawal from the river system is 
always the same amount. The only 
parameter for this method is the 
flow rate of the diversion.  This 
constant value will apply to each 
period of your simulation.  

7.3.1.2 Diversion Method—Monthly Varying 

Use the Monthly Varying diversion method (Figure 7.25) when the withdrawal 
from the river varies on a monthly basis.  For this method, you will need to enter 
the diversion flow value corresponding to each month of the year.  These 
monthly values will apply to each year in your simulation.  

 

Figure 7.23 Diversion Editor—Diversion Tab 

 

Figure 7.24 Constant Diversion Method 
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Figure 7.25 Monthly Varying Diversion Method 

 

7.3.1.3 Diversion Method—Seasonal 

Use the Seasonal method (Figure 7.26) when the withdrawal pattern varies as a 
function of date but not on a monthly basis.  For each season, you will need to 
enter: 

• a Date, in the format ddMMM (e.g., 01Jan), for the beginning of the season 

• an associated Diversion flow value.  

The seasonal table always starts on the first of January (01Jan), so if you have a 
season that spans across the calendar year boundary, be sure to specify the start 
of that season as the last entry in your table (as well as the first). Like the 
monthly varying diversion, the seasonal diversion is a pattern that repeats for 
each year of your simulation and each season’s desired value applies until the 
start of the next season (i.e., step interpolation will be used between values in 
the table). 

Figure 7.26 Seasonal Diversion Method 
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7.3.1.4 Diversion Method—Function of Flow  

Use the Function of Flow diversion method (Figure 7.27) to describe the 
diversion demand as a function of flow in the river.  Although for most function-
of-flow diversions the location of the flow is usually the diversion’s source 
junction, you can identify any junction in the network as the flow location for the 
function. 

When specifying the data for this method, first select the Flow Location from the 
list of junctions in your network. Then, define the diversion function—the 
relationship between the Flow Location’s Flow and the Diversion flow.  Linear 
interpolation will be used between values in the table. 

 

Figure 7.27 Function of Flow Diversion Method   

 

7.3.1.5 Diversion Method—Function of Pool Elevation  

Use the Function of Pool Elevation diversion method (Figure 7.28) to describe a 
diversion demand that varies with the pool elevation of a reservoir in your 
network. For this method, you will need to select the reservoir from the 
Reservoir list and then specify the relationship between that reservoir’s pool 
Elevation and the Diversion flow. Linear interpolation will be used between 
values in the table. 

Figure 7.28 Function of Pool Elevation Diversion Method 
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7.3.1.6 Diversion Method—Time-Series 

Use the Time-Series diversion method (Figure 7.29) for a diversion whose 
demand varies through time without a repeating pattern and without any 
relationship to flow or pool elevation.   

Figure 7.29 Time-Series Diversion Method 

The edit panel for the Time-Series method has no data entry fields; instead you 
will be required to identify a time-series for this diversion when you setup your 
alternatives; an entry for this diversion 
will appear in the Time-Series mapping 
table when you create an Alternative 
(Chapter 13).  The time-series you 
provide must be in standard units of 
flow (cfs or cms). 

 

7.3.1.7 Diversion Method—Flexible Diversion Rule 

The Flexible Diversion Rule diversion method (Figure 7.30) was added to allow 
the diversion demand to be specified as a function of any model variable or state 
variable and thus, make specification of the diversion demand as “flexible” as a 
reservoir release rule (see Chapter 11, Section 11.2).  Although virtually every 
other diversion method could be replaced by this method, the older methods 
with their simpler interfaces are easy to understand and use.  

The data required to specify a “flexible diversion rule” depends on how you 
define the function.  The common options for defining the rule are described 
below. 

 

You can also use the Time-Series 

diversion method when you want 

to change the diversion demand 

per alternative without having to 

change the network. 

 

Figure 7.30 Flexible Diversion Rule Method  
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Function of—The first step in specifying a Flexible Diversion Rule is to identify 
the independent variable of the “function” (the diversion quantity is the 
dependent variable).  To 
do so, select the Define 
button to the right of the 
Function of: field. The 
Independent Variable 
Definition editor will 
open (Figure 7.31); use 
this editor to select the 
type of variable your 
“Release is a function 
of”.  Options include:  Date, Date and Time, Model Variable, External 
Variable, and State Variable.  See Appendix C for a description the 
Independent Variable Definition editor and of each of the variable types. 

Interp—Select an interpolation method to be used between values in the 
function table.  Options include Linear, Step, and Cubic.   

Hour of Day Multiplier—The primary purpose of the Hour of Day Multiplier is 
to turn the diversion on and off at specific times of the day, but it can 
also be used to vary the diversion demand throughout the day.  

To specify a set of hourly multipliers to be applied to the diversion 
demand, select the Hour of Day Multiplier Edit button.  The Hour of Day 
Multiplier dialog will appear (Figure 
7.32); this dialog has a table listing 
each hour of the day and an 
associated multiplier. The default 
multiplier is 1.0. 

For example, if you have a diversion 
that only requires flow from 6 a.m. to 
4 p.m., but the morning hours require 
twice as much flow as the afternoon 
hours, you could modify the 
multipliers as shown in Figure 7.32. 
The multiplier is 0.0 for the hours from 
0000 to 0600 and from 1600 to 2400 
(to turn off the diversion during those 
hours) and 0.5 for the hours from 
1200 to 1600.  Alternatively, you could 
enter 2 for the hours from 0600 to 1200 —the choice between applying 
0.5 for the afternoon or 2 for the morning is dependent on the values 
you specified in the diversion function that the multiplier will be applied 
to.  

Click OK to apply your entries and close the Hour of Day Multiplier dialog.  
A checkmark will appear in the checkbox in front of the Hour of Day 

 

Figure 7.31 Select Independent Variable 

Figure 7.32 Hour of Day Multiplier 
with Example Pattern 
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Multiplier label in the diversion edit panel when the default set of 
multipliers is modified. 

Time Interval—A selector for Time Interval is available in the Hour of Day 
Multiplier dialog.  This selector defaults to 1 hour, but options 
for intervals of 1, 2, 3, 4, 6, and12 hours are available; if you pick 
another interval, the Hour of Day Multiplier table will change to 
reflect your interval selection.  For example, if you chose 12 
hours, the Multiplier table would have only two rows, 0000-1200 
and 1200-2400.  If you placed 0.0 in the first row and 1.0 in the 
second, your diversion would divert flow only between noon and 
midnight. 

Day of Week Multiplier—The purpose of the Day of Week Multiplier is to turn 
the diversion on or off on specific days of the week, but it can also be 
used to vary the diversion demand throughout the week.  

Select the Day of Week Multiplier Edit button to specify a set of daily 
multipliers to be applied to the diversion demand.  The Day of Week 
Multiplier dialog will appear (Figure 
7.33). This dialog contains a table 
where you can specify a multiplier 
for each day of the week. The 
default value is 1.0.  

So, if you have a diversion that 
diverts only on weekdays, you can 
set the multiplier for Saturday and 
Sunday to 0.0 and leave all other 
days set to 1.0. 

Click OK to close the Day of Week 
Multiplier dialog. If the table 
contains any non-default values, a checkmark will appear in the Day of 
Week Multiplier check box in the diversion edit panel  

Seasonal Variation—The Seasonal Variation option allows you to add Date (or 
Season) as a second independent variable 
to your Function of relationship, but it is 
only active when your first independent 
variable is Model Variable, External 
Variable, or State Variable (i.e., a time-
series). 

So, if your diversion demand varies as a 
function of a time-series variable and 
seasonally, select the Seasonal Variation 
Edit button to specify the seasons.  The 
Seasonal Variation dialog (Figure 7.34) will 
appear.  This dialog contains a seasonal 
table in which you can enter dates that represent the start of each 

Figure 7.33 Day of Week Multiplier 

Figure 7.34 Seasonal Variation 
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“season”. Seasonal tables always start on 01Jan. If you have a season 
that crosses the calendar year boundary, it will be entered as two 
seasons, one at the beginning of the year and one at the end of the year 
(the first and last seasons in the table). 

The Seasonal Variation dialog also provides an option for Interpolation 
Type.  You can select from: Linear, Cubic, and Step.  This interpolation 
selection applies to the seasonal variation of your function (the columns 
of your table).   

Click OK to close the Seasonal Variation dialog. If you created more than 
one season, a checkmark will appear in the Seasonal Variation check box 
in the diversion edit panel and a column will be added to the function 
table for each season specified in the Seasonal Variation dialog. 

7.3.1.7.1 Flexible Diversion—Function of: Date 

If the diversion demand varies seasonally (as a function of date), select Date 
from the Release is a Function of: list in the Independent Variable Definition 
editor for your Flexible Diversion Rule’s function. A seasonal function table 
will appear in the diversion’s edit panel as illustrated in Figure 7.35. All 
seasonal tables in ResSim start on 01Jan.  You can enter a single demand 
value for 01 Jan to describe a constant diversion amount throughout the year 
or enter the appropriate dates and diversion flows to specify the relationship 
between time of year and the desired diversion flow (release). Be sure to 
specify the Interpolation type to indicate how to determine the value to be 
returned when the value of the independent variable is between values in 
the table. 

Figure 7.35 Flexible Diversion—Function of Date  

You can use the Flexible Function of Date diversion method to represent a 
Constant (Section 7.3.1.1), Monthly Varying (Section 7.3.1.2) and Seasonal 
(Section 7.3.1.3) diversion methods by selecting Step for the Interpolation 
method. However, by using Linear interpolation and/or Hour of Day and Day 
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of Week Multipliers, your flexible diversion function can be defined in ways 
the original methods could not. 

 

7.3.1.7.2 Flexible Diversion—Function of: Date and Time 

The Flexible Function of Date and Time diversion function is almost exactly 
the same as the Flexible Function of Date diversion function — with one 
difference—the addition of a Time column in the function table — see Figure 
7.36. Use this function type when the demand varies with both date and 
time.  When entering time values, use a 24-hour clock, e.g. 6 pm is 1800. 

7.3.1.7.3 Flexible Diversion—Function of: Model Variable  

If the diversion demand varies as a function of a standard variable computed 
by ResSim, you can use the Model Variable form of the Flexible Diversion 
rule.  To set up: 

• Select Model Variable from the Release is a Function of: selector in the 
Independent Variable Definition dialog. The features of this dialog are 
described in detail in Appendix C. 

The edit panel of the Independent Variable Definition dialog (Figure 7.37 
will fill with three Filter fields above a table containing all the model 
variable time-series computed by ResSim for the current network. To the 
right of the model variables table is a section labeled Time Series 
Options.  

 

All seasonal tables in ResSim treat each date entered as the 

beginning of the day, i.e., as applying at 0000 hours.  If you would 

prefer that it applied at the end of the day, use the next day or 

use a table that allows you specify Time as well as Date. 

Figure 7.36 Flexible Diversion—Function of Date & Time 
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• Find and highlight the appropriate model variable time-series for your 
function in the table, then click the 
Select button (Figure 7.37).  Your 
selection will appear in the 
Selected Model Time-Series field at 
the bottom.   

• Next, specify the Time Series Options to indicate which value to use from 
the selected time series at each timestep of the simulation. 

• Click OK when you have selected the Model Variable and Time Series 
Options for your function. The Flexible Diversion Rule edit panel will now 
contain a table for you to enter the relationship between the specified 
External Variable and the diversion demand. 

Be sure that the model variable time-series you selected appears in the 
Selected Model Time-Series field at the bottom of Independent Variable 
Definition dialog before clicking the OK button in the to apply your 
settings, close the dialog, and return to the Diversion Editor. The Flexible 
Diversion Rule edit panel will now contain a table for you to enter the 
relationship between the model variable and the diversion demand. 

7.3.1.7.4 Flexible Diversion—Function of: External Variable 

When the diversion demand varies as function of an external time-series, 
select External Variable from the Release is a Function of: list in the 
Independent Variable Definition dialog (Figure 7.38).  

When External Variable is selected, the edit panel of the Independent 
Variable Definition dialog will fill with a Variable Name text field and the Time 
Series Options.  The name you provide will appear in the Alternative Editor’s 
Time Series tab where you will be expected to associate an HEC-DSS time-
series dataset with this variable. Enter an appropriately descriptive variable 
name so that you know what time-series to use for each External Variable to 
specify in your model. 

 

Note: double-clicking on the 

variable you want will NOT 

perform the selection; you 

must use the Select button. 

 

Figure 7.37 Flexible Diversion—Function of Model Variable  
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Figure 7.38 Flexible Diversion—Function of External Variable 

The Time Series Options apply to the External Variable time-series in exactly 
the same way as they do for a Model Variable time-series.  See Appendix C 
for details on these options. 

Click the OK button in the Independent Variable Definition dialog to apply 
your settings, close the dialog, and return to the Diversion Editor. The 
Flexible Diversion Rule edit panel will now contain a table for you to enter 
the relationship between the specified External Variable and the diversion 
demand. 

7.3.1.7.5 Flexible Diversion—Function of: State Variable 

When the diversion demand varies as a function of a user-defined (scripted) 
State Variable, select State Variable from the Release is a Function of: list in 
the Independent Variable Definition dialog (Figure 7.39). 

When State Variable is selected, the edit panel of the Independent Variable 
Definition dialog will fill with a selection list showing all the state variables 
defined in the current network and the Time Series Options. Select the 
appropriate state variable from the selection list. Note: the state variable 
must be defined prior to creating a flexible diversion function that uses it 
(see how to create State Variables in Section 12.2). 

The Time Series Options apply to the External Variable time-series in exactly 
the same way as they do for a Model Variable time-series.  See Section 
7.3.1.7.3 for details on these options. 

Click the OK button in the Independent Variable Definition dialog to apply 
your settings, close the dialog, and return to the Diversion Editor. The 
Flexible Diversion Rule edit panel will now contain a table for you to enter 
the relationship between the specified State Variable and the diversion 
demand. 
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Figure 7.39 Flexible Diversion—Function of State Variable 

7.3.2 Diversion Editor—Routing Tab 

The Diversion Editor’s Routing tab (Figure 7.40) allows you to define the routing for 
the diversion channel.  The Routing tab is only active for diversions that are 
connected to a downstream junction. The routing methods available to a diversion 
are the same as those available to a reach; they are: Null, Coefficient, Muskingum, 
Muskingum-Cunge 8-pt Channel, Muskingum-Cunge Prismatic Channel, Modified 
Puls, SSARR, Working R&D 
Routing, and Variable Lag & K; 
each with its own set of 
parameters.  If there is no lag or 
translation of the hydrograph 
through the diversion reach, 
you can select Null Routing 
(which is the default routing 
method). 

The Routing tab of the 
Diversion Editor is identical to 
the Routing tab of the Reach 
Editor.  For details about using 
specifying the routing method 
on the Routing tab, refer to Section 7.2.1. 

 

7.3.3 Diversion Editor—Losses Tab 

The Diversion Editor’s Losses tab (Figure 7.41) allows you to define losses from the 
diversion channel.  Like the Routing tab, the Losses tab is only active for diversions 
that are connected to a downstream junction.  Three options for specifying the 
channel losses are provided: Return Ratio, Constant Seepage, or Seepage as a 
function of Flow.  Whichever loss method you used, the loss is applied to the routed 
flow from the diversion channel, right before it enters the downstream junction. 

Figure 7.40 Diversion Editor—Routing Tab 
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Return Ratio—to describe a consumptive use diversion where only a fraction of 
the diverted water actually returns to the network, specify a Return 
Ration between 0.0 and 1.0 (the default is 1.0) to indicate how much of 
the diverted flow reaches through the diversion to the downstream 
junction.   

Constant Seepage—Enter a seepage value (in cfs or cms) to indicate how much 
diversion flow will “seep into” the ground and therefore be lost from the 
system. 

Seepage as a function of Flow—Enter a Flow vs. Seepage relationship (in cfs or 
cms) In the Flow vs. Seepage table to indicate how much of the diversion 
flow is lost before reaching the downstream junction. The thumbnail plot 
to the right of the table will reflect the values you enter and can be 
viewed in full size when you double-click on it. 

 

 

 

Figure 7.41 Diversion Editor—Losses Tab 
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Chapter 8 

The Reservoir Editor 
The Reservoir Editor (Figure 8.1) is used to specify both the physical and operational data 
for a reservoir through the use of two tabs—a Physical tab and an Operations tab.  

To open the Reservoir Editor: 

• Select Reservoirs… from the Edit menu (of the Reservoir Network or Simulation 
module).  OR 

• Using the Pointer  or Reservoir Tool , right-click on a reservoir in the Map 
Display area, then select Edit Reservoir Properties from its context menu. 

Figure 8.1 shows an annotated version of the Reservoir Editor.  From top down, the 
Reservoir Editor is made up of: 

A Title Bar—which displays the name of the editor followed by the name of the current 
reservoir network.   

A Menu Bar—which has a Reservoir (File) menu and an Edit menu.  The Menu Bar may 
also display one or more additional menus depending on your most recent action 
or selection in the editor. 

A Navigation Bar—which provides features to selecting the reservoir for editing.  The 
Navigation Bar includes: 

A Reservoir Selector that you can use to select the reservoir you want to edit 

 

Figure 8.1 Reservoir Editor—Physical Tab—Annotated 
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A Description textbox that displays the description you entered when you 

created the reservoir.  The ellipsis button  at the end of the text box 
will open a description edit dialog. 

A set of Navigation Tools for switching between reservoirs in the Editor.   

A set of Tabs including: 

Physical tab—for defining the physical properties of a reservoir.  The Physical Tab 
divided into two parts: the Reservoir Tree is at the left and an Edit Panel 
is to the right. 

Operations tab—for defining the zones and rules and other features that 
describe the reservoir’s operating constraints 

Observed Data tab—for selecting the computed model variables that you may 
want to compare to an observed or external time series when reviewing 
results through ResSim’s standard reservoir plots. 

A set of Save & Close Buttons including: 

Ok—will save the changes made to the current reservoir and close the Editor. 

Cancel—will close the Editor and discard (not save) any changes made to the 
current reservoir. 

Apply—will save the changes made to the current reservoir but will not close the 
Editor. It is a good practice to press Apply before switching to another 
tab or reservoir. 

8.1 Reservoir Editor—Physical Tab 

 

Figure 8.2 Reservoir Editor—Physical Tab 
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8.2  Reservoir Editor—Operations Tab 

 

8.3 Reservoir Editor—Observed Data Tab 

Use the Observed Data tab (Figure 8.4) to indicate that observed data is available for 
comparison purposes in ResSim’s standard plots.  If the Observed box in the table is 
checked for a given model variable, then there will be a corresponding entry in the Time-
Series mapping table on the Observed Data tab of the Alternative Editor (Section 14.10) 
when you create or edit an alternative using this network. 

 
Figure 8.4 Reservoir Editor—Observed Data Tab 

 

Figure 8.3 Reservoir Editor—Operations Tab 
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Chapter 9 

The Physical Properties of Reservoirs 

Once you have created a reservoir network and established its connectivity (as described 
in Chapter 6), you will need to specify the properties of the elements in the network.  To 
do so, you will use ResSim’s specialized network element editors. The four major element 
editors all share some common features; see the introductory section of Chapter 7 for a 
description of these common features. Chapter 7 then goes on to describe the Junction, 
Reach, and Diversions Editors and how to enter and edit data for their respective 
network elements.  

The data needed to define a reservoir element is divided into two types:  Physical and 
Operational.  This chapter describes the physical components of a reservoir and how to 
use the Physical tab of the Reservoir Editor (Figure 9.1) to define them.  Subsequent 
chapters will describe the options for defining the reservoir operating objectives and 
constraints.  Chapter 10 describes the basics for defining reservoir operating objectives 
and constraints, and Chapter 11 describes operational rules.  Chapter 12 describes the 
advanced operational features such as IF_Blocks and scripts.  Two or more reservoirs can 
be made to operate in conjunction by defining them as a Reservoir System.  Reservoir 
Systems are covered in Chapter 13. 

 

Figure 9.1 Reservoir Editor—Physical Tab 

9.1 The Reservoir Tree 

In ResSim, reservoirs are complex elements that are made up of a variety of other 
elements (or components). The elements that make up a reservoir fall into two 
categories — release elements and property elements. A Release Element is a physical 
feature of a dam or reservoir that can take water away from the reservoir pool and put it 
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somewhere else in the network, usually into the downstream river system. The release 
elements include the reservoir itself, the dam, all the outlet types, outlet groups, and 
diverted outlets.  A property element describes some physical aspect of the reservoir, 
such as the size and shape of the reservoir pool. The property components include the 
pool, evaporation, seepage, leakage, tailwater elevation, and forebay head loss. 

The Physical tab of the Reservoir Editor uses a “tree structure” to represent the 
hierarchical relationship between the reservoir and its elements. This tree structure is 
called the Reservoir Tree and is shown at the left side of the Physical Tab of the Reservoir 
Editor (see Figure 8.1).   

The Reservoir  node is the root of the Reservoir Tree. By default, each reservoir has 
two elements: 

the Pool  and 

the Dam  

which appear as nodes immediately below the Reservoir  in the Reservoir Tree.   

Other Elements that can be added to the Reservoir Tree include: 

Controlled Outlets ,  

Uncontrolled Outlets ,  

Power Plants ,  

Pumps ,  

Outlet Groups , 

Diverted Outlets ,  

Evaporation , Seepage , and Leakage  losses, and  

Tailwater Elevation  and Forebay Head Loss  specifications. 

When an element is added to a node in the Reservoir Tree, the receiving node spawns a 
branch in the tree (if it doesn’t already have one) and the new element becomes a node 
on the branch. Almost all components of a reservoir are added to the Pool, the Dam, an 
Outlet Group, or a Diverted Outlet branch of the Reservoir Tree. Element nodes cannot 
be added to the reservoir node itself — with one exception — a diverted outlet.  See 
Section 9.5.1 for details on adding a diverted outlet to the reservoir. 

But the Reservoir Tree is more than just an illustration of the reservoir hierarchy; it is the 
user interface mechanism you will use to access the data for the various components of a 
reservoir.   

When you select an element (node) in the Reservoir Tree… 

The Edit Panel to the right of the Reservoir Tree will display the edit pane for the 
selected component.  At the top of each edit pane is the fully-qualified name 
of the selected element. The rest of the edit pane will contain the data entry 
fields for specifying the data needed to define the selected element.  
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An element menu will appear in the Menu Bar of the Reservoir Editor.  For example, 
when you select the Dam in the reservoir tree, a Dam menu appears in the 
menu bar. Each element menu contains options pertinent to the selected 
element in the Reservoir Tree. 

And, when you right-click on any element in the Reservoir Tree, a context menu will 
appear, giving you access to the same options that are available from the element menu 
that will appear in the Menu Bar.  

The order in which you add elements to the reservoir (tree) and edit their properties is 
flexible.  You can add all the physical elements to the reservoir then go back and define 
each element’s properties, or you can define the properties of each element as you add 
it, before going on to add and edit the next element.  Choose the style that works best 
for you.  Just be sure to finish defining the physical representation of your reservoir 
before going on to define its operational data (Chapter 10), as the definition of the 
operational zones depends on the physical definition of the pool and the rules depend on 
the description of the outlets.  

9.2 The Reservoir  

When you select the Reservoir  node in the Reservoir Tree, the Edit Panel displays the 
Reservoir pane (Figure 9.2).   

Below the selected reservoir’s name, the Reservoir pane contains a non-editable table 
listing the release capacity of the reservoir. The thumbnail plot to the right of the 
Composite Release Capacity table displays three curves, one for each release capacity 
column shown in the table.  The Controlled capacity curve is blue, the Uncontrolled 
capacity curve is red, and the Total capacity curve is green.   

Only one editable field is available on the Reservoir pane—it is the Label Position selector 
in the bottom right corner.  Use this selector to specify where you want the reservoir 

 

Figure 9.2 Reservoir Editor—Physical Tab—Reservoir Pane 
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label will to display in the Map Display area relative to the current reservoir’s label 
handle.  Refer to Section 5.2.2 to learn how to identify the Reservoir’s label handle.  

9.3 The Pool 

The Pool is the reservoir element in which you specify the characteristics of the 
reservoir’s storage though an elevation-storage-area relationship.  

When you select the Pool  node in the Reservoir Tree, the Edit Panel displays the Pool 
pane (Figure 9.3).  This pane contains a table in which you must enter the reservoir’s 
elevation-storage-area (ESA) relationship. Before entering data in the storage table, 
select one of the two options provided above the table to indicate the type of ESA 
relationship you will enter; your options are Linear Interpolation or Conic Interpolation.   

Figure 9.3 Reservoir Editor—Pool Pane 

Linear Interpolation—By default, the interpolation method ResSim uses to compute 
values for elevations and storages between those specified in the table is 
linear.  With this method, area data is optional unless you add evaporation 
losses to the pool. 

Conic Interpolation—This method requires that you specify a series of values for 
Elevation and pool surface Area to describe the reservoir pool.  Also required 
is a value for starting storage at the lowest elevation in the table and the 
Initial Conic Depth (the depth from the first storage value down to zero 
storage).  Using data you provide, ResSim will compute the storage between 
each sequential pair of elevations using the equation for the volume of a slice 
of a cone.  Conic interpolation will also be used to obtain intermediate 
storage values for elevations between those explicitly entered in the table 
(using a linearly interpolated area at each elevation of interest). 

The pool definition detailed in the regulation manual for most reservoirs was 
originally developed using conic interpolation.  The area of the pool surface 
at a regular interval of elevation was computed based on the topography of 
the land.  
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The following are requirements when specifying the Elevation, Storage, and Area data: 

• A minimum of two rows (values) must be entered. 

• Values in each column must increase down the columns (i.e., lowest elevation in 
the top row, highest elevation in the bottom row). 

• No duplicate values. 

To enter data into the table, either copy-and-paste it from a spreadsheet or type it in 
manually. The two thumbnail plots to the right of the storage table illustrate the 
elevation-storage curve and the elevation-area curve represented by the data you 
provided in the table. You can open a full-size plot from any thumbnail plot by double-
clicking on it. 

 

9.3.1 Pool Losses 

Two types of pool losses can be added to a reservoir pool—Evaporation and 
Seepage. Both types of losses remove water from the reservoir pool, never to be 
seen again in the model. In other words, ResSim does not continue to account for the 
water lost to evaporation or seepage nor does the water return to the system in any 
way.  

When you add Evaporation  and/or Seepage  to the 
reservoir pool, they will appear as nodes in the Pool 
branch of the Reservoir Tree (Figure 9.4). Since only one 
Evaporation or Seepage node may be added to a 
reservoir pool, there is no need nor option to rename it. 

9.3.1.1 Evaporation 

Evaporation is a loss of water from the reservoir pool to the atmosphere.  It is 
entered as a rate in units of depth per period of time.  ResSim gives you two ways 
to specify evaporation — as a monthly table where you specify the number of 
inches (or millimeters) per month or as a time series.  Computed evaporation is 
output as a rate in units of flow (cfs or cms).   

To add Evaporation to the reservoir pool: 

• Right-click on the Pool in the Reservoir Tree on the Physical tab of the 
Reservoir Editor (Figure 9.5).  

Pool Menu in Menu Bar Pool Context Menu from Reservoir Tree  

Figure 9.5 Pool Menu Option 

 

NOTE: Elevation and Storage data are required for definition of the reservoir 

pool.  Surface area data is optional unless you are defining storage using 

conic interpolation or you added evaporation losses to the pool. 

 

Figure 9.4 Reservoir Tree 
with Pool Losses 
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• Select Add Pool Evaporation from the Pool’s context menu (Figure 9.5). 

• An Evaporation node will appear in the Reservoir Tree as the active node and 
the Edit Panel will display the Evaporation edit pane as shown in Figure 9.6. 

 

Figure 9.6 Reservoir Editor—Evaporation 

• Select the type of Evaporation you want to specify. 

o For Monthly Evaporation, enter a value for the seepage rate in cfs (or 
cms) in the text box for each month. The thumbnail plot to the right of 
the table will reflect the values you enter in the table.  

o For Evaporation Time Series, no further information is required in the 
Evaporation edit pane.  Instead, when you set up an alternative that uses 
this network, an entry for evaporation will appear in the Time Series 
table.  There you must identify the evaporation rate time series for the 
reservoir. 

 

9.3.1.2 Seepage 

Seepage is loss of water from the reservoir pool to the ground.  It is entered and 
reported as a rate in units of flow (cfs or cms).  ResSim gives you two ways to 
specify Seepage—as a constant rate or as a function of pool elevation. 

To add Seepage to the reservoir pool: 

• Right-click on the Pool in the Reservoir Tree. 

• Select Add Pool Seepage from the Pool’s context menu in the Reservoir Tree 
(Figure 9.5). 

• A Seepage node will appear in the Reservoir Tree as the active node and the 
Edit Panel will display the Seepage edit pane as shown in Figure 9.7.   

 

NOTE: in addition to entering evaporate rate information, reservoir 

surface area is also required to model evaporation.  Be sure to 

enter area information in the elevation-storage table for your 

reservoir pool. 
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• Select the type of Seepage you want to specify. 

o For Constant Seepage, enter a single value for the seepage rate in cfs (or 
cms) in the text box. 

o For Seepage as a function of Reservoir Elevation, enter the relationship 
of Elevation vs. Seepage into the table.  The data must be entered in 
increasing values of elevation. 

9.4 The Dam 

The Dam is the reservoir element that can move water from the reservoir pool to the 
downstream system and is the primary element to which you will add outlets and outlet 
groups.  In the Reservoir Tree, the dam is a special type of outlet group.  What makes the 
dam special are three features that standard outlet groups don’t have:  

1. The dam is attached directly to the reservoir 

2. The dam can be assigned a leakage element  

3. The dam is the default release element of a reservoir — an overflow weir. Even if 
you do not add outlets to it, the dam itself is a weir that ResSim models using the 
standard weir equation and a (hard-coded) weir coefficient of 3.0.  To define the 
weir, you must provide:  

Elevation at top of dam—the elevation at which overtopping of the dam will 
occur (i.e., the weir crest). 

Length at top of dam—the length of the dam or the length of the section of 
the dam that will overtop (the weir length). 

 

Figure 9.7 Reservoir Editor—Seepage 

 

If you do not want ResSim to compute dam overflow or if you want to specify the 

overflow capacity using a separate outlet, enter zero for the length of the dam.  

 

The computed overflow from the dam will be combined with leakage and will be 

appear in the output as “Dam L&O”. 
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When you select the Dam  node in the Reservoir Tree, the Edit Panel displays the Dam 
pane (Figure 9.8)  

Below the name of the Dam, the Dam pane contains a non-editable table displaying the 
Composite Release Capacity of the dam. The thumbnail plot to the right of the Composite 
Release Capacity table displays three curves, one for each release capacity column shown 
in the table.  The Controlled capacity curve is blue, the Uncontrolled capacity curve is red, 
and the Total capacity curve is green.  Be aware that the uncontrolled capacity in the 
table does not include the overflow capacity of the dam itself.   

9.4.1 Rename the Dam 

The default name of the dam is “Dam at stream name”, where stream name is the 
name of the stream on which the dam is located.  In the example shown in Figure 
9.8, the name of the dam is “Dam at Hayes River”.  Except in the Reservoir Tree, 
where ever the dam is referenced, the dam name is always appended to the 
reservoir name; this combined name can get long so it is highly recommended that 
you rename the dam to something short, like just “Dam”. 

To rename the dam: 

• Select Rename from the Dam’s context menu.  A Rename dialog will open. 

• Enter a new Name for the dam and click OK.   

In case you are wondering why the default name of the dam includes the stream 
name, it is because you can create a reservoir with more than one dam.  (Yes, you 
really can.)  By drawing the reservoir across two or more streams that flow away 
from the inflow(s), a dam will be created at each outflow junction of the reservoir 
and each dam requires a unique name in the reservoir.  See Section 5.2.3 for details 
on creating a reservoir with more than one dam. 

 

Figure 9.8 Reservoir Editor—The Dam 
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9.4.2 Adding Outlets and other Elements to the Dam 

Unless you only want to model dam overflow, you will need to add one or more 
outlets to the dam to enable water to pass through it into the downstream system.   

Outlet types available in ResSim include:  

Controlled Outlets—can be used to represent any outlet that has some 
mechanism, like a gate or valve, which can be used to adjust the release 
capacity of the outlet.   

Uncontrolled Outlets—can be used to represent any outlet whose release 
capacity cannot be adjusted; i.e. it is always fully open (e.g., gates, 
valves). 

Power Plants—a special type of controlled outlet that can be used to represent a 
hydropower generation facility fed by a reservoir (e.g., weirs, culverts). 

Pumps—another special type of controlled outlet that can be used to represent a 
pump or the “reverse” half of a reversible turbine in a pumpback system. 

The other release elements that are available in ResSim include: 

Outlet Groups—used to combine one or more outlets so that they can be 
operated together as a single unit.  

Diverted Outlets—a combination of an Outlet Group and a Diversion.  Diverted 
outlets are schematic elements. You create them from the map display 
area in the same manner as you create a diversion. You cannot add a 
diverted outlet to the reservoir through the Reservoir Editor, but you can 
edit it, including adding and removing outlets and other elements and 
defining the routing properties of the diversion. 

Leakage—a loss of water from the reservoir pool that passes “through” the dam 
into the downstream system. 

In addition to release elements, the following dam elements allow you to define 
certain properties of the dam, outlet, or group: 

Tailwater Elevation—a feature you may need add to the dam or an outlet so that 
it can compute head, the difference between pool elevation and 
tailwater, for the purpose of computing power generation or 
determining the ability to pump. 

Forebay Head Loss—a feature you can add to the dam or an outlet so that it can 
adjust the current pool elevation to reflect the elevation of water at the 
face of the outlets for the purpose of computing release capacity.   

Like the Pool, there are two ways to add outlets and other elements to the Dam: 

1. from the Dam menu or  

2. from the Dam’s context menu in the Reservoir Tree.  
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Each menu shown in Figure 9.9 provides the same list of options for adding and 
renaming dam elements.  For simplicity, we’ll focus on use of the context (right-click) 
menu. 

Reservoir Editor—Dam Menu Reservoir Tree: Dam Context Menu 

Figure 9.9 The Reservoir Editor’s Dam Menus 

To add an outlet or other element to the dam: 

• Right-click on the Dam to which you want to add the outlet or other feature. 

• Select the outlet type or property you want to add from the context menu. The 
menus illustrated Figure 9.9 show the various outlet types and dam elements 
that you can add to a dam. 

• The new outlet or feature will appear in the Reservoir Tree as a branch beneath 
the dam or outlet group you selected. 

 

Pulse Flow Options is a Dam menu option that is not discussed in this 

chapter.  It is an advanced option needed for effective downstream control 

operation and is described in Chapter 11, Section 11.3.5. 

9.4.3 Renaming Elements 

When you add a release element to the Reservoir Tree, ResSim will give it a default 
name based on the element type.  For example, if you add a Controlled Outlet, the 
outlet will be given the name Controlled Outlet.  If you add a second outlet of the 
same type without renaming the first one, the new outlet will get the same default 
name but with a number appended to it so that each outlet has a unique name, e.g. 
Controlled Outlet 1. To give your outlets and outlet groups meaningful and unique 
names, rename them as soon as you create them.   

To rename an outlet or outlet group: 

• In the Reservoir Tree, right-click on the release element and select Rename from 
the context menu  (Figure 9.10). 

• The Rename Reservoir Component dialog will open (Figure 9.11). 

• Type the new name for the element in the Name field.  You may also enter a new 
description in the Description field. 
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• Click OK to close the dialog.  The new name will appear in the reservoir tree. 

 

 

 

 

 

 

 

 

9.4.4 Deleting or Removing Elements 

As you build or revise your reservoir model, you may find it necessary to remove an 
element from the dam or reservoir. For example, you may find that you want to 
combine two or more existing outlets into an outlet group.  Since cut, copy, and 
paste of reservoir elements are not features that have been implemented in the 
ResSim Reservoir Editor, be sure to create the new outlets in the outlet group before 
deleting the originals.  

Take care when deleting or removing elements since once they’re gone, they’re 
gone. In other words, when you delete elements from the reservoir tree, ResSim 
immediately removes them from the reservoir and the reservoir network; no need to 
click the apply button.  And, if you use cancel to close the Reservoir Editor, the 
deleted outlets will still be gone when you reopen the editor.  

You can delete Outlet Groups, Diverted Outlets, Controlled Outlets, Power Plants, 
Pumps, and Uncontrolled Outlets from your reservoir.  You can remove Evaporation, 
Seepage, and Leakage as well as Tailwater Elevation and Forebay Head Loss 
specifications from the reservoir and/or dam and its outlets and groups. 

When you delete or remove a reservoir component, it will no longer appear in the 
reservoir tree. When you delete a Diverted Outlet, it will be removed from both the 
Reservoir Tree and from the network schematic shown in the Map Display Area of 
the Reservoir Network module.  To replace a Diverted Outlet, you will need to re-
draw it in the map display area. 

To delete or remove an element from the dam or reservoir: 

• Right-click on the release element in the Reservoir Tree. 

Figure 9.10 Outlet 
Context Menu—Rename Figure 9.11 Renaming a Reservoir Component     
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• From the context menu, select Delete or Remove 
(Figure 9.12). 

• A confirmation window will appear.  If the chosen 
outlet or group has rules that limit its operation, 
the confirmation window will show a list of those 
rules (Figure 9.13).  

o Select Yes to verify that you want to 
remove/delete the selected element and any 
rules associated with it. The element will 
disappear from the Reservoir Tree (and any 
rules associated with it will be deleted as well). 

o Select No to cancel the Delete component 
process. 

 
   

Figure 9.13 Confirm Deletion of Reservoir Component 

9.4.5 Leakage 

Like Evaporation and Seepage, Leakage is a loss of water from the reservoir pool.  
Leakage, although referred to as a “loss,” is not a true loss of flow to the system.  In 
fact, leakage effectively passes through the dam into the downstream system at the 
downstream (or tailwater) junction.  

In ResSim, Leakage is considered a property of the dam and can only be added to the 
dam—not to an outlet or outlet group.  Also like Evaporation and Seepage, you can 
only add one Leakage node to the dam, so there is no need, nor option, to rename it.  

To add Leakage to a dam: 

• Right-click on the Dam in the Reservoir Tree. 

• Select Add Leakage from the dam’s context menu.  

 

 

Figure 9.12 Reservoir Tree 
Element Context Menus—

Delete & Remove 
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• Leakage will appear as a node of the reservoir tree, immediately below the dam.  
It will be the active node and the Edit Panel will display the Leakage pane (Figure 
9.14). 

The Leakage pane allows you to define Leakage as a function of pool Elevation. To 
enter data into the Elevation vs Leakage table, either copy & paste it from a 
spreadsheet application or type in the data manually. Values of elevation must be 
entered in increasing order.  The thumbnail plot to the right of the table will reflect 
the values entered in the table. 

9.4.6 Outlet Groups 

Use outlet groups so that you can treat a subset of the 
outlet in your reservoir as a single unit — in other 
words, so that you can apply rules to the group rather 
than to individual outlets or to the dam or reservoir.  
You can add an Outlet Group to a dam, diverted outlet, 
or other outlet group.  An example outlet group, called 
Outlet Tower is shown in Figure 9.15. 

An Outlet Group can include any outlet type as well as 
Tailwater Elevation and Forebay Head Loss elements. 

To add an Outlet Group: 

• In the Reservoir Tree, right-click on the dam (or group) to which you want to add 
an outlet group. 

• Select Add Outlet Group from the context menu. 

• The new Outlet Group node will appear in the Reservoir Tree beneath the 
element you selected, and the Edit Panel will display the Group pane for your 
new outlet group. 

When you select the Group  node in the Reservoir Tree, the Edit Panel displays the 
Group.  Like the Reservoir and Dam panes, the Group pane contains the name of the 

Figure 9.14 Reservoir Editor—Leakage 

Figure 9.15 Reservoir Tree 
with Outlet Group 
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Outlet Group and a non-editable Composite Release Capacity table (Figure 9.16) 
which reflects the total capacity of the outlets contained in the group.  

 

Figure 9.16 Outlet Group Node and Group Edit Pane 

9.4.7 Tailwater Elevation 

Tailwater Elevation is used in the computation of 
head — the difference between reservoir pool 
elevation (above the dam) and tailwater elevation 
(below the dam). Specification of Tailwater Elevation 
is required when you model power plants and/or 
pumps. You can add Tailwater Elevation to Dams, 
Diverted Outlets, Outlet Groups, or individual outlets. 

When Tailwater Elevation is specified at the Dam, it 
applies to all outlets in the dam unless overridden by 
another Tailwater specification at a level closer to a 
specific outlet.  For example, consider the two 
Tailwater nodes illustrated in Figure 9.17 — one Tailwater node was added to the 
Dam and another was added to the Pump.  The Pump will use the Tailwater definition 
that was attached it, but the Power Plant will use the Tailwater Elevation specified at 
the Dam. 

To add Tailwater Elevation: 

• In the Reservoir Tree, right-click on the dam, group, or outlet to which you want 
to add a Tailwater Elevation specification. 

 

Figure 9.17 Reservoir Tree 
with Tailwater Nodes 
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• Select Add Tailwater Elevation from the 
component’s context menu (Figure 9.18)  

• A Tailwater node will appear in the reservoir 
tree beneath the component you selected and 
the Tailwater pane will be displayed in the edit 
panel. 

The Tailwater pane (Figure 9.19) provides three 
options for specifying the tailwater elevation:  

1. Constant Elevation,  

2. Downstream Control (elevation of a 
downstream element), or  

3. Rating Curve.  

You can choose one, two or all three of the options 
and ResSim will evaluate all those selected and use 
the highest value among them.   

If you select Rating Curve, you can specify the rating as a Simple Rating for which you 
must enter the relationship between Flow and Stage in the table, or as a Rating 
Function for which you must define tailwater Stage (or elevation) as a function of a 
Model Variable, External Variable, State Variable, or Two Variables. 

 

Figure 9.19 Tailwater Node and Tailwater Edit Pane 

A rating curve usually relates STAGE at a gage to FLOW.  And the measured quantity 
is usually STAGE, which would make STAGE the independent variable.  But to ResSim 
FLOW is the known variable and it wants to lookup STAGE, so STAGE is seen as the 
dependent variable.  So, be careful when entering the rating table to be sure FLOW is 
the first column of data and STAGE is the second.  

 

Figure 9.18 Dam Context Menu—
Add Tailwater Elevation 
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In addition, each rating curve has an option for a Stage Datum to be provided.  The 
Stage Datum (or gage zero) is the elevation of a STAGE of 0.0 at the gage.  Each time 
ResSim looks up stage from a rating curve, it also computes elevation using the Stage 
Datum.  If you do not provide a value for the Stage Datum, ResSim will use a default 
value of 0.0. 

9.4.8 Forebay Head Loss 

You can add Forebay Head Loss to Dams, Outlets, 
Diverted Outlets, and Outlet Groups. 

To add Forebay Head Loss: 

• Right-click on the dam, outlet, or group to 
which you want to add Forebay Head Loss. 

• Choose Add Forebay Head Loss from the 
element’s context menu (Figure 9.20) 

• The Forebay Head Loss you have added will 
appear in the reservoir tree as a node 
beneath the element you selected and the 
Edit Panel will display the Forebay Head Loss 
pane (Figure 9.21).   

Use the Define button to the right of the Function Of: 
field to specify the independent variable of the Forebay Head Loss function.  Options 
include: Model Variable, External Variable, State Variable, or Two Variables.  

 

Figure 9.21 Forebay Headloss Node and Forebay Head Loss Edit Pane 

9.5 Diverted Outlets 

In ResSim, a Diverted Outlet is used to represent a withdrawal (or release) of water from 
the reservoir pool.  In the Reservoir Tree, a diverted outlet is a special type of outlet 
group. Three things make a diverted outlet special with respect to a normal outlet group: 

• A Diverted Outlet is attached directly to the Reservoir in the Reservoir Tree, parallel 
to the Dam and Pool. 

 

Figure 9.20 Dam Context Menu—
Add Forebay Head Loss 
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• A Diverted Outlet is always created with a Controlled Outlet in it. If you want to 
replace the default outlet with some other type of outlet, add the new outlet first 
before deleting the default outlet. 

• If the diversion (arrow) of the Diverted Outlet is connected at its downstream end to 
a Junction in the network schematic, a Routing node will be included in the Diverted 
Outlet group.  See Section 7.2.1 for information about the available routing methods. 

9.5.1 Adding a Diverted Outlet to a Reservoir 

A Diverted Outlet cannot be added to a Reservoir from the Reservoir Editor in 

ResSim.  Instead, a Diverted Outlet  can be only added to the reservoir by using 

the Diverted Outlet tool  to draw a reservoir diversion from the reservoir in the 
network schematic in the Map Display area. 

Once a diverted outlet has been added to the 

reservoir in the schematic, a new Diverted Outlet  

branch from the Reservoir  will be added to the 
Reservoir Tree in the Reservoir Editor (Figure 9.22).  
By default, a Controlled Outlet is included in the  

Diverted Outlet group when the diverted outlet is 
added to the reservoir.  If you want to replace the 
default outlet with a different outlet, create the new outlet before deleting the 
default one.  To add an outlet to the diverted outlet group, select the Diverted Outlet 
in the Reservoir Tree then use the diverted outlet’s context menu (or the Outlet 
menu) to add an outlet to the diverted outlet. 

When you select the Diverted Outlet  node in the Reservoir Tree, the Edit Panel 
displays the Diverted Outlet pane (Figure 9.23).  Like the Group pane, the Diverted 
Outlet pane contains the name of the Diverted Outlet and a non-editable Composite 
Release Capacity table which reflects the total capacity of the outlets contained in 
the Diverted Outlet group.  

 

Figure 9.23 Diverted Outlet Pane—Composite Release Capacity Table 

 

Figure 9.22 Reservoir Tree 
with Diverted Outlet  
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9.6 Controlled Outlets 

A Controlled Outlet is a generic release element that may be used to represent almost 
any control structure used to regulate releases from a reservoir. The release capacity of a 
controlled outlet is specified as a relationship between pool elevation and maximum 
release capacity.   

A variation of the maximum capacity relationship is available that allows you to define 
the release capacity per pool elevation for a series of gate settings or openings. Gate 
settings are sometimes known as “cranks” because they reflected how many times the 
operator must turn the crank or lever that opens or closes the gates.  At present, ResSim 
opens or closes all the gates of a given outlet together as a single unit.  So, if a given 
outlet represents 6 gates, ResSim will open or close all 6 gates to the same gate opening 
in order to produce the desired release. 

In addition to Release Capacity, two physical Rate of Change constraints may be entered 
Max Rate of Increase and Max Rate of Decrease.  However, it is recommended that you 
leave these fields blank and use rules in your operation sets to model all rate of change 
constraints — both physical and operational. 

To edit data for the Controlled Outlet: 

• Select the outlet you want to edit in the Reservoir Tree.  The Edit Panel will display 
the Controlled Outlet edit pane (Figure 9.24).  

 

Figure 9.24 Controlled Outlet Pane—Maximum Capacity Table 

• Specify the Number of Gates of this type. 

• Specify the release Capacity of one gate by entering Elevation and corresponding 
Max Capacity flow values into the table.  The Max Capacity table reflects the 
maximum physical flow constraint per gate of the outlet; Total Max Capacity of the 
outlet is the product of the Max Capacity for one gate times the number of gates. 

• Optionally, specify Physical Limitations for Max Rate of Increase and Max Rate of 
Decrease. 
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• Click Edit Gate Settings to access the Gate 
Settings dialog (Figure 9.25).  Gate settings 
are sometimes known as “cranks.” Choose 
either Specify Maximum Capacity Only (the 
default) or Specify Capacity at Specific Gate 
Openings. 

To Specify Capacity at Specific Gate Openings: 

o Select the Number of Gate Settings (or 
“cranks”) and the Gate Setting Units 
(Length or Percent). 

o Enter the Setting for each gate. 

o Click OK to close the Gate Settings dialog. 

Note:   Even though you can enter the 
appropriate Gate Settings, ResSim does not 
currently make use of this information in most of 
its operations.  It will, however, produce a time 
series of gate settings as output based on the final release from the outlet. The 
exceptions are the induced Surcharge and Prescribed Release rules. 

Figure 9.26 shows the Reservoir Editor’s Controlled Outlet data editor with Gate Settings 
specified. 

 

Figure 9.26 Controlled Outlet—Capacity per Gate Setting 

When you are done entering Controlled Outlet data, be sure to click Apply before moving 
on to edit the next component. 

 

Figure 9.25 Controlled Outlet 
Specifying Gate Settings 
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9.7 Power Plants 

A Power Plant is a type of controlled outlet that has the additional capability of 
computing hydropower generation.  A Power Plant can be added to a Dam, Diverted 
Outlet, or Outlet Group.  To edit data for a Power Plant, select the Power Plant in the 
Reservoir Tree. The Power Plant pane (Figure 9.27) will display in the edit panel. 

The Reservoir Editor’s Power Plant pane has five tabs that allow you to edit data for 
Outlet Capacity, Generating Capacity, Efficiency, Station Use, and Hydraulic Losses, as 
described in the following sections. 

9.7.1 Outlet Capacity 

On the Outlet tab (Figure 9.27), you will enter the rating table for the physical 
capacity of this outlet.  You can also specify the increasing and decreasing physical 
limitations (i.e., physical rate-of-change constraints). 

 

Figure 9.27 Power Plant—Outlet Tab 

To enter Outlet data: 

• Specify the Number of Gates of this type. 

• Enter Elevation and corresponding Max Capacity flow values (per gate) into the 
table.  You can either copy and paste data from a spreadsheet application or type 
in the values manually. 

• Optionally, specify Physical Limitations for Max Rate of Increase and Max Rate of 
Decrease. 

 

Note:  Tailwater Elevation must be specified at or above a power plant in the 

Reservoir Tree in order for the plant to properly calculate energy production  
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9.7.2 Generating Capacity 

On the Capacity tab, you must specify the generating capacity of the power plant.  All 
power plants come with a general “nameplate” or installed capacity.  In addition, the 
capacity of the plant may vary as a function of elevation, release, or net head.  Both 
forms of generating capacity are required input—the Installed Capacity and the 
Variable Capacity.   

The Installed Capacity will be used by the Hydropower Requirement operating rules 
that determine required generation using Plant Factor.  The Installed Capacity is 
entered as a constant value in units of megawatts (MW).   

The Variable Capacity will be used by all the Hydropower Requirement rules to limit 
the plant’s generating capability computed using the power equation and the other 
properties of the power plant. The Variable Capacity can be specified with one of the 
following five options (as illustrated in Figure 9.28): 

 

Figure 9.28 Power Plant Capacity—Variable Capacity Options 

Installed Capacity with Overload Factor (Figure 9.29)—This option is the 
equivalent of defining the variable capacity as constant.  The Overload 
Factor is used as a multiplier for the Installed Capacity to determine the 
maximum generating rate the plant can operate at.   For example, to 
overload a plant’s installed capacity by 10%, enter a factor of 1.10.  To 
use the full Installed Capacity with no overload, enter an Overload Factor 
of 1.0. 

 

Figure 9.29 Variable Power Plant Capacity—Installed Capacity 
with Overload 

Function of Reservoir Elevation—If the generating capacity of your power plant 
varies as a function of the pool elevation of the reservoir, select Function 
of Reservoir Elevation for 
your Variable Capacity.  
Then, right click on the 
blank row in the function 
table and insert the 

 

If you are copying data from a  

spreadsheet into a table in ResSim, 

you do not need to size the table to 

fit the data.  It will resize 

automatically when you paste the 

table data into the first cell. 
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number of rows you need to specify the functional relationship. Enter 
the data specifying the relationship between elevation and generating 
capacity into the table in increasing order of elevation.  

Function of Reservoir Storage—If the generating capacity of your power plant 
varies as a function of the current storage in the reservoir, select 
Function of Reservoir Storage for your Variable Capacity.  Then, right 
click on the blank row in the function table and insert the number of 
rows you need to specify the functional relationship. Enter the data 
specifying the relationship between storage and generating capacity into 
the table in increasing order of storage. 

Function of Release—If the generating capacity of your power plant varies as a 
function of the previous release from the reservoir, select Function of 
Release for your Variable Capacity.  Then, right click on the blank row in 
the function table and insert the number of rows you need to specify the 
functional relationship. Enter the data specifying the relationship 
between release and generating capacity into the table in increasing 
order of release. 

Function of Operating Head option (Figure 9.30)—If the generating capacity of 
your power plant varies as a function of the net head for the power 
plant, select Function of Operating for your Variable Capacity.  Then, 
right click on the blank row in the function table and insert the number 
of rows you need to specify the functional relationship. Enter the data 
specifying the relationship between net head and generating capacity 
into the tab in increasing order of head. 

 

Figure 9.30 Variable Power Plant Capacity—Function of Operating Head 

9.7.3 Efficiency 

Efficiency represents a percentage of the total potential energy the power plant 
(generator efficiency & turbine efficiency) could theoretically generate. Typical plant 
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efficiency ranges between 80% and 90%.  In actual operation, however, the turbine-
generator efficiency varies throughout its range of operation.  

Like generating capacity, efficiency may vary as a function of a pool elevation, release 
or head.  These are options are labeled Efficiency Methods (Figure 9.31). 

 

Figure 9.31 Power Plant Efficiency Methods 

On the Efficiency tab of the Power Plant edit pane, select an Efficiency Method.  The 
options include:  

Constant (Figure 9.32)—If the efficiency of your power plant does not vary 
significantly, select Constant as the method for specifying the efficiency 
of your power plant.  Enter a constant value for the overall, generator 
plus turbine, plant efficiency. Efficiency is specified as a percentage. 

 

Figure 9.32 Variable Power Plant Efficiency—Constant 

Function of a Reservoir Elevation—If the efficiency of your power plant varies as 
a function of the elevation of the reservoir pool, select Function of 
Reservoir Elevation as the method for specifying the efficiency of your 
power plant.  Next, right click on the blank row in the function table and 
insert the number of rows you need then enter the data specifying the 
relationship between elevation and generating capacity into the table in 
increasing order of elevation. The thumbnail plot will reflect the data you 
enter in the table.  

Function of Release—If the efficiency of your power plant varies as a function of 
the previous release from the reservoir, select Function of Release as the 
method for specifying the efficiency of your power plant.  Enter the data 
specifying the relationship between release and generating capacity into 
the table in increasing order of release.  

Function of Operating Head (Figure 9.33)—If the efficiency of your power plant 
varies as a function of the net heat at the reservoir, select Function of 
Operating as the method for specifying the efficiency of your power 
plant.  Enter the data specifying the relationship between head and 
generating capacity into the table in increasing order of head. 
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Figure 9.33 Variable Power Plant Efficiency—Function of Operating Head 

9.7.4 Station Use 

Station Use is the quantity of flow used to run a “station” unit whose power is used 
to operate the powerhouse.  It is a portion of the flow that passes through the 
powerhouse, but it is not used to generate power for the “grid” and is therefore 
considered a loss.  

On the Station Use tab of the Power Plant edit pane, you can define the Station Use 
as constant flow rate or as a function of flow entering the powerhouse (release).   

Constant (Figure 9.34)—enter the station use as a constant flow rate.  

 

 Figure 9.34 Power Plant—Station Use—Constant 

Function of Release (Figure 9.35)—enter a table of values to specify the 
relationship between Release and Station Use.  The thumbnail plot will 
reflect the data you enter in the table.  

 

Figure 9.35 Power Plant—Station Use—Function of Operating Head 
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9.7.5 Hydraulic Losses 

Hydraulic loss can also be referred to as head loss and is used to represent the 
friction losses in the penstock.  ResSim uses net head (the difference between the 
pool elevation and the tailwater elevation) in the power equation to calculate 
generating capacity.  When you specify a hydraulic loss, you are describing a loss to 
the head, which results in a reduction in the plant’s generating capacity. 

You can specify the head loss as a constant or as a function of flow through the 
penstock (entering the powerhouse): 

Constant Hydraulic Losses (Figure 9.36)—enter the hydraulic loss as a constant value 
of distance (ft or m). 

 

Figure 9.36 Power Plant—Hydraulic Losses—Constant 

 

Function of Release (Figure 9.37)—enter a table of values to specify the relationship 
between Release and Loss to describe the head loss as a function of flow 
through the outlet.  The thumbnail plot will reflect the data you enter in the 
table.  

 

Figure 9.37 Power Plant—Hydraulic Losses—Function of Release 
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9.8 Pumps 

A Pump (or pump station) is effectively a negative outlet—instead of taking water from 
the pool and discharging it to the downstream system, it takes water from the 
downstream system—specifically from another reservoir—and discharges it into the 
pool.  Although the downstream reservoir may not be immediately downstream, a pump 
outlet creates a virtual pipe between the reservoir that contains the pump and the 
downstream reservoir.  You cannot use a pump to move water from a river into the 
reservoir.  Figure 9.38 shows a pump outlet in the Reservoir Editor Physical tab. 

 

Figure 9.38 Pump Outlet  

A Pump can be added to the Dam, a Diverted Outlet, or an Outlet Group.  

The Pump edit pane (Figure 9.39) has three basic input parameters for defining a pump: 

Number of Pumps—Think of a pump outlet as a “Pump Station” in which one or 
more pumps operate together to meet the pumping objective.  Enter the 
number of identical pumps in the pump station.  This value will add rows the 
Operating Limits table, one for each pump, and will be used as a multiplier on 
Pump Capacity to determine the total rate at which the pumps can move 
water. 

Operating Limits—this table requires that you specify the operating range for each 
pump in the pump station.  The operating range is defined by a minimum 
tailwater elevation and a maximum head.  The tailwater and head 
information both rely on a valid definition of the tailwater, so don’t forget to 
add a tailwater element to the pump or to its parent element. 

Pump Capacity—Two options are available for specifying the Pump Capacity of each 
pump in your pump station: 

Constant—enter a flow value that represents the rate at which the pump can 
water (Figure 9.39). 

 

Note: Tailwater Elevation must be specified at or above a pump in the Reservoir 

Tree in order for the pump to determine if it is allowed to operate.  
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Figure 9.39 Pump Edit Pane—Pump Capacity—Constant 

Function of Operating Head—enter the relationship between operating head and 
pump capacity in the table (Figure 9.40).  The values of operating head 
must in entered in increasing order 

 

Figure 9.40 Pump Edit Pane—Pump Capacity—Function of Operating Head 

9.9 Uncontrolled Outlets 

An Uncontrolled Outlet can be a component of a Dam, Diverted Outlet, or Outlet Group.  
An uncontrolled outlet can represent an ungated overflow spillway or any opening in the 
dam through which water can pass without impediment by a movable gate or panel.   

Two options for specifying the capacity of an uncontrolled outlet are provided — a weir 
equation or an Elevation vs Outflow capacity table.  If the outlet is a standard overflow 
weir, you can use the weir equation to compute the flow over the spillway using a Weir 
Coefficient and a spillway Length that you must provide.  You can use the capacity table 
for all types of uncontrolled outlets whose capacity can be defined by a simple rating 
curve (elevation vs outflow relationship. 
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Weir Coefficient—typically in the range 2.6-4.0 depending on the shape of the 
spillway crest.  This value determines flow over the spillway in the weir 
equation. 

Length—spillway length. 

Elevation vs. Outflow Table—enter data into the table in increasing order of 
elevation.  You can either copy-and-paste the data from a spreadsheet 
application or type it in manually. 

Figure 9.41 shows the Reservoir Editor’s Uncontrolled Outlet edit pane with the capacity 
table selected and data entered. Note that the corresponding thumbnail plot reflects the 
entered data. 

 

Figure 9.41 Reservoir Editor—Physical Data—Uncontrolled Outlet 

Whether you use the weir equation or the Elevation vs Outflow table, you must specify 
an Outlet Elevation.  The Outlet Elevation serves as a trigger to determine when this 
outlet starts “flowing.”  

Outlet Elevation—The minimum elevation at which the outlet will begin to release 
water.  This elevation is usually the “sill” or bottom of the outlet opening. 

 

.
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Chapter 10 

Reservoir Operations — The Basics 

Reservoir operation is the act or process of storing water in and releasing water from a 
reservoir. The operations for most reservoirs regulated by the U.S. Army Corps of 
Engineers are based on a concept called Guide Curve Operation.  

Guide Curve Operation is the process of determining and making releases from a 
reservoir in order to get to and maintain the reservoir pool at its target elevation. Thus, 
the guide curve is the target or desired pool elevation for the reservoir.   

Reservoir operating zones are another concept related to the guide curve. An operating 
zone is a horizontal slice of the reservoir pool for which the goals and constraints differ 
from those in another zone of the reservoir. 

The operating plan for most reservoirs is described in a reservoir regulation or water 
control manual. The water control manual for most Corps of Engineers reservoirs 
describes a seasonally-varying target pool elevation commonly called the Guide Curve. 
The (available) storage of the reservoir above this target elevation is referred to as the 
Flood Control pool and the storage below the guide curve is called the Conservation pool.  
The guidelines for determining the release from the reservoir are then based on where 
the current pool elevation is in relation to the guide curve.  With guide curve operation as 
the fundamental objective of the reservoir operation, all other goals and objectives 
described in the regulation plan or water control manual can be interpreted as limits on 
guide curve operation. 

Since ResSim was designed for modeling Corps reservoirs, the foundation of the ResSim 
decision logic is basic Guide Curve Operation.  This means that, to ResSim, the primary 
reservoir operating objective is to maintain the pool at, or return the pool to, the guide 
curve elevation as soon as possible.  So, if the pool is below the guide curve, guide curve 
operation would reduce or suspend releases in order to refill the pool; if the pool is 
above the guide curve, then releases would be increased up to maximum capacity in 
order to draw the pool back down to the guide curve elevation.   

Operational rules that reflect the goals and constraints on the reservoir operation act as 
limits on the guide curve operation.  A well-designed set of rules will temper the 
potentially volatile release behavior of the guide curve operation and produce smooth 
transitions across reservoir operating zones without abrupt or oscillating changes in the 
releases. 

In a manner similar to the methods a regulator may use, each reservoir in your ResSim 
network must determine how much water to release at each timestep of a simulation 
run.  In ResSim, reservoir operation is the timestep by timestep simulation of the release 
decision-making process over a time window. 

This chapter will describe the Operations Tab of the Reservoir Editor and guide you 
through the process of creating and managing your reservoirs’ operating plans 
(Operation Sets), defining the operating zones in each plan, and specifying the allocation 
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of the release to your outlets.  Creating and managing the operating rules that you will 
add to the zones in your operation sets will be covered in Chapter 11. Chapter 12 covers 
creating and managing IF-Blocks, State Variables, and Scripted Rules (Sections 12.1, 12.2, 
and 12.3, respectively), as well as some advanced operation features that can be applied 
to the operation set (Sections 12.5-12.8). 

10.1 The Reservoir Editor’s Operations Tab 

The Operations tab of the Reservoir Editor (Figure 10.1) allows you to define reservoir 
operation sets for the reservoirs in your network. As part of the definition of an operation 
set, you will specify the zones and rules that describe the operating plan for the reservoir.   

When the Operations tab is selected, four menus unique to the Operations tab will be 
added to the Menu Bar at the top of the Reservoir Editor: 

• Operations 

• Zone 

• Rule 

• IF_Block.   

These menus provide options for creating and deleting operation sets, zones, rules, and 
IF_Blocks respectively.   

 

Figure 10.1 Reservoir Editor Operations Tab—Annotated 
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At the top of the Reservoir Editor, the Reservoir selector contains a list of all of the 
reservoirs in your network, with the name of the current reservoir displayed.  You can 
access all of the reservoirs in your network either from this list or by using the arrows to 
navigate through the available reservoirs.  Beside the Reservoir name list is the 
Description of the current reservoir; this field is editable. Use the description field to keep 
notes on decisions you made while developing the data for the reservoir, your plans, 

intentions, references, etc.  You can enter a longer description by using the  button to 
access the full text editor for the description. 

At the top of the Operations tab, the Operation Set selector contains a list of all the 
operation sets you have defined for the current reservoir.  Use the Operation Set selector 
to select the operation set you wish to edit.  The rest of the Operations tab will fill with 
the data for the selected operation set. 

Beside the Operation Set selector is the Description text box. Enter information in the 
Description field to describe the significant features of the operation set and how this 
operation set differs from others you may have created for this reservoir. You can enter 

and view longer descriptions by using the  button to access a larger text editor for the 
description. 

 

NOTE: In the Reservoir Network module of ResSim, the Operation Set selector 

defaults to the first operation set in the list when the editor is first opened or when 

you change to a new reservoir, so be sure the operation set you wish to edit is 

displayed in this selector before making changes. 

Below the Operations Set selector and the Description, the Operations tab contains a set 
of sub-tabs that provide the editors for specifying various features of your operation set.  
The first two tabs are active by default because they contain the features that must be 
defined for every operation set.  The remaining tabs are inactive by default because they 
are for optional features of your operation set.  The options to active the inactive tabs 
are available in the Operations menu of the Reservoir Editor. 

The first sub-tab is the Zone-Rules tab.  As the name implies, this is where you will create 
and edit the zones and rules for your operation set.  This tab has two parts, the Zone-
Rules Tree and its associated Edit Panel.  

The Zone-Rules Tree displays the zones you have defined for the current operation set.  
With each new operation set, ResSim creates a default set of zones that includes Flood 
Control, Conservation, and Inactive.  Beneath each zone in the tree is a prioritized list of 
the rules that apply to that zone.  As you add zones and rules to the reservoir, the tree 
will expand to show them. 

Like the Physical tab, the Edit Panel of the Zone-Rules sub-tab of the Operations tab, 
changes depending upon the element you select in the Zone-Rules Tree.  If you select a 
zone, the zone editor will appear in the Edit Panel.  If you select a rule, the specialized 
rule editor for that rule type will be displayed.  A thumbnail plot on the right side of the 
Edit Panel reflects the data you enter in the table of the current editor.  The thumbnail 
plot can be viewed in full size when you double-click on it. 
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The Rel. Alloc. sub-tab contains the editor for specifying the Release Allocation scheme 
for the current operation set.  The release allocation scheme describes the method the 
reservoir will use to distribute the release from the reservoir across the available outlets. 

10.2 Reservoir Operation Sets 

To guide the decision-making process in ResSim, a paradigm has been developed for 
describing the goals, objectives, and constraints that define how a reservoir should 
operate; this paradigm is called an operation set. 

An Operation Set is the operation plan or scheme upon which a reservoir bases its 
decisions regarding how much water to release at each timestep of a simulation run.  You 
can define multiple operation sets for each reservoir, but each alternative can follow only 
one operation set per reservoir. 

An operation set consists of the definition of at least four basic features:   

Zones are operational subdivisions of the Reservoir Pool.  Each zone is defined by a 
curve describing the top of the zone.  When you create an operation set, 
ResSim establishes a default set of zones within the operation set.  These 
zones are Flood Control, Conservation, and Inactive.  The Inactive zone is a 
special zone in the operation set.  It represents the “dead” storage of the 
reservoir.  The reservoir cannot release water from the Inactive pool, and 
rules cannot be added to this zone. 

Rules represent the goals and constraints upon the release(s).  Rules can be applied 
to selected zones of the reservoir to describe the different factors influencing 
the release decision when the reservoir elevation is within each zone. 

The Guide Curve is identified by selecting the top of one of your operational zones to 
represent the target elevation of the reservoir.  By default, ResSim assigns 
the Guide Curve to the top of the Conservation zone. 

 

The guide curve concept is used as the basis for the release decision 

process in ResSim.  Basic Guide Curve Operation means “get the 

reservoir pool elevation to the current guide curve elevation as fast as 

possible, within the physical and operational constraints of the 

outlets”. 

 

 

An operation set that has the zones defined but no rules will cause 

ResSim to follow the Basic Guide Curve Operation.  For testing 

purposes, every reservoir should have an operation set of this type.  It 

is the easiest way to verify that your physical data, your operational 

zones, and your guide curve have been properly defined. 

Release Allocation is the specification of how the release from the reservoir is divvied 
up across the reservoir’s outlets.   

A variety of advanced features can be added to the operation set to further describe the 
regulation plan for the reservoir.  These features are defined using the various sub-tabs 
of the Operations tab.  See Chapter 12 for information on modeling Outages (Section 
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12.5), Storage Credit (Stor. Credit sub-tab, Section 12.6), Decision Schedule (Dec. Sched. 
sub-tab, Section 12.7), and Projected Elevation (Projected Elev sub-tab, Section 12.8). 

This section describes how to create and edit an operation set.  The next section (Section 
10.3) describes how to configure the zones within your operation set. 

10.2.1 Creating a New Operation Set 

 To create a new Operation Set: 

•  Select New from the 
Operations menu of the 
Reservoir Editor.  The New 
Operation Set dialog will open 
(Figure 10.2). 

• Give the new operation set a 
Name and a Description. 

• Click OK to complete the 
process and to close the 
dialog. 

The name you entered will now appear in the Operation Set list, and the description 
will appear in the Description field.  The Description field is editable.  Use the 
description to describe the purpose of the operation set, the expected behavior the 
operation set should provide, and any changes you had to make to accomplish your 
goal. 

ResSim establishes a default set of zones within the new operation set.  These zones 
are Flood Control, Conservation, and Inactive.  These zones can be renamed or 
deleted.  However, the Inactive zone is a special zone in the operation set.  It 
represents the “dead” storage of the reservoir.  The reservoir cannot release water 
from the Inactive pool and rules cannot be added to this zone.   

The remainder of this chapter will detail all the options available for defining and 
editing your operation set.   

10.2.2 Renaming an Operation Set 

 To rename an operation set: 

•  Select Rename from the 
Operations menu of the 
Reservoir Editor.  The 
Rename Operation Set 
dialog will open (Figure 
10.3). 

• Give the operation set a 
new Name. 

 

Figure 10.2 New Operation Set 

 

Figure 10.3 Rename Operation Set 
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• Click OK to complete the rename process and to close the dialog.  A confirmation 
dialog will appear asking if you really want to rename the selected operation set. 

10.2.3 Copying an Operation Set 

To copy (or duplicate) an operation set: 

• Select the Operation 
set you want to copy 
from the Operation 
Set selector on the 
Operations tab. 

•  Select Duplicate from 
the Operations menu 
of the Reservoir 
Editor.  The Duplicate 
Operation Set dialog 
will open (Figure 
10.4). 

• Give the operation set a new Name and a Description. 

• Click OK to complete the copy process and to close the dialog. 

The new operation set will have a copy of all the zones that were in the original 
operation set.  Each zone in the new operation set will also list the same rules that 
were used by the original operation set. 

10.2.4 Deleting an Operation Set 

To delete an operation set: 

•  Select Delete from the Operations menu of the Reservoir Editor.  The Select 
Operation Set to Delete dialog will open (Figure 10.5). 

• Highlight the operation set 
you wish to delete.  Its 
name should appear in the 
grey box at the bottom. 

• Click OK to complete the 
delete process and to close 
the dialog.  A confirmation 
dialog will appear asking if 
you really want to delete 
the selected operation set. 

 

 

Figure 10.4 Duplicate Operation Set 

 

Figure 10.5 Select Operation Set to Delete 
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10.3 Reservoir Operation Zones 

As illustrated in Figure 10.6, when you create a new Operation Set, ResSim automatically 
creates a Zone-Rules tree that contains three default reservoir operation zones:  Flood 
Control, Conservation, and Inactive.  You may wish to rename these default zones and 
add descriptions.  You may need to define additional zones as well.  This section will 
detail how to edit the zone definitions of your operation set. 

 

Figure 10.6 Reservoir Editor Showing New Operation Set 

10.3.1 Adding a New Reservoir Storage Zone 

To add a new Reservoir Storage Zone: 

• Select New from the 
Zone menu of the 
Reservoir Editor.  The 
New Zone dialog will 
open (Figure 10.7). 

• Enter a Name and 
Description for the 
new zone. 

• Click OK to complete 
the zone creation and close the New Zone dialog. 

The new zone you created now appears in the Zone-Rules Tree.  Complete the 
process of creating the zone by defining the curve that represents the top of the 
zone, as explained in the next section. 

 

Figure 10.7 New Zone 
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10.3.2 Defining Operation Zones 

An operation zone of a reservoir is the storage between two elevations or levels of 
the reservoir.  To ResSim, a zone is defined by a curve representing the top of the 
zone and is usually named for that curve or upper level; the bottom of the zone (or 
lower level) is the top of the next lower zone in the operation set. The bottom of the 
bottom-most zone is the bottom of the reservoir pool. 

You will need to define the curve representing the top of each zone you create.  The 
default definition of a zone is a linear function of date and is specified with a table of 
dates and elevations.  The first date in the table is always 01Jan and the table is 
expected to represent the shape of the level over a single year.  When plotted, the 
top-of-zone curve is drawn with a series of straight lines connecting the points 
defined in the table. 

Although function-of-Date covers the majority of zone definitions, a top-of-zone 
curve can be defined as a function of something other than Date by selecting the 

Define button .  Your options include:   

o Date and Time,  
o Model Variable,  
o External Variable,  
o State Variable, or  
o Two Variables.   

For example, if the elevation of the top of the zone varies from year to year, then it 
can be defined as a function of an external time series (External Variable) by reading 
the top of zone from HEC-DSS.  Or, top of zone could be computed by a State 
Variable script within your model allowing it to vary as a function of multiple 
variables and conditions over time.  

When you select a zone in the Zone-Rules Tree, the Zone Editor is displayed in the 
Edit Panel and the thumbnail plot at the right of the editor will display the curves 
representing the top of each zone (Figure 10.8).  The color of the current zone’s 
curve will be red.  All other zones will be black except the zone that has been 
designated as the guide curve which will be cyan. The figure below shows the top-of-
zone curve definition for a zone named WS Curve B. 
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Figure 10.8 Reservoir Editor—Operations Tab—Zone Editor 

To define a top-of-zone curve:  

• Select the zone in the Zone-Rules Tree to access the Zone Editor and the data for 
that zone. 

• Use the Function of:  button to open the Independent Variable 
Definition editor (Figure 10.9): 

 

Figure 10.9 Independent Variable Definition 
“Zone is a Function of:” Selector 

• Select the type of function (and its variables) you want to use to define the top-
of-zone curve.  Your options include: 

Date: By default, the function type for a zone defintion is set to Date.  When a 
zone is defined as a Function of: Date, the data in the function table is 
expected to represent the top-of-zone elevation for a single year, which 
will be repeated as needed for a simulation. 

If function-of-date is appropriate for your zone, specify the top-of-zone 
curve by entering the Date and Elevation values for each inflection point 
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of your curve into the function table.  You can either copy and paste data 
from a spreadsheet application or type in the values manually.  The data 
you enter in the table will be displayed as the red curve in the thumbnail 
plot to the right of the table. 

Dates are entered in a DDMMM format — signifying a two-digit day (yes, 
use a preceding zero for days 1-9) and a 3-character month. Dates can 
also be entered using the calendar tool, which can be accessed by 
double-clicking in a date cell and then clicking the small ellipsis button  
that appears on the right side of the cell.   

NOTE: Function-of-date tables in ResSim ALWAYS start on 01Jan, which 
will appear in the first cell of the table.  This first cell is grey to indicate 
that it cannot be changed.   

The function-of-date curve for a zone is always a linear function, which 
means that the value of a point between two specified points in the table 
is computed using linear interpolation and the curve is plotted with a 
series of straight lines connecting the points defined in the function 
table. 

External Variable (Figure 10.10): Although External Variable is a standard option 
in the Independent Variable Definition editor, two aspects of the External 
Variable panel are unique when used to define a zone curve: 

Variable Name—Rather than requiring you to enter a Variable Name for 
the External Variable, ResSim will generate a name for the using 
the form: ReservoirName-ZoneName, where ReservoirName is 
the name of the current reservoir and ZoneName is the name of 
the zone for which you are specifying the independent variable. 

Define Zone with Time-Series checkbox — this option is included at the 
bottom of the External Variable panel.  By checking this option, 
you are telling ResSim that the data in the External Variable time 
series you will provide the alternative explicitly defines the zone 
elevation and no Function of: relationship is needed. As such, 
after you complete your setup of the External Variable and click 
OK, the function table in the Zone editor will be greyed out, 
indicated that the function is not required. 

 

Be careful when copying “Date” data from a spreadsheet.  Most 

spreadsheet applications use their own specialized numeric format 

for dates.  Only ‘text’ and dates in DDMMM format can be pasted 

into a date cell in ResSim. 

 

Since the Independent Variable Definition editor is used by a variety of 

features throughout ResSim, to minimize repetitiveness, the description 

for using it has been moved to Appendix C.  However, there are two 

unique options specific to zones that should be mentioned, and they are 

included below. 
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Two Variable (Figure 10.11): This is a new option for a zone definition.  It allows 
you to define the top of zone Elevation as a function of two independent 
variables.  The expected use of this option is to define the guide curve as 
a function of both Date and an External Variable that represents the 
forecasted inflow volume expected over the remainder of the season.  

The first independent variable, the Row Variable, can be one of:  

o Date, 
o Date and Time, 
o Model Variable,  
o External Variable, or  
o State Variable.   

The second independent variable, the Column Variable, can be one of: 

o Model Variable,  
o External Variable, or  
o State Variable.   

Don’t forget to set the Interpolation type and Time Series Options for 
each variable (as needed).  The values for the second independent 
variable must be defined for your function; use the Edit Column Values 
button open the editor to enter the values for the second variable. 

 

Figure 10.10 Zone as a Function of External Variable 
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• When you have finished defining the top of zone curve for the current zone, be 
sure to:  

o Specify the zone’s Zone Sort Elevation value; this value tells ResSim the sort 
order of the zones in the Zone-Rules tree and their relative elevation so they 
can be illustrated in the thumbnail plot.. If your zone is a function of Date (or 
Date and Time), the Zone Sort Elevation field is greyed-out and ResSim uses 
the elevation for 01Jan as the Zone Sort Elevation.  

o Click Apply to save your settings before moving on to the next zone.   

 

Be careful when defining each top-of-zone curve — zones may be 

coincident, but they should not cross one another. 

 

10.3.3 Renaming and Describing Operation Zones 

To change the name of a Zone as it appears in the Zone-Rules Tree and/or edit its 
description: 

• Select the zone (to be renamed) in the Zone-Rules Tree. 

• Select Rename from the Zone menu or select Rename from the context menu by 
right-clicking on the zone you wish to rename in the Zone-Rules Tree.  Enter the 
new name and/or description.  The Description field for the Storage Zone is also 
editable in the Edit panel of the reservoir editor. 

Any changes you make to the Zone name will be reflected in the Zone-Rules Tree. 

 

Figure 10.11 Zone as a Function of Two Variables 
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Renaming the Inactive zone does not change its nature.  The inactive zone is 

still a special zone from which the reservoir cannot release water and in which 

no rules can be added. 

10.3.4 Deleting Operation Zones 

To delete a zone from an operation set: 

• Select the Zone you wish to delete from the Zone-Rules Tree. 

• Select Delete from the Zone menu or select Delete from the context menu by 
right-clicking on the zone you wish to delete in the Zone-Rules Tree. 

• Click OK in the Delete Storage Zone dialog to complete the delete process. 

10.4 Selecting the Reservoir Guide Curve 

The top of zone curve of any zone in your reservoir can be selected to represent the 
Guide Curve (i.e., target elevation) of your reservoir.  
The guide curve (or rule curve) represents the basic 
objective of the reservoir − get the pool elevation to, 
and hold it at, the guide curve.  Without any other 
operational constraints, the decision logic will attempt 
to get to and keep the reservoir at the guide curve, 
within maximum outlet capacity and physical rate of 
change constraints.  By default, the zone initially 
labeled Conservation is selected as the guide curve. 

To select a different zone to represent the guide curve 
for your reservoir operation set: 

• Right-click on the zone to be used as the guide 
curve in the Zone-Rules Tree and select Set Guide 
Curve (Figure 10.12) from the context menu. 

• The name of the zone that is defined as the Guide 
Curve will be displayed with bold text in the Zone-
Rules Tree.  

10.5 Identifying the Inactive Pool 

The Inactive Pool is a special zone in the reservoir; its top of zone curve represents the 
level below which the reservoir may not release water.  Even if it is physically possible to 
release water below the top of the Inactive Pool, the reservoir is not allowed to do so.  As 
such, rules cannot be placed in the Inactive Pool since, operationally, the allowable 
release range is already zero.  Any zone in your reservoir can be selected to represent the 
Inactive Pool of your reservoir.  By default, the zone initially labeled Inactive is selected as 
the Inactive Pool. The name of the zone that is identified as the Inactive Pool will be 
italicized in the Zone-Rules Tree. 

 

Figure 10.12 Set Guide Curve 
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To select a different zone to represent the Inactive Pool for your reservoir operation set: 

• Right-click on the zone in the Zone-Rules Tree to be used as the Inactive Pool and 
select Set Inactive Pool from the Zone’s context menu. 

10.6 Specifying Release Allocation 

As we’ll see in the next chapter when we create rules, rules can be specified to apply to a 
specific outlet, thus imposing an “allocation” of the release determined for that rule to 
the identified outlet.  Although rule-based allocation takes precedence, there are usually 
releases that are not specifically allocated by the rules; these are typically the releases 
made due to rules or operations that are applied to the dam or reservoir as a whole and  
are the ones the Release Allocation feature is intended to manage. 

Release Allocation is the method ResSim uses to allocate the release from the reservoir 
to its outlet groups and their available outlets.  The Release Allocation feature is available 
on the Rel. Alloc sub-tab of the Reservoir Editor’s Operations tab.  This feature enables 
you to specify the release allocation method by weighting or prioritizing the outlets in 
your reservoir’s outlet hierarchy. 

Three Release Allocation methods are currently available in ResSim:  

• Balanced—releases distributed based on default or user-defined weights, 

• Sequential—releases distributed sequentially to outlets prioritized by ranking, and 

• Stepped—combines the balanced and sequential approaches. 

By default, HEC-ResSim uses an evenly balanced (or weighted) allocation scheme to share 
the unallocated release across the available (see Section 12.5) outlets of a reservoir.  The 
default Balanced allocation scheme is illustrated in Figure 10.13 below. 

 

Figure 10.13 Release Allocation Editor—Default Allocation—Balanced 

However, this default allocation scheme may not be desirable or appropriate for one or 
more of your reservoirs.  For example, in many hydropower reservoirs, all releases are 
directed to the power plant first (to achieve incidental power generation); other outlets 
would be used only when the power plant has reached capacity (or when the desired 
release is too small to send through the power plant efficiently).  For this example, a 
sequential or prioritized scheme for allocating the release should be used.  
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To edit the reservoir’s Release Allocation scheme for the active Operation Set: 

• Select the Release Allocation sub-tab (Figure 10.14) of the Reservoir Editor’s 
Operations tab to access the Release Allocation editor.   

 

Figure 10.14 Release Allocation Editor—Balanced Allocation—Even Balance Example 

• In the outlet tree at the left, select the group for which you want to define the 
allocation scheme.  The group may be the reservoir itself, the dam, or an outlet 
group that you defined in the reservoir’s outlet hierarchy on the Physical tab of the 
Reservoir Editor.  The release allocation is defined at all but the lowest level of the 
outlet hierarchy.   

• Next, select the Allocation Type and specify the associated weights or order for the 
outlets or outlet groups within the selected group.  Your options are:  

Balanced—Each outlet in the outlet group is assigned a Weight for the Balanced 
allocation method.  The weights, entered in the table to the right of the 
outlet hierarchy tree, will be used to distribute the outlet group’s release 
between its outlets.  ResSim will normalize the values entered in the table to 
produce a set factors that are then applied to the group’s total release to 
produce the release for each outlet within the group. 

In the example illustrated in Figures 10.13 and 10.15, the Allocation Type for 
both Hurst (the reservoir) and Hurst-Dam is Balanced.  The weights specified 
in the table for Hurst (the reservoir) define an even balance (i.e., a 1:1 ratio) 
between the Dam (1.0) and the Emergency Spillway diverted outlet (1.0).  
The weights specified in the table for Hurst-Dam define an uneven balance 
(or distribution) among the available outlets in the Dam; the Power Plant is 
allocated 50% of the release from the Dam while the Main Gates and Sluice 
Gates are allocated 30% and 20% of the Dam release, respectively. 

 

Figure 10.15 Release Allocation Editor—Balanced Allocation—Uneven Balance Example 
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Sequential—To define the Sequential allocation type, the available outlets are 
assigned an order of priority, indicating which outlet gets the release first.  
When the first outlet it reaches capacity, the next outlet gets the remainder 
of the release until it reaches capacity, and so on.  

In the example illustrated in Figure 10.16, the group called Sayers-Dam has 
been assigned the Sequential Allocation Type, and the outlets within that 
group have been ordered so that the Power Plant is first, then the Sluice 
Gates, and the Main Gates are last. 

 

Figure 10.16 Release Allocation Editor—Sequential Allocation Example 

To set up the Sequential allocation type and define the order of the outlets: 

• Highlight the appropriate component (e.g., the “Dam”) in the left panel 
of the editor.   

• In the right panel of the editor, select Sequential from the Allocation 
Type selector.  Below the Allocation Type selector, a text box will display 
the list of outlets in the selected outlet group. 

• Select an outlet in the list and use the arrows located on the right side of 
the textbox to move the outlet up or down in the list.  The outlet at the 
top of the list will be the first to release (up to its capacity), then the next 
outlet in the list will release (if needed, up to its capacity), and so forth.   

Stepped—The Stepped allocation type is a combination of the Balanced and 
Sequential allocation types.  Stepped allocation allows for distribution of a 
reservoir release among the outlets of the outlet group with the portion of 
the release allocated to each outlet varying over a specified range of outlet 
capacities.   

The distribution of the group’s total release across its outlets, and varying by 
step, is defined using a column for each outlet and rows describing the steps 
(or ranges of outlet capacity).   A dropdown menu that defines units for 
values entered can be selected from the Table Units selector.  The Stepped 
allocation method is designed to allow two or more options for the Table 
Units, although only one option has been implemented for ResSim version 
3.3 – % Release Capacity.   
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To define the Stepped allocation method, enter values into the table, in 
decreasing order of % Release Capacity, to describe how the total release to 
the group should be distributed to each outlet.  Each value represents that 
outlet’s share of the total release that its row in the table can accommodate. 

The table always starts with a row in which a value of 100% is entered for 
each outlet.  This means that if the total release assigned to the group is 
equal to the sum of the total capacity of each outlet, then each outlet will be 
allocated 100% of its capacity to release.  

Enter values in each succeeding row such that the % Release Capacity value 
for at least one of the outlets is less than the value entered for that outlet in 
the previous row.  The sum of the flows represented by the % capacity value 
for each outlet in a given row equals the total release that can be made by 
the group using that row’s distribution.  

If needed, additional rows can be added to the table by right-clicking in a cell 
of the table and selecting Insert Row(s) or Append Row from the table’s 
context menu.  Insert Row(s) will add the number of (blank) rows you 
specified into the table above the row of the cell from which you accessed 
the context menu.  Append Row will add a blank row below the last row of 
the table.  

It is not necessary to enter a final row where the allocation to each outlet is 
0% since that will by assumed by ResSim. However, that (assumed) last row 
(of all zeros) represents a total group release of 0 cfs. 

At each timestep, ResSim will calculate the release that each value in the 
table represents based on the current release capacity of the assoicated 
outlet.  It then sums these release values by row to determine the total 
release that can be made by the group using that row’s distribution. Next, 
ResSim determines the two successive rows that bound the total release 
allocated to the group and uses linear interpolation to determine the release 
each outlet will make.  

Although defining the data for the Stepped allocation type is not as intuitive 
as defining the other two allocation methods, the following example should 
clarify how the data will be used and thus help you to determine the values 
to enter to produce the desired allocation. 
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In the Stepped release allocation example shown in Figure 10.17 , the Sayers-
Dam outlet group has been assigned the Stepped allocation type and the 
table is filled with values (in units of % Release Capacity) to define how the 
total release to the group should be divied up between the outlets. To 
understand how these values will be used, read the entries in the table from 
bottom up. 

The bottom row (row 4) indicates that the total dam release, if less than or 
equal to 100% of the Power Plant’s capacity, should go to the Power Plant. 

The next row up (row 3) indicates that if the total dam release is less than or 
equal to 100% of the Power Plant’s capacity plus 50% of the Sluice Gates’ 
capacity, the releases to Sayers-Dam are intended to go to the Power Plant 
first and then to the Sluice Gates.   

The next row up (row 2), as well as the top row (row 1), indicate that if the 
total dam release is greater than the sum of the Power Plant’s capacity plus 
50% of the Sluice Gate’s capacity, the excess is shared between the Sluice 
Gates and the Main Gates. The distribution of that excess between the Sluice 
Gates and the Main Gates appears to be 1:2, but it’s not quite that simple 
because the values in the table are not % Total Release but rather % Release 
Capacity.  As such, the weighting of the release between the two outlets is a 
function of their capacity at any given time. 

The significance of the use of % of Release Capacity can be seen by looking at 
at the arithmetic for the state of the system at timestep i : 

• The Power Plant’s release capacity = 5,000 cfs 

• The Sluice Gates’s release capacity = 5,000 cfs  

• The Main Gates’s release capacity = 20,000 cfs 

 

Using these capacities, the table of releases computed for the timestep is: 

 

 

Figure 10.17 Release Allocation Editor—Stepped Allocation Example 



HEC-ResSim User’s Manual  Chapter 10 - Reservoir Operations — The Basics 

  10-19 

Row 
# 

Main Gates 
(%: cfs) 

Power 
Plant 

(%: cfs) 

Sluice Gates 
(%: cfs) 

Total 
Release 

(cfs) 
1 100: 20,000 100: 5,000 100: 5,000 30,000 
2 50: 10,000 100: 5,000 75: 3,750 18,750 
3 0: 0 100: 5,000 50: 2,500 7,500 
4 0: 0 100: 5,000 0: 0 5,000 

 0: 0 0: 0 0: 0 0 

 

If the total release to the Dam is 9000 cfs, then the release falls between 
rows 2 and 3.  Using linear interpolation with the data in rows 2 and 3, the 
calculations for divvying up the 9000 cfs release are: 

• Total Flow Ratio = 9000 – 7500/ 18750 – 7500 = 0.13333 

• Power Plant = 5000 + 0.13333 x (5000 – 5000) = 5000 

• Sluice Gates = 2500 + 0.13333 x (3750 – 2500) = 2666.66 

• Main Gates = 0 + 0.13333 x (10000 – 0) = 1333.33 
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Chapter 11 

Reservoir Operations — The Rules 
Operation Rules represent the operational goals and constraints for each zone of the 
operation set.  Each zone can contain a different set of rules depending on how the 
regulation plan describes the flow limits and requirements for that operating zone.  

As previously described in Section 10.3.2 and illustrated in Figure 10.8, as you create and 
arrange your operating zones and rules in the current operation set, they are displayed in 
the Zone-Rules Tree on the left side of the Operations tab of the Reservoir Editor.  The 
order of the rules in each zone indicates their relative priority.   

In Chapter 10, you learned about guide curve operation and operation zones.  In this 
chapter, you’ll learn about the variety of Operation Rules you can create to describe the 
goals and constraints on the operation of your reservoirs.  But, to understand how rules 
work, it is important to understand the release decision process and how it uses the rules 
and their relative priority. 

The Release Decision Process 

The ResSim decision logic for determining the reservoir releases in each timestep is called 
the Release Decision Process.  It involves determining an allowable release range, 
calculating the desired guide curve release, and comparing the two to arrive at a release 
decision.   

The allowable release range is defined by a minimum allowable release and a maximum 
allowable release.  The reservoir’s physical and operational constraints are used to 
determine the allowable release range. 

The desired guide curve release is, by definition, the release the reservoir should make to 
get to or stay at guide curve in this timestep.  This calculation derives from the basic 
Conservation of Mass Equation:  

Inflow minus Outflow equals Change in Storage. 

There are few limitations on how the desired guide curve release is computed since guide 
curve operation is the primary objective of the reservoir operation.  However, the 
computations do include logic to limit or prevent oscillating releases as the reservoir pool 
elevation approaches the guide curve. 

The steps that make up the release decision process are: 

Estimate Physical Limits—The decision logic begins by estimating the physical capacity of 
the reservoir to release water, given the reservoir’s state at the start of the 
timestep and an estimate of the pool elevation at the end of the timestep.  
Unless the dam leaks, the physical minimum release limit is usually zero.  The 
physical maximum release limit is a function of the estimated average elevation 
for the timestep. The physical release limits establish the initial values for the 
minimum and maximum limits of the allowable release range. 
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Identify the Current Zone—To determine the current zone, the decision logic computes 
the elevation value at the end of the current timestep from each top-of-zone 
curve or relationship.  Then, working from the bottom up (based on the zone-
sort order), it compares the reservoir pool elevation computed at the end of the 
previous timestep to each “current” top-of-zone elevation until it finds the zone 
elevation value that is greater than or equal to the current pool elevation. 

Identify the Active Rules—If necessary, the decision logic evaluates all relevant State 
Variables, IF-Blocks, and Rule Modifiers to identify the active rules in the current 
zone and assemble them in an ordered list based on priority. 

Apply the Rules—The decision logic then works its way through the list of active rules 
from the highest priority rule to the lowest.  As each rule is evaluated, its current 
release limit is applied to the allowable range. The maximum allowable release is 
reduced if a rule calls for a lower maximum, and the minimum allowable release 
is increased if a rule calls for a higher minimum.  However, if a rule has a desired 
maximum limit that is greater than the current maximum allowable release or 
has a desired minimum limit lower than the current minimum allowable release, 
the allowable range will remain unchanged.  Since rules are evaluated from 
highest to lowest priority, the allowable range can never be widened, because 
the rule attempting to do so would violate the higher priority rule or physical 
constraint that set the limit.  

Calculate the Guide Curve Release—After evaluating all the rules, the decision logic then 
determines the desired guide curve release. This is the release needed to bring 
the reservoir pool elevation to the guide curve in the current timestep 
(computation interval) based on the starting pool elevation, the prior release, 
and the current inflow.  

Determine the Release—In this final step, the decision logic compares the guide curve 
release to the limits of the allowable range.  If the guide curve release is within 
the allowable range, the release decision will be the guide curve release. 
However, if the guide curve release is outside the allowable range, the release 
decision will be the limit of the allowable range nearest the guide curve release.  

For example: if the desired guide curve release for this timestep (guide curve 
release) is 35,987 cfs but the final maximum limit of the allowable release range 
is 10,000 cfs, then the release decision will be 10,000 cfs. 

Why are rules “prioritized”? 

Sometimes, the rules that describe the desired operation of the reservoir conflict with 
one another and a means for resolving the conflict is needed.  A conflict is when two 
rules call for a desired release or a release limit that cannot both be satisfied.   

For example, a reservoir might have a minimum release rule of 500 cfs and a maximum 
downstream control rule of 12,000 cfs.  At a given timestep during high flow conditions, 
the downstream control rule evaluates to a maximum release of 100 cfs from the 
reservoir.  If the reservoir releases 500 cfs, the downstream rule is violated.  If the 
reservoir only releases 100 cfs, the minimum flow rule is violated.   
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ResSim uses rule prioritization as the method for resolving rule conflicts — the highest 
priority rule wins.  And, it is up to you, the modeler, to order your rules appropriately for 
all circumstances.  

The fundamental rule for applying rules to the allowable release range is:  

As each rule is applied, from highest priority to lowest, the allowable range may narrow, 
by reducing the maximum limit or increasing the minimum limit, but it may not widen.  

Therefore, a minimum limit rule may raise but not lower the minimum limit of the 
allowable range.  

For example, if the current minimum allowable release is 100 cfs, a minimum limit 
rule of 500 cfs may raise the minimum allowable release to 500.  This is allowed 
because a release of 100 cfs is still met by a 500 cfs release so the higher priority rule 
(min 100) is not violated by the lower priority rule (min 500). 

But, if the next rule calls for a minimum release of 10 cfs, the allowable range would 
not change.  The minimum would stay at 500 cfs.  This is not considered a violation of 
the 10 cfs minimum rule, since a minimum release of 500 cfs still meets the minimum 
10cfs objective  

And, a maximum limit rule may lower the maximum limit of the allowable range but 
not raise it.  

For example, if the current maximum allowable release is 9000 cfs, a maximum limit 
rule of 5000 cfs may lower maximum allowable release to 5000.  Remember a 
maximum limit of 9000 allows for the release to be any value less than 9000.  By 
reducing the maximum limit to 5000, a value less than the previous limit of 9000, the 
9000 cfs limit is not violated. 

These examples can be considered illustrations of the following two Rules of Thumb that 
you should remember when prioritizing rules: 

When two maximum-limit rules are beside one another in the rule stack, their 
relative priority doesn’t matter – the smaller max wins (sets the maximum limit of 
the allowable range). 

When two minimum rules are beside one another in the rule stack, their relative 
priority doesn’t matter – the larger min wins (sets the minimum limit of the allowable 
range). 

11.1 Managing Rules 

Before we discuss each of the available rule types and all their parameters, we are going 
to learn about how to manage rules in general. 

The Zone-Rules Tree of the Zone-Rules sub-tab of the Operations tab of the Reservoir 
Editor (Figure 11.1) is the primary tool for interacting with the rules in your operation set.   
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Figure 11.1 ResSim Rule Editor 

When you click on a zone or rule in the tree, you have selected that element of the 
operation set, and the Edit Panel to the right of the tree displays the corresponding zone 
or rule editor.   

The Rule Editors that display in the Edit Panel have a few common attributes which are 
located at the top of each editor: 

Operates Release From: this field identifies the release element that was chosen when 
the rule was created.  The release element that the rule applies to cannot be 
changed once a rule has been created. 

Rule Name: this field displays the name you entered when you created or renamed the 
rule.  Rule names should be short but reasonably descriptive of the type, 
purpose, and/or objective of the rule. 

Description: this field is editable and does not have a length limit.  Be sure to enter a 
description for each rule you create. Your description should include the purpose 
of the rule, what operating constraint it represents, and any other important 
characteristics. To open a larger description editor/viewer, click the ellipsis 

button . 

When you right-click on a zone or rule in the tree, its context menu will display (Figure 
11.2).   
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Zone Context Menu 

 
Rule Context Menu 

Figure 11.2 Rule Management Functions in the Zone and Rule Context Menus 

A zone’s context menu provides functions for adding or removing rules from the selected 
zone. A rule’s context menu includes functions for renaming that rule, managing that rule 
within the current zone, and adding or removing the rule from all zones in the current 
operation set.  Most of these rule management functions can also be found in the Zone 
and Rule menus that are included in the menu bar of the Reservoir Editor when the 
Operations tab and its Zone-Rules sub-tab are active. Because of this duplication 
between the context menus and the Zone and Rule menus (illustrated in Figure 11.3) and 
to minimize repetitive descriptions, the following sections will provide instructions 
primarily using the context menu.  Use the menu you are most comfortable with (the 
menu in the menu bar or the context menu from the tree nodes). 

 

 

Figure 11.3 Rule Management Functions in Zone and Rule Menus in Menu Bar 

11.1.1 Creating New Rules 

When you create a rule, you must: 

• identify the release element that the rule constrains, 

• select the rule type, and 

• give the rule a name (and an optional, but recommended, description). 

You learned about release elements in Chapter 9. They include the reservoir itself, 
the dam, the outlet groups, diverted outlets, and the outlets.  The only release 
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element to which you cannot assign an operation rule is an uncontrolled outlet 
because its releases cannot be controlled, and rules are all about controlling releases.  

ResSim has several rule types to choose from. The availability of the rule types varies 
depending on the release element. Some rules can only be applied to a specific type 
of outlet while other rules can be applied to more than one type of release element.  
Table 11.1 lists the various release elements and the rule types that can be applied to 
them. 

Table 11.1 Matrix of Rule Relese Element and their Available Rule Types 
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Reservoir ✓ ✓ ✓ ✓ ✓   ✓ ✓ 

Dam or Group ✓  ✓     ✓ ✓ 

Controlled Outlet ✓  ✓     ✓ ✓ 

Power Plant ✓  ✓   ✓  ✓ ✓ 

Pump       ✓   

Uncontrolled 
Outlet 

Rules cannot be applied to an uncontrolled outlet 

To add a new operation rule to a zone: 

• Right-click on the zone in the Zone-Rules Tree to which you want to add the new 
rule. 

• Select Add New Rule… from 
the zone’s context menu.  
The New Operating Rule 
dialog will open (Figure 
11.4).   

• The three fields of the New 
Operating Rule dialog 
include: 

Rule Name:—Enter a name for the new rule.  You may want to enter this 
after specifying the other two parameters 

Operates Release From:—Select the release element of the reservoir to 
which you will assign this rule (reservoir pool, dam, outlet group, or 
outlet) 

Rule Type:—Select the rule type from the selection list.  The available rule 
types in the list will depend upon your selection for Operates Release 
From.   

The new rule will appear, highlighted, at the bottom of the set of rules in the 
selected zone in the Zone-Rules Tree and the edit panel will display the 
appropriate rule editor for the new rule’s type.  The first two fields for each rule 

 

Figure 11.4 New Operating Rule 
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editor contain the name of the rule and its description.  The description of the 
rule can be added or changed whenever the rule editor is displayed in the edit 
panel.   

11.1.2 Using Existing Rules 

A rule can be used in more than one zone and in more than one operation set.  

To add a rule that you have already created to a zone: 

• Right-click on the zone you want to add the rule to and select Use Existing Rule… 
from the context menu. The Select Existing Rule dialog will open (Figure 11.5).   

• Select the rule you want to add from the white rows in the table.  The grey rows 
in the table are rules that are already being used in the current zone.  

• Click OK to add the rule and close the Select Existing Rule dialog.  (Cancel will 
close the dialog without adding a rule to the zone.) 

• The selected rule will appear at the bottom of the list of rules in the selected 
zone.  See Section 11.1.3 for instructions on prioritizing rules. 

To add a rule to all zones in the current operation set: 

• Follow the instructions above but place a checkmark in the Add Rule to All Zones 
checkbox before clicking OK in the Select Existing Rule dialog. 

If you have a rule in one zone that you want to add to all zones in the current 
operation set: 

• Right-click on the rule and select Add Rule to All Zones from the rule’s context 
menu. 

 

Note: Rules belong to the reservoir in the current network, not to a zone or to 

an operation set. So, when you see a rule in a zone, it is a reference to the rule, 

NOT a copy of the rule. Thus, a change to a rule in a zone carries through all 

operation sets and zones that use that rule in the current Network.  

 

Figure 11.5 Select Existing Rule 
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11.1.3 Prioritizing Rules 

Each time you add a rule to a zone, it is placed at the bottom of the rule stack. The 
rule stack is the list of rules in the zone.  The order of the rules in the rule stack 
indicates their relative priority—the highest priority rule is first in the list (at the top) 
and the lowest priority rule is at the bottom of the list.   

To raise or lower the priority of a rule within the rule stack of a zone: 

• Right-click on the rule in the zone and select one of the move functions from the 
context menu: 

Increase Priority—moves the rule up one position in the list 
Decrease Priority—moves the rule up one position in the list 
Move to Top—moves the rule to the top of the list 
Move to Bottom—moves the rule to the bottom of the list 

 

NOTE: The prioritization (move) functions only apply to the position of the 

selected rule in the current zone of the current operation set.  The rule stack 

of each zone is prioritized independently of all other zones and all other 

operations sets. 

Some rules are designed to work best when applied at the top or bottom of the rule 
stack, so pay special attention when prioritization of a rule is discussed in that rule’s 
description later in this chapter.  For example, Induced Surcharge rules should be 
placed at the top of the rule stack and Tandem rules should be at the bottom.   

11.1.4 Removing Rules 

Removing a rule from a zone does not delete the rule from the reservoir.  The rule 
still exists in the reservoir for inclusion in other zones and operation sets. Several 
options are available for removing rules from a zone or zones of the current 
operation set.  They include: 

• Remove a rule from a selected zone  

• Remove a rule from all zones  

• Remove all rules from a selected zone 

To remove a rule from a selected zone… 

• Right-click on the rule you want to remove in zone you want to remove it from in 
the Zone-Rules Tree and select Remove from the context menu. 

• A confirmation dialog will appear asking you to verify that you want to remove 
the rule (Figure 11.6).  Click OK to complete the removal (or Cancel to abort the 
process).  The rule will disappear from the current zone. 

 

Figure 11.6 Confirmation Dialog—Remove Rule 
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To remove a rule from all zones: 

• Select Remove Rule From All Zones from the context menu.   

To remove all rules from a selected zone: 

• Right-click on the zone and then select Remove All Rules in this Zone from the 
context menu.   

11.1.5 Deleting Rules 

Delete is the only rule management function that is not available from the rule’s 
context menu.  To delete a rule from the reservoir: 

• Select the Delete option from the Rule menu.  This will open the Delete Rules 
dialog (Figure 11.7).  

• As the title bar implies, the Delete Rules dialog will allow you to select one or 
more rules to delete.  Clicking on a row in the table will select a rule.  To select 
multiple rules, use the Shift or Ctrl keys on your keyboard when you click a row. 

• Click OK to accept your selection(s) and close the Delete Rules dialog.  

11.1.6 Renaming Rules 

To rename a rule: 

 

Figure 11.7 Delete Rules Dialog 

 

Use caution when deleting rules! 

The selected rule(s) will be deleted from all zones and operation sets of the 

current reservoir in the current network.  In addition, downstream control and/or 

system hydropower rules will be deleted from all zones and operation sets of all 

reservoirs in the current network that used those rules.  



Chapter 11 - Reservoir Operations — The Rules HEC-ResSim User’s Manual 

11-10  

•  Right-click on the rule in the Zone-Rules Tree and select Rename from the 
context menu.  The 
Rename Rule dialog 
will open.  

• Enter a new name in 
the Name field. 

• If desired, add or 
revise the description 
for the rule in the 
Description field. 

• Click OK to complete 
the rename process. Cancel will dispose of your changes and close the dialog. 

 

Use caution when renaming rules. Because rules belong to the reservoir, when 

you rename a rule, all instances of the rule in all the zones and operation sets 

of the current network will be renamed. 

 

11.2 Release Function Rules 

The Release Function rule type is one of the two most flexible rule types available in 
ResSim (the other being the Downstream Control Function rule). Most of the rules you 
create for your reservoirs will be Release Function rules. 

With this rule type, you can define a wide array of “function of” rules—meaning rules 
whose desired release (limit) is a function of the current date or pool elevation or inflow 
or pretty much whatever you can think of.  A rule of this type can be assigned to any of 
the release elements — the reservoir (pool), the dam, an outlet, or an outlet group. And, 
this rule allows you to specify the maximum, minimum, or specified flow to be released 
through the release element. 

The simplest Release Function rules are defined as a function of Date. A function-of-date 
release rule describes a seasonally-varying release limit whose seasonal pattern, which 
always starts on 1 January, repeats annually.  

A constant release rule is usually specified as a function-of-date rule where only one date 
and its associated value is entered in the function table. 

The more complex Release Function rules are defined as a function of a time-series 
variable.  The time-series variable types are internal (model) variables, external variables, 
and state (scripted) variables.  

A function-of-external-variable release rule is a little more abstract than a function-of-
model-variable rule simply because the variable itself is provided as input and is not 
computed by ResSim.  The variable and its relationship to the release is limited only by 
your imagination and the time-series data available.  

 

Figure 11.8 Rename Rule Dialog 
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Since state variables are user-defined variables whose value is computed in each 
timestep of the simulation by a Jython script written by the modeler, a Function of State 
Variable Release Function rule could represent almost any operating constraint.  

Here are some example release function rules that could be found in a water control 
manual or reservoir regulation plan: 

“The maximum release from the reservoir during the growing season is 6,500 cfs and 
8,500 cfs during the non-growing season” is an example of a seasonally-varying 
operating constraint.  This can be represented with a function-of-date release rule. 

“The reservoir must release at least 3 cfs or 10 percent of inflow up to a maximum of 
100 cfs, whichever is greater” is an example of a more complex operating constraint. 
Since inflow to the reservoir is one of several model variables computed by ResSim, 
this constraint could be defined as a function-of-model-variable release rule.   

“During spawning season, releases from the reservoir should be guided by Table 7.3, 
which relates the forecasted maximum daily air temperature at the spawning grounds 
to releases from the low level outlets” is a more abstract complex operating 
constraint that could be modeled with a function-of-external-variable release rule. 
Since ResSim cannot compute or forecast air or water temperature, a time-series 
record that describes the predicted or observed values for that variable would be 
required in order to determine each timestep’s the release limit based on the 
function you define.   

“The reservoir must release at least 4800 cfs unless system drought operations have 
been declared whereby the minimum release is 4000 for drought level 1, 3800 for 
drought level 2, and 3600 for drought level 3” is an example of an operating 
constraint that would need a state variable and an associated release function rule to 
represent it.  The state variable would calculate the current drought level and the 
rule would use that value to determine the rule’s desired release limit for each 
timestep. 

To define or edit a Release Function rule: 

• Create a new rule as described in Section 11.1.1.  Be sure to select Release Function 
for the Rule Type in the New Operating Rule dialog. 

• Or, if necessary, select the Release Function rule you want to define/edit from the 
Zone-Rules Tree.   

The edit panel of the Operations tab of the Reservoir Editor will display the Release 
Function Rule editor (Figure 11.9).   

The following sections describe each field, option, or attribute of the Release Function 
Rule editor and how to define the associated data. 
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Figure 11.9 Reservoir Editor—Operations Tab—New Release Function Rule 

11.2.1 Select the Limit Type 

Remember, each rule you create describes a desired limit on the allowable range of 
release from the reservoir.  Although some rules are inherently a specific limit type, 
the release function rule, with all its flexibility requires that you select the limit type 
as part of the rule definition. 

Select that the Limit Type from the selection list 
(Figure 11.10).  Your options are:  

• Minimum 

• Maximum 

• Specified 

Specify the limit type early in the process of defining 
your rule because it keeps your mind focused on your objective while you complete 
the rest of the rule definition. 

 

Figure 11.10 Rule Limit Type 

 

  NOTE: Use the specified limit type with caution.   

Most operational constraints describe either a minimum or maximum release 

limit.  Specified rules describe the precise amount of flow to be released, neither 

more nor less, making them effectively both a minimum and a maximum limit at 

the same time.  As such, a specified release rule is very restrictive because it sets 

the allowable range of the release to a single value.  If specified is the appropriate 

limit type, consider carefully where to place the rule in the rule stack.  Unless the 

rule applies to a specific outlet, the bottom of the rule stack is usually the best 

place for specified-limit rules; in this position, other rules have a chance to 

influence the allowable range. 
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11.2.2 Define the Function 

The function (or Release Function) is the relationship between the desired release 
(limit) and the variable it is a “function of”.  The release function is defined by: 

• The specification of the independent variable or variables (what the release is a 
“function of”). 

• The table of values describing the function 

• The interpolation type to be used when looking up a value in the table. 

11.2.2.1 Select the Independent Variable of the Function 

Use the  button to the right of the Function of: field to open the 
Independent Variable Definition editor (Figure 11.11).  Although limited 
instructions for using the Independent Variable Definition editor are provided 
below, the full description of how to use this editor was placed in Appendix C to 
minimize duplication since the Independent Variable Definition editor is used in 
several of places throughout ResSim. 

 

Figure 11.11 Release Function Rule—Independent Variable Definition Editor 

Release is a Function of:—this field, at the top of the editor, is the independent 
variable (Date, Date and Time) or variable type (Model Variable, External 
Variable, or State Variable) for your function.   

Variable Selection Panel—below the Release is a Function of: field is a panel for 
identifying the specific variable. 

If you select Date or Date and Time, no additional information is needed 
to define the independent variable so the Variable Selection Panel will be 
blank.  

If you select Model Variable or State Variable, a table of available 
variables of that type will be displayed and you must select the specific 
variable for the independent variable of your function. 

If you select External Variable, a single Variable Name field will be 
provided.  Enter a unique name for the External Variable.  Make the 
name descriptive enough that you will recognize it in the Alternative 
Editor’s Time Series tab when it comes time to associate an HEC-DSS 
pathname to this variable. 
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Time Series Options—If you selected Model Variable, External Variable, or State 
Variable, the Time Series Option section is included on the right side of 
the Variable Selection Panel.  These options allow you to define how the 
value of the independent variable is determined in each timestep before 
being used to look up the desired release from the release function. 

Function—Choose a time series function from the selection list. The 
available functions include: 

Previous Value—this function returns the value from the 
selected variable’s time series that was computed at the 
end of the previous timestep.  The previous value of 
several model variables, such as elevation, can be 
considered the starting condition of the current 
timestep. 

Current Value—this function returns the value from the selected 
variable’s time-series for the current timestep. NOTE: 
some variables, like inflow, are known for the current 
timestep while others, like elevation, have been 
computed yet because they are computed at the end of 
the timestep, after release decisions have been made. 

Offset Value—this function returns a value from the selected 
time-series that is some number of hours offset from the 
end of the current timestep. This function requires a 
value in the Offset field.   

Period Average—this function returns the average value from a 
set of values retrieved from two or more timesteps of 
the selected variable’s time series. This function looks 
for values in both the Offset and Period fields to 
determine the range of values to use to compute the 
average. 

Period Maximum—this function returns the maximum value 
from a set of values retrieved from two or more 
timesteps of the selected variable’s time series. This 
function looks for values in both the Offset and Period 
fields to determine the range of values to use to 
determine the maximum value. 

Period Minimum—this function returns the minimum value from 
a set of values retrieved from two or more timesteps of 
the selected variable’s time series.  This function looks 
for values in both the Offset and Period fields to 
determine the range of values to use to determine the 
minimum value. 

Offset—the offset identifies a timestep in the selected time-series 
relative to the current timestep. Enter a value in hours.  
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A positive value indicates a future timestep while a negative 
value indicates a past (or completed) timestep. ResSim will 
convert the offset from hours to timesteps by dividing by the 
length of the timestep (compute interval) and truncating any 
remainder.   

For example, to get the value computed 3 hours earlier, enter a -
3 in the offset field.  NOTE: If the compute interval is 2 hours, a -
3 offset will cause ResSim to return the value from the previous 
timestep (an offset of -1 timesteps). 

Period—the period is the number of hours over which one of the Period 
functions computes a value. Enter a value in hours. 

The period is always back in time relative to the time indicated 
by the offset.  If the offset is zero or blank, the period is back in 
time relative to the current timestep. ResSim will convert the 
period from hours to timesteps by dividing by the length of the 
timestep (compute interval) and truncating any remainder. 

When you have identified the independent variable and its Time Series Options, 
click OK to complete the definition of the Independent Variable of your release 
function and close the Independent Variable Definition Editor. 

11.2.2.2 Select the Interpolation Type 

The interpolation type indicates the type of curve that the data in the release 
function table describes.  It also specifies the interpolation method to be used 
when performing a lookup from the release function table.  The three Interp 
options are: 

Linear—this option will cause ResSim to interpret the data in the table as a linear 
curve — where each pair of points (2 consecutive rows in the table) are 
connected by a straight line. And, linear interpolation is used when 
performing a lookup on the table to obtain a release.  Figure 11.12 shows 
an example of a release function with the interpolation type set to 
Linear. The thumbnail plot shows how ResSim interprets the data as a 
linear curve (a series of straight line segments). 
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Figure 11.12 Example Release Function Rule using Linear Interpolation 

 

Step—this option will cause ResSim to interpret 
the data in the release function table as a 
step function — where the release value 
in each row is held constant (drawn 
horizontal) until changed by the next 
row.  Step interpolation is used to 
determine a release value when 
performing a lookup on the table—if the 
independent value falls between rows in 
the table, the value of the release (the 
dependent variable) is the release value 
in the row above. Figure 11.13 shows the 
thumbnail plot for the same function 
shown in Figure 11.12 but with the interpolation type set to Step.  

Cubic—this option will cause ResSim to interpret 
the data in the release function table as a 
3-point Cubic Spline curve.  When a value 
for the independent variable is used to 
perform a lookup on the table to obtain 
an associated release (the dependent 
variable), the release is determined by the 
cubic spline function defined with each 
three consecutive rows in the table. Figure 
11.14 shows the thumbnail plot for the 
same function shown in Figure 11.12 but 
with the interpolation type set to Cubic.  

11.2.2.3 Seasonal Variation 

If you selected a time series variable — Model, External, or State Variable — as 
your independent variable, a second independent variable, Date, can be selected 
to describe your release function. For example, if your release limit varies as a 

 

Figure 11.13 Step Interpolation  

 

Figure 11.14 Cubic Interpolation 
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function of pool elevation but the lookup table has a column for growing season 
and non-growing season, then your first independent variable is the model 
variable Elevation and the second independent variable is date (or season). 

To add Date as a second independent variable of your release function: 

• Click the Seasonal Variation  button located at the bottom of the 
list of modifiers to the right of the release function table.   

• The Seasonal Variation editor (Figure 
11.15) will open.  

Dates—Use the Seasonal Variation 
editor to define the seasons 
or date values to be entered 
into your release function 
table.  The seasons or dates 
that you enter here define 
the columns of your function 
table (Figure 11.16). 

Interpolation Type—this interpolation 
type selection applies to the 
columns of the release function table. The interpolation type on the 
main edit panel applies to the rows of the table (between the values 
list for the first independent variable.) Your options are: Linear, 
Cubic, or Step. 

 

Figure 11.16 Release Function table for 
a Seasonally-Varying Function of Inflow Relationship 

• When you have finished entering the dates that represent the start of each 
season, click OK.  The Seasonal Variation editor will close, the Seasonal 

Variation checkbox will be checked , and 
the function table will have a column for each season start date you specified 
(Figure 11.16). 

11.2.2.4 Filling in the Function Table 

The release function is defined by the data you enter in the table (Figure 11.16) 
in the rule editor.  The first column of the table represents your independent 
variable and the second column represents the desired release. 

 

Figure 11.15 Seasonal Variation Editor 
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The data you provide should span the full range of values of the independent 
variable that could be used to lookup a desired release when the rule is 
evaluated in each timestep of a simulation.  If, during the table lookup process, 
the value provided for the independent variable is outside the range of the data 
in the table, the returned release value will be from the end of the table whose 
independent variable value is closest to the provided value. 

In addition, the data values entered into the table for the independent variable(s) 
must be monotonically increasing; this means that the value in the first (top-
most) row in the table must be less than the value in the next row, and the value 
in the next row must be less than the value in the row below that, and so on, 
with no duplicate values. 

Manual Data Entry 

You can type values directly into cells in the table. Although you can use your 
mouse to move between cells in the table, the Tab key and the Enter key on your 
keyboard may make the process of data entry faster. 

Tab—each click of the Tab key will move your cursor from one cell to the 
next cell in a row (left to right).  And, when you reach the last cell of 
a row, the next Tab will move the cursor to the first cell of the next 
row. 

Enter—each click of the Enter key will move the cursor to the next cell down 
in the current column. When you reach the last cell in a column, the 
next Enter will move the cursor to the first cell of the next column (to 
the right).  

Neither the Tab nor the Enter keys will add rows to the table. The following 
options for adding rows to the table are available from the table’s context menu: 

Append Row—If you need to add a row to the bottom of the table, right-click 
on any cell in the table and select Append Row from the context 
menu of the table.   

Insert Rows—to add multiple rows to the table, right-click on a cell in the 
table above which you want to add the new rows, then select Insert 
Rows.  A dialog will open asking how many rows to insert.  Enter the 
number of rows you want to insert above the selected cell and click 
OK. 

Copy and Paste 

If the data for your function is available in a spreadsheet application or any 
program that displays the data in a table, you can use the copy and paste 
functions to enter the data into the function table in ResSim.  

To COPY: 

• In the source program, select the range of data 

• If available, select Copy from a menu of the editor or from the context menu 
of the table – OR – press Ctrl-C on your keyboard. 

To PASTE: 
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• Select the first cell where you want the data placed in the function table in 
ResSim 

• Right-click on the cell and select Paste – OR – press CRTL-V on your 
keyboard.  

Note: When pasting a range of data into the function table, you do not need to 
select an equal range of cells in the table to paste the data into; you only need to 
select the first cell where you want the data placed. The paste function will 
overwrite preexisting data in the table. And, if the number of rows of data you 
have copied is greater than the number of rows available in the table below the 
selected cell, the paste function will expand the table (append rows) to 
accommodate the data. 

The thumbnail plot to the right of the function table will reflect the values in the 
table. This is very useful to verify the data you are entering in the table; you can 
quickly see when a value entered is out of range or order with respect to the 
other values. To view the plot “full-size”, double-click on the thumbnail plot.  If it 
seems that the plot does not reflect the data you just pasted in, click the Apply 
button or double-click in a cell, re-enter in the data for that cell, then click in 
another cell.  This action will cause the table to notice that it contains new data 
and the thumbnail plot should update accordingly. 

11.2.3 Release Rule Modifiers 

Several options are available to modify the value returned by your rule or to 
influence its applicability.  These rule modifiers are located below the thumbnail plot, 
at the bottom right of the rule editor.  The rule modifiers are: 

Period Average Limit—to meet the flow limit over a period of time rather than 
timestep by timestep 

Hour of Day Multiplier—modify the flow limit hour by hour 

Day of Week Multiplier—modify the flow limit for each day of the week 

Rising/Falling Condition—apply the rule only if the current conditions match the 
rising or falling condition specification. 

11.2.3.1 Period Average Limit 

ResSim treats most rules as an “instantaneous” limit on the release, which means 
that it tries to meet that limit every timestep.  The Period Average Limit rule 
modifier allows you to specify a range of time, or period, over which the release 
limit determined from the release function applies; options for the averaging 
period include: None, Daily, and Weekly.  Occasional violations of the rule’s limit 
would be allowed as long as the average release over the period meets the rule’s 

 

Be careful when copying dates from a spreadsheet.  Most spreadsheet 

applications use their own specialized numeric format for dates.  Only ‘text’ 

dates in the form DDMMM or DDMmm can be reliably pasted into a date cell 

in ResSim. 
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limit.  The averaging period is not a sliding 
period or time window relative to the 
current timestep; instead, it is a standard 
calendar day (0000-2400) or week (7 
sequential calendar days starting on a day 
of the week of your choosing).  

The Period Average Limit rule modifier 
also allows you to specify a Daily Release 
Pattern for each day in the averaging period; options for the pattern type include 
All Week, Weekdays and Weekend, and Each Day.  The Daily Release Pattern is 
defined by an hourly table, but the values specified in the pattern table are 
weights, not multipliers (like the Hour of Day Multipliers). ResSim will normalize 
the set of weights you specify in the daily pattern so that the average value of 
the set of weights for each day (Daily period) or for each week (Weekly period) 
equals 1.0. The normalized weights can be thought of as multipliers of the flow 
limit determined from the function table to produce the rule’s desired limit for 
the current timestep.  If the objective for a given timestep is not met, the weights 
for the remaining timesteps of the period will be scaled so that the overall 
objective can still be met over the period. 

To make your release function rule a Period Average Limit rather than an 
instantaneous limit: 

• Click the Edit… button to the right of the Period Average Limit label. 

• The Period Average Limit editor will open (Figure 11.17).  Specify each of the 
attributes needed to define the Period Average Limit: 

Period—Select the averaging Period from the selector. The options for the 
averaging Period are: 

None—indicates that the Period Average option is not active.  

Daily—for timesteps less than 1DAY, ResSim will attempt to make 
the average flow over each 24-hour period (0000 – 2400) 
equal to the given rule value.  Not useful with a 1DAY 
timestep. 

Weekly—the averaging period is 1 calendar week, starting on the Starting 
Day of Period.  The Weekly period is useful with longer timesteps, 
especially 1DAY. 

Starting Day of Period—use this selector to specify the first day of the Week 
for a Weekly averaging period.   

—use the Daily Release Pattern button to open 
the Period Average Requirement Pattern editor (Figure 11.18). The 
purpose of this editor is to allow you to specify the daily pattern and 
hourly weights to be used for the averaging period; you can even 
specify a set of daily patterns for seasonally varying demand 
schedules. 

 

Figure 11.17 Period Average Limit Editor 
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Seasonal Variation—If the daily release pattern changes with the 
time of year, click the Seasonal Variation Edit to open the 
Seasonal Variation editor and define the seasons.  Section 
11.2.2.3 describes how to use the Seasonal Variation editor. 

 Specify Pattern for—select the pattern type you want to use. Your 
options are All Week, Weekday and Weekend, and Each Day 
as described above. Three types of Daily Release Patterns 
are available:  

All Week—applies the same pattern for every day of the 
week.  The pattern table provides a row for each 
hour of the day.  

Weekdays and Weekend—allows you to specify a different 
release pattern for weekdays (Monday through 
Friday) than for weekend days (Saturday and 
Sunday). 

Each Day—allows you to specify different release 
requirement patterns for each day of the week.  

Figure 11.18 illustrates the pattern tables for each of the three 
pattern types. 

• Click OK to save your settings and close the Period Average Limit editor.  

 Back in the rule editor, if you selected a 
Period of Daily or Weekly, the check box in front of the Period Average Limit will 
be checked indicating that this option is “ON”.  The next two modifiers—Hour of 
Day Multipliers and Day of Week Multipliers—are not available when the Period 
Average Limit option is active.  

All Week Weekdays and Weekends Each Day 

   

Figure 11.18 Period Average Limit—Daily Release Patterns 
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11.2.3.2 Hour of Day Multiplier 

 The Hour of Day Multiplier allows you to specify a table of factors (based on the 
time of day) that will be applied to the desired release returned from the release 
function.   

Use the Hour of Day Multipliers to represent an operating constraint that 
requires a minimum (or maximum) flow during only a portion of the day.  

For example, to specify a rule that would only apply from 8:00 a.m. to 5:00 p.m. 
In addition, the midday hours need twice as much flow than the early morning 
and late afternoon hours.  To reflect these requirements, set the multipliers to: 

1—for 0800, 0900, 1500, and 1600 

2—for 1000, 1100, 1200, 1300, 1400 

0—for all other hours  

Figure 11.19 illustrates these settings in the 
Hour of Day Multiplier editor. 

To define a set of Hour of Day Multipliers: 

• Click the Edit… button to the right of the 
Hour of Day Multiplier label.   

• The Hour of Day Multiplier editor will 
open. Specify the attributes needed to 
define the Hour of Day Multipliers: 

Time Interval—At the top of the editor 
is a selector for the Time 
Interval.  Figure 11.20 shows 
the Hour of Day Multiplier editor with the Time Interval selector 
open to display its list of options. 

 Multipliers—The rest of the editor is a table for you to specify the 
multipliers for each interval of the day. A multiplier of 1.0 has no 
impact on the value of the desired release so the table will 
initially be filled with 1.0. 

• Click OK to save your settings and close 
the Hour of Day Multiplier editor.   

Back in the rule editor, if the table of 
multipliers you just saved has any cell 
whose value is not 1.0, the check box in 
front of the Hour of Day Multiplier label 
will display a check mark indicating that 
the Hour of Day Multipliers are active: 

 

 

Figure 11.19 Example Hour of Day 
Multipliers 

 

Figure 11.20 Hour of Day Multiplier 
Editor—Time Interval Options 
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11.2.3.3 Day of Week Multiplier 

The Day of Week Multiplier allows you to specify a factor (based on the day of 
the week) that will be applied to the desired release determined from the release 
function.  To define a set of Day of Week multipliers: 

• Click on Day of Week Multiplier Edit button  

•  The Day of Week Multiplier editor (Figure 11.21) 
will open.  This editor contains a table with a row 
for each day of the week.  A multiplier of 1.0 has 
no impact on the value of the desired release so 
the table will initially be filled with 1.0. 

• Use the Day of Week Multipliers when 
representing an operating constraint that only 
applies to certain days of the week or that varies 
by day of week. 

Figure 11.21 illustrates the following example: 
for a minimum flow that is only required on weekdays but not weekends, set 
the multiplier for Monday–Friday to 1.0 and set Saturday and Sunday to 0.0. 

• Click OK to close the Day of Week Multiplier editor.   

Back in the rule editor, if the table of multipliers you just saved has any cell 
whose value is not 1.0, the check box in front of the Day of Week Multiplier 
will display a check mark indicating that the Day of Week Multipliers are 

active:  

11.2.3.4 Rising / Falling Condition 

The Rising/Falling Condition rule modifier can be used to restrict the applicability 
of a rule (i.e., to turn the rule on or off as a function of the specified condition).  
The condition is evaluated every timestep.  If the condition evaluates to TRUE, 
then ResSim includes the rule in the rule stack, evaluates it, and applies it within 
the release decision logic.  However, if the condition evaluates to FALSE, ResSim 
ignores the rule (does not include the rule in the rule stack, does not evaluate 
the rule, and does not apply the rule in the release decision logic). 

The Rising/Falling Condition rule modifier allows you to select one of eight 
conditions with which you can restrict the applicability of the rule.  These 
conditions include:  

1. rising pool elevation 
2. rising or constant pool elevation 
3. falling pool elevation 
4. falling or constant pool elevation 
5. rising inflow 
6. rising or constant inflow 
7. falling inflow  
8. falling or constant inflow. 

 

Figure 11.21 Example Set of  
Day of Week Mulitpliers 
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To apply a rising/falling condition to a rule: 

• Click the Rising/Falling Condition Edit button. 

• The Rising/Falling Condition dialog will open (Figure 11.22).  A Rising/Falling 
Condition is defined by the following 
attributes. You must select or enter a 
value for each attribute: 

Condition—choose from: 

o Rising  
o Rising or Constant 
o Falling or Constant 
o Falling  

Parameter—choose from: 

o Pool Elevation 
o Inflow  

Averaging Period—this is a range of time define in hours back from the 
current timestep. The period is used, along with Tolerance, to 
determine if the Condition is met. Think of the averaging period as 
time span over which the slope of the Parameter is computed. 

Tolerance—The tolerance is used for the determination of the “constant” 
portion of the condition. If the difference in the Parameter over the 
Averaging Period is less than the Tolerance, the condition is 
considered constant — neither rising nor falling.   

• Click OK to save your settings and close the Rising/Falling Conditions dialog. 

A check mark will appear in the Rising/Falling Conditions checkbox: 

 

When you have finished entering data for your rule, be sure to click Apply before 
moving on to the next rule.   

An example of a completed Release Function rule is shown in Figure 11.23.   

 

Figure 11.22 Rising/Falling Condition 



HEC-ResSim User’s Manual Chapter 11 - Reservoir Operations — The Rules 

  11-25 

 

Figure 11.23 Example of Completed Release Function Rule 

 

11.3 The Downstream Control Function Rule 

The Downstream Control Function rule describes a minimum or maximum flow or stage 
limit (e.g., flow requirement, channel capacity, flood stage) at a control point rather than 
an explicit limit on the reservoir release.  However, like all ResSim rules, when the rule is 
evaluated for a given timestep, it must produce a desired release limit. The desired 
release limit that the downstream control rule calculates will be determined based on the 
downstream objective, the influence of routing to the control point, previous and future 
releases, and the cumulative local flows at the control point. 

A Downstream Control rule can be used to implement or impose an implicit system 
operation. System operation occurs when two or more parallel reservoirs are operated 
together to meet a common objective, in this case—the downstream constraint. Once a 
Downstream Control rule is created at one reservoir, it will be included in the list of 
Existing Rules at each reservoir in the network that is upstream of the control point.  All it 
takes to establish an implicit system operation is to use the same downstream control 
rule in each applicable reservoir’s operation set.  Chapter 13 discusses ResSim’s 
methodology for defining and managing system operation. 

Defining a Downstream Control Function rule is very similar to defining a Release 
Function rule.  In fact, the Downstream Control Function rule editor is an extension of the 
Release Function rule editor described above, so this section will focus on describing how 
to define the three attributes that are unique to the Downstream Control Function rule 
— Parameter, Flow Contingency, and Advanced Options.   

Like all ResSim rules, a Downstream Control Function rule must be assigned to a release 
element when the rule is created. However, a Downstream Control Function rule can 
only be assigned to the reservoir itself because the rule evaluation logic must account for 
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all releases from the reservoir, including releases through a diverted outlet, that could 
influence the flow or stage at the downstream control point.   

To create a Downstream Control Function rule: 

• Right-click on the zone in the Zone-Rules Tree to which you want to add the new 
rule. 

• Select Add New Rule… from the zone’s context menu.  The New Operating Rule 
dialog will open.   

• Select the reservoir from the Operates Release From: selector.  It will be the first 
entry in the list. 

• Select Downstream Control Function from the Rule Type selector. This selection will 
cause a new field — Downstream Location — to appear in the New Operating Rule 
dialog (Figure 11.24). 

• Select a junction from the 
Downstream Location 
selector that represents 
the control point of 
interest.  The list of 
available locations will 
include all the reaches 
and junctions in the 
current network that are 
downstream of the 
current reservoir. 
Reaches are included for completeness, but there are very few situations in which a 
reach is the appropriate selection for a downstream control point.  

• Give the rule a name and click OK to complete the creation of the new rule and close 
the New Operating Rule dialog.   

As illustrated in (Figure 11.25), your new rule will appear at the bottom of the rule 
stack of the current zone in the Zone-Rules tree and the Downstream Control 
Function rule editor (in the edit panel) will show the name of your rule and the 
Downstream Location you selected when you created the rule. 

 

Figure 11.24 Reservoir Editor—New Operating Rule—
Downstream Control Function 

 

 Note: When you see a grey box drawn around a junction in the Map 

Display area of ResSim, this is a visual cue that the junction is a control point 

for a downstream control rule.  
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Figure 11.25 Reservoir Editor—Downstream Control Function Rule 

Refer to the Release Function Rule section above for descriptions of the features and 
parameters that are common to both the Release Function rule and the Downstream 
Control Function rule.  The features and parameters that are unique to the Downstream 
Control Function rule editor are described in the following sections. 

11.3.1 Parameter 

The Parameter is the objective variable of the rule; as such it is the dependent 
variable of the downstream control rule’s function table. Your Parameter options are 
Flow and Stage. 

11.3.2 Limit Type 

For a Downstream Control Function rule, your options for the limit type are 
Minimum and Maximum.  Specified is not an available limit type for a Downstream 
Control Function rule. 

 

Since the downstream control logic in ResSim operates for a Flow target, if 

you choose Stage as the Parameter for your downstream control function, 

you must provide a rating curve that relates flow to stage at the junction you 

identified as the control point so that ResSim can, in each timestep, lookup 

the value of the flow limit represented by your rule’s stage limit value. 

Although a Rating Function (stage as a function of two variables) can now be 

specified in ResSim, if the rating function at your control point reflects a 

backwater influence, the downstream operation may not be able to produce a 

valid estimate of the flow limit at the control point during the rule evaluation 

in each timestep.  For this reason, a Simple Rating is recommended at the 

control point when operating for Stage. 
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11.3.3 Flow Contingency Factor 

The Downstream Control Function rule editor offers a Rule Modifier that is not 
available to a Release Function rule— a Flow Contingency Factor.  The purpose for 
this factor is to enable you to apply an uncertainty factor to the cumulative local flow 
so that the downstream control objective can still be met even when the quantity of 
the local flow is most uncertain.   

If the limit type of the downstream control rule is Maximum, ResSim will use the 
contingency factor to increase the cumulative local flow at the control point which 
effectively reduces the available space at the control point.  The reduced available 
space will cause the reservoir to release less than it would have without the 
contingency factor.  This would make the operation appear more “conservative”. 

If the rule’s limit type is Minimum, the contingency factor will be used to decrease 
the cumulative local flow, effectively increasing the available space at the control 
point and causing the reservoir to release more than it would have without the 
contingency factor, thus reducing the risk of not meeting the objective. 

To apply a contingency to the cumulative local flows at the Downstream Location: 

• Click the Flow Contingency  button to open the Flow Contingency for 
Downstream Operation dialog (Figure 11.26). 

 

Figure 11.26 Flow Contingency for Downstream Operation 

• Two options are available for specifying the Flow Contingency factor: 

Constant Contingency percentage—select this radio button if you want the 
local flow to be increased by a constant percentage, then enter a 
value in the textbox.  For example, if you want to adjust the 
cumulative local flow by 20%, enter 20 in the textbox. 

Contingency percentage as a function of Cumulative local flow—select this 
ratio button if you want the contingency factor to vary with the 
magnitude of flow.  With this option, you must enter a relationship 
between the computed cumulative local flow at the control point 
and the contingency factor to be applied to it in the downstream 
control computations.  For example, if the estimate of local flow is 
more uncertain under high flow conditions than under low, base 
flow conditions, you could enter a relationship where the 
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contingency factor is zero or very small for smaller flow values and 
increases with larger flow values. 

• Click OK to save your settings and close the Flow Contingency… editor.  

If you specified a flow contingency factor or relationship, the Flow Contingency 

checkbox will be checked:  in the Downstream 
Control Function rule editor. 

 

NOTE — the current implementation of the Flow Contingency Factor is not 

quite what has been described here.  Testing has revealed that the 

Contingency Factor is currently being applied to the limit of the rule rather 

than to the cumulative local flow at the control point.   

Look for this to be corrected in a future version of ResSim.  If your model 

uses this feature, the correction will cause the newer ResSim to produce 

different results than the current version does. 

11.3.4 Advanced Options 

In addition to local inflows, the downstream control logic is affected by two other 
external factors — routing and rate of change constraints.  Additional logic, referred 
to as Advanced Options, has been added to ResSim’s downstream control algorithm 
to enable you to make adjustments that may help ResSim respond better to these 
external factors or minimize their influence on the downstream control operation.  
Specifically, the Advanced Options relate to how routing, attenuation, and rate of 
change constraints are considered during the operation for downstream control 
rules.  The four Advanced Options are named: 

1. Correct for Attenuation 

2. Consider Rate of Change Constraints 

3. Routing Time Window 

4. Pulse Flows 

The parameters that control the first three of the Advanced Options are available in 
the downstream control rule’s Advanced Options editor and can be specified (as a 
set) to apply to all downstream rules or to just the current rule. The fourth Advanced 
Option, Pulse Flows, is described the next section. 

To edit the Advanced Options: 

• Click the Advanced Options button  located at the bottom 
right of the Downstream Control Function rule editor. The Advanced Options 
editor will open (Figure 11.27). 
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Figure 11.27 Advanced Options for Downstream Control 

• Specify whether this rule should use the Global settings for the Advanced 
Options or if it should use its own, Rule Specific, set of Advanced Options 
settings.  Make this choice by selecting one of the two radio buttons located at 
the top of the Advanced Options editor.  Your choices are: 

Use Global Options—this is the default for all downstream control rules unless 
you select the other option in the rules that should use a different set of 
settings.  

To view and/or modify the global options, click the Edit button to the 
right of the Use Global Options radio button.  The Global Downstream 
Options editor will open (Figure 11.28).  You may view or edit the global 
Advanced Options settings whether or not the Use Global Options radio 
button is selected for the current rule. 
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Figure 11.28 Global Downstream Options 

Use Rule Specific Options—choose this radio button if you want to specify a set 
of Advanced Options setting that will apply only to the current 
downstream rule. If you choose this option, the panel below the radio 
buttons will become active, allowing to you modify the available options.  

Whether you are editing the Global settings or the Rule Specific settings, the 
available Advanced Options and their parameters are: 

Correct for Attenuation—Choose one of the three radio buttons in this section of 
the editor (Figure 11.29) to identify which method the downstream 
control logic will use to adjust its desired release limit to account for the 
effects of attenuation.  Your choices include: 

 

Figure 11.29 Advanced Downstream Options—Methods to 
Correct for Attenuation 

Option 1 (Lagged Space Adjustment)—if you choose this option (the 
default), you can enter Max Iterations, an Absolute Flow 
Tolerance (cfs or cms), and a Tolerance Fraction of Limit (%).  
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However, before making changes to these parameters, see how 
well the default values work for your model.  This method seems 
to work well with non-linear routing. 

Option 2 (Predictor Corrector)—enter Max Iterations and a Correction 
Factor (from zero to one).  This method seems to work well with 
linear routing. 

No Correction—select this option when you do not want any 
adjustments made based on the routing attenuation parameters.  
This option is usually the fastest, but it is applicable only if your 
local inflows change gradually or do not oscillate from high to 
low values two or more times within the routing window. 

Rate of Change Constraints—By default, ResSim considers rate of change limits 
when determining the routing time window for each downstream 
control rule.  This means that ResSim estimates the number of timesteps 
it needs to make adjustments to its releases so that both the rate of 
change is satisfied and the downstream objective is not violated and 
adds that estimate to the routing window to be used by the downstream 
control logic. 

Consider ROC Constraints—In this section, you can turn OFF the 
influence of rate of change constraints on the downstream 
operation by unchecking this checkbox (Figure 11.30). 

Max Lookahead for ROC (Number of Time Steps)—If Consider ROC 
Constraints is ON, you can use this field to specify the maximum 
number of timesteps that can be added to the routing time 
window to account for rate of change constraints.  This is a way 
to limit how much ResSim can extend the routing window to 
accommodate rate of change constraints. 

Blank—When Consider ROC Constraints is ON (checked) and the 
Max Lookahead… field is blank (the default), no limit is 
placed on how many timesteps can be added to the 
routing time window to account for rate of change 
constraints.  Unfortunately, ResSim’s estimate of the 
number of timesteps needed may be excessive; 
especially if the model has one or more variable rate of 
change constraints.   

 

Figure 11.30 Advanced Downstream Options—Rate of Change 
Constraints 

Routing Time Window—for each downstream control rule, ResSim computes the 
number of timesteps into the future over which a release made in the 
current timestep will influence (be part of) the flow at the control point.  
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The length of this time window is a function of the routing between the 
reservoir and the control point.  It is determined at the start of the 
compute process, before the input data has even been loaded.  The next 
section, titled Pulse Flow Options, includes a description of how ResSim 
computes the routing window and about how you can help ResSim 
improve those computations. 

Limit look ahead time window for downstream control—If you active this 
checkbox, ResSim will replace the computed routing time window with a 
value equal to the lag time multiplied by a factor (Figure 11.31).  The 
factor that ResSim will use is [1 + Multiplier].   

Use this option if your model is using non-linear routing and the routing 
time window that ResSim computed is too long, causing the downstream 
control operation to appear to “not be working right”. 

To activate and use this option: 

• Click in the Limit look ahead time… checkbox to add (or remove) the 
checkmark.  When a checkmark appears in the checkbox, the option 
is ON or active.  

• Enter a Multiplier value.  

 

Although Multiplier is not a great name for this parameter, 

the value you enter will be added to 1.0 to produce a factor.  

The lag time will be multiplied by this factor to produce a 

new value (or limit) for the Routing Time Window. 

Be sure to carefully consider the value you enter for the multiplier.  If 
you do not enter a value, the default multiplier value is 1 which 
results in a factor of 2. Thus, the new routing window = 2 x lag time.  

 

Figure 11.31 Advanced Downstream Options—Limit the 
Routing Time Window 

Reset Parameters—this button  will clear your settings and 
restore the settings and their parameters back to their original, default values. 

 

Note: Since these Advanced Options are complex, “trial and error” runs 

might be needed to test their impact on downstream operations. 

11.3.5 Pulse Flow Options 

The purpose of the Pulse Flow Options is to allow you to specify a new value for the 
Default Pulse Flow and/or to specify a reservoir-specific Pulse Flow value for one or 
more of the reservoirs in your network.  ResSim uses the Pulse Flow value in its 
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algorithm for determining the routing window that will be used in the downstream 
control operations logic. 

In order to identify when the value of the pulse flow needs to be changed and what 
value should be used, you need to understand how ResSim estimates the routing 
time window. 

The Routing Time Window 

When downstream control (DSC) rules are active in an alternative, ResSim adds a 
special compute section, labeled Evaluating Routing for Downstream Operations, 
to the beginning of the compute of the alternative.  During this compute section, 
ResSim routes a “pulse” of water from each reservoir (with downstream control 
rules) to that reservoir’s downstream control points.  It then compares the 
hydrograph of the pulse as it left the reservoir to the routed version of the pulse 
at each control point in order to determine the peak to peak “lag time” and the 
overall spread of the pulse at the control point. The routing time window for 
each control point starts with the timestep when the pulse left the reservoir and 
ends at the end of the “spread”.  The routing time window computed by ResSim 
for each active downstream control rule will be reported in the compute log at 
the start of the Computing Regulated Flow section—look for the messages that 
start with “Pulse Width Steps =”.  An example of these messages is shown in 
Figure 11.32. 

To view the routed hydrographs of the pulse flow produced by your model: 

• Open DSSVue from the Tools menu of your simulation 

•  Filter the DSS pathnames for a C-part of Flow-Routing-YourReservoir-1 
where YourReservoir is the name of the reservoir you are interested in.  

• Select the dataset generated at the outflow junction of the reservoir and the 
dataset generated at the downstream-most control point. Then,  

• Plot the selected datasets. 

An example plot of the two suggested pulse flow hydrographs is shown in Figure 
11.33. Did you notice that the pulse illustrated above is actually an inverted 
pulse?  Routing an inverted pulse of water is numerically more stable for the 
hydrologic routing methods used by ResSim.  It is also more consistent with how 
reservoir operations actually work; reservoirs rarely send out pulses of water, 
instead they often maintain a relatively constant release then cut back when 
necessary. 

 

Figure 11.32 Example Compute Log Messages—Computed Window Size for 
each DSC Rule 
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If you look carefully at the hydrograph leaving the reservoir, you’ll see that 
ResSim is routing a constant flow and then cutting that flow in half for one 
timestep before returning the flow to the original constant value.  The inverted 
pulse is the one-timestep cutback.  Although it is a bit of a misnomer, the Pulse 
Flow Options editor labels the constant flow value Pulse Flow.  The default value 
for the Pulse Flow is 5000 cfs (142 cms). 

 

Figure 11.33 Plot of Pulse Flow and Routed Pulse Flow 

The Pulse Flow Options is the only other option 
currently available in ResSim for influencing the 
estimate of the Routing Time Window used by 
the downstream control operation logic. 
However, this option is not located in the 
Downstream Control Function rule editor.  
Instead, it is located in the Dam menu or the 
Dam’s context menu (Figure 11.34) on the 
Physical tab of the Reservoir Editor.  

The Pulse Flow Options is the only option, other 
than those included in the downstream control 
rule’s Advance Options, that is currently 
available in ResSim for influencing the estimate 
of the Routing Time Window used by the 
downstream control logic. However, this option 
is not located in the Downstream Control Function rule editor.  Instead, it is 
located in the Dam menu or the Dam’s context menu on the Physical tab of the 
Reservoir Editor (): 

To edit the Pulse Flow value(s): 

• Open the Reservoir Editor and click on the Physical Tab. 

Figure 11.34 Dam Context 
Menu—Pulse Flow Options 
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• Right-click on the Dam in the Reservoir Tree, then select Pulse Flow Options 
from the context menu. The Pulse Routing Options editor will open: (Figure 
11.35). 

 

Figure 11.35 Pulse Routing Options Editor 

• Enter a new Pulse Flow value in the Default Pulse Flow textbox.   

Remember, the value you are entering as the Pulse Flow is actually the 
constant flow of the pulse flow hydrograph and the magnitude of the 
inverted pulse is half of that.  As a rule of thumb, use a pulse flow value that 
is 1.5—2 times larger than the average value of the limit that the reservoir 
should usually be operating for. 

• And/or uncheck the Use Default box for each reservoir for which you want to 
specify a new Pulse Flow value, then enter the new Pulse Flow value in the 
last column of the table. 

If your model is using a linear routing method in your reaches, then there should 
be no need to change the Pulse Flow value(s) from the default since the routing 
window will not change as a function of flow.  However, if you are using a non-
linear routing method, then determining an appropriate value for the pulse flow 
can be a challenge, especially if you are operating for both a minimum and a 
maximum limit at the control point.  Decide which limit is the most important, 
then, as a rule of thumb, set the pulse flow to 1.5—2 times the average value of 
the downstream limit defined at the control point.  See how that value affects 
the routing window and the downstream operation.  If necessary, adjust from 
there.  It won’t take long to zero-in on an appropriate value. 

• When you have finished setting the Pulse Flow value(s), click OK to save your 
setting and close the Pulse Flow Options editor.   

• Be sure to click Apply in the Reservoir Editor to save your changes to the 
reservoir data in the network before proceeding to another tab or reservoir. 
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11.4 The Induced Surcharge Rule 

In the context of watershed hydrology, the word surcharge refers to the extra storage 
that naturally occurs behind an uncontrolled spillway when the pool elevation exceeds 
the spillway’s crest (and inflow exceeds outflow from the reservoir).  Thus, surcharge 
storage is the volume of water in the reservoir above the spillway crest elevation.  This 
concept is illustrated in Figure 11.36.  

 

Figure 11.36 Surcharge Storage 

Induced surcharge is the extra storage that occurs behind a controlled spillway when the 
spillway gates are at least partially open.  The adjective induced is used to indicate that 
the extra storage was caused by man’s actions and not a natural occurrence.  So, since 
induced surcharge is caused by opening the gates, then induced surcharge storage is the 
volume of water in the reservoir above the elevation of the top of the closed gates.  As 
the gates are opened (together), the elevation of the top of the gates rises providing 
more room for water to be held behind the dam (as long as inflow exceeds outflow).    
Figure 11.37 below shows both the minimum and the maximum positions of the gates on 
a spillway, closed and fully open, and the maximum size of the induced surcharge pool. 
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Figure 11.37 Induced Surcharge Storage 

Induced surcharge operation is the process of adjusting the position of the spillway gates 
for the specific purpose of inducing surcharge.  When the gate opening is set to limit the 
spillway flow to less than free overflow, water is intentionally surcharged—or stored—
behind the gates.   

To water managers (reservoir regulators), Induced Surcharge Operation is a flood risk 
reduction operation that calls for larger releases (than would be made under normal 
flood operations) when the current pool elevation together with a rapidly rising inflow (or 
pool elevation) threaten dam stability. As such, it could be considered a “save the dam” 
operation.  Induced surcharge operation allows operators and regulators to manage an 
extreme flood event by utilizing the additional volume above the top of the (closed) 
gates.  

Although induced surcharge operations are predicated on the assumption that the 
reservoir has a gated spillway, this is not necessarily a requirement.  The actual 
requirements are (a reserved quantity of storage at the top of the usable reservoir pool 
and enough release capacity to pass the peak inflow of the PMF or reservoir design 
storm.  For example, a reservoir may be constructed without a gated spillway but with 
one or more lower level outlets have far more release capacity than would ever be 
utilized under normal conditions.  If a portion of storage at the top of the pool of this 
reservoir is identified for use only under extreme inflow conditions, an operating plan 
could be developed that, when needed, follows the induced surcharge operation 
described above to utilize the reserved reservoir storage and the full release capacity of 
the reservoir. 

The induced surcharge operation in ResSim is a special operation whose primary 
objective is to “protect the dam without making the downstream flooding worse than if 
the dam were never there”.  To do this, ResSim will utilize the last remaining “safe” 
storage in the reservoir to store the peak of the incoming flood event while passing the 
rest of the inflow through the reservoir. The assumption is that by holding back the peak 
of the inflow, the downstream peak will be reduced. In addition, during the rising limb of 
the inflow hydrograph, the Induced Surcharge rule will not call for releases that are 
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greater than inflow; thus, this operation won’t make the flood worse than it would have 
been if the reservoir weren’t there. 

The induced surcharge, or emergency gate regulation, operation described in the water 
control manual for most USACE reservoirs usually specifies a release that must be made.  
In general, a release that must be made can usually be interpreted as a minimum release 
requirement.  However, under the conditions that call for induced surcharge operation, 
the release requirement is usually interpreted as a specified flow, i.e., no more and no 
less.  Since specified flow rules can be more heavy-handed than necessary, the Induced 
Surcharge rule in ResSim was designed to produce a desired minimum release limit. 
However, it was not designed to stand alone, it needs a partner. 

To model induced surcharge operation in HEC-ResSim, you MUST specify TWO rules: 

1) An Induced Surcharge rule placed at the top of the rule stack in each operating 
zone from which the induced surcharge operation could be triggered.  
Remember, the trigger is a combination of pool elevation and rapidly rising 
inflow or elevation so the rule could potentially be activated even if the pool is 
relatively low but inflow is high and rising fast. 

2) An accompanying maximum limit rule (Release or Downstream Control Function) 
placed below the Induced Surcharge rule in the rule stack of each zone that 
includes the Induced Surcharge rule. This maximum limit rule should correspond 
to the maximum discharge that would occur if surcharge operations were not in 
effect; as such, the maximum limit rule(s) you select to partner with the induced 
surcharge rule may vary per zone. 

It is important to understand why the two rules listed above are necessary to model 
induced surcharge operation.  If you don’t understand why, you will find it difficult to 
build an operation set that can smoothly transition from normal flood control operation 
to induced surcharge and back again.   

First, the Induced Surcharge rule is a minimum limit release rule. And, it should be placed 
as the highest priority rule so that, when it determines that the dam is at risk, it can force 
higher releases than normal flood control operations would allow. 

The maximum limit rule is the rule (or set of rules) that describe normal flood operation. 
The maximum limit rule must be placed at a lower priority so that it can prevent the 
reservoir from releasing more than it should while still allowing the higher priority 
Induced Surcharge rule to override the more restrictive normal flood control operation 
when necessary. 

When the Induced Surcharge rule becomes active, the two rules function together as a 
specified limit rule. To explain this, let’s see how the two rules will affect the allowable 
release range:  

• For simplicity, assume the rule stack has only two rules, an Induced Surcharge rule 
followed by a Maximum Release rule representing channel capacity.   

• When the Induced Surcharge rule becomes active, it will produce a desired release 
that is usually equal to or greater than the limit of the Maximum Release rule.  
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• The desired Induced Surcharge (minimum) release is then applied to the allowable 
range.  If the desired release is greater than the current minimum limit of the 
allowable range, the minimum limit will be assigned the desired release value.   

• Next, the lower-priority Maximum Release rule will be evaluated, and its value will be 
applied to the allowable range.   

• As the allowable range attempts to lower its maximum limit to the new value called 
for by the Maximum Release rule, it will bump into the bottom (minimum limit) of 
the range which has been set by the higher-priority Induced Surcharge rule.  Since 
the lower-priority maximum rule cannot reduce the minimum limit of the allowable 
range, the maximum limit of the range will be assigned the same value as the 
minimum limit, resulting in a single-valued allowable range equal to the value of the 
desired Induced Surcharge release.  Thus, combined, the two rules effectively 
produce a specified limit. 

11.4.1 Defining an Induced Surcharge Rule 

An Induced Surcharge rule is defined by three sets of attributes: 

The Induced Surcharge Computation Method—Two methods by which the Induced 
Surcharge rule can determine the release requirement are available and 
must be selected as part of the rule definition: 

Induced Surcharge Function—This method uses an equation or formula to 
determine the required release.  The data needed to define this 
method includes the Induced Surcharge Envelope Curve and the 
Time of Recession of the project design storm. With this information 
and the current pool elevation, the equation is used to estimate the 
remaining space in the reservoir.  Then, using the assumption that 
the current inflow is the peak of the inflow hydrograph, the method 
uses the current inflow and the remaining space estimate to 
determine the minimum required release to “just fill” the reservoir. 
EM 1110-2-3600 (USACE, 1987) provides a discussion of this function 
and its parameters. 

ESRD Curves—This is a tabular representation of the Emergency Spillway 
Release Diagram, Gate Regulation Curves, or Induced Surcharge 
Curves that are depicted in the water control manual, as shown in 
the example in Figure 11.38.  One of these will be present for each 
reservoir that includes induced surcharge operation in its regulation 
plan.  The table is used to look-up the minimum required release. 
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Figure 11.38 Example ESRD Curves 

 

The Falling Pool Options—The Induced Surcharge computation method is used to 
determine the minimum release required by the rule while the pool is still 
rising. But once the pool starts to fall, that means that inflow is less than the 
release and the induced surcharge operation must transition to new scheme 
for determining the minimum release that should be made to draw the pool 
down.  The Falling Pool Options described this scheme and the parameters 
needed to trigger this operation. 

The Inflow Time Series Options—The current inflow to the pool is a necessary 
parameter for the induced surcharge operation.  However, just what 
constitutes current inflow is debatable.  Most regulation plans recommend 
using an average of the “observed” inflow over a specified number of hours 
as the input to the rule or operation.  The Inflow Time Series Options dialog 
allows you to set identify the “time series function” for specifying the inflow 
to be used by the rule. 

To define or edit an Induced Surcharge rule: 

• Create a new rule as described in Section 11.1.1.  Be sure to: 

o Select the reservoir as the release element (Operates Release from:). Although 
surcharge operations are conceptually tied to the operation of a gated spillway, 
the Induced Surcharge rule type is only available when the selected release 
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element is the reservoir so that it can utilize the total available release capacity of 
the reservoir. 

o Select Induced Surcharge for the Rule Type in the New Operating Rule dialog.  

• Or, if you want to edit a rule you have already created, select the Induced Surcharge 
rule from the Zone-Rules Tree.   

• The edit panel of the Operations tab of the Reservoir Editor will display the Induced 
Surcharge Rule Editor (Figure 11.39).  The name and description of the rule will 
appear in the Induced Surcharge Rule and Description fields. 

• The rest of the rule editor has two potential views, one for each of the Induced 
Surcharge computation methods described above.  Each view as well as the 
attributes that are common to both will be described in the following sections. 

 

Figure 11.39 Induced Surcharge Rule Editor—Use Induced Surcharge Function Option 

11.4.2 Use Induced Surcharge Function  

Two parameters are needed to define the Induced Surcharge Function: 

The Envelope Curve represents the maximum pool elevation the reservoir is allowed 
to reach while operating to manage an extreme inflow event.   

The envelope curve is the top-most curve of the family of induced surcharge 
curves that can be found in the water control manual for any Corps reservoir 
that includes induced surcharge operation in its operating plan.  The figure or 
“plate” that contains these curves goes by several names, the most common 
of which are: Gate Regulate Schedule, Emergency Spillway Regulation 
Diagram, Induced Surcharge Schedule, or some variation thereof.  
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The lowest elevation of the envelope curve is typically the top of the 
reservoir’s Flood Control pool and its highest elevation is typically the top of 
the portion of the reservoir pool reserved for managing extreme inflow 
events.  The highest elevation of the envelope curve is also the elevation at 
which the envelope curve intersects the spillway’s maximum release capacity 
curve (with the gates fully open).  The induced surcharge pool is defined by 
the range of elevations encompassed by the envelope curve. 

When the induced surcharge operation is developed for a reservoir, the 
elevation range of the envelope curve is usually of function of the safe range 
for operating the spillway gates to induce surcharge.  For reservoirs whose 
gated spillway is intended to be used exclusively for managing extreme 
events, the spillway crest elevation (not the elevation of the top of the closed 
gates) is used as the starting elevation of the envelope curve. 

For reservoirs with very large spillway gates, where the gates are expected to 
be used to make releases for a variety of purposes under a wide range of 
conditions and over multiple operating zones, the elevation of the top of the 
closed gates is often used for the starting elevation of the envelope curve, 
although a lower elevation (below the top of the closed gates) may be used. 

The top elevation of the envelope curve is the maximum pool elevation that 
can be reached while passing inflow with the gates still “in the water” but 
open to their maximum safe gate opening.  Physical properties of the gates 
as well as manufacturers testing are used to identify the maximum safe gate 
opening.  Vibration is just one of the factors used to identify an unsafe 
condition for the gates. 

During induced surcharge operation, if the pool elevation reaches the 
envelope curve, the release specified by the envelope curve should equal 
inflow.  If inflow is greater than the release capacity of the spillway at the 
maximum safe gate opening, the spillway gates are opened “fully” such that 
the bottom of the gates are “out of the water”. 

The Time of Recession is the length of time an incoming flood is expected to take to 
recede.  It is used in the induced 
surcharge function to calculate 
the required release.  

The Time of Recession, TS, is 
estimated using the inflow 
hydrograph of the spillway design 
storm.  The process for 
estimating the Time of Recession 
includes the following steps: 

• Several points are selected 
along the recession limb of 
the hydrograph and re-
plotted on semi-log paper 
(Figure 11.40).   

 

Figure 11.40 Estimating Time of Recession 
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• A straight line is drawn through the plotted points.  The time of 
recession, TS, is the slope of the straight line.   

• To calculate TS, a point is selected on the straight line and its flow value, 
QA, is read from the graph.  

• A second flow, QB, is calculated using the equation: 

QB = QA/e = QA/2.718 

• The point on the straight line whose flow equals QB is marked.  

• The time of recession, TS, is the difference in time between the two 
points placed on the straight line whose flows are QA and QB: 

TS =TB – TA 

The Induced Surcharge Function logic assumes that the current inflow (from the end 
of the previous timestep) is the peak inflow of the event.  Using that inflow and the 
time of recession, a recession hydrograph and the volume of water it represents is 
computed. Assuming the previous release is held constant, the volume represented 
by that release is subtracted from the volume in the recession limb to determine the 
volume of water that must be “managed”. These volumes are illustrated in Figure 
11.41. 

 

Figure 11.41 Estimating Time of Recession 

To determine the release needed to manage the recession volume, the induced 
surcharge function logic must determine the remaining space in the reservoir.  But 
the remaining space is a function of the current pool elevation and the elevation of 
the envelope curve for the needed release. Since the release is a function of the 
release, an iteration loop is used to converge on a release.  As described above, the 
first iteration uses the release at the end of the previous timestep to calculate 
elevation of the envelope curve.  Using the computed envelope curve elevation and 
the current pool elevation, the volume of the remaining space in the reservoir is 
calculated. If the volume to be managed (recession volume minus release volume) is 
greater than the remaining volume, a new release is calculated to make up the 
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difference. In each successive iteration, the release estimate from the previous 
iteration is used to determine the new envelope curve elevation, the volume to be 
managed, the available space, and a new release estimate. The loop stops when the 
new release estimate is equal to the previous estimate (convergence), is greater than 
or equal to inflow, or the maximum number of iterations has been reached.  If the 
envelope curve is not adequately detailed, is “bumpy”, or is almost flat, the iteration 
loop may have trouble converging; messages will be sent to the console log 
indicating a problem and reporting that it is either holding the previous release to 
setting the release to inflow. Although an advanced option is available to adjust the 
maximum number of iterations, revising the envelope curve is usually a better 
approach when your model has trouble converging. 

To define an Induced Surcharge rule using the Induced Surcharge Function: 

• Select the radio button for Use Induced Surcharge Function in the Induced 
Surcharge rule editor. 

• Select the Interpolation Type.  Your options are: Linear or Cubic (Step is not 
included since the envelope should represent a smooth curve). 

• Enter Elevation and Release data into the Induced Surcharge Envelope Curve 
table to describe the envelope curve.  The elevation values entered in the table 
must be monotonically increasing.  Use the finest detail you can produce, 
especially in the upper elevation range as the envelope curve flattens out. 

• Enter the Time of Recession in hours.  This constant describes the length of time 
an incoming flood is expected to take to recede.  ResSim uses this time to 
compute the volume of water that must be evacuated to prevent overtopping 
the dam.  See discussion in for further documentation regarding the Recession 
Time constant parameter (TS). 

After entering the above information, the Induced Surcharge rule editor should 
appear similar to the example shown in Figure 11.42. 

 

Figure 11.42 Induced Surcharge Rule Editor 
Completed Example of Induced Surcharge Function 
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Plotting the Induced Surcharge Curves 

In the Induced Surcharge rule editor for a rule that uses the Induced Surcharge 
Function, the thumbnail plot to the right of the Induced Surcharge Envelope Curve 
table shows a graph of the data entered in the table.  Although the thumbnail plot 
can help you identify data entry errors, a full-size plot can provide more visualization 
options, like zoom. 

To view a full-size plot of the envelope curve, double-click on its thumbnail plot. The 
full-size plot (Figure 11.43) will display the envelope curve specified in the rule as well 
as the reservoir’s composite discharge capacity curve.   

 

Figure 11.43 Full-Size Plot produced from the Induced Surcharge Rule’s Thumbnail Plot 

But, this full-size plot, opened from the thumbnail plot of the Induced Surcharge 
Function’s envelope curve, is unlike the plot opened from any other thumbnail plot in 
ResSim. This plot has an Options menu… 

The Options menu (Figure 11.44) provides access to 
features that will allow you to specify a set of Inflow 
or Rate of Rise values from which a family of 
induced surcharge curves will be computed and 
displayed in the plot. The Options menu contains 
the following options: 

 

Figure 11.44 Induced Surcharge  
Curve Plot—Options Menu 



HEC-ResSim User’s Manual Chapter 11 - Reservoir Operations — The Rules 

  11-47 

Edit Inflows for Curves…—This option opens the Specify Inflows for Induced 
Surcharge Curves dialog (Figure 11.45) in which you can specify a list of 
inflow values that will be used to generate a family of induced surcharge 
release curves.  To add more 
rows to the Inflows table, 
right-click on a cell in the 
table and select Insert Rows 
or Append Row from the 
context menu. Click OK to 
save your entries or changes. 
The inflow values you 
entered will be saved with 
the rule so that you do not 
need to enter them again. 

Plot Rate of Rise—this option is a 
toggle switch that indicates 
whether the family of 
induced surcharge curves will be computed and plotted for a set of inflow or 
rate of rise values.  By default, the switch is OFF (unchecked) and the plot will 
display the family of curves by inflow value (if inflows have been entered). By 
selecting this option, you can switch the plot to show the family of curves by 
rate of rise value. 

*** When this switch is ON (checked), the first option in the Options menu 
changes to Edit Rate of Rise for Curves…  If you haven’t already done so, you 
will need to enter a set of rate-of-rise values in order to generate the 
associated family of curves. 

Show Discharge Capacity—also a toggle switch.  Its state (ON or OFF) indicates 
whether or not the plot should include the reservoir’s total Discharge 
Capacity curve.  Figure 11.46 and Figure 11.47 show the Induced Surcharge 
Curves Plot with and without the Discharge Capacity Curve. 

 

Figure 11.45 Edit Inflow for Curves… 
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Figure 11.47 Family of Computed Induced Surcharge Curves—without the Discharge Capacity Curve 

Once you have entered a set of inflows or rate of rise values, the resulting plot of the 
computed induced surcharge curves should resemble the diagram in the water 
control manual from which you estimated the envelope curve.  If the plotted curves 
do not match the original diagram, try these adjustments: 

 

Figure 11.46 Family of Computed Induced Surcharge Curves—with the Discharge Capacity Curve 
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• Add more detail to the envelope curve.  Both the beginning and end of the 
envelope curve should be well defined.  In general, a well-defined envelope curve 
will have 10-20 values to describe the nose of the envelope, 5-10 values to 
describe the middle, and another 10-20 values to describe the tail (even if all 
those values describe a straight line). 

 

When developing the table of values that describe the envelope curve, 

start with a regular interval of release values and find their associated 

elevation values in the diagram in the water control manual.  This should 

give you a good definition of the middle and tail of the envelope.  Then, 

using a progressively smaller interval of release, add more detail to the 

beginning so that the nose of the envelope looks smooth when plotted, 

even when zoomed in. 

• Once you have an envelope curve that produces in a set of smooth induced 
surcharge curves, revise the time of recession.   

• Continue to fine-tune the time of recession until the plotted curves are a good 
match to those in the manual. Think of this as a binary search. Start with a fairly 
large change from your original entry to determine if the new curves are going in 
the right direction.  Then use successively smaller changes as your plotted curves 
get closer to those in the manual. 

IF, however, you have tried various adjustments to both the envelope curve and the 
time of recession and have been unable to produce a set of plotted curves that 
closely resemble the original diagram, then either the induced surcharge curves 
shown in the manual were not created using the induced surcharge function or they 
were altered to meet criteria that cannot be reflected by the function.  In this case, 
you may find it necessary to Specify the ESRD Curves rather than Use the Induced 
Surcharge Function. 

11.4.3 Specify the ESRD Curves  

The option to Specify the ESRD Curves was added to the Induced Surcharge rule to 
enable you to provide a lookup table that describes the family of induced surcharge 
curves from which the required release can be found or interpolated. This option 
should be used when the induced surcharge curves were not created using the 
concepts of the induced surcharge function or were altered to meet conditions or 
criteria that are not considered or accounted for in the function. 

To define an Induced Surcharge rule by entering a table elevations and releases that 
describe the curves of an Emergency Spillway Regulation Diagram: 

• Select the radio button for Specify the ESRD Curves in the Induced Surcharge rule 
editor. Figure 11.48 illustrates the initial view of the Induced Surcharge rule with 
the Specify the ESRD Curves option selected.   
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Figure 11.48 Induced Surcharge Rule Editor—Specify the ESRD Curves Option 

Although you may not notice immediately, the Specify the ESRD Curves view of 
the Induced Surcharge rule editor differs from the Use Induced Surcharge 
Function view in the following ways: 

o The header changed for the second column of the table. This one has two 
rows.  The second row will display the value of inflow or rate or rise for each 
induced surcharge curve in the table. 

o A pair of radio buttons were added below the table.  The selected button 
identifies the type of curves in the table — inflow curves or rate of rise 
curves. 

o The thumbnail plot is bigger. Since this thumbnail plot will show the full 
family of curves as entered in the table, a bigger plot was used so you could 
see all the curves at a glance. 

o An Edit… button was added below the thumbnail plot and the Advance 
Options button was removed. The new Edit button will open a dialog for 
specifying the Inflow or Rate of Rise values for each induced surcharge curve 
in the table. The Advanced Options only apply to the Induced Surcharge 
Function form of the rule. 

• Identify the type of induced surcharge curves that will be entered in the ESRD 
table by selecting one of the two Specify Releases with Respect to: radio buttons 
located below the table.  Your choices are: 

o Reservoir Inflow—use this option if the curves plotted (or tabulated) in your 
water manual are labeled with increasing values of inflow.  This parameter is 
used when plotting the induced surcharge curves if the expected user of the 
diagram is a water manager or regulator.  The water manager is back in the 
office with access to a variety of computing resources and data that he can 
use to estimate reservoir inflow. 
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o Rate of Rise—use this option if the curves plotted (or tabulated) in your 
water manual are labeled with increasing rates of rising pool elevation.  This 
parameter is often used when plotting the induced surcharge curves if the 
expected user of the diagram is a dam operator.  The assumption is that the 
dam operator would not have time during a major inflow event to perform 
the calculations necessary to estimate inflow but can quickly determine the 
rate at which the pool is rising glancing at the pool’s stage gage on a regular 
interval. 

• Depending on your selection, the Edit… button 
below the thumbnail plot will either be labeled 
Edit Inflows for ESRD Curves… or Edit Rate of 
Rise for ESRD Curves…   

Click this Edit… button to open a dialog (Figure 
11.49) where you will enter a list of values (of 
Reservoir Inflow or Rate of Rise) that identify the 
curves in the ESRD table.  Click OK to save your 
list and close the dialog.  The ESRD table will 
update to include a column for each value in the 
list. 

Note: if you change one or more values in the list 
of inflows or rates of rise after you have filled in 
the ESRD Curves table, the data in the columns of the table associated with the 
original values will disappear.  However, if you insert new values (rows) into the 
list without changing the originally entered values, the ESRD Curves table will 
expand to include a new column for each new value added to the list without 
losing the data in the columns associated with the original values. 

• Enter Elevation and Release data into the ESRD Curves (Elevation versus Min 
Release per Inflow or Rate of Rise) table.  The first two columns in the table 
represents the envelope curve.  When paired with the elevation column, the 
remaining columns represent the minimum release curve for each inflow or rate 
of rise values that you specified in the previous step.  NOTE — the elevation data 
must be monotonically increasing and at the finest detail you can manage. Since 
ResSim will use linear interpolation to determine a minimum release for a given 
elevation and inflow (or rate of rise), a significant elevation range and detail will 
be needed in order for each curve to be adequately defined.  

An example of a complete (but not perfect) table of data defining a set of ESRD 
curves is illustrated in Figure 11.50 below. In this example, the cells in the upper 
left corner of the completed table are empty because the curves for the lower 
inflow are not defined for the lower elevations. In other words, when the 
reservoir is not too full and inflows are still low, increased releases are not 
required. 

 

 

Figure 11.49 Induced Surcharge 
Rule—Inflows for ESRD Curves 
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Figure 11.50 Example of a Complete ESRD Table 

 

Once you start entering data in a row or column, the rest of the row or column 
should be filled in.  Do not leave blank cells between cells with data, in either 
rows or columns of the table.  

Although ResSim will allow it, the cells in the lower left corner of the table (the 
last few cells of each column) should not be left blank. Figure 11.51 shows an 
example of an incomplete table, where the cells in the lower left corner have 
been left blank. 

The cells in the lower left corner of the ESRD table should define where each 
curve intersects and merges with the envelope curve.  Some users leave these 
cells blank because defining the intersection point for each curve can be 
troublesome and the remaining cells are viewed as redundant. For each curve’s 
intersection point an additional elevation row may need to be added to the 
table; as a result, a release for those added elevations must be entered for each 
curve in the table; so, you can see why this effort might be considered 
troublesome.  Since the remaining cells of the table below the intersection 
elevation of each curve represent the region where the curve merges (or is 
coincident) with the envelope curve, these cells can be filled with a copy of the 
data from the envelope curve.   
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Figure 11.51 Example of an Incomplete ESRD Table 

 

To illustrate why you should not leave the cells in the lower left corner of the 
ESRD table blank, full size plots of the ESRD curves from each example ESRD table 
were generated and are shown in Figure 11.52 and Figure 11.53.  These plots are 
zoomed-in to the region where the curves should intersect or merge with the 
envelope curve.  In Figure 11.52, you can see that the curves for the complete 
table properly intersect and merge with the envelope curve.  In Figure 11.53, the 
curves for the incomplete table do NOT intersect the envelope curve.  Since 
ResSim will not extrapolate the curves beyond the data provided, if the elevation 
and inflow used to lookup a release from the incomplete table happen to fall into 
one of the undefined regions, between the end of the curve data and the 
envelope, the resulting release may not be what you intended or expected.   
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Figure 11.52 The Curves from the Complete ESRD Table Example 

 

 

Figure 11.53 The Curves from the Incomplete ESRD Table Example 
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After entering the above information, the Induced Surcharge rule editor should 
appear similar to the example shown in Figure 11.54. 

 

Figure 11.54 Induced Surcharge Rule Editor 
Completed Example of Specifying the ESRD Curves 

The thumbnail plot reflects the data entered in the ESRD Curves table.  To see a full-
size plot of the family of curves, double-click on the thumbnail plot (Figure 11.55).   

 

Figure 11.55 Plot of Induced Surcharge Curves for Specified ESRD Inflow Values 

11.4.4 Falling Pool Options 

To specify how the induced surcharge minimum release should be determined when 
the reservoir starts falling, you must set up the Falling Pool Options.  To do so: 
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•  Click the Falling Pool Options Edit button.  The Falling Pool Options dialog will 
open (Figure 11.56).  

• Specify each of the following attributes: 

Time for Pool Decrease— 
enter a value in 
hours.  This 
parameter describes 
the required 
number of 
successive hours the 
reservoir pool level 
must be falling 
before the minimum 
release 
determination 
transitions from 
rising pool 
emergency spillway 
releases to falling 
pool releases.  
During this period, the rule often appears to hold the peak rising pool 
release since one of the rules on the rising pool release determination is 
logic is to not reduce the release as long as the pool is rising. 

Falling Pool Transition Elevation—enter a value in feet (meters).  This parameter 
represents the pool elevation above which Falling Pool releases will be 
made.  Once the pool elevation falls below this elevation, the Induced 
Surcharge rule will no longer operate, and ResSim will resume releases 
based on other rules in the active zone. 

Release Options—this is the method for determining the minimum release while 
the pool is falling until the transition elevation is reached.  Some of these 
options may seem counterintuitive.  Just remember, the objective during 
falling pool is to maintain the falling pool trend (to draw down the 
reservoir) so the release at this point must be greater than inflow. 
Choose from:  

Ratio of Inflow—this method requires two parameters: 

o The ratio value — a multiplier of inflow.  For example, to release 
120% of inflow, enter a value of 1.2 

o An averaging period — like the rising limb, you need to specify 
the period, in hours, over which to determine inflow for the use 
of this method. 

Average of Inflow and Previous Release—like previous method, this 
method requires that you specify an averaging period for inflow, 
in hours. 

 

Figure 11.56 Induced Surcharge—Falling Pool Options 
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Maintain Peak Release—select this method is you want the release to 
hold at the value it was releasing when the pool started to fall. 

Maintain Peak Gate Openings—select this method if you want ResSim to 
determine the gate setting (or percent open) of the outlets at 
the time the pool started to fall.  For each subsequent timestep 
until the transition elevation is reached, that gate opening (or 
percent open) will be used to determine the minimum release. 

• Click OK to close the Falling Pool Options dialog. 

11.4.5 Inflow Time Series Options 

To specify the how the current value of inflow is determined from the inflow time 
series, follow the instructions below.  Note: if you skip this step, the default of 
Previous Value will be used. 

• Click the Inflow Time Series Options button.  This editor defines how the 
reservoir inflow time series is interpreted when used in making induced 
surcharge operation release decisions.  The editor and its options will vary 
depending on your Induced Surcharge computation method:  

• If you are using the Induced Surcharge 
Function, Figure 11.57 shows the editor 
that will open.   

o The Function list and the associated 
parameters of Offset and Period are 
described in the Independent 
Variable Editor’s Time Series 
Options section in Appendix C. 

• If you are using the ESRD Curves, Figure 
11.58 shows the more complex editor that will open. The more complex editor 
allows you to specify any external times series or model variable as the Inflow to 
be used by the rule—rather than the default, computed inflow. 

Variable for ESRD Lookup— 

Inflow—To use the default, computed inflow and the standard Inflow Time 
Series Options, select the first radio button, Inflow.  The associated 
Time Series Options will be specified above the radio buttons. 

User Selected—To specify an external variable or model variable as the 
“inflow” for the ESRD lookup, select the second radio button, User 
Selected.  The lower portion of the editor will be enabled; use it to 
select the variable you want to use as “inflow” and its associated 
Time Series Options.  

 

 

Figure 11.57 Induced Surcharge—Inflow 
Time Series Options 
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Figure 11.58 Inflow Time Series Options—External Variable 

When you have finished specifying all the required attributes for your Induced Surcharge 
rule, press Apply to save your settings.  Then, be sure the rule is added to and correctly 
positioned at the top of the rule stack in each zone where the rule should apply. 
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11.5 Flow Rate of Change Limit Rule 

A Flow Rate of Change Limit rule specifies the allowable change when increasing or 
decreasing release values (a.k.a., “ramping rates”).  A single rule of this type will only limit 
a rising release or a falling release, but not both.  To describe both increasing and 
decreasing limits, you must define two rules and set the type of one to increasing and the 
other to decreasing.  A rule of this type can be assigned to any release element to 
influence the behavior of that element. 

To define or edit a Flow Rate of Change Limit rule: 

• Create a new rule as described in Section 11.1.1.  Be sure to: 

o Select Flow Rate of Change Limit for the Rule Type in the New Operating Rule 
dialog.  

• Or, if you want to edit a Flow Rate of Change rule you have already created, select it 
from the Zone-Rules Tree.   

• The edit panel of the Operations tab of the Reservoir Editor will display the Flow Rate 
of Change Limit rule editor (Figure 11.59).  The name and description of the rule will 
appear in the Release Rate of Change Limit and Description fields. 

 

Figure 11.59 Flow Rate of Change Limit Rule Editor—Function of Constant 

Function Of—A Flow Rate of Change rule can be Constant, or it can vary with: 

o Reservoir Inflow 
o previous Release 
o Pool Elevation 

 

Note:  Rate of Change rules have more impact than you might think… 

Unless otherwise noted, ResSim’s decision logic tries to meet its objectives as 
fast as possible, usually within the current timestep.  But rate-of-change 
constraints are in direct opposition to that tendency; their objective is to slow 
things down.  To more fully address this slow-down objective, logic was added 
to the downstream control evaluation and guide curve release determination 
to account for rate of change constraints.  So, in addition to acting as normal 
release limit rules, Rate of Change rules also impact downstream control and 
guide curve releases by extending the time window over which the two 
methods try to meet their objectives. 
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Type—this is the Limit type.  Select either Increasing or Decreasing.  Note: when 
evaluated, an Increasing Flow Rate of Change Limit results in a maximum 
release limit and a decreasing Flow Rate of Change Limit results in minimum 
release limit 

Max Rate of Change—depending on your Function of selection… 

Constant—you will either be presented with a single field — for a constant 
value in units of flow per hour.  Figure 11.59 shows this view of the 
Flow Rate of Change rule editor. 

Inflow, Release, or Elevation—you will either be presented with a table.  
Enter the relationship between the selected independent variable 
and the maximum rate of change limit.  The limit is described in units 
of flow (cms or cfs) per hour, regardless of the compute interval.  For 
example, if you enter 500 cfs/hr with a compute interval of 12 hours, 
then this rule describes the maximum flow change per timestep as 
6,000 cfs.  Figure 11.60 shows this view of the Flow Rate of Change 
rule editor. 

 Interpolate—enter the interpolation type for looking up values in the 
table.  You can choose from the standard options of Linear, Cubic, or 
Step.  See Section 11.2.2.2 for an explanation of the interpolation 
options. 

 

Figure 11.60 Flow Rate of Change Limit Rule Editor—Function of Time-Series 

 

• When you have finished entering data for the Flow Rate of Change rule, be sure to 
click Apply before moving on to the next rule. 
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11.6 Elevation Rate of Change Limit Rule 

An Elevation Rate of Change Limit rule describes the allowable change when increasing or 
decreasing pool elevation values.  A single rule of this type will only limit a rising pool or a 
falling pool, but not both.  To describe both increasing and decreasing limits, you must 
define two rules and set the type of one to increasing and the other to decreasing.  Since 
this rule watches the pool elevation, this rule type is only available for the reservoir (pool) 
release element 

To define or edit an Elevation Rate of Change Limit rule: 

• Create a new rule as described in Section 11.1.1.  Be sure to: 

o Select Elevation Rate of Change Limit for the Rule Type in the New Operating 
Rule dialog.  

• Or, if you want to edit an Elevation Rate of Change rule you have already created, 
select it from the Zone-Rules Tree.   

• The edit panel of the Operations tab of the Reservoir Editor will display the Elevation 
Rate of Change Limit rule editor (Figure 11.61).  The name and description of the rule 
will appear in the Elevation Rate of Change Limit and Description fields. 

 

Figure 11.61 Elevation Rate of Change Limit Rule Editor—Function of Constant 

Function Of—An Elevation Rate of Change rule can be Constant, or it can vary with: 

o Reservoir Inflow 
o Reservoir Release 

Type—this is the Limit type.  Select either Increasing or Decreasing.  Note: when 
evaluated, an Increasing Flow Rate of Change Limit results in a maximum 
release limit and a decreasing Flow Rate of Change Limit results in minimum 
release limit 

Instantaneous or Period Average Radio Buttons—These radio buttons allow you to 
choose whether or not the rate of change rule applies to the current 
timestep (Instantaneous) or to a range of timesteps (Period Average).  When 
Period Average is selected, you must enter the time period, in hours, over 
which the change in elevation applies. 

Max Rate of Change—depending on your Function of selection… 



Chapter 11 - Reservoir Operations — The Rules HEC-ResSim User’s Manual 

11-62  

Constant—you will either be presented with a single field — for a constant 
value in units of elevation (ft or m) per hour. Figure 11.61 shows this 
view of the Flow Rate of Change rule editor.  This view will change to 
include a field for the period if the Period Average option is selected. 

Inflow or Release—you will either be presented with a table.  Enter the 
relationship between the selected independent variable and the 
maximum rate of change limit.  The limit is described in units of 
elevation (ft or m) per hour, regardless of the compute interval.  
Figure 11.62 shows this view of the Flow Rate of Change rule editor.  
This view changes to include a field for the period if Period Average 
is selected. 

 Interpolate—enter the interpolation type for looking up values in the 
table.  You can choose from the standard options of Linear, Cubic, or 
Step.  See section 11.2.2.2 for an explanation of these options. 

 

Figure 11.62 Elevation Rate of Change Limit Rule Editor—Function of Time-Series 

 

• When you have finished entering data for the Elevation Rate of Change Limit rule, be 
sure to click Apply before moving on to the next rule. 
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11.7 The Hydropower Rules 

Hydropower rules specify a power generation requirement from the power plant at 
reservoir or a system of reservoirs. When evaluated, the hydropower rules determine the 
minimum flow that must be released through the power plant to produce the required 
energy given the plants generating capacity, the hydraulic head, and the generation 
pattern. The various hydropower rules (Figure 11.63) each provide a different way of 
specifying the generation requirement: 

The Power Guide Curve rule allows you to specify the required generation as a 
function of storage. 

The Schedule rule allows you to specify the requirement as a function of date. 

The Time Series Requirement lets you specify the requirement directly through an 
external time series. 

And the System Schedule rule allows you to define the generation requirement in the 
same manner as the Schedule rule but the System Schedule rule is applied to 
multiple reservoirs so that together they can operate to meet the generation 
requirement specified in the rule. 

The data requirements for each of these rules will be described in the following sections. 

 

Figure 11.63 Hydropower Rule Types 

To define or edit a Hydropower rule: 

• Create a new rule as described in Section 11.1.1.  Be sure to: 

o Select the Power Plant as the release element in the Operates Release From: 
selector. 

o Select the appropriate Hydropower rule type from the Rule Type selector. 

• Or, if you want to edit a Hydropower rule you have already created, select it from the 
Zone-Rules Tree.   

• The edit panel of the Operations tab of the Reservoir Editor will display the 
Hydropower rule editor for the specific Hydropower rule type.  The name and 
description of the rule will appear in the Hydropower-Type Rule and Description 
fields. 
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11.7.1 Hydropower—Power Guide Curve Rule 

The Hydropower—Power Guide Curve rule allows you to define a function that 
describes the hydropower generation requirement with respect to the available 
storage in the power pool.  The power pool is defined by identifying two top-of-zone 
curves—one that marks the top power pool and one that marks the bottom.   

The power requirement must be described in units of percent of plant factor.  Plant 
factor is a fraction of the capacity of the plant to generate; so, percent plant factor is 
a percentage of the capacity of the plant to generate.  Plant factor can also be 
interpreted to mean the fraction (or percentage) of the day the plant generates at 
full capacity.  Thus, a plant factor of .25 (or 25%) may mean that the plant generates 
at 25% of capacity all day long, or the plant generates at full capacity for 25% of the 
day (or 6 hrs a day).  No matter how you phrase it, this specification is a quantity of 
energy in MWHs.  How the plant actually generates is a function of the power 
generation pattern. 

The Power Guide Curve Rule editor is shown in Figure 11.64 and its attributes are 
described below. 

 

Figure 11.64 Hydropower—Power Guide Curve Rule Editor 

Zone at Top of Power Pool—select the zone whose top of zone curve will define the 
top of the power pool. 

Zone at Bottom of Power Pool—select the zone whose top of zone curve will define 
the bottom of the power pool.   

Power Guide Curve table—The table in the Power Guide Curve rule editor represents 
the relationship between storage and the hydropower generation 
requirement. The first column, the independent variable, is the percent of 
storage available in the power pool.  These values should increase as you 
move down in the table (monotonically increasing).  The second column is 
the plant factor (in units of percent); this is the power requirement as a 
percentage of the plant’s capacity to generate (or the percent of the day the 
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plant should generate at full capacity).  The thumbnail plot will display the 
data in the table. 

Power Generation Pattern—use this button to open the Power Generation Pattern 
editor which is described in detail in Section 11.7.5. 

11.7.2 Hydropower—Schedule 

The Hydropower—Schedule rule allows you to define a regular monthly or user 
specified seasonally varying hydropower requirement.  The various options on this 
rule editor (Figure 11.65) allow you to define each month’s or season’s power 
generation requirement, the type of the requirement (megawatt-hours or plant 
factor), and the hours of the day and days of the week during which the plant can 
generate. 

 

Figure 11.65 Hydropower—Schedule Rule Editor 

Power Generation Requirement—click the Options button to open the Power 
Generation Requirement editor (Figure 11.66). 

 

Figure 11.66 Power Generation Requirement Options 
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Requirement Varies—the option for interval in which you want to specify the 
requirement.  Your options are:  Monthly and Seasonally.  The 
remaining attributes on this editor define what the requirement 
values mean (Requirement Specification) and how they are to be 
met (Period over which Generation Requirement is satisfied).  

Requirement Specification 

Requirement Specified as:—the list of options for describing the values in 
the Power Generation Requirement table.  The options include: 

Plant Factor—Monthly or Seasonal Total—this means that the 
requirement values in the table are in units of plant 
factor and represent a total energy requirement for the 
Month or Season assuming that the plant ran all the 
time at the specified fraction of capacity (or ran at full 
capacity for the specified fraction of the total time). No 
matter how you phrase it, this specification can be 
translated into a quantity of energy in MWHs.  How the 
plant actually generates is a function of the power 
generation pattern. 

Daily Total MWH—this option indicates that the values in the 
requirement table identify how much energy must be 
generated each day of the month or season. 

Weekly Total MWH—this option indicates that the values in the 
requirement table identify how much energy must be 
generated each week of the month or season.  If you 
select this option, you must also specify the attributes: 
Starting Day and Week belongs to a month (or season) 
when this day is in the month. 

Monthly (or Seasonal) Total MWH—this option indicates that the 
values in the requirement table identify how much total 
energy must be generated over the current month (or 
season). 

Starting Day—this is the first day of the week, when Weekly Total is 
selected for Requirement Specified as. 

Week belongs to a month (season) when this day is in the month 
(season)—This field identifies a day of the week that must be in 
the season so that the whole week can belong to the current 
month (season) or to the next month (season)—when Weekly 
Total is selected for Requirement Specified as.   
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For example, if the Requirement 
is specified as a Weekly Total that 
varies Monthly, and the week 
Starts on Sunday and the Week 
belongs to…day is Wednesday, 
then if the current month is the 
one shown in Figure 11.67, then 
the week that starts on Sunday 
the 28th belongs to the next 
month because the following 
Wednesday is in the next month.  

Period over which Generation Requirement will be satisfied  

Period—all of the options for Requirement Specified as are period total 
values.  That means that if your timestep is less than the period 
total, which it probably is, then the requirement is divided up 
across the timesteps of the total period based on the power 
generation pattern, and each timestep is assigned is shared of 
the total requirement. As each timestep is computed, if that 
timestep cannot meet its allotted portion of the total 
requirement, your selection for the Period over which 
Generation Requirement will be satisfied will determine how or 
if the unmet requirement will be satisfied.  The Period options 
include: 

Each Timestep—with this option, the energy requirement is 
distributed to all timesteps of the total period based on 
the power generation pattern.  If a given timestep 
doesn’t meet its allotted requirement, the unmet 
portion will remain unmet. 

Daily—with this option, if your timestep is less than 1DAY, then 
the total energy requirement is distributed to the days 
across the total period, then across the day to the 
timesteps of the day—all based on the power generation 
pattern.  If a given timestep cannot meet its allotted 
requirement, the unmet portion of the day’s 
requirement is redistributed to the remaining timesteps 
of the day, per the generation pattern.  If the remaining 
timesteps cannot meeting that day’s allotted 
requirement, the requirement will remain unmet. 

Weekly—with this option, the total energy requirement is 
distributed to the weeks across the total period, then 
the week’s allotment is distributed to the timesteps of 
the week—all based on the power generation pattern.  If 
a given timestep cannot meet its allotted requirement, 
the unmet portion of the week’s requirement is 
redistributed to the remaining timesteps of the week, 
per the generation pattern.  If the remaining timesteps 

 

Figure 11.67 An Example Month 
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cannot meeting that week’s allotted requirement, the 
requirement will remain unmet.  If you select Weekly, 
you must also specify the Starting Day of Period 

Starting Day of Period—this is the starting day of the week over which 
the requirement is to be satisfied.  This option is only required if 
the Period over which Generation Requirement will be satisfied 
is Weekly. 

Power Generation Requirement table—Complete the power requirement table 
as appropriate, depending on the options selected Power Generation 
Requirement editor. For example, if Monthly Total MWH was selected, 
then enter the total monthly requirement for each month of the year in 
the table. 

Power Generation Pattern—this button will open the Power Generation Pattern 
editor. The Power Generation Pattern Is used by the rule to distribute 
the power requirement to the weeks, days, and timesteps in the period. 
Please see Section 11.7.5 for a full description of the purpose of the 
Power Generation Pattern and options for defining it using the Power 
Generation Pattern editor. 

11.7.3 Hydropower—System Schedule 

The Hydropower—System Schedule rule allows you to specify a hydropower 
generation requirement that a set of reservoirs (a reservoir system) will operate to 
try to meet.  This rule describes the hydropower generation requirement in the same 
manner as the Hydropower—Schedule rule (as described above).  The System 
Schedule rule, however, has some additional options for specifying the power 
generation pattern and for identifying reservoirs whose power generation and/or 
storage can be used to meet the system requirement.  

To cause a reservoir to operate to meet a system power requirement, it must have 
the System Schedule rule in the currently active zone of its operation set.  The easiest 
way to do this is to create the rule in one of the reservoirs, then add the rule to the 
operation set(s) of the other reservoirs in the system by selecting it from the “Use 
Existing” list. 

The Hydropower—System Schedule rule editor is shown in Figure 11.68 and its 
options and attributes are described below: 

System Generation Requirement—to specify what values of the system 
generation requirement table mean, what their units are, and how the 
requirement is to be met, click the Options button to open the Power 
Generation Requirement editor which is the same editor used by the 
Hydropower—Schedule rule, so please refer to Section 11.7.2 above for 
its description.  

Power Generation Requirement table—Complete the power requirement table 
as appropriate, depending on the options selected in the Power 
Generation Requirement editor. For example, if Monthly Total MWH was 
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selected, then enter the total monthly requirement for each month of 
the year in the table. 

 

Figure 11.68 Hydropower—System Schedule Rule Editor 

Power Generation Pattern—as with the Hydropower—Schedule rule, the power 
generation pattern specifies how the power requirement is distributed 
across the weeks, days, and timesteps of the requirement period.  
However, with the System Schedule, you can specify for each reservoir 
(that operates to meet the system requirement) whether the Power 
Generation Pattern that that reservoir should use is specific to that 
reservoir (Local) or is the pattern defined to be shared by one or more 
reservoirs in the system (System).  In either case, the Power Generation 
Pattern editor is the same and is described in detail in Section 11.7.5. 

Specify Local Generation Pattern—this option allows you to specify a 
different generation pattern for each reservoir that operates to 
meet the system power requirement.  If you choose this option, 
you will need to edit the power pattern in the system 
hydropower rule from each reservoir that includes the rule in its 
operation set.  

Specify System Generation Pattern—
this option allows you to 
specify a single generation 
pattern that will be used by all 
the reservoirs that operate to 
meet the system power 
requirement.   

 

Figure 11.69 
Power Generation Pattern   
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Edit Pattern—use this button to open the Power Generation Pattern 
editor, where you will specify a (local or system) pattern for 
meeting the system hydropower requirements.  Please see 
Section 11.7.5 for a full description of the purpose and use of the 
Power Generation Pattern editor. 

Specify Energy Requirement with External Time Series—with this option checked, 
you are telling ResSim to use an External Time Series to be identified in 
the alternative as the specification of the Generation Requirement for 
this rule; this disables the System Generation Requirement Options and 
table.  This option makes the Hydropower—System Schedule rule very 
similar to the Hydropower—Time Series Requirement rule rather than 
the Hydropower—Schedule rule. 

Operating Reservoirs…—use this button to open the Hydropower-System Rule: 
Operating Reservoirs list.  This list shows the reservoirs that have this 
rule in their operation set(s) and are, therefore, operating to meeting the 
power generation requirement called for by this rule.  

Contributing Reservoirs…—use this button to open the Hydropower-System Rule:  
Reservoir List dialog (Figure 11.70).  The purpose of this dialog is to allow 
you to identify those power-producing reservoirs in your network that do 
not actively operate for this system hydropower requirement but whose 
generation can be counted toward meeting it.  You need not add 
reservoirs which will actively operate for this requirement, they will 
automatically be added to the “Selected” list when you add this rule to 
their operation set(s). 

 

Figure 11.70 Hydropower System Rule—Reservoir List Editor 
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11.7.4 Hydropower—Time Series Requirement 

The Hydropower—Time Series Requirement rule allows you to define an irregular 
schedule of Hydropower requirements through the use of a DSS time-series record.  
Except for the Description, there are options or attributes to be selected or edited in 
this rule editor, not even a Power Generation pattern since the time series directly 
indicates the generation requirement for each timestep.  Instead, a message is 
included in the editor (Figure 11.71) to remind you that you will need to specify a 
time series of required power in units of megawatts when you setup an alternative 
that uses this operation set for this reservoir. 

 

Figure 11.71 Hydropower—Time Series Requirement Rule Editor 

11.7.5 Power Generation Pattern 

The Power Generation Pattern allows you to specify a weekly, daily, and hourly 
distribution of the specified energy requirements.  The pattern covers a week and 
each day is described with a set of 24-hourly weighting factors.  By default, the 
weekly pattern repeats throughout the year unless you specify a set of seasons and a 
different pattern for each season. 

Weekly Distribution 

Three options are available for specifying the weekly power pattern:  All Week, 
Weekdays and Weekend, and Each Day. These options are available from the Specify 
Pattern for list.  

All Week—this option applies the same hourly power generation pattern for 
every day of the week.  See Figure 11.72 for an illustration of the editor 
for this pattern. 

Weekdays and Weekend—this option allows you to specify a different power 
generation pattern for Weekdays (Monday through Friday) than for 
Weekend days (Saturday and Sunday).  See Figure 11.72 for an 
illustration of the editor for this pattern. 
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Each Day—this option allows you to specify different power generation patterns 
for every day of the week. See Figure 11.73for an illustration of the 
editor for this pattern. 

 

All Week

 

Weekdays & Weekends

 

Figure 11.72 Power Generation Patterns—All Week or Weekdays and Weekends 

 

Figure 11.73 Power Generation Pattern (Each Day) 
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Hourly Distribution 

Each day of the Power Generation Pattern table is divided into 24 hourly values.  
Each value represents a weighting factor that you can use to distribute the energy 
requirement throughout the day and throughout 
the week.  The default value for each hour of the 
day is 1.0 (Figure 11.72) which will attempt to 
evenly distribute the energy requirement across 
the day.   

However, if you want the power plant to generate 
only during a portion of the day, you can set the 
factor for those hours to 1.0 and set all other 
hours to 0.0. Basically, the values of 1.0 and 0.0 
turn the hourly generation “on” and “off”, 
respectively.   

For example, to specify that generation 
should only occur from 8:00 a.m. to 5:00 p.m. 
7 days a week, use the All Week pattern and 
change the value of 1.0 to 0.0 for hours 0000-
0800 and 1700-2400 (Figure 11.74). 

The weighting factor aspect of the values in the 
table comes into play when the values used in the 
pattern are not just 0’s and 1’s; in other words, 
when the generation should be distributed 
unevenly over the “on” hours.   

For example, to indicate that the generation 
between 10:00 a.m. and 1:00 p.m. should be 
twice the generation of the other generating 
hours, you could change the value of 1.0 to 
2.0 for hours 1000-1300 (Figure 11.75).  The 
sum of the weighting factors for each day in 
this example is 6(1.0) + 3(2.0) = 12.0.  If each 
day’s energy requirement was 12 megawatt-
hours, then the “unit” generation 
requirement would be 1 megawatt (12 
MWh/12 units).  Thus, from 8am to 10am and 
from 1pm to 5pm, the plant would generate 
at a rate of 1 megawatt (1 MW * 1.0 
weighting factor), but from 10am to 1pm, the 
plant would generate at a rate of 2 megawatts 
(1 MW * 2.0 weighting factor). 

 

 

Figure 11.74 Example Generation 
Pattern—On from 8 am–5 pm 

 

Figure 11.75 Example Pattern—
Varied Hour of Day Weighting  
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Daily Distribution 

Another aspect of the weighting factors that should be understood is the impact of a 
pattern that changes from day to day throughout the week.  If the pattern is 
specified for Each Day or for Weekdays and Weekend, then the weighting factors are 
summed for the entire week and applied to the generation requirement for the 
whole week.   

For example, if the weekly generation requirement is 20MWh and the daily 
pattern is for Each Day, then the following power requirement would be 
specified as shown in Figure 11.76: 

• No generation on Tuesday, Thursday, Saturday and Sunday; 

• Generation on Monday and Friday is from 10am to 2pm; 

• Generation on Wednesday is for the same hours as Monday and Friday but 
at twice the rate. 

In this example, the sum of the weighting factors is 4(1.0) + 4(2.0) + 4(1.0) = 16 
which produces a unit generation of 20/16.0 = 1.25.  Thus, for each hour on 
Monday and Friday, 1.25 MWh of energy will be produced for a total of 5 MWh 
each day and for each hour on Wednesday, 2.5 MWh of energy will be produced 
for a total of 10 MWh, resulting in the total of 20 MWh for the week. 

 

Figure 11.76 Weighting Factors throughout the Days of the Week 
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Seasonal Variation 

If the weekly pattern varies throughout the year, 
then you can click the Seasonal Variation Edit… 
button to open the Seasonal Variation editor 
(Figure 11.77). This editor will allow to you 
define the seasons for which different 
generation patterns apply. To define the 
seasons, enter the start date of each season.  
The first season always starts on the first of 
January, so if you have a season that begins 
before the end of the year and ends after the 
first of January, then you must define the first 
half of the season as the last season in the table 
and the second half as the first season in the 
table.   

If you define two or more seasons, the Power Generation Pattern editor will show: 

• a checkmark in the checkbox in front of the Seasonal Variation label 

• a season selector and a set of navigation buttons so that you can specify the 
pattern that should apply to each season (Figure 11.78).   

The power generation pattern you define for one season will apply to all days and 
weeks of that season until the start date of the next season. 

 

Figure 11.78 Power Generation Pattern Editor 
with Season Selector 

 

Figure 11.77 Seasonal Variation Editor 
for Specifcation of Seasons 
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11.8 Defining a Pump Schedule Rule 

A Pump Schedule rule is an operation rule that specifies the pumping schedule and 
requirements for a pump outlet.  Unlike other outlet types, pump outlets will not “move 
water” without a rule, and that rule is the Pump Schedule rule.  

A Pump outlet provides a reservoir with the ability to pump water from a downstream 
reservoir into the current reservoir (i.e., pumpback storage operation).  This means that 
the flow direction for water moving through a Pump is opposite to the flow direction of 
any other outlet; a Pump moves water into the current reservoir while all other outlets 
move water out of the current reservoir.  

The Pump Schedule rule type is only available when a Pump outlet is selected as the 
release element in the Operates Release From selector; and, it is the only rule type that 
can be applied to a Pump.  

The Pump Schedule Rule editor is shown in Figure 11.79. The Pump Schedule rule has a 
number of options and attributes, which are described below; pay careful attention to 
the description of each option and attribute to learn how each selection you make could 
change what appears in the editor and how it will affect the way the pump operates. 

Target Fill Elevation—the pump operation needs to know why it should pump.  The why 
is the Target Fill Elevation. When the Pump Schedule rule is evaluated, its first 
determination is whether the reservoir pool is below the target elevation.  If so, 
then the rule decides it needs to pump and proceeds to determine if it is allowed 
to pump and how much it should pump.   

 

Figure 11.79 Pump Rule Editor 
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 Option—there are three options (Figure 
11.80) for specifying the Target Fill 
Elevation.  Each option will change 
the lower portion of the Target Fill 
Elevation section of the rule editor as 
you will see below. 

Constant—if selected, a Target 
Elevation text field will be 
displayed in the lower 
portion of the Target Fill 
Elevation section.  Enter an 
elevation above which the 
reservoir should not pump. 

Storage Zone—if selected, a Zone selector will be displayed (Figure 
11.81). Choose the zone whose top of zone curve represents 

FULL for the current reservoir.  

Seasonally Varying—if selected, a 
seasonal table relating the 
Target Fill Elevation to a Date 
or season will be displayed 
(Figure 11.82). Enter the data 
to define the seasonally 
varying target fill elevation in 
the table. 

Daily Pumping Period—This is the schedule for which 
the rule gets its name.  Since pumps often run 
only at night when the power to run them is 
less expensive, a schedule identifying the 
pumping window is necessary. In this 
table you must specify the portion of the 
day during which pumping is allowed. 
This is a seasonal table that should start 
on 01Jan, like all other seasonal tables. 
You have two options for defining the 
Daily Pumping Period: 

Fixed Hour Range—This option displays a 
seasonal table in which you must 
enter the start date of each 
season, the Begin and End times 

 

Figure 11.80 Pump Rule Editor—
Target Fill Elevation Options 

 

Note: each zone in the list of zones shown in the Zone selector is identified by its 

name and the operation set it is defined in.  Select the zone associated with the current 

operation set.  Unfortunately, this will make the rule applicable to only to the current 

operation set.  If the same rule is needed in a different operation set, you should re-

create the rule and select the appropriate zone for that operation set. 

 

Figure 11.81 Pump Rule Editor—
Target Fill Elevation Option—Storage 

Zone 

 

Figure 11.82 Pump Rule Editor—Target 
Fill Elevation Option—Seasonally Varying 
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of that season’s pumping window, and the number of pump units that 
may be used.  The times must be entered as times on a 24-hour clock 
and may cross over midnight.  For example, to specify a pumping period 
starting at 9:00 pm and ending at 3:30 am, enter 2100 and 0330 into the 
Begin and End columns, respectively. The data in each row of the 
schedule table is treated as a step function and remains in effect until 
the start of the next season. 

Between Sunset and Sunrise—If selected, this option displays a seasonal table in 
which you must define the start and end times of the pumping window 
for each season as a number of hours after sunset and before sunrise 
(After SS & Before SR), respectively. In order for this schedule to 
determine when sunrise and sunset occur on any particular day, you are 
required to provide the approximate Latitude and Longitude of the dam.  
Note, blank entries for Latitude and Longitude will be translated as 0 
values. 

Pumping Strategy—The pumping strategy identifies how and when the pumps are to be 
used during the pumping window, assuming that there is more time available 
than is needed to get the reservoir to its target elevation. Your options are:  

Use full pump capacity—This strategy will minimize the time spent pumping.  
With this option, you must select the Pumping Bias.  Your options 
include: 

Beginning of Period—The pumps will start pumping at the beginning of 
the pumping window. 

Middle of Period—The hours needed to pump to get the reservoir to the 
target elevation will be centered within the pumping window. 

End of Period—the hours needed to pump will be pushed toward the 
end of the pumping window.  

Use entire pump period:  This strategy will run the pumps at a rate which may be 
less than full capacity in order to just reach the target at the end of the 
pumping period. 

Regardless of your Pumping Strategy selection, if the target cannot be reached in the 
pumping period, the pumps will be operated at full capacity over the entire pumping 
period in order to get the reservoir elevation as close as possible to the target. 

• Identify the Source Reservoir.  This should be the next reservoir downstream of the 
current reservoir although it may be a reservoir connected to the current one 
through a diverted outlet.  ResSim’s pump outlets are designed to only pump from a 
storage pool, not directly from a stream.  NOTE: This field should be defined in the 
physical data of the pump outlet, not in the operation rule—so don’t be surprised if 
this setting gets moved to where it belongs in a future version of ResSim. 

• Determine if Whole Hour Pumping should be activated.  When checked, if the pumps 
needed to run for a fraction of an hour, then they will run for the full hour, even if 
their pumping causes the reservoir to exceed the target pool elevation.  Note—
ResSim really doesn’t want to run the pumps longer than necessary, so if it can, it will 
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minimize the total number of pump hours.  For example, if you have 2 available 
pumps and the number of pump unit hours needed to get the reservoir to target is 
4.5, then the pumps will only run for a total of 5 pump unit hours—one pump will run 
for 3 hours and the other for 2 hours (or just one pump for 5 hours). 

• Select the Minimum Pumping requirement.  Depending on your selection, this 
feature identifies the minimum number of hours the pumps must run—if they turn 
on at all during the pumping window. Your options include: 

No Required Min—The default.  The pumps will only operate if and for how long 
they need to in order to get the reservoir pool elevation back up to the 
target within the pumping window. 

At Least Min—The pumps will operate for at least the specified minimum 
duration even if the target elevation has been reached or exceeded.  
With this option, you must enter a value in the Min. Pump Unit Hrs field.   

Pump unit hours are the number of hours a single unit operates.  If you 
have 4 pump units and you want all four pumps to operate for at least 1 
hour each during the pump window, you might enter 4 in the Min. Pump 
Unit Hrs field.  ResSim, however, probably won’t interpret your entry as a 
requirement to run all four pumps.  It may turn on just one pump and 
run it for four hours. 

At Least Min if blw Target—With this option, the pumps will only operate if the 
reservoir is below the target elevation at the start of the pumping 
window.  And, if they do operate, they will run for at least the specified 
duration.  With this option, you must enter a value in the Min. Pump Unit 
Hrs field.  

Only if Req’d >= Min—With this option, the pumps will operate only if the time 
needed to pump (at maximum capacity) is greater than or equal to the 
specified minimum.  In other words, if the time needed is less than the 
min, don’t pump. With this option, you must enter a value in the Min. 
Pump Unit Hrs field.   
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11.9 Defining a Tandem Operation Rule 

A Tandem Operation rule establishes a tandem system operation in which an upstream 
reservoir operates for a downstream reservoir to achieve a storage balance.  Unlike the 
Downstream Control and System Hydropower rules, which must be included in the 
operation sets of all the reservoir that operate together as a system, the Tandem 
Operation rule is created and included in the operation set at the upstream reservoir 
only.  The Tandem Operation rule simply identifies the downstream reservoir for which 
the current reservoir must operate to balance storage. Refer to Chapter 12 to learn more 
about defining system operations. 

Because the tandem operation must account for all releases from the reservoir that 
could reach the downstream reservoir, the only valid release element for a Tandem 
Operation rule is the reservoir (pool), not an outlet or outlet group.   

When evaluated, the Tandem Operation rule returns a desired specified release. That 
means the Tandem rule is saying to the allowable range that the release can be no more 
than AND no less than the release value calculated by the rule.  Because a specified 
release limit is very aggressive, it is recommend that you place the Tandem rule at the 
bottom of the rule stack in each zone it applies to; by doing so, you allow other rules to 
take precedence over the Tandem rule, hopefully preventing the Tandem rule from 
“taking over”. 

To create a Tandem Operation rule: 

• Follow the instructions for creating a new rule as described in Section 11.1.1.   

• Be sure to select the reservoir from the Operates Release From selector and Tandem 
Operation from the Rule Type selector.   

• After giving the rule a name, click OK to finish creating the new rule and close the 
New Operating Rule dialog.  The new rule will appear at the bottom of the rule stack 
in the selected zone of the Zone-Rules Tree and the Tandem Rule editor (Figure 
11.83) will appear in the edit panel. 

 

Figure 11.83 Tandem Operation Rule Editor 

To define the data for a Tandem Operation rule: 

• If necessary, select the Tandem rule from the Zone-Rules Tree. The Tandem 
Operation rule editor will be displayed in the edit panel (Figure 11.83).  
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• Select the Downstream Reservoir for which the current (upstream) reservoir is 
operating.  This is usually the next reservoir downstream of the current reservoir. 

• Check the position of your Tandem rule with respect to other rules in the zone in 
which it is placed.  If necessary, use the Move to Bottom option from the rule’s 
context menu to force the rule to the bottom of the rule stack. 

11.10 Defining a Prescribed Release Rule 

A Prescribed Release rule is a rule that can be used to “hand regulate” a reservoir.  That 
means that you can tell the reservoir how to operate over a specific time window with a 
specific operating objective. The operating objective is defined by selecting an Operator 
and an accompanying value.  For example, if the Operator is “Rel % Inflow”, the Value is 
the percentage of inflow that should be released. 

Although similar in concept to a Release or Elevation Override, the Prescribed Release 
rule can be prioritized with other rules; while an override is just that—it overrides 
whatever the rules may have decided was the appropriate release. 

To create a Prescribed Release rule: 

• Follow the instructions for creating a new rule as described in Section 11.1.1.   

• Be sure to select an appropriate release element from the Operates Release From 
selector and Prescribed Release from the Rule Type selector.   

• After giving the rule a name, click OK to finish creating the new rule and close the 
New Operating Rule dialog.  The new rule will appear at the bottom of the rule stack 
in the selected zone of the Zone-Rules Tree and the Prescribed Release Rule editor 
(Figure 11.84) will appear in the edit panel. 

 

Figure 11.84 Prescribed Release Rule Editor 

To define a Prescribed Release rule: 

• Select the Prescribed Release rule from the Zone-Rules Tree. The Prescribed Release 
rule editor will be displayed in the edit panel (Figure 11.84). 

• Use the buttons at the bottom of the editor to add rows to the table for each 
prescribed release you want to define.   

Append Row—adds one row at a time to the bottom of the table. 
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Insert Row(s)—allows you to specify the number of rows to insert above the 
selected row in the table. 

Delete Row—will delete the selected row. 

• In each row… 

o Define the time window over which the prescribed release will apply by entering 
a Start Date/Time and an End Date/Time 

o Choose an Operator to define the type of prescribed release you are defining 
(Figure 11.85).   

 

Figure 11.85 Prescribed Release—Setting Operator 

The list of available Operators will vary depending on the release element you 
identified for this rule to Operate Release From. Table 11.2 shows the list of 
available Operators that you’ll find for the different release elements. 

o And, as needed, enter an appropriate Value for the selected Operator to use. 

• Check the position of your new rule with respect to other rules in the zone it is 
placed.  To raise or lower the priority of a rule within the rule list for a particular 
zone, use the Increase/Decrease Priority or Move to Top/Bottom options in the rule’s 
context menu or from the Rule menu. 

When you have finished setting up your Prescribed Release rule, be sure to click Apply 
before moving on to the next rule. 

Table 11.2 The Available Prescribed Rule Operators by Release Element Type 

Reservoir Dam or Group Controlled outlet 
Controlled Outlet  
with Gate Settings 
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Chapter 12 

Advanced Features 
In Chapter 10 and Chapter 11, you learned the basics about developing an Operation Set 
to guide how your reservoir should make its release decisions.  In this chapter, you will 
learn about the additional features that can be added to your network and to its 
reservoirs’ operation sets to allow you to specify more complex objectives and 
constraints on the operation of your reservoirs. You will also learn about the network 
data importer that can be used to import or copy model data from one network to 
another. 

The first part of the chapter describes some advanced tools that you can use to define 
your reservoir and diversion operations.  These tools provide additional flexibility and 
control over the conditions that activate one or more rules, influence the desired release 
from a rule (or diversion), or even define a zone.  These tools are IF_Blocks, State 
Variables, and Scripted Rules.  

The next part of the chapter describes the advanced operational features that can be 
added to the operation set of a reservoir.  These features include: Capacity Outages, 
Storage Credit, Release Decision Schedule, and Projected Elevation.  Each of these 
features has a unique influence on the overall reservoir operation; their influence is not 
zone-based and doesn’t fit into the zone-rules portion of the operation set.  These 
features are specified on the remaining sub-tabs of the Reservoir Editor’s Operations tab; 
but each tab must be activated by selecting the feature from the Operations menu of the 
Reservoir Editor.  

The last part of this chapter steps back from the reservoir operations to describe the two 
network properties importers that are available in ResSim.  One of these importers will 
copy a whole reservoir network from another watershed into the current watershed. The 
other importer will copy data from an existing network into the current (open) network.   

12.1 IF_Blocks 

Reservoir operations can be influenced by several conditions that determine the 
applicability of specific operational goals and constraints.  So far, you have learned that, 
in ResSim, the determination of the applicable set of rules is related to the prioritization 
and presence of the rules in the active operation zone.   

Using the ResSim IF_Block feature, you can define one or more conditional expressions 
that determine which rules should be used in the reservoir release decision process.  
IF_Blocks are highly customizable.  You can create simple IF_Blocks that contains only a 
single IF statement or you can build more complex IF_Blocks by adding one or more ELSE 
IF statements and/or an ELSE statement. For each IF, ELSE IF, or ELSE statement used in 
an IF_Block, you can associate a prioritized set of rules that is only applicable when its 
conditional expression evaluates to TRUE.  
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12.1.1 IF_Block Terminology 

To understand how to create and use IF_Blocks, you should understand the 
terminology that was developed related to IF_Blocks.  Below are some important 
terms and their definitions: 

IF_Block—a feature that you can add to a zone in which you can define one or more 
conditional expressions that, when evaluated to a value of TRUE, activates 
one or more operation rules. An IF_Block contains an ordered list of 
conditional blocks. 

A complex (or compound) conditional expression strings together two or 
more simple conditional expressions using the logical operators: AND and 
OR. 

Conditional Block—an object made up of a conditional expression and a rule set that 
will be activated when the conditional expression evaluates to true.   

IF, ELSE IF, and ELSE are the three types of conditional blocks that may be 
members of an IF_Block in ResSim. By default, all IF_Blocks are created with 
an IF in their list of conditional blocks; you can add one ELSE and one or more 
ELSE IFs to the IF_Block list.   

Conditional Expression—a logical or comparative statement that can be evaluated to 
TRUE or FALSE.  A simple conditional expression compares two objects or 
values using one of the comparison (or Boolean) operators:  =, >=, >, <=, <, 
and !=. 

IF—one of the three types of conditional blocks that may be found in an IF_Block.  

For simplicity, an IF conditional block will usually be referred to in this 

document as an IF.  The feature that an IF is contained in will always be 

referred to as an IF_Block. 

And, for consistency, the ELSE and ELSE IF conditional blocks will also be 

referred to as just ELSE and ELSE IFs. 

An IF conditional block is always created as part of an IF_Block; it cannot be 
deleted nor can another IF be added. The IF is always first in the list of 
conditional blocks that belongs to an IF_Block and, as such, its conditional 
expression is always evaluated first.  If the IF block’s conditional expression 
evaluates to true, the IF’s rule set will be added to the zone’s set of active 
rules and the conditional expressions for the remaining conditional blocks 
contained in the parent IF_Block will be evaluated; however, if there are any 
nested IF_Blocks in the IF block’s rule set, the conditional expression 
evaluation will move into the nested IF_Block(s). 

ELSE IF—one of the three types of conditional blocks that may be found in an 
IF_Block.  If an ELSE IF has been added to an IF_Block, the ELSE IF is 
evaluated only when the conditional expression of the preceding IF 
evaluated to FALSE.  If more than one ELSE IF has been added to the 
IF_Block, the ELSE IFs will form an ordered list between the IF block and the 
ELSE block (if there is one); the conditional expressions of the ELSE IF blocks 
will be evaluated in order, from top down, until one of them evaluates to 
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TRUE, at which point the evaluation of the conditional expressions will cease 
and the rule set of the TRUE ELSE IF block will be added to the current zone’s 
list of active rules.  If the conditional expressions of all the ELSE IF blocks 
evaluate to FALSE, the rules in the ELSE block (if there is one) will be added 
to the current zone’s list of active rules. 

ELSE—one of the three types of conditional blocks that may be found in an IF_Block. 
Only one ELSE may be added to an IF_Block.  When added, the ELSE will 
always be placed at the bottom of the ordered list of conditional blocks in the 
IF_Block.  Although an ELSE does not have a conditional expression that you 
can specify, think of it as having a conditional expression that is always TRUE.  
As a result, an ELSE’s rule set will be activated when the conditional 
expressions of the IF and all the ELSE IFs that precede it evaluate to FALSE.   

Nested IF_Block—this is an IF_Block that is added to the rule set of a conditional 
block belonging to a higher-level (or parent) IF_Block.  

  A ResSim Truth: wherever you can add a rule, you can add an IF_Block.   

Nested IF_Blocks can be useful, especially when you need to conditionally 
activate the same rule set in multiple conditional blocks of a single IF_Block 
or in multiple other IF_Blocks. However, do not use a nested IF_Block as a 
way to avoid defining a conditional block with a compound or complex 
conditional expression and/or using multiple ELSE IF blocks. 

Rule Set—the prioritized list of rules and IF_Blocks belonging to a zone or conditional 
block.   

During the compute of each timestep and after the current zone has been 
determined, ResSim needs to assemble the zone’s list of active rules before it 
can evaluate those rules.  To do so, ResSim processes each member of the 
zone’s rule set, from top to bottom—if a member of the rule set is a… 

Rule—the rule is added to (the bottom of) the active rule list. 
IF_Block—ResSim evaluates the conditional expression of each conditional 

block in the IF_Block until it encounters one that evaluates to TRUE, 
at which point ResSim processes the members of the conditional 
block’s rule set, adding its rules to the zone’s active rule list and 
evaluating its IF_Blocks.  

12.1.2 Managing IF_Blocks 

Since you can add an IF_Block wherever you can add a rule, the functions for 
managing them are similar to those for managing rules.  You can create, rename, and 
delete IF_Blocks, as well as add or remove existing IF_Blocks from one or all zones.  
But there’s one additional function that is available for IF_Blocks that is not available 
for rules—duplicate.   

Most of the IF_Block management functions are available from the IF_Block menu in 
the Menu bar of the Reservoir Editor when the Operations tab is active. And, except 
for New… and Delete…, the same functions are available from the IF_Block context 
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menu (see Figure 12.1).  Because of this duplication, the following sections will focus 
on the use of the context menu; however, you should use the menu you are most 
comfortable with—the context menu from the tree nodes or the menu in the menu 
bar.  If you are more comfortable with the menu in the Menu bar, replace the words 
“right-click on” with “select” and “context menu” with the appropriate menu for the 
operation (IF_Block). 

 

 

Figure 12.1 Reservoir Editor—Operatons Tab—IF_Block Menu and Context Menu 

The Zone menu and the zone context menu include the remaining the IF_Block 
management functions.  These menus and their IF_Block functions are shown in 
Figure 12.2. 

 

 

Figure 12.2 Reservoir Editor—Operatons Tab—Zone Menu and Context Menu 

The contents in the IF_Block and Zone menus are sensitive to the currently selected 
node in the Zone-Rules tree.  For example, the New… function in the IF_Block menu 
is only active when the currently selected node in the tree is a zone or conditional 
block. 

Sections 12.1.2.1—12.1.2.6 describe each of the IF_Block management features. 
Editing IF_Blocks is covered in Section 12.1.3. 
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12.1.2.1 Creating an IF_Block 

To create a new IF_Block: 

• Open the Reservoir Editor, select the Operations tab, and select the 
appropriate operation set. 

• Right-click on a zone in the Zone-Rules tree in which you want to place the 
new IF_Block. 

• Select Add IF_Block from the 
zone’s context menu or select 
New from the IF_Block menu.  
The New IF_Block dialog will 
open (Figure 12.3). 

• Enter a name (and optional 
description) for the new 
IF_Block and click OK. 

•  A branch in the Zone-Rules tree will appear at the bottom of the selected 
zone (Figure 12.4).  This branch represents the IF_Block you created.  The 
root node of the branch will display the IF_Block’s name preceded by a pair 
of curly brackets { }.  Below the root node of the IF_Block, indented, is the 
node for the IF conditional block belonging to the IF_Block; this node displays 
the word IF preceded by a thick black arrow  and followed by a label in 
parentheses () and.  Untitled is used as the default label to remind you to 
give each conditional block a more appropriate label—one that describes the 
condition(s) defined in the conditional expression or the set of operations 
that will be added if the conditional expression evaluate to TRUE. 

• When the new IF_Block is added to the Zone-Rules tree, its IF becomes the 
selected node and the Conditional Expression Editor for the IF is displayed in 
the Edit Pane (Figure 12.4). Section 12.1.3.3 describes how to use the 

 

Figure 12.3 New IF_Block Dialog 

 

Figure 12.4 New IF_Block and the Conditional Expression Editor 
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Conditional Expression Editor for defining the conditional expressions of your 
IF and ELSE IF conditional blocks. 

12.1.2.2 Using an Existing IF_Block 

Like a rule, an existing IF_Block can be added to 
the rule set of any zone or conditional block.   

To add an existing IF_Block to a zone: 

• Right-click on the zone in the Zone-Rules 
tree. 

• Select Use Existing IF_Block… from the 
node’s context menu. 

• The Use Existing Conditional Block dialog 
will open (Figure 12.5).  Select the IF_Block 
you want from one of the white rows in the 
table and click OK.  [Grey rows in the table are IF_Blocks that are already 
being used in the rule so are not available to be added again.] 

• The IF_Block will appear at the bottom of the selected zone’s rule set.  

To add the IF_Block to all the zones in the current operation set:  

• Activate the checkbox in front of Add to All Zones before clicking OK in the 
Use Existing Conditional Block dialog—OR— 

• Right-click on the IF-Block in the Zone-Rules tree and select Add IF_Block to 
all Zones from the context menu. 

12.1.2.3 Copying an IF_Block 

Making a copy of an IF_Block is not the same as using an existing IF_Block.  When 
you use an existing IF_Block in multiple zones, a change made to the IF_Block in 
one zone will show up in all instances of the IF_Block.  However, when you make 
a copy of an IF_Block, you give the copy a new name and the copy can now 
evolve independently of the original IF_Block it was copied from. 

Two methods are available for making a copy of an IF_Block; these methods 
differ depending on where you start: 

From a Zone in the Zone-Rules tree: 

• Select a zone in the Zone-Rules tree. 

• From the IF_Block menu, select Duplicate. 

• The Duplicate IF_Block selection dialog will 
open (Figure 12.6).  Select the IF_Block you 
want to copy from the list and click OK. 

• The Name Duplicate Conditional dialog will 
open (Figure 12.7). Enter a new name for 
the new IF_Block and click OK. 

• The new (copied) IF_Block will appear in at the bottom of the selected zone. 

 

Figure 12.5 Use Existing 
IF_Block Dialog 

 

Figure 12.6 Duplicate IF_Block 
Selection Dialog 
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From an IF_Block in the Zone-Rules tree: 

• Select an IF_Block in the Zone-Rules tree. 

• From the IF_Block menu, select Duplicate. 

• The Name Duplicate 
Conditional dialog will 
open (Figure 12.7).  

• Enter a new name for the 
new IF_Block and click OK. 

• The new (copied) IF_Block 
will not appear in the 
Zone-Rules tree, but it will 
be available for use from 
the Use Existing IF_Block dialog. 

12.1.2.4 Prioritizing an IF_Block 

Since IF_Blocks are intended to conditionally add a set of rules into the list of 
active rules for a zone, IF_Blocks can and should be prioritized with respect to 
the other rules and IF_Blocks in a zone’s (or conditional block’s) rule set.  The 
context menu of an IF_Block (Figure 12.8) contains the move functions needed 
for prioritizing an IF_Block within a rule set: 

Increase Priority—use this function to move 
the whole IF_Block above the rule 
or IF_Block right above it in the rule 
set. 

Decrease Priority—use this function to 
move the whole IF_Block below the 
rule or IF_Block right below it in the 
rule set. 

Move to Top—use this function to move the 
whole IF_Block to the top of the rule set. 

Move to Bottom—use this function to move the whole IF_Block to the bottom of 
the rule set. 

12.1.2.5 Removing an IF_Block 

Removing an IF_Block from the rule set of a 
zone or conditional block is the same as 
removing a rule.  To do so: 

•  Right-click on the IF_Block node in the 
Zone-Rules tree 

• Select Remove from the context menu. 

• The Remove IF_Block confirm dialog will 
open (Figure 12.9). 

• Click OK to proceed with removing the selected IF_Block from the rule set. 

 

Figure 12.7 Name Duplicate IF_Block Dialog 

 

Figure 12.8 IF_Block Context Menu—
Move/Prioritize Functions 

 

Figure 12.9 Remove IF_Block 
Confirm Dialog 
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To remove an IF_Block from all zones in the current operation set: 

• Right-click on the IF_Block node in the Zone-Rules tree 

• Select Remove IF_Block from 
All Zones from the context 
menu. 

• The Remove IF_Block confirm 
dialog will open (Figure 12.10).   

• Click OK to proceed with 
removing the selected IF_Block 
from the rule sets of all the zones of the current operation set. 

To remove all IF_Blocks from a zone in the current operation set: 

• Right-click on the zone in the Zone-Rules tree 

• Select Remove all IF_Block from this Zone from the context menu. 

• The Remove All IF_Blocks… 
confirm dialog will open (Figure 
12.11).   

• Click OK to proceed with 
removing the selected IF_Block 
from the rule sets of all the zones 
of the current operation set. 

12.1.2.6 Deleting an IF_Block 

Deleting an IF_Block removes all uses of the IF_Block from the reservoir’s 
operation sets, even if the IF_Block is nested inside another IF_Block.  After 
removing all reference to the IF_Block in the operation sets, the IF_Block is then 
deleted from the reservoir.  Since Delete is such an encompassing operation, it is 
only available from the IF_Block menu. 

To delete an IF_Block: 

• Select an IF_Block in the Zone-Rules tree.  [Any IF_Block will do in order to 
activate the Delete option in the IF_Block menu.] 

• The Select Conditional Block to Permanently Delete dialog will open (Figure 
12.12).   

• Select the IF_Block you want to 
delete from the list of existing 
IF_Blocks and click OK.  

• A Delete IF_Block confirm dialog 
will open (Figure 12.13).  Click Yes 
to complete the delete process.  
No will abort the delete process. 

 

Figure 12.10 Remove IF_Block from All Zones 
Confirm Dialog 

 

Figure 12.11 Remove All IF_Blocks… 
Confirm Dialog 

 

Figure 12.12 Delete IF_Block Dialog 
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Figure 12.13 Delete IF_Block Confirm Dialog 

12.1.3 Editing IF_Blocks 

There are three steps to editing IF_Blocks, although they can be addressed in almost 
any order:  

• Adding (and/or Deleting) ELSE IF and ELSE Conditional Blocks 

• Defining the Conditional Expressions of the Conditional Blocks 

• Specifying the Rule Set for each Conditional Block 

The following sections describe these steps. 

12.1.3.1 Adding a Conditional Block to an IF_Block 

Since an IF conditional block is created by default as part of the IF_Block and 
cannot be deleted, only ELSE and ELSE IF conditional blocks can be added to an 
IF_Block.  The functions for adding ELSE and ELSE IF conditional blocks are 
available from the context menus of an IF_Block and a conditional block; they are 
not available from the IF_Block menu in the Menu bar.  These functions are: 

Append ELSE—this function will add an ELSE conditional block to the bottom of 
the list of conditional blocks in the IF_Block.  If the IF_Block already has 
an ELSE, the Append ELSE function will be unavailable (greyed-out) in the 
context menu. 

Append ELSE IF—this function will add a new ELSE IF conditional block to the 
bottom of the list of ELSE IF blocks in the IF_Block, even if you selected 
Append ELSE IF from the context menu of a specific conditional block in 
the IF_Block.   

12.1.3.2 Deleting a Conditional Block from an IF_Block 

To delete an ELSE or ELSE IF from an IF_Block: 

• Right-click on the ELSE or ELSE IF conditional block to be deleted. 

• The Remove Rule confirm dialog will open (Figure 12.14).   

• Click OK to confirm 
that you want to 
delete the selected 
conditional block 
or Cancel to abort 
the delete process. 

 

Figure 12.14 Delete ELSE (or ELSE IF) Confirm Dialog 
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12.1.3.3 The Conditional Expression Editor 

The Conditional Expression Editor (Figure 12.15) is displayed in the Edit Panel of 
the Zone-Rules tab whenever the selected node in the Zone-Rules tree is an IF or 
ELSE IF conditional block of an IF_Block.   

 

Figure 12.15 Conditional Test Editor—Pick Value 

The Conditional Expression Editor is divided into three parts—a name and 
description row and two panels: 

The name field is labeled with the conditional type (e.g., IF Conditional).  Unlike 
the rule editors, this name field is editable.  Enter a name or label for the 
conditional block in this name field.  Each conditional block was given the 
label Untitled by default in order to remind you to give each conditional 
block a more appropriate label. Use a label that describes the 
condition(s) defined in the conditional expression or the set of 
operations that will be added if the conditional expression evaluates to 
TRUE.  And, if you change the conditions, be sure to change the label. 

The upper panel gives you the ability to create one or more conditions or 
comparisons.  Each condition is a row in the table. A single condition 
(row) forms a simple conditional expression.  Two or more conditions 
(rows) can be joined with logical operators to form a compound 
conditional expression.  

The function buttons to the right of the table are for managing the rows, 
in the table: 

Add Cond.—adds a row to the bottom of table. Since the table starts 
out empty, you must add at least one row to specify a simple 
conditional expression. 

Del. Cond.—deletes the selected row from the table. 

The order in which conditional expressions are evaluated is similar to 
that for mathematical expression.  The evaluation order for conditional 
expressions follow these three basic principles: 
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• left to right,  

• comparison operators before logical operators, and 

• if parentheses are used, innermost parenthetical expressions first, 
moving out from there. 

Since the order of the conditions in a compound conditional expression 
may be important when it is evaluated, functions to rearrange the order 
of the conditions in the table are provided: 

Move Up—swaps the selected row with the row above it. 
Move Down—swaps the selected row with the row below it. 

When using these functions, think of the first row in the table as the left-
most comparison in the compound conditional expression and the last 
row as the right-most comparison.  Like the thumbnail plots in the rule 
editors, the last function button will help with visualizing what you define 
in the table: 

Evaluate—assembles the rows in the Conditions table into a string 
and displays the string in a message box so that you can 
verify that your table entries describe the conditional 
expression you intended. 

The lower panel is for specifying each condition that forms the conditional 
expression.  A condition is formed by two operands, Value 1 and Value 2, 
and the comparison operator between them:   

Value 1 and Value 2—The two operands can be defined as being one for 
the variable types listed in Table 12.1.  Table 12.1 indicates 
which variable types can be used by each operation and the data 
required to define them.  

Table 12.1 Available Variable Types and Their Required Data 

Value 1 Value 2 Data Required 

Constant Constant Enter a numeric value in the text field 

Date/Time Date/Time Enter a specific calendar date (e.g., 
31Oct1949) and a clock time (0000—2400) 
in Date and Time fields. A calendar tool can 
be opened using the  button in the Date 
field to assist in specifying a date. 

Current 
Time Step 

Current Time 
Step 

- No user input required - 

Time 
Series 

Time Series Use the Pick Value button to open the 
Independent Variable Definition Editor.  Use 
it to select the specific model variable, state 
variable, or external variable you need. 

Seasonal Seasonal Enter a specific day of the year (e.g., 01Apr) 
in the Date field.   

 Time of Day Enter a clock time (0000—2400)  

 Day of Week Enter a weekday (e.g., Sun, Mon, etc.) 
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The operators that can be used to compare Value 1 to Value 2 are listed 
in Table 12.2. 

Logical Operators—AND and OR.  Each condition after the first must be 
joined to the prior condition(s) with a logical operator.   

You can include parentheses in your conditional expression by setting 
Value 1 to the required parenthesis.  If you set Value 1 to an open 
parenthesis ((), the operator and Value 2 selectors will be greyed-out 
(deactivated); however, you must specify the logical operator that 
precedes the parenthesis.  If you set Value 1 to a close parenthesis ()), all 
other fields of the lower panel will be greyed-out (deactivated) since the 
closed parenthesis forms the end of a condition.  Figure 12.16 shows an 
example of a compound conditional expression and illustrates the use of 
parentheses and logical operators. 

 

Figure 12.16 Example of a Compound Conditional Expression and the Associated Evaluate String 

Table 12.2 The Comparison Operators 

=  equal to  

> greater than 

>=  greater than or equal to 

<  less than 

<=  less than or equal to 

!=  not equal to 
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12.1.3.1 Defining the Rule Set of a Conditional Block 

The steps for adding rules and IF_Blocks to the 
rule set of a conditional block is the same as 
adding them to a zone.  The functions you need 
are all available from the context menu of a 
conditional block in the Zone-Rules tree (Figure 
12.17). 

To add a new or existing rule to the rule set of a 
conditional block: 

• Right-click on the conditional block (IF, ELSE IF or ELSE) in the Zone-Rules 
tree. 

• Select Add New Rule... or Use Existing Rule… from the context menu 

• For a new rule, select the release element, set the rule type, and give the rule 
a name.  For an existing rule, select the rule from the Use Existing Rule 
dialog.  Click OK to complete the add rule process. 

Figure 12.18 illustrates a completed conditional block rule set. 

 

Figure 12.18 Completed Conditional 
Block with Rule Set 

12.2 State Variables 

Definition: A state variable is one of a set of variables used to describe the state of a 
dynamical system.  Since a watershed is a dynamic system, this definition applies to all 
the variables that can be computed for an object or a group of objects in the watershed 
as it varies through time.   

ResSim places state variables into three categories:  

Model Variables—state variables that ResSim computes natively for each element in 
a ResSim network.  Examples include: reservoir pool elevation, release from 
an outlet, or flow through a diversion. A Model Variable is computed for each 
timestep of the simulation and stored in a Time Series object. 

External Variables—variables that have been computed externally (outside of 
ResSim) and provided as input time series.  Examples include: a time-series of 
forecasted snowmelt inflow volume or water supply demand. An External 
Variable is also stored in a Time Series object.  

(User-Defined) State Variables—variables that a user defines by writing a Jython 
script that will be used to compute the value of the variable for each 
timestep of the simulation.  A State Variable is an object that belongs to a 

 

Figure 12.17 Conditional Block 
Context Menu 
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reservoir network and contains a Time Series object that holds the state 
values computed by the script. 

In order to minimize confusion, outside of the descriptions above, the term state variable 
will only be used in this manual to describe user-defined or scripted State Variables.  For 
the most part, the modifiers: user-defined and scripted will be omitted unless they are 
needed for clarity.  

Since many reservoirs are operated based on the state of the watershed (e.g., dry or wet 
hydrologic conditions) or some abstract state of a reservoir or system of reservoirs (e.g., 
a system drought level), State Variables can be developed to compute these watershed 
conditions.     

State Variables can be used wherever a Model Variable or External Variable can be used 
to control or influence the operation of a reservoir.  This includes (but is not limited to): 

• Function-of Rules 

• IF_Block Conditional Expressions 

• Zones 

• Diversions 

A State Variable is a special form of a TimeSeries Object.  It is defined and computed 
through the execution of a user-defined Jython script.  Jython is a Java implementation of 
the Python programming language.  The script may perform calculations referencing any 
TimeSeries object in the ResSim network and alternative, including all model variables 
and other State Variables.  

Python and Jython tutorials and references can be found at www.python.org and 
www.jython.org. 

12.2.1 The State Variable Editor 

State variables are created, edited, and managed 
through the ResSim State Variable Editor. The State 
Variable Editor can be accessed by selecting State 
Variables… from the Edit menu of either the Reservoir 
Network module (Figure 12.19) or the Simulation 
module.   

ResSim’s State Variable Editor (Figure 12.20) is designed 
to help you create and manage your state variables.  It 
includes a built-in scripting interface for editing your 
state variable scripts and accessing needed objects from 
your ResSim model.   

 

Figure 12.19 Reservoir 
Network Module—Edit Menu 

http://www.python.org/
http://www.jython.org/
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Figure 12.20 The State Variable Editor—Annotated 

The State Variable Editor consists of several important regions and widgets: 

Menu bar—this bar contains the StateVariable and Edit menus. 

StateVariable menu—like a File menu, this menu provides access to the 
functions for creating and managing your state variables.   

Edit menu—this menu provides access to the standard text editing functions 
including Cut, Copy, Paste, and Undo.  Redo will also appear in this 
menu if there’s anything that has been Undone since the last save of 
the current state variable. 

Name & Description—this bar contains the Name and Description fields as well as a 
set of navigation buttons.  The Name field is a selector; use it to select the 
specific state variable you want to edit.  The Description field can be used to 
add a description of the selected state variable.  The navigation buttons, like 
the Name selector, give you the ability to cycle through all the network’s 
state variables by moving forward and backward through the list. 

Parameter Info—this bar contains the fields for specifying the current state variable’s 
Parameter Name and Type.  For example, if your state variable is going to 
compute basin inflow, then the parameter type is probably Flow and the 
parameter name you enter is up to you—you might call it flow, or inflow, or 
flow-in or something descriptive of the data you are computing.  

 

Note: when the compute results are written to the simulation.dss file at the 

end of the compute, the B and C parts of the DSS pathname for each state 

variable’s output are formed from its Name and its Parameter Name, 

respectively. The units of the data are based on the parameter type and the 

current unit system for your watershed. 
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 —this checkbox, located to the right of the Parameter 
Info bar, is provided to force the computation of a State Variable that would 
otherwise not be computed.  State variables that are not referenced in the 
current operations (e.g., used in a rule) will not be calculated during the 
simulation unless the Compute As Post Process box is checked.  When this 
box is checked, the state variable will be computed after the Regulated 
Compute has finished running through the time window but has not yet 
started its CleanUp process.  This option might be used when a State Variable 
has been created for the purpose of post-processing results (e.g., water 
accounting, system balancing, etc.).  Note:  this option to compute the State 
Variable as a Post Process should only be used when needed since it will 
increase the compute time.   

State Variable Type Radio Buttons—these radio buttons allow you to choose 
between two types of state variable—Jython Script or Scriptless.  While all 
user-defined state variables must be calculated and written by a script, the 
default Jython Script state variable type is calculated by its own Jython script, 
whereas a Scriptless state variable has no script of its own and must be 
calculated by another state variable.  You may wish to use a single script to 
calculate several different but related state variables.  In such a case, you 
would create one Jython Script state variable and one or more Scriptless 
state variables, all of which would be calculated and populated during the 
compute of the Jython Script state variable. When a state variable is denoted 
as Scriptless, the Script tabs and Text Editor will be disabled and ResSim will 
not attempt to launch a script to compute the variable.  A lookback entry will 
be created for the Scriptless state variable and a DSS record will be defined, 
however the record will not be populated with data unless a Jython Script 
state variable explicitly writes values to that Scriptless state variable.   

 

Script Tabs—the Tabs in the State Variable Editor separate the three scripts that 
define the three compute functions of each state variable: 

Initialization—this tab holds the initStateVariable function for your state 
variable.  Use this tab to initialize the variables and objects that your 
state variable needs.  The initialization function is executed only 
once, at the start of the Regulated Compute loop. 

Main—this tab holds the script that is executed at least once per timestep 
through the simulation portion of the time window in order to 
compute the value of the state variable for each timestep. 

CleanUp—this tab holds the script that is executed only once, at the end of 
the Regulated Compute loop.  Use this tab to clean up the variables 
you created in your state variable and to write to disk any local time 
series or other objects that you need for analysis and/or debugging. 

 

Note: The functionality of the Scriptless state variable will be replaced by 

Global Variables in future versions of ResSim. 
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API Tree—a tree widget is used to 
provide access to the 
ResSim Application 
Programming Interface (API) 
available to the script. The 
tree is divided into two 
major branches: 

TimeSeries branch—Each 
node in this branch 
gives you access to 
the TimeSeries 
objects for the 
various elements in 
your model (Figure 
12.21).   

 APIs branch—each node in 
this branch provides 
you with easy 
access to the 
method calls for accessing and manipulating the objects in your 
model that you are most likely to need in your scripts. Among other 
things, it contains API entries for: 

o Accessing methods for manipulating the TimeSeries objects you 
have retrieved from the TimeSeries branch. 

o Determining the date and time, as well as the index, of the 
timestep being evaluated. 

o Accessing data directly from HEC-DSS file. 

By double-clicking on a node in the tree, the code needed to retrieve 
an element’s time series or to access a method for manipulating a 
particular object type can be placed in your script at the current 
location of your cursor in the editor.  This action can also be 
performed by selecting a node in the API tree and clicking the Insert 
in Script button.  

By hovering your cursor over a node in the tree, a tooltip (Figure 
12.22) will appear with the Javadoc entry for the method call that is 
represented by that node. The Javadocs are class-level 
documentation of the public classes and their methods that you can 
use in your scripts.  

Most method calls (or functions) that you may need require 
arguments (or parameters) as input.  If the method you select 
requires arguments, the text of that method call that is added to 
your script will include the arguments between the parentheses (). 

Method arguments given as literals (i.e., actual numbers, or strings 
enclosed by “ ”) are already complete and require no additional 
input.  The text inserted from items under the Time Series branch of 

 

Figure 12.21 Model Variable Node in the Time 
Series Branch of the API Tree 
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the API Tree typically fall into this category; for these calls, you do 
not need to modify the argument list.   

Method arguments 
given as java classes 
are placeholders for 
variables that you 
must supply in the 
script (Figure 12.22).  
The method call text 
inserted from nodes 
in the APIs branch 
usually requires that 
you replace the 
placeholders in the 
argument list with 
appropriate 
variables/objects 
that you created 
within your script. 

 

The list of ResSim classes and their methods that are included in the 
APIs branch of the API Tree is not complete or all-inclusive.  If you 
are looking for a class or method you think you need from ResSim 
and it isn’t in the list, click on a branch or node in the APIs section 
and press F1.  The Javadoc Viewer (Figure 12.23) will open showing 
the Javadoc pertinent to the node or branch you selected. From 
there, you can search through the Javadocs to find the method you 
need to access the information you need. 

 

Figure 12.23 The Javadoc Viewer 

 

Figure 12.22 Method Node in the 
APIs Branch of the API Tree—Showing Tooltip 

 

If a method call has: RunTimeStep rts as an argument, you 

should almost always use the variable: currentRuntimestep for 

that argument. You will learn more about currentRuntimestep 

in the next section. 
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API Preview Bar—When you select a node in the API tree, the text that would be 
generated by that node will appear in the Preview Bar. 

Text Editor—This pane of the State variable Editor uses a text editor that interprets 
the text of your script as Jython source code and colorizes it according to the 
type of statement or key word it recognizes.  This editor supports the 
standard Windows® shortcut-keys for select all (Ctrl+A), cut (Ctrl+X), copy 
(Ctrl+C), and paste (Ctrl+V), and undo (Ctrl+Z) functions.  These functions can 
also be accessed from the Edit menu or by right-clicking in the Text Editor to 
open a context menu.  The find (Ctrl+F) function is also supported but can 
only be access from the shortcut keys. 

Cursor Position—the position (row and column number) of the cursor in the Text 
Editor is shown in the small box to right of the API Preview Bar.   

12.2.2 State Variable Scripting Concepts 

Here are some basics you should know about scripting state variables in ResSim: 

The Scripts—State Variable have three scripts, each of which represents all or part of 
a compute function of the state variable object in ResSim.  These scripts are 
referred to as: 

Init—The Initialization script is called by the initialization function of the state 
variable, which is executed only once per run, early in the regulated 
compute.  This script is where you should create the persistent local 
variables that you may need to hold data between executions of the 
Main script. 

Main—The Main script is executed by the evaluate function of the state 
variable, which is executed at least once per timestep of the 
regulated compute.  This script is where your code to determine the 
value of the state variable for the current timestep should be 
located. 

CleanUp—The CleanUp script is executed by the function of the state 
variable that tidies up after the compute.  This method is only 
executed once per compute, at the end of the regulated compute.  
This script is where you should perform the tasks that should be  

Templates—each of the three scripts you can write for your state variables gets 
started with a template for you to write you script into.   

Init—The Initialization script template includes an import statement and the 
function definition for the initStateVariable method, and some 
instructive comments describing the arguments that ResSim will 
send into the function (Figure 12.24).   
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Figure 12.24 The Initialization Script Template 

Main—The Main script template is all comments describing the three 
variables (arguments) that ResSim will provide to the main script and 
the method call you need to include in your script in order to store 
the computed value for the state variable for each timestep (Figure 
12.25).   

 

Figure 12.25 The Main Script Template  

CleanUp—The CleanUp script template also has an import statement and 
some comments describing the two variables (arguments) that 
ResSim will provide to your CleanUp script (Figure 12.26). 

 

Figure 12.26 The Cleanup Script Template 
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Arguments—each script receives some variables that are provided by ResSim so that 
it can access model elements and their objects for use in computing the 
value of the state variable.  The three variables that may be provided are 
described below.  All three scripts are provided the first two.  The third is 
provided only to the Main script. 

currentVariable—is a reference to the current state variable object itself.  
currentVariable is conceptually equivalent to the this keyword in Java 
or the self keyword in Python.  

network—is a reference to the object that holds the reservoir network.  It 
can be used to access to all the elements of your network and their 
model variables such as pool elevations, inflow, diversions, etc.… It 
can also be used to access the current alternative and its properties. 

currentRuntimestep—is a reference to the object that holds the timestep 
being evaluated.  The actual date & time of the timestep, as well as 
the sequence number of the timestep and the run time window are 
accessed through this object.  This object is used, among other 
things, to determine where (or is that when) to store the computed 
value of the state variable. 

The StateVariable.setValue method—the Main script template of your state variable 
instructs you to include the following line in your script to store the compute 
value of your state variable for the current timestep: 

currentVariable.setValue(currentRuntimestep, newValue) 

Where newValue is the value, or local variable that holds the value, to be 
stored. 

12.2.3 Creating a State Variable 

To create a new state variable:  

• Open the State Variable Editor by selecting State Variables… 
from the Edit menu in the Reservoir Network or Simulation 
module. 

• Select New from the StateVariable menu (Figure 12.27) of the 
State Variable Editor.   

• The New State Variable dialog (Figure 12.28) will open.  Enter 
a Name (and an optional Description) and click OK. 

 

Figure 12.28 New State Variable Dialog 

 

Figure 12.27 
StateVariable Menu 
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• The State Variable Editor will add the new variable to the Name selector and 
make it the selected variable.  As such, the name of the new state variable will 
appear in the Name selector, the Parameter Name and Parameter Type fields will 
be blank, and the three script tabs will be filled with their relevant templates.  
Figure 12.29 illustrates the how the State Variable Editor will appear immediately 
after a new state variable is created. 

• Enter a Parameter Name for the state variable that you will be computing.  This 
name will be used for the C part of the HEC-DSS pathname that will be written to 
the simulation.dss file for this state variable. 

• Select a Parameter Type from the selection list.  The parameter type is used to 
determine the units of the state variable.  If your state variable should be 
unitless, then select Code or Count for your variable’s parameter type. 

  

Figure 12.29 New State Variable in the State Variable Editor 

12.2.4 Compiling your State Variable 

The State Variable Editor provides a syntax checker that you run your script through 
to check for errors.  To do so: 

• Click the Compile Script button below the Text Editor 

• If you get a message box that says “Compile failed”: 

o Select OK to dismiss the message box. 
o Correct the mentioned syntax error. 
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• Repeat the above steps until the process results in a message box that says 
“Script Compiled Successfully”.  Select OK to close the message box; then save 
the state variable. 

12.2.5 Saving a State Variable 

Although the State Variable Editor will prompt you to save if you try to close the 
editor after having made changes to the current state variable, it is good practice to 
save your work regularly.  And, you should always save changes before switching to 
another state variable within the editor. 

To save your current state variable: 

• Select Save from the StateVariable menu, or type Ctrl+S. 

12.2.6 Renaming a State Variable 

To rename the current state variable: 

• Select the state variable you want to rename from the Name selector in the State 
Variable Editor. 

• Select Rename from the 
StateVariable menu.   

• A Rename State Variable 
dialog will appear (Figure 
12.30).  Enter a new 
name for the state 
variable and click OK. 

• The name shown in the 
Name selector for the current state variable will change to the new name. 

12.2.7 Deleting a State Variable 

Deleting a state variable merely deletes the state variable object and its scripts.  It 
does NOT delete any existing references to the state variable in the rules, IF_Blocks, 
zones, or diversion; these references will be broken until you go find them and fix or 
removed them.  

To delete the current state variable: 

• Select the state variable you want to delete from the Name selector in the State 
Variable Editor. 

• Select Delete from the StateVariable 
menu.   

• A Confirm Delete dialog will appear 
(Figure 12.31).  Click Yes to proceed with 
the delete process or No to abort the 
delete. 

 

Figure 12.30 Rename State Variable 

 

Figure 12.31 State Variable—Confirm 
Delete Dialog 
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• The state variable will be removed from the Name selector and the first variable 
in the selection list will become the current variable in the State Variable Editor. 

12.2.8 Importing and Exporting a State Variable 

You may find it useful to save the three parts of your script to a single file so that you 
can use a more sophisticated editor for building and editing your scripts.  The Export 
function is very useful for this purpose.  It will add comment lines to the file to label 
each section script code for the tab it belongs to.  If you leave those comment lines 
intact during your external editing, you can use the Import function to bring your 
edited scripts back into the state variable’s tabs in ResSim.  This process is much 
easier and less error prone than using Ctrl+A to select all, then Ctrl+C to copy the 
contents of a tab to the Windows clipboard, then Ctrl+V to paste the clipboard 
contents into the external editor.  Then you would have to reverse those steps to 
return the edited code back into the state variable ResSim. 

To write the three scripts of your state variable to a file: 

• Select the state variable you want to export from the Name selector in the State 
Variable Editor. 

• Select Export from the State Variable menu.  

• An Export State Variable Script file browser will open.  Use the browser to select 
the folder where you want to save the file and enter a filename in the File name 
field at the bottom.  Note—although the browser has a field for Files of type: 
which defaults to Python Scripts, it does not use this setting to append an 
extension to the filename you entered; instead, it uses the file type to filter the 
list of files it shows.  For convenience when you later want to Import your script 
file, we recommend that you add the extension .py to your exported script 
filenames. 

• Click the Export button to complete the export process and close the browser. 

To read the three scripts of your state variable from a file that you had previously 
exported and place them into their respective tabs in the State Variable Editor: 

• Select the state variable you want to import from the Name selector in the State 
Variable Editor. 

• Select Import from the State Variable menu.  

• An Import State Variable Script file browser will open.  Use the browser to locate 
and select the file you want to import. Note—the browser has a field for Files of 
type: which defaults to Python Scripts. It uses the file type to filter the list of files 
it shows; Python scripts use .py as the file extension. 

• Click the Import button to complete the import process and close the browser. 

• The contents of the three tabs of your current state variable will be replaced with 
the contents of the associated section from selected file. 
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12.3 Scripted Rules 

A scripted rule is an advanced operation rule that provides you with the ability to write 
your own Release Function rule so that you can perform complex calculations or address 
a complex set of constraints to arrive at a desired release. The scripted rule must be 
written in Jython, a Java implementation of the Python programming language.  Python 
and Jython tutorials and book references can be found at www.python.org and 
www.jython.org.  

To create a scripted rule: 

• Open the Reservoir Editor and select the Operations tab. 

• Select the operation set in which you want to use the scripted rule. 

• Right-click on a zone in the Zone-Rules tree and select Add New Rule… from the 
context menu. 

• The New Operating Rule dialog will 
open (Figure 12.32). 

• Select the release element for 
which you want the scripted rule 
to influence. 

• Set the Rule Type to Script. 

• Enter a name for your new rule 
and click OK.  

• The new Scripted Rule will appear 
at the bottom of the selected zone.  The rule will be the selected node in the Zone-
Rules tree and the edit panel will display the Scripted Rule Editor (Figure 12.33).  And, 
as with state variables, the Text Editor pane of the Scripted Rule Editor will include 
the text of a template that provides the framework for your new rule script. 

Since a scripted rule is just another rule type to ResSim, all the rule management 
functions described in Chapter 11, Section 0, like renaming, deleting, and prioritizing, 
apply to scripted rules. 

12.3.1 The Scripted Rule Editor 

The Scripted Rule editor (Figure 12.33) has the same scripting interface as the State 
Variable Editor including the API tree and the Text Editor: 

Name & Description—Like any other rule, you can enter a Description for the rule in 
the Name & Description section. 

API Tree—A tree widget is used to provide access to the ResSim Application 
Programming Interface (API) available to the script. The tree is divided into 
two major branches: 

The TimeSeries Branch—Each node in this branch gives you access to the 
TimeSeries objects for the various elements in your model.   

 

 

Figure 12.32 New Operating Rule Dialog—Script 

http://www.python.org/
http://www.jython.org/
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Figure 12.33 Scripted Rule Editor—“Default” Template 

 

The APIs Branch—Each node in this branch provides you with easy access to 
the method calls for accessing and manipulating the java objects in 
your model that you are most likely to need in your scripts.  

By double-clicking on a node in the tree, the code needed to retrieve 
an element’s time series or to access a method for manipulating a 
particular object type can be placed in your script at the current 
location of your cursor in the editor.  This action can also be 
performed by selecting a node in the API tree and clicking the Insert 
in Script button.  

By hovering your cursor over a node in the tree, a tooltip will appear 
with the Javadoc entry for the method call that is represented by 
that node. The Javadocs are class-level documentation of the public 
classes and their methods that you can use in your scripts.   

Most method calls (or functions) that you may need require 
arguments (or parameters) as input.  If the method you select 
requires arguments, the text of that method call that is added to 
your script will include the arguments between the parentheses (). 

Method arguments given as literals (i.e., actual numbers, or strings 
enclosed by “ ”) are already complete and require no additional 
input.  The text inserted from items under the Time Series branch of 
the API tree typically fall into this category; for these calls, you do not 
need to modify the argument list.   

Method arguments given as java classes are placeholders for 
variables that you must supply in the script (Figure 12.34).  The 
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method call text inserted from nodes in the APIs branch usually 
requires that you replace the placeholders in the argument list with 
appropriate variables/objects that you created within your script. 

 

Figure 12.34 Scripted Rule Editor—API Tree—Java Object Classes 
and Methods 

 

The list of The ResSim classes and their methods that are included in 
the APIs branch of the API Tree is not complete nor all-inclusive.  If 
you are looking for a class or method you think you need from 
ResSim and it isn’t in the list, click on a branch or node in the APIs 
section and press F1.  The Javadoc Viewer (Figure 12.35) will open 
showing the Javadoc pertinent to the node or branch you selected. 
From there, you can search through the Javadocs to find the method 
you need. 

 

If a method call has: RunTimeStep rts as an argument, you 

should almost always use the variable: currentRuntimestep for 

that argument. You will learn more about currentRuntimestep 

in the next section. 

 

Figure 12.35 The Javadoc Viewer 
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API Preview Bar—When you select a node in the API tree, the text that would be 
generated by that node will appear in the Preview Bar. 

Text Editor—This pane of the State variable Editor uses a text editor that interprets 
the text of your script as Jython source code and colorizes it according to the 
type of statement or key word it recognizes.  This editor supports the 
standard Windows® shortcut-keys for select all (Ctrl+A), cut (Ctrl+X), copy 
(Ctrl+C), and paste (Ctrl+V), and undo (Ctrl+Z) functions.  These functions can 
also be accessed from the Edit menu or by right-clicking in the Text Editor to 
open a context menu.  The find (Ctrl+F) function is also supported but can 
only be access from the shortcut keys. 

12.3.2 Development Concepts for Scripted Rules 

Developing a scripted rule involves writing Jython code to create the data objects and 
execute the methods and other calculations that will produce a desired release limit 
to be returned by your rule.  It is important to note that a scripted rule is essentially a 
Release Function rule; thus, the rule must return a desired “release” value and an 
associated “Limit Type” for that release value.  The limit types are Maximum, 
Minimum, and Specified. 

The code development process has been simplified somewhat by two things: the 
scripted rule template and the API tree.  The API tree is described in the previous 
section and the template is described below: 

12.3.2.1 The Scripted Rule Template 

Like State Variables, each new Scripted Rule will be created with a template. Figure 
12.36 displays the Scripted Rule template. This template has some very important 
lines of code as well as several comment statements which are marked with the 
number sign (#).   

The template basically gives you instructions on three key elements that you must 
provide in your script:  

The two function statements for the initRuleScript and runRuleScript functions. 
You should use these statements as-is, do not edit them.  

The opValue object, its init (or set) method, and the constants that represent the 
available limit types. 

The return statements that will cause ResSim to correctly receive the result of 
your script’s functions and utilize that information within the release 
decision logic. 

Looking at the template in more detail, you will notice that it starts with some import 
statements.  Import statements are needed to “teach” your script what it needs to 
know about the java objects your script will be using.  The three import statements in 
the template are required for your scripted rule to function properly.  It is 
recommended that you add any additional import statements that your script may 
need below these lines. 
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Below the imports are the two function definitions mentioned above.  Each 
function’s def statement is preceded by several comment lines that describe the 
function and its arguments.  Since the two functions are called by ResSim during the 
Regulated compute, the arguments are objects that are passed into your script from 
your model. A more comprehensive description follows: 

initRuleScript—this function is where you should put the setup code for your rule.  
This function is called by the rule object only once, at the start of the 
regulated compute loop. Use the function definition statement as-is, do not 
edit it. It is the content of the function that you are expected to edit.  The 
function must return a value of Constants.TRUE (to indicate success) or 
Constants.FALSE (to indicate failure).  It is up to you to determine if your 
script requires special logic that might cause it to return FALSE. The return 
value of the initRuleScript function should be True for successful and False 

 

Figure 12.36 The Scripted Rule Template 
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for unsuccessful.  If this function returns false, the ResSim compute will be 
aborted. 

runRuleScript—this is the “main” function of the script.  This function is called by the 
rule’s evaluate method and is called at least once per timestep.  Use the 
function definition statement as-is, do not edit it. It is the content of the 
function that you are expected to edit. This is where you should put the code 
that calculates the desired release limit of your rule.  The return value of the 
runRuleScript function is an OpValue object.  In this object, you are expected 
to store the value of the desired release limit that you calculated and the 
limit type. 

The function arguments—the two default functions of your scripted rule receive 
some variables (arguments) that are provided by ResSim so that your 
function can access model data needed to compute the value of the rule’s 
desired release limit.  The three variables that may be provided are described 
below.  Both functions receive the first two variables.  Only the runRuleScript 
function receives the third variable. 

currentVariable—is a reference to the current state variable object itself.  
currentVariable is conceptually equivalent to the this keyword in Java 
or the self keyword in Python.  

network—is a reference to the object that holds the reservoir network.  It 
can be used to access to all the elements of your network and their 
model variables such as pool elevations, inflow, diversions, etc.  It 
can also be used to access the current alternative and its properties. 

currentRuntimestep—is a reference to the object that holds the timestep 
being evaluated.  The actual date & time of the timestep, as well as 
the sequence number of the timestep and the run time window are 
accessed through this object.  This object is used, among other 
things, to determine where (or is that when) to store the computed 
value of the state variable. 

The opValue object—this object is used to carry each rule’s desired release limit 
value and the limit type back to ResSim (through the return statement) for 
use in determining the allowable release range (see the introduction to 
Chapter 11 for details on the release range).  As described in the template, 
the limit types are: 

• OpRule.RULETYPE_MAX—maximum flow 

• OpRule.RULETYPE_MIN—minimum flow 

• OpRule.RULETYPE_SPEC—specified flow  

The template also shows how to create an OpValue object and how to 
initialize it: 

# create new Operation Value (OpValue) to return 
opValue = OpValue() 
# set type and value for OpValue 
opValue.init(OpRule.RULETYPE_MAX, 1000) 
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Remember, for these lines to work, the imports at the top of the template 
must be included in your script. 

12.3.2.2 Compiling your Scripted Rule 

The Scripted Rule editor provides a syntax checker that you can run your script 
through to check for errors.  To do so: 

• Click the Compile Script button below the Text Editor 

• If you get a message box that says “Compile failed”: 

o Select OK to dismiss the message box. 
o Correct the mentioned syntax error. 

• Repeat the above steps until the process results in a message box that says 
“Script Compiled Successfully”.  Select OK to close the message box then 
save the state variable. 

 

Compiling the Script simply checks for basic syntax errors.  It does not guarantee 

that the programming logic of the script is error free. 
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12.4 Water Account Sets 

Reservoirs used for water supply may reserve a particular volume of their conservation 
pools for the use of a water storage account holder.  The water storage account holders 
may draw water from their accounts to use for water supply, and their currently available 
volume of water is determined by tracking credits and debits from their storage account.   

ResSim has a water accounting feature that tracks reservoir storage accounts.  Water 
Account Sets are used to define storage accounts within your reservoirs.  In order to use 
the ResSim water accounting feature, you will need to set up a water account set with 
water account(s) and create reservoir release rules for the water account holder(s).  The 
lower limit of the conservation pool must also be defined.  This setup allows ResSim to 
track the volume in the water account(s).  The ResSim Yield alternative type can also use 
the water accounting feature to calculate water account yield or to size a water account 
to meet a particular yield.  See Appendix F for details on the ResSim Yield feature.   

To create a Water Account Set for your network: 

• Select Water Account Sets… from the Network Module’s Edit menu.  The Water 
Account Set Editor will open (Figure 12.37). 

• Create a new Water Account Set by selecting New from the Set menu.  You will be 
prompted to give your new water account set a name and description. 

• Next, from the Reservoir tab, select the reservoir(s) that have water accounts by 
checking their box(es) in the Active column of the table.  Then select the appropriate 
Operation Set and the lower limit of the Conservation Storage pool.  The designated 
Guide Curve for the operation set is considered the upper limit of the Conservation 
Storage pool.  Click Apply. 

• Next create your Water Accounts.  Select the Water Accounts tab (Figure 12.38). 

• From the Accounts menu, select New.  You will be prompted to give your water 
account a name and description.  You may create multiple water accounts.  For each 
account, do the following: 

 

 

Figure 12.37 Water Account Set Editor—Reservoirs tab 
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o Select an account in the lefthand pane of the editor to activate its information.  
ResSim will display a list of all minimum or specified flow and hydropower rules 
used in the Water Account Set’s active reservoir(s).   Choose the rule that 
represents the release allocated to the water account holder and click Select.   

o The conservation pool storage allocated to that water account holder is either 
specified as a percent of the conservation pool volume, or as a total volume.  
Select the appropriate radio button and enter either the percent or the 
maximum volume.  Click OK.   

 

 

  

 

Figure 12.38 Water Account Set Editor—Water Accounts tab 

 

Note: Water accounting output available in the simulation.dss file includes: 

• Max storage of water account 

• Computed storage of water account 

• Water account inflow 

• Water account demand withdrawal 
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12.5 Capacity Outage Schedules 

The Capacity Outage Schedule is the first of four features that can be added to an 
operation set by activating it from the Operations menu of the Reservoir Editor. By 
default, this feature is OFF because it is assumed that all outlets are available for use all 
the time; but for many reservoirs, especially hydropower reservoirs, that assumption is 
false.  Periodic gate and turbine maintenance occurs at most projects and the Outage 
Schedule feature allows you to specify when an outlet is expected to be unavailable and 
assess the potential impacts of that downtime on the overall operation of the reservoir.  

A scheduled outage is typically used to represent scheduled maintenance of the 
reservoir’s outlets.  If an outlet is not available due to an unforeseen circumstance, then 
you might consider using the Outlet Capacity Overrides in the Simulation module (Section 
15.7). 

To activate the Outage Schedule feature: 

• Open the Reservoir Editor and select the 
reservoir that needs an outage schedule. 

• Select the Operations tab. 

• From the Operations menu, select Use 
Outage Schedule. 

The Outages sub-tab will become active 
(Figure 12.40) and a check mark will appear 
in front of the Use Outage Schedule option in 
the Operations menu to indicate that the 
Outage Schedule is ON (Figure 12.39). 

The Outages sub-tab contains the Outage 
Schedule edit panel, which allows you to specify which outlets are scheduled to be out, 
when each outage will occur, and what fraction of the outlet’s capacity will be available 
during the outage and whether or not this is a regularly Repeating outage (Figure 12.40). 

 

Figure 12.40 Capacity Outage Schedule—Edit Panel 

 

Figure 12.39 Reservoir Editor—Operations 
Menu—Use Outage Schedule 
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To add an outage to the list of Scheduled Capacity Outages: 

• Click the Add button located to the right of the Scheduled Capacity Outages table.  
The Outlet Capacity Schedule Entry dialog (a.k.a, 
Outage Editor, Figure 12.41) will open.  To define the 
outage, make a selection for each of the following 
outage attributes: 

Outlet—select the outlet that is scheduled for 
maintenance. 

Starting Date & Time—enter the date and time when 
the outage will begin.  The  button in the 
date field can be used to open a calendar 
widget to help you specify the date. 

Ending Date & Time—enter the date and time when 
the outage will end. 

Capacity Factor—enter a value that represents the fractional portion of the outlet’s 
capacity that will available for release during the outage.  For example, if a 
spillway outlet has 4 equal gates and only one of them will be unavailable, 
then ¾ of the spillway capacity, or 75%, will be available and you would enter 
0.75 as the capacity factor.  

 Repeat—The label on the Repeat button shows the basic recurrence interval for the 
outage. Click the button to open the Repeat dialog (Figure 12.42) where you 
will specify the recurrence interval for the repeating outage. 

A repeating outage uses the Start and 
End times to determine the duration 
of the outage and the first occurrence 
of the outage will begin on the Start 
Date and Time. Each subsequent 
occurrence will begin one recurrence 
interval after the start of the previous 
occurrence. 

Select one of the radio buttons to 
indicate how often the outage should 
occur. Options include: 

None—the outage will occur only 
once, beginning on the date 
and time specified. 

Daily—specify the recurrence interval, 
in number of days (Figure 
12.43).  

Every:—each of the repeat 
options (except None) 
allow you to specify 
how many of the 

 

Figure 12.41 Outlet Capacity 
Schedule Entry Dialog 

 

Figure 12.42 Outage Repeat Dialog 

 

Figure 12.43 Outage Repeat Dialog 
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option’s time units actually represent the recurrence 
interval. The default is 1. 

End On:—this is a specific date when the repeating outage stops 
completely. If blank, the outage repeats throughout the 
whole simulation. 

Weekly—specify the recurrence interval, in number of weeks. 

Monthly—specify the recurrence interval, in number of months. 

Yearly—specify the recurrence interval, in number of years. 

Note:—enter a description of the outage.  This note can only be seen in the Outage 
Editor. It will not appear in the Scheduled Capacity Outage table. 

Once an outage has been specified, it will become an entry in the Scheduled Capacity 
Outage table (Figure 12.44).  If you select a row in this table, the Duplicate, Delete, and 
Edit buttons become available. Use these buttons to manage your scheduled outages.  

 

Figure 12.44 Scheduled Capacity Outage Example 
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12.6 Storage Credit 

As discussed in Section 10.4, the Reservoir Editor allows you to pick the top of zone curve 
for any zone in your operation set to act as the guide curve.  The storage above the guide 
curve is considered flood storage and the storage below is considered conservation 
storage.   

The Storage Credit feature allows you to vary the allocated flood storage (and thus the 
guide curve) of the current reservoir based on the available storage space in one or more 
other reservoirs in the watershed. The idea is that if incidental storage is available in the 
crediting reservoirs, then the required flood control space in the current reservoir can be 
reduced by some fraction of the available credit space.  Reducing the required flood 
control space has the net effect of raising the guide curve and thus increasing the 
reservoir’s potential conservation storage.  Note—the crediting reservoirs need not have 
dedicated flood storage space; their credit storage could be a result of conservation 
releases. 

This feature requires that you identify: 

o the reservoirs that could provide flood storage credit to the current reservoir, 
o the total reservoir storage at “full pool” for each reservoir, 
o the maximum amount of credit each reservoir could provide, and 
o whether negative credit can be computed for that reservoir.  A net negative 

credit could increase the required flood storage at the current reservoir and thus 
lower the guide curve.  

To activate the Storage Credit option for a reservoir:  

• Open the Reservoir Editor. 

• Select the reservoir to receive the credit. 

• Select the Operations tab. 

• From the Operations menu, select Use Storage Credit. 
The Stor. Credit sub-tab will become active and a 
check mark will appear in the Operations menu in 
front of the Use Storage Credit option to indicate that 
storage credit will be computed and used (Figure 
12.45).  

The Stor. Credit sub-tab contains the Storage Credit edit 
panel (Figure 12.46).  Use this tab/editor to identify the crediting reservoirs and specify 
their storage credit parameters.  The components of the Storage Credit edit panel are:  

Crediting Reservoir List—The table in the upper left of the editor is the list of reservoirs 
that can provide storage credit to the current reservoir.  

Edit Reservoir Set button—This button is located in the upper right corner of the editor.  
This button will open a Reservoirs Selector dialog; use it to select the crediting 
reservoirs.   

Storage Credit Relationship—The table in the lower left of the editor is the relationship 
between the available storage credit and the credit that can actually be applied 
to the required flood storage at the current reservoir.   

 

Figure 12.45 Reservoir Editor—
Operations Menu 
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Seasonal Variation Edit button—This button is located in the bottom right corner of the 
editor.  It will open the Seasonal Variation editor which you can use to define a 
set of seasons across which the Storage Credit relationship varies.   

 

Figure 12.46 Storage Credit Edit Panel 

Thumbnail Plots—Both of the two thumbnail plots located on the right side of the edit 
panel are associated with the Storage Credit Relationship.  

The upper plot displays the relationship(s) as defined in the table. If the Storage 
Credit Relationship varies seasonally, this plot will show a curve for each season’s 
(column’s) relationship. 

The lower plot displays the guide curve of the current reservoir in terms of 
storage. For each row in the lower table, a curve is added to the plot to show 
how the potential flood storage credit would impact the required flood pool 
storage and, thus, the guide curve.   

As with all thumbnail plots, if you double-click on one, a full-size plot will open. 

To identify the reservoirs that can provide storage credit to the current reservoir: 

• Select the Edit Reservoir Set 
button.  The Reservoirs 
Selector dialog will open 
(Figure 12.47).  

• In the Available list, double-
click on each reservoir that can 
provide storage credit to the 
current reservoir; this will 
move the reservoirs from the 
Available list to the Selected 
list.  For a detailed description 
of the Selector dialog, refer to 
Appendix C.  

Figure 12.47 Storage Credit—Reservoirs Selector Dialog 
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• Click OK to accept your selections and close the Reservoir selector dialog. 

• The reservoir(s) you selected will appear in the Crediting Reservoirs List of the 
Storage Credit edit panel.  For each reservoir in the list, specify: 

Maximum Credit Pool Storage—this is the total storage of the reservoir below which 
available storage can be counted as storage credit.  If the crediting reservoir 
has an allocated flood storage pool and this space can be used as credit 
storage, then the Maximum Credit Pool Storage would be at the top of the 
flood pool; if credit storage can only come from available space in the 
conservation pool, then the Maximum Credit Pool Storage would be at the 
top of the conservation pool.  If the crediting reservoir does not have a flood 
pool, then the Maximum Credit Pool Storage would probably be at “full” or 
“maximum” pool.   

 Maximum Credit—this is the amount of available storage at the crediting reservoir 
that can be used as credit to the current reservoir. 

Allow Neg Credit—specify whether the reservoir can provide “negative” credit when 
the current pool is above the Maximum Credit Pool storage.  Negative credit 
from a credit reservoir would have the effect of lowering the guide curve at 
the reservoir where you are adjusting the guide curve.  This could occur if the 
current storage in the crediting reservoir’s pool is greater than its maximum 
credit pool storage. 

• Next, in the Storage Credit Relationship table, specify how much flood Storage Credit 
can be applied to the required flood storage at the current reservoir as a function of 
the total available credit storage in the crediting reservoirs.  This can be defined by a 
single curve or by a seasonally-varying family of curves.  See Appendix C for a detailed 
description of the Seasonal Variation Editor that you can use to define the seasons. 

Figure 12.48 shows an example of a completed Storage Credit specification.  In this 
example, two crediting reservoirs have been identified and the Storage Credit 
relationship has been specified as a seasonally varying relationship where at its 
maximum, the relationship is not quite 1:1 and at its lowest (in the summer months), 
the relationship indicates that no credit is allowed. 

 

Figure 12.48 Storage Credit Edit Panel—Credit Definition for Selected Reservoir(s) 
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12.7 Reservoir Decision Schedule 

By default, each reservoir in your network makes a release decision for every 
computation interval (timestep).  By activating the Decision Schedule feature, you can 
specify a different decision interval or a decision schedule for each reservoir.  By 
changing a reservoir’s decision interval, you are telling the reservoir to evaluate 
conditions over a different or varying time horizon to determine its releases; within the 
release capacity of the reservoir, each release decision will be held constant until the 
next decision.  Your selection of the decision interval should be appropriate for the 
compute interval of the simulation. 

To activate the Decision Interval feature for a reservoir:  

• Open the Reservoir Editor. 

• Select the reservoir to receive the credit. 

• Select the Operations tab. 

• From the Operations menu, select Use Decision 
Interval. The Dec. Sched sub-tab will become active 
and a check mark will appear in the Operations menu 
in front of the Use Decision Interval option to indicate 
that the Decision Schedule feature is ON (Figure 
12.49).  

The Dec. Sched. sub-tab contains the Decision Schedule 
edit panel.  Use this editor to specify the decision interval 
or schedule.   

To specify the reservoir decision interval or schedule: 

• Select an Interval Option from the 
list.  Your three options are: 

Every Time Step—this is the 
default and what ResSim 
does when the Decision 
Schedule feature is OFF. 

Regular Interval—use this option 
if you want the reservoir 
to make its release 
decisions on a larger interval than the current timestep. The lower panel of 
the editor will fill with four options for defining the new decision interval 
(Figure 12.51). 

Interval—this is the amount of time between release decisions.  You can 
choose from the following intervals: 1 hr, 2 hr, 3 hr, 4 hr, 6 hr, 8 hr, 
12 hr, Daily, Weekly, and Monthly.  But, be careful—you should only 
select a decision interval that is a multiple of the current timestep.  
For example, if the timestep is 6 hours, then valid decision intervals 
include 12 hr, Daily, Weekly, and Monthly. 

 

Figure 12.49 Reservoir Editor—
Operations Menu—Use Decision 

Interval 

 

Figure 12.50 Decision Schedule Editor—Decision 
Interval Options 
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Start Hour—this is the time of the first decision. You can select from 0000 to 
2300.   

Day of Week—if you chose Weekly Interval, this is the day of the week when 
each decision will be made.  

Day of Month—if you chose Monthly Interval, this is the day of the month 
when each decision will be made. 

Weekly Schedule—use this option if you want to specify an irregular schedule for 
making release decision.  The lower panel of the editor will fill with a 7-
column table, one column for each day of the week.   

In the cells of the table, enter the time(s) of day when the reservoir should 
make a release decision. The time entries must be entered as values from a 
24-hour clock—that means values between 0000 and 2359.  And, you should 
only enter times that coincide with compute intervals. 

NOTE: When entering times into the Weekly Schedule, a whole row must be 
complete. That means that if one day a week you want 2 decisions made, 
then every day, two decisions must be made; however, the times of each 
decision on each day need not be the same. Figure 12.52 illustrates an 
example of an irregular Weekly Schedule with two decisions schedule each 
day. 

 

Figure 12.52 Decision Schedule Edit Panel—Weekly Schedule Option 

 

Figure 12.51 Decision Schedule Edit Panel—Regular Interval Option 
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• When you are finished specifying the Decision Schedule, click Apply to accept the 
Decision Schedule and keep the Reservoir Editor open.  Or, click OK to accept the 
revisions and close the Reservoir Editor. 

12.8 Projected Elevation 

Projected Elevation is the last of the advanced operations features that can be added to 
an operation set by activating it from the Operations menu of the Reservoir Editor.  

This feature acts on the current reservoir and has two parts: 1) it turns on the 
computation of a projected pool elevation at the end of a specified projection window, 
and 2) it gives the option to use that projected elevation (instead of the current pool 
elevation) to determine the active zone whose rules will be used to influence the 
reservoir operation (release). 

When this option is activated in the Operations menu and a Projection Time Window has 
been specified, ResSim will compute a projected reservoir elevation at each timestep of 
the compute window.  You can then use the projected elevation like any other model 
variable—it can be referenced in a rule, zone definition, IF_Block, diversion, state 
variable, or scripted rule to influence the operation of the reservoir.  

The primary purpose of the Projected Elevation feature is to use the projected elevation 
to determine the active operation zone.  This feature was designed as a flood operation 
to allow less restrictive rules from a higher zone to be used before the pool actually 
reaches that higher zone.  The objective is to prevent or delay the pool from reaching the 
higher zone.   

To activate the Projected Elevation feature: 

• Open the Operations tab of the Reservoir 
Editor and select a reservoir. 

• From the Operations menu, select Compute 
Projected Elevation. 

A check mark will appear in front of the 
Compute Projected Elevation option in the 
Operations menu to indicate that the 
Projected Elevation feature is ON (Figure 
12.53), and the Projected Elev tab will become 
active (Figure 12.54). 

 

 

Figure 12.53 Operations Menu—Compute 
Projected Elevation 
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Figure 12.54 Reservoir Editor—Projected Elevation Sub-tab 

The Projected Elev sub-tab has only two fields for you to set: 

Projection Time Window—the number of hours into the future that you want ResSim 
to estimate the reservoir pool elevation.  To perform this computation, 
ResSim will assume that the release it was making at the end of the previous 
timestep will be held constant through the Projection Time Window.  Note: If 
you leave 0 in this field, ResSim will simply compute an estimate of the pool 
elevation at the end of the current timestep assuming that no change was 
made to the release in this timestep. 

Use Projected Reservoir to determine Operation Zone—To use the projected 
elevation to determine the active zone, place a checkmark in the checkbox.  
To use the projected elevation in an IF_Block, rule, or script, you do not need 
to check this box. 
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12.9 The Reservoir Network Importers 

ResSim has two import tools for bringing network data from another model into your 
current watershed.  The first is the Import Network Wizard.  This tool allows you to copy 
a network from one watershed into the current watershed.  It will step you through the 
process of identifying the network you want to copy and resolving the associations 
between each network element and the reciprocal for the current stream alignment or 
watershed configuration. 

The second import tool is the Import Element Properties Wizard.  This tool is very similar 
to the Import Network Wizard, but it does not create a new network in your watershed; 
instead, it copies data from elements in one network into the elements in your current 
network.  The Import Element Properties Wizard will step you through the process of 
selecting the network from which you are going copy the element data and resolving the 
connectivity to the other elements and their model variables. 

 

PLEASE NOTE:  Before you can use the Importers… 

Both Import Wizards require that you have one or more Watershed Locations 

defined for your ResSim installation.  A Watershed Location is now named Shortcut 

and it points to a folder on your computer where you have one or more 

watershed(s) stored.  The Importers can only find watersheds that are located in 

one of these Watershed Locations.   

The first section of Appendix A describes how to create and manage Shortcuts. 

 

12.9.1 The Import Network Wizard 

The purpose of the Import Network Wizard (or Network Importer) is to copy a 
network from one watershed into another.  This is usually needed when an existing 
watershed is copied and used for a different purpose or study than that of the 
original model.  During its use in the newer study, the model may have evolved and 
been enhanced in ways that could be useful in the context, or for the purpose, of the 
original watershed. 

However, since the new (copied) watershed “evolved”, there may be differences in 
the underlying framework (the stream alignment and/or configuration) of the 
network to be imported that must be addressed in order for that network to function 
as a native part of the watershed it is being imported into. 

In addition, there’s nothing to prevent you from importing a network from a 
watershed that did not share its development path with the watershed it is being 
imported into.  The source watershed could be older or lacking in some way (or even 
broken) and by importing its network into a newer or more complete watershed, the 
older network can be updated and used as part of the new watershed. 
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The steps for importing a Reservoir 
Network into your current watershed 
are as follows: 

• From the Reservoir Network 
module, select Import Network… 
from the Network menu (Figure 
12.55). 

• The Import Network Wizard will 
open (Figure 12.56).  In Step 1 of 6, 
select the watershed to copy from.   
The Watershed Locations area 
shows the list of your Shortcuts to 
directories on your computer.  
Highlighting each will show a list of 
watersheds in the right-hand side.  Select the desired watershed to copy from 
and click Next. 

 

Figure 12.56 Import Network Wizard—Step 1—Select the Watershed 

• In the Import Network Wizard—Step 2 of 6, a list of available networks in your 
chosen watershed will be shown (Figure 12.57).  Select the network you wish to 
copy into your current watershed and click Next. 

 

Figure 12.57 Import Network Wizard—Step 2—Select the Network to Import 
Elements from 

• Set the new network name and description in the Import Network Wizard—Step 
3 of 6 (Figure 12.58).  All networks in your current watershed are listed under 

 

Figure 12.55 Network Menu—Import Network… 
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Existing Reservoir Networks.  At the bottom, under New Reservoir Network, 
create a new name and description for the imported network.   

 

Figure 12.58 Import Network Wizard—Step 3—Set New Network Name and Description 

• Click Next to open the Import Network Wizard—Step 4 of 6 (Figure 12.59). The 
Assign Stream Names dialog shows a table listing each Imported Element, 
Element Type, and its location (From Stream) in the originating (“import from”) 
watershed.  The final column “To Stream” gives the location to which the 
element will be imported in the current watershed.  ResSim will automatically 

 

Figure 12.59 Import Network Wizard—Step 4—Assign Stream Names 
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populate the “To Stream” fields, if it can match a stream name in the “import 
from” watershed to a stream name in the current “import to” watershed.  
Update the field using the dropdown menu to select from the list of streams in 
the current watershed.   

• You can also use the Assign Stream Names button to associate streams in the 
“copy from” watershed with streams in the “copy to” watershed.  Clicking this 
button will open the Select Stream Name editor (Figure 12.60).  Once you have 
associated the streams, click OK, and this will update all the imported element 
“To Stream” fields accordingly. 

 

Figure 12.60 Import Network Wizard—Select Stream Name 

• Click Next to go to the Import Network Wizard—Step 5 of 6 (Figure 12.61), where 
you will Resolve the Network Computation Points.  The table lists every Imported 
Element name and type and indicates the associated current Watershed 
Computation Point.  Verify that these are correct, or if they are blank, select 
them with the dropdown menu.  Sometimes an imported element can’t be 
matched to a similar location in the current watershed.  When this happens, 
consider how the two watersheds differ and whether you need to make a change 
before importing.  If the computation point can’t be resolved, the associated 
element will not be imported.  Click Next, and if there were issues, you will see a 
warning with a list of any import elements that were not assigned computation 
points and will therefore not be imported into your current watershed.  You can 
choose the Back button if necessary. 

• The Import Network Wizard—Step 6 of 6 shows a summary of all the import 
information (Figure 12.62).  Obvious issues will be in red font. Once you are 
satisfied with the summary, click Finish to complete the import, or select Back to 
make changes in previous steps.  If you are sure about the import, confirm by 
selecting Yes in the Continue with Import dialog.  Choosing No will return you to 
the Wizard’s Step 6 of 6. 
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Figure 12.61 Import Network Wizard—Step 5—Resolve Network Computation Points 

 

 

Figure 12.62 Import Network Wizard—Step 6—Import Summary 
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12.9.2 The Import Element Properties Wizard 

After network elements have been drawn and labeled, physical and operational data 
can be imported from another network using the Import Element Properties Wizard.  
Data that can be imported include: 

• reservoir storage and outlet capacity 

• reservoir operation sets and rules 

• reach routing method and parameters 

• junction data, and  

• diversion data. 

To use the import wizard, open the Network that data will be imported into.  Then, 
perform the following six steps: 

• From the Edit menu in the Reservoir Network module, select Import Element 
Properties….  The Import Element Properties Wizard—Step 1 of 6 will appear 
(Figure 12.63). 

 

Figure 12.63 Import Element Properties Wizard—Step 1—Select Network Elements 

 

• Select the network elements that you would like to import physical and 
operational data into from an existing network by checking the Import boxes to 
the left of the Network Element names or by clicking Select All Elements located 
in the upper right region of the editor.   

• Select Next to continue and the Import Element Properties Wizard—Step 2 of 6 
will appear (Figure 12.64).  Select the watershed that contains the network from 
which you would like to import physical and operational data.  The box on the left 
side of the dialog contains names of Watershed Locations that have been 
specified as Model Directories.  The box on the right side of the dialog contains 
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all the watersheds that can be found in each Watershed Location.  When the 
desired watershed is highlighted, click Next. 

 

Figure 12.64 Import Element Properties Wizard—Step 2—Select Watershed to Import 
Data from 

 

• Select Next to continue and the Import Element Properties Wizard—Step 3 of 6 
will appear (Figure 12.65).  Select the specific network from which you would like 
to import physical and operational data. 

 

Figure 12.65 Import Element Properties Wizard—Step 3—Select Network to 
Import Elements from 

• Select Next to continue and the Import Network Elements Wizard—Step 4 of 6 
will appear (Figure 12.66).  Assign the element properties to be imported by 
matching the appropriate elements in the Import From column with their 
corresponding elements in the Import Into column. 
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Figure 12.66 Import Element Properties Wizard—Step 4—Assign Network Elements 

 

• Select Next to continue and the Import Element Properties Wizard—Step 5 of 6 
will appear (Figure 12.67).  Resolve network connectivity by choosing the 
element in the Select Network Element column that you would like the 
corresponding rule to be applied to.  In most cases, what is chosen in the Select 
Network Element column will match the network element in the References 
Element column. 

 

Figure 12.67 Import Element Properties Wizard—Step 5—Resolve Network 
Connectivity 

• Select Next to continue to the Import Element Properties Wizard—Step 6 of 6 
(Figure 12.68).  Resolve network connectivity by choosing the element in the 
Select Network Element column that you would like the corresponding rule to be 
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applied to.  In most cases, what is chosen in the Select Network Element column 
will match the network element in the References Element column. 

 

 

Figure 12.68 Import Element Properties Wizard—Step 6—
Import Summary 

 

• Select Finish to carry out the import, 
or select Back to make changes in 
the previous steps.  If you are sure 
about the import, confirm by 
selecting Yes in the Continue with 
Import dialog (Figure 12.69).  
Choosing No will return you to the 
Wizard’s Step 6 of 6. 

• After finishing with the Element Properties Import process, a dialog will appear 
summarizing the results of the import carried out.  Check to ensure that all 
physical and operational data was successfully imported by reviewing the Import 
Results summary (Figure 12.70) and by viewing the various network element 
editors in the Reservoir Network module. 

 

Figure 12.69 Continue with Import 
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Figure 12.70 Import Results 

• Select Close to complete the process of Importing Element Properties from one 
Watershed/Network into another. 
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Chapter 13 

Reservoir Systems 

A Reservoir System in ResSim is defined as two or more reservoirs that operate together 
for common goals.  Reservoir systems are created by defining system operation rules for 
two or more reservoirs.  ResSim provides for tandem operation to manage the storage 
distribution between upstream and downstream reservoirs on the same stream.  Tandem 
operations are created by applying a tandem rule at an upstream reservoir operating for 
a downstream reservoir (i.e., two reservoirs in series).  In addition, ResSim supports 
parallel operation of reservoirs, where two or more reservoirs on different streams 
control for common downstream requirements, through the use of common 
downstream control (for flow or stage limit) rules.  For each individual reservoir, system 
operation rules are prioritized among other rules in the operation set.  (Refer to Section 
11.1.3 for a more detailed description of rule prioritization.)  This chapter will present the 
concept of system operation, specifically implicit and explicit methods for determining 
the system balance, and provide guidance for using the Reservoir System Editor to set up 
explicit system storage balances. 

13.1 Concept of Reservoir Systems 

When a tandem or parallel reservoir system is defined, the model determines the priority 
and the amount of release to make from each reservoir in order to operate towards a 
storage balance among the system reservoirs.  For every decision interval, an end-of-
period storage is first estimated for each reservoir based on the sum of beginning-of-
period storage and period average inflow volume, minus all potential outflow volumes.  
The estimated end-of-period storage for each reservoir is compared to a desired storage 
that is determined by using a system storage balance scheme.  The priority for release is 
then given to the reservoir that is furthest above the desired storage.  When a final 
release decision is made, the end-of-period storages are recomputed.  Depending on 
other constraints or higher priority rules (Chapter 12), system operation strives for a 
storage balance such that the reservoirs have either reached their Guide Curves or they 
are operating at the desired storage (percent of the active storage zone). 

The storage balance across reservoir systems is based on the definition of System Storage 
Zones.  These zones divide each system reservoir into comparable zones, across which to 
balance.  There are two methods by which the desired storage balance is determined:  
implicit (default) and explicit (user-defined).  The implicit method delineates the default 
storage balance scheme for the reservoir system.  The explicit method is optional and 
allows a user defined storage balance scheme for the reservoir system.  Detailed 
descriptions and examples are presented in Sections 13.1.1 and 13.1.2 and 
demonstrating the functionality of implicit and explicit storage balance methods. 
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13.1.1 Implicit System Storage Balance Method 

The default method in ResSim for determining the desired storage balance in a 
reservoir system is referred to as the implicit method.  This method applies to both 
tandem and parallel system operations.  The implicit method is automatically used 
when a reservoir system is established − either by using a common Downstream 
Control rule in two or more parallel reservoirs, or adding a Tandem Operation rule to 
an upstream reservoir operating for a downstream reservoir. 

For example, consider a two-reservoir 
tandem system, as shown in Figure 13.1.  
Reservoir 1 is the upstream reservoir 
where a Tandem Operation rule has been 
applied in its operation set, as shown in 
Figure 13.2. (See Section 11.9 for details 
about adding the Tandem Operation 
rule.)  This establishes an implicit system 
operation with the downstream 
reservoir, Reservoir 2.  Assume that each 
reservoir has the same amount of storage 
capacity (100,000 ac-ft).  For each of the 
reservoirs, the Guide Curve has been set 
to be the top of Conservation zone. (See 
Section 10.4 for instructions on setting 
the Guide Curve.)  The conservation 
storage in Reservoir 1 is 75,000 ac-ft, 
whereas the conservation storage in 
Reservoir 2 is 30,000 ac-ft. 

 

 

Figure 13.1 Example of a Two-Reservoir 
Tandem System 
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  Figure 13.2 Tandem Operation Rule Included in Upstream Reservoir 

The implicit system storage 
balance scheme (illustrated in 
Figure 13.3) takes into account 
the System Storage (the total 
storage from the reservoirs in the 
system).  In this example, the 
system storage ranges from 
empty (0 ac-ft) to full (200,000 
ac-ft).  Additionally, this default 
scheme considers only one 
System Storage Zone, the System 
Guide Curve (Sys G.C.) storage, 
which amounts to the sum of 
both reservoirs’ conservation 
storages (105,000 ac-ft). 

The desired storage for each 
reservoir is determined through 
an implicit “balance line”.  The balance line is simply a linear relationship between 
storage at each reservoir and the system storage.  For each reservoir, the balance 
line hinges on the intersection of the reservoir’s Guide Curve (G.C.) storage and the 
System Guide Curve (Sys G.C.) storage.  For system storage less than the System 
Guide Curve storage, the balance line has a lower limit that corresponds to empty 
storage at the reservoir versus empty system storage, and the upper limit 
corresponds to Guide Curve storage at the reservoir (75,000 ac-ft at Res. 1 and 

 

Figure 13.3 Implicit System Storage Balance 
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30,000 ac-ft at Res. 2) versus System Guide Curve storage (105,000 ac-ft).  For system 
storage greater than the System Guide Curve storage, the lower limit of the balance 
line corresponds to Guide Curve storage at the reservoir (75,000 ac-ft at Res. 1 and 
30,000 ac-ft at Res. 2) versus System Guide Curve storage (105,000 ac-ft), and the 
upper limit corresponds to full storage at the reservoir versus full system storage. 

At the end of each decision interval (i.e., end-of-period), the desired storage for a 
reservoir corresponds to a point on the balance line that coincides with the sum of 
the estimated storages for both reservoirs.  When the total estimated storage from 
both reservoirs is less than the System Guide Curve storage, the corresponding 
desired storages represent an equal percentage of the storage below the Guide 
Curve at each reservoir.  When the total estimated storage from both reservoirs is 
greater than the System Guide Curve storage, the corresponding desired storages 
represent an equal percentage of the storage above the Guide Curve at each 
reservoir. 

For instance, as shown in Figure 13.4, assume that preliminary end-of-period storage 
estimates are 25,000 ac-ft for Reservoir 1 and 45,000 ac-ft for Reservoir 2.  The 
resultant total system storage of 70,000 ac-ft coincides with each reservoir’s desired 
storage (50,000 ac-ft for Reservoir 1 and 20,000 ac-ft for Reservoir 2) found along the 
balance line from empty system storage to System Guide Curve storage.  These 
desired storage values signify a desired balance because they amount to an equal 
percent (66.7%, in this case) of the Guide Curve storage at each reservoir:  50,000 of 
75,000 ac-ft at Reservoir 1, and 20,000 of 30,000 ac-ft at Reservoir 2. 

With 25,000 ac-ft estimated as its end-of-period storage, Reservoir 1 would be below 
its desired storage of 50,000 ac-ft.  On the other hand, at an estimated storage of 
45,000 ac-ft, Reservoir 2 would be above its desired storage of 20,000 ac-ft. 
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Figure 13.4 Example of Desired Storages using the Implicit System Storage 
Balance Method 

Since Reservoir 2 is above its desired storage, it receives the priority to release for 
this period in order to drop its storage down, as close as possible, to the desired 
storage.  Unless other constraints (such as maximum physical outlet capacity, 
maximum flow limit rules, or flow rate of change limit rules) restrict releases and 
have higher priority than the system operation rule, Reservoir 2 would increase its 
releases in order to drop its pool to the desired storage of 20,000 ac-ft.  As for 
Reservoir 1, it is forced to cut back its releases so that its storage can rise, as close as 
possible, to its desired storage of 50,000 ac-ft.  If there are no restrictions (such as 
minimum flow limit rules or flow rate of change limit rules) that could require a 
different release due to having a higher priority than the system operation rule, 
Reservoir 1 would stop releasing from its outlet(s). 

In the implicit system operation, a release decision made for a particular time period 
may not necessarily achieve the desired balance.  The reservoirs in the system are 
considered “in balance” when both reservoirs have reached their Guide Curves, or 
they are operating at equivalent storage levels in terms of percentage of their 
counterpart system storage zones. 

13.1.2 Explicit System Storage Balance Method 

The user-defined method in ResSim for determining the desired storage balance in a 
reservoir system is referred to as the explicit method.  This method can be used for 
an established reservoir system, whether tandem or parallel.  For example, consider 
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two parallel reservoirs (Reservoir 1 and Reservoir 2) operating for a common 
downstream location (MyTown), as shown in Figure 13.5.  In this case, both 
reservoirs are operating for a common downstream location, and each has the same 
downstream control rule applied in its operation set (establishing an implicit system 
operation).   

As described in Section 12.1.1, 
the implicit scheme by default 
develops balance lines, using a 
single system storage zone 
(System Guide Curve), to define 
linear relationships between 
storage at each reservoir and the 
total system storage.  The user 
can further modify these balance 
lines explicitly to characterize the 
desired storage distributions 
using one or more system zones 
and placing inflection points 
along the balance line. 

For this example, both reservoirs 
have the same storage 
characteristics, maximum storage 
capacities and conservation 
storage as described in the 
tandem example in Section 13.1.1.  Additionally, for Reservoir 1, the top of the Flood 
Control zone is at a storage of 85,000 ac-ft.  For Reservoir 2, the top of Flood Control 
is at a storage of 65,000 ac-ft. 

Figure 13.6 shows an explicit scheme defined such that Reservoir 1 fills its 
conservation zone more rapidly than Reservoir 2, and Reservoir 2 fills its flood control 
zone at an initially faster rate than Reservoir 1.  This is accomplished by first 
identifying two system zones.  For instance, System Conservation would represent 
one system zone that is the aggregate of the conservation storages from the two 
reservoirs.  The other system zone would be the System Flood Control zone, the total 
of both reservoirs’ flood control storages.  As shown in Figure 13.6 and summarized 
in Table 13.1, a customized desired storage balance can be made by introducing 
inflection points to the balance lines within each system zone.  Inflection points 
would transform the implicit balance line into an explicit curve.  The inflection points 
allow the slope of the line, or the relationship between individual reservoir storage 
and system storage, to vary.  An unlimited number of balance line inflection points 
could be added within each system zone to further refine and shape the desired 
balance distribution. 

 

 

Figure 13.5 Example of a Two-Reservoir Parallel 
System 
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Figure 13.6 Explicit System Storage Balance 

 

Table 13.1 Explicit System Storage Balance 

Storage Reservoir 1 Reservoir 2 System Storage 
Full 100,000 ac-ft 100,000 ac-ft 200,000 ac-ft 
F.C. 85,000 ac-ft 65,000 ac-ft 150,000 ac-ft 
%F.C. (25% F.C.)  77,500 ac-ft (75% F.C.)  56,250 ac-ft 133,750 ac-ft 
Con 75,000 ac-ft 30,000 ac-ft 105,000 ac-ft 
%Con (70% Con)  52,500 ac-ft (33% Con)  9,900 ac-ft 62,400 ac-ft 
Empty 0 ac-ft 0 ac-ft 0 ac-ft 

In this example, within the System Conservation zone, balance line inflection points 
are set at 70 percent of the conservation storage (52,500 ac-ft) for Reservoir 1 and 
33 percent of the conservation storage (9,900 ac-ft) for Reservoir 2.  As a result, 
these inflection points coincide with system storage of 62,400 ac-ft, and reshape 
their respective balance line curves according to the general criterion that Reservoir 
1 fills up its conservation zone to 70 percent in the time Reservoir 2 fills to only 33 
percent.  Similarly within the Flood Control System zone, balance line inflection 
points set at 25 percent of the flood control storage (77,500 ac-ft) for Reservoir 1 and 
at 75 percent of the flood control storage (56,250 ac-ft) for Reservoir 2 coincide with 
system storage of 133,750 ac-ft.  This would satisfy the requirement that Reservoir 2 
fills up its flood control zone faster than Reservoir 1. 

As demonstrated in Figure 13.7, for estimated end-of-period storages of 25,000 ac-ft 
at Reservoir 1 and 45,000 ac-ft at Reservoir 2, the resultant system storage of 70,000 
ac-ft coincides with desired storages found along the explicitly defined balance line 
curves within the System Guide Curve storage zone.  The desired storage levels are 
56,500 ac-ft for Reservoir 1 and 13,500 ac-ft for Reservoir 2. 
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Figure 13.7 Example of Desired Storages using the Explicit System Storage Balance 
Method 

At 45,000 ac-ft, Reservoir 2 would be above its desired storage of 13,500 ac-ft.  As 
such, Reservoir 2 receives the priority to release for this period.  Unless other 
constraints restrict releases and have higher priority than the system operation rule, 
Reservoir 2 would increase its releases in order to reduce its storage, as close as 
possible, to the desired storage.  On the other hand, with only 25,000 ac-ft of 
estimated storage, Reservoir 1 would be below its desired storage of 56,500 ac-ft.  
Then Reservoir 1 is forced to cut back its releases for this particular time period so 
that its storage can rise, as close as possible, to the desired level.  If there are no 
higher priority rules that require a release, Reservoir 1 would not make a release 
from its outlet(s).  

Similar to the implicit system operation, the explicit system operation is carried out 
each time period when system rules are in effect.  The process of determining 
desired storages is repeated every decision interval in order to assign the priority for 
release to the reservoir that is farthest above the desired storage.  A release decision 
made for a particular time period may not necessarily achieve the desired balance.  
The reservoirs are considered “in balance” when both reservoirs have reached their 
Guide Curves or are operating at the desired storages levels along their balance line 
curves as prescribed in the explicit storage balance scheme. 
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The user interface process of creating an explicit system storage balance is described 
in subsequent sections. 

13.2 Overview of the Reservoir System Editor 

The Reservoir System Editor is used to create explicit system storage balances for 
selected reservoir systems.  The editor is very similar to the Operations tab of the 
Reservoir Editor (Section 10.1).  An example of the Reservoir System Editor is shown in 
Figure 13.8 and reflects the example data for the explicit storage balance method 
previously discussed in Section 13.1.2. 

 

Figure 13.8 Reservoir System Editor—New Reservoir System 

As previously discussed, a reservoir system is implicitly created when two or more 
reservoirs are operating in tandem or when parallel reservoirs are operating together for 
a common downstream location.  For system operations, you can either accept the 
implicit default system storage balance or you can create and define one or more explicit 
System Storage Balance schemes.  For each system storage balance scheme you develop, 
you must define the System Storage Zones and the distribution of storage across the 
individual reservoirs (similar to the concept of Reservoir Operation sets discussed in 
Section 10.2). 

The remainder of this chapter will discuss the Reservoir System Editor in detail and will 
provide instructions for specifying explicit system storage balance data. 
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13.3 Accessing the Reservoir System Editor 

To specify the explicit reservoir system balance 
scheme, you will use the Reservoir System Editor 
(previously shown in Figure 13.8).  This editor is 
available in the Reservoir Network Module and is 
accessed from the Edit menu (in the menu bar), as 
shown in Figure 13.9. 

 

 

 

 

 

13.4 Reservoir System Editor 

Menu Items 

At the top of the Reservoir System Editor, the Menu Bar includes four menus unique to 
this editor.  The menus are ReservoirSystem, Edit, SystemBalance, and SystemZones.  
These menus provide the following options:  creating, renaming and deleting reservoir 
systems; editing reservoir sets; creating, renaming and deleting system operation sets; 
and creating and deleting system zones.  These options are presented in the following 
paragraphs and described in subsequent sections of this chapter.  

• The ReservoirSystem menu (Figure 13.10) allows you to: 

o create a New system,  

o Rename a system,  

o Delete a system, and  

o Close the editor.   

Refer to Section 13.5 for additional information. 

 

• From the Edit menu (Figure 13.11): 

o select Edit Reservoir Set to specify which reservoirs 
are to be included in the reservoir system. 

 

 

 

 

 

Figure 13.9 Reservoir Network 
Module—Edit Menu—Reservoir 

Systems 

 

Figure 13.10 Reservoir 
System Editor—

ReservoirSystem Menu 

 

Figure 13.11 Reservoir 
System Editor—Edit Menu 
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• The SystemBalance menu (Figure 13.12) allows you to: 

o create a New system storage balance,  

o Rename a system storage balance, or  

o Delete a system storage balance.   

Before you can create a new system balance, you must first 
define which reservoirs are included in the system (see 
previous paragraph for instructions to edit the reservoir set).  

 

 

• The SystemZones menu (Figure 13.13) allows you to: 

o create New system zones, or  

o Delete system zones and is active only after a system 
balance has been created. 

 

 

13.5 Defining a New Reservoir System 

The Reservoir System Editor is used for creating a Reservoir System with explicit system 
storage balances.  The process of setting up a new reservoir system includes defining a 
new reservoir system, creating a system operation set (Section 13.7), defining system 
zone values (Section 13.8), and specifying the storage balance (Section 13.9) for each 
reservoir in your system. 

The initial steps in creating a reservoir system that uses explicit system storage balancing 
are: 

• From the ReservoirSystem menu, select New System.  The New Reservoir System 
dialog will open (Figure 13.14). 

 

Figure 13.14 New Reservoir System 

• Enter a Name and Description for the new reservoir system. 

• Click OK.  The New Reservoir System dialog will close. 

 

Figure 13.12 Reservoir 
System Editor—

SystemBalance Menu 

 

Figure 13.13 Reservoir 
System Editor—System 

Zones Menu 
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The name and description of the new Reservoir System will now appear in the Reservoir 
System Editor, with all other fields remaining blank (as shown in Figure 13.15). 

 

Figure 13.15 Reservoir System Editor—New Reservoir 
System 

13.6 Selecting Reservoirs for the System 

Once you have named your reservoir system, you will need to select all of the reservoirs 
to be included in the system storage balancing.  Only those reservoirs that have not been 
included in another reservoir system are available to be selected. 

To select the reservoirs to be included in the system storage balancing: 

• Choose Edit Reservoir Set from the Edit menu of the Reservoir System Editor.  The 
Reservoir Selection Editor will open (Figure 13.16). The available reservoirs in your 
network (that have not been included in another reservoir system) appear in the 
Available pane on the left side of 
the Reservoir Selection Editor.  To 
add a reservoir to your new 
reservoir system, click on the 
reservoir’s name and click Add.  To 
select all of the available reservoirs, 
click Add All. 

• The reservoirs you select will move 
from the Available pane to the 
Selected pane on the right.  To 
remove a reservoir from the 
selected list, click on its name and 
click Remove.  To remove all 
reservoirs from the Selected list, 
click Remove All. 

• Click OK to approve your choices and close the Reservoir Selection Editor. 

 

Figure 13.16 Reservoir Selection Editor 
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Although you have selected reservoirs for your reservoir system, they will not yet appear 
in the Reservoir System Editor.  You must first specify the system storage balance and 
define reservoir system storage zones. 

13.7 Defining a System Storage Balance 

To define the System Storage Balance for the reservoirs in your reservoir system: 

• Select New from the SystemBalance menu of the Reservoir System Editor.  The New 
System Balance dialog will open (Figure 13.17). 

 

Figure 13.17 New System Storage Balance for Reservoir System 

• Enter a Name and Description for the System Storage Balance. 

• Below the Description area, you will see the names of the reservoirs you have 
selected for your system.  Below the name of each reservoir is a dropdown list of the 
Operation Sets available for that reservoir.  Click on the arrow to access the list for 
each reservoir and then select an operation set that contains the system operation 
rule(s). 

• Click OK to close the New System Balance dialog. 

• You must now define at least one Reservoir System Zone. 

13.8 Defining Reservoir System Zones 

To define the Reservoir System Zone(s): 

• Select New from the Zones menu of 
the Reservoir System Editor.  The 
New Storage Zone dialog will open 
(Figure 13.18) 

• Enter a Name and Description for 
the new storage zone. 

• Click OK to close the New Storage 
Zone dialog. 

 
 

Figure 13.18 New Storage Zone 
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When you have defined at least one system storage zone for your reservoir system, its 
name will appear in the white pane at the bottom left of the Reservoir System Editor, and 
a new set of fields will appear in the large gray area, as shown in Figure 13.19.  These 
new fields allow you to configure the system storage balance for your reservoir system. 

13.9 Configuring System Storage Balance 

Once you have successfully created a new reservoir system (by following the steps 
presented in Sections 13.5 through 13.8), several new fields become available that allow 
you to configure the storage balance across reservoirs.  We will use Figure 13.19 to 
illustrate how to do this. 

 

Figure 13.19 Configuring System Storage Balance 

 

 

• Choose a System Storage Balance option from the drop-down list.  
Its description will appear in the editable Description field, and 
the available System Storage Zones will appear in the white pane 
on the left side of the editor window. 

• In Figure 13.19, the System Storage Balance field indicates we are using a System 
Storage Balance called “Parallel SysOp_MyTown,” and there are two System Storage 
Zones, “Flood Control” and “Conservation.” 

• Click on a System Storage Zone in the white pane on the left side of the editor 
window to select it.  Its name and description will appear to the right in the editable 
System Storage Zone name (as shown below).   
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In Figure 13.19, “Flood Control” is selected, so its name and description appear in the 
System Storage Zone and Description fields.  For the selected zone (“Flood Control” in 
this example), in the list beneath each reservoir name, select a reservoir zone for each 
reservoir in the system.  In Figure 13.19, there are two reservoirs in the system, and we 
have chosen the “Flood Control” zone for each reservoir. 

• In the table below the reservoir 
operation sets, enter percentages of 
system storage zones for each reservoir, 
as shown in Figure 13.20.  These storage 
percentages represent inflection points 
along the balance line curve, which 
delineates how the reservoirs will 
balance when system operations are 
performed. 

• Click Apply to save your changes. 

• Repeat the process for each System Storage Zone you have created.  For example, in 
Figure 13.19, once you have configured the “Flood Control” System Storage Zone, 
you would want to configure the reservoir system balance for the “Conservation” 
System Storage Zone. 

• If you wish to configure additional storage balance options, click Apply to save your 
changes for the current storage balance option, then select another storage balance 
option from the System Storage Balance list. 

• When you have finished configuring your system storage balance, click OK to close 
the Reservoir System Editor. 

13.10 General System Operation Notes 

As previously discussed, you can allow ResSim to use its implicit storage balance, or you 
can create an explicit system storage balance.  In addition, the following notes related to 
system operations are provided: 

• When not identified in an explicit storage balance definition, maximum storage 
(100% full) is considered to be the maximum storage value in the elevation-storage 
table defining the pool of each reservoir. 

• Minimum storage (0% full) is considered to be the top of the Inactive zone unless the 
user has deleted the Inactive zone from the operation set, in which case, minimum 
storage of zero is used.   

• The Guide Curve does not have to be the top of the Conservation zone.  The implicit 
balance scheme will recognize the specified guide curve at each reservoir when 
delineating the default balance lines. 

• For parallel reservoirs to operate as a system for a common downstream control 
point, the same common downstream control rule must exist at all of the parallel 
system reservoirs.  The rule must be created at only one of the reservoirs. Once 
created, that rule will automatically be available in the list of existing rules for the 
other reservoirs.  Then, to establish system operation, the downstream control rule 

 

Figure 13.20 Percent Storage for each 
Reservoir in a Two-Reservoir System 
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can be added to the operation set at the other reservoirs via the “Use Existing” 
option in the Operations tab of the Reservoir Editor (Section 11.1.2).  

If the downstream control rules are created separately at each reservoir, even if the data 
entered into the rules is identical, system operation will not be invoked. 

• For tandem reservoirs, there can be an intermediate control point(s) for which the 
upstream reservoir operates. 

• System operation rules can be prioritized along with other rules in the operation set 
(i.e., depending on prioritization, they may be overridden). 

• Implicit and explicit storage balance schemes can be established among two or more 
reservoirs.  When defining an explicit system balance, all reservoirs identified for 
parallel or tandem operation must be included in a single reservoir system (refer to 
Section 13.6).  For example, if you have three parallel reservoirs operating for a 
common downstream location, and only two of them are included in an explicit 
system storage balance, the explicit system storage balance will be ignored and the 
default implicit storage balance scheme will be used instead.   

When one or more reservoirs are involved in both tandem and parallel system operation 
and you want to define an explicit storage balance between the parallel reservoirs, you 
should put all the participating reservoirs (both parallel and tandem) into a single 
reservoir system and the balance definition should address all the reservoirs in the 
system.  For example, if you have two reservoirs operating in parallel for a common 
downstream location and one of the two reservoirs is part of a tandem system with an 
upstream reservoir, it is best to include all three reservoirs in the explicit reservoir system 
and associated system balance.  Otherwise, if only the parallel reservoirs are included in 
the explicit system, and the tandem reservoirs are left to operate using the implicit 
system balance, then undesirable operations will result due to incompatibility between 
the implicit and explicit balance schemes. 

• The explicit system storage balance is defined using the Reservoir System Editor, as 
presented in the preceding sections of this chapter.  To simulate the explicit system 
operation, the explicit system storage balance must be selected in the Alternative 
Editor’s operations tab (Sections 14.6) along with the reservoir operation sets that 
contain the system operation rules. 

 



HEC-ResSim User’s Manual  Chapter 14 - Defining Alternatives 

  14-1 

Chapter 14 

Defining Alternatives 

Each alternative represents the combination of a reservoir network, a selection of one 
operation set per reservoir, the specification of the initial conditions of each reservoir, 
and the selection of inflows and other input time-series datasets needed by your model.  
An Alternative consists of a Reservoir Network (previously created from a Configuration), 
Run Control specifications, an Operation Set for each Reservoir in the network, a Storage 
Balance Operation Set for each Reservoir System in the network (if applicable), a 
definition of initial (Lookback) conditions, and a mapping of all Time-Series records to 
identified local inflows.  To develop an Alternative, you use the Alternative Editor to 
name the Alternative and give it a description, define the Time Step and Flow 
Computation method, select Reservoir Operation Sets, select System Operation Sets (if 
applicable), select a Lookback Type, associate time-series data with locations, associate 
observed data with locations, and save the Alternative you have created.  This chapter 
will guide you through these steps. 

14.1 Preparing to Develop Alternatives 

Before you can develop an alternative, you need to define the operational reservoir data 
using the Reservoir Editor.  Chapter 11 describes this procedure.  If your network 
contains reservoir systems, you need to define the system storage balance (as described 
in Section 13.7). 

14.2 Accessing the Alternative Editor 

To access the Alternative Editor (Figure 14.1), choose Edit from the Alternative menu in 
the Reservoir Network Module. 
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Figure 14.1 Alternative Editor 

 

14.3 Creating a New Alternative 

The first step in creating an Alternative is to give it a Name and Description, and then 
select the reservoir Network you want to use. 

 To create a New Alternative: 

•  From the Alternative menu of the 
Alternative Editor, select New.  The 
New Alternative dialog will open 
(Figure 14.2). 

• Enter a Name and Description.  Use the 

 button to open a larger editing 
window for the description. 

 

Figure 14.2 New Alternative 
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• Select a Network by choosing from the list of available networks. 

• Click OK to close the New Alternative dialog.  The name and description you entered 
will now appear in the Name and Description fields of the Alternative Editor (Figure 
14.3). 

 

Figure 14.3 Alternative Editor—Name and Description Fields 

14.4 Selecting a Time Step and Flow Computation 

Method 

Once you have given your alternative a name and description and chosen the reservoir 
network, you will need to select the timestep and flow computation method for the 
alternative. 

• From the Run Control tab, select the timestep from the drop-down menu (Figure 
14.4):  

 

Figure 14.4 Alternative Editor—Run Control Tab—Time Step 

 

• Select the Flow Computation Method (Program Determined, Period Average, or 
Instantaneous) (Figure 14.5).   

Flow Computation Method:  choose one of the following methods to indicate the 
appropriate technique to be used in the computations: 

o Program Determined—determined by ResSim from reviewing time intervals of 
the input time series data. 

o Period Average—typically used when the time interval of the input time series 
data is daily or longer. 

o Instantaneous—typically used for short-interval data (e.g., hourly) that is less 
than a daily time interval.  
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• Select Compute Unregulated Flows, Compute Holdouts, and Choose the Log Level 
(Figure 14.5). 

o Check Compute Unregulated Flows if you want ResSim to perform additional 
calculations to determine the unregulated conditions in the watershed (i.e., 
without the regulation of reservoir and diversion projects).  This process occurs 
after the computations have been completed; therefore, if the unregulated flows 
are not of interest, you can un-check this option to save compute time. 

o Check Compute Holdouts when you want ResSim to calculate the amount of 
water the reservoir stores (as opposed to just releasing inflow).  Holdouts 
indicate the effects of reservoir regulation and are most applicable when you will 
be performing a subsequent Flood Impact or Flood Damage analysis. 

o Select the Log Level (1-10) to control the amount of detailed messages that will 
be displayed during the computations.  A log level of 10 will provide the highest 
level of detailed messages. 

 

Figure 14.5 Alternative Editor—Run Control Tab—Flow Computation Method 

• Select the Alternative Type (Figure 14.5).   

Alternative Type:  The default alternative type is Standard, and almost all models use 
this default, but occasionally there is a need for advanced techniques offered with 
other alternative types.  You can read about these other alternative types in the 
Appendices.  Select one of the following: 

o Standard—default alternative type for doing classic ResSim simulations. 

o Yield Analysis—used to run iterative simulations that can solve for reservoir or 
storage account yield (Appendix F). 

o Ensemble—designed for use with ensemble streamflow forecasts, this 
alternative type allows you to run multiple correlated inflow sets for one 
alternative and produce multiple correlated output datasets. (Appendix G).  

o Monte Carlo—designed to incorporate risk and uncertainty into results.  A 
simulation is run numerous times with specified input variables sampled from 
given distributions (Appendix H).  
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14.5 Selecting a Reservoir Operation Set 

Now that you have selected the alternative’s timestep and flow computation method, 
you will need to select the Operation Set you want each reservoir to follow for the 
alternative.  You will have created the operation set(s) using the Reservoir Editor (as 
described in Chapter 10). 

To select a reservoir operation set for an alternative: 

• In the Alternative Editor, select the Operations tab (Figure 14.6). 

 

Figure 14.6 Alternative Editor—Operations Tab—Reservoir Operation Set 

• Select an Operation Set (for each reservoir in the network) by choosing from the 
Operation Set dropdown list. 

14.6 Selecting a Reservoir System Storage Balance 

When you create a reservoir system and define an explicit storage balance scheme for a 
system operation (described in Chapter 12), an entry will appear in the Alternative 
Editor’s Operations tab that identifies the Reservoir System along with a field in which 
you are required to select a system storage balance operation for the reservoirs to 
follow.  Note that the individual operation sets for each reservoir containing the 
Downstream Control and/or Tandem Operation rules have to also be selected in the 
alternative in order to simulate system operation. 

To select a system operation scheme for an alternative: 

• In the Alternative Editor, select the Operations tab (Figure 14.7). 

• In addition to selecting the operation set for each reservoir (as previously described 
in Section 14.5), select a Storage Balance for each Reservoir System you have 
configured by choosing from the Storage Balance dropdown list.  The selection 
options will be either the operation that contains the explicit storage balance scheme 
you want to apply, or “NONE” if you wish to have the alternative use the implicit 
(default) storage balance scheme instead of the explicit storage balance you 
previously set up. 
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Figure 14.7 Alternative Editor—Operations Tab—Reservoir System Storage 
Balance 

14.7 Selecting a Water Account Set 

If you are using the ResSim water accounting feature in your alternative, you will need to 
specify the account set to use in the Operations tab of the Alternative Editor.  See 
Appendix F for information on ResSim water accounting. 

To select a Water Account Set for an alternative: 

• In the Alternative Editor, select the Operations tab (Figure 14.8). 

 

Figure 14.8 Alternative Editor—Operations Tab—Water Account Set Selection 

• At the very bottom of the Operations tab is the Water Account Set Selection pane.  
Select the correct Water Account Set using the dropdown menu.  If NONE is selected, 
water accounting will not be performed for the alternative.   

14.8 Selecting Lookback Type 

After specifying the operation set for each of your reservoirs, you will need to specify the 
initial (or starting) conditions for the alternative.  This is referred to in ResSim as the 
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Lookback (or warmup) period.  You will need to specify whether Constant or “mapped” 
Time-Series data will define each element and parameter during the Lookback period. 

To set the Lookback Type for locations in your reservoir network: 

• In the Alternative Editor, select the Lookback tab. 

• For each location or parameter, in the Type column double-click on the appropriate 
arrows to select either Constant or Time-Series from the dropdown list (as shown in 
Figure 14.9). 

 

Figure 14.9 Alternative Editor—Lookback Tab 

 

• For locations or parameters where you have selected Constant as the lookback type, 
enter the value for the constant in the Default Value field. 

14.9 Associating Time-Series Data with a Location 

Next, you will need to associate (by “mapping”) a time-series record to each location or 
parameter for which Time-Series Data are needed.  You can also use inflow multipliers to 
increase or decrease the inflow values. 

To associate Time-Series Data with a Location: 

• In the Alternative Editor, select the Time-Series tab  
(Figure 14.10). 

 

Figure 14.10 Alternative Editor—Time-Series Tab 

• Each row in the Time-Series table is a local flow location (specified in the Local Flow 
tab within the Junction editor in the Reservoir Network module), an 
element/parameter you have defined on the Lookback tab as Time Series, or a Time 
Series that is referenced in the Operation rules.  Select each row, one at a time, and 
click Select DSS Path to access the Select Pathname dialog (Figure 14.11). 
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Figure 14.11 Select Pathname 

The Select Pathname dialog allows you to select records from a list of pathnames (or 
catalog) in the database.  From the View menu, you can choose to display a straight list 
of pathnames or a list of pathnames separated into parts, and you can refine the list by 
searching for either a string in the pathnames or for specific pathname parts.  For 
detailed information about working with DSS files, refer to the discussion of HEC-DSSVue 
in Appendix D. 

• To select time-series records for a location or element/parameter in your alternative, 
open the DSS file you wish to browse.  If you know the name of the file, you can type 
the file name (including the path) directly into the File Name box to open the DSS file.  

Otherwise, choose Open from the File menu or click the folder icon  to select the 
DSS database file you want. 

• Once you have selected a file, the Select Pathname dialog displays the filename, the 
number of pathnames shown in the list, the number of pathnames selected, the total 
number of pathnames in the database file, and the size of the database file.  The 
individual pathnames display in a table beneath the search area. 

• Use the Search feature to “filter” and locate individual records in the DSS file or scroll 
through the list of pathnames with the vertical scrollbar. 

• Click on a pathname in the list (to select it).   

• If you would like to view the DSS data for the selected pathname, select Plot or 

Tabulate from the Display menu, or you can click on Plot  or Tabulate . 

• When you are satisfied with the DSS record you have chosen for a location or 
element/parameter, click on Set Pathname and the selected pathname will appear in 
the Time-Series tab of the Alternative editor. 

•  and  are available at the bottom of the Alternative Editor for 
use in reviewing the time series data associated with a location. 

• You can increase or decrease the magnitude of the flow data values by clicking on 

Inflow Multipliers.   
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• If you are using the flow multipliers, a check will appear in the checkbox to indicate 
inflow multipliers are being used.    

• The Inflow Multipliers editor (Figure 14.12) appears when you click on Inflow 
Multipliers. 

 

Figure 14.12 Inflow Multiplier Editor 

Click in the Use Inflow Multipliers checkbox to activate the editor (as shown in Figure 
14.13).   

 

Figure 14.13 “Activated” Inflow Multiplier Editor 

The following options are available for entering the Inflow Multipliers: 

• The Global Multiplier option is used when you want the same multiplier to be applied 
to all locations, as shown in Figure 14.14. 
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Figure 14.14 Inflow Multiplier Editor—Global Multiplier 

• The Multipliers by Location option is used when you want a different multiplier to 
apply to each location, as shown in Figure 14.15. 

 

Figure 14.15 Inflow Multiplier Editor—Multipliers by Location 

• If you uncheck the Use Inflow Multipliers checkbox, then you de-activate the 
multipliers, but the values remain in the editor for future use, if desired. 

14.10 Defining Observed Data 

While defining your reservoir network, if you have specified (by checking the appropriate 
box or boxes in the Observed tab within each element’s editor in the Network module) 
that observed data is available for individual reservoirs, junctions, reaches, diversions, 
and diverted outlets, then the Observed Data tab of the Alternative Editor will list these 
locations in a table along with the DSS path information associated with them, as shown 
in Figure 14.16. 
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Figure 14.16 Alternative Editor—Observed Data Tab 

14.11 Hotstart Options 

Typically, the Lookback period is used for warming-up the state of the watershed.  
However, instead of using the Lookback period and associated data for determining the 
system state, you can save (and subsequently use) the data from one simulation to 
another simulation by using the Hotstart options.  In other words, you can use the 
Hotstart as a way of assigning a previously simulated watershed state to another 
simulation. 

To use the Hotstart option, you must first run a simulation that saves system state data 
to “Hotstart” files.  You may create one or multiple Hotstart files from a single simulation, 
differentiated by the dates saved in the hotstart files.  Each of those files can be used to 
inform an alternative of starting state data, but only one Hotstart file can be used by an 
alternative.  The Hotstart file used is selected by setting the using alternative’s simulation 
start date to correspond to the Hotstart date.  The alternative then uses a Hotstart file, 
rather than Lookback data to determine initial conditions. 

To define the Hotstart Options: 

• In the Alternative Editor, select the Hotstart tab  
(Figure 14.17).  The Hotstart editor is divided into two panels:   

• Create Hotstart File 

• Read Hotstart File 

 

Figure 14.17 Alternative Editor—Hotstart Tab 

•   Check the box labeled “Create Hotstart File”. 
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•   Enter an appropriate value for the 
“Number of Hours to Save (for Rule Lookback)”.  Because some rules or other 
operations may rely on data from previous timesteps, the Hotstart feature will 
save the appropriate number of timestep values (based on the number of hours 
you enter into this text field) for all its computed time series.  This puts the 
responsibility on you, the modeler, to determine how many hours should be 
saved. 

• Check one or more of the Hotstart options for saving the Hotstart files.  You can 
choose to write the Hotstart files at the “Start of Simulation”, at the “End of 
Simulation”, at a specific “Date/Time”, or you can choose the “Save Hotstart File 
at Interval” option and then select the Interval from the available list and specify 
the Date and Time to start writing the recurring interval Hotstart files.  Caution 
should be used when selecting the Interval option since many Hotstart files can 
be written, depending on the interval you select and the length of the simulation 
used when saving the Hotstart files. 

 

The “Save Hotstart File at Interval” option can write many, many Hotstart files.   

Therefore, use caution when selecting the recurring Interval with Starting Date 

and Time option. 

Figure 14.18 shows an example portion of the Alternative editor where Create Hotstart 
File is being invoked.  Hotstart options for an alternative named “HotStart” are being 
used to save Hotstart files at a specific Date/Time (27Nov1993 at 1400 hours).  Since this 
example indicates that the number of hours to include in the Hotstart files (prior to the 
saved Hotstart Date/Time) is 1 hour, the Hotstart files will contain system state data from 
27Nov1993 at 1300 hours through 20Oct1999 at 1400 hours. 

 

Figure 14.18 Alternative Editor—Create Hotstart File 

After simulating an alternative (e.g., “HotStart”) that creates Hotstart files, a hotstarts 
folder is created in the rss folder of the watershed and contains two types of files 
corresponding to the selected Hotstart options:  These files have extensions of “dss” and 
“nhs” and are named based on the selected Hotstart option(s).  Figure 14.19 shows the 
watershed folder’s file system after a folder named hotstarts was created that contains 
two files whose names are based on the options shown in Figure 14.18 (for this example, 
the Hotstart files reflect a Date and Time of 27Nov1997 at 1400 hours). 
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•   For the alternative that uses (or 
loads) Hotstart files, check the box labeled “Load 
Hotstart File” (to use the system state from a 
previously simulated alternative).  The simulation 
starting date of an alternative that uses a Hotstart 
file must correspond to the save date for one of the 
Hotstart files saved in the alternative that created 
the Hotstart files.  For the above example, a Hotstart 
file has been created for 27Nov1993 at 1400 hours, 
so this must be the starting date and time for any 
simulation using the alternative that Loads that Hotstart file. 

• Once you have checked the Load Hotstart File checkbox, then you need to select the 
Alternative Name to indicate which alternative was used in creating the Hotstart files 
(Figure 14.20).   

 

 

Figure 14.20 Alternative Editor—Load Hotstart File 

14.12 DSS Output 

The DSS Output tab of the Alternative Editor allows the user to optimize write time to the 
simulation.dss output file by specifying which elements and variables should be written 
to the file during a compute.  The DSS Output tab contains a tab for each DSS output 
element, i.e. Reservoirs, Reaches, Diversions, Junctions, and State Variables (Figure 
14.21). 

Initially, the Output All DSS Records check box is selected and all element tabs are 
disabled.  All DSS output will be written to the simulation.dss file.  If the Output All DSS 
Records check box is unselected, the element tabs will become available and the user can 
check DSS data to not write. 

 

 

Figure 14.19 Hotstart Files 

 New 
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Figure 14.21 Alternative Editor—DSS Output Tab Default 

To select DSS data to write to the simulation.dss file at the end of a ResSim Alternative 
compute, the user would check the row (specific element) and column (variable) for a 
particular output variable.  The top row of checkboxes represents all elements and 
variables in the table.  The user can select or unselect the entire column using the all 
checkboxes.  Individual elements and their single variables can be selected/unselected by 
checking/uncheck the checkbox in the (specific element) and column (variable) for a 

particular element.  The top checkbox displays a third state,  which indicates various 
rows are selected for that column. 

14.13 Saving an Alternative 

When you have finished defining an alternative, save it by selecting Save from the 
Alternative menu of the Alternative Editor, as shown in Figure 14.22.  You may then close 
the Alternative Editor. It is a good idea to save your Network and Watershed after 
creating a new Alternative.  To do this, select Save from the Network menu (Figure 
14.22), and then select Save Watershed from the File menu (Figure 14.23). 

 

 

 

 

 

 

 
 

Figure 14.22 Reservoir Network 
Module—Network Menu—Save 

Network 

 

Figure 14.23 File Menu—Save 
Watershed 
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Chapter 15 

Running Simulations and Analyzing 

Results 

When you have entered all required data and have created Alternatives, you are ready to 
perform a Simulation.  A Simulation is where you specify the time window and time 
interval parameters for either a single Alternative or a group of Alternatives.  After a 
successful Simulation, you can analyze the results, make revisions, and perform 
additional Simulations to better evaluate the reservoir operations in your watershed. 

When you create a simulation, you must specify a simulation time window and select the 
alternatives to be analyzed.  ResSim then creates a folder with the name of the 
simulation in the rss folder of the watershed; this folder represents the simulation.  
Within this simulation folder will be a partial copy of the watershed, including only those 
files needed by the selected alternatives.  Also created in the simulation folder is a DSS 
file named simulation.dss, which will contain all the DSS records that represent the input 
and output for the selected alternatives.   

15.1 Recognizing Simulation Screen Components 

The Simulation Module (Figure 15.1) provides the tools you will need to create and run 
Simulations.  A discussion of the components and features of the Simulation Module 
follows and begins on the next page so that the descriptions can be viewed with the 
figure. 
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Figure 15.1 Simulation Module—Main Window 

 

The Title Bar displays the name of opened watershed (displayed to the right of the HEC-
ResSim name). 

The Simulation Control Panel shows the time window for the currently opened simulation 
and provides controls to manipulate the simulation and alternatives.  For more detail, see 
Section 15.1.3. 

The Menu Bar contains menus of commands that you can use in ResSim.  The items on 
the menus change as you switch between the various Modules, offering Module-specific 
commands.  You can select a menu bar item by clicking on the name of the menu (such 
as File), then pointing and clicking on the item you wish to select.  The Menu Bar is 
described in more detail in the next section. 

The Module List contains all the available Modules of ResSim.  Use this list to move 
between the Watershed Setup, Reservoir Network, and Simulation Modules.  By default, 
the Module List opens to the Module most recently used. 
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15.1.1 Menu Bar 

The following is an overview of the Simulation Module’s Menu Bar tools, which allow 
you to create and edit Simulations.  The tools specific to this module will be 
described in more detail in the context of particular tasks later in this chapter. 

 The File menu (Figure 15.2) allows you to Open an existing watershed, Save a 
watershed, Save Map (saves the display area) and Exit ResSim.  Your most-
recently-used watersheds are listed at the bottom of the File menu.  

 

 

 

 

 

 

The Edit menu (Figure 15.3) provides access to the Script 
List, allows you to Set the Active Alternative, and 
allows access to editors for Reservoirs, Reaches, 
Junctions, Diversions, Reservoir Systems, and 
State Variables.  Additionally, you can select Run… 
to open the ResSim Editor for the active 
alternative.  Note that any revisions you make to 
these elements applies only to the active 
Alternative.  If you want the revisions to apply to 
subsequent Simulations, you must save the 
changes to your base directory (Section 15.8.1). 

 

 

In the View menu (Figure 15.4) select Zoom to All to 
restore your watershed map view to full size.  
Layers... opens the Layers Selector dialog.  Unit 
System allows you to customize the display (view) 
settings for your watershed.  If a dialog or editor 
window is open but inactive, Restore Windows 
brings the dialog or editor window to the front as 
the active window.  The Grid Lines option allows 
for turning on or off the grid lines in the map 
region. 

 

 

 

 

Figure 15.2 File Menu 

 

Figure 15.3 Edit Menu 

 

Figure 15.4 View Menu 
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 The Simulation menu (Figure 15.5) is unique to the 
Simulation Module.  It allows you to create a 
New Simulation, and Open, Re-Open, Close, 
Simulation List…, Replace from Base…, Save, or 
Delete an existing Simulation.  The Edit 
command opens the Simulation Period dialog, 
while Info allows you to view the name, 
directory path, and user information for the 
current Simulation.  The Run Manager 
provides the user with the capability of 
computing multiple alternatives without 
having to manually compute each one 
separately.  You can also access Overrides for 
alternatives within the Simulation. 

The Alternative menu (Figure 15.6), also available in 
the Reservoir Network Module, provides 
access to the Alternative Editor.  

 

Figure 15.6 
Alternative 

Menu 

 

The Reports menu (Figure 15.7) provides access to the 
following reports:  
Reservoir Summary, Flow Summary, Power 
Summary, Gates Summary, Stage Summary, 
Release Decision, and User Reports.  You can also 
access Compute logs and Network reports 
(including the Reservoir List, Reach List, Junction 
List, Diversion List, and the “Advanced” Network 
Connectivity summary report). The Refresh All 
Plots option will cause all open plots to reflect any 
changes that have been made in the event of a 
simulation being recalculated after changes have 
been made to an alternative. 

As in the other Modules, the Tools menu (Figure 15.8) provides access to HEC-
DSSVue, Scripts and the Script Editor, the Console Log (which displays the 
information written to the ResSim.log file), HEC-DSS Output (a temporary log 
file that contains messages produced when DSS files are accessed), Options, 
and Information (which provides details about client, user, and watershed 
settings as well as server and system properties).   

 

Figure 15.5 Simulation Menu 

 

Figure 15.7 Reports Menu 
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The Options Editor has tabs allowing access to the following items which are 
the same as those in the Network Module: 

Model Directories (watershed locations for storing 
your watersheds); Compute Display settings (set the 
colors for compute messages and the format of log 
files); Debug Levels (set the level of debug 
messages); General (choose whether or not you 
want a confirmation message to appear when you 
exit ResSim and choose whether you want the last 
watershed reloaded at startup of the program); and, 
Fonts (for various window components). Specific to 
the Simulation Module, are two additional tabs:  
Simulation and ResSim Compute.  These two options 
are discussed further in Section 15.4.2. 

In the Help menu (Figure 15.9), the About HEC-
ResSim command displays information 
about the version of ResSim.  Also, from 
this menu you can access user 
documentation and Install Example 
Watersheds (after you define a watershed 
location as described in Section 3.2.1)  

 

 

15.1.2 Map (Mouse) Tools 

The Map (Mouse) Tools, which appear in a toolbar on the left side of the ResSim 
screen, allow you to interact with objects in the map display.  The Simulation Module 
has three Map Tools and all are available in the other ResSim Modules: 

 Pointer Tool—in the Simulation Module, right-click model schematic elements 
in the map display with the Pointer Tool to access editors, default and user-
defined plots, and release decision reports (for reservoirs). 

 Zoom Tool—the Zoom Tool allows you to zoom in and out of the display area in 
all Modules.  To zoom in, hold the left mouse button down and outline the 
area you want to enlarge.  To zoom out, click the right mouse button.  
Zooming out using the right-click button zooms out by a factor of two, 
positioning the clicked location at the center of the screen. 

 Pan Tool—after you have zoomed in with the Zoom Tool, you can use the Pan 
Tool to view watershed areas that fall outside of the ResSim window borders. 

 

Figure 15.8 Tools Menu 

 

Figure 15.9 Help Menu 
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15.1.3 Simulation Control Panel 

The Simulation Control Panel (Figure 15.10) displays details about the current 
Simulation and allows you to interact with Alternatives.  

 

Displayed at the top of the panel are the Simulation time, 
Lookback time, and End time. 

Below these details is the Simulation Tree, which displays 
the name of the current Simulation and its associated 
Alternatives.  The currently active Alternative displays as 
bold, and a check mark in the box next to an Alternative 
indicates that it will be included when displaying results.  
Right-click on a Simulation or Alternative to access their 
context menus. 

When you select an Alternative, Compute becomes 
available, allowing you to execute a run. 

At the bottom of the Simulation Control Panel, the Scripts 
area displays buttons that launch user-created scripts. 

15.1.4 Display Area 

The Display Area displays model schematic objects and map layers representing the 
Active Alternative. 

Model elements of a Reservoir Network will not appear in the display area until you 
have created or opened a Simulation and activated an Alternative (Section 15.4.1). 

15.2 Creating a Simulation 

Once you have created a reservoir network, entered element data, and developed 
alternatives in the Reservoir Network Module, you can configure the model for a 
Simulation in the Simulation Module.  

• From the Simulation menu, select New.  Or, in the Simulation 
Control Panel, right-click on the currently-active Simulation or 
No Simulation folder to access the context menu.  Select New 
(Figure 15.11).  The Simulation Period dialog will open (Figure 
15.12).  

o The Name field contains a default name for the Simulation 
based on the current date and time.  You may either accept 
the default or enter a name that is more meaningful to 
you. 

o Enter a Start date and Time specifying when you want the 
Simulation to begin.  It must occur after the Lookback Date. 

 

Figure 15.10 Simulation 
Menu 

 

Figure 15.11 
Simulation Control 

Panel Context 
Menu—New 
Simulation 
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o Enter a Lookback Date 
and Time.  The Lookback 
is the “warm-up” period 
before the Simulation 
begins. 

o Enter an End Date and 
Time specifying when 
you want the Simulation 
to conclude. 

o Choose a Time Step 
from the list.  The Time 
Step (or timestep) is the 
computation interval 
and can be 15 Minutes, 
30 Minutes, 1 Hour, 3 
Hours, 6 Hours, 12 
Hours, or 1 Day. 

o The Alternatives table 
includes all of the 
Alternatives you have defined in the Reservoir Network Module.  Select one or 
more applicable Alternatives for the Simulation by checking the boxes next to 
them in the Select column.  Ensure the Alternatives you select include time-series 
date for the entire Simulation period.  

• Click OK to close the Simulation Period dialog.  The Creating Simulation window 
(Figure 15.13) will inform you of the status as ResSim creates the Simulation you have 
defined. 

 

Figure 15.13 Creating Simulation Window 

The Simulation you have created will now appear in the Simulation Control Panel. 

 

The Reservoir Network will not appear in the map region until you have set 

an Alternative to Active (Section 15.4.1). 

15.3 Working with Existing Simulations 

If you have previously created a ResSim Simulation, you may want to make revisions to 
the Lookback date and time or End date and time (the Start date and time cannot be 
changed), or you may want to revise data in an Alternative (operation rules, reservoir 
operation zones, etc.).  To accomplish this, you will open an existing Simulation. 

 

Figure 15.12 Simulation Period 
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15.3.1 Opening an Existing Simulation 

To open an existing Simulation: 

• From the Simulation menu, select Open.  Or, in the Control 
Panel, right-click on the currently-active Simulation or No 
Simulation folder to access the context menu (Figure 
15.14). Select Open. 

• The Open Simulation dialog will open (Figure 15.15). 

 

Figure 15.15 Open Simulation 

• Click on the Simulation you want and select Open. 

• The time period details of your selected Simulation will now appear in the 
Simulation Tree (Figure 15.16), and the map display will now update to show the 
model schematic for the Active Alternative (see Section 15.4.1 for information 
about setting the alternative to active). 

 

Figure 15.16 Simulation Tree 

15.3.2 Editing a Simulation 

Once you have created a Simulation, you can use the Simulation Period dialog (Figure 
15.12) to edit the Lookback Date and Time, the End Date and Time, Time Step, and 
selected Alternatives.  You cannot change the Start Date or Time. 

 

Figure 15.14 
Simulation Control 

Panel Context 
Menu—Open 
Simulation 
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You can access the Simulation Period dialog two ways: 

• Select Edit from the Simulation menu. 

• Right-click on the Simulation folder at the top of the simulation tree in the 
Simulation Control Panel, then select Edit from the context menu. 

• When editing a simulation, it may be necessary to recopy the time series data to 
the simulation.dss file used by ResSim for its computations.  There are two 
methods available for doing this: 

• From the Simulation Period dialog, check the Run New Extract box and click OK. 

• In the Menu Bar, click Simulation→Rerun Extract. 

15.4 Computing a Simulation 

After you have created a new simulation or have opened an existing simulation, you are 
ready to make one of the alternatives active (if not already active) and have ResSim 
perform the computations. 

15.4.1 Setting the Active Component 

Once you have opened a Simulation, the simulation tree will show all of the selected 
Alternatives for the Simulation you have chosen. 

The Active alternative of a simulation will be identified in the Simulation tree with 
bold text and its model schematic will be displayed in the map region.  It will be 
computed if you press Compute in the Simulation Control Panel. 

Most importantly, the Active alternative is editable.  Only the Active alternative can 
be edited in the Simulation module.  If you need to edit more than one alternative in 
your simulation, you must do so one at a time, making each alternative “active” in 
turn to make the desired changes.  Section 15.7 describes the ways you can edit the 
various elements of the active alternative. 

To set the Active Alternative: 

• In the simulation tree, right-click on the 
Alternative you want to be active. 

• Select Set as Active from the context menu 
(Figure 15.17). 

15.4.2 Computing the Simulation 

After inputting all data and parameters as desired, 
you can compute a Simulation. 

In the Simulation Control Panel of the main window 
of the Simulation Module, the simulation tree 
displays the current Simulation as a folder, beneath 
which is a list of the Alternatives associated with the 

 

Figure 15.17 Simulation Control 
Panel Context Menu—Set 

Alternative As Active 
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Simulation.  Also shown in the Simulation Control Panel is the time information 
associated with the Simulation. 

To execute a Simulation, you must first set an Alternative as Active.  Right-click on an 
Alternative in the Simulation Control Panel and, from the context menu, select Set as 
Active (Figure 15.17). 

The name of the active Alternative appears in bold in the simulation tree and 
Compute becomes available.  Also, the model schematic for the active Alternative 
will appear in the display area. 

To compute a Simulation, either click Compute in 
the Simulation Control Panel or, in the simulation 
tree, right-click on the Alternative and select 
Compute from the context menu (Figure 15.18). 

When you compute a Simulation, a Compute 
window opens, as shown in Figure 15.19.  The 
Compute window provides Message Output that 
contains information regarding the status of each 
step of the computation process.  The Progress 
Bar indicates the percentage of completion for 
each step.  When the computation is finished, the 
Progress Bar is completely filled in and reads 
“100%” along with the message “Compute 
Complete” in the Message Bar of the Compute 
window. 

If there are errors or any problems during the execution process, you can review the 
Message Output Text area of the compute window.  The Compute Log can also 
provide information regarding any errors (Section 14.5.1). 

 

Figure 15.18 Simulation Control 
Panel Context Menu—Compute 

 

Figure 15.19 Compute Window 
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Click Close to close the Compute window. 

As previously mentioned in Section 15.1.1, there are two tabs available from the 
Tools Options menu that are specific to the Simulation Module.  These two options 
are Simulation and ResSim Compute and are described below: 

• Simulation options—as shown in Figure 15.20, you can choose to Reload Last 
Simulation on Startup, Restore Simulation Tree State, and/or indicate that the 
Compute Button Forces a Recompute.   

 

Figure 15.20 Simulation Module—Tools Menu—Options 

• ResSim Compute options—as indicated in Figure 15.21, there are default 
compute options that you can revise if needed.  These options include:  
Minimum Number of Compute Passes (default = 2); Error Tolerance Factor for 
Storage Calculation (default = 0.00001); Maximum number of sub-steps for 
Storage Calculation (default = 200); a checkbox to indicate whether or not you 
want to Save Release to Guide Curve to DSS; and, a button to Edit Global ROC 
Options.  If you change from these values and want to go back to the defaults, 
then you can click Reset Defaults.  

 

Figure 15.21 Simulation Module—Tools Menu—Compute 

A Compute Pass refers to one ResSim program solution search moving from the 
upstream elements of the network to the downstream elements.  The default is two 
passes.  Certain system operation rules, such as system hydropower, automatically 



Chapter 15 - Running Simulations and Analyzing Results HEC-ResSim User’s Manual  

15-12  

force four passes.  A user may want to set the minimum number of passes to 3 or 
more if there are diversion elements in the network that are not performing correctly 
or that seem to have been ignored by upstream reservoirs. 

The Storage Calculation refers to a ResSim storage integration approximation 
calculation performed across a computation step to assure the continuity principle is 
enforced over the outlet capacity range experienced during the timestep.  If there 
are severe nonlinear shapes or discontinuities in the range of outlet capacities 
experienced during the timestep, then ResSim subdivides the time to better 
represent the average outflow during each time subdivision and therefore to better 
represent the storage at the end of the timestep.  Storage calculation allows for a 
better simulation of small reservoirs subjected to large inflows and therefore large 
variations in outlet capacities during a timestep.  If a small reservoir in a simulation 
has its storage oscillate unrealistically, increasing the error tolerance factor and/or 
the maximum number of sub steps may improve the behavior of the small reservoir. 

For each time period, releases are determined that represent the amount of water 
that needs to be released in order to reach the reservoir’s guide curve.  By default, 
these releases are not stored to DSS.  During analysis of the results, you may find it 
useful to know what these values were computed to be by selecting the Save Release 
to Guide Curve to DSS option. 

If the operation set contains reservoir rate of change rule(s) and downstream 
operation rule(s), you can indicate to include complex logic to consider the rate of 
change limits when determining the release needed for downstream operation by 
revising the options in the Global ROC Editor (Figure 15.22). 

 

Figure 15.22 Global ROC Editor 

15.5 Trials 

After one or more alternatives have been added to a simulation, you can create a Trial of 
the alternative.  A Trial is a copy of an existing alternative and can be used to quickly test 
“what if” scenarios involving various changes to the alternative (e.g. flows, rule priority, 
overrides, etc.).  Unlike Alternatives, Trials are created in the Simulation Module.  To 
create a Trial: 
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• In the Simulation Control Panel, right-click on the Alternative that you want to make 
a Trial for and select New Trial… (Figure 15.23). 

• The Create Trial Run dialog will open. 

• Enter a name for the Trial, preferably something descriptive (e.g. “2xFlows”, 
“MaxFlowRulePriority”) and then click OK to finish creating the Trial (Figure 15.24). 

• The newly created Trial will appear in the Simulation Control Panel, nested beneath 
its parent alternative (Figure 15.25). 

 

Figure 15.25 Trial Nested Under 
Parent Alternative 

• After creating a trial, it should automatically be made active, but if not, right-click on 
the trial in the Simulation Control Panel and select Set As Active.  The active trial or 
alternative will appear in bold text. 

• Changes can be made to the trial either by: 

o right-clicking in the Simulation Control Panel, selecting Edit Run, and then 
selecting the portion of the trial that you wish to edit, 

 

Figure 15.23 Creating a New 
Trial 

 

Figure 15.24 Create Trial Run Dialog 
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o right-clicking on a network component in the map window, or 

o selecting Alternative→Edit… in the Menu bar of the Simulation Module 

Trials can be reset to the original conditions of their parent alternative by right clicking on 
the Trial in the Simulation Control Panel and selecting Restore from Original Alternative 
(Figure 15.26).  Alternatively, a trial can replace its parent alternative by selecting Accept 
ResSim trial. 

 

Figure 15.26 Simulation Control Panel 
Context Menu—Trials 

 

15.6 Reviewing Simulation Results 

After computing a Simulation, you can review results in many different forms.  Compute 
Messages provide information about each step of the computation process.  Plots and 
Tables in the Simulation Module offer detailed views of data and model results.  Reports 
provide details about individual components of the Reservoir Network.  These options for 
viewing your results are described in the following sections. 

15.6.1 Selecting Alternatives for Plotting and Review 

To view the results from an alternative, check the box next to the alternative(s) you 
want to plot or review. 

15.6.2 Viewing Compute Logs 

If there are errors or any problems during the computation process, the Compute 
Log (Figure 15.27) can provide information regarding the type of problem that exists.  
To view Compute Logs, select Compute from the Reports menu, then select the 
appropriate Alternative. 

 

Only Alternatives that have a checkmark to the left of the alternative 

name in the simulation tree will appear in the list for viewing Compute 

Reports.  These checkmarks indicate the alternatives that you are interested 

in viewing results for. 
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Figure 15.27 Compute Log 

 

You can use the Find and Find Next commands in the Search menu to locate specific 
text in a log. 

You can customize the appearance of the Compute 
Log with the Colors and Font commands in the 
Format menu. 

The Colors command allows changes to the 
Foreground and Background colors.  Selecting 
either one opens the Select Color dialog.  See 
Appendix D for instructions on how to use the Color 
Chooser tools. 

The Font command opens the Select Font dialog 
(Figure 15.28), which allows you to choose the font 
Type and Size.  Also, you can choose whether or not 
to set the appearance to Bold and/or Italic 
characters. 

15.6.3 Viewing the Alternative Input 

Report 

The Alternative Input report provides a complete set of the data used by an 
alternative to compute results.  To access the Alternative Input report, select 
Reports→Alternative Input and then select the desired alternative (Figure 15.29). 

 

Figure 15.28 Compute Log—
Format Menu—Select Font 

 New 
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Figure 15.29 Selecting an 
Alternative Input Report 

The Alternative Input Report Editor will open (Figure 15.30).  From the editor, the 
user can specify the Output Type as either XML or HTML and choose which elements 
of the alternative should be included in the report. 

 

Figure 15.30 Alternative Input Report Editor 

 

  



HEC-ResSim User’s Manual  Chapter 15 - Running Simulations and Analyzing Results 

  15-17 

15.7 Calibrating the Model and Editing Data 

You may need to make adjustments as you test and calibrate your reservoir Simulation 
model.  In the Simulation Module of ResSim, you can access editors that allow you to edit 
all components of your Reservoir Network, modify Alternatives, and fine-tune Override 
controls. 

15.7.1 Using the ResSim Editor Interface 

In the Simulation Module, the ResSim Editor Interface (Figure 15.31) provides access 
to editors for Reservoirs, Junctions, Reaches, and Diversions, as well as State 
Variables, Systems Operations, the Alternative Editor and the Overrides Editor.  You 
can also use the ResSim Editor Interface to quickly set Compute Options. 

To access the ResSim Editor Interface, right-click on the Active Alternative in the 
Simulation tree, then select Edit Run (Figure 15.31). 

 

Figure 15.31 ResSim Editor Interface in Simulation 
Module 

15.7.2 Editing Alternative Lookback, Time Series, 

Observed, and System Operations Data 

To edit references to Time Series and Observed data, you will need to access the 
individual editors for Reservoirs, Junctions, Reaches, and Diversions.  Also, you may 
want to revise the System Operations storage balance.  You can access each of these 
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editors either from the ResSim Editor Interface (as previously shown in Figure 15.31) 
or from the Edit menu of the Simulation Module or Reservoir Network Module. 

To select different Alternative Operations or to adjust Lookback data or revise the 
“mapping” of your Time Series and/or Observed data, you will need to access the 
Alternative Editor (Chapter 13).  The Alternative Editor is available from the ResSim 
Editor Interface (as previously shown in Figure 15.31) or from the Alternative menu 
of the Simulation Module.  For detailed descriptions of the element editors available 
in ResSim, refer to Chapters 9, 10, 11 and 12. 

15.7.3 Editing Override Values 

Once you have computed a Simulation, you may want to disregard (i.e., override) 
some of the decisions that were made.  The Overrides Editor (Figure 15.32) allows 
you to adjust the computed results for each timestep of the Simulation.  You can 
access the Overrides Editor using Overrides in the ResSim Editor Interface (as 
previously shown in Figure 15.31); or, you can select Overrides (for the appropriate 
Alternative) from the Simulation Menu. 

 

Figure 15.32 Overrides Editor 

 

ResSim will use the values you specify for Elevation Target Overrides, Release 
Overrides, Outlet Capacity factors within the physical limits of the reservoir, and 
Storage (or Elevation) Overrides.  The physical rate-of-change and the amount of 
water available in the reservoir may preclude ResSim from using your override 
values. 



HEC-ResSim User’s Manual  Chapter 15 - Running Simulations and Analyzing Results 

  15-19 

For the Reservoir shown in the list at the top of the Overrides editor, there are four 
tabs available for overriding the simulation results:  Each tab contains a Date, Time 
and either “Elevation Target” or “Release” or “Factor” or “Storage.”  You can use any 
one of these override capabilities to adjust the simulation results. 

Specifying Elevation Target Overrides:  
Initially, the Target Elevation is based on the elevation values you specified for the 
reservoir’s “guide curve” (Reservoir Editor, Operations tab).  This is typically the top 
of the Conservation pool and is commonly referred to as the “target” or “guide 
curve”.  In addition to meeting all of the other rules that you specify for a reservoir, 
ResSim will try to keep the reservoir pool at the guide curve elevation.  Therefore, by 
specifying Elevation Target values within this editor, you are inherently overriding the 
reservoir’s release decisions. 

Specifying Release Overrides:  
During a Simulation, ResSim determines the reservoir release values based on the 
rules you specified for the Alternative.  However, there may be situations where you 
do not want the results to reflect the rules for specific timesteps.  Therefore, you can 
enter release values for the pool, the dam, an outlet group, or an individual outlet 
using the Release overrides tab. 

Specifying Capacity Factor Overrides:  
The maximum release capacity of an outlet can be increased or reduced by using a 
factor for the time periods desired.  For example, if you want to indicate that an 
outlet is “out-of-service” for a specific time window within the simulation, you can 
enter a value of 0 to indicate no release capacity for that outlet. 

Specifying Storage (or Elevation) Overrides:  
A warning is made to the user when selecting this override option because the mass 
balance computations can be disrupted by forcing the storage or elevation to be 
specific values.   

Editing Override Values 
You can specify Overrides by entering single cell 
values or by revising multiple adjacent values using 
a fill function. 

To revise a single value, double-click in the cell you 
want to revise and enter the new value. 

To revise multiple adjacent values: 

• Point and click on the first cell, then drag your 
mouse or Shift+click (hold down the shift key 
while clicking in other cells) to highlight the 
cells to be revised. 

• Right-click on the highlighted cells, and select 
Fill from the context menu (Figure 15.33).   

• The Table Fill Options dialog will open (Figure 
15.34). 

 

Figure 15.33 Release Overrides 
Editor Context Menu—Fill Data 

Values 
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• Select the appropriate fill option in the Table Fill 
Options dialog (Figure 15.34), then click OK. 

The revised values will reflect the fill option you 
selected.  In the example shown in Figure 15.34, the 
Repeat Fill option is selected.  Therefore, as the table in 
Figure 15.35 illustrates, all of the highlighted cells equal 
the value of the first cell selected; also, the color of the 
revised values changes from black to blue and the 
thumbnail plot shows the revised values as a red line.  
The thumbnail plot can be viewed in full size when you 
double-click on it. 

 

Figure 15.35 Release Overrides Editor Table—Revised Data Values using Repeat Fill Option  

 

For those timesteps where you do not specify override values, ResSim uses the 
reservoir rules to determine the reservoir release values.  After running a simulation 
using your override values, you may decide to no longer use some, or all, of your 
override values.  In that case, you can use Unspecify and Unspecify All to indicate 
that you want ResSim to determine the release values. 

Use Unspecify when you want release values to be based on the reservoir rules for 
some of the override values you have specified (override values are in green text 
after a simulation is computed).  Highlight the cells where you have specified 
override values, then press Unspecify. 

 

Figure 15.34 Table Fill 
Options 
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Use Unspecify All when you want all of the release values to be based on the 
reservoir rules and not have any overrides specified. 

Use Import when you want to use a time series of override values.  The Import 
Overrides Time Series dialog (Figure 15.36) will open, which functions exactly like the 
Select Time Series Path dialog used to select time-series records for an Alternative.  
Refer to Section 14.9 for more information. 

 

Figure 15.36 Import Overrides Time Series 
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15.8 Managing Simulation Data 

ResSim facilitates archiving and sharing of Simulation data.  There are two operations 
involved in managing Simulation data.  You can save your data to the base directory to 
make it available for other Simulations, and you can replace data in a Simulation for a 
specific Alternative with data from the base directory.  Figure 15.37 shows the 
relationship between the Reservoir Network module and the Simulation module for 
saving and replacing data. 

 

 

Figure 15.37 Data Relationship between Reservoir Network and Simulation Modules  
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15.8.1 Saving Data to the Base Directory 

When you edit model data from the Simulation Module, your changes apply only to 
an individual Alternative and are saved in your Simulation directory (see Appendix A 
for an overview of the ResSim directory structure). 

 

Important:  If you want your changes to be available for use in other Simulations, 

you will need to Save the data back to the Base directory. 

To save data to the Base directory: 

• In the Simulation Control Panel, right-click on the Alternative to access the 
context menu, then choose Save to Base Directory… (Figure 15.38).  The Save 
Simulation Run Model Parameters to Base Directory dialog will appear (Figure 
15.39). 

• Select the appropriate boxes in the Copy Data column beside the items you wish 
to copy from the Simulation directory to the Base directory (i.e., save back to the 
Reservoir Network). 

• Click OK to save the Simulation data to the Base directory. 

15.8.2 Replacing Data from the Base Directory 

While editing Simulation data, if you need to revert to the original Alternative data 
(as it exists in the Reservoir Network module), you can replace the changed data in 
your Simulation directory with data from the Base directory. 

To replace Simulation data with data from the Base directory: 

• From the Simulation Control Panel, right-click on the Alternative to access the 
context menu, then choose Replace from Base Directory.  The Replace Simulation 
Run Model Parameters from Base Directory dialog will appear (Figure 15.40). 

  

Figure 15.38 Alternative 
Context menu—Save to Base 

Directory 

Figure 15.39 Save Simulation Run Model Parameters to 
Base Directory 
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Figure 15.40 Replace Simulation Run Model Parameters from Base Directory 

• Select the appropriate boxes in the Restore Data column beside the items you 
wish to restore from the Base directory to the Simulation directory. 

• Click OK to replace the Simulation Alternative data you have selected with data 
from the Base directory. 

The Replace from Base… option is also available from the Simulation menu. 

15.9 Using HEC-DSSVue 

Included within the framework of ResSim is HEC-DSSVue, a tool that allows you to access 
data stored in HEC-DSS database files. 

When HEC-DSSVue is selected from the Tools menu (Figure 15.41) within the Simulation 
Module, the current “simulation.dss” file is opened. 

 

Figure 15.41 Accessing 
HEC-DSSVue from the 

Tools Menu 
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In the Main Window of HEC-DSSVue, a listing of pathnames that are contained in the 
simulation.dss file are provided, as shown in Figure 15.42. 

 

Figure 15.42 HEC-DSSVue Main Window Showing Pathname Listing 

A screened listing of pathnames can be obtained by selecting a pathname part from the 
lists in the Search by Parts section of the window.  For example, if you want a listing of 
“observed” records, you can select OBS from the F-part list, as shown in Figure 15.43.  To 
obtain an unscreened listing of pathnames, select the “blank” area at the top of the list. 

 

Figure 15.43 Screened Pathname Listing Showing Observed (OBS) Records 

To select records to be plotted, tabulated, or edited, highlight the desired pathnames and 

click on Select.  After one or more records are selected, the icons for the graph  and 

table  become active.  Now, you can click on either icon to generate a plot (Figure 
15.44) or tabulated values (Figure 15.45) of the selected records. 
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Figure 15.44 Example Plot Using HEC-DSSVue 

 

Figure 15.45 Example of Tabulated Data Using HEC-DSSVue 

For a more detailed description of HEC-DSSVue, see Appendix D.
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Chapter 16 

Plotting Results 

ResSim has many standard plots for viewing output, and you can customize and create 
your own, as well.  This chapter describes some of the main plotting features available in 
ResSim. 

16.1 Using Plots and Tables 

Plots and tables in the Simulation Module offer detailed 
views of data and model results. 

You can access plots using context menus in the 
Simulation Module’s display area. 

To access a Plot from the display area, right-click on a 
model element in the map display.  The context menu will 
provide a list of one or more plot options, as illustrated in 
Figure 16.1. 

Once you have opened a plot, you can also tabulate 
values by selecting Tabulate from the plot’s File menu.  

16.1.1 Features of Plots 

ResSim plots offer a variety of information that will assist you with reviewing the 
results of a Simulation.  Included in the information available from the default plots 
are reservoir elevation, storage, and release values as well as regulated and 
unregulated flow values.  Figure 16.2 shows a default plot style illustrating reservoir 
results from a Simulation. 

The plot window displays the location name in the title bar.  Axis labels and a color-
coded legend identify the data contained in the plot. 

When a plot depicts the results of an Alternative, as in Figure 16.2, a dashed vertical 
line represents the start time of the Simulation.  The Lookback (historic/observed) 
period occurs prior to the start time. 

The Zoom Tool  allows you to view data closely at a specific time.  To zoom in, 
hold the left mouse button down and outline the area you want to enlarge.  To zoom 
out, click the right mouse button.  To resize a plot, use the mouse to drag the edges 
of the window.  It is possible to zoom in on one section of the entire plot (both the x 
and y variables simultaneously) or a range for either variable.  To zoom in on a 
section of the plot, outline that area on the plot.  To zoom in on a range (for either x 
or y variable), outline the desired range on the respective axis. 

 

 

Figure 16.1 Reservoir Context 
menu—Plot Simulation Results 
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Figure 16.2 Sample Plot of Reservoir Results 

From a plot window, the View menu provides additional controls for the display of 
results such as quickly displaying the entire plot after zooming in (Zoom to All), 
reposition or hide the legend (Legend Placement/Hide Legend), refresh the plot after 
modifying the alternative and recomputing (Refresh), and refresh the plot on the fly 
after recomputing (Live Display…). 

16.1.2 Customizing Plots 

You can customize the appearance of plots by using several properties editors that 
you can access from context menus: 

• Line Properties:  Right-clicking on a plot line or point will allow you to open a 
Curve Properties Editor to edit line colors, styles, and weights, as well as labels 
and quality symbols. 

• Background Properties:  Right-clicking on the background of a plot will allow you 
to add Markers on the X- or Y-Axis.  Also, you can open a Viewport Editor where 
you can customize the border, background, and gridlines of the plot. 

• Axis Properties:  Right-clicking on a plot axis will allow you to set the Axis Type to 
“Log Axis” (or “Linear Axis”).  Also, you can open an Axis Properties Editor where 
you can customize the axis scale and tic marks. 

• Label Properties:  Right-clicking on an axis label or plot legend will allow you to 
open a Label Properties Editor where you can add backgrounds and borders to 
the labels. 

• Legend Properties:  Right-clicking in an empty area in the legend region will allow 
you to open a Legend Properties Editor where you have a variety of options for 
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determining the appearance of the legend.  Or, you can select Hide Legend from 
the right-click menu (to show the legend, select Show Legend from the View 
menu). 

16.1.3 Creating User-Defined Plots 

Since everyone has their own preferences regarding which variables to include in the 
context menu location plot selections, the User Defined Plot capability offers 
flexibility. 

To create a User Defined Plot: 

• Right-click on the element where you want the 
plot to appear, and select Plot from the context 
menu (Figure 16.3).  The default plot for that 
location will appear. 

• Choose Select Variables from the Plot Menu.  
The Select Plot Variables dialog will appear 
(Figure 16.4). 

The Available Variables list shows the variables you 
can choose for your User Defined Plot.  The 
Selected list shows variables you have selected. 

To add variables to your User Defined Plot: 

• Click on the variable in the Available Variables list, then click on the appropriate 
Plot Region or component in the Selected list.  This allows you to specify where 
you want variables to appear in your plot. 

• Click Add to add the variable you have chosen to the Selected list.  If the added 
variable reflects different units, a separate Y-axis will be automatically added. 

To remove a variable, click on its name in the Selected list then click Remove. 

You can also Move a Plot Region up or down or Remove it by right-clicking on the 
plot region name and choosing the action desired from the context menu, as 
illustrated in Figure 16.5. 

• Click OK.  The Select Plot Variables dialog will close, and your User Defined Plot 
will open. 

To save your User Defined Plot: 

• From the Plot menu on the plot that appears, select Save Plot Type... The Save 
Plot Type dialog will appear (Figure 16.6).  You can specify whether you want this 
User Defined Plot to be available to All Applications or to just This Watershed 
only.  Enter a Name for the plot.  

• Click Save.  The Save Plot Type... dialog will close. 

The new User Defined Plot will now be available when you select User Plots from 
the right-click context menu in the Display Area (Figure 16.7). 

 

 

Figure 16.3 Context Menu for an 
Element 
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Figure 16.4 Select Plot Variables 

 

 

Figure 16.5 Select Plot Variables—Plot Region Context Menu 

 



HEC-ResSim User’s Manual  Chapter 16 - Plotting Results 

  16-5 

 

 

 

Figure 16.6 Save Plot Type  Figure 16.7 Context menu—User Plots 

 

16.2 Viewing Data in Tabular Form 

You can view plotted data in tabular form by selecting Tabulate from the File menu of the 
plot.  Figure 16.8 shows an example. 

 

 

Figure 16.8 Data in Tabular Form 
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The View menu of the Tabular Data window offers six display options.  The Commas 
option displays commas in numbers greater than one thousand.  The Reverse Order 
shows the table starting with the last time period and ending with the first time period.  
The Date and Time Separately option splits the date and time into two separate columns.  
The Date with 4 Digit Years option displays the year with four digits instead of the default 
two.  You can set the decimal place for viewing the data by using the Show Decimal 
Places option.  Lastly, you can indicate how you want missing data displayed by using the 
Show Missing As option.  You can also resize table columns by dragging their borders to 
the desired position with your mouse. 

16.3 Printing and Exporting Plots and Tables 

You can print ResSim plots and tables, copy and paste them into other applications, and 
specify export options for plots.  See Appendix E for details.

 

To sort the data in most report tables: 

Click on the column header. Each click will toggle the sort between ascending 

and descending order. 
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Chapter 17 

Viewing and Managing Reports 
Reports are available from every module of HEC-ResSim.  Many of the reports are 
module-specific, but some things remain the same no matter which module you are in—
things like opening a report, selecting view settings, printing, and exporting.  In addition, 
ResSim has a Report Builder for creating your own reports based on simulation results.  
This chapter covers the basics for viewing and managing reports and describes different 
types of reports available in the Simulation Module. 

17.1 Viewing Summary Reports 

Summary Reports are available from the Reports menu.  In all Summary Reports, the 
Simulation name and Alternative appear at the top of the window, along with the 
Lookback date and time, the Start date and time, and the End date and time. 

Summary Reports also have two menus.  The File menu allows you to Print and Close the 
report (see Appendix F for information about printing).  The Options menu lets you 
Specify the Time to review the simulation results for a single time period. 

17.1.1 Reservoir Summary Reports 

The Reservoir Summary Report (Figure 17.1) displays Average, Maximum, and 
Minimum result values for pertinent reservoir parameters. 

To view the Reservoir Summary Report, select Reservoir Summary from the Reports 
menu. 

 

Figure 17.1 Reservoir Summary Report 
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17.1.2 Flow Summary Reports 

The Flow Summary Report (Figure 17.2) displays Average, Maximum, and Minimum 
flow values for individual location parameters. 

To view the Flow Summary Report, select Flow Summary from the Reports menu. 

 

Figure 17.2 Flow Summary Report 

 

17.1.3 Power Summary Reports 

The Power Summary Report (Figure 17.3) displays Average, Maximum, and Minimum 
values for individual location parameters. 

To view the Power Summary Report, select Power Summary from the Reports menu. 

 

Figure 17.3 Power Summary Report 
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17.1.4 Gate Summary Reports 

The Gate Summary Report (Figure 17.4) displays Average, Maximum, and Minimum 
values for individual location parameters. 

To view the Gate Summary Report, select Gate Summary from the Reports menu. 

 

Figure 17.4 Gate Summary Report 

17.1.5 Stage Summary Reports 

The Stage Summary Report (Figure 17.5) displays Average, Maximum, and Minimum 
stage values for individual location parameters. 

To view the Stage Summary Report, select Stage Summary from the Reports menu.  

 

Figure 17.5 Stage Summary Report 
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17.1.6 Release Decision Reports 

The Release Decision Report (Figure 17.6) displays a reservoir’s Active Zone, 
Elevation, and Net Inflow for each timestep of the simulation.  It also gives the Active 
Rule and calculated release for the reservoir pool, dam, and outlets for each 
timestep.   

 

 

Figure 17.6 Release Decision Report 

 

You can access the Release Decision 
Report by selecting Release Decision from 
the Reports menu.  To go straight to a 
specific reservoir’s Release Decision 
Report, select Release Decision Report 
from the reservoir’s context menu (right-
click the reservoir element).   

The Release Decision Report File menu 
allows you to Print and Close the report.   

The Options menu (Figure 17.7) allows 
you to select a different reservoir for the 
report.  It also gives you the option to 
select a time window—either the default 
of the entire simulation period, or a 
specific, shorter time window. 

 

Figure 17.7 Release Decision 
Report Options 
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17.1.7 User Reports 

The User Report editor provides you with 
the ability to create and edit user reports.  
User Reports make it possible to organize, 
manipulate, and display simulation results 
in customized tables.  Output time series 
data specific to the current active 
alternative in the Simulation module is 
made available to the User Report editor. 

To create, edit, or access User Reports: 

• From the Reports menu, select User 
Reports → Edit… (Figure 17.8).  The 
User Report Editor will appear, as 
shown in Figure 17.9. 

 

 

Figure 17.9 User Report Editor 

• Create a new report template by selecting New from the Report menu.  The 

Create a New Report Template tool  (located in the upper left-hand corner of 
the editor) can also be used for creating a new report.  The Create New Report 
Template dialog will appear (Figure 17.10) where you will give your report a 
Name and Description and select OK.  

 

Figure 17.8 Simulation Module—Reports 
Menu—Accessing the User Report Editor 
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Figure 17.10 Create a New Report Template 

• After creating a new report template (Figure 17.11), you will notice four tabs in 
the User Report Editor: Contents, Options, Report Header/Footer, and Page 
Header/Footer.  

 

Figure 17.11 User Report Editor—After Creating a New Report Template 

• From the Contents tab select Edit to choose the output time series that you 
would like to include in your first report block.  The Report Content Selection 
dialog will appear (Figure 17.12). 
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Figure 17.12 Report Content Selection 

• To add a time series, highlight the Time Series Name and select Add to Report 
Columns.  Each time series that is added will be represented as its own column in 
the current report block.  As mentioned previously, only output time series data 
from the current active alternative in the Simulation module is available for 
report building.  

Figure 17.13 is a display of the Report Content Selection dialog after two time series 
have been added to the report block under construction. 

All elements in the Report Columns area of the Report Content Selection dialog are 
editable.  To edit Time Series Name, Parameter, or Column Header, double click on 
the desired cell and make the appropriate changes. 

Units for column headings can either be entered in manually or using the character 
string code %S.  Typing this into the column header box (as shown in Figure 17.13) 
will result in the units automatically being displayed in the report.  Note that the code 
is case sensitive. 
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The buttons at the bottom of the Report Columns area, Append, Insert, Delete, Move 
Up, and Move Down, can be used to add columns to the report and rearrange time 
series data into different columns.  Append will add a blank column to the far-right 
side of the report (a row will be added to the template).  Insert will add a blank 
column to the left of the column in the report that is selected in the Report Columns 
area (a row will be added before the selected row in the template).  Delete will erase 
from the report whatever column is selected in the Report Columns area (the 
selected row in the template will be deleted).  Move Up and Move Down will shift the 
selected column to the left and right in the report, respectively (the row in the 
template will shift up or down). 

Select the Edit option to manipulate the time series data in each column.  Doing so 
will bring up the Report Column Options dialog (Figure 17.14).  The title bar at the 
top of the dialog will include the column currently being edited (in this case, C1).  The 
Report Column reflects the contents of the Column Header (in this case, SAYERS 
INFLOW JCT FLOW (%S)). 

 

Figure 17.13 Report Content Selection—Time Series Added to Report Columns 
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Figure 17.14 Report Column Options 

For Interval Option, you are given four choices as to how you would like your data to 
be defined for each point in time:  SOP (Start of Period), EOP (End of Period), PAVG 
(Period Average), and PCUM (Period Cumulative).  This gives you the ability to specify 
what type of data is actually being reported for each time interval. 

The number of decimal places reported for the time series can also be specified with 
Num. Decimal Places. 

Units Multiplier (prefix) can be used to select a multiplier (1, 1000, or 1000000) that 
will be applied as a “prefix” to the units of the data reported in the column being 
reported.  For example, you might choose 1000 to convert KW units to MW units.  
The data values will be divided by 1000 and the units label will be preceded by 1000 
(e.g., 1000 KW).  For example, for a value of 2526 KW, then the value displayed in the 
report column will change to 2.526 and the Units should reflect 1000 KW.  Currently, 
however, the multiplier value is not automatically displayed in the column header.  
Therefore, you must manually enter the multiplier into column headings wherever 
appropriate.  Note:  it also might be appropriate to increase the number of Decimal 
Places (see previous paragraph) when using this option for displaying units. 

The Column Width can also be specified.  To manually enter a desired width, enter 
the number of characters wide that you would like your column to be in the Column 
Width box.  

Checking the Hidden Column box will effectively prevent the column from being 
visible in the report.  Selecting this option only prevents the column from being seen.  
The time series data, and all edits to the column, will still be attached to the report. 

It is possible to withhold data that does not fall within a certain specified range by 
checking the Clip Values to Range box.  After checking the box, specify the range 
(outside of which the data will not be shown) by entering the Minimum and 
Maximum values.  Furthermore, you can check the Show Clipped as Missing box, 
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which will replace the clipped data with either “M”, “-M-”, or a blank space.  See 
options from the View menu of the User Report as subsequently discussed in Step 8. 

The right side of the Report Column Options dialog contains Summary Statistics that 
can be calculated for the time series data in the current column being edited.  These 
statistics include the following:  Maximum, Time Max Occurred, Minimum, Time Min 
Occurred, Average, Sum, and Count.  The statistics that are chosen to be calculated 
will be shown in the report at the bottom of the column. 

Once all edits have been made to the column, select OK to save and return to the 
Report Content Selection dialog (previously shown in Figure 17.12), or select Cancel, 
which will return you to the Report Content Selection dialog and ignore all column 
edits you just made.  In the Report Content Selection dialog, select OK to save all 
edits and return to the User Report Editor (previously shown in Figure 17.11).  
Selecting Cancel will return you to the User Report Editor but will not save any edits 
you made to the report block.  

In the User Report Editor, select the Options tab (as shown in Figure 17.14). 

By using the dropdown menu for Reporting Interval, you can select which report 
interval you would like to use.  You can select Each Step, Daily, Weekly, Monthly, or 
Yearly.  When choosing Daily, Weekly, Monthly, or Yearly, it will be necessary to 
specify what hour, day, or month you would like to report.  For instance, if a daily 
reporting interval is used, you will need to choose which hour of the day you would 
like reported.  When Each Step is chosen, data will be reported for all intervals, so it 
is not necessary to specify reporting hours, days, or months.  

Default Minimum Column Width can also be specified.  In the box to the right, 
column width, expressed in pixels, can be set to whatever value you find appropriate.  
The default column width is set to 100 pixels.  You can increase the column width, 
but the minimum width will be at least 100 pixels (even if you enter a value less than 
100). 

In the bottom left corner are the Date/Time Column options which can be used to 
specify how you would like time to be reported.  Choosing Start of Period will display 
the time at the start of each interval that data is reported.  Choosing End of Period 
will display the time at the end of each interval, and choosing Both will display the 
beginning time and ending time of each interval.  You can also check Show Time, 
which will display the hour of day for each time interval, and Show Day of Week, 
which will display the day of week for each time interval.  

In the bottom right corner are the Report Size and Location options that can be used 
to specify how large you would like your report to be and where on the screen you 
would like it to appear.  The size of your report can be set by entering dimensions (in 
pixels) in the Report Size (w×h) boxes.  Furthermore, you can set the location where 
the report will appear on your computer screen by entering coordinates (in pixels) in 
the Report Screen Location (x,y) boxes.  These screen coordinates should correspond 
to an origin based on the upper left hand corner of your computer screen (i.e., an “x, 
y” coordinate of “1, 1” would place the upper left corner of your User Report in the 
upper left corner of your computer screen).  Since this display control affects the 
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report both when it is displayed on the screen and when it is printed, you should only 
use this option when you are not printing the report. 

• Select the Report Header/Footer tab in the User Report Editor to give your report 
a title, header, and footer, if desired (Figure 17.15). 

 

Figure 17.15 User Report Editor—Report Header/Footer Tab 

The Title and Header Text will appear at the beginning of the report, while the Footer 
Text will appear at the end.  Notice the character string codes (%) entered in Figure 
17.15.  These codes refer to run name (%R), alternative name (%A), and network 
name (%N), respectively. 

Table 17.1 provides a list of the character string codes (which are case sensitive) that 
can be used to allow automatic viewing of special text fields in the report where text 
can be added or edited and in the Report Header & Footer. 

Table 17.1 User Reports—Character String Codes 

%R Run name 

%A Alternative name 

%N Network name 

%L Lookback time 

%B Simulation Beginning (or start) time 

%E Simulation End time 

%V Build Version 

%S Units 
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• Select the Page Header/Footer tab in the User Report Editor to add a header and 
footer to the page of your report, if desired (Figure 17.16).   

 

Figure 17.16 User Report Editor—Page Header/Footer Tab 

Instead of inserting a header and footer at the beginning and end of the report, a 
header and footer will be inserted at the top and bottom of each printed page.  Table 
17.2 provides a list of the character string codes (which are case sensitive) that can 
be used to allow automatic viewing of special text fields in the page header and/or 
footer. 

Table 17.2 User Reports—Character String Codes for 
Header/Footer 

%d Date report is printed 

%p Page number 

%n Number of pages 

The three tool buttons located above the Page Header options can be pressed to 
insert the following codes (instead of manually typing in the %code):   

 Add the page number (%p) 

 Add the total pages (%n) 



HEC-ResSim User’s Manual  Chapter 17 - Viewing and Managing Reports 

  17-13 

 Add the current date (%d) 

If you do not want the Page Header and/or Footer information to appear on the first 
page of your report, you can check the box labeled omit from first page. 

• In the User Report Editor, use the Save and View Report tool  to save your 
report template to disk and see a preview of your User Report.   

A User Report contains the following menus: 

•  Report:  Options include Save As…, Print, and 
Close (as shown in Figure 17.17).   

• View: Options include Show Missing As (blank, M, 
-M-) and Show Commas (as shown in Figure 
17.18).  

 

Figure 17.18 User Report—View Menu 

 

• Format:  Options include Font (for Title, Header, Footer, and Tables) and  
Save Settings (as shown in Figure 17.19). 

 

Figure 17.19 User Report—
Format Menu 

Figure 17.20 shows the “Beginning” (top of figure) and “End” (bottom of figure) of 
the Example User Report (note the report title, header, and footer as well as the 
statistics printed at the end of each column).  

 

Figure 17.17 User 
Report—Report Menu 
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“Beginning” of Report Block:

 
“End” of Report Block: 

 

Figure 17.20 User Report Preview 

• To add another report block, return to the User Report Editor.  Under the 
Contents tab, select Add to insert another report block.  Add one or more time 
series to the new report block using methods previously discussed and make 
desired edits to the newly created columns.  Each report block can be given a 
title in the Label column in the Report Blocks area of the User Report Editor.  
Figure 17.21 shows the User Report Editor with two report blocks.  In this 
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example, the two labels Block 1 and Block 2 were entered for illustration 
purposes. 

 

Figure 17.21 User Report Editor—Contents Tab—User Report Template with 
Two Report Blocks 

 

Figure 17.22 shows a preview of the User Report after adding 
the second report block.  Note that the labels assigned in the User Report Editor 
appear above the time column. 
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Figure 17.22 User Report with Two Report Blocks 

 

• Be sure to save your user report template after you have made all necessary 

edits.  If you have not used the  tool after making your final edits, then be 
sure to save your User Report template using one of the following options: 

You can use the tools available in the toolbar located near the top of the User Report 
Editor:  

•   Save the Current Report Template using the current name.  

•   Save the Current Report Template under a new name which 
will bring up a separate dialog that allows you to specify a new 
Name and Description for your report template.  

You can also choose to use the Save commands available from the Report menu of 
the User Report Editor, as shown in Figure 17.23. 
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• Completed and saved User Reports can be 
directly accessed in the Simulation module 
from the Reports menu.  Select Reports → 
User Reports to view a list of current user 
reports (Figure 17.24).  In this example, the 
new user report created for this watershed 
is named “My_User_Report.”  Selecting 
“My_User_Report” will bring up the User 
Report previously shown in Figure 17.20. 

 

Figure 17.24 Simulation Module Reports Menu—
Accessing Saved User Reports 

17.1.8 Network Reports 

The Reservoir List, Reach List, Junction List, Diversion List, and the Network 
Connectivity Summary report are also available from the Reports menu → Network 
option of the Simulation Module.  Refer to Section 6.5 for more information about 
Network Reports. 

17.2 Printing and Exporting Reports 

From each individual report (or plot) there is a context menu that allows you to print the 
report, preview the report before you print, and export the report to an ASCII file.  Right-
clicking on the active report accesses the context menu.  You can also print or export a 
report by selecting Print or Export from the report’s Report (or File) menu. 

 

Figure 17.23 User Report Editor—
Report Menu 
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17.2.1 Printing Reports 

In one way or another, all ResSim reports are 
tables of information about your model.  Hence, 
when you select Print from a report’s context 
menu (Figure 17.25) or Report (or File) menu, the 
printed output will be a titled table containing the 
data from the active report.  The printed report 
and its columns are influenced by the width of the 
report window and the reports columns, so if 
items in the columns of the report are not printing 
as you would like, you can resize the report 
window and/or the individual columns to adjust 
the printed report.   

To resize the report columns or the report window: 

• Position the mouse pointer in the table header over one of the lines that 
separate the columns or over the window border.   

• When the resize arrows  appear, hold down the left mouse button and drag 
the mouse right or left to indicate how wide or narrow you want the columns or 
dialog.  

To print a report from the Watershed Setup module: 

• Open a report.  For example, from the Reports menu in the Watershed Setup 
module, select List of Streams 
(Figure 17.26). 

• From the Report or File menu of 
the opened report, select Print. 

• Or, right-click anywhere within 
the tabulated data of the report 
and select Print from the 
context menu (Figure 17.27). 

• The Print Properties dialog will 
open (Figure 17.28). 

• From the Page tab of the Print 
Properties dialog, you can: 

o Set the Orientation of your printed report—Portrait (default) or Landscape  

o Make the report columns fit on one page 

o Print the Entire Table (default) or just print the Selected Cells,  

o Repeat (Column) Headers on subsequent pages, 

o Display Gridlines (draw borders around each cell of the table).   

 

Figure 17.25 Report Print Option 

 

Figure 17.26 Selecting a Report 
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Figure 17.27 A Report's Context Menu   Figure 17.28 Print Properties Dialog 

• By default, the report prints in ASCII format with a white background. If you 
would like the column headers to have a light grey background, uncheck ASCII 
and check Use Header Background. If header rows are included among the data 
in the table, those rows will also get a grey background, a little darker than the 
column headers. 

• The Header/Footer tab contains two text boxes where you can enter text for a 
header and/or footer for the report.  The header will be centered just below the 
top margin (and just above the report title). The footer be centered just above 
the bottom margin and will be separated from the table data by a blank line. The 
header and footer will appear on all pages of the report.  When a header and 
footer are included, together they occupy approximately 3 lines of space on each 
page, thus reducing the number of lines of table data that will appear per page. 

• The Table Title tab contains a text box with the default title shown.  You can use 
this text box to change the title of the report.  Also on the Table Title tab is a 
check box to allow you to choose whether to repeat the report title on 
subsequent pages.  

• Once you have your print properties set, click Print and the system Print dialog 
will open (Figure 17.29).  Select a printer then click OK.  The report will be printed 
on the selected printer.  

 

Tip 
To save paper, use “Microsoft Print to PDF” to test your print settings 

before sending your report to a printer. 
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17.2.2 Print Preview 

You can preview the report before printing.  To do so: 

• Open a report by selecting one from the Reports menu. 

• Right-click anywhere within the tabulated data of the report and select Print 
Preview from the context menu.  

• The Print Properties dialog (Figure 
17.30) will appear. This Properties 
dialog differs from the one in Figure 
17.28 only by the Print button, which 
is now labeled Preview. 

• Configure your report and print 
properties as described in Section 
17.2.1 above, then click the Preview 
button.  

• The Print Preview dialog (Figure 
17.31) will open.  If you like what you 
see, you can send the report to a 
printer by clicking the Print button at 
the top of the dialog or you can close 
the Print Preview dialog by clicking 
the Close button. 

 

 

Figure 17.29 System Print Dialog  

 

Figure 17.30 Print Preview Properities Dialog 
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Figure 17.31 Print Preview Dialog 

 

17.2.3 Exporting Reports to a File 

You can export reports to an ASCII text file.  The primary reason to export the report 
to a file is to open it in another software product such as Microsoft Excel.  To export a 
report: 

• Right-click anywhere within the tabulated data of the report and select Export 
from the context menu. The Table Export Options dialog (Figure 17.32) will open.  
The options include: 

o Field Delimiter—the dropdown list 
includes TAB, SPACE, COMMA, 
COLON, and SEMI-COLON. If you plan 
to import the report into Excel, TAB 
and COMMA are the best delimiters 
to use. 

o Fixed Width Columns—although not a 
default setting, if you want the table 
to be more readable in a simple text 
editor, you may want to turn this 
option on.  The cool thing about this 
option is that, unlike the printed 
report, the “fixed” width of each 
column in the exported report is at 
least the length of the longest string (value) in that column, so you will not 
get truncated data in your exported report.  

o Quoted Strings—some software products treat spaces as string delimiters, so 
you might need this option so that a multi-word name or description is seen 
as a single string.  Be careful, if you select this option and fixed width string, 
the quoted string for each column will be padded with trailing blanks so that 
all the strings in a column have the same number of characters. 

o Include Column Headers—although the column headers are, by default, 
included in the report, you can turn them off if you wish. 

 
Figure 17.32 Table Export Options 

Dialog 
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o Print Gridlines—is another option you might want to consider but use with 
care.  This turns on Fixed Width Column and then disables the Field 
Delimiters and turns on Fixed Column Width Options.  This results in an 
exported report with fixed width columns of data separated by pipe 
characters (|) and rows of data separated by rows of dashes (-). 

o Print Title—this option adds a title to the top of the exported report.  If 
selected, a text box is available for you to enter a title. 

• Once you have chosen your desired options, click OK. 

The Save file browser will open.  Use the browser to select where you want the file to 
be saved and enter a filename.  If you want the filename to have an extension, you 
must enter your own; there is no default file extension.  Then click Save to save the 
file and close the browser. 
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Chapter 18 

Utility Scripting in ResSim 

Scripting is the process of automating the actions of an interactive program for the 
purpose of being able to execute a prescribed set of actions with a simple selection.  
Scripting can simplify user operations and abstract complexity, ensure repeatability and 
consistency of results, reduce time required to generate results, and schedule an 
operation to occur one or more times in the future. 

Scripting in ResSim takes two forms: The first form is represented by scripts that compute 
a value during each timestep of a simulation which will be used to influence the 
operation of one or more reservoirs; these are State Variables and Scripted Rules.  State 
Variables and Scripted Rules were covered in Sections 12.2 and 12.3, respectively. The 
second form is represented by scripts that perform actions outside of the compute of an 
alternative; these scripts are often referred to as utility scripts because they perform 
such tasks as producing a custom plot of results, generating custom reports, and pre– or 
post–processing of output to produce additional information not directly generated by 
ResSim.  This chapter will describe how to create, use, and manage this second form of 
scripting in ResSim, the utility scripts. 

Both forms of scripting in ResSim use the Jython scripting language.  Jython is a special 
implementation of the Python scripting language that enables scripts written in Jython to 
interact with programs written in Java.  For further details on how to write Jython utility 
scripts that utilize the Java classes from ResSim and HEC-DSSVue, see the scripting 
chapter in the HEC-DSSVue User's Manual (HEC, 2009 or later). 

Two interfaces are provided in ResSim for working with your scripts. Both are available 
from the Tools menu (Section 2.3.1.4) of any ResSim module: 

Scripts…—The first option, Scripts…, opens the Scripts window, 
where you can collect buttons for launching your 
scripts. In addition, there are options available from 
the Scripts window for scheduling the launch of a 
utility script and for monitoring the status of a 
scheduled script. 

Script Editor…—The second option, Script Editor… opens the 
interface you will use to create, edit, and test your 
scripts.  Use the Script Editor to perform all your script 
file management. 

 

 

Figure 18.1 Tools Menu 
Scripts… 
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18.1 The Scripts Window 

The Scripts window is simply a 
module-specific dialog where 
you can place buttons for 
launching your scripts.  It is 
provided to make access to your 
scripts easier than it would be if 
you had to search for your script 
in a list of available scripts.  
Figure 18.2 illustrates the Scripts 
window for each module of 
ResSim; note that the name of 
the module from which you 
opened the Scripts window 
appears in the window’s title bar. 
The script buttons that will 
appear in each module’s Scripts 
panel are set by you and each 
panel is independent of the 
others.  The idea is that scripts you would use in one module are not necessarily the 
same as those you would use in another.  However, most scripts you will write will be 
used in the Simulation module, so, for simplicity, the following discussion of utility 
scripting in ResSim assumes you are working in the Simulation module. 

To open the Scripts window: 

•  Select Scripts… from the Tools menu of the main ResSim window. 

The Scripts window contains one menu in its menu bar—Script.  From the Script menu 
(Figure 18.3), you can choose from the following options: 

Script Editor—in addition to accessing the 
Script Editor from the Tools menu of 
the main ResSim interface, you can 
access it from the Scripts panel.   

Delete—select one or more scripts to delete 
from folder in the AppData area of 
user profile where ResSim stores 
your active scripts. 

Add to Panel—add a script button to the 
Scripts panel of the main ResSim 
interface.  This panel is at the 
bottom right of the Simulation 
module, below the compute button.  
The option opens a dialog that will 
also allow you to remove a button from the Scripts panel.  Add to Panel 
cannot be used to add or remove buttons from the Scripts window; that is 

 

Figure 18.2 Scripts Windows for each Module 

 

Figure 18.3 Scripts Window—Script Menu 
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accomplished with the Show in Script Selector checkbox in the Script Setup 
pane of the Script Editor. 

Schedule Script Job…—set a date and time to automatically run a selected script (as 
long as ResSim is running). The script can be scheduled to run once or on 
repeatedly on a regular interval (Figure 18.4). 

 

Figure 18.4 Schedule Script Job 

Status…—opens the Script Job Status dialog (Figure 18.5) which lists the scheduled 
scripts their schedule and their status.   

 

Figure 18.5 Script Job Status 

Close—close the Scripts panel. 
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18.2 The Script Editor 

The Script Editor option from the Script menu opens the Script Editor (Figure 18.6).  The 
Script Editor contains a Menu Bar and three primary sections: 

Available Scripts Tree—This tree is similar to a file system tree, but it displays the logical 
organization of how your scripts are stored.  You can use this tree (or the File 
menu) to create, open, or import scripts in your watershed. 

Setup Pane—This pane is for setting up a few properties of your script, including the label 
or icon that will be displayed on a script button, the name of the file containing 
the script, and a description of the script. 

Edit Pane—This pane is where you will edit the script.  The text editor of this pane 
recognizes Python source code and will colorize the text of your script to reflect 
key elements it recognizes such as comments, strings, keywords, constants, and 
parentheses. 

The menu bar on the Script Editor includes the following three menus: 

File—contains most of the standard options you’d expect to find in a File menu 
(Figure 18.7).  One interesting aspect of the File menu is that some of the 
options are inactive (greyed out) depending on what is selected in the 
Available Scripts Tree.  

 

Figure 18.6 Script Editor 
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New—Before creating a new script, be sure to select 
the module the script will belong to in the 
Active Scripts Tree. When New is selected, 
the Setup and Edit panes become active and 
a few import lines are added to your new 
script.  Be sure to give your script a name in 
the Label field; when you do, the Script field 
will display the filename of and path to the 
script.  

Open/Edit—To open a script for editing, select an 
existing script from the Available Scripts Tree, 
then select Open/Edit from the File menu or 
click the Edit button below the tree. Or, you 
can just double-click on the script in the tree. 

Import—When Import is selected, a File Browser will 
open to allow you to navigate your file 
system to select a script to import. 

Save—Save the changes you have made to the script you have open in the 
Script Editor. 

Save As—Save the script you have open in the Script Editor to a new file with 
a new name or label. 

Delete—Delete the script you have selected in the Available Scripts Tree.  If 
you do not have a script selected or open in the Script Editor, the 
Delete option will be unavailable. 

Print—Print the script 

Test—Run or execute the script you have selected in the Available Scripts 
Tree.   

Close—Close the Script Editor.  This action is also available through the OK 
and Cancel buttons at the bottom right of the Script Editor. 

 

Figure 18.7 Script Editor 
File Menu 

 

Note: Currently, ResSim does not edit or run utility scripts that are stored 

in the watershed folder.  It stores them under the /users/ folder, which it 

creates in the AppData area of your profile on your computer.  However, 

the most logical place to store your scripts IS in your watershed, so that if 

you move or share your watershed with a colleague, all necessary 

information is contained in the watershed.   

 

Therefore, it is recommended that you maintain a utility script folder in 

your watershed directory.  Before sharing the model with a new modeler, 

copy your current utility scripts from their location in the /users/ area* to 

a location in your watershed directory.  The next modeler can then use 

the Import option to bring those scripts from their location in the 

watershed to the /users/ location, where ResSim will recognize them. 

 

* C:\Users\yourUsername\AppData\Roaming\HEC\HEC-

ResSim\3.3\users\yourUsername\yourWatershedname\ 
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Edit—contains two sets of functions (Figure 18.8).  The first set of functions are the 
standard text editing functions you might expect.  Each entry for these 
functions in the Edit menu is followed by the shortcut keystrokes that can be 
used to apply the function without accessing it from the menu.  The second 
set of functions in the Edit menu apply to the script file as a whole and could 
be considered “edits” to the Available Scripts Tree. These functions do not 
have shortcut keys.  

The text editing functions include:  

Undo—use this function to undo the last edit or 
edits to the text of your script.  With each 
selection of this option, the last edit made 
to the text will be reversed and the text will 
be restored to its prior state.  When there 
are no edits to undo, this menu entry 
displays in the menu as Can’t Undo and is 
greyed-out. 

Redo—use this function to redo the last undo.  
With each selection of this option, the last 
text edit that was reversed will be 
reapplied. When there are no edits to redo, 
this menu entry displays in the menu as 
Can’t Redo and is greyed-out. 

Cut—this function copies the selected text to the 
Windows Clipboard and deletes it from the script.  If no text has 
been selected in the script edit panel, this function is greyed-out and 
cannot be selected from the menu and its shortcut keystrokes will 
perform no action. 

Copy—This function copies the selected text to the Windows Clipboard. If no 
text has been selected in the script edit panel, this function is 
greyed-out and cannot be selected from the menu and its shortcut 
keystrokes will perform no action. 

Paste—This function copies the text that was most recently placed on 
(copied to) the Windows Clipboard into the text of the current script 
at the current position of the text cursor. 

Find—This option opens the 
Find dialog (as 
shown in Figure 
18.9).  Like most Find 
dialogs, you enter a 
string and select 
some options for 
how the find should 
operation.  The 

 

Figure 18.8 Script Editor 
Edit Menu 

 

Figure 18.9 Script Editor—Edit Menu—Find Option 
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options include the search direction (All, Up or Down), whether the 
entered string represents a word and not a substring of a word, and 
whether or not case matters to the find.   

Find Next—The Find Next function finds the next occurrence of the text that 
had been in the Find dialog the last time it was used.  Find Next does 
not open the Find dialog, nor will it report failure if it doesn’t find the 
string. 

The Available Scripts Tree edit functions include: 

Cut Script—This function deletes the currently selected script from the 
Available Scripts Tree and places it on the Clipboard.  Because the 
script file is on the Clipboard, it can be pasted back into the current 
folder of the Tree or into another one. 

Copy Script—This function copies the current script file onto the Clipboard. 

Paste Script—This function copies the script file, if there is one, from the 
Clipboard into the current folder of the Available Scripts Tree. 

The Cut Script, Copy Script, and Paste Script functions mimic the Delete, 
Save, and Save As functions from the File menu, but they do not function as 
properly or consistently, so their use is not recommended.  Use the File menu 
functions. 

Options—contains two features that influence how the tabs and spaces appear in the 
Edit pane (Figure 18.10). 

Tab Size—to set how many spaces (blank 
characters) a tab represents.  

Show Whitespace—this is a toggle that turns 
illustration of “whitespace” characters 
ON and OFF.  When ON, tabs are drawn 
with arrows and spaces are drawn with 
dots.  When OFF, tabs and spaces are drawn as blank characters. 

An example of using a Script might be to compute all the Alternatives contained within a 
Simulation (instead of running each Alternative one at a time).  Figure 18.11 shows the 
contents of an example script to run all alternatives contained within a simulation.  NOTE:  
as previously described in Section 15.1.1 and indicated in Figure 14.5, the capability to run 
all alternatives in the simulation is available from the Simulation Menu → Run Manager. 

 

Figure 18.10 Script Editor—
Options Menu 
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from hec.script import * 

from hec.hecmath import * 

from hec.heclib.dss import * 

import time 

import java.util.Vector 

# 

# The purpose of this script is to run all Alternatives in a ResSim Simulation.  

# This script should be run from the Simulation module (==>Tools menu, Scripts..) 

# There are two places where you will need to make revisions (search for REVISE) 

# Have Fun and Good Luck!!! 

#.................................... REVISE ................................. 

# the next line defines the name and location of this script's output log file 

logFileName = "C:/Program Files/HEC/HEC-
ResSim/v3.0BetaVII/users/CWMS/BaldEagleDemo/scripts/Modules/Simulation/ResSimScript_log.out" 

logFile = open(logFileName, "w") 

#============================================================================== 

def log(str) : 

 print str 

 logFile.write("%s : %s\n" % (time.ctime(), str)) 

#============================================================================== 

def runSimulation(simulationName, alternativeName=None) : 

 #----------------------------------------------------------------# 

 # Make sure we're in the correct module and open the simulation. #  

 #----------------------------------------------------------------# 

 module = ClientAppWrapper.getCurrentModule() 

 if `module` != "Simulation" : 

  title = "Incorrect Module" 

  msg = "This script must be run from the Simulation module." 

  MessageBox.showError(msg, title) 

  log("\n\n%s : %s\n" % (title, msg)) 

  return Constants.FALSE 

 

 if not module.openSimulation(simulationName) : 

  title = "Simulation Not Found" 

  msg = simulationName  

  MessageBox.showError(msg, title) 

  log("\n\n%s : %s\n" % (title, msg)) 

  return Constants.FALSE 

 

 #-----------------------------# 

 # Run all the alternative(s). # 

 #-----------------------------# 

 if not alternativeName : 

  runs = module.getSimulationRuns() 
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 else : 

  run = module.getSimulationRun(alternativeName) 

  if not run : 

   title = "Alternative Not Found" 

   msg = alternativeName  

   MessageBox.showError(msg, title) 

   log("\n\n%s : %s\n" % (title, msg)) 

   return Constants.FALSE 

  runs = [run] 

 

 for run in runs :  

  print 

  log("===========================================") 

  log("Computing %s" % run) 

  log("===========================================") 

  #module.setActiveRun(run) 

   module.computeRun(run, 5, Constants.TRUE, Constants.TRUE) 

  log("===========================================") 

  log("%s done" % run) 

  log("===========================================") 

 

   return Constants.TRUE 

#============================================================================== 

 

#--------------------------# 

# run the simulation # 

#--------------------------# 

#....................................... REVISE .................................... 

# the next line defines the name of the Simulation containing Alternatives to be run 

runSimulation("1993.11.29-0700") 

logFile.close() 

Figure 18.11 Example Script to Run Multiple Alternatives 
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Appendix A  

ResSim Application Settings 
ResSim allows you to configure a variety of program options and preferences.  You can 
create watershed locations for storing your watersheds, configure the fonts used in the 
user interface, and specify debug levels—to name just a few. These are managed by the 
ResSim Options Editor.   

Other settings, mostly related to the environment that ResSim is running in, are also 
accessible.  These settings can be viewed and managed through the Application 
Properties Editor.  

This appendix describes both the Options Editor and the Application Properties Editor, all 
their tabs, and the various properties and settings that can be managed therein.  

A.1 The Options Editor 

To access the Options Editor: 

• Select Options… from the Tools menu of any ResSim module.   

As shown in Figure A.1, the Options Editor is arranged in tabs. Some tabs are module 
dependent, such as the Simulation tab which only appears when the Options Editor is 
accessed from the Simulation module of ResSim. 

 

Figure A.1 ResSim Options Editor 
 

Unless otherwise stated, any changes you make to settings in the Options editor are 
saved as global User Preferences and are retained until reset. In this context, global 
means: applies to All watersheds.  ResSim’s User Preferences are stored in the AppData 
folder of your Windows® user profile in a folder specific to the version of ResSim that you 
are currently working with. Since they are stored per version, each time you install a new 
version of ResSim, you will need to reset your preferences; they do not carry forward. 
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A.1.1 Shortcuts 

A Watershed Location, or Shortcut, is the place on disk where you store your 
watersheds.  You can have multiple watershed locations, although a single watershed 
cannot span multiple locations.  Each watershed location is given an alias (or logical 
name) such as My Watersheds or Current Projects. 

In prior versions of ResSim, you were required to create at least one watershed 
location before you could create a watershed.  In version 3.3, that requirement has 
been removed; however there are still features in ResSim that expect your watershed 
to reside in a known watershed location so we recommend that you continue to 
create and use specified watershed locations (shortcuts) for storing your watersheds.   

So, before you create or open a watershed, you should define at least one watershed 
location.  To define a watershed location (a.k.a., a Shortcut): 

• From the Tools menu, select Options.  The ResSim Options Editor will open. See 
Figure A.1. 

• Select the Shortcuts tab.  The Name and Location of any watershed locations you 
have already defined will display in the Shortcuts list. 

• To add a new location to the 
list, click the Add Shortcut 
button.  The Add Shortcut 
dialog will open (Figure A.2) 

• Enter a Name (or alias) for the 
new shortcut, then click 
Browse….  A file browser 
window will open.  Use it to select the folder on disk where you want to store 
your watershed(s). 

• Click OK to close the Add Shortcut dialog.  The new watershed location (shortcut) 
will now appear in the list of Shortcuts on the Shortcuts tab (Figure A.1). 

A.1.2 Compute Display 

When you compute a simulation 
in the Simulation Module, the 
ResSim Compute Window opens 
(Figure A.3).  

The Compute Window reports 
on the progress of the currently 
computing alternative and 
displays messages generated by 
the ResSim compute engine.  

The Compute Display tab of the 
Options Editor (Figure A.4) 
allows you to specify the text 

 

Figure A.2 Add Shortcut Dialog 

 

Figure A.3 ResSim Compute Window 
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colors for the messages that are displayed in the Compute Window and to determine 
the format of the Compute Log. 

 

Figure A.4 Options Editor—Compute Display Tab 

Compute Window Properties—contains the options for setting the text Color for:  

• General Messages 

• Warning Messages 

• Error Messages 

Log File Properties—this section contains options for specifying the format of the 
Compute Log: 

• Use HTML for Logs—By default, the log is written in simple ASCII text 
format (the default) but if you would prefer that it be written in HTML, 
place a checkmark in the Use HTML for Logs checkbox.   

• HTML Background Color—If the Use HMTL… checkbox is checked, then 
you can select a background color for display of the HTML formatted log. 

A.1.3 Debug Levels 

The Debug Levels tab (Figure A.5) lets you manage the level of diagnostic output 
(messaging) that ResSim will generate in the ResSim Console and Compute logs.  The 
table on this tab lists Log Flags and their associated messaging Levels for various 
objects and features in ResSim that produce Level-controlled status messages.  The 
default Level settings usually provide an adequate level of diagnostic output, but if 
you are having issues in a particular area, you may find it useful to increase the log 
Level (up to 10) for a relevant Log Flag to see if additional diagnostic information 
might be produced.  

 

Note: Because ResSim uses source code that is shared with other HEC 

applications, there are Log Flags in the list of Debug Levels that are not 

applicable to ResSim. For example, the Log Flag GridUtil is used by GridUtil & 

CWMS, not ResSim. 
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Figure A.5 Options Editor—Debug Levels Tab 

HEC-DSS Debug Level—This log level is used by HEC-DSS to control the types of 
messages it produces to its log. The default value is 4 which will produce 
limited messaging in the DSS log for all DSS reads and writes.  You can reduce 
DSS logging by entering a value of 1 or 2.  Or you can increase the log level all 
the way up to 10 to get the maximum diagnostic output from DSS. 

A.1.4 General 

The General tab (Figure A.6) lets you manage settings that influence how ResSim 
behaves when opened or closed.  These options are saved as user preferences for 
this version of ResSim and will remain as set until changed. 

 

Figure A.6 Options Editor—General Tab 

Show Confirm on Exit—When you first start 
using ResSim, you will find this option is 
checked by default.  If you find it 
annoying that ResSim prompts you 
(Figure A.7) each time you try to close 
ResSim, then you can uncheck this 
option.  

Reload Last Watershed at Startup—If you will be working on the same watershed for 
a while, this option is handy.  Upon starting ResSim, it will reload the 

 

Figure A.7 Exiting Prompt 
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watershed you were working on when you last closed ResSim.  This option is 
unchecked by default.  

Tooltip Display Time—Tooltips appear when you pause your cursor over a user 
interface widget that has a tooltip defined for it.  But they don’t hang around 
long.  This option lets you change how long a tooltip will be displayed before 
disappearing.  The time is in milliseconds. 

A.1.5 Fonts 

The Fonts tab (Figure A.8) lets you specify the font that will be used for a variety of 
components (widgets) in the ResSim main user interface, windows, dialogs, and 
editors.  These widgets include:  Tabs, Labels, Descriptions for Radio Buttons and 
Checkboxes, Buttons, Lists and Text Fields. 

 

Figure A.8 Options Editor—Fonts Tab 

Font—To change the font you see throughout ResSim, use the Font drop-down list to 
select your desired font.  Use the fields below the Font selector to set the 
font Size and to make it Bold and/or Italic.  You can even enter a different 
string of Sample Text to use to see how the font will look.   

Set Font Selection—After making your selections, click the Set Font Selection button 
to apply your changes to the various widgets shown on the left side of the 
panel.  If you like what you see, click OK to apply your selections and close 
the Options Editor.  As ResSim will tell you, your new font settings will not be 
applied until the next time you start ResSim.   NOTE—you must click the Set 
Font Selection button before pressing OK, or your changes will not be applied. 

Reset Font Selection—If you don’t like how your font settings appear on the Sample 
Components, click the Reset Font Selection button to start over (return to 
defaults) or press Cancel to discard your changes and close the Options 
Editor. 
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A.1.6 Simulation Options 

The Simulation tab only appears in the Options Editor when accessed from the 
Simulation module with a watershed open. It provides some options that are 
reminiscent of those on the General tab but these options apply to the Simulation 
module.  

 

Figure A.9 Options Editor—Simulation Tab 

Reload Last Simulation on Startup—If checked, this option will cause ResSim to load 
the simulation that you last had open in each watershed you open. This 
option will work even if you do not have Reload Last Watershed at Startup 
checked on the General tab.  

Restore Simulation Tree State—The simulation tree state reflects the current settings 
of the tree in the Simulation Control panel.  These setting include the identity 
of the active alternative and the checked/unchecked state of the checkboxes 
for each alternative. 

Compute Button Forces Recompute—By default, this option is unchecked resulting in 
the following behavior:  

The Compute button on the Simulation Control panel and the Compute 
option in an alternative’s context menu will start a compute, but if 
ResSim thinks that nothing about the alternative has changed since the 
last compute, it will not actually perform the compute; instead, it will 
report in the Compute Window that it is “Skipping” the alternative.  
While in this default state, you can force a re-compute by holding the 
Ctrl key on your keyboard while clicking the Compute button or menu 
option.  

By activating this option (placing a checkmark in the checkbox), no compute 
will be “skipped” even if no changes have been made. 

Re-Use Compute Dialog—By default, the Compute Window (or Dialog) must be 
closed before a subsequent compute can be performed.  By activating this 
option, the current compute must finish before another can be started, but 
the window will not need to be closed first. 
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A.1.7 ResSim Compute Options 

The ResSim Compute tab (Figure A.10) gives you access to a number of settings that 
influence how ResSim performs its computations.  Since you can only compute from 
the Simulation module in ResSim, the ResSim Compute tab only appears in the 
Options Editor when accessed from the Simulation module with a watershed open. 

 

Figure A.10 Options Editor—ResSim Compute Tab 

Minimum Number of Compute Passes—Each time ResSim computes through the 
time window is referred to as a “pass”.  Each time you tell ResSim to 
compute an alternative it will perform at least two passes—the idea is that it 
can use the results from a prior pass to improve the results of the current 
pass.  

If the Minimum Number of Compute Passes is set to its default of 2, ResSim 
will perform two passes or more as mandated by the rule types being used in 
the alternative.  During the first pass, ResSim evaluates only “at site” rules. It 
will ignore downstream and system rules, IF-Blocks, as well as any state 
variables and scripted rules.  During the second pass, ResSim evaluates all 
active state variables and scripted rules, IF-Blocks, and it adds in the 
downstream control rules, if there are any.  During the third pass, ResSim 
adds in system rules (like Tandem, Pump Schedule, and System Hydropower).  
If there are no downstream control or system rules, ResSim will stop after 
the second pass. If there are downstream rules but no other system rules, 
ResSim will stop after computing a third pass.  If there are system rules, 
ResSim will compute a fourth pass, evaluating all the state variables, IF-
Blocks, and rules, just as it did in the third pass. 

The option to set the Minimum Number of Compute Passes is provided to let 
you determine if a greater number of passes should be computed than what 
ResSim will do by default. As such, ResSim will ignore any entry less than 2.  

So, if you have downstream control rules in your model, an effective entry 
would be greater than 3.  And, if you have system rules, an effective entry 
would be greater than 4. 
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Error Tolerance Factor for Storage Calculation—ResSim uses an estimate of the 
average pool elevation during a time step to determine release capacity of 
each outlet, so the longer the timestep, the more potentially inaccurate the 
estimate of average pool elevation could be, which would result in a 
potentially inaccurate estimate of the release capacity of each outlet. The 
computed releases from an uncontrolled outlet, like an overflow spillway, are 
often more affected by this potential inaccuracy than controlled outlets are; 
this is due to the fact that uncontrolled outlets always release at capacity, 
while controlled outlets often release at less than capacity. 

To reduce the inaccuracies, a “storage integration” scheme was added to 
integrate storage over the timestep in an effort to better estimate the 
average elevation over the timestep.  Unfortunately, this storage integration 
scheme can run into trouble converging if you have sharp inflection points in 
the storage-elevation data or in the outlet capacity curves, or if your 
reservoir storage is small compared to the release capacity.  In addition, 
if/when the storage integration scheme has trouble converging, it can add a 
significant amount of time to the compute.   

The Error Tolerance for Storage Calculation and Max Sub-steps for Storage 
Calculation parameters were added to give you control over the storage 
integration scheme.   

This option, Error Tolerance for Storage Calculation, is the convergence 
criteria in units of storage (acre-feet or cubic meters) for the integration 
scheme.  The default value is 0.00001.  If you increase the tolerance (enter a 
larger value, like 0.001), the method will converge easier but may be slightly 
less accurate.   

Max Sub-steps for Storage Calculation—This is the other parameter you can use to 
influence the storage integration computations.  This value represents the 
maximum number of time slices the method can use for integration of 
storage over the timestep.  The default value is 200.  If your timestep is 
relatively short, ResSim should need fewer sub-steps to compute a valid 
estimate of average elevation.  If you reduce the maximum number of sub-
steps, the method occasionally may not converge which could result in 
slightly less accurate results. 

Each model is different so you may need to run some tests to determine how 
sensitive your model is to these parameters.  The storage integration scheme 
outputs warning messages to the console log and error messages to both the 
Compute Window (and log) and to the console log. 

Save Release to Guide Curve to DSS—as part of the release decision process, each 
reservoir computes a “desired release to get to guide curve” for each 
timestep.  But these flows are not, by default, written as part of the standard 
output to the DSS file.  If you activate this option, you can find the desired 
guide curve release by filtering the pathnames in DSSVue to a C-part of 
FLOW-GC-RELEASE. 
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Do Not Include System Hydropower in Requirements for Number of Routing Steps—
because routing effects (lag and attenuation) can affect downstream control 
and system operations, ResSim attempts to estimate these affects at the 
start of the compute process.  These estimates result in a routing window (or 
Number of Routing (time)Steps) over which ResSim iterates in an attempt to 
determine an appropriate release from each reservoir.   

As a system rule, the routing between System Hydropower reservoirs can, by 
default, influence the size of the total routing window. But, since System 
Hydropower does not have a target location for the system reservoirs to 
operate for, the influence of routing between the system hydropower 
reservoirs may not be relevant (e.g., if all the reservoirs in the system were 
on parallel streams).  Use this option to turn off the influence of the System 
Hydropower rules on the routing window. 

Reset Defaults —Press this button to reset the options listed 
above to their default values. 

 

—Shortly after rate of change impacts were added to 
the guide curve logic, user control over those impacts was added.  To access 
the options for controlling the impact of rate of change rules on the guide 
curve logic, click the Edit Global ROC Options button. The Global ROC Options 
Editor will open (Figure A.11). 

 

Note:  Rate of Change Rules have more impact than you might think… 

ResSim’s decision logic tries to meet its objectives as fast as possible, usually 

within the current timestep.  But rate-of-change constraints are in direct 

opposition to that tendency; their objective is to slow things down.  To more 

fully address this objective, logic was added to the downstream control and 

guide curve methods to account for rate of change constrains.  So, besides 

acting as normal release limit rules, Rate of Change rules also impact 

downstream control and guide curve by extending the time window over 

which the two methods try to meet their objectives.  The options below are 

intended to give you some control over the impact of Rate of Change rules 

on Guide Curve operations. 
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Figure A.11 Global ROC Options Editor 

Consider Rate of Change in Guide Curve Release Computations—this 
checkbox acts as an ON/OFF switch for the application of Rate of 
Change rules upon the Guide Curve logic. By default, this option is 
ON by default.  If you uncheck this option, all other parameters are 
deactivated. 

Minimum Look Ahead—this option is the minimum number of days 
that the ROC rules will add to the time window over which 
the Guide Curve logic will attempt to get the reservoir back 
to guide curve. 

Maximum Look Ahead—this option is the maximum number of days 
that the ROC rules can add to the time window over which 
the Guide Curve logic will try to get the reservoir back to 
guide curve. 

Allow Iterations for Variable ROC—Since rate of change rules can vary with 
inflow, outflow, or pool elevation, the impacts of the rate of change 
on the guide curve logic’s time window can vary as a result of the 
decision that is currently being determined.  This option allows you 
provide convergence criteria for evaluating the impact in this 
timestep. This feature is ON by default. The convergence parameters 
include: 

Maximum Iterations—this value limits how many attempts ResSim 
can make to determine the time window impact on the 
Guide Curve logic per timestep.  

Flow Tolerance—if the difference in flow between one iteration and 
another is less than this value, the iterations stop—the logic 
is considered to have reached “convergence”. 

Storage Tolerance—if the difference in ending storage between one 
iteration and another is less than this value, the iterations 
stop. 
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—If you have made changes to the Global 
ROC Options, you can return all the settings to the ResSim defaults 
by pressing this button. 

 

Unlike most other settings in the Options Editor, the settings on the ResSim 

Compute tab are stored in the watershed, not as User Preferences. 

A.1.8 Advanced Options 

The Advanced tab gives you access to a couple of settings related to scripted State 
Variables and Rules.  Since you can only interact with the State Variable and Scripted 
Rule editors from the Network and Simulations modules, the Advanced tab only 
appears in the Options Editor when accessed from the Network or Simulation 
modules. 

 

 Figure A.12 Options Editor—Advanced Tab  

Allow State Variables to be defined as Java Classes—by turning this option on, you 
active an option in the State Variable Editor that will allow you to identify a 
Java class file as the implementation of your state variable rather than the 
native Jython script.  By writing your own Java class for your state variable 
you can improve compute time of your state variable by 20% or more.  This 
option should be seriously considered for state variables scripts that are very 
long, complicated, and access a significant number of ResSim model objects 
and their methods. 

Allow Reservoir Operation Scripted Rules to be defined as Java Classes—this option is 
exactly the same as the one above for State Variables, but it applies to 
scripted rules. 

 

 

Since these settings impact how you create your operations in the current 

watershed, the settings on the Advanced tab are stored in the watershed, not 

as User Preferences. 
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A.2 The Application Properties Dialog 

The Application Properties dialog is a viewer for a variety of properties related to the 
current watershed as well as the environment in which ResSim is running.  Similar to a 
File->Properties dialog in a Windows application, the Application Properties editor 
provides details about your ResSim setup.  These details include information about your 
local computer (your ResSim root directory, whether you are working in local or 
networked mode, and the IP address of your computer); your unique user properties 
(your user ID, user name, login, user directory path, preference directory, and access 
levels); watershed properties for the watershed you are viewing; server properties 
(application server, File manager, and login server); and system properties. Editing 
capability is limited and should be treated with care. 

To open the Application Properties dialog: 

• Select Information from the Tools menu of any ResSim module. 

Like the Options editor, the Application Properties dialog is organized with tabs, as 
illustrated in Figure A.13. 

 

Figure A.13 Application Properties Editor—Watershed Tab 

 

 

Note: ResSim was originally designed and built as a tightly integrated tool of a 

larger software development project (CWMS).  Because of that effort, not only 

does ResSim share a lot of code with other HEC applications, it was also created 

to work in a client-server environment.  Much of the information provided by the 

Application Properties dialog was considered important in that client-server 

framework but is of little to no interest when ResSim in run as a standalone 

program—which is how it is assumed you are running ResSim.  Therefore, only 

those parameters and attributes that may be of interest in standalone have been 

documented here.  For details on other parameters, you can refer to the CWMS 

User’s Manual. 
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A.2.1 Watershed Properties 

The Watershed tab of the Application Properties editor (Figure A.13) displays 
properties of the currently opened watershed including the: 

• Name 

• Path 

• Units 

• Time Zone 

• Coordinate System 

See Chapter 3 for details on how these properties are defined. 

A.2.2 User Properties 

The User tab of the Application Properties editor (Figure A.14) is primarily used for 
displaying user information.  The only useful entry on this tab is the: 

User Preferences Directory—the folder where your User Preferences are stored. 

 

Figure A.14 Application Properties Editor—User Tab 

A.2.3 Client Properties 

The Client tab of the Application Properties editor (Figure A.15) displays information 
about ResSim and how it is running on your computer.  The properties of interest 
include:  

Base Directory—This is the path where you stored your watershed.  If you identified 
a watershed location (shortcut) when you created the watershed, this is the 
directory the shortcut points to.  

Java Version—This is the version number of the Java JRE that is running ResSim. 

Jar Versions—This is a list of the program jars (Java Archives) that make up ResSim.  
Following each jar in the list is its build number.  The jars should all have the 
same build number. 
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Figure A.15 Application Properties Editor—Client Tab 

A.2.4 Server Properties 

The Server tab of the Application Properties editor (Figure A.16) displays no useful 
information when ResSim is not running in Client-Server mode. 

 

Figure A.16 Application Properties Editor—Server Tab 

A.2.5 System Properties 

The System Properties tab of the Application Properties editor (Figure A.17) displays 
a list of various environment variables and command line settings that are 
considered system properties of ResSim.  Many of these variables are specified in the 
HEC-ResSim.config file that accompanies the HEC-ResSim.exe file which is used to 
launch (execute) ResSim.  Although this tab has features necessary to edit these 
properties, don’t use them. 
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Figure A.17 Application Properties Editor—System Properties Tab 

  

 

Very few, if any, of the System Properties should ever be changed by you, the 

user.  But, if you must make changes to any of these properties, do so in the 

HEC-ResSim.config file (or its companion, the HEC-ResSim - Personal.config 

file located in your AppData area), not from this Editor. 
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Appendix B  

Working with Map Display Layers 
Layers in ResSim can be displayed, one on top of the other, in the Map Display area of 
ResSim.  There are three types of layers used in the display: map layers, image layers, and 
ResSim layers.  Map layers typically come from GIS shapefiles, DEMs, or DLGs and may 
contain features such as roads, political boundaries (cities, counties, etc.), rivers, 
subbasins, waterbodies, etc.  Image layers are geospatially referenced images, which may 
also contain similar information, or perhaps photographic or satellite imagery.  Each of 
these files, along with its associated data, is a called layer.  In addition to these static map 
and image layers are ResSim schematic layers that are shown by default depending on 
the current module and the currently open dataset.  Each ResSim module includes its 
own default layers -- Watershed Setup: Time Series Icons, Study, and Stream Alignment; 
Network: ResSim and Stream Alignment; Simulation: Model Schematic (which contains 
the ResSim layer) and Stream Alignment.  These ResSim schematic layers contain 
elements that represent parts of the model schematic you create for your watershed.   

Layers are considered hierarchical, which means that they may contain zero or more sub-
layers. The first or top layer of a layer hierarchy is referred to as the primary or root layer.  
Each sub-layer usually represents a different type of component or element contained in 
the layer.  Layers that do not have sub-layers usually contain only one type of drawing 
element or type.  Most static map or image layers contain only one element type. 

This appendix describes the various functions of the Layer Selector including: 

• Adding Map Layers 

• Setting the Watershed Coordinate System 

• Editing Map Layer Properties 

• Editing Schematic Layer Properties 

B.1 The Layer Selector 

The Layer Selector manages the 
organization and properties of the 
various Map Display Layers described 
above, including the  Stream Alignment 
layer, the schematic layers, and the map 
layers. 

To access the Layer Selector (Figure B.1) 
from any module: 

• Select Layers… from the View menu.  

 

 

 
 

Figure B.1 Layer Selector 
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B.2 The Layer Selector Menus 

The menus of the Layer Selector provide a variety of tools for managing the layers 
displayed in the Map Display area. If a command or option in a menu is greyed-out, the 
option is unavailable either because you have not turned on Allow Layer Editing from the 
Edit menu or the option cannot be used for the currently selected layer in the Layers 
tree.  The menus of the Layer Selector include: 

Layers (Figure B.2)—This menu is 
equivalent to a File menu.  
However, since the Layer Selector 
does not manage a file that 
contains its configuration settings, 
the only option in the Layers menu 
is Close, which will close the Layer 
Selector.  Other ways to close the Layer Selector include:  

• The OK and Cancel buttons at the bottom of the Layer Selector 

• The X at the end of the Title Bar 

Edit (Figure B.3)—this menu provides tools 
for rearranging layers, viewing and 
editing layer properties, and adding 
and removing user toolbar buttons. 

Allow Layer Editing—The Layer 
Selector uses a “locking” 
concept similar to that 
used by the Watershed 
Setup and Reservoir 
Network modules.  The 
Layer Selector always 
opens in an “unlocked” 
state which limits the 
functions that you can 
perform on the existing layers and does not allow you to add layers.  To 
enable all (or most) of the functionality in the Layer Selector, you must 
first “lock” it for editing by selecting Allow Layer Editing from the Edit 
menu. When editing is enabled, a checkbox appears next to the Allow 
Layer Editing menu item as shown in Figure B.3. 

Move to Top, 
Move Up, 
Move Down, 
Move to Bottom—These commands change the position of the currently 

selected layer in the Layers tree and how the layer is drawn in the Map 
Display.  The current position of the selected layer will determine which 
Move commands are available in the Edit menu.  When a layer is already 
at the top, the Move to Top and Move Up options will be unavailable.  

 

Figure B.2 Layers Menu 

 

Figure B.3 Edit Menu 
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Likewise, if a layer is at the bottom, the Move Down and Move to Bottom 
options will not be available. 

 Maps (Figure B.4)—This menu allows you 
to add and remove map layers, as 
well as import images as layers.  
The Map Display Coordinates 
option opens the Geographic 
Region editor.  These functions are 
described in Section B.5.1 below. 

 

 View (Figure B.5)—this menu has the following two options that impact the “view” of the 
Layer Selector itself: 

Expand / Collapse—This option causes the selected layer in the Layers tree to 
display its sub-layers (or Legend).  This is the same functionality as 
clicking on the plus-sign of 
the selected layer in the 
tree.  Once you have 
expanded a layer, Expand 
changes to Collapse in the 
menu.  Use Collapse to 
cause the selected layer to 
hide its sub-layers or Legend. This is the same functionality as clicking on 
the minus-sign of the selected layer in the tree.   

Always on Top—This option in the View menu is a “toggle switch”.  When active 
or ON, this option keeps the Layer Selector on top of all other windows 
on your desktop. If a checkmark precedes this option in the View menu, 
the option is active. 

 

B.3 The Layers Tree 

The Layers Tree is a tree widget used in the Layer Selector for displaying the hierarchical 
organization of the map, schematic, and image layers in your watershed.  The top level of 
the tree (or root node) is the Layers folder, which contains all of the layers in the 
watershed relevant to the current module. Beneath the Layers folder are the primary 
layers.  Each primary layer represents one of the layer types and is drawn as a branch in 
the tree with a plus/minus box, followed by a checkbox, then the layer name.  A primary 
layer may have one or more components layers which is why a primary layer is referred 
to as a branch.  Each component layer is drawn below the primary layer’s checkbox with 
a plus-minus box and checkbox of its own. 

In the following sections you will learn how to interact with the layers in the Layer 
Selector by using the options menus and context menus, the plus/minus boxes, the 
checkboxes, and the properties editors. 

 

Figure B.4 Maps Menu 

 

Figure B.5 View Menu 
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B.3.1 Controlling the Layer Display 

The plus/minus box  in front of each primary and component layer implements the 
same functionality as the Expand and Collapse options in the View menu.   

 Expand/Plus Sign—Click on a plus sign to expand a tree branch to display component 
sub-layers; if no sub-layers exist, you will see a legend for the layer (if a 
legend exists).   

Collapse/Minus Sign—Click on a minus sign to 
collapse the tree branch or sub-branch 
below the minus sign.   

You can also expand and collapse layers by double-
clicking on the layer name (but don’t be surprised if 
the Properties editor for that layer opens too.)  
Figure B.6 shows the Layer Selector with some of 
the Study Layer’s sub-layers expanded. 

The checkbox  that follows the plus/minus box 
turns the display of the layer ON or OFF in the Map 
Display. When a primary layer is un-checked (OFF), 
neither the primary layer nor its components layers 
will display. When checked (ON), the primary layer 
and all its checked component layers will display. 

B.3.2 Viewing a Layer’s Legend 

When you click on the plus symbol  to the left of a layer (or sub-layer) with no 
components or sub-layers of its own, the component’s legend will be drawn below 
the component in the tree.  The legend is the icon or drawing style of the component 
as it will appear in the Map Display. 

The type of legend displayed is determined by the file formats or layer type.  Figure 
B.6 shows the legend for Computation Points, Diversions, and Reservoirs, which are 
elements of the Study (watershed configuration) layer. 

B.3.3 Accessing a Layer’s Context Menu 

You can access a primary layer’s context menu by right-clicking on the layer in the 
Layers tree of the Layer Selector. Context menus offer commonly used commands 
that are also available in the Layer Selector’s Edit and View menus.  Figure B.7 shows 
the context menu for the Stream Alignment layer. 

If a command or option in a context menu is greyed-out, the option is unavailable 
either because you have not turned on Allow Layer Editing from the Edit menu or the 
option cannot be used for the currently selected layer in the tree. 

 

 

Figure B.6 Study Layer—Expanded 
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The common commands available in a layer’s 
context menu include: 

Expand—opens the branch of a layer to display 
its component (sub-)layers.  Collapse 
closes layer’s branch to show only the 
primary layer.  If a layer does not have 
sub-layers, Expand will show the 
layer’s legend. 

Move to Top,  
Move Up,  
Move Down, and  
Move to Bottom—use these commands to 

rearrange the layers in the tree.  The 
current position of an individual layer 
will determine which Move command 
are available. These options are 
described in detail in Section B.3.4. 

Properties—opens a Properties editor for the 
layer, allowing you to change how the elements of that layer will be drawn in 
the Map Display area. 

For map layers (Figure B.8), there are several 
additional options available in the context menu: 

Show Legend option expands the map layer 
tree to display the map legend.  This 
option changes to Hide Legend when 
the layer is expanded, allowing you to 
close the branch view of legends.   

Change Label option allows you to change the 
name of the layer in the tree.  

Set Scale for Zoom-in, 
Set Scale for Zoom-out, and 
Remove Scale Factors—use these commands 

to describe how the layer should 
appear in the Map Display relative to 
the zoom level.  

Attributes Table…—this option will open a 
dialog showing a table of the attributes 
and their values for the elements in 
the selected shapefile layer.  

 

Figure B.7 Layer Selector—Schematic 
Layer Context Menu 

 

Figure B.8 Layer Selector—Map Layer 
Context Menu  
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B.3.4 Managing Layer Order 

The Layer Selector controls how layers are arranged in the Map Display Area.  When 
you add map layers to the watershed, the map layer is added to the bottom of the 
list of maps in the Layers Tree of the Layer Selector.   

Use the Layer Selector to rearrange the order of the primary layers: 

• From the Edit menu, select Allow Layer Editing. 

• Select the layer you would like to move. 

• From the Edit menu or from the layer’s context menu, select: 

Move to Top—to move the layer to the front of the map display and to move 
the layer to the top of the layers in Layers tree. 

Move Up—to move the layer towards the front of the map display and to 
move the layer up in the Layers tree. 

Move Down—to move the layer toward the back of the Map Display and to 
move the layer down in the Layers tree.   

Move to Bottom—to move the layer to the back of the Map Display and to 
move the layer to the bottom of the layers in Layers tree. 

To see your changes, click Apply (to keep the Layer Selector open) or click OK to 
close the Layer Selector. 

B.4 ResSim Default Layers 

ResSim has a three default layers, the Time-Series Icon Layer, the Schematic layer, and 
the Stream Alignment Layer.  These layers are described in the following sections. 

B.4.1 Time Series Icon Layer 

Time-Series Icons are used in the CWMS CAVI to display data of various types for key 
locations in a watershed.  They usually represent a gage and may contain datasets for 
each parameter measured at or derived for that gage.   

The Time Series Icon Layer contains all of the time-series icons created in your 
watershed and may contain sub-layers that represent one or more dataset types.  

 

Although you can create Time-Series Icons and their layers in the Watershed 

Setup module in ResSim, ResSim does not use time-series icons nor does it 

display them in its Reservoir Network or Simulation modules.  Refer to the 

CWMS User’s Manual for additional details about Time-Series Icons. 

B.4.2 Schematic Layer 

The Schematic Layer has a different name, contains different component layers, and 
uses different display properties in each module of ResSim: 

• In the Watershed Setup module, the schematic layer is called Study. 

• In the Reservoir Network module, the schematic layer is called ResSim. 

• In the Simulation module, the schematic layer is called Model Schematic. 
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B.4.2.1 Study Layer 

The Study layer is the schematic layer that is displayed in the Watershed Setup 
module of ResSim. The Study layer contains all of the schematic elements that 
you can define in your watershed configurations including the various project 
types, impact areas, and computation points.  The elements displayed by the 
Study layer in the Map Display area are a function of the currently selected 
Configuration. 

When you are in the Watershed Setup 
module, the Layer Selector includes Study 
as a primary layer in the Layers tree 
(Figure B.9). 

When you click on the plus sign in front of 
the Study layer in the Layers tree, the 
layer expands to show the set of 
component layers contained in the Study 
layer, including:  

• Computation Points 

• Diversions 

• Names (labels for the projects, 
computation points, and impact 
areas) 

• Reservoirs 

• Channel Modifications 

• Levees 

• Off Channel Storage 

• Other Projects 

• Impact Areas   

ResSim creates a sub-layer for each component types even before you have 
defined any projects, computation points, or impact areas.  Each component 
layer can be turned on and off without impacting the display of the other 
components. 

B.4.2.2 ResSim Layer 

The ResSim layer (Figure B.10) is the 
schematic layer that is displayed in the 
Reservoir Network module of ResSim. 
The ResSim layer contains all of the 
schematic elements that you can define 
in your reservoir networks. However, the 
elements displayed in the Map Display 
area of the Reservoir Network module as 
represented by the ResSim layer are a 
function of the currently open reservoir 

 

Figure B.9 Study Layer 

 

Figure B.10 ResSim Layer 
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network; if no network is open, only the stream alignment and map layers will be 
shown in the Map Display area and in the Layers tree of the Layer Selector. 

When you are in the Reservoir Network module, the Layer Selector includes 
ResSim as a primary layer in the Layers Tree.  When you click on the plus sign in 
front of the ResSim layer in the Layers Tree, the layer expands to show the set of 
component layers contained in the ResSim layer, including:  

• Reservoirs 

• Reaches 

• Diversions (and Diverted Outlets) 

• Junctions 

B.4.2.3 Model Schematic Layer 

The Model Schematic layer (Figure B.11) 
represents the model schematic in the 
Simulation module.  It contains the 
ResSim layer and its component layers as 
described in Section B.4.2.2.  

When you are in the Simulation module, 
the Layer Selector includes Model 
Schematic as a primary layer in the Layers 
tree. 

The elements drawn in the Map Display 
area of the Simulation module as 
represented by the Model Schematic layer are a function of the currently active 
alternative.  If no alternative is active, only the stream alignment and map layers 
will be shown.  

B.4.3 Stream Alignment Layer 

The Stream Alignment layer contains the 
Stream Alignment which represents the river 
system in your watershed.  The Stream 
Alignment layer includes three component 
sub-layers (Figure B.12):   

• Streams 

• Stream Nodes 

• Stream Junctions 

The Stream Alignment layer is available in the 
Layer Selector in all three ResSim Modules. 

 

Figure B.11 Model Schematic Layer 

 

Figure B.12 Stream Alignment Layer 
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B.5 Map Layers 

ResSim can display various types of maps in the geo-referenced Map Display area.  These 
maps, displayed as map layers, are static images and are typically used as background for 
your model schematic to give the watershed “context”.  Examples of map layers include 
rivers, subbasins, county and state boundaries, etc.  Map layers are not interactive.   

Several map file formats are supported in ResSim including: 

• ESRI® Shapefiles 

• AutoCAD® DXF files 

• ArcInfo® DEM files  

• USGS Digital Line Graphs (DLG) files 

• USGS Digital Elevation Model (DEM) files 

• ASCII NET TIN files 

• Raster images 

B.5.1 Adding and Removing Map Layers 

You will find it helpful to add maps to the watershed and the display area to provide 
a geographical reference for time-series icons, the stream alignment, and projects in 
your watershed. 

B.5.1.1 Adding Map Layers 

To add a background map to the Map Display area:  

• First, copy any maps you wish to use to the maps folder of your watershed. 

• From the Edit menu of the Layer Selector, select Allow Layer Editing. 

• From the Maps menu, select Add Map Layer…  A file browser will open to the 
default maps folder of your watershed.   

• From the file browser, select the map you wish to add. Click OK to accept the 
chosen file and close the file browser. 

• The selected map now appears in the Layer Selector Tree as a new primary 
layer (or branch).  See “Adding a Map Layer” in Chapter 3 for more 
information. 

B.5.1.2 Removing Map Layers 

To remove a map layer from the Map Display area: 

• Select the layer in the Layers tree of the Layer Selector 

• Select Remove Map Layer from the Maps menu 
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B.6 Configuring Layer Drawing Properties 

The Layer Selector provides three ways to access a Properties editor in order to view and 
configure the drawing properties of the selected layer.  You can: 

• Select a layer in the Layers tree, then select Properties from the Edit menu. 

• Right-click on a layer in the Layers tree, the select Properties from its context menu. 

• Double-click on a layer in the Layers tree. 

Each of these techniques opens a Properties editor specific to the layer type. Each type of 
schematic layer, map layer, or image layer has its own editor for configuring the drawing 
properties of its components.  For information about configuring the Time-Series Icon 
Layer, refer to the CWMS User’s Manual (HEC, 2010). 

B.6.1 Stream Alignment Layer Drawing Properties 

When you select Properties for the Stream Alignment layer, the Stream Alignment 
Properties Editor (Figure B.13) appears.  

 

Figure B.13 Stream Alignment Properties Editor  

The Stream Alignment Properties editor allows you to view and edit the following 
properties related to how the stream alignment is drawn in the Map Display: 

Stream Width—Select the line width of the streams, in points, from the selection list.  
Possible values are 1—10. The default stream line width is 6. 
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Stream Color—Select the color of the stream lines from the list of pre-defined colors. 
The default stream color is a custom color of orange. 

Show Stream Name—Use the checkbox to indicate if the stream name labels should 
be drawn with the streams in the Map Display. Uncheck the box to turn OFF 
the stream names. 

Choose Font—This button opens the Font Chooser (Figure B.15).  Use it to modify 
the font properties for the stream name labels. The stream names will be 
drawn using the Stream Color. 

Draw Station Tics—Tic marks are drawn perpendicular to the stream line to mark 
approximate distance along the stream from downstream to upstream. Use 
the checkbox to indicate if the stationing tic marks should be drawn along 
the streams in the Map Display. Uncheck the box to turn OFF the tic marks. 
The tic marks and their labels will be drawn using the Stream Color. 

Tic Length—Select the length of the minor tic marks, in points, from the 
selection list. The default minor tic length is 7. 

Major Tic Length—Select the length of the major tic marks, in points, from 
the selection list. The default major tic length is 14. 

Draw Tic Labels—Use the checkbox to indicate if the tic mark labels should 
be drawn with the tic marks of the streams in the Map Display. 
Uncheck the box to turn OFF the tic mark labels. 

Tic Labels Font—this Choose Font… button will open the Font Chooser. Use it 
to set the font properties for tic mark labels. 

Draw Stream Nodes—Small circles are used to represent the stream nodes. By 
default, a stream node is created at the endpoints of every stream. Use the 
checkbox to turn ON or OFF the drawing of the stream nodes on the streams 
in the Map Display. 

Node Color—Select the fill color of the stream nodes from the list of pre-
defined colors. The default stream node color is a custom color of 
green. 

Node Outline Color—Select the outline color of the stream nodes from the 
list of pre-defined colors. The default stream node color is a custom 
color of dark green. 

Node Width—Select the diameter of the stream nodes, in points, from the 
selection list.  Possible values are 1–10. The default node diameter 
(width) is 7. 

Draw Junctions—Stream junctions are drawn at the connection of two or more 
streams; they appear as a larger circle (or halo) behind the smaller stream 
node circles that are created and drawn at the endpoints of every stream.  
Use the checkbox to turn ON or OFF the drawing of the stream junctions.  

 

The stream alignment tic marks can strongly influence how the schematic 

layers are drawn, especially the labels for the various schematic elements.  

Once your stream alignment has been finalized, you probably won’t need 

the station tic marks, so turn them off for a cleaner view of your schematic. 
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Junction Color—Select the color of the stream junction from the list of pre-
defined colors. The default stream junction color is bright green, a 
custom color of green. 

Junction Width—the size of the circle that forms the stream junction halo, in 
units of points. 

The Stream Alignment Properties editor has a preview pane located on the right side 
of the editor.  This preview pane allows you to view your changes before applying 
them. 

B.6.2 Study Layer Drawing Properties 

When you select Properties for the Study layer, the Drawing Properties Editor 
appears (Figure B.14). This editor has six tabs that allow you to view and edit 
properties of Reservoirs, Levees, Diversions, Channel Modifications, Computation 
Points, and Impact Areas in your watershed. The Study Layer is available only in the 
Layer Selector when opened from the Watershed Setup module.  

B.6.2.1 Reservoirs 

Reservoirs are drawn using four distinct elements: 

• a Triangle Element—a re-shapeable polygon representing the reservoir pool, 

• a Storage Reach Element—a thick line that follows the stream alignment and 
stretches from the inflow location(s) to the outflow location(s), 

• a Dam Element—a rectangle drawn at the reservoir’s outflow location(s), and 

• a Reservoir Name label.   

The Reservoir tab (Figure B.14) provides options for setting how reservoirs will 
appear in the Map Display. It is organized to present the drawing properties of 
each element of the reservoir separately.  

 

Figure B.14 Drawing Properties Editor—Reservoir Tab 

The reservoir drawing properties you can modify include: 

Triangle Fill Color—select the fill color of the reservoir pool polygons from the list 
of pre-defined colors. The default fill color is cyan.  
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Triangle Outline Color—select the color of the reservoir pool polygons outline 
from the list of pre-defined colors. The default line color is blue.  

Draw Reservoir Triangle—Use the checkbox to indicate if the reservoir pool 
polygons should be drawn in the Map Display area. Uncheck the box to 
turn OFF the reservoir pool polygons. 

Storage Reach Fill Color—select the fill color of the reservoir storage reaches 
from the list of pre-defined colors. The default fill color is cyan.  

Storage Reach Outline Color—Select the color of the outline of the reservoir 
storage reaches from the list of pre-defined colors. The default outline 
color is blue. 

Storage Reach Width—Select the width of the storage reaches, in points, from 
the selection list.  Possible values are 1–10. The default width is 10.  

Dam Fill Color—Select the (fill and outline) color of the dam rectangles from the 
list of pre-defined colors. The default color is grey.  

Dam Width—Select the width of the dam rectangles, in points, from the 
selection list.  Possible values are 1–10. The default width is 10. The 
length of the dam rectangle is a multiple of the width.   

Draw Reservoir Name—Use the checkbox to indicate 
if the reservoir name labels should be drawn 
in the Map Display. Uncheck the box to turn 
OFF the reservoir names. 

Font…—This button opens the Font Chooser (Figure 
B.15).  Use it to select the Font and Size of 
the name label and whether it should be 
Bold and/or Italic.  You can even change the 
Sample Text used to preview your selections. 
Click OK to save your settings and close the 
Font Chooser. The reservoir names will be 
drawn using the Triangle Outline Color. 

B.6.2.2 Levees 

Levees are drawn as a line that parallels the stream alignment. The Levees tab 
(Figure B.16) provides options for setting the drawing properties of that line and 
its label.  

 

Figure B.16 Drawing Properties Editor—Levees Tab 

 

Figure B.15 Font Chooser 
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The levee drawing properties you can modify include: 

Levee Line Color—Select the color of the diversion line from the list of pre-
defined colors. The default levee line color is black.  

Levee Width—Select the diversion line width, in points, from the selection list.  
Possible values are 1–10. The default width is 8.  

Draw Levee Name state—Use the checkbox to indicate if the name labels should 
be drawn with the levees in the Map Display area. Uncheck the box to 
turn OFF the levee names. 

Font…—This button opens the Font Chooser (Figure B.15). Use it to modify the 
font properties for the levee name labels. The levee names will be drawn 
using the Levee Line Color. 

B.6.2.3 Diversions 

A diversion is drawn as a polyline with an arrowhead at the downstream end.  
The connectivity of the downstream end of a diversion is reflected in the color of 
the arrowhead.  

The Diversions tab (Figure B.17), provides options for setting how diversions will 
appear in the Map Display area.  The diversion drawing properties are presented 
in three sections—the Line Element, the Arrowhead Element, and the Name 
label.  

 

Figure B.17 Drawing Properties Editor—Diversions Tab 

The diversion drawing properties you can modify include: 

Diversion Line Color—select the color of the diversion line from the list of pre-
defined colors. The default diversion line color is black. 

Diversion Line Width—select the line width, in points, from the selection list.  
Possible values are 1–10. The default diversion line width is 5. 

Diversion Arrowhead Color - Connected—This is the fill color of the arrowhead 
when the diversion is connected to a computation point at the 
downstream end.  Select the color from the list of pre-defined colors. 
The default fill color is blue. The outline color of the arrowhead is always 
black. 
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Diversion Arrowhead Color - Disconnected—This is the fill color of the arrowhead 
when the diversion is not connected to anything at its downstream end. 
Select the color from the list of pre-defined colors.  The default fill color 
is black.  The outline color of the arrowhead is always black. 

Draw Diversion Name—Use the checkbox to indicate if the name labels should be 
drawn with the diversions in the Map Display area. Uncheck the box to 
turn OFF the diversion names. 

Font…—This button opens the Font Chooser (Figure B.15).  Use it to modify the 
font properties for the diversion names. The diversion names will be 
drawn using the Diversion Line Color. 

B.6.2.4 Channel Modifications  

A channel modification is drawn as a thick line on top of the stream alignment. 
The Channel Modification tab (Figure B.18) provides options for setting how 
channel modifications will appear in the Map Display area.  

 

Figure B.18 Drawing Properties Editor—Channel Modification Tab 

The channel modification drawing properties you can modify include: 

Channel Modification Line Color—Select the color of the line drawn on top of the 
stream alignment from the selection list. The default color is black.  

Channel Modification Width—Select the line width, in points, from the selection 
list.  Possible values are 1–10; the default is 10. 

Draw Channel Modification Name—Use the checkbox to indicate if the name 
labels should be drawn with the channel modifications in the Map 
Display area. Uncheck the box to turn OFF the channel modification 
names. 

Font…—This button opens the Font Chooser (Figure B.15). Use it to modify the 
font properties for the channel modification name labels. The channel 
modification names will be drawn using the Channel Modification Line 
Color. 
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B.6.2.5 Computation Points  

The Computation Point tab (Figure B.19) of the Drawing Properties Editor 
provides options for setting the computation point drawing properties, however 
only modifications to the Computation Point Name properties will actually 
impact what you see in the Map Display.   

 

Figure B.19 Drawing Properties Editor—Computation Point Tab 

The computation point name drawing properties you can modify from the 
Drawing Properties Editor include:  

The rest of the drawing properties for the computation point elements in the Map 

Display are managed by the Computation Point Layer Editor.   

To open the Computation Point Layer Editor: 

▪ Select Computation Point Layers from the Edit menu of the Watershed Setup 

module.  

The Computation Point Layer Editor allows you to create computation point 
layers and set the drawing properties per layer.  Every watershed is created 
with a default computation point layer—called Default.  In ResSim watersheds, 
this is really all you need since ResSim cannot take advantage of additional 
computation point layers.  

The computation point drawing properties available in the Computation Point 
Layer Editor (Figure B.20) include the Computation Point’s: 

 
Figure B.20 Computation Point Layer Editor 

▪ Background Color—the 

outline of the symbol... 

▪ Foreground Color—the fill 

color of the symbol... 

▪ Symbol—the shape or text 

character used to represent 

the computation point on 

the map schematic. 

▪ Symbol Size—a value, in 

points, between 4 and 25.  

A value of 10 is 

approximately equal to the 

size of a 10pt font. 

See the HEC-WAT User’s 

Manual for more details on 

Computation Point layers. 
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Draw Computation Point Name—Use the checkbox to turn ON or OFF drawing of 
the computation point name labels in the Map Display.  

Font…—This button opens the Font Chooser (Figure B.15). Use it to modify the 
font properties for the computation point name labels. The computation 
point names will be drawn in black. 

B.6.2.6 Impact Areas 

The Impact Area tab (Figure B.21) provides options for modifying the Impact Area 
Name label properties.  They include: 

Draw Impact Area Name—Use the checkbox to indicate if the name labels should 
be drawn with the impact areas in the Map Display. Uncheck the box to 
turn OFF the impact area names. 

Font…—This button opens the Font Chooser (Figure B.15). Use it to modify the 
font properties for the impact area name labels. The impact area names 
will be drawn in black. 

 

Figure B.21 Drawing Properties Editor—Impact Area Tab 

B.6.3 ResSim Layer Drawing Properties 

When you select Properties for the ResSim layer, the ResSim System Draw Properties 
editor appears (Figure B.22). This editor has four tabs that allow you to view and edit 
properties of the Reservoirs, Junctions, Reaches, and Diversions in your model 
schematic. The ResSim layer is available in the Layer Selector when opened from the 
Reservoir Network and Simulation modules. However, in the Simulation module, the 
ResSim layer appears as a sub-layer under Model Schematic. 

B.6.3.1 Reservoirs 

In the ResSim layer, reservoirs are drawn using the same four distinct elements 
as in the Study layer: 

• a Triangle Element—a re-shapeable polygon representing the reservoir pool, 

• a Storage Reach Element—a thick line drawn on top of the stream alignment; 
it stretches from the inflow junctions(s) to the outflow junctions(s), 

• a Dam Element—a rectangle drawn behind the reservoir’s outflow 
junction(s), and 

• a Reservoir Name label.   
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The Reservoir tab (Figure B.22) of the ResSim System Draw Properties editor 
provides options for setting how reservoirs will appear in the Map Display, but 
there are fewer properties to set/modify than in the Study layer: 

Fill Color—Select the fill color of 
the reservoir pool 
polygon from the list of 
pre-defined colors.  The 
default fill color is cyan.   

Note—the reservoir 
storage reach will be 
drawn with a dark 
version of the selected 
fill color; as such, the 
default fill color for the 
reservoir storage reach 
is a dark cyan. 

Outline Color—Select the 
outline color of the 
reservoir pool polygon 
and the reservoir 
storage reach from the list of pre-defined colors.  The default outline 
color is blue.  

Dam Color—Select the fill and outline color of the dam from the list of pre-
defined colors.  The default dam color is blue. 

Minimum Dam Width—Select the width of the dam rectangle, in points, from the 
selection list.  Possible values are 1–15. The default width is 10. The 
length of the dam rectangle is a multiple of the width.   

Reach Width—Select the line width, in points, from the selection list.  Possible 
values are 1–15. The default storage reach width is 10. 

Draw Reservoir Polygon—Use the checkbox to indicate if the reservoir pool 
polygons should be drawn in the Map Display area. Uncheck the box to 
turn OFF the reservoir pool polygons. 

Draw Reservoir Name—Use the checkbox to indicate if the reservoir name labels 
should be drawn in the Map Display. Uncheck the box to turn OFF the 
reservoir names. 

Name Font…—This button opens the Font Chooser (Figure B.15).  Use it to 
modify the font properties of the reservoir name labels. The reservoir 
names will be drawn using the Outline Color. 

 

Figure B.22 ResSim Layer Draw Properties—
Reservoirs 
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B.6.3.1 Junctions 

Junctions are drawn as filled circles.  The Junction tab (Figure B.23) of the ResSim 
System Draw Properties editor provides options for modifying how junctions will 
appear in the Map Display: 

Junction Width—Select the 
diameter of the circle, 
in points, from the 
selection list.  Possible 
values are 1–15. The 
default diameter is 12. 

Fill Color—Select the fill color of 
the junction circle from 
the list of pre-defined 
colors.  The default fill 
color is red.   

Outline Color—Select the 
outline color of the 
junction circle from the 
list of pre-defined colors.  The default outline color is blue. 

Draw Junction Name—Use the checkbox to indicate if the junction name labels 
should be drawn in the Map Display. Uncheck the box to turn OFF the 
junction names. 

Name Font…—This button opens the Font Chooser (Figure B.15).  Use it to 
modify the font properties of the junction name labels. The junction 
names will be drawn using the Fill Color. 

B.6.3.1 Reaches 

Reaches are drawn as a thick 
line on top of the stream 
alignment.  The Reach tab 
(Figure B.24) of the ResSim 
System Draw Properties editor 
provides options for modifying 
how reach will appear in the 
Map Display: 

Reach Width—Select the width 
of the reach line, in 
points, from the 
selection list.  Possible 
values are 1–15. The 
default diameter is 10. 

 

Figure B.23 ResSim Layer Draw Properties—
Junctions 

 

Figure B.24 ResSim Layer Draw Properties—Reaches 
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Fill Color—Select the fill color of the reach line from the list of pre-defined colors.  
The default fill color is blue.   

Outline Color—Select the outline color of the reach line from the list of pre-
defined colors.  The default outline color is blue. 

Draw Reach Name—Use the checkbox to indicate if the reach name labels should 
be drawn in the Map Display. Uncheck the box to turn OFF the junction 
names. 

Name Font…—This button opens the Font Chooser (Figure B.15).  Use it to 
modify the font properties of the reach name labels. The reach names 
will be drawn using the Outline Color. 

Draw Flow Direction Arrow—Use the checkbox to indicate if the flow direction 
arrows should be drawn at the midpoint of each reach in the Map 
Display. Uncheck the box to turn OFF the flow direction arrows. 

B.6.3.1 Diversions 

A diversion is drawn as a polyline with an arrowhead at the downstream end.  
The connectedness of a diversion is reflected in the color of the arrowhead.  

The Diversion tab (Figure B.25) of the ResSim System Draw Properties editor 
provides options for modifying how diversion will appear in the Map Display: 

Fill Color—Select the fill color of the reach line from the list of pre-defined colors.  
The default fill color is 
blue.   

Outline Color—Select the 
outline color of the 
diversion reach line 
from the list of pre-
defined colors.  The 
default outline color is 
blue. 

Connected Fill Color—Select the 
outline color of the 
reach line from the list 
of pre-defined colors.  
The default outline 
color is blue. 

DisConnected Fill Color—Select 
the outline color of the 
reach line from the list of pre-defined colors.  The default outline color is 
blue. 

 Diversion Width—Select the line width of the diversion, in points, from the 
selection list.  Possible values are 1—15. The default line width is 6. 

 

Figure B.25 ResSim Layer Draw Properties—
Diversions 
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Draw Diversion Name—Use the checkbox to indicate if the reach name labels 
should be drawn in the Map Display. Uncheck the box to turn OFF the 
junction names. 

Name Font…—This button opens the Font Chooser (Figure B.15).  Use it to 
modify the font properties of the reach name labels. The diversion 
names will be drawn using the Outline Color. 

B.6.4 Map Layer Drawing Properties 

Map layers can be any of a number of formats supported by ResSim, including 
ArcView® Shapefiles, ArcInfo® DEM files, AutoCAD® DXF files, U.S Geological Survey 
(USGS) Digital Line Graphs (DLG) files, USGS Digital Elevation Model (DEM) files, ASCII 
NET TIN files, and raster images.  So, when you select Properties for a map layer, the 
editor that opens is specific to the type of map. ResSim allows you to configure 
several options for each type of map (except for AutoCAD® DXF files). 

To access the Properties editors for a map layer: 

• Open the Layer Selector (Figure B.26) by 
selecting Layers... from the View menu of 
any module.   

• In the Layers Tree, double-click on the map 
layer or right-click on it and select 
Properties from the context menu.   

An editor specific to the type of map will open. 
The directory location of the map file in your 
ResSim watershed is shown at the top of each 
Properties editor.  

The following sections describe most of the 
map layer editors currently available in ResSim. 

B.6.4.1 Shapefiles (*.shp)  

The shapefile spatial data format was developed by the Environmental Systems 
Research Institute, Inc. (ESRI) and is now a (mostly) open geospatial vector data 
format that can be used by ArcGIS and other geographic information system 
(GIS) software.  Shapefiles store non-topological geometry and attribute 
information for the spatial features of a data set.   

ResSim can use three types of shapefiles (*.shp):  Point, Line, and Polygon. Each 
shapefile type has its own properties editor.  Each properties editor is organized 
into 2 or 3 tabs.  One of the tabs in each editor is the Label tab which looks and 
works the same in each editor and is described in its own section following the 
descriptions of the three shapefile editors. 

ResSim saves the drawing properties of your shapefile(s) to a file with the same 
base name as your shapefile and the extension .gdr.  This file will be stored in the 
maps folder for your watershed.    

 

Figure B.26 Layer Selector 
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Point Shapefile Properties 

If the map layer you wish to configure is a point shapefile (e.g., gages, control 
points), selecting Properties for the map layer will open the Edit Point Properties 
editor.  This editor is organized in two tabs—Style and Label.  

The Style tab lets you set the drawing properties of the Point elements in the 
shapefile.  The drawing properties that you can modify are a function of the first 
field in the panel, Draw Features using.  The options are: 

 One Style (Figure B.27)—under this option, the drawing properties are:   

Style—the symbol used to represent each point. 
Color—the color of the symbols. 
Size—the size of the symbols, in 

points. 

Attribute Values (Figure B.28)—under 
this option, the drawing 
properties expand to: 

Field for Values—select the 
attribute whose values 
will determine the color 
of each point. 

Style—the symbol used to 
represent each point. 

Size —the size of the symbols, in 
points. 

Color—two colors are used to 
define the Start and End 
colors of a color ramp. 
ResSim will determine 
the number of unique 
values in the selected 
attribute field, then 
create a gradation set of 
colors ranging between 
the Start and End colors, 
with a different color in 
the gradation for each 
unique attribute value.   
The set of colors and 
their associated 
attribute values will be 
displayed in the Color-
Value table. 

 

Figure B.27 Edit Point Properties 
Style Tab—One Style 

 

Figure B.28 Edit Point Properties 
Style Tab—Attribute Values 
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Line Shapefile Properties 

If the map layer you wish to configure is a line shapefile (e.g., rivers and streams), 
selecting Properties for the map layer will open the Edit Line Properties editor.  
This editor is organized in two tabs—Style and Label. 

The Style tab lets you set the drawing properties of the Line elements in the 
shapefile.  The drawing properties that 
you can modify are a function of the first 
field in the panel, Draw Features using:. 
The options are: 

One Style (Figure B.29)—under this 
option the drawing properties 
are:  

Color—the color of the line that 
is drawn for each 
element in the shapefile. 

Style—the line style, such as 
solid, dashed, dotted, 
etc.  

Weight—the thickness of the 
line. 

Attribute Values (Figure B.30)—under 
this option, the drawing 
properties expand to: 

Field for Values—select the 
attribute whose values 
will determine the color 
of each line. 

Style—the line style, such as 
solid, dashed, dotted, 
etc. used to draw each 
line in the shapefile  

Weight—the thickness of the 
lines.  

Color—two colors are used to 
define the Start and End 
colors of a color ramp. 
ResSim will determine 
the number of unique 
values in the selected 
attribute field, then 
create a gradation set of colors ranging between the Start and 
End colors, with a different color in the gradation for each 
unique attribute value.   The set of colors and their associated 
attribute values will be displayed in the Color-Value table. 

 

Figure B.29 Edit Line Properties 
Style Tab—One Style 

 

Figure B.30 Edit Line Properties  
Style Tab—Attribute Values  
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Polygon Shapefile Properties 

If the map layer you wish to configure is a 
Polygon shapefile (e.g., lakes), selecting 
Properties for the map layer will open the 
Edit Polygon Properties editor.  This editor 
is organized in three tabs—Fill, Border, and 
Label. 

The Fill tab lets you set the fill drawing 
properties for the polygon elements in the 
shapefile.  These properties are a function 
of the first field, Draw Features using:. The 
options are: 

One Fill (Figure B.31)—under this option, 
the drawing properties are:  

Color—the color of the interior of 
each polygon element in 
the shapefile. 

Style—the fill style, such as solid, hashed, lined, etc.  
Transparency—a value between 1 and 100; 1 is fully opaque; 100 is fully 

transparent. 

Attribute Values (Figure B.32)—under this 
option, the drawing properties 
expand to: 

Display Fill—Use the checkbox to 
turn ON or OFF drawing 
the fill of the polygons in 
your shapefile. 

Field for Values—select the 
attribute whose values will 
determine the fill color of 
each polygon 

Style—the fill style, such as solid, 
hashed, lined, etc.  

Transparency—a value between 1 
and 100; 1 is fully opaque; 
100 is fully transparent. 

Color—the fill color properties 
take up the rest of the edit 
panel.  But you really have 
only two color fields to 
set—Start and End.  
ResSim is going to 
determine the number of 
unique values in the 

 

Figure B.31 Edit Polygon Properties—Fill 
Tab—One Fill 

 

Figure B.32 Edit Polygon Properties—Fill 
Tab—Attribute Values 
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selected attribute field, then it is going to create a color 
gradation ranging between the Start and End colors with a 
different color in the gradation for each unique attribute value.  
The set of colors and their associated attribute value will be 
displayed in the Color-Value table. 

Use Gradations—Use the checkbox to turn ON or OFF the use of 
gradations in the use of the color ram.  If checked ON, you can 
set the number of gradation colors. The values of the selected 
attribute will then be divided into ranges, one range for each of 
the gradation colors. 

The Border tab (Figure B.33) lets you set the 
outline drawing properties for each polygon 
element in the shapefile.  Your options 
include: 

Display Border—Use the checkbox 
to turn ON or OFF drawing 
of the borders of the 
polygons.   

Color—the color of the line that is 
drawn for around each 
polygon element in the 
shapefile. 

Style—the line style, such as solid, dashed, dotted, etc.  
Weight—the thickness of the line. 

Shapefile Label Properties 

The Label tab (Figure B.34) of each of the shapefile Properties editors look and 
function in exactly the same way.  This tab 
lets you set whether or not the labels are 
drawn and with what font, size, and 
position. 

Label Features using:—To draw the 
labels, select the attribute 
whose values you want to use 
as the labels for element in 
the shapefile. To NOT draw 
labels for each element, 
select <None> (which will 
disable the selection of the 
rest of the label drawing 
properties.) 

Font—select a font (typeface) to use 
to draw the labels 

Bold—On/Off—makes the text bold 

Figure B.33 Edit Polygon Properties—
Border Tab 

Figure B.34 Edit Shapefile Properties—
Labels Tab 
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Italic—On/Off—makes the 
text italic 

Size—the font size, in points. 

Placement—select one of 
the eight points of 
the compass to 
determine where 
you want the label 
drawn relative to 
each element.  For 
example, North 
would place the 
label centered 
above the element. 

Rotation—select a rotation value to draw the label.  Horizontal is 0.  The 
increasing values are clockwise from the horizontal.  Upside-down is 
180. 

All labels are drawn with respect to a label “handle” or position.  In general, this 
handle is located near the center of the element plus a hard-coded offset; it is 
usually NOT obvious where the label handle is located because it can be affected 
by your Position selection.  Try testing out a few Position and Rotation settings to 
understand how the various settings will affect where and how your labels will be 
drawn. 

B.6.4.2 USGS Digital Line Graph Maps (*.dlg) 

If the map layer you wish to configure is a USGS Digital Line Graph map (*.dlg), 
selecting Properties from the map will open the USGS Digital Line Graph Editor 
(Figure B.35).  When ResSim loads with a dlg file, it automatically creates a dlgbin file 
for use within the watershed.  The dlgbin file contains the dlg information in binary 
form as well as your drawing properties.  

On the Properties tab of the USGS Digital Line Graph Editor, you can modify the 
following drawing attributes:  

Default Color—the button open a Color Chooser (Figure B.39) from which you 
can select the color you want the elements in your map drawn. 

Draw Nodes, 
Draw Lines, 
Draw Areas—use the checkboxes to turn ON or OFF the drawing of the nodes, 

lines, or areas in your map. 

Saturation—Control the intensity of the color used to draw the elements in your 
map by entering a decimal value between 0 and 1. The default value is 1. 

 

Figure B.35 USGS Digital Line Graph Editor for DLG 
Map Layer—Properties Tab 
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Brightness—Control the amount of white in the color used to draw the elements 
in your map by entering in a decimal value between 0 and 1. The default 
value is 1. 

On the Scale tab of the USGS Digital Line Graph Editor (Figure B.36), you can specify 
how the map will be displayed based on zoom level: 

Always show layer—by default, the digital line graph layer is set to always display, 
regardless of the zoom level. 

Only show layer in the following scale range—select this radio button if you want 
the map to display only for specific zoom ranges:  

Only visible below 1: To set the scale (zoom range) so that the digital line 
graph layer becomes visible as you zoom-in, you can set the scale 
to the current scale by clicking Set to Current or enter a value in 
the box.  

Only visible above 1: To 
set the scale so 
that the digital 
line graph layer 
becomes visible 
as you zoom-
out, you can set 
the scale to the 
current scale by 
clicking Set to 
Current or enter 
a value in the 
box. 

B.6.4.3 ArcInfo® DEM, ASCII DEM, and ASCII NetTIN Maps 

If the map layer you wish to configure is an ArcInfo® DEM (*.asc), ASCII DEM (*.dem), 
or ASCII NetTIN (*.net) file, selecting Properties from the map opens the Elevation 
Options editor (Figure B.37).  The Elevation Options editor is organized in two tabs—
Properties and Scale.  

The Properties tab allows you to define the properties for drawing the terrain map 
using color contours.  The drawing properties include: 

The Color Contour type—this is the selector in the upper left corner of the panel.  
The selection list includes: Aspect Shading, Grayscale, Linear, 
Precipitation, Red-Green-Blue, or Terrain.   

Draw Edges—this option is specifically for ASCII NetTIN files.  If checked, the 
edges of the triangles that make up an ASCII NetTIN file will be drawn. 

Tic Interval—used for marking the color contours 

Contour Limits—set the Maximum/Minimum values for Contour Limits.  By 
default, Contour Limits are set to System Specified Min/Max Values 

 

Figure B.36 USGS Digital Line Graph Editor—
Scale Tab 
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based on the elevation data in stored in the map.  If you deselect the 
checkbox, you can enter custom values.  

Brightness—the relative lightness or darkness of a color from 0 to 1 (black to 
white). 

Saturation—the intensity or density of the color, measured from 0 (grey) to 100 
(vivid color). 

Transparency—the level of opacity, measured from 0.0 to 1.0, of your gridded 
data layer.  

Aspect Shading—On/Off—If you are using elevation maps, you may wish to 
choose Aspect Shading as the color contour and activate the Aspect 
Shading option.  Aspect Shading uses a single color and makes the map 
appear in relief by placing an imaginary light source above the map and 
shading the elevation contours.  When the Aspect Shading option is On, 
use the Angle slider to adjust the angle of the light source. 

Maximum Clipping and Minimum Clipping—On/Off—by default, these options 
are unchecked (Off).  If you activate these options, the Value sliders and 
Color buttons become available for setting the end points of the color 
ramp. 

Figure B.37 Elevation Options Editor 
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The Value sliders allow you to specify the amount of Clipping within the 
Contour Limits you have specified; you can also type values into 
the text boxes.   

 Color—these buttons open the Color Chooser (see Section B.8 for a 
description of the Color Chooser). 

Scale—The color ramp on the right side of the Properties tab will reflect your 
drawing property settings. 

On the Scale tab of the Elevation 
Options Editor (Figure B.38), you can 
specify how the map will be displayed 
based on zoom level: 

Always show layer—by default, the 
digital line graph layer is set 
to always display, regardless 
of the zoom level. 

Only show layer in the following 
scale range—select this 
radio button if you want the 
map to display only for 
specific zoom ranges:  

Only visible below 1: To set the scale (zoom range) so that the digital line 
graph layer becomes visible as you zoom-in, you can set the scale 
to the current scale by clicking Set to Current or enter a value in 
the box.  

Only visible above 1: To set the scale so that the digital line graph layer 
becomes visible as you zoom-out, you can set the scale to the 
current scale by clicking Set to Current or enter a value in the 
box. 

 

Figure B.38 Elevation Options—Scale Tab 
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B.7 Using the Color Chooser 

Most drawing properties editors only provide a limited list of colors to choose from for 
setting the color of a particular layer element.  However, some Properties editors let you 
use the Color Chooser to pick a color for the layer element. The Color Chooser affords 
great flexibility for select default colors.  The Color Chooser has three tabs:  Swatches, 
HSB, and RGBA, offering three methods for choosing a color.  For each method, the 
preview area shows you how your selected color will look—review it carefully before 
applying your changes (clicking OK). 

B.7.1 Swatches 

To select a color from the 
Swatches tab (Figure B.39), click 
on the swatch of the color you 
want.  The Recent panel keeps 
track of your choices so you can 
return to them easily. 

B.7.2 HSB Colors 

HSB stands for Hue, Saturation 
and Brightness. Hue is the basic 
color.  Saturation is how dark the color is (how much black is added).  Brightness is 
how light the color is (how much white is added).  To select a color from the HSB tab 
(Figure B.40): 

•  Start by selecting the Hue—
select the Hue radio button 
then select a color by moving 
the rainbow slider bar in the 
middle of the tab panel.  A 
value will appear in the Hue 
textbox representing your 
color selection and the 
associated values of Red, 
Green, and Blue that make up 
that hue will be shown. 

•  The large box to the left of 
the slider bar will fill to show 
the range of saturation and 
brightness you can select 
from for the Hue you chose.  
Click in the box to pick a 
shade of your selected Hue.  The Saturation and Brightness values will update to 
reflect your selection.  The Red, Green, and Blue fields will also update to show 
the equivalent RGB values for your selected color. 

 

Figure B.39 Color Chooser—Swatches Tab  

 

Figure B.40 Color Chooser—HSB Tab  
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If using Hue is not effective for finding the color you want, you can also select a color 
by choosing the Saturation or Brightness radio buttons and adjusting your color 
selection with the slider bar and the shade box. 

Hue (H) is measured in a circle from 0 to 359 degrees (0=red, 60=yellow, 
120=green, 180=cyan, 240=blue, 00=magenta). 

Saturation (S) is the intensity or density of the hue, measured from 0 (grey) to 
100 (vivid color). 

 Brightness (B) is the relative lightness or darkness of a color from 0 (black) to 
100 (while). 

B.7.3 RGBA Colors 

To select a color from the RGBA 
tab (Figure B.41), use the sliders 
or type in values to select the 
Red, Green, Blue, and Alpha 
values to produce the color you 
want. 

We all know what Red, Green, 
and Blue are, but when mixing 
these colors as light, not paint, 
most folks don’t know how to 
produce certain familiar colors, 
so Table B.1 has some examples. 

Alpha is another aspect of 
defining the color of light that 
may be unfamiliar, but it is really 
just opacity or transparency.  The 
larger the alpha value, the darker (and denser) the color; the smaller the alpha value, 
the lighter and more transparent the color.   

Table B.1 Example Colors in RGB Values 

Color Red Green Blue 

Black 0 0 0 

Med. Grey 128 128 128 

White 255 255 255 

Yellow 255 255 0 

Green 0 128 0 

Lime Green 0 255 0 

Cyan/Aqua 0 255 255 

Blue 0 0 255 

Navy 0 0 128 

Maroon 128 0 0 

Red 255 0 0 

Purple 128 0 128 

Magenta/Fuchsia 255 0 255 

Figure B.41 Color Chooser—RGBA Tab 
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B.8 Creating User Toolbar Buttons 

A User Toolbar Button acts as a shortcut for controlling the view of a layers in your Map 
Display without having to open the Layer Selector. These buttons are useful when you 
need to have frequent control over layers that are being displayed.  User Toolbar Buttons 
are module specific, which means that if you create a button in the Watershed Setup 
module, it will not appear in the Simulation module unless you create it (again) in that 
module.   

Clicking a User Toolbar Button turns the associated layer ON or OFF in the Map Display, in 
much the same way as the checkbox in the Layers Tree in the Layer Selector.  

Right-clicking on a toolbar button opens a context menu that gives you access to the 
layer’s properties editor and the ability to select and deselect sub-layers to be 
displayed. The options available from a toolbar button’s context menu depend 
upon the associated layer’s layer type. 

Hovering your cursor over a toolbar button displays a tooltip with a description of the 
button or the layer it is associated with. 

To create a toolbar button:  

• Open the Layer Selector and select a layer in the 
Layers tree. 

• From the Edit menu, select Add Toolbar Button.  
The Toolbar Button Editor (Figure B.42) opens. 

• The layer’s name appears in the Tool Tip field, but 
you can enter a more descriptive tooltip if desired. 

• Select an icon from the Icon list to display on the button. If you forget to select an 
icon, a toolbar button will not be created. 

• Select OK to finish creating the Toolbar Button.  Cancel will abort the process. 

The toolbar button will appear in the Module toolbar above the Map Display Area as 
shown in Figure B.43. 

To remove a toolbar button: 

• Select the layer in the Layers Tree of the Layer Selector 

• From the Edit menu, select Remove Toolbar Button.   

To remove all toolbar buttons that you have defined: 

• Select Reload Default Button from the Edit menu in the Layer Selector. 

 

BLUF (Bottom Line Up Front) 
The results of recent testing suggest that the User Toolbar Buttons may be more 

trouble than they are worth. These buttons seem to have more scope than they 

should, i.e., when added to one watershed, they may show up in other 

watersheds. You may find yourself Removing the Toolbar Buttons repeatedly 

from both the original watershed as well as watersheds that shouldn’t show 

them.  And, the Reload Default Button function doesn’t appear to clear them 

out everywhere or permanently. 

 

Figure B.42 Toolbar Button Editor 
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Figure B.43 User Toolbar Button Added to Main ResSim Window 

B.9 Defining the Watershed Coordinate System  

In Chapter 3, the section titled “Setting the Geographic Coordinate System” explains how 
to specify the coordinate system of your watershed by accessing the Display Coordinate 
Information.  This Appendix section provides more detailed information related to setting 
up the coordinate system for your watershed. 

B.9.1 Accessing Display Coordinate Information 

The Display Coordinate Information editor is accessible from the Layer Selector which 
can be opened from any of the three ResSim modules.  To open it: 

• Select Layers from the View menu in the Main ResSim window.  The Layer 
Selector will open 

• Select Map Display Coordinates from the Maps menu of the Layer Selector. 

• In the Display Coordinate Information editor, select Edit. 

• The Map Coordinate Information editor will appear where you can set the 
appropriate coordinate information. 

The above steps are illustrated in Figure B.44. 
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Table B.2 shows the options available for System, Units, and Spheroid.  When you 
choose specific coordinate systems, not all options are available from the Spheroid 
list.  For example, choosing X-Y from the System list deactivates the Spheroid list.  
Additionally, when State Plane Coordinates is selected as the System, only Clarke 
1886 and GRS 1980 are available choices from the Spheroid list. 

  

 

Figure B.44 Steps for Accessing the Coordinate System 
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Table B.2 Available Map Coordinate Systems, Units, and Spheroid Options 

System Units Spheroid 

X-Y 
U.S. Feet 

Meters 

International Feet 

X-Y does not allow selection of Spheroid 

Geographic 
Radians 

Seconds of Arc 

Degrees of Arc 

• Clarke 1866 (NAD27) 

• WGS 72 

• GRS1980 (NAD83) 

• WGS84 

• Sphere of Radius 6371200 Meters 

Universal Transverse 

Mercator(2) 

U.S. Feet 

Meters 

International Feet 

• Clarke 1866 (NAD27) 

• WGS 72 

• GRS1980 (NAD83) 

• WGS84 

• Sphere of Radius 6371200 Meters 

State Plane Coordinates(3) 
U.S. Feet 

Meters 

International Feet 

• Clarke 1866 (NAD27) 

• GRS1980 (NAD83) 

Albers Equal-Area Conic(4) 
U.S. Feet 

Meters 

International Feet 

• Clarke 1866 (NAD27) 

• WGS 72 

• GRS1980 (NAD83) 

• WGS84 

• Sphere of Radius 6371200 Meters 

Lambert Conformal Conic(4) 
U.S. Feet 

Meters 

International Feet 

• Clarke 1866 (NAD27) 

• WGS 72 

• GRS1980 (NAD83) 

• WGS84 

• Sphere of Radius 6371200 Meters 

Transverse Mercator (5) 
U.S. Feet 

Meters 

International Feet 

• Clarke 1866 (NAD27) 

• WGS 72 

• GRS1980 (NAD83) 

• WGS84 

• Sphere of Radius 6371200 Meters 

Albers Equal-Area Conic 

(SHG) 

U.S. Feet 

Meters 

International Feet 

• Clarke 1866 (NAD27) 

• WGS 72 

• GRS1980 (NAD83) 

• WGS84 

• Sphere of Radius 6371200 Meters 

Polar Stereographic (HRAP) 
U.S. Feet 

Meters 

International Feet 

• Clarke 1866 (NAD27) 

• WGS 72 

• GRS1980 (NAD83) 

• WGS84 

• Sphere of Radius 6371200 Meters 
(2) Universal Transverse Mercator System also requires a UTM Zone to be entered 
(3) State Plane Coordinates also requires a numeric Zone to be entered (e.g., 3701) 
(4) Albers Equal-Area Conic and Lambert Conformal Conic also require the following: •Latitude for the 

first and second standard parallel, •Longitude of the central meridian, •Latitude of the projection origin, 

•False easting and northing 

(5) Transverse Mercator also requires the following entries: 
Scale factor and Longitude of the central meridian, Latitude of the projection origin, False easting and 

northing. 
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B.9.2 Coordinate Systems Options 

The following sections describe each of the Coordinate Systems that are available 
from the Map Coordinate Information editor. With one exception, all require you to 
select distance Units and a Spheroid definition. Each spheroid definition inherently 
describes a prime meridian and a datum. 

The options for distance Units include: 

• (U.S. Feet 

• Meters 

• International Feet 

The options for Spheroid definition include: 

• Clark 1866(NAD27) 

• WGS 72 

• GRS 1980(NAD83) 

• WGS 84 

• Sphere of Radius 6371200 Meters 

B.9.2.1 X-Y System 

X-Y is a simple Cartesian 
coordinate system 
(Figure B.45). 

B.9.2.2 Geographic 

System 

A Geographic 
coordinate system 
(Figure B.46) defines 
locations on the earth 
using a three-dimensional spherical surface. This coordinate system differs from 
the others in that the Units are not of distance but rather angle.  The Units 
options include: 

• Radians 

• Seconds of Arc 

• Degrees of Arc 

 

Figure B.45 X-Y Coordinate System 

 

Figure B.46 Geographic Coordinate System—Spheroid List 
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B.9.2.3 Transverse Mercator System  

and Universal Transverse Mercator (UTM) System 

The Transverse Mercator coordinate system represents the earth as a spheroid 
that has been flattened onto a transverse (sideways) cylinder such that each 
longitude line is equally spaced and parallel to one another. Small shapes are well 
represented because this projection preserves angular relationships, but area 
becomes increasingly distorted the further you get from the equator (toward the 
Polar Regions). 

The Universal Transverse Mercator (UTM) coordinate system is a special 
implementation of the Transverse Mercator system that divides the globe into a 
specific set of 60 6° north-south segments or zones. The limits of each zone 
extent to 84 N and 80 S.  Each zone is divided into a north and south half at the 
equator.  The Polar Regions use the Universal Polar Stereographic coordinate 
system. 

For the Transverse Mercator coordinate system (Figure B.47), you must choose 
both the Units (U.S. Feet, Meters, or International Feet) and Spheroid. 

Additional required 
information includes: 
Scale factor at central 
meridian; Longitude of 
the central meridian; 
Latitude of the 
projection origin; False 
easting; and False 
northing. 

When specifying 
latitudes, use N or S.  
For longitudes, use E 
or W.  You may either 
type these into the 
fields or use the 
SPACEBAR on your 
keyboard to toggle 
between the acceptable entries (after placing your cursor in the first box of 
either the latitude or longitude field). 

 

Figure B.47 Map Coordinate Information 
Transverse Mercator System 
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The Universal Transverse Mercator system (Figure B.48) is a specialized form of 
the Transverse Mercator projection.  It uses a simple Cartesian coordinate 
system to represent 
locations on the earth. 
It represents the earth 
as a spheroid divided 
into 60 6° north-south 
segments or zones, 
flattens (transforms) 
each segment onto a 
transverse (sideways) 
cylinder, and applies an 
X-Y coordinate system 
to it.  To use this 
system for your 
watershed, you must select: 

• Distance Units (U.S.) 

• Spheroid definition 

• UTM Zone  

B.9.2.4 State Plane Coordinates System 

The State Plane coordinate system (Figure B.49) is a set of 124 geographic zones 
covering the 50 US 
states and US 
territories. It uses a 
simple Cartesian 
coordinate system to 
specify locations rather 
than a more complex 
spherical coordinate 
system. This system 
requires that you 
select: 

• Distance Units 

• Spheroid definition: 

o Clarke 1866 (NAD27) 
o GRS 1980(NAD83)  

• Zone 

 

Figure B.48 UTM Coordinate System 

 

Figure B.49 State Plane Coordinate System 
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B.9.2.5 Albers Equal-

Area Conic 

System 

and Lambert 

Conformal Conic 

System 

The Albers Equal-Area 
Conic coordinate 
system (Figure B.50) 
is based on a 
projection of a 
horizontal section of 
the earth onto a cone 
placed directly above 
the pole.  The section 
of the earth that is 
projected is defined by two standard parallels—circles around the earth parallel 
to the equator.  The Albers projection preserves the area of each section at the 
expense of a small distortion of distance (shape). 

Like Albers, the Lambert Conformal Conic coordinate system (Figure B.51) is 
based on a projection of a horizontal section of the earth onto a cone placed 
directly above the 
pole. The Lambert 
Conformal Conic 
differs from the 
Albers Equal Area 
Conic projection 
because it preserves 
distances (shape) 
within each section at 
the expense of a 
small error in area. 

These projections are 
best for regions that 
are predominately 
east-west in 
orientation and are 
best applied in the 
middle latitudes (the zones nearer the equator).  The difference between the 
first and second parallels should not exceed 30-35 degrees. 

To use one of these coordinate systems for your watershed, you must specify 
quite a few parameters: 

• Distance Units 

 

Figure B.50 Albers Equal-Area Conic Coordinate System 

 

Figure B.51 Map Coordinate Information 
Lambert Conformal Conic System 
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• Spheroid definition 

• Latitude of the two standard parallels 

• Longitude of the central meridian 

• Latitude of the projection origin 

• False easting—a value for the origin of the x-coordinates 

• False northing—a value for the origin of the Y-coordinates 

When specifying latitudes, use N or S.  For longitudes, use E or W.  You may 
either type N, S, E, or W into the fields, or use the SPACEBAR on your keyboard to 
toggle through the acceptable entries (after placing your cursor in the first box of 
either the latitude or longitude field). 

B.9.2.6 Albers Equal-Area Conic (SHG) System 

The SHG version of the 
Albers Equal-Area 
Conic (SHG) 
coordinate system 
(Figure B.52) displays a 
set of default 
parameters.  These 
parameters cannot be 
changed.  If you must 
change them, use 
instead the Albers 
Equal Area Conic 
system described 
above. 

 

 

 

 

Figure B.52 Map Coordinate Information 
Albers Equal-Area Conic (SHG) System 
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B.9.2.7 Polar Stereographic (HRAP) System 

The Polar 
Stereographic (HRAP) 
coordinate system 
(Figure B.53) is used 
by the National 
Weather Service for 
describing their 
NEXRAD precipitation 
grids.  The editor for 
this coordinate system 
shows the default 
parameters that 
define the HRAP 
system.  These 
parameters cannot be 
changed. 

 

 

 

Figure B.53 Map Coordinate Information 
Polar Stereographic (HRAP) System 
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Appendix C  

Commonly Used Editors and Dialogs 
There are a few editors and dialogs that are used repeatedly throughout the ResSim user 
interface.  These editors have the same purpose or provide the same functionality for a 
variety of model features.  To minimize repetition in the manual, the details of these 
editors and dialogs are described here. 

C.1 File Browser Dialog 

A file browser dialog may be 
used whenever ResSim needs 
to know a filename or a 
directory or folder location. 

The file browser can come in a 
variety of shapes, sizes, and 
views, but they all have 
essentially the same 
purpose—to help you identify 
and select a file (or folder) on 
your computer.   

Figure C.1 shows the Open file 
browser that is opened when 
you select Open Watershed… 
from the main File menu in 
ResSim. This browser includes 
a Shortcuts menu on the 
right. These shortcuts are 
ResSim watershed 
locations.  You can create 
a shortcut right there in 
the browser (with the 
Add button) or in the 
Options Editor described 
in Appendix A, Section 
A.1.1. 

Figure C.2 shows the Save 
file browser that is 
opened when you Export 
a report or table.  This is 
probably the most 
generic of the file 
browsers. 

 

Figure C.1 File Browser Dialog—Open Watershed 

 

Figure C.2 File Browser Dialog—Export Report 
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Figure C.3 show the file browser that is opened when you select Add Map… from the 
Maps menu in the Layer Selector.  

 

Figure C.3 File Browser Dialog—Open Map 

The various file browsers share several common features: 

C.1.1 Folder Shortcut Buttons 

On the left side of each of these browser dialogs is a list of shortcut buttons (Icons). 
These buttons will change the current folder in the browser to the folder identified 
by that button. In the first two figures, these buttons reflect the same shortcuts you 
would find a Windows® file browser.  In the third figure, the buttons reflect the two 
important folders to a CWMS watershed.  This is an older version of the file browser 
that originated in the code that ResSim shares with CWMS.  

C.1.2 Current Folder 

The current folder is displayed in the field at the top of the dialog. Each browser that 
opens will open to its own default folder and that folder name will be displayed here.  

C.1.3 File List 

The center of the browser dialog is the list of files and folders in the current folder.  
In most of the browsers, the files and folders are listed together.  In older file 
browsers, the folders are listed in a separate pane to the left of the list of files.  Use 
the file (and/or folder) list to find the file or folder you need.   

To change the current folder to a folder shown in the file (or folder) list, double-click 
on it.   
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To change the current folder to the parent folder of the current folder, use the Move 
Up file button. 

To select a file, click on it in the file list; the filename will appear in the selected file 
field. 

C.1.4 File List Buttons 

To the right of the current folder field are a set of small (icons) buttons for managing 
the current folder and for how the list of files are displayed.  These buttons access file 
and folder utility functions. The typical File List buttons you may find in a file browser 
include: 

 Move Up—change to the parent of the current folder 

 New Folder—create a new folder in the current folder 

 File Names—the file list should show only the file names 

 File Details—the file list should show the file names, size, and modified date. 

C.1.5 File List Filter 

Each file browser will have its own potential list of file type filters.  The All Files option 
will be in the filter lists and equates to “no filter” so that all files in the current folder 
are lists.  The default filter in each browser will be the file type that the specific 
browser was intended to help you locate and select.  For example, the Open 
Watershed file browser defaults to Watershed Files, which means that it is filtering 
for files with the extension: .wksp. 

C.1.6 Selected File 

The field near the bottom of the browser labeled File Name: is the file that the 
browser thinks you selected (clicked on) in the File List.  Verify the file name before 
you click OK to accept the file and close the Browser. 
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C.2 The Independent Variable Definition Dialog 

The Independent Variable Definition dialog is used anywhere a model element allows a 
functional relationship (lookup table) to be defined as “a function of” one of a set of 
options including: Date, Date and Time, 
Model Variable, External Variable, State 
Variable, and sometimes even Two 
Variables, depending on the element and 
feature.  The three most common forms 
of the Function of: option list are shown 
in Figure C.4. 

Each option for the Function of: selector 
and its edit panel in the Independent 
Variable Definition dialog is described in 
the following sections. 

C.2.1 Function of: Date 

Use Date if the lookup table or 
relationship you need to define is 
constant or varies as a function of 
the time of year or season.  

The independent variable Date 
needs no further definition so its edit 
panel in the Independent Variable 
Definition dialog is blank.   

After you select Date and click OK to 
accept that selection and close the 
Independent Variable Definition 
dialog, a seasonal function table will appear in the editor you came from.  The 
seasonal function table will have Date in the header of the first column and the first 
cell below the Date header will contain the value 01Jan.  Any additional dates needed 
for your function should be entered in the form DDMMM, where DD is a two-digit 
day of month and MMM is a three-character abbreviation for the month. Function-
of-Date relationships in ResSim repeat annually and always begin on 01 January, so 
no year specification is included in the date.  If your relationship is constant, only one 
row of the table is required—just enter your constant value in the 01Jan row. 

 

 

 

 

Figure C.4 Option Lists for 
the Independent Variable Definition Dialog 

 

All seasonal tables in ResSim treat each date entered as the beginning of 

the day, i.e., as applying at 0000 hours.  If you would prefer that your 

dates in the Function-of-Date table applied at the end of the day, use the 

next day in the table or define your relationship (table) as a Function-of-

Date-and-Time. 
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C.2.2 Function of: Date and Time 

A Function of Date and Time relationship (lookup table) is almost exactly the same as 
a Function of Date relationship—with one difference: the addition of a Time column 
in the seasonal function table. Use this function type when the demand varies with 
both date and time.  When entering time values, use a 24–hour clock, e.g., 6 pm is 
1800. 

 

C.2.3 Function of: Model Variable  

Use Model Variable if the lookup table or relationship you need to define varies as a 
function of a variable that is computed by ResSim.   

When Model Variable is selected, the edit panel of the Independent Variable 
Definition dialog (Figure C.5) will display the Model Variable pane; this pane contains 
the user interface widgets needed to define the model variable to be used as the 
independent variable for your function.   

 
Figure C.5 Independent Variable Definition Dialog—Model Variable 

The Model Variable pane includes:  

A Model Variables table—a scrollable list of all the model variables computed by 
ResSim for the current network.  

Model Variables are the variables that ResSim calculates for each element property 
that it needs or uses in its standard computations.  A value for each model variable is 
computed for each timestep of the simulation and stored in a time-series object. For 
example, pool elevation is a property of a reservoir that ResSim uses to determine 
release capacity, but it must be computed each timestep to account for changes that 
result from the release decisions ResSim makes.  
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A set of three Filters—use one or more of these selectors, located above the 
Model Variables table, to thin out the list of model variables so that you 
can quickly find the variable you need.  Each filter selector contains a list 
of all the possible values for its 
associated column in the variable 
table.   

When you select a value in one of 
the Filter selectors, the model 
variables table will show only those variables that have the selected 
value for that column of the table.  For example, if you select reservoir in 
the second filter, then the table will show only those model variables 
that are computed for the reservoirs in your network. Also, when one (or 
more) Filters has a selected value, the list of values in the other Filters 
will change to reflect the new, shorted list of variables shown in the 
table.  

A Select button—when you find the model 
variable you need, highlight it (click 
on it) in the table then click the 
Select button. 

A Selected Model (Variable) Time-Series textbox—The name of the model 
variable you selected from the table will appear here when you press the 
Select button.  Be sure your selected model variable is shown in this field 
before you click the OK button to apply your selection. 

A set of Time Series Options (Figure C.6)—Model variables are time-series data; 
during the compute, a value reflective of the state of that model variable 
is used to look up the dependent variables in the relationship you are 
defining.  The Time Series options 
allow you to specify how the value 
of the model variable is to be 
selected or computed from the 
model variable time series.  The 
time series options are specified as 
a combination of the Function and, 
if needed, the offset and or period 
used by the function.  The Function 
are all used to identify or compute a 
value from the time series relative to the current timestep, so think of 
the time of the current timestep as the base time or origin.  For example, 
if you selected Previous Value for the Function, the value returned from 
the model variable and used in the current timestep to lookup the value 
of the dependent variable from your function will be from the end of the 
previous timestep.  The Time Series Options include: 

Function—this is how the value for the selected model variable is to be 
selected or computed from the model variable time series.  
Options include: 

 

Although it is natural to use 

the first filter first, try using 

the second filter first.  You’ll 

probably find what you are 

looking for a lot faster. 

 

Note: double-clicking on the 

variable you want will NOT 

perform the selection; you 

must use the Select button. 

 
Figure C.6 Time Series Options  
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Current Value—returns the value stored in the model variable 
for the current timestep.  Be careful, some model 
variables (like elevation) haven’t been computed yet for 
the current timestep when the value is needed by the 
feature that uses the lookup table. 

Previous Value—returns the value stored in the model variable 
at the end of the previous timestep. 

Offset Value—returns the value stored in the model variable at a 
time offset from the current timestep’s time. This 
function activates the Offset field; you may enter a 
positive or negative value, in HOURS, for the offset. 

For example, if you enter an offset of 6 hours, the value 
obtained from the time series will be at time = current 
time + 6 hours.   

Period Average, Period Maximum, Period Minimum—these 
functions will compute a value (average, maximum, or 
minimum) for the period of time specified in the time 
series relative to the current timestep’s time.  Both the 
Period and Offset fields are active for these functions.   

For example, if you want a 6 hour average computed 
from the time series data offset 3 hours back from the 
current timestep, you should select Period Average for 
the Function and enter -3 for the Offset and 6 for the 
period.  These entries will return the average value of 
the model variable from the period -9 hours to -3 hours 
relative to the current timestep. 

Offset—The offset adjusts the origin time and may be entered as a 
positive or negative value. A positive offset will obtain a value 
from the time series at a time forward from the time of the 
current timestep. A negative offset will look backward from the 
current timestep.  Note—the offset is entered in units of hours, 
not timesteps; take this and the compute interval (timestep) into 
account when specifying the offset. 

Period—The period is used to specify a range of time back from the 
origin over which a value is to be computed. Only positive values 
can be used to specify the period.  Note—the period is entered 
in units of hours, not timesteps; take this and the compute 
interval (timestep) into account when specifying the period. 
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C.2.4 Function of: External Variable 

Use External Variable if the lookup table or relationship you need to define varies as 
a function of a variable whose values are stored in a time series that you will provide 
to as input to the model.   

 
Figure C.7 Independent Variable Definition Dialog—External Variable  

When External Variable is selected, the edit panel of the Independent Variable 
Definition dialog will display the External Variable pane; this pane contains: 

A Variable Name text field—The name you enter will appear in the Alternative 
Editor’s Time Series tab; this is where you will identify the HEC-DSS time-
series dataset that represents the External Variable. Enter an 
appropriately descriptive name in the Variable Name field so that you 
will know what time-series to use for each External Variable you create in 
your model. 

A set of Time Series Options—these options apply to the input time series 
representing the external variable and are described in detail in Section 
C.2.3 above.   

C.2.5 Function of: State Variable 

Use State Variable if the lookup table or relationship you need to define varies as a 
function of a state variable.  State variables are variables that you create to represent 
the state of an abstract property or parameter that is not computed natively by 
ResSim.  The value of the state variable is computed each timestep through 
execution of a Jython script that you write and save as part of the reservoir network. 

When State Variable is selected, the edit panel of the Independent Variable 
Definition dialog will display the State Variable pane (Figure C.8).  This pane looks and 
behaves like the Model Variables pane except it does not include Filters for the table; 
since the list of state variables is usually a lot smaller than the list of model variables, 
the filters are not needed.   

The State Variables pane includes: 

A State Variables table—a scrollable list of all the state variables defined in the 
current reservoir network. 
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A Select button—when you find the state 
variable you need in the table, 
highlight it (click on it) in the table 
then click the Select button. 

A Selected Model Variable Time-Series textbox—The name of the model variable 
you selected from the table will appear here when you press the Select 
button.  Be sure your selected model variable is shown in this field 
before you click the OK button to apply your selection and close the 
Independent Variable Definition dialog. 

A set of Time Series Options—these options apply to the input time series 
representing the external variable and are described in detail in Section 
C.2.3 above. 

 

 
Figure C.8 Independent Variable Definition Dialog—State Variable 

 

C.2.6 Function of: Two Variables 

The Function of Two Variables option is available when creating a function that 
defines a zone, stage, or elevation.  Use this option if the lookup table or relationship 
you need to define varies as a function of two independent variables.  For example, 
stage at a location may be impacted by both the flow and the backwater of a 
downstream pool.  In such a case, you may define the stage as a function of both 
flow and elevation.  This will allow you to build a two-variable data table to represent 
your function, as shown in the example in Figure C.9.  The independent variables are 
expressed as a Row Variable and a Column Variable.  The Row Variable will be 
displayed in the left-most column of the data table and vary by row. The column 
variable varies per column of the data table. 

 

Note: double-clicking on the 

variable you want will NOT 

perform the selection; you 

must use the Select button. 
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Figure C.9 Rating Curve as a Function of Two Variables 

When the Function of Two Variables option is selected, the edit panel of the 
Independent Variable Definition dialog will display two panes: one for defining the 
Row Variable and one for defining the Column Variable (Figure C.10).  Each of these 
two panes allow you to select either a Model, External or State Variable, and are 
otherwise similar to the other Model Variables panes.   

Each of the two (row variable and column variable) Two Variables panes includes: 

A Variable Type selector—a dropdown list for selecting Model Variable, External 
Variable, or State Variable as the independent variable. 

An Interpolation Type selector—a dropdown list for selecting the type of 
interpolation to use between rows or columns of the independent 
variable.  Interpolation types available are Linear, Cubic, and Step. 

Once a variable type has been selected, the rest of the pane populates with the 
options inherent to either Model Variable, External Variable, or State Variable (as 
described in the previous sections).   
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Figure C.10 Independent Variable Definition Dialog—Model Variable 
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C.3 Seasonal Variation Dialog 

In the previous section, you learned about the Independent Variable Definition dialog.  
That dialog allowed you to specify one of the two variables in a functional relationship.  
Occasionally, the relationship between the two variables may vary as a function of time 
(season).  The Seasonal Variation dialog is provided so that you can specify the seasons or 
days of the year when the relationship changes. 

Usually included in the Seasonal Variation 
dialog is an Interpolation Type selector.  The 
options in the selector are usually Linear and 
Step, although you may also find Cubic as an 
option.  It is important to understand the 
interpolation type so that you know how 
ResSim will use the dates in the table with 
respect to the functional relationship you are 
defining. 

If the functional relationship does not vary (is 
constant) across a season, use Step as the 
Interpolation Type and enter dates in the 
Seasonal Variation table that represent the 
first day of each season.   

If the functional relationship changes linearly 
across between two successive dates, then 
use Linear as the Interpolation Type and 
enter dates in the Seasonal Variation table 
that represent the inflection points of the linear relationship that the functional 
relationship has with time. 

The dates in the Seasonal Variation table should be entered in DDMMM format.  That 
means two digits to identify the day of the month and three 3 characters to identify the 
month.  For days 1-9, use a preceding 0 (i.e., use 01-09).  The 3-character month is the 
first three letters of the name of the month, in English.  The month characters are not 
case sensitive, so Nov is the same as NOV and nov.  

You may have noticed that the Date table in the Seasonal Variation dialog starts with 
01Jan and that entry is non-editable (greyed-out).  This means that the list of seasons or 
dates always starts on 01Jan. So, if you have a season that crosses the calendar year 
boundary, treat that season as two seasons.  The start of the first half of the season will 
be the last date entry in the table and the start of the second half of the season will be 
the first date entry in the table (i.e., 01Jan). 

 

 

 

 

 
Figure C.11 Seasonal Variable Dialog 
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C.4 Selector Dialog 

A selector (or mover) dialog is once in which two lists are provided side by side with some 
“move” buttons in between them.  Typically, the list on the left is labeled Available and 
the list on the right is labeled Selected and you are expected to “move” entries from 
Available into Selected.. The Selector dialog (Figure C.12) gets its name from its primary 
purpose—to allow you select one or more items from the list of available items.  

To make a selection: 

• Double-click on each item in 
the Available list that you want 
to select; this will move the 
item to the Selected list. 

—OR— 

• Click on the item in the 
Available list, then use the Add 
button to move the selected 
item to the Selected list.  

NOTE: By holding the Shift or 
Ctrl keys while clicking on an 
item, you can highlight more 
than multiple items to be moved with the Add button. 

• Click OK to accept your selections and close the Reservoir selector dialog.  Cancel will 
close the Selector dialog without saving the changes that may have been made to the 
Selected list. 

 

To select all the items in the Available list:  

• Use the Add All button.  This will move all the items in the Available list to the 
Selected list 

• Click OK to accept your selections and close the Reservoir selector dialog.   
 

To remove items from the Selected list: 

• Double-click on each item in the Selected list that you want to deselect.  This will 
move the item to the Available list 

—OR— 

• Click on the item in the Selected list, then use the Remove button to move the 
selected item to the Available list.  

— OR— 

• Use the Remove All button to move all the items from the Selected List to the 
Available list. 

• Click OK to accept your changes and close the Reservoir selector dialog.   

 

 
Figure C.12 Reservoirs Selector Dialog 
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Appendix D  

Using HEC-DSSVue 
HEC-DSS is a data storage system developed by the US Army Corps of Engineers 
Hydrologic Engineering Center (HEC).  HEC-DSSVue (or DSSVue) is a utility program, also 
developed by HEC, to create and manage the data stored in HEC-DSS database files.  (DSS 
files have extension type .dss.) Since ResSim relies on HEC-DSS for storing and retrieving 
all of its input and output time-series and paired data, DSSVue is included as an integral 
part of ResSim.  With DSSVue, data may be entered, edited, plotted, tabulated, and 
manipulated with over fifty mathematical functions.  In addition to these functions, 
DSSVue provides several utility functions, such as entering data sets into a database, 
renaming data sets, copying data sets to other DSS database files, and deleting data sets.   

HEC-DSS identifies, stores, and retrieves to data stored in DSS files by pathnames.  Each 
pathname represents a record in the database. Pathnames are separated into six parts 
labeled "A" through "F." The six parts are delimited by slashes “/”.  

To identify regular-interval time-series data, the naming conventions for the six 
pathname parts are: 

A Project or watershed name 
B Location or gage identifier 
C Data variable or parameter, such as FLOW or PRECIP 
D Starting date of the time series data, using the date format DDMmmYYYY 
E Time interval of the data 
F Additional user-defined descriptive information 

For each DSS file you open, DSSVue will generate a list of the pathnames associated with 
the data stored in the file. You can select one or more datasets from the list of 
pathnames (or catalog) and visualize the data in tabular or graphical form.  The list of 
pathnames can be displayed in a variety of forms—from a list of simple strings, to a list of 
pathnames separated into parts. You can refine the list by searching for either a string 
anywhere in the in the pathnames or by filtering by one or more pathname parts. 

One form of the pathname list is called the Condensed Catalog.  This pathname list 
displays one row (condensed pathname) for each dataset. A dataset is a set of dss 
records with the same A, B, C, E, & F parts that spans the full time window of the data 
identified by those pathname parts stored in the database.  The condensed pathname for 
the dataset displays the D part as the time window of the dataset rather than the start 
time of the data in a single record of the dataset. 

This appendix provides a brief overview of DSSVue and describe some of the general 
functions you may need when working with DSS files in ResSim.  Refer to the HEC-DSSVue 
User's Manual for a complete description of all the features and capabilities of DSSVue. 
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D.1 Launching DSSVue from ResSim 

Although you can install and run HEC-DSSVue independently, it is also included as part of 
HEC-ResSim and is available from any ResSim module. To open DSSVue from within 
ResSim: 

• Select HEC-DSSVue from the ResSim Tools menu. 

The main window of HEC-DSSVue will appear (Figure D.1). 

D.2 Exploring the DSSVue User Interface 

The DSSVue user interface was designed to make working with DSS files easy and 
intuitive. The annotations in Figure D.1 identify the various components of the DSSVue 
interface that you will quickly become familiar with. 

Figure D.1 The HEC-DSSVue User Interface 

The Menu Bar includes menus that provide access to the various features for managing 
and viewing your DSS files and their data. 

The Toolbar provides shortcuts to some menu options that are used most frequently.  
You can add buttons to the toolbar to execute scripts that you have written.  
And, some DSSVue Plugins may add buttons to the toolbar as well. 

The Current File Info section displays the fully qualified path to the active DSS file as well 
as some properties of the file including its size and the version of HEC-DSS that 
rote it. 

The Opened File Tabs cover the remainder of the DSSVue Main Window.  The label on 
the tab is the name of the file whose contents are displayed on that tab.  The 
components of the tab include: 
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The Pathname Filters are used to thin the pathname list, making it easier to find the data 
you are looking for. 

The Pathname List which shows the list of records or data sets stored in the DSS file. 

The Selected Datasets list which shows the pathnames of the datasets you have chosen. 

The Selection Tools are (with one exception) for managing the entries in the Selected 
Datasets list. 

The Message Box shows status or informational messages generated by DSSVue. 

D.3 The DSSVue Menus 

The Menus in DSSVue provide access to a wide variety of features for managing your DSS 
files and the data stored in them. Some of the features available allow you to search for, 
select, and edit DSS datasets; control the display of pathnames; and access plots and 
tables.  The HEC-DSSVue menus are as follows: 

File—The File menu features are for managing dssfiles.  Options include: New…, Open…, 
and Close DSS File(s), Print Catalog Preview…, and Print Catalog….  The File menu 
also lists your six most recently opened files; these entries are shortcuts for 
opening the listed files. 

Edit—The Edit menu options apply to the records in the Selected Datasets list (or the 
highlighted datasets if the Selected Datasets list is empty).  The Edit functions 
include: Tabular Edit…, Graphical Edit…, Select All, Rename Records, Delete 
Records, Undelete (All, Select…, Last Deleted), Duplicate, Copy To, and Merge 
(copy) into…. 

View—The View menu options allow you to customize the display and filtering of DSS 
pathnames.  Options include: Pathname List, Pathname Parts, Condensed 
Catalog, No Pathnames, Unsorted List, Search pathnames by string, Search 
pathnames by parts, Refresh Catalog, Unit System (As Stored, English, SI), and 
Time Zone (As Stored, Local, UTC (GMT), Custom). 

Display—The Display menu features relate to the visualization of your selected datasets 
as well as provide accesses for setting some parameters that affect the 
visualization of the data. Menu options include: Plot, Plot Individual Data Sets, 
Tabulate, Display Data Options (Normalize and Sync data set times to first), 
Supplemental Information, and Time Window…. 

Groups—The Groups menu features are for creating and managing groups of data sets. 
The menu options include: Save Selected, Get, Plot, Plot Individual Sets, Tabulate, 
Math, and Manage… 

Data Entry—The Data Entry menu provides features for creating new datasets in DSS and 
entering data. The menu options include: Manual Time Series…, Manual Paired 
Data…, and Manual Text... Also available are Import and Export options from a 
small list of formats although plugins exist that can expand the sources and data 
formats extensively.  
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Tools—The Tools menu features relate to the manipulation and analysis of the selected 
data sets as well as a couple of options for DSS file management.  The Tools 
menu options include Math Functions…, Compare (Files, Data Sets, Data Sets 
with Options), Search for Value, Check File Integrity, and Squeeze. 

Collections—The Collections menu is generated by a DSSVue plugin that is included in the 
ResSim package.  ResSim includes the Collections plugin because DSS Collections 
are used to represent Ensemble datasets which are needed as input for ResSim 
Ensemble Alternatives.  Appendix G provides details on Ensemble Alternatives 
and the DSSVue Collections features. 

Advanced—The Advanced menu features are for the “advanced” user and relate to 
generating and managing catalog files and setting some program options.  Menu 
options include Condensed Disk Catalog (New, View, Print), Abbreviated Disk 
Catalog (New, View, Print), Full Disk Catalog (New, View, Print), Debug (Message 
Level…, DSS File Header, Record Addresses, Pathname Bin, Debug/Examine File…, 
Memory Monitor…, DSS Files Opened, DSS ZSET, DSS ZINQIR), and Program 
Options. 

Help—The Help menu contains the About command which will display version 
information about DSSVue. 

D.4 DSSVue Toolbar Buttons 

The buttons on the DSSVue Toolbar are shortcuts to some menu options that are used 
frequently.  The standard set of buttons are: 

 

Opens the file browser so that you can select a file to open.   
This is a shortcut for File -> Open. 

 

Plots the selected dataset(s).   
This is a shortcut for Display -> Plot. 

 
Displays a table listing the contents of the selected datasets.  
This is a shortcut for Display ->Tabulate. 

 

Opens the Graphical Editor with the selected datasets.   
This is a shortcut for Edit -> Graphical Edit. 

 

Opens the Math Functions editor with the selected datasets.   
This is a shortcut for Tools -> Math Functions…. 

 

Open the selected datasets in a Microsoft® Excel spreadsheet.  
This is a shortcut for Display -> Tabulate in Excel  
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D.5 Managing DSS Files 

The File menu (Figure D.2) provides most of the options you might need for managing 
DSS files—like New and Open.  And, like most Windows® applications, the File menu 
includes a Close command for exiting DSSVue. 

 

D.5.1 Opening DSS Files 

To open an existing DSS file, you have three options: 

• Click the Open toolbar button, —OR- Select Open… from the File menu. 

• An Open HEC-DSS File file browser will appear (Figure D.3).  Use the browser to 
navigate to and select the file you want to open, the click Open. 

 

Figure D.3 Open HEC-DSS File File Browser 

• Or, select one of the recently opened files listed near the bottom of the File 
menu. 

 

 

Figure D.2 HEC-DSSVue—File Menu 

 

NOTE: When DSSVue is opened from the Simulation module of ResSim, it 

automatically opens the current simulation’s simulation.dss file. 
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D.5.2 Creating DSS Files 

To create a new DSS file: 

• Select New… from the File menu.   A Create new HEC-DSS File file browser will 
appear (Figure D.4).  Use the browser to navigate to the folder in which you want 
to store the new DSS file, then enter a filename and click Create.  

 

Figure D.4 HEC-DSSVue File Browser—Create new HEC-DSS File  

 

 

You can also use the Open HEC-DSS File file browser to create a DSS file. 

▪ Just click the Open toolbar button, . 

▪ Browse to the folder where you want to store the file and enter a name 

in the File name field. 

▪ Click Open. 

▪ You’ll get a message box telling you that the file doesn’t exist and asking 

if you want to create it. Click OK to create the new DSS file. 

D.6 The DSSVue Pathname List 

When you open a DSS file, DSSVue will display the 
pathnames representing the datasets stored in the file. 
The appearance of this display of pathnames is controlled 
by the options in the View menu (Figure D.5). 

D.6.1  The Pathname List Views 

The most commonly used View option is the: 

Condensed Catalog (Figure D.6).—When in the 
Condensed Catalog view, DSSVue shortens 
the pathname list by combining pathnames 
that vary only by the D-part (start date); thus, 
the D-part of each “condensed” pathname 
shows the date range of all the records that 
share the rest of the pathname parts. Each 

 

Figure D.5 HEC-DSSVue—View 
Menu 
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condensed pathname identifies a DSS dataset (which can contain multiple 
DSS records). 

Other Pathname List views available from the View menu include:  

Pathname List (Figure D.7)—Displays the pathnames as concatenated strings. 

Pathname Parts (Figure D.8)—Displays the pathnames in columns by their six 
parts. 

No Pathnames—the No Pathnames view is useful when you need to open a very 
large DSS file but do not need to see any pathnames in the Pathname 
List. 

Unsorted List—like the No Pathnames view, the Unsorted List view is most useful 
for very large DSS files that could otherwise take a long time to open 
simply because DSSVue must not only generate the pathname list, it 
must sort it.  This view looks like an unsorted version of the Pathname 
List view. 

 

Figure D.7 Pathname List—Pathname List View 

 

Figure D.8 Pathname List—Pathname Parts View 

 

Figure D.6 Pathname List—Condensed Catalog View 
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D.6.2 Filtering the Pathname List 

There are two options for filtering the Pathname List.  These options are: 

Search by Parts provides six drop-down lists, one for each pathname part (Figure 
D.9).  Each drop-down list contains a list of all the different values for 
that pathname part currently used in the pathnames show in the 
Pathname List.  That means that if you select a value for one of the 
filters, not only does the Pathname List update to show only those 
pathnames that use the selected string, the other filter lists update to 
include only those pathname part strings for the pathnames shown in 
the filtered pathname list.  

 

Figure D.9 DSSVue Pathname Filters—Search by Parts 

Search by String provides a single field in which you can enter a string that you 
want to use to filter the list of pathnames (Figure D.10).  In other words, 
the string will apply to all the pathname parts.  For example, if you enter 
the string “flow”, the Pathname List will show all pathnames that include 
the word flow anywhere in the pathname. 

 

Figure D.10 DSSVue Pathname Filter—Search by String 

D.6.3 Selecting DSS Pathnames 

Selecting DSS Pathnames is no mystery.  Just highlight one or more pathnames (rows) 
in the Pathname list then click the Select button.  Or, double-click on each pathname 
you want to select.  The pathnames you select will appear in the Selected Pathnames 
list. 

Figure D.11 illustrates the row of buttons that are provided below the Selected 
Pathnames list in the DSSVue interface.   

 

Figure D.11 Pathname Selection Tools  

 

Each of the buttons in the set of Selection Tools is described below: 
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Select—To add pathnames to the Selected Pathnames list, highlight (click on) 
the pathnames to want to add in the Pathname List then click the 
Select button. 

De-Select—To remove pathnames from the Selected Pathnames list, select 
the pathnames you want to remove the click the De-Select button. 

Clear Selections—To remove all the pathnames from the Selected 
Pathnames list, click the Clear Selections button. 

Restore Selections—This tool works as an UNDO button for the Clear 
Selections option; it restores the state of the Selected Pathnames list 
from right before the Clear Selections button was last pressed. 

Set Time Window—This tool does not directly operate on the list of Selected 
Pathnames.  Instead, it is a shortcut for the Display -> Time 
Window… command, which allows you to set a time window for 
viewing and editing your selected datasets. 

D.7 Setting the Time Window 

The setting of the DSSVue Time Window determines how much of each selected dataset 
will be used or impacted when viewing or editing. To set (or unset) the DSSVue Time 
Window you can either: 

• Select Time Window...from the Display menu, or  

• Click the Set Time Window button. The Set Time Window editor will be displayed 
(Figure D.12). 

The Set Time Window editor has four radio button options to choose from for setting the 
time window: 

No Time Window—this option clears 
the Time Window setting.  
When no Time Window is set, 
all the data in the selected 
datasets will be used or 
affected by the actions you 
take on them. 

Specific Time Window—this option 
requires that you enter 
specific Start and End Dates 
and Times to define the time 
window.  Dates are entered in 
DD MMM YYYY format.  Times 
are entered using a military 
24-hour clock (e.g., 3:00 pm is 
1500). 

 

Figure D.12 Set Time Window Editor 
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The … button—in any date field can be used to open a Calendar tool for 
selecting a specific date. 

Clear—clears the time window fields of any prior settings. 

Set Current Time—uses the system time on your computer to fill in the Start and 
End dates and times. 

Relative to Current Time—this option uses the system time of your compute to 
determine a time window.  The parameters for this option are: 

Go Back—a time interval from the drop-down list and then enter the number of 
intervals backward in time to set the start of the time window. 

Go Forward—select a time interval from the drop-down list and then enter the 
number of intervals forward in time to set the end of the time window. 

By Individual Water Year—this option will cause DSSVue to act on the selected datasets 
in Water Year chunks.  This means that if data in a selected data set starts before 
the start of the Water Year or extends beyond the end of a water year, then the 
data outside a water year boundary will not be included in the “Time Window”. 

Start Date of Water Year—enter a date that defines the start of a water year for 
your data; this date is in the form DD MMM, a year is not required. 

If you activate (check) the Retain Between Sessions checkbox, DSSVue will remember 
your Time Window settings between executions of DSSVue.  If unchecked, the default of 
No Time Window will be used each time DSSVue is launched. 

 

NOTE: When DSSVue is opened from the Simulation module of ResSim, ResSim 

sets the DSSVue Time Window to the time window of the active Simulation. 

D.8 Visualizing Your DSS Data 

Two methods for visualizing the data stored in your DSS files are available in DSSVue—
plotting and tabulating. Below are some details you may find useful in working with DSS 
Plots and Tables 

D.8.1 Plotting DSS Data 

To tabulate the data stored in a DSS file: 

• Select the datasets of interest, then… 

• Click the Plot  button on the Toolbar—OR—Select Plot from the Display 
menu.  
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Figure D.13 HEC-DSSVue Time-Series Plot Window 

Figure D.13 shows a Plot Window that displays the two time-series datasets selected 
in Figure D.11 with the time window set as shown in Figure D.12.   

Each Plot Window that displays time-series data includes a… 

Title Bar—showing the pathname of the first selected dataset 
Menu Bar—containing File, Edit, and View menus. 
Vertical Toolbar—containing a Pointer tool and a Zoom tool 
Viewports (one or more)—showing a graph of the data 
Legend—included directly below the viewports—it identifies each dataset and 

shows the line style used to display the data in its plot.  
Y Axis—one for each viewport—it is labeled to show the parameter, units, and 

range of values of the plotted data  
X Axis—the horizontal axis that is shared by all viewports since it represents the 

time axis; all the plotted data in the viewports are aligned in time. 

You can resize the plot window by dragging any corner of the window to the desired 
size; the contents of the plot (especially the axes and the text of the legend) will 
rescale as you change the size of the plot window.   

You can use the Zoom tool  to view only a subset of the data in the plot.  To zoom 
in, use the Zoom tool to drag a box (within a viewport or along one axis or the other) 
around the portion of the plot you want to view; the plot content inside the zoom 
box will fill the viewport or the plot will adjust to show data relevant to the portion of 
the axis you zoomed in on.  While zoomed in, the plot window will show scroll bars to 
allow you view more of your data without having to zoom back out.  However, to 
zoom back out, just right click anywhere in the graph or along the axes.  

Refer to the HEC-DSSVue User's Manual for more details on configuring a DSSVue 
plot window. 
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D.8.2 Tabulating DSS Data 

To tabulate the data stored in a DSS file: 

• Select the datasets of interest, then… 

• Click the Tabulate  button on the Toolbar, or… 

• Select Tabulate from the Display menu. 

Figure D.14 shows a table window that displays the two time-series datasets selected 
in Figure D.11 with the time window set as shown in Figure D.12.   

Like a plot window, each table window 
that displays time-series data includes a… 

Title Bar—showing the pathname of 
the first selected dataset 

Menu Bar—containing File, Edit, and 
View menus. 

But it also includes a table showing the 
data stored in the selected datasets. The 
table includes a column for: 

The Ordinate number (or counter) for 
each row of data in the table.  
Values in a time-series table 
are assigned an ordinate in 
increasing order of time.   

The Date and Time associated with 
each value in the datasets  

The Values for each selected dataset  
A Header row that labels each column in the table. 
A Scrollbar to allow you to scroll through the data since most tabulated time 

series data will not fit on your computer screen. 

The View menu of a DSSVue table window provides you with several options for 
displaying the tabulated data (Figure D.15):   

Commas—will include commas in the data values.  
For example, a value of one thousand, two 
hundred thirty-four and fifty-six 
hundredths will be displayed without 
commas as 1234.56 and with commas as 
1,234.56.  A checkmark will appear in front 
of this option in the menu when this 
option is ON.  When unchecked (OFF), the 
data will display without commas. 

Reverse Order —will display the data in the opposite order.  Since the default 
order for time-series data is oldest to newest (oldest first), reversing the 

Figure D.14 HEC-DSSVue Table Window 

Figure D.15 HEC-DSSVue 
Table Window—View Menu  
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order will list the data from newest to oldest (newest first).  The Ordinate 
values will be reassigned based on your selected order. A checkmark will 
appear in the menu when this option is ON.  

Date and Time Separately—will split the date-time stamp into two columns.  A 
checkmark will appear in the menu when this option is ON as shown in 
Figure D.15.  When unchecked (OFF), the date and time appear together 
as a single column. 

Date with 4 Digits —will display the year in the date with four digits instead of 
the two.  A checkmark will appear in the menu when this option is ON. 

Show Decimal Places—unlike the previous options, this is not a toggle switch.  
Instead, this menu option provides a submenu from which you can select 
how many digits after the decimal you want displayed.  

Show Missing As—provides a submenu of options for how missing values are 
displayed in the table.  Options include: 

• Blank (the default) 

• -901.0 (an old HEC-DSS paradigm for missing values) 

• M 

• -M- 

Refer to the HEC-DSSVue User's Manual for more details on configuring a DSSVue 
table window. 

 

FYI—You can Tabulate from a Plot and Plot from a Table… 

Just look in the File menu of your Plot or Table window to find the option to 

Tabulate or Plot. 

D.8.3 Printing Plots and Tables in HEC-DSSVue 

You can print plots and tables by selecting Print from the File menu of the plot and 
table windows.  For more details on the printing capabilities, see Appendix E, Printing 
and Exporting ResSim Data. 

D.9 Editing Your DSS Data 

There are three ways to directly edit the values of the data stored in your selected DSS 
datasets: 

• Select Graphical Edit from the Edit menu in DSSVue 

• Select Tabular Edit from the Edit menu in DSSVue 

• Select Allow Editing from the Edit menu of a DSSVue Table window 

The third option is an easy way to make quick edits to data you are already viewing in a 
table window.  Please refer to the HEC-DSSVue User's Manual for details on using the 
Graphical and Tabular Editors.   
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When you select Allow Editing 
from the Edit menu of a table 
window, the window display 
switches into Edit mode—see 
Figure D.16.  The Ordinate and 
Date/Time columns grey out 
indicating that these columns are 
not editable.  To edit a value in 
one of the data columns, just click 
in the cell and type in a new 
value. 

You can also select a range of 
cells then right-click and select 
Fill… from the context menu. 
After making changes to the data, 
DSSVue will prompt you to save 
changes to the data set when you 
close the window or you can 
select Save or Save As… from the 
File menu before closing. 

 

D.9.1 Using the Math Functions Editor  

To perform math functions on your selected datasets: 

• Select the dataset(s) on which you want to perform a math function. 

• Click the Math Functions  tool or select Math Functions from the Tools 
menu. The Math Functions editor will open, as shown in Figure D.17.  

 

Figure D.17 HEC-DSSVue Math Functions Editor  

 

Figure D.16 DSSVue Table Window—Edit Mode  
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• Select one of the six tabs (Arithmetic, General, Time Functions, Hydrologic, 
Smoothing, and Statistics).  Figure D.18 shows the Statistics tab of the Math 
Functions Editor—
these basic statistics 
on a dataset can be 
very useful when 
analyzing data and 
results.   

• After you have 
selected the 
appropriate math 
function (tab and 
Operator) and the 
required parameters 
for the function, 
click Compute.  
DSSVue will perform 
the selected math 
on the dataset 
shown in the 
Selected Data Set 
selector. 

• To view the results, 

click the Plot  or Tabulate  button. The computed results from the 
selected math function will be displayed. 

• To save the new values in place of the original values, click the Save  
button (or select Save from the File menu).  HEC-DSSVue will ask you to 
confirm that you wish to replace the original data. 

• To save the new values as a new record, click the SaveAs  button or 
select Save As from the File menu. A Save As dialog will open (Figure D.19).  

• Enter the new pathname information then click OK to save the record. 

 

Figure D.19 HEC-DSSVue Save As Dialog 

There are many very useful math functions available in HEC-DSSVue.  This Appendix 
only covers the basic functionality for accessing the functions.  The HEC-DSSVue 
User’s Manual (HEC, 2009) is the primary reference for further information and 
details for using the Math Functions Editor. 

 

Figure D.18 HEC-DSSVue Math Functions—Statistics Tab 
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D.9.2 Manual Data Entry 

D.9.2.1 Time Series Data  

To enter Time Series data 
manually: 

• From the Data Entry menu, 
select Manual Time Series….  
The Time Series Data Entry 
editor (Figure D.20) will 
open. 

• Enter the Pathname Parts 
into the A, B, C, and F fields.  
DSSVue will define the D-part 
of the pathname based on 
the dates/times you enter for 
the data.   

• You must select an 
appropriate time interval (E-
part) from the list. The list 
includes both regular and 
irregular interval options for 
the time interval.  The behavior of the data entry tabs will change depending 
on the E-part you select. 

• The complete pathname will automatically appear in the Pathname field.  
(Alternately, you can enter the pathname into the Pathname field and the 
parts will appear in the Pathname Parts fields.) 

• Enter the Start Date (e.g., 30 Mar 2002). 

• Enter the Start Time (e.g., 0800). 

• Enter the Units (e.g., cfs, feet, etc.). 

• Select a data type from the Type list.  Your options are PER-AVER, PER-CUM, 
INST-VAL, and INST-CUM. 

• Using the Manual Entry tab—if you have selected a regular interval for the E-
part of the pathname, the Date and Time fields will fill in automatically 
according to the start date and time you have entered.  If you selected an 
irregular interval for the E-part of the pathname, you must enter the Date 
and Time values for each data value you wish to enter.   

o The first two cells of the table are provided automatically, but when you 
press Enter or Tab on your keyboard after entering a value in the last cell 
of the table, a new row will appear to allow you to continue entering 
data. 

o Or, using the Automatic Generation tab, enter the End Date and End 
Time and a Fill Value.  This option is useful when you want to generate a 
dataset that contains a constant value. 

 

Figure D.20 HEC-DSSVue 
Manual Time Series Data Entry Editor  
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• To view the data in plot form, click the Plot button at the bottom of the 
window. 

• To graphically edit (or enter) the data, click the Graphically Edit button. 

• To save the new time-series dataset, click Save. 

• To close the Time Series Data Entry editor, click Cancel. 

D.9.2.2 Paired Data  

To enter Paired Data manually: 

• From the Data Entry 
menu, select Manual 
Paired Data….   

• The Manual Paired 
Data Entry editor 
(Figure D.21) will open. 

• Type the Pathname 
Parts into the A, B, C, D, 
E, and F fields.   

• The C-part name has 
two fields, separated 
by a dash.  Enter the X 
parameter name in the 
first field and the Y 
parameter name in the 
second.  For example, a 
rating curve for a gage 
would have a C-part of 
STAGE-FLOW.   

• As you enter the 
various pathname parts, the full pathname will automatically appear in the 
Pathname field. 

• Select the Number of Curves (Y curves) from the list (1-50).  For example, if 
you are entering a gated outlet capacity table, each column of gate opening 
is a Y curve. 

• Enter the X Units and the Y Units. 

• Choose the X Type and Y Type scale from the lists.  Available options are:  
Linear, Log, Probability, and Percent. 

• The Y ordinates column of the table will split into individual columns 
according to the Number of Curves you have specified.  

• Type the data values into the X ordinates and Y ordinates columns. 

• To view the data in plot form, click the Plot button. 

• To save the new time-series record, click Save.  

• To close the Manual Paired Data Entry editor, click Cancel. 

 

Figure D.21 HEC-DSSVue 
Manual Paired Data Entry Editor   
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D.10 Managing Your DSS Datasets 

D.10.1 Renaming Datasets 

To Rename a DSS Record: 

• Select the dataset(s) you want to rename. 

• Select Rename Records from the Edit menu.   

• The Rename Records to editor (Figure D.22) will open. 

• Type the new 
pathname parts into 
the A, B, C, and/or F 
fields. 

• Click OK.   

• A confirmation 
message will appear, 
indicating that the 
record(s) has been 
renamed. 

D.10.2 Copying Datasets to another DSS File 

To Copy records into a DSS file: 

• Select the dataset(s) you want 
to copy to another DSS file. 

• Select Copy To from the Edit 
menu 

• The Copy Records into HEC-
DSS File Browser (Figure D.23) 
will open. 

• Type in a new DSS File Name or 
select an existing DSS file into 
which you want to copy the 
record(s) and click Open.  A 
message will appear, stating 
that the record has been copied to the DSS file you specified. 

D.10.3 Duplicating Datasets 

To Duplicate one or more datasets: 

• Select the dataset(s) you want to make a copy of in the current DSS file. 

• Select Duplicate from the Edit menu.   

• The New pathname parts for duplicate records dialog (Figure D.24) will open. 

 

Figure D.22 Rename Records Editor   

 

Figure D.23 Copy Records into HEC-DSS File Browser 
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• Type the new 
pathname parts 
into the A, B, C, or 
F fields. 

• Click OK.   

• A message will 
appear, stating 
that the record(s) 
have been 
duplicated. 

D.10.4 Deleting Datasets  

To Delete records from a DSS file: 

• Select the dataset(s) you want to delete. 

• Select Delete from the Edit menu. 

• A confirmation dialog will appear asking you to verify the datasets to be 
deleted (Figure D.25).  If less than 5 datasets have been selected, they will be 
listed in the confirmation dialog, otherwise the number of datasets (and the 
number of records they represent) will be indicated. 

 

Figure D.25 Confirmation Message Box—List of Records to be Deleted  

• If the list correctly identifies the record(s) to 
be deleted, select Yes.  

• A message box will appear (Figure D.26) 
telling you the records have been deleted.  
Otherwise, select No, and the records will not 
be deleted. 

D.10.5 Undeleting Records 

Deleted records can be recovered as long as the HEC-DSS file has NOT been squeezed 
(see Section E.14).  When a file is squeezed, all deleted records are physically 
removed.  You can undelete records in three ways:   

• Undelete all records in a file 

• Select the records to undelete from a list  

• Undelete the records that you just deleted 
 
 

 

Figure D.24 New Pathname Parts for Duplicate Records Dialog 

 

Figure D.26 Records Deleted 
Message 
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To Undelete records from a HEC-DSS file: 

• Select Undelete from the Edit menu.  A submenu will appear with the options: 

All—To undelete all records, select All. 

• A confirmation message box will appear asking if you want to undelete 
nn records (where nn is the number of deleted records in the current 
file).   

• Click OK.  

• A final message box will appear stating that all available records were 
undeleted. 

Select…—To pick which records to undelete, select Select… 

• A window will appear containing a list of pathnames for all the records 
that have been deleted in the current file (Figure D.27) that are eligible 
to be undeleted.  Check the checkboxes of the records that you want to 
undelete, or press Select All to undelete all records in the list.  You can 
unselect the checked records by pressing Unselect All. 

Figure D.27 Undelete Records Selection Window 

• Once you have indicated which records to undelete… 

o Click OK to undelete those records and close the window 
o Click Apply to undelete the records and leave the window open 
o Click Cancel to close the window without making further undeletes. 

Last Deleted—To undelete the records that you have just deleted, select Last 
Deleted.  

o A message box will appear asking if you want to undelete nn records 
(where nn is the number of records that were deleted in the most 
recent delete operation).   

o Click OK.  
 

D.11 Managing Your DSS Files 

D.11.1 Merging HEC-DSS Files  

To Merge the current DSS file into another DSS file: 
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• Select Merge (copy) … from the Edit menu.  The Merge (copy all records) into 
HEC-DSS File Browser (Figure D.28) will open. 

• Enter in a new DSS 
File name or select 
an existing DSS file 
into which you want 
to copy all of the 
records from the 
current DSS file and 
click Open.   

• A message will 
appear, stating “Files 
Merged.” Click OK to 
acknowledge the 
message and close 
the message box. 

D.11.2 Squeezing DSS Files in HEC-DSSVue 

Whenever you delete a DSS record, HEC-DSS marks the record as deleted but doesn’t 
actually delete the record from the DSS file.  Other actions, like rename and edit can 
cause HEC-DSS to create a new record and mark the old one as deleted. This dis-
inclination to actually delete a record from the database is normal for database 
systems but it means that periodically, “maintenance” must be performed on the 
database to recover storage space by cleaning out the deleted records and to speed 
up data access by rebuilding index tables. The Squeeze command performs this 
maintenance by copying all valid data in the current DSS file to a new DSS file then 
deleting the original DSS file and renaming the new file to the old filename.   

To perform maintenance on an HECDSS database: 

• Open the DSS file in DSSVue 

• Select Squeeze from the Tools menu.   

•  When the process is complete, a message box will appear (Figure D.29) 

 

Figure D.29 HEC-DSSVue Squeeze Message (Example) 

 

 

NOTE: Once a file has been squeezed, datasets that had been deleted CANNOT 

be undeleted. 

Figure D.28 Merge (Copy All Records) into HEC-DSS File Window 
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D.11.3 Viewing Status of DSSVue and its DSS Files 

DSSVue provides a variety of options to monitoring the status of DSSVue itself as well 
as the database(s) you have open.  To access these options: 

• Select Debug -> OFF from the Advanced menu in DSSVue. 

• This will activate the Debug submenu which contains the following options: 

o Message Level…—this will temporarily change the message level for the 
messages that are written by HEC-DSS to its log file. 

o DSS File Header—this should open a window showing a table of information 
that is stored by HEC-DSS in the DSS file header for the current file.  
Unfortunately, in the version of DSSVue included in this version of ResSim, this 
option crashes ResSim. 

o Record Addresses—this option opens a window that provides a variety of 
esoteric information about the records for the currently selected datasets.  
Most of this information is only useful to the programmers of DSSVue. 

o Pathname Bin—works only DSS 7 files.  Shows information about the 
indexing of the Pathnames in the DSS file 

o Debug/Examine File…—Only useful to the programmers; this option allows 
them to look at what is stored at specific addresses in the DSS file 

o Memory Monitor…—this option displays the 
Memory Monitor (Figure D.30), a very small 
window which shows a graph of the quantity of 
real-time memory used by HEC-ResSim and HEC-
DSSVue in relation to the memory allocated. 

o DSS Files Opened—this opens the HEC-DSS File 
Manager Status window (Figure D.31).  This window 
displays the number of HEC-DSS files you have 
accessed during the current session of DSSVue; and 
for each file it reports: the name and location of the 
file, whether the file is currently open, the first and 
last times you accessed the file, and the total number of accesses.  

o DSS ZSET—this option allows you to enter a ZSET parameter and value. 

o DSS ZINQIR—this option allows you to enter a ZINQIR parameter and will 
respond with information relevant to the parameter you provided. 

 

Figure D.30 
Memory Monitor 
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Figure D.31 HEC-DSS File Manager Status Window  
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Appendix E  

Printing and Exporting ResSim Data 
ResSim’s plots and reports as well as HEC-DSSVue plots and tables offer detailed views of 
model data and results.  Each of these data visualization features provide options for 
printing, as well as exporting and copying of the data for use in other applications.  

E.1 Saving and Printing Plots 

The File menu in ResSim and DSSVue plots (Figure 
E.1) contains options that allow you to:  

• Save the plot 

• Save a template of the plot 

• Apply a template to the plot 

• Define some page setup parameters for printing, 
and  

• Print the plot. 

E.2 Saving a Plot to a File 

To save a plot to a file: 

• Select Save As … from the plot’s File menu. 

• A Save file browser will 
appear (Figure E.2). Enter 
a File name and select the 
file format from the Files 
of type selector. The File 
format options are:   

• Windows Metafile (*.wmf) 

• Postscript (*.ps) 

• JPEG (*.jpg, *.jpeg) 

• Portable Network Graphics 
(*.png) 

E.2.1 Saving and 

Applying Plot 

Templates 

Once you have customized an individual plot (by changing its line styles, adding 
marker lines and/or callouts, adjusting the axes, etc., you can save the settings you 
have made to the plot as a Template that you can apply to future plots. 

 

Figure E.1 Plot Window—File Menu 

 

Figure E.2 Plot, Save As File Browser 
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E.2.1.1 Saving a Plot Template 

To create a template based upon a 
customized plot: 

•  Select Save Template... from the plot’s 
File menu.  

• The Export Plot Template dialog appears 
(Figure E.3). 

• Enter a Name for the new template and 
choose whether the template will be 
available for: 

o All Applications—this really means all 
watersheds. 

o This Watershed only  
o All Users Watershed  
o All Users. 

• Click OK to save the 
template and close the dialog.  Like user preferences (see Appendix A), the 
template is stored in your AppData area in a folder under this version of 
ResSim. 

E.2.1.2 Applying a Plot Template 

To apply a template that you previously saved: 

• Select Apply Template from a plot’s File 
menu.   

• Select the template from the Import Plot 
Template dialog that appears (Figure E.4). 

• Click OK to apply the template to your 
current plot and close the dialog. 

 

E.2.2 Preparing and Printing Plots 

E.2.2.1 Page Setup for Printing Plots 

The Page Setup option in a plot’s File menu 
opens the Page Setup editor (Figure E.5), 
where you can: 

• Set the page Orientation 

• Add Page Numbers 

• Set the Printer Scale, and 

 

Figure E.3 Export Plot Template 

 

Select from the first two options only. 

The second two options were designed for 

a multi-user, client-server version of 

ResSim. 

 

Figure E.4 Apply Plot Template 

 

Figure E.5 Page Setup Edit 
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• Set the Margins. The Set Margins button opens the 
Printer Margins dialog (Figure E.6). 

 

 

 

 

E.2.2.2 Previewing Printed Plots 

The Print Preview command in the plot window’s File menu allows you to view 
the plot as it will be printed.  Figure E.7 shows an example of the Print Preview 
window showing the plot as it should look printed. 

Figure E.7 Print Preview of a Plot 

E.2.2.3 Printing Plots 

The Print option in the plot window’s File menu opens the Print dialog (Figure 
E.8), where you can choose your printer (by Name), set printer Properties, and 
specify the Number of copies to print.  You can also select Print to File to print 
your plot to a File instead of to a printer. 

 

Figure E.6 Printer Margins 
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Figure E.8 Print Dialog 

E.2.2.4 Printing Multiple Plots 

The File menu of a Plot window also provides a Print Multiple option.  With this 
feature, you can print several plots on one page. 

The Print Multiple dialog 
(Figure E.9) shows all of 
the currently opened 
plots in the Available 
Plots pane.  To select 
plots for printing, 
double-click on them 
and they will move to 
the Selected Plots pane. 

Next, use the slider bars 
to specify the number of 
plots you wish to appear 
horizontally and 
vertically on the page.  
The grid to the right of 
the sliders reflects your choices.  

Page Setup and Print Preview are available from the File menu of the Print 
Multiple dialog.  Figure E.10 shows a print preview of multiple plots. 

Figure E.9 Print Multiple (Plots) Dialog 
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Figure E.10 Print Multiple Preview Window  

E.3 Saving and Printing Tabulated Data 

When tabulating data from a ResSim Plot or from DSSVue, the Table window’s File, Edit, 
and context menus provide options for printing, exporting, and copying the contents of 
the table.   

E.3.1 Copying Tabulated Data to the Clipboard 

To copy tabulated data to the clipboard:  

• Select the data you want to copy.  To select the whole table: 

o Select Select All from the table window’s Edit or context menus 
o Or, click anywhere in the table and type Ctrl-A. 

• Then, to copy the selection to the clipboard: 

o Select Copy from the table window’s Edit or context menu (Figure E.11), or 
o Or, type Ctrl-C. 

The data you have copied to the clipboard is in tab-separated format.  It can now be 
pasted into another application such as Microsoft® Excel or Word. 
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Figure E.11 Tabulated Data Window Showing Context Menu 

E.3.2 Saving Tabulated Data to a File 

To save (or export) tabulated data to a file: 

• Select Export from the File or context menu of the table window.  The Table 
Export Options dialog (Figure E.12) will open.  

 

 

 

Figure E.12 Table Export Options  Figure E.13 Save File Browser 

• Select a Field Delimiter (Tab, Space, Comma, Colon, or Semi-Colon) 

• Check or uncheck the various options for formatting the data, including: 

o Fixed-Width Columns  
o Quoted Strings  
o Include Column and Row Headers 
o Print Gridlines 
o Print Title—you can override the default title by entering a new title in the 

text box. 

• Click OK to accept your formatting selections and proceed.  A Save file browser 
(Figure E.13) will open.   
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• Select the folder where you want to save the file and enter a File name. 

• Click Save to complete the export, save the file, and close the browser. 

E.3.3 Previewing Tabulated Data (before Printing) 

To preview tabulated data before printing: 

• Select Print Preview from the File or context menu of the table window (Figure 
E.14). The Print Properties editor will open. 

 

Figure E.14 Table Window—File Menu 

• The Print Properties editor (Figure E.15) uses three tabs to organize the various 
properties you can configure: 

The Page tab allows you to specify the page 
Orientation, Scaling, and Selection.  
You can also choose to print the table 
as ASCII, to Repeat Headers on every 
page, and print the Gridlines. 

The Header/Footer tab provides text boxes in 
which you can type the header and 
footer you want to appear on your 
printed pages. 

The Table Title tab offers a default title for the 
table based on the data source.  You 
may edit this title. 

• After you have configured the Print Properties, 
click the Preview button.  

• A Print Preview window (Figure E.16) will 
open, allowing you to view the tabulated data as it will be printed.   

 

Figure E.15 Print Properties Editor 
from Print Preview 
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Figure E.16 Print Preview of a Table (Example)  

• Click the Print button at the top of the Print Preview window to proceed with 
printing your data. The Print Dialog will open. 

• Here you can:  

o Choose your Printer (by Name) 
o Set Printer Properties  
o Specify the Number of copies to print 
o Decide to Print to file rather than to a printer. 

• Click OK to print your tabulated data. 

 

 

 

 

How you configure (size) the columns of your table in the table window 

will affect how your tabulated data looks when printed. Be sure to use 

Print Preview to be sure things look right before printing. 
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E.3.4 Printing Tabulated Data 

To print tabulated data: 

• Select Print from the File or context menu of 
the table window (Figure E.17). The Print 
Properties editor will open.  

•  See Section E.3.3 above for details in setting 
the print properties. 

• When you have configured your print 
properties, click the Print button. 

• The Print Dialog will open.   

• Choose your printer then click OK to print your 
data. 

 

 

E.4 Printing and Exporting ResSim Reports 

Each module in ResSim includes a Reports menu from which you can open a variety of 
reports that you can use to view your ResSim data and results.  And, just like DSSVue’s 
tabulated data windows, ResSim’s reports all provides options for printing and exporting. 

All ResSim reports have either a File menu or a Report menu.  In all these menus, you will 
find a Print option.  In most, you will also find a Save As… or Export option.  In addition, if 
you right-click in the table area of any ResSim report, the context menu will include 
options for Print, Print Preview, and Export. 

To Preview a ResSim report before printing: 

• Select Print Preview from the report’s context menu.   

• The Print Properties editor will open.  Proceed as you would for previewing and 
printing tabulated data.  See Section E.3.3 for full details. 

To Print a ResSim report: 

• Select Print from the report’s File or Report menu or from its context menu.   

• The Print Properties editor will open.  Proceed as you would for printing tabulated 
data.  See Section E.3.4 for further details. 

To Export a ResSim report: 

• Select Save As... or Export… from the report’s File or Report menu or Export… from 
its context menu. 

• The Table Export Options dialog will open.  Proceed as you would for saving 
tabulated data to a file.  See Section E.3.2 for full details. 

  

 

Figure E.17 Print Properties Editor 
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Appendix F  

Yield Analysis 
In the water resources field, the concept of yield can be understood a few different ways. 
USACE defines yield as follows: 

“Yield is the amount of water that can be supplied from the reservoir to a specified 
location and in a specified time pattern” (EM 1110-2-1420) across a period of 
streamflow.   

Yield includes all water supplied, possibly at differing rates.  Reservoir or system firm yield 
is an additional important calculation used for water supply studies.  USACE defines firm 
yield as follows: 

“Firm yield is the largest consistent flow rate (demand) that can be provided [without 
fail] throughout a period of historic stream-flow” (EM 1110-2-1420).   

Firm yield estimates the amount of water that can always be supplied.  The ability to 
store water increases the firm yield by allowing water to be saved and used when 
streamflow is less than demand.  Thus, the process of identifying firm yield also identifies 
the critical period as the driest in the record that identifies the firm yield for a given 
storage volume.  Greater storage volume produces greater firm yield by providing the 
ability to supply more water to meet demand during a drier period or a longer dry period.  
A different available storage volume might have a different critical period for a given 
period of streamflow. 

A modeler can manually perform a yield analysis in ResSim by iteratively computing a 
period-of-record simulation until the yield has been identified.  With each iteration, the 
modeler makes a small change to the demand.  This process continues until a run is made 
that just barely empties the water supply storage in the reservoir.  That level of demand 
is the yield for the period-of-record conditions. 

The Yield Analysis alternative type, added in ResSim 3.3, automates the iteration process 
and makes calculation of yield a more easily reproducible.  There are two types of yield 
analysis currently implemented in ResSim:  Reservoir Yield and Storage Account Yield.  
Reservoir Yield uses the entire conservation pool of the reservoir to meet the demand 
and can be calculated for an individual reservoir or for a system of reservoirs.  Storage 
Account Yield calculates the yield of a single water storage account among multiple 
accounts at a reservoir. The ResSim Water Accounts feature allows you to divide the total 
conservation storage into multiple storage accounts based on either volume or percent 
of pool.  ResSim can then track water use for each account and account holder based on 
the rules attached to it.   

The ResSim yield feature can be used to calculate firm yield for water supply or 
hydropower, or it can be used to calculate a specific Exceedance Drought Yield by using a 
particular time series of inflows.  This chapter covers the use of the ResSim Yield Analysis 
feature for the purpose of calculating water supply firm yield. 
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F.1 ResSim Yield Analysis Feature 

The ResSim Yield Analysis feature automates the iterative work necessary to determine 
firm yield.  A single minimum or specified flow rule (or downstream control rule) is used 
to represent the demand at the location of interest; the demand can be constant or 
seasonally-varying (though repeating each year).  The yield is computed by repeatedly 
adjusting the value of the demand rule and re-simulating until the conservation pool is 
emptied once during the period-of-record; seasonally-varying demands are scaled 
proportionally during the search process.   

After each simulation, the demand is increased or decreased to get closer to the goal of 
exactly emptying the pool once, with no failure to meet the minimum rule.  The bisection 
search method is one method used to determine the next demand to try, and there is 
also an option to use a heuristic search based on mass balance to attempt to converge in 
fewer iterations.  The bisection method is more reliable for finding the firm yield, but 
typically requires more iterations.  The heuristic approach looks at the remaining storage 
and demand volumes and computes an estimate of exactly-meetable demand for the 
next iteration.  While it requires fewer iterations than the Bisection method, the Heuristic 
method is currently successful only in fairly simple, single-reservoir watershed analyses.   

The ResSim Yield Analysis Tool also allows the user to set flow rate and storage 
tolerances for defining convergence, to limit the number of iterations needed.  The 
maximum number of iterations can also be directly limited.  

A Yield Analysis is performed as part of a special ResSim alternative Type, a Yield Analysis 
Alternative.  To create a Yield Analysis Alternative, you must set the Alternative Type to 
Yield Analysis on the Run Control tab of the Alternative Editor as illustrated in Figure F.1.  
When the alternative type is Yield Analysis, the content of the Yield Analysis tab will be 
enabled as illustrated in Figure F.2. 

 

Figure F.1 Alternative Editor—Run Control Tab—Yield Analysis 
Alternative Type 
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Figure F.2 Alternative Editor—Yield Analysis Tab with Reservoir Yield selected 

The Yield Analysis tab has two views depending on the selection of the Yield Analysis 
Type at the top of the tab.  As illustrated in Figure F.3, the Yield Analysis Type options 
include: 

Reservoir Yield for the total yield from a 
reservoir pool or  

Water Account Yield for yield based on 
a specified water storage 
account within a reservoir. 

The edit panel for each Yield Analysis Type is described in the next two sections. 

F.1.1 Reservoir Yield Analysis 

The edit panel for the Reservoir Yield analysis type is shown in Figure F.2.  The 
process for setting up a Reservoir Yield Analysis proceeds from the top down in the 
edit panel.  Most of the panel involves selecting the Demand Rule.  The remainder of 
the panel provides options for setting the tolerances, maximum number of iterations, 
and the convergence method.  

Select “Demand” Rule to Maximize—You must select one minimum limit or specified 
limit type rule to represent demand from the pool.  The value of the rule will be 
maximized in order to determine the pool’s firm yield.  This rule may be a Release 
Function rule, Downstream Control Function rule or Hydropower rule.  

 

 

Figure F.3 Yield Analysis Types 
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1. Rule Category Radio Buttons—select a rule category and the table below will be 
filled with all available rules of the selected category.  The list of rules will be 
drawn from the active operation sets for the reservoirs in the current alternative. 

Water Supply Rules—minimum or specified Release Function and 
Downstream Control Function rules  

Hydropower Rules—system and local Hydropower rules  

2. Filter—(optional) use the filter dropdown boxes to filter the list of rules based on 
Location (reservoir), Rule name, or Rule Type.   

3. Highlight the desired rule in the rule list and click Select. This will place your 
selected rule into the Selected Demand Rule table. It will also place the Reservoir 
and Operation Set into the last table on the edit panel, the Storage Parameters 
table. 

4. Selected Demand Rule—set the tolerance for the rule. 

Tolerance—this is the flow Tolerance used for the determination of the 
yield analysis convergence. The flow tolerance is the maximum 
tolerable limit for the demand being shorted.  If the computed 
demand delivery in a given yield iteration is below the 

 

Figure F.4 Yield Analysis Tab—Reservoir Yield View 
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requirement by more than the tolerance, the iteration is 
considered “failed.”  Both the flow and storage tolerance criteria 
must pass in the same iteration for the yield analysis to reach 
final convergence. 

5. Reservoir Storage Table—displays reservoir and active operations set.  You set 
the pool lower limit and storage tolerance.  Note that this table refers to the 
“Con Pool” but the storage pool used for the yield calculation is actually defined 
by the Guide Curve, which may or may not be the top of your conservation pool. 

Lower Limit of Con Pool—Use the selector to choose the top of zone 
curve that marks the bottom of the storage pool used to 
determine yield.  The top of this storage pool (usually referred to 
as the Conservation pool) is by default the reservoir’s Guide 
Curve.  Note that the storage pool defined here may encompass 
more than one zone below the Guide Curve. 

Tolerance—this is the storage Tolerance used for the determination of 
the yield analysis convergence.  The storage tolerance defines 
how close above the bottom of the conservation pool (defined 
as “Lower Limit of Con Pool”) the computed minimum storage 
may reach to be acceptable for the analysis. If the computed 
minimum storage in an iteration is greater than the bottom plus 
tolerance, it is a failed iteration.  If the reservoir empties below 
the lower limit of the conservation pool, it is also considered to 
be a failed iteration.  Both the flow and storage tolerance criteria 
must pass in the same iteration for the yield analysis to reach 
final convergence. 

6. Maximum Iterations—this is maximum number of iterations that the yield 
analysis may perform in its attempt to converge on a solution.  The default value 
is 25. If the simulation is unable to converge within the specified flow and storage 
tolerances you entered but has reached the maximum iterations, it will save the 
answer from the last iteration and give a warning in the Compute Log that the 
convergence was not achieved after completing the maximum number of 
iterations. 

7. Convergence Method—a radio button provides the choice of either Bisection 
Search Only or Heuristic and Bisection Search, and the second option allows you 
to specify a value for the Maximum Heuristic Iterations that will be performed 
before the convergence method automatically switches to the Bisection search.  
The heuristic method uses a mass balance approach; it calculates the storage 
remaining (or the volume of water shorted, if storage went to zero) from the 
prior iteration to estimate the next demand to use while attempting 
convergence. The combined heuristic and bisection search may narrow in on the 
final result faster than with Bisection Search only.  The heuristic search can 
diverge in multiple reservoir cases, so it is used for a limited number of iterations 
before switching to the bisection method for the remaining iterations. Typically, 
the heuristic search can approach the final result within a few iterations, and the 
bisection method adds to the precision of the final answer if the maximum 
number of iterations for the heuristic method is exceeded.  The combined 
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Heuristic and Bisection Search is currently meant for single-reservoir watersheds 
and is less successful for more complex reservoir systems and operations.   

F.1.2 Water Account Yield Analysis 

The edit panel for the Water Account yield analysis type is shown in Figure F.5.  The 
process for setting up a Water Account Yield Analysis proceeds from the top down in 
the edit panel.   

 

1. Water Account—Select the water account for which you want to compute the 
maximum yield.  In order for there to be anything in the list to choose from, you 
must have—1) created a Water Account Set with at least one water account in it, 
and 2) selected that water account set on the operations tab of this yield 
alternative.  See Section 14.8 of the main User’s Manual. 

   

Figure F.5 Yield Analysis Tab—Water Supply Yield View 
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2. Tolerance—this is the water account storage Tolerance used for the 
determination of the water account yield analysis convergence.  The storage 
tolerance defines how close to zero the water account’s storage must reach to 
be acceptable for the analysis. If the computed minimum water account storage 
in a given iteration is above the tolerance, it is a failed iteration.  Both the flow 
and storage tolerance criteria must pass in the same iteration for the water 
account yield analysis to reach final convergence. 

Select “Demand” Rule to Maximize—You must select a minimum limit or specified 
limit type rule attached to the water account to maximize its firm yield.    This 
rule may be a Release Function rule, Downstream Control Function rule, or 
Hydropower rule.  Like Steps 1-3 in the process of setting up a Reservoir Yield 
calculation, Steps 3-5 are for selecting a rule category, filtering, and selecting 
the demand rule.  However, since each water account can only have one rule 
attached to it, there will only be one rule available to choose.   

3. Rule Category Radio Buttons—select the rule category that matches the rule 
attached to the water account (most likely Water Supply Rules).  

Water Supply Rules—minimum or specified Release Function and 
Downstream Control Function rules. 

Hydropower Rules—system and local Hydropower rules  

4. Filter—these boxes allow you to filter the list of rules based on Location 
(reservoir), Rule name, or Rule Type.  This step is not needed for the Water 
Account Yield option. 

5. Highlight the desired rule in the rule list and click Select. This will place your 
selected rule into the Selected Demand Rule table.  

6. Selected Demand Rule—set the flow tolerance for the rule. 

Tolerance—this is the flow Tolerance used for the determination of the 
water account yield analysis convergence. The flow tolerance is 
the maximum tolerable limit for the water account’s demand 
rule being shorted.  If the computed demand delivery in a given 
yield iteration is below the rule requirement by more than the 
tolerance, the iteration is considered “failed.”  Both the flow and 
storage tolerance criteria must pass in the same iteration for the 
water account yield analysis to reach final convergence.  

7. Maximum Iterations—this is maximum number of iterations that the yield 
analysis may perform in its attempt to converge on a solution.  The default value 
is 25.  

8. Convergence Method—this radio button provides the choice of either Bisection 
Search Only or Heuristic and Bisection Search.  See the previous section for a 
detailed description. 
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F.2 Yield Analysis Summary Report 

While the reservoir plot showing storage levels and releases is the first and most 
important result to study (Section F.3.4), ResSim also creates a Yield Analysis Summary 
report when a Yield Alternative type has been computed.  The Yield Analysis Summary 
can be accessed from the Reports menu of the Simulation module.  From the Reports 
menu, select Storage Yield Analysis > [yield alternative name] > Output Summary Report 
(Figure F.6). 

 

Figure F.6 Reports menu—Yield Analysis Report Option 

The resulting Yield Analysis Summary report (Figure F.7) includes Simulation Run 
identification information at the top followed by an Iteration Summary table with 
demand estimate scaling factors and simulation convergence results per iteration. 

 

 

Figure F.7 Yield Analysis Summary Report 

The Simulation Run identification information includes: 

• The Simulation name,  

• The Alternative name,  

• The Simulation Time Window: Lookback, Start, and End Dates and Times,  

• The Reservoir name for which yield was calculated,  

• Yield Analysis Rule name, and  

• The Maximum Number of Iterations setting. 
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The Iteration Summary table has a row for each compute iteration describing the 
progress toward convergence of flow and storage.  The results describe the scaling 
factors for the demand rule, resulting storage pools, flow and storage shortages or 
excesses, critical period dates, and whether the iteration passed or failed the flow and 
storage tolerances.  There are two sets of columns: 

 

Demand Estimate Factors—this set of columns is broken into two subsections that 
detail the two search methods and their search limits and/or scaling factors 
used to adjust the demand estimates. 

Bisection Method—the data list includes Demand Scale Limits (Min and Max 
Factors) and the resulting Trial Factor. The Trial Factor is the 
bisection (average) of the Min Factor and Max Factor, and it is the 
value used to scale the initial demand value of the rule.  (The first 
iteration uses the initial demand value with a trial factor of 1.0.)   

Heuristic Method—these columns list the scaling factors used by this 
method.  The heuristic method scaling factors are applied to the 
previous demand estimate, rather than the initial demand estimate.  
If the previous demand estimate was too small, the new scaling 
factor used is expressed under the Factor 1 column, and if the 
previous demand estimate was too large, the new scaling factor is 
listed in the Factor 2 column. 

Simulation Results—this set of columns is broken into three subsets of columns: 

WS Yield Average Annual Demand—the demand value selected for that 
iteration.  The demand value represents the constant flow rate of 
the rule (or the average value if the rule criteria is time-varying).  It is 
calculated using either the initial (bisection method) or previous 
(heuristic method) demand value multiplied by the current scaling 
factor. 

Storage Convergence—these columns include: 

Lower Limit of Con Pool—the value of the lower storage limit of the 
conservation pool, as defined in the Yield Analysis tab of the 
Alternative Editor.  This value does not change across 
iterations.  If the lower limit zone varies seasonally, the 
lowest value of the seasonal pool is considered the lower 
limit.  

Simulated Minimum Storage—the minimum storage reached during 
that iteration. 

Lower Limit of Con Pool + Storage Tolerance—the maximum volume 
of water that can be left in the reservoir that will satisfy the 
convergence tolerance when the simulated minimum 
storage is reached.  This value defines the upper limit of the 
storage tolerance and does not vary across iterations.  
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Storage Convergence Test (Pass/Fail)—The storage convergence test 
passes when the minimum simulated storage falls within the 
storage tolerance. The storage convergence test fails when 
the minimum simulated storage falls below the Lower Limit 
of the Con Pool, or when the minimum simulated storage is 
greater than the Lower Limit of the Con Pool + Storage 
Tolerance.  

Flow Convergence—these columns include: 

Maximum Demand Shortage—the greatest shortage to the demand 
over the period of record.  If demand was always met during 
an iteration, the maximum demand shortage will be zero.   

Flow Tolerance—Maximum allowable shortage.  This value does not 
change across iterations. 

Flow Convergence Test (Pass/Fail)—The flow convergence test 
passes when the maximum demand shortage is zero or 
below the flow tolerance. 

Start Date—the date on which the critical period began—when the 
pool was last at the top of the guide curve before reaching 
the minimum storage. 

Min Date—the date when the pool was at its minimum value. 

End Date—the end of the critical period—when the pool has fully 
recovered and is again at the top of the guide curve. 

F.3 Example Firm Yield Analysis for a Reservoir 

Pool 

The firm yield is the demand that can be just barely satisfied by inflow and storage 
through the driest period experienced (period of record hydrology) or expected 
(synthetic hydrology).  Firm Yield is limited by a critical period which can vary based on 
the demand and storage capacity.   

This example covers one way to conduct a firm yield analysis for a reservoir pool.  Future 
documentation will describe other approaches and offer examples for doing water 
account yield analysis.  To begin a firm yield analysis for a reservoir, an initial network and 
base alternative are needed, along with inflows for the period of record, or a comparable 
synthetic record.  Typically, it is best to start with an existing alternative that has been 
shown to compute correctly through the period of record.  These instructions assume 
that you are starting with an existing, well-reviewed watershed that contains an 
alternative that represents “current conditions”. 

F.3.1 Create a Base Network and Alternative 

Begin by identifying an existing network and alternative that represent the current 
conditions. This “base network” will begin as a copy of the current conditions 
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network. Later, you will simplify this network and then add some physical and/or 
operational features to it. The “base alternative” is a new alternative created for the 
base network but using the current conditions alternative as a template. You will use 
the base alternative to test that the model is running as expected before adding the 
yield operation.   

F.3.1.1 Create a Base Network for the Yield Analysis 
• In the Reservoir Network module, open the current conditions network. 

• From the Network menu, select Save As… to create a copy of the current 
conditions network (Figure F.8).  Give the new network an appropriate name. 

 

Figure F.8 New Network 

F.3.1.2 Create a Base Alternative for the Yield Analysis 

• Next, create a new alternative based on the new network (Figure F.9).  This 
alternative will be the base alternative for all the yield alternatives you may 
create.  

• Copy the setup of the existing current conditions alternative into the new 
alternative—this is easier to do if you haven’t made any changes to the network 
yet.   

• Start with the Run Control tab. Set the Time Step and the Flow Computation 
Method to the same settings as in the template (current conditions) alternative.  
Set the Alternative Type to Standard.  Also, consider the settings for Compute 
Unregulated Flow and Compute Holdouts.  You obviously will not need Holdouts 
for this alternative and you probably won’t need Unregulated Flows either 
(unless there’s something in the operations that uses them); if you can, set both  



Appendix F - Yield Analysis HEC-ResSim User’s Manual 

F-12 

• of these options to OFF 
(unchecked) so that their 
computes do not add 
unnecessarily to the compute 
time of each iteration of your 
alternative. 

• Next, on the Operations tab, set 
the Operation Set for each 
reservoir in the network using 
the same settings as those in the 
template alternative. 

• On the Lookback tab, copy the settings for each entry in the table from your 
template alternative to your new alternative, then Save the alternative before 
moving on to the Time Series tab. You do not need the Observed data in your 
yield alternatives, so don’t copy that information.  However, if you limited the 
output generated by ResSim using the DSS Output tab in your template 
alternative, consider copying those settings, too. 

• When you are done copying the data from the template alternative to the new 
alternative, save the new alternative and close the Alternative Editor. 

• Change to the simulation module and create a new period of record simulation 
with the same time window as a simulation in which your current conditions 
alternative was used.  Include only the new alternative in the new simulation. 

• Compute the new alternative. Be sure to use the Save to Base Directory… option 
if you have to make any changes to get the alternative working and computing 
properly. 

 

When you need to make a copy of an alternative but Save As is not an 

option (usually when the new alternative uses a different network than the 

original alternative), use the following steps to simplify the process of 

copying the table data from one alternative to another: 

• In the Alternative Editor, select the old alternative, then select the tab 

with the table you want to copy from.   

• Click in the first cell of the table (the upper-left-most cell), then press… 

Ctrl+A—to select all the rows and columns, then press 

Ctrl+C—to copy your selection to the Windows® clipboard 

• Now, select the new alternative 

• Click in the first cell of the table you want to copy the data to, then 

press… 

Ctrl+V—to paste the data you copied into the table. 

Repeat these steps for each tab and table of the alternative you want to 

copy. 

*When using this shortcut, be sure the tables you are copying from and 

pasting to match row by row.  When the new network is an unchanged copy 

of the original network, you can ensure matching fields by first copying the 

data from/to the Operations tab and the Lookback tab and then saving the 

alternative, before copying the data from/to the Time-Series tab. 

 

Figure F.9 Alternative Editor—New Alternative 
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F.3.1.3 Add Physical Elements Needed for the Yield Analysis 

• Return to the Reservoir Network module.  

• Consider adding a diverted outlet for water supply (Figure F.10) to the yield 
reservoir(s).  See Chapter 9 for instructions on adding a diverted outlet to a 
reservoir.  Note that depending on the nature of your system and analysis, a 
diverted outlet may or may not be useful to conducting a firm yield analysis.  You 
can alternatively apply the water supply specified release rule to the existing 
outlets.  Considerations for whether or not to use a diverted outlet include: 
whether demand is taken directly from the pool or downstream, how many 
reservoirs have water supply demands, and how other operations interact with 
the water supply yield. 

 

Figure F.10 Define the Diverted Outlet 
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F.3.1.4 Create a Base Operation Set for the Yield Analysis 

• In each yield reservoir, make a base 
operation set for use in your yield 
alternative(s) by duplicating the 
operation set used to represent 
current conditions (Figure F.11).  

• Next, remove rules in the yield 
operation set to reflect only the 
constraints that must exist at the 
same time as the demand.  It may 
be appropriate to remove most, if 
not all, rules from the reservoirs.  
Note that a complete analysis may 
then involve adding the rules back 
into the operations to examine all 
system interactions.   

• If you created any diverted outlets to represent the withdrawals that you are 
going to maximize, add a rule to keep the diverted outlet closed when not 
needed to meet demand. This can be accomplished with a low priority maximum 
release rule of zero flow applied to the diverted outlet (Figure F.12).  When the 
water supply demand rule is added, it will be placed above the max of zero rule 
so that the diverted outlet will only release to meet demand. 

 

Figure F.12 Max of Zero Rule on Diverted Outlet 

• Close the Reservoir Editor and Save the network.  

F.3.1.5 Update and Verify the Base Alternative 

• Open the Alternative Editor and select the base alternative 

• On the Operations tab, select the new base yield operation sets for each yield 
reservoir.   

 

Figure F.11 Duplicate Reservoir Operation Set 
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• On the Lookback tab, set the Lookback Release of the diverted outlet(s) to a 
constant of zero flow.  Set the Lookback Storage to the top of the guide curve; 
this assumes that the critical period is not during the start of the period of 
record. Make sure your alternative is using the correct inflows. 

• Save the alternative and close the Reservoir Editor. 

• Change back to the Simulation module and the period of record simulation you 
created. 

• Right-click on your alternative in the Simulation Control Panel and select Replace 
from Base from the context menu to update the alternative with the changes you 
just made in the Network module. 

• Compute the alternative and verify that it is still computing correctly. 

F.3.2 Create a Yield Analysis Alternative 

Once a base alternative has been created and is running correctly, a Yield Analysis 
alternative can be developed. The following instructions assume that you are going 
to perform a Firm Yield analysis on the existing conservation pool of a reservoir in 
your network. To do so: 

• Return to the Reservoir Network module.  Make sure your yield network is the 
active network. 

• Open the Reservoir Editor and select the reservoir for which you will be 
computing the yield. 

• Duplicate your base operation set.  In the example shown in Figure F.13, the new 
operation set has been labeled Max Yield. 

• Create a specified Release Function rule and apply it to the diverted outlet (or 
dam or other outlet, as necessary). This rule will represent the water supply 
demand to be maximized.  

• Give the new demand rule a starting value or seasonal pattern. This value will be 
replaced during each iteration of the Yield Analysis run.  

Add the demand rule to the zone(s) that make up the conservation pool. Also, add 
this rule to the adjacent zones above and below the conservation pool.  If the lower 
adjacent zone is the Inactive zone, then the rule only needs to be added to the zone 
immediately above the guide curve (typically the Flood Control zone). In the example 
shown in Figure F.13, the new rule is called “WS Yield” and has a starting value of 50 
cfs. 
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Figure F.13 Reservoir Editor—New Operation Set and New Yield rule 

• In the Alternative Editor, use Save 
As… to make a copy of the base 
alternative (Figure F.14), then 
perform the following changes to 
create a yield alternative. 

• On the Run Control tab, change 
the Alternative Type to Yield 
Analysis (Figure F.15). This will 
activate the Yield Analysis tab of 
the Alternative Editor.  

• On the Operations tab, select the 
yield operation set you just created 
with your new yield rule (Figure 
F.16). Save your alternative. 

 

Figure F.14 Alternative Editor—Save As… 

 

Figure F.15 Set Alternative Type to 
Yield Analysis 
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• On the Yield Analysis tab (Figure F.17), set the Yield Analysis Type to Reservoir 
Yield. 

• Use the radio buttons to select the Type of Demand Rule you are going to 
Maximize.  Choose Water Supply Rules. 

• Select the Rule.  The filters are provided to help you find the rule quickly.  The list 
of available rules will only be long if the selected operation sets for your 
reservoirs are complex.  To select the rule, you must highlight it and press the 
Select button. 

• Your selected rule will appear in the Selected Demand Rule table.  Enter a flow 
Tolerance value for the rule.  The flow tolerance is the maximum amount that 
the demand can be shorted and still pass the flow convergence test. 

• Storage information about the selected rule and its reservoir will appear in the 
storage table. Select the top-of-zone curve that marks the bottom of the pool 
from which the withdrawal defining the firm yield may be made.   

• Specify a storage Tolerance.  The storage tolerance is the maximum amount of 
storage that may remain the reservoir conservation pool and still pass the 
storage convergence storage test. 

• Next, enter a Maximum number of Iterations.  The default value is 25.  Very few 
models require 25 iterations.  If the compute has not converged within 25 
iterations, you may have a problem with your model; review the Storage Yield 
report to determine if the iterations are oscillating away from solution or if one 
or both of tolerances are too small or too large. 

• The last parameter to set is the Convergence Method.  Your options are Bisection 
Search Only and Heuristic and Bisection Search. The latter option allows you to 
specify how many Heuristic Iterations should be performed before automatically 
switching to Bisection Search Iterations.   

• Save your alternative. 

 

Figure F.16 Alternative Editor—Operations Tab— 
Select the Yield Operation Set(s) 
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Figure F.17 Alternative Editor—Yield Analysis—Select the Rule and Set the Tolerances 

F.3.3 Compute a Yield Alternative 

Now that a Firm Yield alternative has been created, you can run it for the period of 
record. 

• In the Simulation Module, add your Firm Yield alternative to the period of record 
simulation that currently holds your base alternative. 

• Make your Firm Yield alternative the active alternative and compute it. 

As each iteration completes, it reports how well it did with respect to the 
tolerances in the Compute Window and in the Compute Log.  You can review 
these reported results while it runs or after it computes. 

After the last iteration’s status output, the final yield value will be reported.  The 
final value for the maximized yield rule will also be stored in the demand rule 
itself.  Figure F.18 shows the calculated yield value in the Compute Window. 
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Figure F.18 Compute Window—Final Yield Value  

• Open the Reservoir Editor to verify that the yield rule has been updated.  Figure 
F.19 shows that the simulation’s copy of the yield alternative has the “WS Yield” 
rule populated with the same value.  
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Figure F.19 Reservoir Editor—Yield Rule—After Last Yield Iteration 

F.3.4 Analyze a Yield Alternative 

Once ResSim has completed the Firm Yield simulation and reported a yield value in 
the demand rule, you may examine the results using the reservoir plot and the yield 
report. 

The default reservoir plot  (Figure F.20) can be used to visualize the critical period 
and the point at which the reservoir was drained to the bottom of the conservation 
pool.  For this example, adding the “release” variable to the plot allows for the 
viewing of the controlled outlet release, which represents the demand.  The yield 
value is constantly released over the period of record. 

The Yield Analysis Summary report (Figure F.7) shows the information used in each 
iteration to achieve convergence.  You can see the demand value used in each 
iteration and how close it was to the required storage and flow tolerances.  The 
report also identifies the critical period. 

 

Note: This is a cursory example of a firm yield analysis, provided only to guide you 

through some of the basics for setting up a one type of yield alternative.  Setting up 

other types of yield analysis (such as hydropower and water account) use similar steps.  A 

full summary of the available output and the process for fully examining a yield 

simulation is not described in this manual.  



HEC-ResSim User’s Manual Appendix F - Yield Analysis 

F-21 

 

 

Figure F.20 Default Reservoir Plot with Releases 
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Appendix G  

Ensemble Computing 
Ensemble Computing was added to HEC-ResSim to support reservoir operations 
modeling using ensemble streamflow forecasts produced by NOAA’s Extended 
Streamflow Prediction (ESP) of the National Weather Service River Forecast System 
(NWSRFS) and/or its successor, the Community Hydrologic Prediction System (CHPS).  
The ensemble computing capability can, however, be used with data that comes from 
other sources.   

An ensemble streamflow forecast for a single location represents a set of possible 
streamflow hydrographs that could occur at that location over the forecast period.  A full 
ensemble forecast for a watershed should be a correlated set of ensemble inflow 
forecasts for all inflow locations in the basin.  This means that the first hydrograph in the 
ensemble forecast for a headwater location in the basin was generated with the same set 
of model parameters and boundary conditions as for the first hydrograph at the 
downstream-most location (and all points in between).  

A standard ResSim alternative can be defined to simulate only one member (or trace) of 
an ensemble forecast set.  Thus, if an ensemble forecast contained 30 members, then 
you would need to define 30 standard ResSim alternatives to simulate a given operation, 
one for each member of the ensemble forecast. This is very time consuming to setup and 
cumbersome to manage and analyze.  However, with a new Ensemble Alternative, you 
only need to create one alternative to simulate through one or more members in an 
ensemble forecast. And, ensemble results from an Ensemble Alternative can be visualized 
together.  Section G.3 of this Appendix will describe how to define and use Ensemble 
Alternatives in ResSim. 

But, before you can jump into creating and running Ensemble Alternatives, you will need 
to “collect” your ensemble hydrographs into a new HEC-DSS data representation called a 
Collection.  Collections are defined using an F-part naming convention that identifies 
each member of the collection with a numeric string, followed by a separator after which 
the normal F-part conventions apply for identifying the dataset. The collection member 
number (or ID) are how you can reference specific ensemble members to be computed in 
the Alternative Editor.  Section G.1 below describes HEC-DSS Collections and how to 
create and edit them for use in ResSim Ensemble Alternatives. 

G.1 HEC-DSS Collections 

A Collection is a group or set of HEC-DSS time-series datasets that share a common 
location (A & B Parts), parameter (C Part), and time-step (E-Part). Any set of DSS time-
series records for a given location, parameter, and time-step can be put into a collection, 
however, when applied to an ensemble, the records grouped into a collection must span 
a common time window.  

The “collection” concept is implemented through an F-part naming convention. The F-
part of each member of a collection has a collection ID string prepended to a common 
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version label (F Part).  The collection ID string is made up of:  “C:” followed by a 6-digit 
collection member number (ID) and ending with a pipe symbol “|”.  The | is used as a 
delimiter; it separates the collection ID string from the standard F-part string that 
specifies the “version” or uniqueness of the data. The ID number must be 6 digits long 
and may be simple integers or alpha-numeric strings, but must be unique within the 
collection. Like the other pathname parts, the “version” string following the | will be the 
same for all members in the collection.   

Below is an example pathname of a collection member: 

/YUBA/SMARTSVILLE/FLOW/01JAN1997-30SEP1997/1HOUR/C:000042|ESP/ 

G.2 The DSSVue Collection Utilities  

The software for creating and managing DSS collections is provided in a DSSVue 
Collection Utilities Plug-In.  This plug-in may be used in HEC-DSSVue Version is 2.2.1 or 
later. The plugin is included with HEC-ResSim 3.3 (and later), along with ResSim’s 
Ensemble plug-in, so you do not need to do anything to activate either plug-in in ResSim.  
However, if you would like to use the Collection Utilities in a standalone version of 
DSSVue, the instructions for installing the plug-in are below. 

To install the Collection Utilities Plug-In to a standalone version of DSSVue: 

• Make sure that DSSVue is not currently running. 

• Find the installation folders of this version of ResSim and the version of DSSVue you 
want to add the plug-in to. 

• Copy the file:   CollectionUtilities.jar 

from:  ResSim’s  jar/ext  folder 
to:  DSSVue’s  jar/ext  folder  

• When installed correctly, you’ll see a new Collections menu added to DSSVue’s menu 
bar the next time you launch DSSVue. 

With the Collection Utilities Plug-In installed, a 
Collections menu is added to the menu bar of 
DSSVue providing access to several options for 
creating and managing collections. Many of these 
options represent different ways to create a 
collection.  At present, collections can only be 
formed from individual records that already exist 
in DSS.  Other options in the Collections menu 
include features to copy, re-number, rename, and 
perform some simple statistics on the collection 
members.   

The Collections Utilities Plug-In also adds a new 
Condensed—Group Collections entry to the View 
menu in DSSVue.  A description of this view 
option as well as descriptions of most of the Collection menu options are provided in the 
following sections. 

Figure G.1 Collections Menu Options 
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G.2.1 Create a Collection from a Period of Record Dataset 

Collections can be created within DSSVue in a number of ways, but you must start 
with existing DSS records.   Two of the create-collection utilities start with a period of 
record (POR) data set; one searches for data based on a date range, for example 
December 15 through January 25; the other uses annual peaks.  

G.2.1.1 New Collection from Period of Record (Date Range) 

To create a collection from a period of record dataset using a date range: 

• From the DSSVue View menu, select Condensed Catalog. 

• Select a period of record dataset. A period of record dataset is usually one that 
spans several years.  

• From the Collections menu, select New Collection from Period of Record. 

• You will be prompted to enter the starting (Figure G.2) and ending (Figure G.3) 
date and time of the data that will l be copied from the period of record for each 
member of the collection.  

 Dates should be entered in 
the form DDMMM or 
DDMMMYYYY. And times 
should entered in hours and 
minutes of a 24-hour clock: 
hhmm or hh:mm.  For values 
less than 10 for days (DD), 
hours (hh), or minutes (mm), leading 
zeros are required. 

 As indicated in the prompt, you do not 
need to enter a year, since the date 
range is year-independent. However, if 
the time window of data you want to 
copy for each member is longer than 1 
year, the year must be entered and will 
not be ignored.  For example. If you 
want 15 months of data, spanning October to December, copied from the 
POR dataset into each collection member, then if you entered 01Oct 0000 
and 31Dec 2400, you would get only 3 months of data; the correct entries 
are 01Oct1901 0000 and 31Dec1902 2400. 

 If the timestep (interval) of the data is less than 1DAY, you must enter start & 
end times with the start & end dates. 

 If your date range extends beyond a single year, include the year and time in 
your start & end date/time specification. 

 

Figure G.2 Prompt for Starting Date and Time 

 

Figure G.3 Prompt for 
Ending Date and Time  
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• Next, you will be prompted (Figure G.4) to 
enter a starting sequence number (first 
member ID number). You can leave it 
blank if you want to use the data’s original 
year as the sequence number (most 
common). 

• Lastly, you will be prompted to enter the 
date and time for the first data point of 
the collection (Figure G.5).  

• The prompt will provide a suggested date 
and time based on the start date and time 
you entered; it will include the year 3000, 
which is often used for generated data that 
is intended to be year independent.  

• Review the suggested data and time 
carefully.  The time suggested is sometimes a 
poor choice—for example, it may suggest 
0001 as a start time for 1DAY data when a 
more appropriate value would be 2400.  In addition, you may want to use a 
different base year for your collection  

• Click OK to create the collection. 

The plug-in will process its way through the time window of the selected POR dataset 
and copy (from each year) the data within the date range you specified into a new 
dataset.  Each new dataset will be assigned a collection member ID number starting 
with the sequence number you provided or with the year the new dataset was 
copied from.  And, the time of the first value of each new dataset will be the 
collection start date and time you entered. 

G.2.1.2 New Collection from POR Peaks (Annual Peaks) 

To create a collection from a period of record dataset using a time window around 
the annual peak value in the dataset: 

• Select one or more period of record datasets.  

• From the Collections menu, select New Collection from POR Peaks.  

• You will be prompted to 
enter the number of days 
before and after (Figure 
G.6) the peak in order to 
define the date range. 

• Then, just like in the 
previous section (POR 
date range), you will be 
prompted to enter a 
starting sequence number 

 

Figure G.4 Prompt for 
Starting Sequence Number  

 

Figure G.5 Prompt for 
Date and Time of the First Value 
in each Collection Time Series 

 

 

Figure G.6 Prompts for Days Before and After the Peak 
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and a date for the first data point of each member of the collection (Figure G.4 
and Figure G.5 above).  

• Click OK to create the collection. 

The plug-in will work its way through the time window of the selected POR dataset, 
find the peak in each year, and copy (from each year) the data within the time 
window you specified around the peak into a new dataset.  Each new dataset will be 
assigned a collection member ID number starting with the sequence number you 
provided or with the year the new dataset was copied from.  And, the time of the 
first value of each new dataset will be the collection start date and time you entered. 

G.2.2 Create a New Collection Using Numeric F Part 

If a number in the F-part uniquely identifies each dataset in a set of selected 
datasets, that number can be used as the collection member ID when assembling the 
selected dataset into a collection. This option will find the numeric value in the F-part 
of each dataset and use that value as the collection member ID (sequence number).  

To create a collection from a set of selected records using a numeric value in the F-
part of the pathnames: 

• Select the datasets that you want to group into a collection. 

• From the Collections menu, select New Collection Using Numeric F Part. 

This utility function will rename the selected records to form a collection.  The F part 
of each resulting collection member will only contain the collection ID number that 
was found in the original F part of its source dataset, no other information from the 
original F part will be retained.  Figure G.7 and Figure G.8 show the before and after 
pathnames for a set of selected datasets that were used to form a collection using 
the New Collection Using Numeric F Part function. 

 

Figure G.7 Original Pathnames 

 

Figure G.8 Collection Pathnames 
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G.2.3 Create a New Collection Using F Part Mask 

Data may be gathered from a variety of sources and numbers are often used to 
identify the uniqueness of the data.  For example, if you use a rainfall-runoff model 
to compute flows for a set of frequency events with a variety of storm centerings, 
you are likely to use a string identifying both the storm centering and the recurrence 
interval as a way to identify the output.  Figure G.9 shows what these pathnames 
might look like.    

With a bit of adjustment, the datasets shown in Figure G.9 can be grouped into 
collections labeled with the storm centering and using the recurrence interval as the 
member ID.  The reason for the adjustment is because the utility that will create the 
collection uses a string mask to locate the member ID number and the remaining 
collection F-part.  This mask relies on the numeric portion of the F-part to either 
always have the same number of digits or for the digits to be at the end of the F part. 

 

Figure G.9 Example Data with Numeric F-parts  

Figure G.9 shows some datasets whose pathnames reflect two storm centerings and 
eight recurrence intervals.  To use these pathnames with an F-part mask, either the 
recurrence interval strings must all use 3 digits or the “YR” characters at the end 
must be removed.  If you plan ahead when creating the data, you can use the three 
digits.  If not, as in this example, the easiest way to make the adjustment was to 
rename the records and remove the YRs. The revised pathnames are shown in Figure 
G.10. 

 

Figure G.10 Revised Pathnames Ending in Numeric F-parts  
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With the pathnames ready, here are the steps to create a collection using an F-part 
mask: 

• Select the datasets you want to put into a collection 

• Select New Collection Using F Part Mask from the Collections menu 

• You will be prompted to 
“Enter Mask over existing F 
Part”.  This means you should 
type over the original first F-
part with a set of characters 
to build the mask.   Figure 
G.11 shows the prompt dialog 
with the original F-part and 
below it the mask we used for 
he selected datasets shown in 
Figure G.10. 

• After entering the F-part 
mask, click OK. 

The New Collection Using F Part Mask function will parse the F-part of the first 
selected dataset to determine the F part for all members of the new collection.  
Then, as it copies each selected data set into the collection, this function will parse 
the F Part of each dataset to identify the collection member’s ID number.  Figure 
G.12 shows the new collection pathnames created for the example datasets shown in 
Figure G.10 using the F-part mask shown in Figure G.11. 

 

Figure G.12 New Collection Pathnames Using F-Part Mask 

G.2.4 Assemble a Period of Record from a Collection 

You can create a period of record dataset from a collection by appending each 
member to one another, in sequence. This function assumes that the members of 
your collection represents a single and complete year. This is useful for doing a 
statistical analysis, such as the Cyclic Analysis Function.  This function also assumes 
you want the resulting dataset to have the same pathname parts as the collection; 
so, if you already have a dataset with that pathname, rename it before running this 
command or it will be overwritten. 

• From the DSSVue View menu, select Condensed-Group Collections. 

• Select the collection from which you want to create a period of record data 

• From the Collections menu, select Period of Record from Collection. 

• If the collection IDs do not represent years, specify a starting year for the new 
dataset. 

 

 

Figure G.11 Prompt for F-part Mask—Before and After  
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Another assumption used by the Period of Record from Collection function is that 
each member of the collection is placed in the new POR dataset at the same time of 
year as the start of the collection member itself.  So, if all the members of the 
collection only span the 6 months from 01Apr to 30Sep, then they will be placed at 
01April in their designated year in the POR dataset and the other 6 months of will be 
“missing” in each year of the POR.  But, if all the members of the collection span 15 
months, when the data of each member is placed at the same start date of each 
year, 3 months of each collection member will be overwritten by the next member 
when it is written to the POR dataset. 

G.2.5 Duplicating Collections 

You can duplicate a collection with new pathname F-parts or sequence numbers. For 
changing pathname parts A, B, and C, use the standard HEC-DSSVue Duplicate 
function under the Edit menu.  

To change the F-part, with either a new sequence number or F-part past the 
sequence: 

• Select Condensed-Group Collections from the View menu 

• Select your collection,  

• Select Duplicate from the Collections menu, then select how you want to identify 
the copy: 

o Using New Sequence Number—Don’t use this option, it does not currently 
work as intended. 

o Adding to Sequence Number—enter a value to add to each collection ID 
number.  Each member of the collection will be duplicated and the copy will 
get an ID number equal to the original ID value plus the value you entered.  
Note: this does not actually create a new collection; instead, it doubles the 
size of the selected collection. 

o New F-part (same Sequence)—enter a new F part string.  Each member of 
the selected collection will be copied to a new collection with the same ID 
number but with a new F-part string following the collection ID.  Note:  If you 
want to change both the sequence (ID) number and the F-part, duplicate 
with a new F-part first, then re- sequence the collection. 

 

Figure G.13 Collection Utilities—Duplicate Collections  
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G.2.6 Re-sequencing a Collection 

You can re-sequence (re-number) a collection by providing a new starting sequence 
number or adding to the existing sequence number. Re-sequencing does not 
duplicate the collection, it renames each member in the collection. To re-sequence: 

• Select Condensed-Group Collections from the View menu 

• Select your collection 

• Select Re-sequence from the Collections menu and then select how you want to 
define the new sequence: 

o Using New Sequence Number—enter a new starting number for the 
collection.  Each member will be assigned a new ID number starting at the 
new sequence number and counting up by 1. 

o Adding to Sequence Number—enter a value to add to each collection ID 
number.  Each member of the collection will get a new ID number equal to 
the original ID value plus the value you entered.   

 

Figure G.14 Resequence Options 

G.2.7 Renaming the F-part of a Collection 

You can rename the F-part of a collection (the portion of the F part that follows the 
Collection ID).  To do so: 

• Select Condensed-Group Collections from the View menu 

• Select your collection 

•  Select Rename F-part from the Collections 
menu. (To rename other parts, use the 
standard Rename function from the DSSVue 
Edit menu).  

• Enter the new F-part string (Figure G.15). 
Each member of the selected collection will 
be renamed with its original Collection ID 
number but with the new F-part string 
following the Collection ID.   

G.2.8 Changing the Date and Time of a Collection 

You can change the dates and times of the data in a collection. For example, if you 
had an ensemble that started Jan 1, 3000, you could copy it in time to the current 
date and use it in your forecast or other real-time analysis. The Change Date/Times 
function gives you the option to either copy your collection to a new date/time or 
shift (move) it to a new date/time. When you copy a collection in time, a new 

 

Figure G.15 Collections 
Rename F-part  
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collection is not created; instead, your current collection is simply enlarged (in time) 
so that you have the original data at the original dates and times and that same data 
copied to the new time period.  When you shift a collection, the data will be moved 
to the new dates and times and will no longer exist at the previous dates and times.  

To copy or shift a collection in time:  

• Select Condensed-Group Collections from 
the View menu. 

• Select your collection.  

• Select Change Date/Times from the 
Collections menu, then select either Copy or 
Shift. 

• Enter the complete date and time to copy or 
shift the collection to.  Use the same format 
as shown in the example (Figure G.16). 

G.2.9 Pathname List—Condensed Collection View 

With the Collections plugin, if your current DSS file has one or more collections in it, a 
new option will appear in the DSSVue View menu for displaying the Pathname List.  
The new View menu option is Condensed - Group Collections.  If you select this 
option, the many pathnames representing the members of your collection(s) will 
condense down to a single pathname.  Like the standard condensed catalog which 
condenses the dates in the D-part into a range, the condensed collection pathname 
shows a range of the Collection IDs in the F-part as highlighted in Figure G.17. 

 

Figure G.17 Pathname List—Condensed - Group Collections View 

If you select a collection dataset (condensed collection pathname) and click the plot 
button, DSSVue will produce a plot window that appears to be all legend (Figure 
G.18).  This is because a collection is usually a large group of individual datasets, each 
of which must be included in the legend.  See the next section for more information.  

G.2.10 Plotting a Collection 

Plotting a collection is much the same as plotting any other DSS data.  However, 
because a collection represents several datasets, you may have some problems 
getting a useful plot.  Here’s a suggestion—to plot a collection: 

• Select Condensed-Group Collections from the View menu. 

• Select your collection. 

• Click the Plot button on the Toolbar.  If your collection has 20 or more members, 
you plot window may open looking something like Figure G.18. 

 

Figure G.16 Change Date/Time Input  
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• To see the curves of your plot, you might try resizing the window, but for large 
collections, that won’t be good enough because the legend is still going to take 
up the whole plot window.  Instead, try removing the legend from the plot 
window: 

o Select Hide Legend from the View menu of the plot window, or 
o Select Legend Placement -> Separate Window from the View menu. The 

resulting plot from either of these options should look something like the 
colorful “spaghetti” plot shown in Figure G.19. 

 

Figure G.18 Collection Plot—All Legend  

 

Figure G.19 Collection from POR Peaks—“Spaghetti” Plot, No Legend 
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G.3 ResSim Ensemble Alternatives 

An Ensemble Alternative is a new type of alternative available in ResSim.  As described in 
the introduction of this Appendix, it was created to facilitate reservoir operations 
modeling using ensemble forecasted inflows. So, while a standard ResSim alternative 
represents only one correlated set of inflow hydrographs for the basin and produces one 
set of outflow hydrographs, an ensemble alternative represents multiple correlated sets 
of inflow hydrographs and produces the associated multiple correlated outflow 
hydrographs.    

Ensemble inflows and the associated ensemble results utilize a new HEC-DSS time-series 
data group called a “collection”.  Collections are described in Section G.1 of this 
Appendix. Collections can contain time series dataset that have varying time windows.  
However, collections that represent ensemble forecasts must contain only time series 
datasets with the same time window (or that span a common time window).  

An ensemble alternative is essentially the same as a standard alternative except that 
instead of representing a single run and computing through a single set of inflow time-
series as a standard alternative does, an ensemble alternative represents several runs, 
one for each selected member of the ensemble inflow datasets.  ensemble set of inflow 
time-series. To do that, an ensemble alternative must use at least one collection dataset 
in place of a single time-series for any time-series boundary condition (e.g., inflow) 
expected by the alternative.  

G.3.1 Defining an Ensemble Alternative 

There are three basic steps in creating an ensemble alternative in ResSim: 

• Set the Alternative Type to Ensemble 

• Map one or more required inflows to a collection time. 

• Select the members of the collection to use/compute in the alternative  

These steps are described in more detail in the following sections. 

G.3.1.1 Set the Alternative Type to Ensemble 

Although you can create a new alternative and make it an ensemble alternative, 
the easiest way to create an ensemble alternative is to start with a standard 
alternative that is already working as desired. That’s where these instructions are 
going to start. 

To create an Ensemble Alternative in ResSim,  

• In the Reservoir Network module of ResSim, open the Alternative Editor. 

• Select an existing alternative that you have tested and validated in the 
Simulation module.  

• Select SaveAs… from the Alternative menu of the Alternative Editor.   

• Give your new alternative a unique name and click Ok. 

• Your new alternative is now the active alternative in the Alternative Editor.   
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• Select the Run Control tab (Figure G.20) and change the Alternative Type 
radio button to Ensemble. 

• Select Save from the Alternative menu to save your change. 

Figure G.20 Alternative Editor—Run Control Tab, Alternative Type 

G.3.1.2 Map Required Inflows to Collections 

Typically, the boundary conditions that are associated with ensembles are the 
inflows to your watershed.  However, you should remember that your model 
may have other boundary conditions that could or should be considered for 
associating with ensembles.  These include diversions, zone definitions, and any 
rule or other element that is defined as a function of an external time-series. 

To associate (map) a boundary condition to a collection: 

• Be sure that the current/active alternative in the Alternative Editor is an 
Ensemble alternative (check the Alternative Type on the Run Control tab). 

• Select the Time-Series tab in the Alternative Editor.  When the Alternative 
Editor’s active alternative is an Ensemble alternative, the Time-Series tab will 
allow selection of collections for any input Time-Series (Figure G.21).  

Figure G.21 Alternative Editor—Time-Series Tab, 
Replacing Single Time-Series with Collections    
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• Click the Select DSS Path button.  A DSS Pathname Selector window will 
open.  This window looks and acts a lot like DSSVue.  

Figure G.22 DSS Pathname Selector Window 

• Select Condensed—Group Collections from the View menu. The collection 
member pathnames will condense as illustrated in Figure G.22.  Filter the 
pathnames to the specific collection F part you need. 

• Move the Pathname Selector window so that you can see both it and the 
Time-Series tab of the Alternative Editor at the same time. 

o On the Time-Series tab, select the first boundary condition row that you 
want to associate with a collection. 

o In the pathname selector window, find and highlight the collection you 
want to associate with the selected boundary condition row on the Time-
Series tab.  Click the Set Pathname button or double-click the highlighted 
pathname.  The pathname of the first member of the selected collection 
will appear in the selected row on the Time Series tab (Figure G.21). 

o Repeat these steps for each boundary condition that should be mapped 
to a collection.   

• When finished, close the pathname selector window and Save the 
alternative. 

G.3.1.3 Select the Collection Members to Use in the Ensemble 

Alternative 

Since collections can contain a large number of members, it may be desirable to 
use only a subset of the available members in your ensemble alternative.  To 
specify which members of the collection to use: 
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• Select the Ensemble tab of the Alternative Editor 

• In the Use Ensemble Members*: text box, enter the ID numbers of the 
collection members use/compute as part of the ensemble alternative (Figure 
G.23). If you want to use all the member of the collection(s), use the asterisk 
 character. If you want to compute only a subset of the members of your 
collection(s), enter a comma-separated list of member IDs with each entry 
consisting of one member ID or a range of member IDs. For example: 

 = all ensemble members 

“3, 7, 10” = ensemble members with IDs 3, 7, and 10  

“1, 3-12, 15” = ensemble members with IDs 1, 3 through 12, and 15 

Figure G.23 Alternative Editor—Ensemble Tab  

NOTE: An additional option is available on the Ensemble tab of the Alternative 
Editor.  This option is labeled Use Multithreaded Compute.  If you turn on (check) 
this option and your computer and operating system is capable of 
multithreading, then ResSim will determine the number of threads that can be 
run on your computer and will divvy-up the ensemble alternative’s runs across 
the available threads.  This can substantially reduce compute time for the 
ensemble alternative.  For example, HEC’s test computer had a dual-core CPU 
capable of “hyper threading” making it appear that the computer had a quad-
core CPU.  The multithreading logic in HEC-ResSim believed the computer was 
capable of 5 threads. It took an ensemble alternative of 30 members and 
assigned 6 members to each of the 5 threads.  The resulting compute time was 
approximately 1/4th of the compute time that the same 30-member ensemble 
alternative took without multithreading. 

• Look back at Figure G.21.  If you look at the row of buttons at the bottom, 
you will notice a new box that shows the set of ensemble members identified 
on the Ensemble tab. 

G.3.2 Viewing Ensemble Reports 

ResSim’s standard reports have been updated to recognize when they are provided 
an ensemble alternative, but they will only show results for a single ensemble 
member at a time. By default, the report will open showing the results for the first 
computed member of the ensemble. You can change which member is displayed by 
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selecting Set Collection Run from the Options menu of the report, then choosing the 
desired member’s ID number from the Collection Run Options dialog (Figure G.24).  

Figure G.24 Reservoir Summary Report—Set Collection Run 

HEC-ResSim will remember the selection when you view other reports. 

G.3.3 Plotting Ensemble Results 

The standard ResSim (and user) plots that you can produce from the context menu of 
an element in the active schematic have been enhanced to recognize when they are 
sent an ensemble alternative’s results. Unlike the standard reports, ResSim plots will 
show all the computed ensemble members’ results at the same time.   

Since there can be many computed members in an ensemble alternative, viewing a 
rainbow of curves is usually not conducive to understanding the overall results. So, in 
an effort facilitate results analysis, a new plotting paradigm was created: for each 
plotted parameter, all members of the ensemble (traces) are drawn in the same color 
with a slightly thinner line and with a moderately-high level of transparency.  When 
several traces all plot on top of each other, the density of color increases and you can 
see where the results overlap.  To also aid in analysis, five additional curves are 
added for each plotted parameter to reflect the minimum, maximum, median, and 
25% and 75% probabilities computed across the computed members of the 
ensemble for each timestep.  These additional curves are drawn with a thicker line 
weight and zero transparency. 

To plot ensemble results: 

• Select an ensemble alternative by placing a checkmark in the box beside it in the 
Simulation Control panel of an active simulation.  Although ResSim will plot 
multiple alternatives at the same time, select only one alternative at a time until 
you get used to viewing the ensemble results. 
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• Right-click on an element in the schematic that you want to view results for then 
select the predefined (or user) Plot you wish to view. 

Figure G.25 Ensemble Plot for a Reservoir 

An example of a standard reservoir plot is shown in Figure G.25. Although the text in 
legend in the illustration is quite tiny, it can be noted that there are far fewer entries 
in the legend than there are curves drawn on in the plot.  This is because the legend 
identifies the results by parameter and collection, not by individual member.  In 
addition, the curves for the computed statistics are not listed since they are 
considered members of each collection, not separate datasets. 

The same plot editing features are available for an ensemble alternative plot that are 
available for a standard plot. However, the implementation of the new plotting 
paradigm used for ensembles is not as complete as you might expect, so some of the 
plot editing features may not function correctly on an ensemble plot.  This will be 
improved in a future release of ResSim. 
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Appendix H  

Monte Carlo Analysis 
Monte Carlo analysis is a feature in ResSim that enables you to evaluate the impacts on 
simulation results due to the uncertainty associated with certain input information in 
your reservoir model, as well as the subsequent uncertainty in those results.  This feature 
uses random sampling of user-selected input variables within specified probability 
distributions.   

Monte Carlo analysis is performed using a ResSim Alternative type called Monte Carlo. 
When you compute a Monte Carlo alternative, ResSim orchestrates iterative simulations 
of the alternative based on random sampling of one or more user-selected input 
variables. The following six types of variables can be selected for random sampling: Time 
Series Multipliers, Input Time Series, Reservoir Rule Parameters, Lookback Values, Rating 
Curves, and Scripts. For each input variable, you can select from seven probability 
distribution types for defining the statistical distribution of each random input variable 
including: Normal, Log-Normal (natural logarithm and base 10), Gamma, Empirical, 
Triangular, Uniform, and Discrete distributions.  Based on your input parameters for a 
selected distribution type, HEC-ResSim’s Monte Carlo analysis computes the Probability 
Density Function (PDF) and Cumulative Distribution Function (CDF) for the random 
variables, and then randomly samples values from the CDF.  Output variables and 
convergence criteria are specified for the Monte Carlo analysis and may use time-series 
summary values (Maximum, Minimum, Mean, or Volume).  You can also specify options 
for defining the minimum and maximum number of simulation iterations, for continuing 
the analysis when additional iterations are desired to improve convergence, for restarting 
the analysis when previous simulation results are desired to be cleared, and for which 
iterations should save their full standard output. 

H.1 ResSim Monte Carlo Alternatives  

To perform a Monte Carlo Analysis, you must use a Monte Carlo alternative type. To do 
so, select the Monte Carlo radio button on the Run Control tab of the Alternative Editor 
(Figure H.1). 

 

When creating a Monte Carlo alternative, setup a Standard alternative first and 

get it working.  Then, on the Run Control tab of the Alternative Editor, change 

the Alternative Type from Standard to Monte Carlo. 



Appendix H - Monte Carlo Analysis HEC-ResSim User’s Manual 

H-2 

  
Figure H.1 ResSim Alternative Editor—Run Control Tab—Monte Carlo Alternative Type 

 

H.2 Setting Up a Monte Carlo Alternative 

In addition to the Operations, Lookback, and Time Series data needed for any alternative, 
the setup for a Monte Carlo alternative has three other data requirements.  The first is 
the set of input variables that will be randomly sampled with each Monte Carlo iteration. 
The second is the set of output variables that are of interest, and that you expect to be 
impacted by the varied input. The third is the specification of the Monte Carlo iteration 
scheme and convergence criteria for the analysis.  This information can be defined on the 
three sub-tabs of the Monte Carlo tab in the ResSim Alternative Editor (Figure H.2). 

 

When a Monte Carlo alternative is run in a ResSim Simulation, it will create and 

compute new iterations until (a) the convergence criteria is met, or (b) the 

maximum number of iterations is reached. 
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Figure H.2 ResSim Alternative Editor—Monte Carlo Tab—Input Variable Sub-Tab 

H.2.1 Input Variables 

To identify a Monte Carlo Input Variable that you want to have randomly sampled: 

• Open the Alternative Editor, select your Monte Carlo Alternative, and select the 
Monte Carlo tab. 

• Select the Input Variables sub-tab (Figure H.2). 

• Click the Add button at the top right corner of the tab.  The Random Variable 
Wizard will open (Figure H.3) to step you through the process of defining an 
input variable. 

  

Figure H.3 Random Variable Wizard—Step 1—Select Variable Type 
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Step 1 of 4: Select the Random Variable Type 

The randomly sampled input variable can be a standard ResSim input variable 
needed by your model or a script variable computed by a Jython script you write 
yourself.   

• Click the radio button next to the Random Variable Type of your choice.  

The ResSim input variable types that are available to be randomly sampled 
during a Monte Carlo iteration include: 

o Time Series Multiplier—by varying the inflow multiplier (a scalar 
value) on one or more inflows to your model, you can investigate the 
impact of the uncertainty of the inflow magnitude on your system.  
For example, you can determine whether a 10% variance in reservoir 
inflow have any impact on downstream flooding. 

o Input Time Series—by providing a variety of inflow shapes for a given 
probability event, you can investigate the impact of the uncertainty 
on the inflow duration.  For example, if you provide a collection of 
inflow hydrographs that represent the same event volume but with 
different durations and peaks, you can determine if the hydrograph 
shape has an impact on downstream flooding. 

o Reservoir Rule Parameter—by varying the magnitude of a rule limit, 
you can determine if the uncertainty in that operating constraint has 
a significant impact on the system. For example, if you vary the 
maximum channel capacity, you can determine if the maximum pool 
elevation is significantly affected. 

o Lookback Value—you can vary the starting condition(s) of your 
reservoir, diversion, or state variable to determine if the uncertainty 
in starting condition has a significant impact on the operation of your 
system.  For example, you can determine if there is a significant 
relationship between starting pool elevation and downstream 
flooding or peak pool elevation 

o Rating Curve—since stream morphology is ever changing, you can 
investigate the impact that the uncertainty of the relationship 
between flow and stage has on your system by varying the stage 
value returned by the rating curve lookup. 

Or, for additional flexibility beyond the currently available options, you can 
define your own Script Variable by selecting: 

o Script—you can develop your own sampling method if standard 
options are not sufficient.  By utilizing script variables and 
dependencies, you can also incorporate two-stage sampling.  
Although defined as an input variable, these sampling scripts are 
really only intermediate variables that another random input variable 
depends on; dependency is defined by clicking on the ellipsis (…) 
button next to the distribution parameter field—see Step 4 of 4 
below.  
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If you are setting up your Monte Carlo alternative for use in an HEC-WAT 
Flood Risk Analysis (FRA) run, variables can be sampled at different levels 
of a nested compute loop, so you must select the Uncertainty Type for 
your input variable. 
Click the radio button next to the Uncertainty Type of your choice. Your 
options include: 

• Natural Variability—Natural Variability variables are sampled in 
the inner WAT loop with each event. 

• Knowledge Uncertainty—Knowledge Uncertainty variables are 
sampled in the outer WAT loop with each realization 

See the HEC-WAT User’s Manual for more information. 

Once you have chosen your input variable’s type, 

• Click Next.  This will take you to Step 2 of 4, the Select Location and 
Parameter step. The list of locations and variables will vary depending on the 
variable type you selected. 

Step 2 of 4: Select a specific Location and Parameter 

Based on the Input Variable Type selected in the previous step, the Random 
Variable Wizard will provide you with a list of locations and parameters of that 
type to choose from. Examples of these lists are shown in Figure H.4.  The initial 
value of each scalar variable is shown in the applicable list.  

Except for Input Time Series and Script, each input variable type will let you 
select more than one variable of that type.  For example, the Reservoir Rule 
Parameter variable type lets you select more than one rule, from one or more 
reservoirs.  If you select multiple variables in this step, they will form a single 
input variable group, and the same random number and relative probability 
distribution will be applied to each variable in the group. 

• Select the input variable from the list of variables of the type you selected in 
the previous step. 

• Click Next.  This will take you to Step 3 of 4 to select the Reference- and 
Time- Dependency types for your input variable’s distribution parameters. 

 

  



Appendix H - Monte Carlo Analysis HEC-ResSim User’s Manual 

H-6 

Inflow Multiplier

 

Time Series

 

Reservoir Rule Parameters
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Lookback Values

 

Rating Curves

 
Script

 

Figure H.4 Random Variable Wizard—Step 2—Select Location and Parameter for each Variable 
Type 
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Step 3 of 4. Select Variable Parameters Modality 

In step 3, you will select how the probability distribution parameters (defined in 
step 4) will be specified for your input variable or variable group (Figure H.5). 

• Reference-Dependency—If 
you selected only one 
variable (rather than a group 
of variables) to be associated 
with your input variable, 
then you will have the option 
to specify whether that input 
variable will use an absolute 
probability distribution or a 
relative probability 
distribution. Otherwise the 
Relative Distribution option 
will be selected for you. 

o Absolute Distribution Parameters—the parameters of the input 
variable’s probability distribution are explicitly defined and have no 
relationship to the original value of the variable.  You will specify the 
distribution using the units of the input variable.   

o Relative Distribution Parameters—the parameters of the input 
variable probability distribution are relative to the original value of 
the variable.  If different variables of a given type have been defined 
as an input variable group, it is unlikely that they would each share 
an identical absolute distribution, so the shared probability 
distribution must be defined with relative parameters that are based 
on the initial values of each.  You will specify the parameters of your 
probability distribution as percentages of the initial value of the 
variable.   

• Time-Dependency—While only one probability distribution type can be 
selected for each variable or group, you can specify whether the parameters 
of that distribution will be held constant throughout year or vary seasonally.  
As such, you must choose between: 

o Constant—this option will allow you to define only one set of 
distribution parameters in the next step of the wizard.   

o Seasonal—this option will allow you to vary your distribution 
parameters seasonally.  With this option, in the next step of the 
wizard, you will need to define the seasons and then the distribution 
parameters that will apply for each season  

• Once you have selected the modality for your input variable, click Next. 

Step 3 of 3: Script Variable 

For a Script input variable, Step 2 of 3 required you to specify a unique name for 
your script variable and to associate the script with a model location (element) 

 

Figure H.5 Random Variable Wizard—Step 3—
Reference- and Time-Dependency 
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and parameter. Step 3 of 3 of the Random Variable Wizard is the script editor, 
much like ResSim’s state variable editor, which will allow you enter the script that 
defines your sampling scheme (Figure H.6).  This script will receive the random 
value generated for it in the current Monte Carlo iteration and can use that value 
any way you wish to compute the script variable’s value. A stochastic script may 
use this number to generate randomness, or it may be ignored in the case of a 
deterministic script. Similarly, the Monte Carlo alternative data is passed as a 
parameter (mcData). Using the Monte Carlo Variables section of the tree on the 
left side on the Script Editor panel allows the user to quickly add code to retrieve 
information about other Monte Carlo input variables. If you retrieve data from 
another Monte Carlo variable, ResSim assumes that the script is dependent on 
that variable.  A return value must be specified in each sampling script; this value 
may be passed to other variables or sampling scripts dependencies. 

 

 
Figure H.6 Random Variable Wizard—Step 3—Script Variable Editor with Script Variable Template 

 

Note: When using a script for the random variable, Step 3 is the last step since no 

distribution is needed. The other types of random variables require a fourth step 

to set up the distribution. 
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Step 4 of 4. Select and Configure a Distribution Type  

For each input variable, the value randomly sampled will be from the probability 
distribution type and parameters you specify.  

• Select a Distribution Type.  Your distribution type options (Figure H.7) are: 

o Uniform 
o Triangular 
o Normal 
o LogNormal 
o Log10Normal  
o Gamma 
o Empirical 
o Discrete 

These distribution types and their required parameters are described in the 
next section, Section H.2.2 of this appendix. 

  
Figure H.7 Random Variable Wizard—Step 4—Select Distribution Type 
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• Next, enter values for the distribution parameter values needed for the 
Distribution Type you selected. How you specify these parameters will 
depend on what modality selections you made in Step 3 of 4:

o If you selected Absolute for the Reference-Dependency, then you will 
define the parameters in the units of the input variable (except for 
dimensionless parameters).

o If you selected Relative for the Reference-Dependency, then you will 
instead define the parameters as a percentage of the initial values of the 
variable.

o If you selected Constant for the Time-Dependency, then a single field for 
entering each distribution parameter value will be displayed.

If you wish to make the distribution parameter dependent on another 
variable, click the ellipsis button that follows the parameter field (as 
annotated in Figure H.7). The Variable Dependency dialog (Figure H.8) 

will open showing a list of the input variables you have already defined.  

Select a variable whose value will be used as the parameter value then 

click OK to accept the selected variable and close the dialog; or click 

Cancel to return without defining a dependency.

Figure H.8 Variable Dependency Dialog 

If you created a variable dependency, the parameter field and ellipsis 
button in the Select Distribution Parameters panel of the Random 
Variable Wizard will be replaced with a button identifying the selected 
dependent variable.  If you wish to change or delete the dependency, 
click the dependency button to reopen the Variable Dependency dialog. 
Use the Remove button to delete the dependency or select a different 
variable to change the dependency. 
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o If you selected Seasonal for the 
Time-Dependency, then an Edit 
Seasons button will appear above a 
table for entry of the seasonally 
varying distribution parameters.  
Click the Edit Seasons button to 
open the Seasonal Variation dialog 
(Figure H.9), then enter the start 
date of each season in the table.  
When done, click OK.  A column for 
each season will appear in the 
Distribution Parameters table 
(Figure H.10).  Enter values for each 
parameter for each season in the 
table. 

  

Figure H.10 Random Variable Wizard—Step 4—Select Distribution Parameters—Seasonal 
Variation 

 

 

Figure H.9 Seasonal Variation Dialog 
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• Next, select the Distribution Clipping options you want to apply to your 
probability distribution.  Like the distribution parameters, the clipping 
options are a function of the modality options you selected in Step 3:   

o If you selected Absolute for the Reference-Dependency, then the 
Distribution Clipping section will allow you to limit the range of your 
distribution by setting a minimum and/or a maximum limit (Figure H.10). 

o If you selected Relative for the Reference-Dependency, (or if your input 
variable represents a group of variables), then the Distribution Clipping 
section will only provide a Clip at Zero option allowing you to limit the 
distribution to positive values (see Figure H.11). 

  

Figure H.11 Random Variable Wizard—Step 4—Select Distribution Parameters for 
Variable Group 

When the Reference Dependency is Relative, a Parameter Value Report 
button will appear below the Distribution Clipping section. Click the 
Parameter Value Report button to see how the selected parameters will 
translate from relative to absolute for each variable in the group.  An 
example of this report is shown in Figure H.12. 

 

 

Note that dimensionless parameters (like shape in the image) are not scaled, and 

so, show as N/A in the relative column of the Parameter Value Report. 
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Figure H.12 Relative Parameter Distribution—
Paramter Value Report 

• Once you have completed the setup of your input variable, click Finish to 
close the Input Variable Wizard.  A row will appear in the table on the Input 
Variables sub-tab that represents the input variable you just defined (Figure 
H.13) 

• Since a large model could require a significant number of input variables, the 
table of input variables is preceded by a set of Filters that you can use to thin 
out the list so that you can find a specific variable of interest. 

• If you have specified several input variables you may choose to deactivate 
one or more of them by unchecking the Active checkbox at the start of their 
row in the table.  Only “Active” input variables will be randomized during the 
run of your Monte Carlo alternative (Figure H.13). 

• You may also choose to specify a linear correlation between two or more of 
your active input variables by selecting the Correlation button located below 
the list.  This will open the Correlation Matrix editor (Figure H.14).  Use this 
editor to create a Correlation Set (a selection of input variables) and the 
correlation matrix that relates the probabilities of the variables in the set to 
one another. The diagonal cells of the correlation table will always have a 
value of 1, as any variable’s correlation with itself is perfect. All other cells 
will default to zero, implying independence. A value between -1 and 1 
entered into an off-diagonal cell indicates correlation between the row and 
column variables. Only the entries below the diagonal are editable. The 
entries above the diagonal are updated automatically to show that the 
matrix is symmetric. 
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Figure H.13 Monte Carlo Tab—Input Variables Sub-tab with several Variables Defined 

 

  

Figure H.14 Input Variable Correlation Matrix Editor 
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• The Check Dependencies button will display a graphical representation of the 
dependencies you have defined between your input variables.  Creating 
variable dependencies is an advanced feature, so don’t be surprised if you 
get a message saying that “No dependent variables have been defined…”. 

H.2.2 Random Variable Distribution Types 

Gamma Distribution 

The gamma distribution (Figure H.15) is a two parameter, flexible, continuous 
probability distribution.  The two parameters are Shape and Scale.  This 
distribution can be either symmetrical or positively skewed. 

  

Figure H.15 Input Variable Wizard—Gamma Distribution 

Triangular Distribution 

The triangular distribution (Figure H.16) is a three-parameter continuous 
probability distribution.  The three parameters are Left (minimum value), Right 
(maximum value) and Peak (the mode, or most-likely value, where the peak of 
the triangle is located). This distribution is useful in that it can be symmetrical, or 
it can be asymmetrical with either a positive or negative skew, i.e., a longer 
upper or longer lower tail.  For example, a negative skew allows the value to be 
farther below the most-likely value than it can be above. 
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Figure H.16 Input Variable Wizard—Triangular Distribution 

Empirical Distribution 

An empirical (graphical) distribution (Figure H.17) is continuous but without a 
function, for which the likelihood of possible values is derived from observed 
data. The empirical distribution is represented by a lookup table that describes 
points on the cumulative distribution function (CDF).   

 

Figure H.17 Input Variable Wizard—Empirical Distribution 
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Uniform Distribution 

A uniform distribution (Figure H.18) is a distribution that has a constant 
probability across the possible range, with any value having an equal likelihood or 
probability.  The parameters for this distribution are Left (minimum value) and 
Right (maximum value), defining the possible range.   

  

Figure H.18 Input Variable Wizard—Uniform Distribution 

Discrete Distribution 

A discrete distribution (Figure H.19) describes the probability of occurrence of 
each possible value of a discrete random variable. A discrete random variable is a 
random variable that has a limited set of possible values, such as the values on 
the faces of a six-sided die.  A discrete distribution is defined by a table of 
individual values and their probabilities. 

If your input variable is a time series, such as reservoir inflow, the only 
distribution type available is Discrete, since sampling for an input time series is 
done only from a set of time series records that you identify.  Figure H.20 shows 
how the parameter table for a discrete distribution changes for an input time 
series variable, as opposed to other variable types.  Weight is a relative value, 
and probability is then computed as weight of each divided by the sum of 
weights. 
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Figure H.19 Input Variable Wizard—Discrete Distribution 

 

 

Figure H.20 Discrete Distribution for Input Time Series 

Normal Distribution 

A normal distribution (Figure H.21) is a continuous, two parameter, symmetrical 
probability distribution.  The two parameters are mean and standard deviation.   



Appendix H - Monte Carlo Analysis HEC-ResSim User’s Manual 

H-20 

 

Figure H.21 Input Variable Wizard—Normal Distribution 

LogNormal Distribution 

A log-normal (or lognormal) distribution (Figure H.22) is a continuous probability 
distribution of a random variable whose (natural) logarithm is normally 
distributed.  The parameters are the mean of the logarithm of the variable, and 
the standard deviation of the logarithm of the variable.  It is always positively 
skewed, by a degree dependent on the ratio of mean to standard deviation. 

 

Figure H.22 Input Variable Wizard—LogNormal Distribution 
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Log10Normal Distribution 

A log10-normal (or log10normal) distribution (Figure H.23) is a continuous 
probability distribution of a random variable whose base10 logarithm is normally 
distributed.  The parameters are the mean of the logarithm of the variable, and 
the standard deviation of the logarithm of the variable.  It is always positively 
skewed, by a degree dependent on the ratio of mean to standard deviation. 

 

Figure H.23 Input Variable Wizard—Log10Normal Distribution 

H.2.3 Output Variables 

Output variables are those variables whose response to changes in the input 
variable(s), and resulting probability distributions, are of interest in the Monte Carlo 
analysis. For each output variable you select, you must choose what statistic (min, 
max, mean, or volume) of that variable you want to track. In addition to selecting the 
statistic, you can also mark the variable as an indicator of an “interesting” iteration 
using the Flag checkbox, or you can mark it as a determinant of Convergence using 
the Convergence checkbox. 

Iterative HEC-ResSim Monte Carlo simulations can produce very large amounts of 
data, because every iteration of the run is capable of producing as much data as a 
standard HEC-ResSim simulation, and typically a Monte Carlo simulation will consist 
of hundreds to thousands of iterations. In order to minimize data storage, the Monte 
Carlo Plug alternative will not write detailed output for all iterations. The user can 
override this for certain iterations by using the interesting Flags—when the Flag 
Condition of the output variable is triggered, the iteration is deemed interesting 
enough to cause the full output of the iteration to be written. 
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Setting convergence criteria for an output variable is a way to determine the stopping 
point of a Monte Carlo Alternative. Similar to Interesting Flags, Convergence criteria 
are conditional expressions that are evaluated at the end of every iteration. 
Convergence is reached when the average value of the output variable (over all 
iterations) is known accurately and confidently enough to stop iterating. 

 At least one of the output variables you define should be setup for and chosen to 
define convergence for your Monte Carlo alternative. 

To specify an Output Variable: 

• Select the Output Variables sub-tab on the Monte Carlo tab of the Alternative 
Editor (Figure H.24). 

• Click the Add button.  This will open the Output Variable Wizard that will step 
you through the process of selecting a ResSim Output Variable and defining the  
variable’s statistic and flag conditions (Figure H.25). 

 

Figure H.24 Alternative Editor—Monte Carlo Tab—Output Variable Sub-Tab 
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Step 1 of 2—Select the Output Variable.   

This first step of the Output Variable Wizard is a variable chooser (Figure H.25) 
much like the one found in ResSim’s Independent Variable Definition editor 
(Appendix C, Section 2).  Use one or two of the three filters available above the 
list of ResSim model variables to help you find the variable you need.  The first 
filter lets you thin out the list by element name (location), the second filter lets 
you thin out the list by element type, and the third lets you thin out the list by 
parameter (or variable type).   

 

Figure H.25 Monte Carlo Output Variable Wizard—Step 1—Select Variable 

 

Step 2 of 2—Specify the analysis criteria. 

The Monte Carlo Output Variable analysis criteria has three parts, which are 
selected in the Output Variable Wizard step 2 (Figure H.26): 

• Statistic—this criterion is a required selection for the convergence 
calculations.  Your options are Minimum, Maximum, Mean, and, for some 
variables, Volume. ResSim will analyze the computed time series for the 
selected model variable to compute the statistic and store the value for the 
current iteration of the Monte Carlo compute. 

• Flag Condition—this criterion is optional and off by default.  It is intended to 
mark extreme iterations for closer review.  To use, place a check in the Flag 
checkbox then select the Test (comparison operator) and Threshold value. 

 

Since ResSim produces a large quantity of output, it is often easiest to 

filter the list first by element type or parameter. Either or both of these 

filters will usually shorten the list substantially, making it much easier to 

find the location and parameter you need.  
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• Convergence Condition—this criterion is also optional and off by default but 
must be on for at least one output variable.  To use the convergence of an 
output variable (i.e., lack of change in the random sample between 
iterations) as a means of stopping the Monte Carlo iterations, place a check 
in the Convergence checkbox and define the parameters for convergence: 
Confidence and Tolerance.  Confidence is the percentile interval (e.g. a 90% 
confidence interval) upon which convergence is based, and Tolerance is the 
maximum percent change (accuracy) in the average of the output statistic 
necessary to consider the variable “converged.”    

• Values of Interest can be specified, and the output will include the 
percentages of the iterations that exceed those values. 

Once you have completed entry of the analysis criteria for your output variable, 
click Finish to close the Output Variable Wizard.  A new row will be added to the 
table of variables on the Output Variables sub-tab, representing your new output 
variable. 

Since a large model could require a significant number of output variables, the 
table of input variables is preceded by a set of Filters that you can use to thin out 
the list so that you can find a specific variable of interest. 

 

Figure H.26 Monte Carlo Output Variable Wizard—Step 2—Define Criteria 

H.2.4 Monte Carlo Controls 

A number of options are available to give you control over the simulation of your 
Monte Carlo Alternative. These options are located on the MC Controls sub-tab of 
the Monte Carlo tab in the ResSim Alternative Editor (Figure H.27). 
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Figure H.27 Alternative Editor—Monte Carlo Tab—MC Controls Sub-Tab 

The first two options control the number of iterations the Monte Carlo alternative 
may perform 

• Minimum Number of Iterations—the Monte Carlo alternative will perform at 
least the minimum number of iterations entered in this field, even if convergence 
criteria are met before the minimum iterations have been performed. 

• Maximum Number of Iterations—If convergence criteria have been met before 
the maximum number of iterations have been performed, the run will stop; 
however, if convergence criteria have not been met, the run will stop when the 
maximum number of iterations have been performed. The value entered in this 
field must be greater than or equal to the minimum number of iterations.   

• Stand-Alone Random Seed—when the Monte Carlo alternative is run within a 
ResSim simulation (in standalone ResSim, as opposed to ResSim within HEC-
WAT), the random number seed is used by ResSim’s random number generator 
to initialize the random numbers used for each input variable in each iteration.  
The same seed will always produce the same random values.  This seed can be 
changed if you want to produce different random values.  This field is not used 
when the Monte Carlo alternative is used in an HEC-WAT stochastic Flood Risk 
Analysis run. 

• Simulation Options—three simulation options control how you start and stop 
Monte Carlo simulations:  

o Continue to add iterations to previous Monte Carlo results.  This option may 
be used when you want to run the Monte Carlo alternative in batches and 
check the results between each batch. 

o Clear previous Monte Carlo results and start first iteration.  This option 
should be used if you make changes to the Monte Carlo alternative in any 
way and want to restart the run. 
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o Simulate and save results for iteration(s)… This option allows you to identify 
specific iterations that you want to rerun and store the complete set of 
output that a standard ResSim alternative would save.  This option is used 
after computing a Monte Carlo alternative and reviewing the limited output 
stored by the run.  This option should be used if something in the output 
calls for a closer look at the specific iteration(s), such as triggering a flag. 

• Pre-Sample Script—this button opens a standard script editor with an 
initialization, main, and cleanup tab.  Code in the initialization tab will only be 
executed at the very start of a Monte Carlo compute right before the first 
iteration, while code in the cleanup tab will only be executed at the very end of a 
Monte Carlo compute after the vary last iteration.  For the Pre-Sample script, 
code in the main tab will be executed every Monte Carlo iteration right before 
the random variable sampling. 

• Post-Sample Script—this button opens a standard script editor with an 
initialization, main, and cleanup tab.  Code in the initialization tab will only be 
executed at the very start of a Monte Carlo compute right before the first 
iteration, while code in the cleanup tab will only be executed at the very end of a 
Monte Carlo compute after the vary last iteration.  For the Post-Sample script, 
code in the main tab will be executed every Monte Carlo iteration right after the 
random variable sampling. 

• Data Check—this button reviews the definition of the Monte Carlo alternative to 
be sure the necessary data is adequate for a successful execution of the run. 

H.3 Analysis Tools 

A number of features have been included in ResSim to assist in analyzing the results from 
a Monte Carlo alternative.  These features can be found in the Reports menu under 
Monte Carlo.  They include: 

• Output Report—a text report generated by the Monte Carlo run that summarizes key 
aspects of the run including the number of iterations, the status of convergence, 
statistics on the input and output variables and a table showing the non-exceedance 
probability of the “values of interest” for each output variable (Figure H.28). 

• Histogram Display—this “Report” includes a graphic showing a histogram of the 
selected input or output variable, sampling statistics, and parameter values (Figure 
H.29).  The displayed information may include the following (depending on which 
variable is selected): 

o Number of Realizations (iterations), 

o Running Average,  

o Distribution Parameters (e.g., mean, standard deviation) specified for the 
variable’s distribution, 

o Clipping limits. 

o Convergence Parameters (confidence, relative tolerance, relative error), 

o Flag Test Parameters 
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• Convergence Plot—this “Report” is a plot of the Output Variable’s statistic, the 
running average and error bounds on the statistic, and the convergence criteria on 
the variable (Figure H.30). 

In addition to the predefined Monte Carlo “reports”, all the output generated by the run 
is stored in the simulation.dss file, so you can look for and find anything else you might 
need to analyze the results. 

 

  

Figure H.28 Monte Carlo—Sample Output Report 
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Figure H.29 Monte Carlo—Sample Histogram Display 
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Figure H.30 Monte Carlo—Scalar Display showing Convergence 

 

 

Note that the reports shown in this appendix do not contain meaningful results.  
They are merely screenshots to help familiarize the reader with the appearance 
of the features in the interface.  Likewise, many of the figures depicting editors 
do not contain real data. 
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Appendix I  

Operation Support Interface 
The Operation Support Interface (OSI) is a user-configurable data visualization and 
editing tool designed to enable you to create your own custom interface to perform one 
or more of the following activities: 

1) Review results 

2) Develop an operation schedule using release (or elevation) overrides 

3) Compute local inflows between gaged flow locations and estimate local inflows 
where gaged data is unavailable. 

These activities revolve around the type of variables you include on your OSI tabs.  Since 
these activities are quite different, they are usually setup on different tabs (or sets of 
tabs) of the OSI.   

To understand those two statements, you’ll need to learn some OSI basics.  In the first 
three sections of this Appendix, we’ll provide an explanation of OSI variables, the 
organization of the OSI user interface, and the basics of OSI setup.  In the subsequent 
sections, we’ll describe how to setup and use the OSI to perform each of the activities 
listed above. Examples will be used to illustrate the process and to help explain why 
you’d want to use the OSI in the first place. 

I.1 OSI Variables 

(Model) Variables are the fundamental data objects of the OSI; they are the time series 
datasets input to or computed by your model that the OSI makes available to you for 
viewing and editing.  The variables which the OSI allows you to view and edit are grouped 
into four categories:  

Local Inflows—These variables correspond to the “Known Flow” time series entries 
you see in the Time-Series tab of the ResSim Alternative Editor (Chapter 14). 
You created one of these variables each time you created an entry in the 
table on the Local Flow tab of the Junction Editor for the various junctions in 
your reservoir network.  Local Inflows are editable (from the OSI) over the 
entire simulation time window, from the start of the Lookback Period to the 
end of the Simulation (or Forecast) Period. 

Reservoir Releases—These variables correspond to the Release Override time series 
for each controllable release element of the reservoir outlet hierarchy of 
each reservoir; they can be viewed/edited from the Release tab of the 
ResSim Overrides editor (Chapter 15).  Reservoir Releases are only editable in 
the Simulation (or Forecast) Period (i.e., the lookback releases are considered 
“observed” and are not editable). 

Elevation Targets—These variables correspond to the Elevation Target Override time 
series for each reservoir; they can be viewed/edited from the Elevation 
Target tab of the ResSim Overrides Editor (Chapter 15).  Like Reservoir 
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Releases, Elevation Targets are only editable in the Simulation (or Forecast) 
Period. 

Computed Parameters—These variables correspond to the set of computed (output) 
time series produced by all the elements in your reservoir network. 
Computed Parameters are not editable from the OSI. 

I.2 Exploring the OSI User Interface 

The OSI can only be opened and configured from the ResSim Simulation module.  Each 
OSI configuration is associated with an active alternative, so you must open a simulation 
and identify an active alternative in the ResSim Simulation module. 

When you first open the OSI, you will be presented with a fairly large blank window.  
Don’t despair, it’s not actually blank; it has a Title Bar and a Menu Bar on it above a large 
white panel (Figure I.1).  The Menu Bar contains everything you will need to configure the 
OSI. 

 

Figure I.1 Operation Support Interface—Unconfigured (Blank) 

Configuring the OSI is fairly easy. Instructions for getting started are in Section I.3 below, 
but they begin with adding a tab. 

I.2.1 Tabs 

The OSI user interface was designed to allow you to group Variables for viewing and 
editing in Tabs.  Once you add your first tab to the OSI, you will see what the OSI’s 
user interface is going to look like (Figure I.2).   

The top portion of each tab is a Plot Panel (and/or Graphical Editor).  A Table Panel 
takes up most of the bottom portion of the tab with a stack of Action Buttons taking 
up the rest.  As you add Variables to the tab, they will appear as columns in the Table 
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Panel. A barely-noticeable Resize bar separates the top and bottom portions of the 
tab; you can “grab” this bar with your mouse and drag it up or down to resize the 
two panels. 

 

Figure I.2 Operation Support Interface with a New Tab Added—Annotated 

The Plot Panel and the Action Buttons are context-sensitive.  That means that how 
they appear and the functionality they provide are related to the active variable’s 
type or category.  To make a variable active, you only need to click on the data in that 
variable’s column in the Table Panel (clicking in the header won’t do it).   

For example, Figure I.3 shows the Plot Panel displaying time-series data for the 
selected (active) variable as well as another time-series dataset that was selected to 
be plotted with it. The plot also shows a green cross-hatched vertical bar indicating 
the range of the data currently displayed in the table and a blue vertical line 
indicating the point in time of the selected cell in the table. 
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Figure I.3 OSI Tab—Plot Panel Showing Active Dataset 

I.2.2 Menu Bar 

The Menu Bar in the OSI is important to the setup and configuration of the OSI.  After 
getting the OSI configured the way you like it, you’ll use the menus less frequently. 

I.2.2.1 File Menu 

The File menu (Figure I.4) is straight-forward; 
you only have Save and Close to choose from.   

Save has two different things to save: 

• The OSI configuration—As you make 
changes to the configuration of the OSI, 
you should be sure to save it frequently.   

• The Variable data. If you make changes to the time-series data of one or 
more of the variables, it will be saved each time you click Compute.  If you 
wish to save your changes without computing, select Save from the File 
menu before closing the OSI. 

Close—closes the OSI. Closing can also be accomplished by clicking the X in the 
upper right corner of the window.   

You might be wondering why you are NOT given the opportunity to 

name your OSI configuration nor are a Rename or SaveAs options 

included in the File menu… 

It’s because the OSI configuration is stored as part of the alternative definition.  

That fact results in a few hidden truths: 

 

Figure I.4 OSI—File Menu 
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▪ You can only create one OSI configuration per alternative. 

▪ You must configure the OSI for each alternative independently. 

▪ You can configure the OSI differently for different alternatives.   

▪ And, unfortunately, you cannot easily copy an OSI configuration from one 

alternative to another. Look for that option in a later version of ResSim. 

However, if you configure the OSI in an existing Alternative, then use SaveAs 

in the Alternative Editor to create a new alternative as a copy of the existing 

one, the OSI configuration will get copied (along with everything else that 

defines the alternative) to the new alternative. 

I.2.2.2 Edit Menu 

The Edit menu (Figure I.5) contains most of 
the features you will need to configure the 
OSI.  Since the OSI is organized around Tabs 
and Variables, the Edit menu gives you the 
options you need to configure them. 

Add Tab—adds a tab to the OSI (after 
prompting you to enter a name and 
description). As illustrated in Figure 
I.2, each tab has a Plot Panel and a 
Table Panel for viewing and editing 
OSI Variables.  Tabs are always 
appended to the end (right) of the 
“list” of tabs. 

Rename Tab—allows you to rename the 
current (active) tab.   

Order Tabs—opens the List Order Editor with a list of the existing OSI tabs to 
enable you to reorder the list. The first entry in the list is the left-most 
tab in the OSI.  Select a tab name in the list then click the Up (^) or Down 
(v) buttons to move the selected tab left or right with respect to its 
neighbors. 

Add Variable—adds a variable (column) to the Table Panel of the current tab.  
Like tabs, variables are always appended to the end of the “list” of 
variables. When you create a variable in the OSI, you will be asked to give 
it a name.  The name you give the variable will appear in the header of 
this variable’s column in the Table Panel and in the title of the Plot Panel 
when the variable is the current (or active) variable. 

Edit Variable—opens the Operations Support Model Variable Editor for 
configuring the variable and its plot(s). 

Rename Variable—allows you to rename the current (active) model variable. 

Order Variables—opens the List Order Editor with a list of the existing OSI Model 
Variables on the current tab to enable you to reorder the list. The first 
entry in the list is the left-most variable in the Table Panel of the current 
tab.  Select a variable name in the list then click the Up (^) or Down (v) 

 

Figure I.5 OSI—Edit Menu 
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buttons to move the selected variable left or right with respect to its 
neighbors.  

Delete Tab—deletes the current tab from the OSI, variables and all.  This does 
not delete the time series associated with the OSI variables from the 
model, it just deletes the tab configuration from the OSI configuration. 

Delete Variable—deletes the current variable from the current tab. This does not 
delete the time series associated with the OSI variable from the model, it 
just deletes the OSI variable from the OSI configuration. 

I.2.2.3 View Menu 

The View menu (Figure I.6) 
provides options for how the 
Variable columns in the Table 
Panel will display.  These options 
include: 

Set Column Width—Use this 
option to specify the 
width of every column in 
the Table Panel on every 
tab.  The units are pixels 
(screen units).  

Show Decimal Places—Use this 
option to specify how many digits after the decimal to display.  Your 
options range from 0 to 6 digits after the decimal. Like Set Column 
Width, Show Decimal Places is also a global setting for this OSI 
configuration; it applies to all columns on all tabs of this OSI. 

I.2.3 OSI Plot Panel and Graphical Editor 

The Plot Panel displays a time series plot of the currently selected Variable.  If that 
Variable is editable, the Plot Panel’s Toolbar will expand to include the Graphical 
Editor tools for editing the time series from the plot. These tools are: 

  Single Point Edit—to use, select this tool, then move the cursor into the plot to 
a time and value that you want to change the variable to.  Double-click your mouse 
button at that position.  A new point will be drawn at that position. You can also use 
this tool to drag an existing point up or down in the plot to a new position and 
therefore a new value. 

  Multi-Point Edit—to use, select this tool, move the cursor into the plot, click 
the cursor at each desired location of a series of new data points.  A line will appear 
connecting the data points you drew.  Right-click after the final data point has been 
placed to stop drawing data points. 

 

Figure I.6 OSI—View Menu 
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Changes made through with the Graphical Editor tools are immediately shown in the 
Table Panel and vice versa.   

Additional time series may be displayed in the Plot Panel to provide supplemental 
context. These time series are added through the OSI Variable Editor.  

Since the plot can show a much longer portion of the data than a column in the Table 
Panel can, the plot uses a cross-hatched background to illustrate the portion of the 
data is that is currently shown in the table.  If an editable cell in the table is selected, 
the time corresponding to that cell is shown as a vertical line in the Graphical Editor.  
If the Table Panel can show the entire time series (without a scrollbar), then the 
green cross-hatched background is not drawn. 

I.2.4 OSI Table Panel 

The Table Panel shows the data for each OSI Variable as a column in the table.  Note -
the additional time series that you can add to plot with a given variable are NOT 
shown in the Table Panel. 

A Date/Time column is included in the table panel to indicate which timestep of the 
current simulation time window is associated with each data value of each Variable 
displayed in the Table Panel.   

The columns to the right of the Date/Time column show the time series for each 
Variable you added to the tab.  The cells holding data values from the lookback 
period of the simulation window are shown with a medium-grey background.  A grey 
background in an editable table typically means that the values are not editable; 
however, even though lookback values for Local Inflows are editable in the OSI in the 
lookback period, the cells still display as grey. Computed Parameter variables are not 
editable for any part of the simulation window and they display with a light grey 
background for the whole simulation time window. 

To change a value in a cell of an editable variable, just click in the cell and type in the 
new value.  When you move to another cell, the cell you just changed will appear 
with Green text to indicate that you have entered an override value.  You can also 
use the table Fill options from the table’s context menu to edit a range of values. 

I.2.5 Action Buttons 

The Action Buttons (Figure I.7), located to the right of the Table Panel on each tab of 
the OSI, include the following: 

Compute—Computes the current alternative associated with the OSI.  Can be used to 
compute results after changes are made using the Table or Graphical Editors. 

Calculate All Locals—Computes the values for all Local Flow Variables across all tabs 
for the entire simulation period when observed flows are available.  See 
Section I.6 below for a description of how to configure your alternative and 
the OSI to compute Local Flow Variables.  
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This compute option runs a special ResSim 
simulation type to override computed Junction 
outflow values with observed time series data 
whenever the observed data is available.  
When the simulation is complete, all local flow 
time series associated with a Local Flow OSI 
Variable are adjusted to make up the 
difference between total inflow to the 
Junction and the observed value at the 
junction outflow.  Note: for this calculation to 
work, observed flow data must be provided 
for the Junction outflows.  Also Note: the 
Known Flow time series in the ResSim 
simulation.dss file will be overwritten with the 
calculated local flows.  A second, normal 
ResSim compute is then launched to use the 
computed local inflow data and thus refresh all output data. 

Calculate Selected Locals—Computes the values for the selected Local Flow Model 
Variables in the current tab and only for the time steps before and including 
the currently selected row in the table. 

Hydrograph Recession—Computes the recession hydrograph for the selected Local 
Flow Model Variables from the selected time to the end of the simulation 
period.  If the only cell selected is in the Date/Time column, then the 
recession hydrograph will be calculated for all Local Flow Model Variables on 
the current tab.  Note: Known Flow time series in the ResSim simulation.dss 
file will be overwritten with the calculated results.  Recession parameters are 
defined independently for each Local Flow Model Variable through the OSI 
Model Variable Editor. 

Clear Selection—Sets local flows to zero and removes release and elevation target 
overrides from the selected model variables for the selected time range.  

Clear Below—Sets local flows to zero and removes release and elevation target 
overrides for the selected model variables beginning with the first time step 
of the selected time range and ending at the end of the simulation time 
window.  

Clear All—Sets local flows to zero and removes release and elevation target overrides 
for the selected model variables for the whole simulation time window.  For 
local flows, this includes the lookback period.  

Refresh Plot —Changes made to the configuration of a variable will not show in the 
Plot Panel until you take an action that forces the plot to refresh. Clicking in 
the column of another variable then clicking back in the one you 
reconfigured is one such action; clicking the Refresh Plot button is another. 

Figure I.7 OSI—Action Buttons 
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I.3 Basic OSI Setup 

Before you can setup an OSI for an alternative, you must have a simulation in which the 
alternative has successfully computed.  Then, after opening the OSI, the process for 
configuring it involves two basic steps—adding a tab and adding one or more variables to 
the tab. 

Compute the Alternative 

• Open (or create) a simulation in the Simulation module of ResSim. 

• Select an alternative for which you want to configure the OSI and make it active.  If 
the alternative has not been computed, compute it. 

Open the OSI 

• Select Operations Support Interface from the bottom of the Simulation menu.  The 
OSI will open as illustrated in Figure I.1 

Add a Tab 

• Select Add Tab from the Edit menu.  A name dialog will open (Figure I.8).  Enter a 
name (and an optional 
description) and click OK.   

• The newly created tab will 
appear directly below the 
menu bar, along with an 
empty Sample Plot and 
Table Panel as illustrated 
in Figure I.2 

 

 

You can add additional tabs as needed; the only limit on the number of tabs 

you can add is the number you can keep track of—so don’t go overboard.  

And, remember the other tab management functions available on the Edit 

menu: 

Rename—you can rename a tab by making it active (by clicking on it), then 

selecting Rename Tab from the Edit menu. 

Rearrange—you also rearrange your tabs.  Select Order Tabs from the Edit 

menu, then use the List Order Editor to re-order them.  

Remove—you can delete a tab from the OSI by making it active, then 

selecting Delete Tab from the Edit menu.  You do not need to delete the 

variables from a tab before deleting the tab, but be careful, there’s no 

UNDO. 

 
 
 

CWMS/RTS—You can also configure (and use) the OSI from a CAVI Forecast. 

Just click on the ResSim alternative of a computed forecast run, then click the 

Operations Support action button. 

 

Figure I.8 OSI New Tab Name Dialog 
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Add a Variable 

• Select Add Variable from the Edit menu.   

• A name dialog will open; enter a Name and an optional Description and click OK.  

• The OSI Model Variable Editor will open (Figure I.9) 

• Select the Element Type. Your choices 
include:  
o Junction 
o Reservoir 
o Reach 
o Diversion 

• Select the Element.  These are the 
elements you created in the reservoir 
network that the active alternative is 
based on.     

• Select the Variable Type.  The 
Variable Types or categories were 
described in Section I.1, OSI Variables.  
The list of available Variable Types is 
dependent on your selection of 
Element Type. 

• Table I.1 shows the list of available 
Variable Types per Element Type and 
their Additional Parameters.   

• After you have configured your OSI 
Variable (made all your selections in 

the upper portion of the OSI Model Variable Editor), click Apply to save your variable 
settings but keep the editor open. 

Configure the Plot Panel 

 

Figure I.9 Variable Editor Dialog Box  

Depending on your Element and Variable Type selection(s), additional parameters may appear in the editor.  These 
parameters affect the behavior or computation of the variable.  

 

Table I.1 OSI Variable Types and their Additional Parameters 

Element Type Variable Type Additional Parameters 

Junction Local Inflow Local Flow 
Recession Method 
Recession Constant 
Max Recession Period (days) 

 Computed Parameter Computed Time Series 

Reservoir Reservoir Release Reservoir Release From 

 Elevation Target  

 Computed Parameter Computed Time Series 

Reach Computed Parameter Computed Time Series 

Diversion Computed Parameter Computed Time Series 
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The lower portion of the OSI Model Variable Editor (Figure I.10) provides options for 
configuring the Plot Panel of the OSI when displaying your variable.  These options 
include: 

Min Target—if you want a 
marker line plotted 
with your Variable to 
indicate a minimum 
target, enter that value 
in this field. 

Max Target—similarly, if you 
want a marker line 
plotted with your 
Variable to indicate a 
maximum target, enter 
that value in this field. 

Time Shift—if you want your variables plotted with a time offset (shift), enter the number 
of hours you want the data shifted by in the plot.  This may be useful when you 
plot additional time series with your variable—such as a downstream flow. 

Additional Time Series Displayed in Plot—this table shows the list of time-series datasets 
that will display with the OSI variable in the Plot Panel. Use the Add, Edit, and 
Delete buttons below the table to manage the entries in the Additional Time 
Series… list.  For example, to Add one or more ResSim output time series to be 
plotted with your variable in the plot panel: 

•  Click the Add button. This will open the Independent Variable Definition 
dialog (Figure I.11). (If the Independent Variable Definition dialog doesn’t 
appear, click Apply, then click Add again.)  

 

Figure I.11 Independent Variable Definition Dialog 

 

Figure I.10 OSI Variable Editor—Plot Panel Configuration 
Options 
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• Use the Independent Variable Definition dialog to select a variable to include 
with the plot of the OSI variable. Detailed instructions for using the 
Independent Variable Definition dialog are available in Appendix C. 

If you added more than 
one time series to 
Additional Time Series… 
table, you can change 
their display order by 
highlighting a time series 
in the table and using 
the arrows buttons to 
move the selected entry 
higher or lower in the list 
(Figure I.12). 

When you have finished configuring your OSI variable, click OK to accept your settings 
can close the OSI Variable Editor. 

Figure I.13 shows the plot panel of the OSI tab for the variable configured to use the 
additional time series shown in Figure I.12.  Since the parameter types of one or more of 
the additional time series had a different parameter than that of the OSI variable, an 
additional plot viewport was automatically added to display the different parameter type.  
Note—the vertical axis in each viewport starts at zero by default.  This may be 
inappropriate for some of the data you are plotting so be sure to zoom in on the axis to 
show a valid plot of the data. 

Figure I.13 OSI Plot Panel for a Variable with Additional Time Series Selected 

Save the OSI Configuration.   

When you have finished defining the tabs and their variables, select Save from the OSI’s 
File menu to save your OSI configuration. Then you can close the OSI. 

Figure I.12 OSI Variable Editor—Rearranging Display Order 
of Additional Time Series 
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To retain your OSI configuration for use in another simulation, save the alternative to 
base by using the Save to Base Directory… option in the alternative’s context menu in the 
Simulation Control Panel. 

The OSI configuration is saved as part of the data of an Alternative.  This means that the 
OSI can (and must) be configured separately for each new alternative.  However, if an 
alternative is created, using SaveAs, as a copy of an existing alternative that already has 
an OSI configuration, the new alternative will include the OSI configuration from the 
original alternative. 

I.4 Using the OSI for Reviewing Results 

Depending on your model, you probably have at least a few locations and parameters 
whose results should be reviewed to determine how well your model is performing or if 
your operations are meeting your objectives.  With the OSI, you can assemble these 
variables on one (or more) tabs to make the review of the results quick and easy.   

For Example: 

The Hayes Basin model (Figure I.14) has two reservoirs, Hayes and Hurst, and two 
downstream control points, Carmichael and Smithford. Further downstream is a 
water supply withdrawal location at Maryland.  

Figure I.14 An Example Watershed—Hayes Basin 

We chose to create a tab to monitor results at the control points and the withdrawal 
location and we named it Results Analysis.   On this tab we added three OSI Variables 
to display the: 

• Carmichael Flow 

• Smithford Flow 

• Maryland Withdrawal Flow. 
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But the flow results at a location usually cannot stand alone.  We needed additional 
information to analyze the results at the three locations including: 

• the flow constraints at the control points 

• releases from the reservoirs 

• the local inflows 

• and, for the diversion,  

o the inflow to the Maryland junction, and 
o the withdrawal demands. 

To view the additional information, they can either be represented with additional 
OSI Variables or they can be plotted as “Additional Time Series…” with one or more 
of the first three identified Variables.   We chose the latter as you will see below. 

I.4.1 Adding Computed Parameter Variables 

The Variable Type to use for simply reviewing results is the Computed Parameter 
type.  Computed Parameter variables are available for all four elements types—
Junction, Reservoir, Reach, and Diversion.  Computed Parameter variables are not 
editable. 

To add a Computed Parameter Variable to your tab: 

• Select Add Variable from the OSI’s Edit menu. 

• A New Operations Support 
Variable (name) dialog will open 
(Figure I.15).  Give the new 
variable a Name and an 
optional Description and click 
OK.  (Cancel will abort the 
create process.) 

• The Operations Support Model 
Variable Editor will open next.  
Use this editor to specify the 
variable and identify any 
additional time-series that you 
want plotted with it.  Start by 
selecting the Element Type. 

• Then, select the Element from 
the list of elements in your 
model. 

• Now, select Computed 
Parameter as your variable 
Type. 

• A field labeled Computed Time 
Series will appear below the 
Type field.  Click the Select 
button to the right of this field. 

 

Figure I.15 OSI Variable Editor—Configured for a 
Computed Parameter with Additional Time Series 
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• The Independent Variable Definition dialog will appear (Figure I.11). Use it to 
select a variable to include with the plot of the OSI variable. Detailed instructions 
for using the Independent Variable Definition dialog are available in Appendix C 

Figure I.15 above shows how we configured the Smithford OSI Variable for our 
Results Analysis tab.  Notice that we chose to add the local and routed flows as 
Additional Time Series… to be displayed in the Plot Panel with the Smithford flow. 

Figure I.16 shows the Results Analysis tab we assembled with the Smithford OSI 
Variable selected so that you can see how this variable is displayed.  The Plot Panel 
shows a single plot window (viewport).  In this plot window are curves for the 
Smithford flow as well as the other time series we chose to be plotted with it.  In 
addition, the Minimum and Maximum limits that were specified for the variable are 
drawn with marker lines and a hatched fill. Since this variable is a computed 
parameter, it is not editable, so its data column in the Table Panel of the OSI is grey. 

Although you might design a tab whose purpose is to simply display data for several 
variables (like we did in this example), you may find it useful to include a few 
Computed Parameter variables on the tabs you design for performing release 
overrides or computing incremental local flows.  Look for Computed Parameter 
variables in the upcoming examples. 

 

Figure I.16 OSI Example—Results Analysis Tab 
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I.5 Using the OSI to Perform Release and Elevation 

Target Overrides 

Using a ResSim model to support real-time release decision making has always been 
assumed to include the use of release overrides to enable the user to develop a release 
schedule that best meets the overall requirements of the basin that few (if any) models 
could do without user interaction. 

Unfortunately, the existing ResSim Overrides Editor requires too many “clicks” to define 
the overrides, compute, review results, and repeat… for the process to be considered 
“quick”.  The OSI was designed to streamline the process in a user-customizable way. 

We will illustrate how to setup the OSI to perform Release and Elevation overrides using 
our Hayes Basin watershed: 

The Hayes Basin model has two reservoirs, Hayes and Hurst, and two downstream 
control points, Carmichael and Smithford. The reservoirs are operated as a system to 
meet minimum and maximum constraints at the control points. Hayes is about 4 
times larger than Hurst but its drainage basin is only about twice that of Hurst’s 
drainage basin.  

Hayes has substantial controlled release capacity of up to 15000 cfs at the top of 
conservation with a gated spillway added in near top of flood control.  But the 
channel capacity below the dam is only 5000 cfs.  Hurst has a maximum controlled 
release capacity of only 5000 cfs with a channel capacity of 4000 cfs. In order to pass 
large events, Hurst has an uncontrolled spillway whose crest is at the top of the flood 
pool. 

An unregulated basin, about half the size of Hurst’s, flows into the system between 
Carmichael and Smithford.  Flooding starts at Carmichael at approximately 8000 cfs 
and at 11000 cfs at Smithford. 

Although standard operations rules perform well during low to moderate inflows, 
they perform poorly during large events over the basin.  To give the water 
management staff more modeling control, we developed an OSI with a tab for 
developing a release schedule using Release Overrides and a separate tab for using 
Elevation Target Overrides.  How each tab was setup is described in the next two 
sections.   

I.5.1 Configuring a Release Overrides Tab and Variable 

To minimize the “clicks” needed for specifying a release schedule and reviewing the 
impacts, you may decide—like we did—to use the OSI as the tool for performing your 
release overrides (instead of ResSim’s Overrides Editor) and to assemble the 
necessary reservoir release override variables in one tab along with the variables that 
show the response to the releases in the system.   

As discussed in Chapter 15, a release override can be applied to any controllable 
outlet or outlet group in the reservoir outlet hierarchy, including the total release 
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from the reservoir pool.  For many systems, a single OSI variable to override the total 
release from each reservoir is good enough to meet the release schedule needs.  For 
some systems, however, you may need to setup a release override OSI variable for 
multiple release elements of one or more of your reservoirs. 

For the Hayes Basin, we created a tab we called Release Schedule.  On this tab we 
created a variable for each reservoir’s total release override and a variable for 
each control point.   

Figure I.17 shows our Release Schedule tab with the Hurst variable selected.  The Plot 
Panel shows two viewports; the upper viewport contains two flow time series and 
the lower viewport contains an elevation time series.  The flows in the upper 
viewport are the pool inflow and outflow; the outflow is the OSI Reservoir Release 
(override) variable and the inflow is one of the two variables we added to be plotted 
with the OSI variable.  The pool elevation, displayed in the lower viewport, is the 
other additional time series we added to be plotted with the reservoir release 
variable.  

 

Figure I.17 OSI—Release Schedule Tab 
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Configuring a Release Override Variable 

To create an OSI variable for performing release overrides: 

• Create a new OSI variable by selecting Add Variable from the Edit menu.  After 
you give the variable a name and click OK in the New Variable dialog, the OSI 
Variable Editor will open (Figure I.18).  

• Select Reservoir as the Element Type. 

• Select the reservoir from the Element list. 

• Select Reservoir Release as the variable Type.  

• Select the release element from the Reservoir Release from selector.  The list 
includes all controlled outlets and outlet groups from your selected reservoir’s 
outlet hierarchy.  Consider carefully which release element you want to apply to 
your variable.  Depending on your circumstances, you may want to setup a 
separate OSI variable for each controlled outlet or you may want just one 
variable to cover the total release. To override the total reservoir release choose 
the Pool; if you have a diverted outlet that you do not want affected by the 
override, choose the DamTailwater. 

• If your reservoir has 
constant, at-site, 
minimum and/or 
maximum release limits 
and you would like to see 
those limits in the plot, 
enter those limits in the 
Min Target and Max 
Target fields. 

• Consider adding key 
reservoir output time 
series to the plot with 
your reservoir release; we 
like to add pool inflow and 
pool elevation.  To do so, 
use the Add button to 
open the Independent 
Variable Definition dialog.  

• When finished, click the 
OK button to close the OSI 
Variable Editor. 

Figure I.18 shows how we configured the Hurst variable in our example watershed. 
As suggested, we included the reservoir pool’s inflow and elevation as Additional 
Time Series… and we entered the minimum and maximum at-site release limits in the 
Min and Max Target fields. 

After setting up the Reservoir Release variables for Hayes and Hurst, we added two 
Computed Parameter variables, Carmichael and Smithford to show results at the two 
control points so that we could see—from the OSI—how our overrides were affecting 

Figure I.18 OSI Variable Editor—Configured for a Release 
Override 
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the control points without having to go back to the main ResSim interface.  In 
addition to the control point flow, we added additional time series to our two 
variables so that we could see how much unregulated (cumulative local) flow was 
reaching the control points, flow that the reservoirs could do nothing about. 

Enter your Overrides and Compute 

The OSI interface is designed to facilitate the specification of overrides, computing 
the alternative using the overrides, and reviewing results.   

To enter overrides, you have two options: 

• Specify the override values by entering data for the variable into the white cells 
in its column in the table panel.  Fill options are available from the column’s 
context menu to assist in entering data into the column.  Each override value will 
appear in the table in green text and will also be drawn, in blue with magenta 
symbols, in the same viewport of the Plot Panel as the variable itself.  

• Specify the override values by using the Edit tools in the Plot Panel’s toolbar to 
draw the desired override on the plot viewport where the variable is displayed. 
Use the Multi-point Edit tool to draw a series of line segments by clicking with 
the tool’s cursor in the plot region to draw each point.  After placing the last 
point, right-click anywhere in the plot to stop the draw process.  The values you 
specified in the plot will be drawn as a blue line and with magenta symbols; the 
same information will appear in the variable’s column in the Table Panel in green 
text. 

To compute the current alternative, you can use the Compute button at the top of 
the stack of Action Buttons; no need to return to the main ResSim interface.  

I.5.2 Setting Up Elevation Target Overrides 

Elevation Target overrides act as an override to the reservoir’s guide curve.  But, 
more than that, they short-circuit the reservoir’s release decision logic—for each 
timestep that has an elevation target override, all reservoir operation rules and 
IF_Blocks are ignored and the reservoir decision logic follows only guide curve 
operation using the elevation target override as the guide curve objective and 
constrained only by physical capacity.  Elevation Target overrides can be useful for 
lock & dam operation, hinge pool operation, or to assist in modeling unusual real-
time situations where the operation of the pool is more important than the releases. 

Configuring an Elevation Target Override Variable 

To configure an OSI variable as an Elevation Target override: 

• Select Add Variable from the Edit menu to create a new OSI variable.   

• Give the variable a name and click OK in the New Variable dialog. The OSI 
Variable Editor will open (Figure I.19). 

• Select Reservoir as the Element Type. 

• Select the reservoir from the Element list. 

• Select Elevation Target as the variable Type.  
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• If your reservoir has 
constant minimum and/or 
maximum pool limits and 
you would like to see those 
limits in the plot, enter 
those limits in the Min 
Target and Max Target 
fields. 

• Consider adding key 
reservoir output time 
series to the plot with your 
pool elevation; we decided 
to add pool inflow and 
outflow as well as one or 
more key zone elevations.  
To do so, use the Add 
button to open the 
Independent Variable 
Definition dialog. Use it to 
select each time series you 
want to include in the plot 
with your release. 

• When finished, click the OK button to close the OSI Variable Editor. 

I.6 Using the OSI to Compute Local Inflows 

In general, there are two situations in which you may want to compute incremental local 
inflows from total flows at a location: 

• In real-time operation where you want to compute the local inflow from observed 
data, then either use a recession equation to estimate the local inflow into the future 
or hand enter an estimate for the local inflow. 

• To compute incremental local flow data for a study model using observed or 
computed total flow data at key locations throughout the watershed.   

Although each of these situations use the same OSI configuration they each may require 
a significantly different setup in the network and/or its alternative.  To reflect this the 
next two sections present the generalized set of instructions for configuring a fairly 
simple model to compute local flow and some addition concepts and instructions for 
configuring a complex study model for computing local flow. 

I.6.1 Configuring the OSI (and Your Alternative) to 

Compute Local Inflows 

To compute incremental local inflows from total flows requires that your network 
and alternative, as well as the OSI, be configured carefully.  The basic steps you need 
to perform are described below. 

 

Figure I.19 OSI Variable Editor—Configured for an 
Elevation Target Override 
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NOTE—If your objective is to compute local inflows from observed data for use in a 
complex study model, see Section I.6.2 for more additional considerations and 
instructions for configuring your network and alternative. 

Prepare the Alternative and Its Network 

The equation used by ResSim to compute incremental local flow is: 

Local Flow = Total Flow — Routed Flow 

Where: 

• Local Flow is the incremental local flow at the junction. 

• Total Flow is the total flow leaving the junction; more specifically, it is the 
Observed flow at the junction. 

• Routed Flow is the flow routed to the junction from upstream; more specifically, 
the upstream Observed flow routed to the junction. 

In order to provide the correct information to the junction to compute the local flow, 
some changes may be necessary in both the reservoir network and the alternative.  

 The configuration requirements include: 

Local Flow cannot be computed at headwater junctions since ResSim cannot 
route flow to these junctions. However, if an Observed flow is provided at 
a headwater junction, it will be used instead of the total inflow for the 
computation of local flow downstream. 

Only one incremental local flow can be computed per junction element. Each 
junction should have no more than one entry on the Local Flow tab of 
the Junction Editor. 

An Observed flow must be associated with each junction where local flow will be 
computed. 

An Observed flow (representing the reservoir release) must be associated with the 
outflow junction of each reservoir upstream of a junction where local 
inflow will be computed.  

To accomplish these requirements: 

• Review the local inflow tab of each junction in your network.  For any with more 
than one inflow defined, replace the set with a single composite inflow—e.g., use 
a flow-local output from an HMS junction rather than multiple subbasin flows.  If 
a composite external time series option is not available, consider modifying the 
network to add additional junctions to receive the various locals—e.g., if one of 
the local inflows is a reach flow coming from a tributary in HMS that is not 
currently represented in ResSim, add the tributary and a junction at its mouth (to 
receive the reach flow) to the ResSim network. 
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• At each junction where you want ResSim to compute an incremental local and at 
each outflow junction 
of the reservoir above 
the junctions where 
you want incremental 
local flow computed, 
place a checkmark on 
the Observed tab of 
the junction editor to 
indicate that you have 
observed data for the 
total Flow from the 
junction (Figure I.20). 

• Save the network. 

• Open the Alternative 
Editor. Select the alternative to be used for computing local flows.  This should be 
the same as or a copy of the real-time or study alternative that will be using the 
local flows.  

• On the Observed Data tab, identify an observed total flow time series for each 
junction’s total flow variable in the list. Unless needed for other purposes, leave 
all other listed entries blank. 

Figure I.20 Junction Editor—Activate Observed Data for Total 
Flow 

 

Figure I.21 Alternative Editor—Observed Tab—Identify the Total Flow Time Series for the 
Junction 
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• On the Time Series tab, identify an input time series for each inflow in your 
model.  This may mean changing some entries that are already filled-in as well as 
filling-in the blank entries.  

 

Caution 

     You may think that because ResSim is going to compute most of the 

inflows listed on the Time Series tab of the Alternative Editor, you can use a 

single dummy time-series record for each local inflow that will be computed.  

Unfortunately, you would be wrong! 

     Each inflow must have a uniquely named time series record associated 

with it in the Time Series tab of the Alternative Editor. This is because ResSim 

is going to write the locals that are computed by the OSI into that record in 

the simulation.  If you do not have a unique time series for each location, 

create one and fill it with a constant value for the full time window over 

which you have observed data and for which you will be computing the 

locals. 

 

OSI Configuration 

ResSim and the OSI will only compute incremental local flow for those locations 
represented by an OSI Local Inflow variable.  

The OSI can only be configured for a computed alternative in the Simulation module, 
so that where you must start: 

•  Open or create a simulation that spans the time window of the observed data. If 
the local inflow computation is for a real-time alternative, the time window 
should include the forecast period.  

• Add your alternative to the simulation and compute it. 

•  Open the OSI and create a Local Flow tab.  You may need more than one tab so 
consider creating a tab for the local flows within each major tributary of your 
watershed.  

For each incremental local 
inflow you want to compute: 

• Create an OSI variable. 

• In the OSI Variable Editor… 

o Set its Element Type to 
Junction. 

o Select the particular 
junction Element. 

o Set the variable Type to 
Local Inflow. 

o The Local Flow field will 
fill with the first (and 
hopefully, only) local 
flow listed on the Local Flow tab for that junction in the Junction Editor. 

 

Figure I.22 OSI Variable Editor—Defining a Local Inflow 
Variable 
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o If you are computing locals from observed data for use in a study, you can 
leave the Recession Method and its parameters blank.  However, if you are 
computing the locals for use in a real-time alternative, then select the 
Recession Method and specify the Recession Constant and the Max 
Recession Period in days.  

o Click Apply in the OSI Variable Editor to save your settings, then set the data 
in the rest of the editor to configure the plot of the variable. Add one or 
more variables to be plot with the local flow so that you can see and analyze 
the validity of the computed local flow. Suggested variables to add to the 
plot include: total computed junction flow and observed junction flow. 

o Click Ok when you are finished with the current local inflow variable and 
close the OSI Variable Editor. 

o Repeat these steps until you have created an OSI Variable for each local 
inflow to be computed. 

• Once you have created an OSI variable for each local flow to be computed, save 
the OSI configuration.  You may also want to copy the alternative back to the 
network module so that your OSI configuration can be used in other simulations. 
To do so, close the OSI, then right-click on the alternative in the Control Panel 
and select Save to Base Directory… from the context menu. 

• You should now be ready to compute the local flows.  See Section I.6.3 for 
instructions. 

I.6.2 Preparing Your Study Model for Computing Local 

Inflows 

The preparations needed in a study model may be more extensive than a real-time 
model depending on the complexity of the model.  Although the “observed” data 
being used plays a role, the relevant aspects are the identification of the local inflows 
and specifying where observed data is required. 

Create a Copy of the Network and an Associated Alternative. 

Since the changes to your network can be extensive and potentially problematic for 
your study, we strongly recommend that you create a copy of the network and an 
associated alternative before making any changes for computing local flows. By 
making a copy of the study network and using the copy exclusively for the 
computation of the local inflows, any changes you make to the network for the 
computation of local flows will not affect the study model.   

See Appendix F, Section F.3.1.2 for instructions and shortcuts for making the copies 
of the network and alternative. 

Configure the Network for Computing Local Flows 

The network changes that should be considered and addressed for a complex study 
model include: 
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Remove distributed locals. A local Inflow should be identified only at a gage location, 
where a total (observed) flow is available.  More specifically—the only local 
flows that should be identified in the network are at the headwater junctions 
and at the interior junctions that represent gage locations for which 
(observed) total flow data is available.   

Any local flow currently identified at a junction where there is no gage should 
be deleted. This will include the local flows that represent a fraction of a 
single local flow hydrograph that has been distributed to two or more 
junctions; the total local flow should (already) be identified at the 
appropriate gage location. 

Any headwater junctions (on an ungaged tributary) that used a distributed 
inflow hydrograph or a basin-weighted multiple of a neighboring basin’s 
inflow hydrograph should be carefully labeled so that it can be assigned a 
zero-inflow hydrograph in the alternative. 

Associate an Observed flow with each junction where local flow will be computed and 
with the outflow junction of each reservoir upstream of a junction where local 
flow will be computed. 

To address both these points requires two steps. The first step is performed 
on the reservoir network and is described here.  The second step is 
performed on the alternative and is described later in this section. 

In the network, place a checkmark next to the junction’s flow (outflow) 
variable on the Observed tab of the Junction Editor for all junctions with an 
entry on the local flow tab and for all reservoir outflow junctions.  Hint: the 
junction outflow is usually the first Flow variable in the list of Variables on the 
Observed Data tab of the Junction Editor; the associated Location name 
should be the name of the junction itself. 

Remove losses from the routing reaches.  Seepage losses are already accounted for 
(hidden) in the observed flow at a gage.  If your reaches also remove water 
due to seepage, it will be “doubly-accounted for” in the computed locals. 

Remove diversions…unless they are gaged. Like seepage, ungaged diversions are 
already accounted for in the observed flow at a gage. If you don’t want to 
delete the diversions, set the Diversion Method of each diversion to Constant 
and set the value to zero.  If you have a gaged diversion, set its Diversion 
Method to Time-Series. 

If your model has one or more reservoirs with multiple inflow junctions and the 
inflows are not gaged, reconfigure each reservoir so that: 

The reservoir has only one inflow junction.  This is because there is no way to 
compute the individual local inflow from each tributary without 
observed data at each tributary inflow to the pool. 

The flow from all upstream tributaries is appropriately routed to that single 
inflow junction.  This is because all upstream flow must be routed to 
the inflow junction in order to compute the local inflow to the pool; 
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the computed inflow to the pool is used as the observed flow at the 
inflow junction. 

Verify the routing.  With the local inflows farther apart than they may have been in 
the study network, you should double-check that each routed observed 
hydrograph from an upstream gage compares well with the observed 
hydrograph at the next downstream gage.  Also, pay attention to the 
timestep of the observed data.  If it does not match the timestep of the study 
model alternatives, your routing parameters, or even your routing method, 
may need to be adjusted to properly route the observed flows. 

Be sure to save the network when you are done making the necessary change an 
before you start configuring the alternative. 

Prepare the Input Time Series Data 

Before configuring the alternative you will need for computing local flows, you should 
prepare the data you are going to need for those computations.  There are two types 
of data you’ll need—the data that represents the “observed” data at a gage and the 
dummy data that will be over-written by the computed local flows.   

The data that represents the observed data at the gages in your watershed will likely 
fall into one of the following three categories: 

Actual observed data—this data is the historic gage record of observations that has 
been cleaned up and verified, a process that involves filling-in missing values, 
correcting invalid values, and verifying or correcting questionable values.  
This data also includes the computed data that is generated using the 
observed data such as flows values from observed stage and reservoir 
inflows from observed reservoir elevations and releases. 

Unimpaired or Modified data—this data uses the historic record and adjusts it by 
adding back in estimates of evaporation losses and diversions.  By making 
these adjustments to the observed data, the modified data can be used to 
generation the local inflows needed as input for a variety of different 
operational scenarios.  These alternatives often result in the pool elevations 
that deviate significantly from what was observed which equates to 
evaporation quantities that did not occur historically. These alternatives may 
also use diversion demands that do not reflect what occurred historically.  

Computed or Synthetic data—this data is generated by an external process that is 
informed by the historic record in order to simulate or estimate potential 
future hydrology.  An example of this type of data would be the flows 
computed by a climate change model. 

Although each of these potential data sets may require that you make specific 
changes or adjustments to the network and alternative before using them to 
compute local inflows, but for the most part they are interchangeable if the network 
is set up as described above.  What remains are some data management tasks in 
preparation for configuring your alternative: 

Gather the data. If you haven’t done so already, assemble the observed data for all 
the gage locations and reservoirs in the model. This includes, if necessary, 



HEC-ResSim User’s Manual Appendix I - Operation Support Interface 

I-27 

computing the inflows to the reservoirs using the reservoir elevation-storage 
tables and the observed elevations and releases. Both reservoir inflow and 
outflow will be used as observed data for the computation of the local flows 
into and below the reservoir. 

Create a zero flow time series that spans the same time frame as the observed data.  
This time series will be used as the inflow to the headwater junctions where 
observed inflow is not available. 

Create a time series for each local inflow to be computed.  For each location where 
local inflow is to be computed, make a copy of the zero flow time series and 
name it for its location and parameter.  For example, if you will be computing 
a local flow for the Carmichael junction, give the associated zero flow time 
series a pathname such as: 

//Carmichael/Flow-Local//1HOUR/Computed/ 

 

 

Configure the Alternative for Computing Local Flows 

Most of the work in configuring the alternative is in mapping (associating) the right 
data to the right input.  To be sure you don’t forget a key requirement, implement 
the following steps carefully and completely. 

• Open the Alternative Editor and select the alternative to be used for computing 
local flows.  This should be the alternative you created when you made a copy of 
the network.  

• On the Run Control tab, verify that the time step matches the interval of the 
observed data; it doesn’t make much sense to compute hourly inflows from daily 
data.  But be careful here—if the alternative has a different timestep than the 
observed data, then the network was probably originally configured for that 
same timestep.  Double-check that discrepancy this was addressed during the 
routing verification step.  If not, you may need to go back to the network and 
adjust the routing parameters to properly route the observed data. 

• On the Operations tab, assign an operation set to each reservoir in your network.  
Although this may have already been taken care of when you first created the 
alternative, if you had to re-build one or more reservoirs due to multiple inflows, 
you may find there are reservoir that need your attention.  Note—when your 
network and alternative are properly configured, the reservoir operations are 
irrelevant to the computation of local flows. However, if you have a guide-curve-
only or an at-site-rules-only operation set at each reservoir, use it instead of the 
study model’s operations; there’s no point wasting compute time on 
downstream or system operations. 

• On the Lookback tab… 

o Set the Lookback Release for one of the outlets of each reservoir to Time-
Series and set the rest of the outlets to Constant with a value of 0.0. 
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o Set the Lookback Elevation for each reservoir to Time-Series.  Since the 
reservoir operations are irrelevant to the computation of locals, the lookback 
elevation values should also be irrelevant; however, when you review results, 
you don’t want to confuse yourself with nonsense at the reservoirs so 
realistic starting elevations should be used.   

If you do not have observed elevation data for a reservoir, set the Lookback 
Elevation to Constant and set the value to the guide curve elevation for that 
reservoir.  

o Set the Lookback Diversion of each ungaged diversion to Constant with a 
value of zero.  For each gaged diversion, set the Lookback Diversion to Time-
Series. 

• On the Time-Series tab… 

o For each gaged headwater inflow, set the pathname to the observed flow 
data for that gage. 

o For each ungaged headwater inflow, set the pathname to the generic zero 
flow time series that you created. 

o For each interior junction where local flow will be computed, set the 
pathname to the uniquely-named zero flow time series that you created for 
that location. 

o For each reservoir Lookback Release, set the pathname to the observed 
reservoir release data. 

o For each reservoir Lookback Elevation, set the pathname to the observed 
reservoir pool elevation data. 

o For each diversion Lookback Diversion and Input Time Series, set the 
pathname to the observed flow at the diversion gage. 

• On the Observed Data tab… 

o For each reservoir outflow junction, set its outflow to the pathname of the 
reservoir’s observed release data. 

o For each reservoir inflow junction, set its outflow to the pathname of the 
reservoir’s computed inflow data. 

o For each remaining interior junction where local flow will be computed, set 
its outflow to the pathname of the associated gage’s observed flow data. 

o For each gaged headwater junction, set its outflow to the same pathname 
you used for the junction’s inflow, the observed flow data for that gage. 

Configure the OSI 

Once your network, alternative, and input data are ready, you can configure the OSI 
to compute the local flows.  Refer to Section I.6.1 for the instructions on configuring 
the OSI and defining Local Flow OSI Variables. 
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I.6.3 Computing Local Flows 
• Open or create a simulation that spans the time window for which you want to 

compute local flows and for which you have the observed data needed.  

• If necessary, edit the simulation and add the local flow alternative you created 
and configured for use in computing the local flows. If the alternative is already in 
the simulation, you may need to update it to include any changes you made in 
the network module. To do so, right-click on the alternative in the Control Panel 
and select Replace From Base Directory… from the context menu  

• Compute the alternative. 

• Open the OSI and select (one of) the tab(s) you created for the local flow OSI 
variables.   

• Click on the data in one of the variable columns to make that variable appear in 
the plot.  Review the flow for the junction to verify that the standard compute 
produced valid results for the input provided. 

• Click the Calculate All Locals button in the stack of Action Buttons.  As described 
in Section I.2.5, a special compute type will be launched in ResSim to compute 
the local flow for each Local Flow OSI variable defined in the OSI. 

• Review your results carefully to be sure the local inflows were calculated 
correctly.  It may take a few iterations before you have the network, alternative, 
and OSI configured correctly for your system.  Between each attempt, if may be 
necessary to Rerun the Extract of the model data so that your computed local 
flows are replaced with the original input data.  

• When you are satisfied with the computed local flows, copy the data to a file in 
the shared folder of the watershed.  Be sure to name both the files and the 
records carefully to identify the data and its source. 

 

I.7 Workflow 

The OSI configuration is saved with the Alternative data.  This means that the OSI can 
(and must) be configured separately for each new alternative; however, if an alternative 
is created using SaveAs from an existing alternative that already has an OSI configuration, 
the new alternative will include a copy of the OSI configuration from the original 
alternative. 

To configure the OSI for a given alternative, a simulation must first be created and the 
alternative computed. 

With the desired Alternative active, select Simulation→Operation Support Interface from 
the main menu of the Simulation module. The ResSim Operation Support Interface will 
open.  The OSI will initially be empty.  Add tabs and variables (as described in the 
following sections).  A basic arrangement will be to show headwater local flows first, then 
other locals, then reservoir releases and supporting time series.  From the menu bar 
select File→Save to save the OSI configuration.  From the Alternative, the Save to Base 
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command allows the OSU to be used with the Alternative in new Simulations, while the 
Replace from Base command allows the configuration to be used in existing Simulations. 

Typical workflow once the OSI has been configured for an Alternative is as follows: 

• Create a new Simulation using the desired Alternative 

• Run the simulation at least once from the Simulation Model 

• Open the Operations Support Interface 

• Compute All Local Inflows 

• Perform Hydrograph Recession on Headwater Locals 

• Perform Hydrograph Recession on other Locals 

• Edit Reservoir Releases or Elevation Targets 

The OSI overwrites time series data for Junction Known Flows in the simulation.dss file 
and release and elevation targets in the overrides dss file associated with the Alternative. 
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